# Setting up a Diffusion Simulation in Graphical Mode

# Working in Console Mode

# Opening DICTRA in Console Mode

# Opening a Macro File (Console Mode)

# About the Console Mode File Formats

# Overview of a System

## Typical Console Mode Workflow

## About Regions and Grids

## About System, Cells and Regions

## About Phases

## About Composition Variables

## About Global Conditions

## About Boundary Conditions

## About Geometry and Coordinates

## Planar Geometry

## Cylindrical and Spherical Geometries

## About Operators and Functions

# Creating a DICTRA Simulation

# Defining a System in Console Mode

# Setting Up and Running a Simulation

# Setting Global Conditions

# Specifying Time-Dependent Profiles

## LOW TIME LIMIT

## HIGH TIME LIMIT

## ANY MORE RANGES

# Creating Regions and Gridpoints

# Entering Phases in Regions

# Specifying Phase Compositions in a Region

# Specifying the Geometry

# Setting Boundary Conditions

# Adding (Creating) Cells

# Importing a Scheil Segregation Profile

# Diffusion Models in Console Mode

## About the Homogenization Model

## About the Disperse Model

## About the Para Equilibrium Model

## About the Thermomigration Model

## About the Grain Boundary Model (GB_Model)

## Coarsening Processes

## About the Coarsening Model

## About the Pearlite Model

## About Cooperative Growth
LIST_MOBILITY_DATA ........................30
LIST_MOBILITY_ESTIMATES ..............30
LIST_PROFILES .............................30
LIST_REGION ...............................31
LIST_TIMESTEPS ............................31
MACRO_FILE_OPEN ..........................31
PARA_EQUILIBRIUM_MODEL ..............32
POLY_COMMAND ............................32
POST_PROCESSOR ............................33
READ_WORKSPACES .......................33
SAVE_WORKSPACES ........................33
SELECT_CELL ..............................34
SELECT_TIMESTEP ..........................34
SET_ACCURACY .............................35
SET_ALL_START_VALUES ..................36
SET_CONDITION ............................36
SET_FIRST_INTERFACE .....................39
SET_INITIAL_TEMPERATURE .............39
SET_INTERACTIVE_MODE ..................39
SET_NUMERICAL_LIMITS ..................39
SET_REFERENCE_STATE ....................41
SET_SIMULATION_CONDITION ..........41
SET_SIMULATION_TIME ....................43
SET_SURFACE_TENSION ....................44
SIMULATE_REACTION ....................46
STORE_HOMOGENIZATION_DATA ........46

SWITCH_MODEL ..............................46
UTILITIES_HOMOGENIZATION ............47
POST_PROCESSOR Commands ............50
Purpose and Methodology ...............52
Plot Condition and Independent
Variable ....................................52
APPEND_EXPERIMENTAL_DATA ..........53
DETERMINE_KIRK_PLANE ..................54
DIFFERENTIATE_VALUES ..................54
DUMP_DIAGRAM .............................54
ENTER_SYMBOL ..............................55
INFORMATION ................................56
INTEGRATE_VALUES ........................57
LABEL_CURVES ..............................57
LIST_plot_SETTINGS ........................57
LIST_REGION_NAMES .......................57
LIST_SYMBOLS ...............................57
LIST_TIME_STEPS ...........................58
MAKE_EXPERIMENTAL_DATAFILE .......58
PLOT_DIAGRAM ..............................58
PRINT_DIAGRAM .............................58
QUICK_EXPERIMENTAL_PLOT .............59
REINITIATE_PLOT_SETTINGS ..........59
SELECT_CELL ..............................59
SET_AXIS_LENGTH ..........................60
SET_AXIS_PLOT_STATUS ..................60
SET_AXIS_TEXT_STATUS ..................60
DATPLOT Files ..................................70
About DATAPLOT Files ....................71

State, Integral and Auxiliary Variables ..................................76

State Variables ................................77
Intensive Properties ................................77
Extensive Properties ................................77
Integral Variables ................................80
Auxiliary Variables ................................83

Diffusion Module (DICTRA)
Examples Guide ..................................1

About the Diffusion Module (DICTRA)
Examples Collection ..............................2
Diffusion Calculator Examples
(Graphical Mode) .................................1
Example Descriptions ............................1

Homogenization of a Binary Fe-Ni Alloy ................................2
Ferrite(bcc)/Austenite(fcc) Transformation in a Binary Fe-C Alloy ................................2
Evolution of an Fe-Cr-Ni Diffusion Couple .........................2
Fe-C Moving Boundary: Austenite to Ferrite ..........................3

Diffusion Module (DICTRA) Examples
(Console Mode) .................................4

Opening the Setup, Run, and Plot Macro Files .......................5
One Phase Examples ................................6
Moving Boundary Examples ..........................10
Cell Calculation Examples .........................22

Diffusion in Dispersed Systems
Examples ........................................24
Cooperative Growth Example ......................29
Coarsening Example ..............................30
Kinetic Data Examples ............................32
Deviation from Local Equilibrium
Examples ........................................35

Diffusion in Complex Phases
Examples ........................................38

Thermo-Calc User Guide .........................1
Rotation Angle and Show
Anchor

121

Changing the Plot Properties 122
Saving Plots

122

Plotting Several Calculations
in One Diagram
123

Performing Calculations in
Console Mode

148

Using the Command Line Prompt 149
Available SYS Module
Commands

149

Moving Between Modules and
Submodules

149

Entering Command Names or
Abbreviations

150

Specifying Parameters

151

128

Wild Card Characters

152

128

Controlling Console Output

153

130

Command History

154

Experimental File Reader

131

Log, Macro and Workspace Files 154

Binary Calculator

131

Log Files

154

Ternary Calculator

133

Macro Files

155

Scheil Calculator

135

Workspace Files

158

Main Menu Commands

159

Increasing the Buffer Size

160

Defining a System in Console
Mode

160

How to Define a System in
Console Mode

161

Adding Axes to a Diagram
Merging Plots into One
Diagram
Results Window Status
Markers
Table Renderer
Defining the Table Columns

124
126

Scheil Calculator Advanced
Settings

137

The Console Mode Interface

140

The Console Mode Layout

142

Console Window

143

Editing the Default Console
Directory

144

Console Mode Results Window

146

About Equilibrium Calculations

164

Event Log Window

146

Calculating an Equilibrium

166

Console Mode Workflow

147

Typical POLY Module Workflow

147

Calculating an Equilibrium with a
Fixed Phase
167

Equilibrium Calculations

Calculating an Equilibrium with

163

167

10 of 24


Ex_09: Carbide Driving Force Heat Map ...........................................15
Property Model Calculator Examples 17
Ex_10: Phase Transition ......................17
Ex_11: Coarsening and Interfacial Energy ...........................................17
Ex_12: Driving Force and Interfacial Energy ...........................................18
Diffusion Calculator Examples .................20
Homogenization of a Binary Fe-Ni Alloy ...........................................20
Ferrite(bcc)/Austenite(fcc)
Transformation in a Binary Fe-C Alloy ...........................................20
Evolution of an Fe-Cr-Ni Diffusion Couple ...........................................21
Fe-C Moving Boundary: Austenite to Ferrite ...........................................21
Precipitation Calculator Examples ........23
Ex_13: Isothermal Precipitation of Al3Sc ...........................................23
Plot Results .................................24
Ex_14: Stable and Metastable Carbides - Isothermal ...........................................24
Plot Results .................................26
Ex_15: Stable and Metastable Carbides - TTT Diagram ...........................................26
Plot Results .................................28
Ex_16: Precipitation of Iron Carbon Cementite ...........................................28
Volume Fraction .........................30

Ex_17: Precipitation of g’ in Ni Superalloys - Isothermal ..................30
Volume Fraction .........................32
Number Density .........................33
Mean Radius .........................34
Ex_18: Precipitation of g’ in Ni Superalloys - Non-isothermal ...........34
Mean Radius Ni-8Al-8Cr .................36
Mean Radius Ni-10Al-10Cr ..........37
Size Distribution (PSD) Ni-8Al-
8Cr ..................................38
Size Distribution (PSD) Ni-
10Al-10Cr ..................................39

Thermo-Calc Console Mode Examples Guide ..................1
About the Thermo-Calc Console Mode Examples ..................2
Opening the Macro File ..................2
Examples of Binary Systems ...........4
Examples of Ternary Systems ...........9
General Examples Using the Steel Database .........................13
Examples of Property and Potential Diagrams .........................16
Property Diagrams .........................16
Potential Diagram .........................16
Examples of Multicomponent Systems .........................17
Examples Using Functions and Variables .........................19
Examples of the Gibbs Energy System (GES) Module ..........................22
Examples of Scheil-Gulliver Calculations ...............................25
Example using the PARROT and EDIT_EXPERIMENT Modules ........27
Example of the Tabulate Reaction (TAB) Module ......................29
Examples with Specialized Databases .................................31
Pourbaix Module Examples ...........................................33
  Step 1: Single-Point Calculations for H2O-NaCl system ..........33
  Step 2: Single-Point Calculations for Fe-X (X = Cr-Ni-Co) system ..34
  Step 3: Single-Point Calculations for Fe-Cr-Ni-Co + H2O-NaCl system ........................................34
  Step 4: Pourbaix Diagram Mapping for Fe-Cr-Ni-Co + H2O-NaCl system - define the variables ........................................34
Thermo-Calc Console Mode
Command Reference .............................. 1
  Introduction to the Command Reference ............................1
  About the Console Command Reference ...........................2
  Thermo-Calc Console Mode File Types ............................2
  General Commands ................................... 3
    BACK ....................................... 4
    EXIT ....................................... 4
    GOTO_MODULE ................................. 4
    HELP (? and ??) ................................ 4
    HELP .......................................... 5
    INFORMATION .................................. 5
    MACRO_FILE_OPEN ............................. 5
    SET_INTERACTIVE ............................. 8
    BINARY_DIAGRAM Commands ......................... 9
    BINARY_DIAGRAM Module ........................ 10
    Database Commands ..................................11
      AMEND_SELECTION ................................12
      APPEND_DATABASE ..............................12
      DATABASE_INFORMATION ........................14
      DEFINE_ELEMENTS ................................14
      DEFINE_SPECIES ................................14
      DEFINE_SYSTEM ..................................15
      GET_DATA .....................................16
      LIST_DATABASE ..................................16
      LIST_SYSTEM ....................................17
      NEW_DIRECTORY_FILE ............................17
      REJECT ........................................18
      RESTORE .......................................20
      SET_AUTO_APPEND_DATABASE ..................21
      SWITCH_DATABASE ..............................22
      EDIT_EXPERIMENTS Commands ...............25
      Running the EDIT_EXPERIMENTS Command ...........27
      ADVANCED_OPTIONS ............................27
Equilibrium Calculations with the POLY_3 Module

About POLY3 - The Equilibrium Calculation Module

ADD_INITIAL_EQUILIBRIUM
ADVANCED_OPTIONS Descriptions
ADVANCED_OPTIONS
AMEND_STORED_EQUILIBRIA
CHANGE_STATUS
COMPUTE_EQUILIBRIUM
COMPUTE_TRANSITION
CREATE_NEW_EQUILIBRIUM
DEFINE_COMPONENTS
DEFINE_DIAGRAM
DEFINE_MATERIAL
DELETE_INITIAL_EQUILIBRIUM
DELETE_SYMBOL
ENTER_SYMBOL
EVALUATE_FUNCTIONS
LIST_AXIS_VARIABLE
LIST_CONDITIONS
LIST_EQUILIBRIUM
LIST_INITIAL_EQUILIBRIA
LIST_STATUS
LIST_SYMBOLS
LOAD_INITIAL_EQUILIBRIUM

MAP
POST
READ_WORKSPACES
RECOVER_START_VALUES
REINITIATE_MODULE
SAVE_WORKSPACES
SELECT_EQUILIBRIUM
SET_ALL_START_VALUES
SET_AXIS_VARIABLE
SET_CONDITION
SET_INPUT_AMOUNTS
SET_NUMERICAL_LIMITS
SET_REFERENCE_STATE
SET_START_CONSTITUTION
SET_START_VALUE
SHOW_VALUE
STEP_WITH_OPTIONS
TABULATE

Plotting and Visualization with the POST Module

Using the POST Module
ADD_LABEL_TEXT
APPEND_EXPERIMENTAL_DATA
CHANGE_LEGEND
DUMP_DIAGRAM
ENTER_SYMBOL
FIND_LINE

17 of 24
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Experiments and Experimental Data</td>
<td>54</td>
</tr>
<tr>
<td>Phase Diagram Data</td>
<td>55</td>
</tr>
<tr>
<td>Data for Individual Compounds</td>
<td>56</td>
</tr>
<tr>
<td>Single Phase Mixing Enthalpies or Partial Enthalpies</td>
<td>58</td>
</tr>
<tr>
<td>Enthalpies of Formation and Enthalpies of Reactions</td>
<td>58</td>
</tr>
<tr>
<td>Chemical Potentials via EMF Measurements</td>
<td>59</td>
</tr>
<tr>
<td>Driving Force for Metastable Phases</td>
<td>60</td>
</tr>
<tr>
<td>Pressure-Temperature-Volume EOS Data</td>
<td>60</td>
</tr>
<tr>
<td>Crystal Structure, Lattice Parameters and Site-Occupancy</td>
<td>61</td>
</tr>
<tr>
<td>Magnetism and Other Atomistic Properties</td>
<td>62</td>
</tr>
<tr>
<td>Data About Systems of Different Orders</td>
<td>62</td>
</tr>
<tr>
<td>Thermodynamic Models</td>
<td>64</td>
</tr>
<tr>
<td>Gas</td>
<td>65</td>
</tr>
<tr>
<td>Compound Energy Formalism</td>
<td>65</td>
</tr>
<tr>
<td>Substitutional Liquid</td>
<td>66</td>
</tr>
<tr>
<td>Ionic Two-Sublattice Liquid Model</td>
<td>66</td>
</tr>
<tr>
<td>Models for Ordered Phases</td>
<td>67</td>
</tr>
<tr>
<td>4SL Model for FCC, HCP and BCC</td>
<td>68</td>
</tr>
<tr>
<td>2SL Model for FCC, HCP and BCC</td>
<td>69</td>
</tr>
<tr>
<td>Magnetic Ordering</td>
<td>70</td>
</tr>
<tr>
<td>Molar Volumes and High Pressure</td>
<td>70</td>
</tr>
<tr>
<td>Excess Models</td>
<td>71</td>
</tr>
<tr>
<td><strong>Database Manager User Guide</strong></td>
<td></td>
</tr>
<tr>
<td>Introduction to the Database Manager Guide</td>
<td>2</td>
</tr>
<tr>
<td>Thermodynamic and Kinetic/Mobility Databases</td>
<td>3</td>
</tr>
<tr>
<td>Initialization of the DATA Module</td>
<td>3</td>
</tr>
<tr>
<td>Initiation Parameter Examples</td>
<td>4</td>
</tr>
<tr>
<td>The Database Definition File and Keywords</td>
<td>6</td>
</tr>
<tr>
<td>Database Definition File Syntax</td>
<td>8</td>
</tr>
<tr>
<td>ELEMENT</td>
<td>9</td>
</tr>
<tr>
<td>SPECIES</td>
<td>10</td>
</tr>
<tr>
<td>PHASE</td>
<td>11</td>
</tr>
<tr>
<td>Examples of Recommended Suffixes</td>
<td>11</td>
</tr>
<tr>
<td>GIBBS Phase-type Codes</td>
<td>12</td>
</tr>
<tr>
<td>Additional clarification</td>
<td>13</td>
</tr>
<tr>
<td>CONSTITUENT</td>
<td>16</td>
</tr>
<tr>
<td>ADD_CONSTITUENT</td>
<td>17</td>
</tr>
<tr>
<td>COMPOUND_PHASE</td>
<td>18</td>
</tr>
<tr>
<td>ALLOTROPIC_PHASE</td>
<td>18</td>
</tr>
<tr>
<td>TEMPERATURE_LIMITS</td>
<td>19</td>
</tr>
<tr>
<td>DEFINE_SYSTEM_DEFAULT</td>
<td>19</td>
</tr>
<tr>
<td>DEFAULT_COMMAND</td>
<td>20</td>
</tr>
<tr>
<td>DATABASE_INFORMATION</td>
<td>20</td>
</tr>
<tr>
<td>TYPE_DEFINITION</td>
<td>21</td>
</tr>
<tr>
<td>FTP_FILE</td>
<td>24</td>
</tr>
</tbody>
</table>
Working with the Mobility Databases 44

About the Diffusion Module (DICTRA) and the Databases 45

Extensions to Database Definition File Syntax 46

PARAMETER 46

DIFFUSION 47

ZERO_VOLUME_SPECIES 48

Database Definition File Examples 49

Example 1: A Steel Database 50

Example 2: A Custom Database for the Sb-Sn Binary System 51

Example 3: A Public Database for the Fe-Cr-C Ternary System 54

The Database Checker 69

About the Database Checker 70

Database Checker Revision History 70

DATAPLOT User Guide 1

Introduction to the DATAPLOT User Guide 2

Using this Guide 3

About the DATAPLOT Graphical Language 3

DATAPLOT Examples 3

Using DATAPLOT Graphical Language 4

DATAPLOT File Structure 5

DATAPLOT Language Syntax 5

Coordinate Systems 5

Graphical Operation Codes 6

Tables or Blocks 7

Drawing a Polygon 8

Drawing an Analytical Function 8

Painting of an Enclosed Area 8

Writing a Text 8

Plotting a Symbol 9

Other Commands 10

Interactive Plotting 11

Formatting DIGLAB Symbols in LaTeX Documents 11

LaTeX Formatting Codes 12

LTEXT vs LaTeX Commands for Labels 13

PROLOGUE Commands 14

PROLOGUE 15

XSCALE 15
Examples of DATAPLOT Files and Outputs .................................................. 30

Example 1 – Draw Lines and Symbols ......................................................... 31
Example 2 – Draw Polygons and Symbols ................................................... 32
Example 3 – Using Strings and Various Line Types ....................................... 33
Example 4 – Draw Curves Defined by Functions .......................................... 34
Example 5 – Use Included Files for Predefined Symbols ............................... 35
Example 6 – Plot Triangular Diagrams for Ternary Systems ....................... 38
Example 7 – Color Codes and Effects ......................................................... 42

DATASET Commands ................................................................. 18
DATASET ................................................................. 19
BLOCK ............................................................. 19
BLOCKEND ...................................................... 20
DATAPoint .......................................................... 20
CLIP .............................................................. 20
ATTRIBUTE .................................................... 21
LINETYPE ....................................................... 21
drawline .......................................................... 21
charsize ............................................................ 22
symbolsize .......................................................... 22
globalsize .......................................................... 22
color ............................................................... 22
font ................................................................. 24
string .............................................................. 26
Text ................................................................. 28

FUNCTION ......................................................... 28
PCFUNCTION .................................................. 28
PAINT ........................................................... 29
INCLUDE .......................................................... 29
Introduction to the Diffusion Module (DICTRA)

In this section:

- About the Diffusion Module (DICTRA) ................................................................. 3
- About This Guide ........................................................................................................ 3
- Which Mode Should I Use? ......................................................................................... 3
- What Do I Do Next? ..................................................................................................... 4
- An Important Note About Terminology ................................................................. 5
- Typographical Conventions ....................................................................................... 5
- Graphical Mode vs Console Mode ............................................................................. 7
- Key Differences Between Modes .............................................................................. 9
- Help Resources ......................................................................................................... 12
- Types of Diffusion Simulations ............................................................................... 14
- About the Examples .................................................................................................. 17
- Graphical Mode Examples ....................................................................................... 17
- Console Mode Examples .......................................................................................... 17
- Diffusion Module (DICTRA) Licenses ..................................................................... 18
- Network License Restrictions .................................................................................... 18
About the Diffusion Module (DICTRA)

The Diffusion Module (DICTRA) is an add-on module to Thermo-Calc. It is used for simulation of diffusion controlled transformations in multicomponent systems. The simulation calculations are both time- and space-dependent. The Diffusion Module (DICTRA) is available in both Graphical Mode and Console Mode, although Console Mode includes more advanced functionality.

The Diffusion Module (DICTRA), which is often just referred to as DICTRA, is ideally suitable for solving diffusion simulations that include a moving boundary (Stefan problems). The multicomponent diffusion equations in the various regions of a material are solved under the assumption that thermodynamic equilibrium holds locally at all phase interfaces. Simulations are one-dimensional and three different geometries can be performed: planar, cylindrical and spherical.

In order to perform a simulation in the Diffusion Module, both a thermodynamic database and a kinetic database is needed. The thermodynamic database is a normal Thermo-Calc database, whereas the kinetic database contains information about the atomic mobility of individual elements in various phases.

Using the Diffusion Module (DICTRA) you can solve a variety of problems, some of which are described in "Types of Diffusion Simulations" on page 14.

About This Guide

This guide includes an overview of the program and describes in generic terms how you can define a system, set up and perform simulations, and then visualize the results. There is also a section to help you troubleshoot your simulation.

The guide is primarily for users already familiar with Thermo-Calc and for those who intend to use Console Mode. The Graphical Mode version is integrated into the Thermo-Calc desktop and its functionality is primarily described in the Thermo-Calc User Guide.

Which Mode Should I Use?

The Diffusion Module (DICTRA) is available in both Graphical Mode and Console Mode, although Console Mode includes more advanced functionality.

Before you start using this guide, it is recommended that you review the Thermo-Calc User Guide and become familiar with using both modes. Also see "Graphical Mode vs Console Mode" on page 7 to give you an overview of the differences. Understanding the capabilities of each mode will help you during the design of a simulation.
The two modes can be run simultaneously, but there is no communication between them. What you do in Graphical Mode does not affect the state of the Console Mode session and vice versa. This can be important to remember if you create a simulation in one mode and then decide to switch to the other mode.

What Do I Do Next?

How you proceed depends on your experience with the software as well as your level of expertise with diffusion simulations. In addition to this guide the following supplemental documentation and training resources can help you learn how to use the Diffusion Module (DICTRA).

Documentation Resources

You can search or browse all the documentation available by going to Help → Online Help from inside the program. Also available with your installation is a PDF called the Diffusion Module Documentation Set (this is what you are reading now). This PDF contains all the Diffusion Module documentation (Quick Start Guides, User Guide, Command Reference and Examples Guide) plus all the Thermo-Calc documentation. This is the same information as the online help and is also search-able.

Quick Start Guides

If you are a new user, a good starting point is to go through the exercises found in the quick start guides; one is available for each mode. Both guides use the same examples included with your installation and have most of the same settings. This gives you a chance to try working in each mode. See "About the Examples" on page 17.

Command Reference and Console Mode Examples

If you are familiar with Thermo-Calc Console Mode and want to use the Diffusion Module in Console Mode, then two supplementary resources are the Diffusion Module Command Reference and the Diffusion Module Console Mode Examples Guide.

Training and Video Tutorials

Some of the Graphical Mode examples have video tutorials available either on our website or our YouTube channel. You may also decide to enroll in a training course or if you have several people interested in on-site training.
An Important Note About Terminology

DICTRA is an acronym for *Diffusion-Controlled TRAnsformations*. The software of the same name has been included in the suite of Thermo-Calc products for many years. When you are working on Console Mode the terminology reflects this historical connection as do all the literature that cites the use of DICTRA.

With the introduction of the Graphical Mode version of DICTRA, and to better describe what the add-on module does, the product name is now the *Diffusion Module (DICTRA)*. However, this means some of the terminology between the modes cannot be consistent even though the theory and concept behind the software is fundamentally the same. For example, in Graphical Mode the term "DICTRA" is not used when describing the Diffusion Calculator node.

In Console Mode there is also some terminology to be aware of as there are two submodules within the program: the DICTRA_MONITOR module and the DIC_PARROT module.

In the documentation for Console Mode, *DICTRA* and *DICTRA module* are used interchangeably to refer to the DICTRA_MONITOR module.

Typographical Conventions

The following typographical conventions are used throughout the documentation.

<table>
<thead>
<tr>
<th>Convention</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Forward arrow symbol $\rightarrow$</td>
<td>The forward arrow symbol $\rightarrow$ instructs you to select a series of menu items in a specific order. For example, <strong>Tools $\rightarrow$ Options</strong> is equivalent to: From the <strong>Tools</strong> menu, select <strong>Options</strong>.</td>
</tr>
<tr>
<td><strong>Boldface</strong> font</td>
<td>A <strong>boldface</strong> font indicates that the given word(s) are shown that way on a toolbar button or as a menu selection. For example, if you are told to select a menu item in a particular order, such as <strong>Tools$\rightarrow$Options</strong>, or to click <strong>Save</strong>.</td>
</tr>
</tbody>
</table>

---

1This module is for running simulations of diffusion controlled transformations.
2The DIC_PARROT module assesses experimental data and uses this data to optimize mobilities.
### Convention | Definition
---|---
*Italic font* | An *italic* font in the body of the text indicates the introduction of important terminology. Expect to find an explanation in the same paragraph or elsewhere in the guide.

**COMMAND** | For features in Thermo-Calc that use Console Mode (i.e. the command line), this font and all capital letters indicates that this is a Console Mode COMMAND. Examples of how you can use a command are written with code font. For example: Use `DEFINE_ELEMENTS` followed by a list of the elements that you want in your system. (To list the elements that are available in your current database, use `LIST_DATABASE` and choose *Elements*).

**HELP** | Text in [blue and underline](#) and a page number is a link to another topic in the current or referenced guide. Command names are often also topics. Clicking the link takes you to more detail about a particular command or subject in the PDF or documentation set.

<Enter> | Text with `<angle brackets>` indicates a keyboard entry. Usually to press `Enter` (or Return) or to use a series of keys such as `<Ctrl + S>`.

**code** and **code bold** | A code font shows a programming code or code example. The code bold font highlights the entry.

### Icons

| Convention | Definition |
---|---|
**Important** | ![Atom icon](atom.png) Provides important information. It is recommended that you read the text or follow the link. |
**Note** | ![Note icon](note.png) The information can be of use to you. It is recommended that you read the text or follow the link to more information. |
<table>
<thead>
<tr>
<th>Convention</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Also see</td>
<td>Go to the link or guide to see more general information about the topic being discussed.</td>
</tr>
<tr>
<td>Examples</td>
<td>Go to the example collection to learn more.</td>
</tr>
<tr>
<td>Console Mode</td>
<td>This note relates specifically to something in Console Mode.</td>
</tr>
<tr>
<td>Graphical Mode</td>
<td>This note relates specifically to something in Graphical Mode.</td>
</tr>
<tr>
<td>Diffusion Module</td>
<td>This indicates that the information relates to the add-on Diffusion (DICTRA) Module.</td>
</tr>
<tr>
<td>Precipitation Module</td>
<td>This indicates that the information relates to the add-on Precipitation Module.</td>
</tr>
</tbody>
</table>

**Graphical Mode vs Console Mode**

There are two interfaces available in Thermo-Calc: *Graphical Mode* with a graphical user interface (GUI) and *Console Mode*, which uses a command line interface. Thermo-Calc and the Diffusion Module (DICTRA) are available in both modes, and the Precipitation Module (TC-PRISMA) is only available in Graphical Mode.

In Graphical Mode calculations are set up, carried out, and visualized as part of a *project*. The steps in the project are performed with *activities*. There are templates and a Wizard available to guide you through the process of defining the project.

In Console Mode you work with *modules*, which are managed using commands typed at a prompt. Some modules, called *response-driven modules*, ask you a series of questions that typically take you through the process of defining your system, setting calculation conditions, performing calculations and plotting the results.
Switching between modes

The first time you open Thermo-Calc, it defaults to Graphical Mode. For any future instance it defaults to the last mode used.

Along the top of the GUI is the **GRAPHICAL MODE TOOLBAR** where you switch between modes.

![Graphical Mode Toolbar](image)

In Console Mode, except for the **SWITCH TO GRAPHICAL MODE** button, the toolbar is not used.

![Console Mode Toolbar](image)

See "Main Menu and Toolbar" on page 33 in the *Thermo-Calc User Guide* for information about the **Tools, Window** and **Help** menus, which are available in both modes.
**File extensions**

The file extensions are different based on the mode you are in (Graphical vs. Console). In Console Mode the extensions are also based on whether you are working with Thermo-Calc or the Diffusion Module (DICTRA).

In Graphical Mode, the Thermo-Calc project files have the extension *.tcu. This includes the examples for the add-on Diffusion Module (DICTRA) and Precipitation Module (TC-PRISMA).

In Console Mode, Thermo-Calc macro files have a *.TCM extension and the Diffusion Module (DICTRA) file extension is *.DCM. In addition to macro files in Console Mode the are also Log files and Workspace files, which also differ.

**Can I work with both modes at the same time?**

The two modes can be run simultaneously, but there is no communication between them. What you do in Graphical Mode does not affect the state of the Console Mode session and vice versa. One exception is the plot settings. See "Global Settings: Graphical and Console Mode-Plotting" on page 228 in the Thermo-Calc User Guide.

**Data optimization and thermodynamic / kinetic assessments**

Although many calculations can be done in either mode, data optimization and thermodynamic or kinetic assessments are only available in Console Mode.

**Key Differences Between Modes**

Below are some of the main differences between the available features or simulation types in Graphical Mode (GM) and Console Mode (CM). There are also other differences not listed in the table such as slight differences between terminology and the file formats, for example.

For the Graphical Mode version of the Diffusion Module, additional functionality is scheduled for future versions of Thermo-Calc.

<table>
<thead>
<tr>
<th>Feature or type of simulation</th>
<th>Graphical Mode</th>
<th>Console Mode</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Features</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Feature or type of simulation</td>
<td>Graphical Mode</td>
<td>Console Mode</td>
<td>Comment</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>----------------</td>
<td>--------------</td>
<td>---------</td>
</tr>
<tr>
<td>Plots</td>
<td>x</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Planar, cylindrical and spherical geometries</td>
<td>x</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Homogenization</td>
<td>x</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Homogenization functions</td>
<td>x</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Tables</td>
<td></td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Setting boundary conditions</td>
<td></td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Importing Scheil segregation profiles</td>
<td></td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Data optimization (PARROT)</td>
<td></td>
<td>x</td>
<td></td>
</tr>
</tbody>
</table>

**Simulation types**

<table>
<thead>
<tr>
<th>Simulation types</th>
<th>Graphical Mode</th>
<th>Console Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Isothermal and Non-Isothermal simulations</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Growth of intermediate phases in compounds</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Growth or dissolution of precipitates</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Microsegregation during solidification</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Feature or type of simulation</td>
<td>Graphical Mode</td>
<td>Console Mode</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>----------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Austenite to ferrite transformations</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Interdiffusion in compounds</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Coarsening</td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>Carburizing of high-temperature alloys</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Nitriding and nitrocarburization</td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>Paraequilibrium</td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>Thermomigration</td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>Grain boundary models</td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>Pearlite models</td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>Interpolation scheme</td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>Cell calculations</td>
<td></td>
<td>x</td>
</tr>
</tbody>
</table>
Help Resources
'Online' Help: No Internet Required

To access online help in a browser, open Thermo-Calc and select Help → Online Help. The content opens in a browser but uses local content so you don't need an Internet connection except links to external websites.

Context Help (Graphical Mode Only)

When you are in Graphical Mode, you can access feature help (also called topic-sensitive or context help) for the activity nodes in the tree.

1. In the Project window, click a node. For example, System Definer.
2. In the lower left corner of the Configuration window, click the help button.
3. The Help window opens to the relevant topic.

The window that opens has the same content as the help you access in the browser. There are these extra navigation buttons in this view.

- Use the buttons on the bottom of the window, to navigate Back and Forward (these are only active once you have started using the help to load pages and create a history), to Close the window, and Reload the original content.

Console Mode Help

Console Mode is for Thermo-Calc and the Diffusion Module (DICTRA).
In Console Mode at the command line prompt, you can access help in these ways:

- For a list of all the available commands in the current module, at the prompt type a question mark (?) and press <Enter>.
- For a description of a specific command, type Help followed by the name of the command. You can only get online help about a command related to the current module you are in.
- For general system information type Information. Specify the subject or type ? and the available subjects are listed. This subject list is specific to the current module.

### Types of Diffusion Simulations

The Diffusion Module (DICTRA) is used to simulate diffusion-controlled transformations in multicomponent alloys. A short summary of the types of simulations it can handle are listed below and whether it is available in Graphical (GM) or Console (CM) Mode.

The three main simulation types that are available for both modes are briefly discussed in this section.

For Graphical Mode, see the *Quick Start Guide* for examples of single phase, moving boundary phase and multiphase simulations.

For Console Mode, also see "Diffusion Models in Console Mode" on page 50, the *Quick Start Guide* and the "About the Examples" on page 17.

<table>
<thead>
<tr>
<th>Simulation type</th>
<th>Examples</th>
<th>Graphical Mode</th>
<th>Console Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>One-phase simulations</td>
<td>Homogenization of alloys</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td></td>
<td>Carburizing and decarburizing of e.g. steel in austenitic state</td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>Moving boundary</td>
<td>Growth or dissolution of precipitates</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>simulations</td>
<td>Microsegregation during solidification</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td></td>
<td>Austenite to ferrite transformations</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Simulation type</td>
<td>Examples</td>
<td>Graphical Mode</td>
<td>Console Mode</td>
</tr>
<tr>
<td>-----------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------------</td>
<td>--------------</td>
</tr>
<tr>
<td><strong>Diffusion in a Single-Phase System</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>This type of simulation is available for both Graphical and Console Mode.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>The simplest simulation is one where certain elements in one phase diffuse over time in that single phase. To simulate this, you create one region and enter one phase into that region. You can set up the system under various conditions by defining profiles for how temperature and pressure change over time.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>In Console Mode you can also simulate how the boundary conditions of the region change over time.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><em>Simulate diffusion in a single-phase system.</em></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**Moving Boundary Multi-Phase System**

This type of simulation is available for both Graphical and Console Mode. With two regions in a single cell you can simulate how diffusion causes phase transformations. For example, you can simulate how an individual particle grows or dissolves as a function of time. The result is a simulation of how the boundary between the regions migrate over time. As in the case of a one-phase simulation, you can set up the system under various conditions by defining profiles for how temperature changes over time.

In Console Mode you can also set up the system to see how the boundary conditions of the region change over time.

**Simulate a moving boundary multi-phase system**

Normally, simulations are performed under the assumption that thermodynamic equilibrium holds locally at all phase interfaces.

In Console Mode it is also possible to simulate a moving phase boundary problem while assuming that para-equilibrium conditions apply at the phase boundary.

**Diffusion in Disperse Systems**

This type of simulation is available for both Graphical and Console Mode. You can perform simulations where one or more dispersed phases are present in a matrix phase. For example, you can simulate how carburization causes precipitation of carbides in an austenitic matrix phase. In both Graphical Mode and Console Mode, problems involving diffusion in disperse systems are handled with homogenization model.

In Console Mode and if you are using the **disperse model** instead of the recommended homogenization model, the dispersed phases act as point sinks or sources of solute atoms in the simulation and the fraction and composition is calculated from the average composition in each node, assuming that equilibrium holds locally in each volume element.

**Simulate diffusion in a disperse system**
The homogenization model allows you to take into account diffusion in all phases for which you have kinetic data; the homogenization model treats all phases in the same way regardless of which phase is entered as type matrix and which phases are entered as type spheroid.

In Graphical Mode, the Homogenization model is automatically selected as the default solver when multiple phases are selected in a region.

In Console Mode, there are two ways in which you can simulate diffusion in a system that contains a dispersed phase, but it is strongly recommended that you use the homogenization model. See "About the Homogenization Model" on page 51.

Simulate diffusion with the homogenization model

About the Examples

To learn more about how to use the software you can open and run the example projects (Graphical Mode) and macro files (Console Mode).

Graphical Mode Examples

Graphical Mode examples are available for Thermo-Calc and the add-on Diffusion Module (DICTRA) and Precipitation Module (TC-PRISMA). These are in the format of project files (*.tcu) and are included together in the same folder.

Console Mode Examples

Console Mode examples are available for Thermo-Calc and the Diffusion Module (DICTRA). The macro files are in the format of *.TCM and .DCM, respectively.
There are other file types when you are working in Console Mode. See "Thermo-Calc Console Mode File Types" on page 2 in the Console Mode Command Reference, and "About the DICTRA File Formats" on page 3 in the Diffusion Module Quick Start Guide.

## Diffusion Module (DICTRA) Licenses

You can start (and install) the Thermo-Calc software without a valid license but you cannot do any calculations. To show information about the available and installed licenses, from the main menu select Help → Show License Info.

### Network License Restrictions

The Diffusion Module (DICTRA) requires a separate license. If you are using a network client installation of Thermo-Calc, then you may not be able to use the Diffusion Module (DICTRA) even if you have access to a license server with a valid network license file. This is because other clients who are part of your network installation may have checked out all instances of the network license allowed to run simultaneously.

#### Graphical Mode and Entering Demo Mode

In Graphical Mode only, and for users with a network license, you must exit Thermo-Calc to release the license for use. The license is checked out as soon as you add a Diffusion Calculator and remains unavailable to others until you exit the program.

With a network license, and if as per above you temporarily do not have access to a license, you are automatically put into Demo Mode. Then the Diffusion Calculator is available with two elements. See "Diffusion Module Options in Graphical Mode" on page 20 for more information.

### Console Mode

In Console Mode, a license is checked out when you enter the DICTRA module and it is checked back in when you leave the module. You do not need to exit the program.
If you are working in Console Mode and try to enter DIC_PARROT after having been in the PARROT module earlier in the session, a message displays: DICTRA PARROT disabled after using PARROT. To enter DIC_PARROT relaunch Thermo-Calc and enter these commands starting in the SYS module: GOTO_MODULE DIC_PAR.

Search the online help or see the Thermo-Calc Installation Guide for more about network licenses.
Working in Graphical Mode

As described in "About This Guide" on page 3, the Graphical Mode version of the Diffusion Module is integrated into the Thermo-Calc desktop. The main functionality is contained in the Diffusion Calculator activity node, which is combined with other activity nodes such as the System Definer and Plot Renderer to create the diffusion simulation.

When you create a simulation in Graphical Mode, most of the information you need to get started is indicated below and included in this documentation set.

You may find it useful to review the logic of the set up of a Console Mode simulation. However, if you are a new user then Graphical Mode is the recommended starting point.

This User Guide

Read the topics in the "Introduction to the Diffusion Module (DICTRA)" on page 2 and if necessary see "Tips for a Successful Diffusion Simulation" on page 60.

Quick Start Guide

If you are a new user, a good starting point is to go through the examples found in the "Diffusion Module (DICTRA) Quick Start Guide - Graphical Mode" on page 1.

Thermo-Calc User Guide

- "The Graphical Mode Interface" on page 27
- "Graphical Mode Activities" on page 56
- "Diffusion Calculator" on page 87
- "Diffusion Calculator Plot Renderer " on page 108

Diffusion Module Options in Graphical Mode

The Diffusion Module is an add-on module to the core Thermo-Calc software.

A separate license is required to perform calculations for more than two elements. Without it you are able to use the module in Demo Mode. This is not available in Console Mode. See "Demonstration (Demo) Mode" on page 22 to learn more.
Diffusion Simulation Template

A **Diffusion Simulation** template is available to all Thermo-Calc users when in Graphical Mode.

If you are using the Diffusion Module in Demo Mode, see "Demonstration (Demo) Mode" on the next page for what is available to you. Even if you have a license, you may find yourself in Demo Mode if you have a network license and all the licenses are checked out. See "Diffusion Module (DICTRA) Licenses" on page 18 for more information.

**Using the Template**

When you first open Thermo-Calc in Graphical Mode, on the **My Project** window, click the **Diffusion Simulation** button to add a **System Definer**, **Diffusion Calculator** and **Plot Renderer** to the **Project** tree.

Click the **Diffusion Simulation** icon in the Templates window to add **THESE NODES** to the Project.

"Creating a "Project from a Template" in the Thermo-Calc User Guide or search the Online Help.

**Diffusion Calculator**

A Diffusion Calculator allows you to set the conditions for your calculation that define the geometry, regions, phases, grids, composition profiles and the thermal profile, plus additional options. Many of the settings are automatically set as you define your system. Details about this activity are described in "Diffusion Calculator" on page 87 in the Thermo-Calc User Guide.

**Demo Database Packages for the Examples Collection**

Both a thermodynamic and mobility database are required to run the Diffusion Module simulation. If you have a Diffusion Module (DICTRA) license you can run all the examples
because the demonstration database packages are included with your installation.

Select the database packages from the **System Definer Configuration** window to run a simulation.

If you are in Demo Mode, see "Demonstration (Demo) Mode" below to learn more.

**EXAMPLE**

![Configuration window](image)

**Demonstration (Demo) Mode**

The Diffusion Module and two examples are available to all Thermo-Calc users but only for simulations with two elements. If you do not have a license for the then you are in *Demo Mode* when using the Diffusion Calculator or Diffusion Simulation template.

**Diffusion Simulation Template**

When you are in DEMO mode, in the **Templates** area this is indicated by the text under the logo.

![Diffusion Simulation DEMO](image)

**Diffusion Calculator**

If you are experimenting with the Diffusion Calculator in Demo Mode, you may have access to a variety of databases based on your license. However, you can only define two elements for a demo simulation.

If you define more than two elements on the System Definer, when you go to the Diffusion Calculator, the **Perform** button is unavailable and the tooltip explains why.

**EXAMPLE**
Even if you have more than two elements, the Plot Renderer **Perform** button is still available. However, if you click the button and try to run the simulation the Event Log displays an error message.

**Basic Terminology in Graphical Mode**

These terms are specific to working in Graphical Mode. The overall simulation in Console Mode is comparable but there are some differences in terminology and functionality.

**Region**

In Graphical Mode, a system consists of one *cell* with one or multiple *regions* in which the diffusion problem is to be solved.

**Grid Types**

These grid types are used in diffusion simulations: linear, geometric and double geometric. When you are setting up the simulation, in either Console Mode or Graphical Mode, a region must have a grid defined.

<table>
<thead>
<tr>
<th>Linear</th>
<th>Geometric</th>
<th>Double geometric</th>
</tr>
</thead>
</table>

**Phases**

Each region must contain at least one *phase*. The so-called *homogenization model* is used if multiple phases are added inside a region, then the average properties of the local phase mixture is used. Phase(s) can also be added to interphases of region(s) and then only participate in the simulation if the driving force for precipitation of the phase exceeds a predefined value. A new region is then created where the name of the region is set to the name of the phase but with $R_+$ added as a prefix.
Composition

Two types of composition variables are used in the configuration of the Diffusion Calculator: weight fraction or mole fraction.

The u-fractions are used in the diffusion equations. The u-fraction of a component $k$ is defined as

$$u_k = \frac{x_k}{\sum_{j \in S} x_j}$$

The summation is only performed over the substitutional elements. The choice of the volume fixed frame of reference in the calculations make it convenient to use a composition variable which is related to the volume. The definition of the u-fraction is based upon the assumption that a species may or may not contribute to the volume of a phase. An interstitial element is assumed to not contribute to the volume. Substitutional elements are assumed to contribute equally to volume. Weight fraction, mole fraction or u-fraction can be used when plotting the results from a simulation.

Geometry and Coordinates

The Diffusion Module (DICTRA) can only handle diffusion problems where compositions vary along one spatial coordinate. The geometry of your system can be planar, cylindrical or spherical.

The planar geometry corresponds to an infinitely wide plate of a certain thickness. If the system has a planar geometry then the lower boundary (the zero coordinate) is at the left side of the system. The upper boundary (the coordinate with the highest value) is at the right side of the system.

Boundary Conditions

Boundary conditions are conditions that define how matter behaves at the boundaries of your system. By default, matter is not allowed to cross the system boundaries.

- In Graphical Mode, the boundary conditions cannot be changed and this corresponds to a closed system.

- However, if this is required for your simulation, you can change this setting in Console Mode for both the lower boundary (left side/centre) and the upper boundary (right side/surface) of the system.
See "Setting up a Diffusion Simulation in Graphical Mode" below then go to "Working in Graphical Mode" on page 20 for links to the other relevant content.

Setting up a Diffusion Simulation in Graphical Mode

When you are using the Graphical Mode version of the Diffusion Module (DICTRA), the steps to set up a simulation are a combination of adding Activity nodes (the System Definer, Diffusion Calculator and Plot Renderer) and then defining the applicable settings for each of these nodes in a Configuration window.

The following is a general overview of the steps to set up the simulation.

1. Use the Diffusion Simulation template to add the System Definer, Diffusion Calculator and Plot Renderer activity nodes.

2. On the System Definer, you select the thermodynamic and kinetic databases, add elements and phases, and generally define the system.

3. On the Diffusion Calculator, you set the geometry (by default the geometry is planar), add region(s) and enter grid(s) and phase(s) in the region(s). You then enter composition(s) of phase(s).

4. On the Plot Renderer, you choose what to plot and then run the simulation, i.e. you Perform the sequence of nodes you have defined in the tree to produce the output simulation.

Go to "Working in Graphical Mode" on page 20 for links to the relevant content to continue.
Working in Console Mode

In this section:

- Opening DICTRA in Console Mode ............................................................... 27
- Opening a Macro File (Console Mode) ....................................................... 27
- About the Console Mode File Formats ....................................................... 29
Opening DICTRA in Console Mode

1. Open Thermo-Calc in Console Mode.

By default, Thermo-Calc opens in the most recently used state. If it opens in Graphical Mode, on the toolbar, click **Switch to Console Mode**.

2. In the **SYS module**, type **GOTO_MODULE DICTRA**. For a list of all the available commands in the current module, at the prompt type a question mark (?) and press <Enter>. For a description of a specific command, type **Help** followed by the name of the command.

Opening a Macro File (Console Mode)

You can open the macro files (*.TCM or *.DCM files) in different ways.

- From the main menu,
- Using a command, or
- By dragging and dropping the file into the Console window.

**How to Open an Example Macro**

To open a specific macro file from the Examples folders included with your installation:

1. Open Thermo-Calc.
2. Confirm you are in Console Mode. If not, click the **Switch to Console Mode** button.
3. From the main menu, select **File → Open Examples** or **Help → Open Examples**. The Console Mode folder opens (these are the Thermo-Calc macro files).
4. Click the **Up One Level** button.
5. Double-click the DICTRA folder.

   The three Quick Start example macros and the PDF guide are in the first folder called Beginner Guide.

**How to open a macro with a command**

At the SYS prompt, type MACRO_FILE_OPEN and press <Enter>. In the file dialogue window that opens, locate and select the macro file on your computer.

**how to open a macro file by Dragging and Dropping it into Console Mode**

For example, navigate to the Beginner Guide folder and then drag the file from its location into Thermo-Calc Console window.

**EXAMPLE**

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>simplest_dictra.DIC</td>
<td>DICTRA DIC file</td>
</tr>
<tr>
<td>simplest_dictra.dcm</td>
<td>DCM File</td>
</tr>
<tr>
<td>simple_reactive.DIC</td>
<td>DICTRA DIC file</td>
</tr>
<tr>
<td>simple_reactive.dcm</td>
<td>DCM File</td>
</tr>
<tr>
<td>simple_moving_boundary.DIC</td>
<td>DICTRA DIC file</td>
</tr>
<tr>
<td>simple_moving_boundary.dcm</td>
<td>DCM File</td>
</tr>
<tr>
<td>simple_moving_boundary2.DIC</td>
<td>DICTRA DIC file</td>
</tr>
<tr>
<td>simple_moving_boundary2.dcm</td>
<td>DCM File</td>
</tr>
<tr>
<td>simple_moving_boundary3.DIC</td>
<td>DICTRA DIC file</td>
</tr>
<tr>
<td>simple_moving_boundary3.dcm</td>
<td>DCM File</td>
</tr>
<tr>
<td>multiphase_example.DIC</td>
<td>DICTRA DIC file</td>
</tr>
<tr>
<td>multiphase_example.dcm</td>
<td>DCM File</td>
</tr>
</tbody>
</table>

Drag the file from its location on your computer and drop it into the Thermo-Calc Console window.

The macro automatically runs after you drop it into the Console window.

**EXAMPLE**
Double-click to Open a File

Navigate to the macro file location, for example where each set of file examples is in its own folder. When you double-click, it opens the file in a new instance of Thermo-Calc.

About the Console Mode File Formats

The Diffusion Module (DICTRA) in Console Mode uses different file formats: log files (*.LOG), macro files (*.DCM) and workspace files (*.DIC).

Also see "Graphical Mode vs Console Mode" on page 7. If you are working with Thermo-Calc in Console Mode, see "Thermo-Calc Console Mode File Types" on page 2 in the Console Mode Command Reference.
**Log Files**

Log files (*.LOG) are plain text files used to save a sequence of commands. Log files can be edited in a text editor.

- To start saving your input into a log file, in the SYS module type `SET_LOG_FILE`, followed by the name of the file that you want to save your command sequence to.
- When creating a command sequence, and if you want to save the output in the log file, type `SET_ECHO` before `SET_LOG_FILE`. This is useful if you later want to use the log file as a macro file because you the macro file lists the full commands instead of only the short names.

**Macro Files**

Macro files (*.DCM) are plain text files used to save a sequence of commands that can be loaded and executed. Macro files can be edited in a text editor. When creating a command sequence, you add comments to the file by starting a line with `@@`.

- To run a macro file, in the SYS or DICTRA module type `MACRO_FILE_OPEN`, followed by the name of the macro file. DICTRA runs the `MACRO_FILE_OPEN` sequence that the file contains.
- To remain in the console and keep working in the DICTRA module, in the SYS, DICTRA, POLY, or POST module add the command `SET_INTERACTIVE` at the end of the macro file. Alternatively, use `EXIT` as the final command.

**Workspace Files**

Workspaces files (*.DIC) allow you to save all the data in your current workspace. A workspace contains all the data, specified settings and the result of any calculations performed. The saved data includes original and modified thermodynamic data, the last set of conditions and options, and the results of any simulations.

- At the `DIC` prompt use `SAVE_WORKSPACES`.
- To load the data and calculation results of a workspace file, at the `DIC` prompt use `READ_WORKSPACES`. 
Overview of a System

In this section:

- Typical Console Mode Workflow ................................................................. 32
- About Regions and Grids ............................................................................ 32
- About System, Cells and Regions .............................................................. 33
- About Phases ................................................................................................. 33
- About Composition Variables ..................................................................... 34
- About Global Conditions ............................................................................. 35
- About Boundary Conditions ........................................................................ 35
- About Geometry and Coordinates .............................................................. 37
- About Operators and Functions ................................................................. 38
Typical Console Mode Workflow

The basic work flow in Console Mode is as follows.

1. You are in the SYS module when you start Thermo-Calc in Console Mode.
2. In the DATA module you define the system. Before performing a calculation, you must define your system and retrieve thermodynamic and kinetic data. The data is retrieved from the database files.
3. The data needed to describe a system is sent to the GIBBS module. When the data is in GIBBS, the software can access the retrieved data. The retrieved data is accessible to the POLY module, which is involved in simulations that require that equilibrium calculations are performed.
4. In the DICTRA_MONITOR you:
   a. Set the initial state of the system and define its geometry and boundary conditions. The simplest system has one cell that contains one region, but you may put additional regions in a cell and put additional cells in your system.
   b. Define the phases each region contains.
   c. Set various parameters for the numerical calculations.
   d. Run the simulation from within the DICTRA_MONITOR.
5. In the POST module you plot and visualize your data.
   a. Choose the data to plot
   b. Change the appearance of the diagram
   c. Save the diagram as an image file (available in several formats).

About Regions and Grids

Also see "Creating Regions and Gridpoints" on page 43.

For Graphical Mode, see "Diffusion Module Terminology in Graphical Mode" on page 3.

A region contains one or more phases. If a region contains several phases one of those must be entered as a matrix phase whereas the others are entered as spheroid.

A region must also contain a number of grid points. The composition is only known at these grid points and the software assumes that the composition varies linearly between them. The amount and composition of all the phases present at a single grid point in a certain region are those given by thermodynamic equilibrium keeping the over-all composition at the grid point fixed.
These grid types are used in diffusion simulations: linear, geometric and double geometric. When you are setting up the simulation, in either Console Mode or Graphical Mode, a region must have a grid defined.

<table>
<thead>
<tr>
<th>Grid Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linear</td>
</tr>
<tr>
<td>Geometric</td>
</tr>
<tr>
<td>Double geometric</td>
</tr>
</tbody>
</table>

**About System, Cells and Regions**

For Graphical Mode, see "Diffusion Module Terminology in Graphical Mode" on page 3.

A system normally consists of one *cell*. This cell contains one or several *regions* in which the diffusion problem is to be solved. A system of diffusion equations is solved for each region. The size of the system is the sum of sizes of all the regions in all the system’s cells.

The interface between two regions typically moves as the result of a simulation, that is, the regions grow or shrink. Such an interface is called an *inner interface*. The boundary of a cell is called an *outer interface* and the condition of this type of interface may be affected by the choice of boundary conditions.

For some simulations it is useful to have several cells in a system. Matter can move between cells. However, it is assumed that there is diffusional equilibrium between all cells (this means that there are no differences in diffusion potentials between cells). In other words, the size of a cell is fixed during the simulation.

By default this is a *closed system*, which means that matter cannot move across its boundaries. However, you can change this setting for both the *lower boundary* (left side/centre) and the *upper boundary* (right side/surface) of the system. You can also set these boundary conditions to vary as a function of time, temperature and/or pressure.

**About Phases**

Also see "Entering Phases in Regions" on page 44 and "Specifying Phase Compositions in a Region" on page 45.

For Graphical Mode, see "Diffusion Module Terminology in Graphical Mode" on page 3.
Each region contains one or more phases. A phase can be of the matrix, spheroid or lamellar type. A phase can be introduced with the status active (the default) or inactive.

An inactive phase is a phase which does not participate in the calculations until it is stable. If a phase is inactive, then the driving force for precipitation of the phase is continuously monitored. When the driving force exceeds a predefined positive value, the phase take parts in the simulation and the phase automatically becomes active. A new region is then created and the formerly inactive phase is entered as the matrix phase of the new region. The name of the region is set to the name of the phase that just became active but with R_ added as a prefix.

**Region Phase Types**

<table>
<thead>
<tr>
<th>Phase type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Matrix</td>
<td>The region’s primary phase. If there is only one phase in a region, then that phase is automatically a matrix.</td>
</tr>
<tr>
<td>Spheroid</td>
<td>Used to treat one or several dispersed phases in a matrix. Unless the homogenization model is invoked, which happens automatically when a spheroid phase is entered, then diffusion is only considered in the matrix phase; the spheroid phases then only act as sources and sinks of the diffusing elements.</td>
</tr>
<tr>
<td>Lamellar</td>
<td>Used to simulate the growth of a eutectic or eutectoid region. The software only treats the growth, not the dissolution, of such a region. The <em>pearlite calculation model</em> is used for a phase that is lamellar.</td>
</tr>
</tbody>
</table>

**About Composition Variables**

For Graphical Mode, see "Diffusion Module Terminology in Graphical Mode" on page 3.

Two types of composition variables are used within the program: site-fractions and u-fractions, although you can also use weight fraction or mole fraction, for example.

The *site-fractions* are used to set up the problem and interface with POLY-3 (in Console Mode). The site fraction of a species \( k \), \( y_k \), is the fraction of equivalent lattice sites occupied by species \( k \). It is the only concentration variable that uniquely defines the composition and the constitution of a phase and it is necessary to use the site fraction in the storage of the data during a simulation.
The *u-fractions* are used in the diffusion equations. The *u*-fraction of a component $k$ is defined as

$$u_k = \frac{x_k}{\sum_{j \in S} x_j}$$

The summation is only performed over the substitutional elements. The choice of the volume fixed frame of reference in the calculations make it convenient to use a composition variable which is related to the volume. The definition of the *u*-fraction is based upon the assumption that a species may or may not contribute to the volume of a phase. An interstitial element is assumed to not contribute to the volume. Substitutional elements are assumed to contribute equally to volume.

**About Global Conditions**

There are several global parameters that influence the diffusion rate in simulations: temperature, pressure and heat content removal. These parameters are defined as functions of time. The temperature can also be a function of the spatial position, and heat content removal can be a function of temperature or pressure.

For heat content removal, the amount of extracted heat per time unit is normalized and the size of the system is normalized to one mole of atoms.

Also see "Setting Global Conditions" on page 42 in the *Thermo-Calc User Guide*.

**About Boundary Conditions**

Boundary conditions are conditions that define how matter behaves at the boundaries of your system. By default, matter is not allowed to cross the system boundaries.

In Graphical Mode, the boundary conditions cannot be changed.

In Console Mode you can change this setting for both the lower boundary (left side/centre) and the upper boundary (right side/surface) of the system.

Also see "SET_CONDITION" on page 36 in the *Diffusion Module Command Reference*. 
## Boundary Condition Descriptions

<table>
<thead>
<tr>
<th>Boundary condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FIX_FLUX_VALUE</td>
<td>Enter functions that yield the flux times the molar volume for the independent components. Can be a function of time, temperature and pressure. Use this boundary condition with caution as it may cause unrealistic compositions.</td>
</tr>
<tr>
<td>STATE_VARIABLE_VALUE</td>
<td>A legal equilibrium condition expression in POLY-3 syntax that reduces the degrees of freedom. This type should be used with care as no checks are done in advance to determine if it is a legal expression. Do not specify the conditions for temperature and pressure here as these are taken from the global conditions.</td>
</tr>
<tr>
<td>POTENTIAL_FLUX_FUNCTION</td>
<td>Use to take into account the finite rate of a surface reaction. The flux for the independent components must be given in the format: [ J_k = f_k(T,P,TIME) \times \left[ \text{POTENTIAL}^N_k - g_k(T,P,TIME) \right] ] The functions ( f ) and ( g ) may have time (TIME), temperature (T), and/or pressure (P) as arguments. ( N ) is an integer. The potentials are those with user defined reference states.</td>
</tr>
<tr>
<td>ACTIVITY_FLUX_FUNCTION</td>
<td>Use to take into account the finite rate of a surface reaction. The flux for the independent components must be given in the format: [ J_k = f_k(T,P,TIME) \times \left[ \text{ACTIVITY}^N_k - g_k(T,P,TIME) \right] ] The functions ( f ) and ( g ) may have time (TIME), temperature (T), and/or pressure (P) as arguments. ( N ) is an integer. The activities are those with user-defined reference states.</td>
</tr>
</tbody>
</table>
Boundary condition | Description
---|---
ITERATIVE_ACTIVITY_FLUX_FUNCTION | Same as ACTIVITY_FLUX_FUNCTION but an iterative scheme is used to determine the flux. Use this if the other command encounters problems.
CLOSED_SYSTEM | Corresponds to a fix flux value, which is set to zero at all times. This is the default boundary condition.
MIXED_ZERO_FLUX_AND_ACTIVITY | The flux of selected components is set to zero and the activity of others may be set to a prescribed value.
GAS | This option can cause a change in system volume. The flux of selected components is set to zero and the activity of others can be set to a prescribed value. Use this to treat an expanding system, e.g. the growth of an external oxide scale.

About Geometry and Coordinates

Also see "Specifying the Geometry" on page 46.

The Diffusion Module (DICTRA) can only handle diffusion problems where composition vary along one spatial coordinate. The geometry of your system can be planar, cylindrical or spherical.

**Planar Geometry**

This geometry corresponds to an infinitely wide plate of a certain thickness. If the system has a planar geometry then the lower boundary (the zero coordinate) is at the left side of the system. The upper boundary (the coordinate with the highest value) is at the right side of the system.

**Cylindrical and Spherical Geometries**

- Cylindrical geometry corresponds to an infinitely long cylinder of a certain radius.
- Spherical geometry corresponds to a sphere with a certain radius.

By default for both geometries, the lower boundary (the zero coordinate) is at the centre of the cylinder/sphere. The upper boundary (the coordinate with the highest value) is at the surface of the cylinder/sphere. You can enter a left most coordinate that is larger than zero to allow for tube and hollow sphere geometries.
About Operators and Functions

Sometimes you need to specify functions when setting up a system. For example, to make global and boundary conditions vary as a function of time. The following operators can be used in writing functions. Use a semi-colon (;) to mark the end of a function.

Available Operators for Writing Functions

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>+, -, *, /</td>
<td>addition, subtraction, multiplication, division</td>
</tr>
<tr>
<td>**</td>
<td>exponentiation, raising one quantity to the power of another, e.g. (x^2).</td>
</tr>
<tr>
<td>SQRT(X)</td>
<td>square root</td>
</tr>
<tr>
<td>EXP(X)</td>
<td>Exponential</td>
</tr>
<tr>
<td>LOG(X)</td>
<td>natural logarithm</td>
</tr>
<tr>
<td>LOG10(X)</td>
<td>base 10 logarithm</td>
</tr>
<tr>
<td>SIN(X), COS(X), ATAN(X)</td>
<td>sinus, cosinus and arctangent</td>
</tr>
<tr>
<td>SIGN(X)</td>
<td>sign function</td>
</tr>
<tr>
<td></td>
<td>SIGN(X) is -1 when X&lt;0, is 0 when X=0 and is 1 when X&gt;0.</td>
</tr>
<tr>
<td>ERF(X)</td>
<td>error function</td>
</tr>
</tbody>
</table>
Creating a DICTRA Simulation

These topics describe in general terms what options you have when setting up your diffusion simulation in Console Mode.

In this section:

Defining a System in Console Mode ......................................................... 40
Setting Up and Running a Simulation .......................................................... 41
Setting Global Conditions ........................................................................... 42
Specifying Time-Dependent Profiles ............................................................ 42
Creating Regions and Gridpoints ................................................................. 43
Entering Phases in Regions ......................................................................... 44
Specifying Phase Compositions in a Region .................................................. 45
Specifying the Geometry ........................................................................... 46
Setting Boundary Conditions ..................................................................... 47
Adding (Creating) Cells ............................................................................. 47
Importing a Scheil Segregation Profile .......................................................... 48
**Defining a System in Console Mode**

Define your system with as few elements (components) and phases as possible; keep the simulation as simple as possible to avoid making the simulation unsolvable.

In order to perform a simulation in the Diffusion Module, both a thermodynamic database and a kinetic database is needed. The thermodynamic database is a normal Thermo-Calc database, whereas the kinetic database contains information about the atomic mobility of individual elements in various phases.

See the "Database Commands" on page 11 in the *Thermo-Calc Console Mode Command Reference*.

1. Open Thermo-Calc in Console Mode. At the SYS prompt, type GOTO_MODULE DATA.
2. Use SWITCH_DATABASE to select databases. Unless you directly specify the name of the database as a parameter to the command, the available databases are listed. Specify the one to use.
3. Use DEFINE_ELEMENTS followed by a list of the elements that you want in your system. (To list the elements available in the current database, type LIST_DATABASE Elements.)
4. Use REJECT with the keyword, Phases to make sure that unnecessary phases are not retrieved from the database.
5. Use RESTORE with the keyword, Phases to restore any phases that have been excluded.
6. Use GET_DATA to read from the database and send the thermodynamic data about your system to the GIBBS and DICTRA workspace.
7. Use APPEND_DATABASE to select the database from which you want to retrieve kinetic data.
8. Define your elements and specify whether to reject and restore any phases. Do this in exactly the same way as you would for the thermodynamics data (see steps 2, 3 and 4).
9. Use GET_DATA to read from the database and add the kinetic data to the thermodynamic data that already exists in the GIBBS and DICTRA module workspace.
10. Use APPEND_DATABASE again to add thermodynamic or kinetic data from another database. When all the data needed is retrieved, you can start using the DICTRA module.
Setting Up and Running a Simulation

1. Before you can set up and start a simulation, you must have retrieved thermodynamic and kinetic data and defined your system. See "Defining a System in Console Mode" on the previous page.

2. Set conditions that hold globally in the system using SET_CONDITION Global. Normally, this is the temperature condition.

3. Enter a region into the current cell using ENTER_REGION. Give the region an arbitrary name. If the region that you create is not the cell’s first region, then by default it is attached to the right side of the last region created in the cell.

4. For each region, use ENTER_GRIDCOORDINATES to specify the region’s size (width) as well as the type of grid and the number of grid points to be used in the region. The size is specified in meters.

5. Use ENTER_PHASE_IN_REGION to enter a phase into a region. Specify whether the phase is active/inactive, which type of phase it is, and what the name of the phase is.

6. Use ENTERCOMPOSITIONS to specify the initial composition of a phase that you have entered in a region. You can specify the composition in terms of site fraction, mole fraction, mole percent, weight fraction, weight percent or u-fraction. The composition profile may be entered by a user or be read from a file.

7. Use SET_CONDITION Boundary to set non-default boundary conditions.

8. Use ENTER_GEOMETRICAL_EXPONENT to enter the geometrical exponent that defines the geometry of the system. If you do not specify the geometrical exponent, then it is assumed that the system has a planar geometry.

9. Use SET_SIMULATION_TIME to set the simulation time.

10. If you want to use a specific model for the simulation calculations, then set the DICTRA module to use a COARSENING_MODEL, PARA_EQUILIBRIUM_MODEL, HOMOGENIZATION_MODEL or GB_MODEL. Also see "About the Pearlite Model " on page 54.

11. You are now ready to run the simulation. However, it is recommended that you use SAVE_WORKSPACES to save the setup before running the simulation.

12. Use SIMULATEREACTION to start the simulation. To ensure that the simulation is run with default settings (answer Y), otherwise you may be prompted to specify certain values during the running of the simulations (if phases appear or disappear in the simulation).
Setting Global Conditions

Use "SET_CONDITION" on page 36 and choose Global. Global conditions include temperature (T), heat content removal (Q) and pressure (P), and these reduce the degrees of freedom for equilibrium calculations.

Also see "About Global Conditions" on page 35.

If the heat content removal is specified then only the initial temperature should be entered with the "SET_INITIAL_TEMPERATURE" on page 39 command.

- In practice, the pressure is rarely specified. By default the pressure is assumed to be constant and equal to 1 bar.
- For each condition, you can define a profile over time that consists of several intervals of time, or ranges, with each range having its own function to define the value of the condition.
- Temperature can be entered as a function of time (TIME) and/or spatial coordinate (X). The pressure condition can be defined as a function of time (TIME). The heat content removal can be defined as a function of temperature (T), pressure (P) and/or time (TIME).

For example, the following function could specify a cooling rate if it is used to specify how the global condition temperature (T) changes with time (TIME) during a certain range: 1900-1*TIME;

- Temperature can also be entered as time/temperature pair values.

Specifying Time-Dependent Profiles

In the DICTRA module you are often prompted to specify a time-dependent profile for a condition.

To define the profiles or intervals, enter information as follows and refer to the Diffusion Module (DICTRA) Command Reference:

LOW TIME LIMIT
To determine the time when the function starts to apply.

HIGH TIME LIMIT
To determine the time when the function stops applying. Use an asterisk (*) to set the high limit to the time when the simulation ends.

ANY MORE RANGES
Enter \textit{Y} to specify an additional range with a time-dependent function, which starts to apply at the time step after the high time limit of the previous range is reached.

\textit{Creating Regions and Gridpoints}

Enter a new region by specifying its name and, unless it is the first region, how it should be located with respect to one already existing region. The size of a region is determined when a grid is entered into the region.

Also see "About System, Cells and Regions" on page 33 and "About Regions and Grids" on page 32 and "DICTRA Commands" on page 3 in the Diffusion Module (DICTRA) Command Reference.

\textbf{Creating a Region}

2. Use \texttt{ENTER\_REGION} to enter a region into the system.
3. Enter an arbitrary name for the region at the \texttt{Region name} prompt.
4. If this is the first region you create in your system, then you are finished. Otherwise, continue to the next step.
5. Enter the name of an already existing region to which the new region is attached.
6. Specify whether the new region should be \texttt{Attached} to the right of the existing region. Enter \textit{Y} to attach to the existing region’s right side or \texttt{N} to attach it to its left side.
7. If the system has a cylindrical or spherical geometry, then this is a question of whether to put the new region outside the existing region, so that the new region surrounds the existing one, or to put it at the existing region’s centre, so that the existing region surrounds the new region.

\textbf{Adding Gridpoints to a Region}

This topic describes how you specify the size and grid point distribution to use in a region.

1. Complete "Defining a System in Console Mode" on page 40 and Creating a region.
2. Use \texttt{ENTER\_GRID\_COORDINATES} followed by the name of the region.
3. Specify the width of the region in meters.
4. At the \texttt{Number of points} prompt enter the number of grid points for the region.
5. Specify the type of grid point distribution to have in the region.
• *Linear* for an equally spaced grid.
• *Read_Point_by_Point* to read a number of specific grid points from a data file.
• *Geometric* for a grid that yields a varying density of grid points in the region. Enter the *Value of R* in the geometrical series, which determines the distribution. A geometrical factor larger than one yields a higher density of grid points at the lower end of the region and a factor smaller than one yields a higher density of grid points at the upper end of the region.
• *Double_Geometric* to have a high number of grid points in the middle or at both ends of a region. Specify two geometrical factors. *Value of R* in the geometrical series for lower part of region for the distribution in the lower (left) part of a region, and *Value of R* in the geometrical series for upper part of subregion for the distribution in the upper (right) part of a region.

**Entering Phases in Regions**

There is no supersaturation locally within a given region.

When defining a region you need to enter one or more phases into the region. The number and type of phases depends on the simulation you want to run.

• To simulate diffusion of components within one phase, enter one matrix phase into the region.
• To simulate how an interface between regions moves, enter two regions with at least one phase in each.
• To simulate growth of one or more dispersed phases in a matrix phase, enter one matrix phase and one or more spheroid phases.

Also see "About Phases" on page 33 and "DICTRA Commands" on page 3 in the Diffusion Module (DICTRA) Command Reference.

**Entering Phases in a Region**

1. Complete "Defining a System in Console Mode" on page 40 and "Creating Regions and Gridpoints" on the previous page.
2. Use ENTER_PHASE_IN_REGION. Specify whether the phase is to be Active or Inactive.
3. For an inactive phase, specify the following:

• Enter the name of the region and the side of that region which the phase is attached
• Enter the required driving force (evaluated as $DGM^1$ (phase) in POLY-3) to be used for determining whether an inactive phase is stable.
• Enter the CONDITION TYPE that the phase boundary condition should be set to if the inactive phase becomes stable. (Inactive phases are only considered in the simulation calculations once it is stable.)

4. For an active phase specify the following:

• REGION NAME for the region in which the phase is to be entered.
• PHASE TYPE: Matrix, Lamellar or Spheroid. Spheroid is only available if a MATRIX phase is created first. You can only enter one matrix phase in each region.
• Enter the PHASE NAME. You can append a hash sign (#) and a digit at the end of the phase name to designate the composition set number (e.g. FCC#2). If you do not append this and the phase has more than one composition set, then you are prompted to specify a composition set number.

**Specifying Phase Compositions in a Region**

When you specify the composition of a phase, you do this by specifying the composition of the phase within its region—a composition profile.

Also see "About Phases" on page 33 and "DICTRA Commands" on page 3 in the Diffusion Module (DICTRA) Command Reference.

**Specifying Phase Compositions in a Region**

1. Complete "Defining a System in Console Mode" on page 40, "Creating Regions and Gridpoints" on page 43 and "Entering Phases in Regions" on the previous page.
2. Use ENTER_COMPOSITIONS to enter a composition of a phase in a certain region.
3. Enter the Region name of the region in which the phase has previously been entered.
4. Enter the Phase name of the phase whose composition you want to specify.
5. If the phase is spheroid, then for Use equilibrium value enter Y to automatically

\(^1\)DGM is the POLY variable for the driving force that is already divided by RT, and it is dimensionless.
calculate the equilibrium fractions of the phase and its constitution at the start of the simulation. Specify the initial Volume fraction of the spheroid phase.

6. Enter the Dependent component. Sometimes the dependent component is automatically set and there is no prompt.

7. Enter a Composition type for the constitution of the phase. The options are: SITE_FRACTION, MOLE_FRACTION, MOLE_PERCENT, WEIGHT_FRACTION, WEIGHT_PERCENT, and U_FRACTION.

8. Enter the Type of composition profile (that is, the type of composition profile). The options are:

   - **Linear** to have an equally spaced composition distribution. Specify the composition at the first (leftmost) grid point (Value of first point) and at the last (rightmost) grid point (Value of last point).

   - **Read_point_by_point** to read the composition at each grid point. The specification of these can either be read from a DATA-file that you are prompted to select or entered directly at the terminal. If you want to enter them at the terminal, then enter **READ_POINT_BY_POINT** and press <Enter>.

   - **Geometric** for a distribution that yields a higher concentration of the component at the lower end of the region if a geometrical factor larger than one is given and a higher concentration at the upper end of the region if the factor is smaller than one. You are prompted to specify the Value of R in the geometrical series which determines the distribution.

   - **Function** for the global distance denoted ‘gd’. Useful functions include the error function (erf(gd)) and the heavy-side step function (hs(gd)). For example, the function 3+2hs(x-1e-4) specifies a concentration of 3 at the region’s left side and 5 at the region’s right side, with a sharp step in the concentration profile at 1e-4m=100µm.

**Specifying the Geometry**

By default a DICTRA module system has a planar geometry. To change the geometry of the system, use **ENTER_GEOMETRICAL_EXPONENT** on page 12 followed by a number 0 (planar), 1 (cylindrical) or 2 (spherical).

Also see **"About Geometry and Coordinates" on page 37.**
With a cylindrical or spherical geometry, the system’s zero coordinate (left boundary) is at the centre of the cylinder or sphere. The highest coordinate (right boundary) is defined by the cylinder or sphere radius. If you want a geometry corresponding to a tube or a hollow sphere, then use "SET_FIRST_INTERFACE" on page 39 to locate the system’s left boundary at a coordinate that is greater than zero.

**Setting Boundary Conditions**

Boundary conditions are conditions that define how matter behaves at the boundaries of your system. By default, matter is not allowed to cross the system boundaries.

- In Graphical Mode, the boundary conditions cannot be changed.
- In Console Mode you can change this setting for both the lower boundary (left side/centre) and the upper boundary (right side/surface) of the system.

**Setting Boundary Conditions**

2. Use "SET_CONDITION" on page 36 and choose Boundary. Then specify whether you want to set the LOWER or the UPPER boundary.
3. Specify which condition type you want to set the boundary to.
4. Enter any parameter values that are necessary for the condition type you have chosen.
5. Specify the LOW TIME LIMIT, when the function you define starts to apply.
6. If required, enter the function that is applied during the time interval. For most condition types, the function may have time, temperature and pressure as arguments.
7. Enter the HIGH TIME LIMIT for the interval.
8. If you want to define a different function for another time interval, then enter Y when prompted with ANY MORE RANGES. Then enter another function for the next range.
9. When you have defined functions for all the ranges you want, enter N at the ANY MORE RANGES prompt.

**Adding (Creating) Cells**

If you add cells to a system, then each new cell is always placed next to the system’s right outer boundary. Use the command CREATE_NEW_CELL.
**Importing a Scheil Segregation Profile**

You can import a previously calculated Scheil segregation profile into the Diffusion Module (DICTRA). A Scheil calculation is a conservative estimate of the segregation that occurs during solidification and is useful when estimating the necessary time/temperature for a homogenizing heat treatment.

From a practical point of view it is also a simple and fast calculation compared to a more accurate, but computationally more difficult, diffusion simulation.

![Warning]

In order to limit the computational effort, this feature cannot be combined with the fast diffusers option in the Scheil module.


**Example a7**

In the following example, taken from "About the Examples" on page 17 number a7, the Scheil segregation profile for a ferritic stainless steel (Fe-17Cr-1.4Ni-1Mn) was calculated in the Scheil module in Thermo-Calc.

The profile was then imported into the DICTRA module and a one hour homogenizing heat treatment at 1200 °C was simulated. For the simulation a domain size of 100 µm was assumed, which approximately corresponds to the secondary dendrite arm spacing. The plot below show the initial and final Ni profile.
Diffusion Models in Console Mode

In this section:
**About the Homogenization Model**

This section is specific to Console Mode.

If you enter a spheroid phase when you configure your calculation, then the homogenization model is automatically used. This is useful when you want to simulate long-range diffusion through a multiphase mixture, under the assumption that local equilibrium holds at each node point.

You can also explicitly set the DICTRA module to use the HOMOGENIZATION_MODEL. This way, you can use it when calculating a one phase or a moving boundary simulation.

When the homogenization model is used, simulations are run using an implicit finite volume method to increase numerical stability. Because of this, and other factors, homogenization model simulations generally run slower than other comparable simulations. You can increase or decrease the Degree of implicity when integrating PDEs with the command SET_SIMULATION_CONDITION.

**About the Disperse Model**

This section is specific to Console Mode.

This model can be used to calculate diffusion of a phase that is dispersed in a matrix phase. However, it is recommended that you use the HOMOGENIZATION_MODEL for this type of calculation instead.

The disperse model has the following limitations:

- There must be a continuous matrix phase otherwise the simulation breaks down.
- There is no implicit integration of the partial differential equations (PDEs), leading to a lower accuracy.
- Only diffusion in the matrix phase can be simulated. It is assumed that no diffusion occurs in the dispersed phase.

There is no specific command to activate this model. It is only available if a phase of type "spheroid" is entered in a region.

After a spheroid phase is entered, the homogenization model must explicitly be *inactivated* in order to run the simulation with the dispersed model. To do this, enter the command HOMOGENIZATION_MODEL and then choose \( N \) to make it inactive.
About the Para Equilibrium Model

This section is specific to Console Mode.

The model allows you to calculate a moving phase boundary simulation while assuming that para-equilibrium conditions hold at the boundary. You must explicitly set the DICTRA module to use this model with the PARA_EQUILIBRIUM_MODEL command.

When this model is used, it implies that the local equilibrium assumption is no longer valid and that substitutional components are regarded as one composite component.

You can only simulate a single moving boundary in one cell.

About the Thermomigration Model

This section is specific to Console Mode.

The thermomigration model allows you to simulate thermally induced diffusion in temperature gradients. To use the model, you must set the temperature to depend on the spatial coordinate (x) in your calculation. In addition, you must also enter the heat of transport quantity (Q*) using the ENTER_HEAT_TRANSFER_PARAMETER command. You must enter this parameter separately for each element in each phase.

The model is automatically used once this is done.

See Console Mode example exh3 in the Diffusion Module Examples Guide.

About the Grain Boundary Model (GB_Model)

This section is specific to Console Mode.

You must explicitly set the DICTRA module to use this model with GB_MODEL. This model allows you to simulate grain-boundary and dislocation-assisted diffusion.

The grain boundaries and the dislocations contribute to the total amount of diffusion according to the weighted fractions. The parameters are entered separately for each region in order to allow for different expression for different phases.

Coarsening Processes

This type of simulation is available for Console Mode. See "About the Coarsening Model" on the next page for more information.
You can run a simulation of a coarsening process. In accordance with Lifshitz-Slyozov-Wagner theory, this is done by assuming that the coarsening can be simulated by calculating the growth of a single particle of the maximum size in the particle size distribution.

Simulate a coarsening process

About the Coarsening Model

This section is specific to Console Mode.

The model is based on LSW theory (after Lifshitz, I. M., & Slyozov, V. V. (1961)\(^1\) and Wagner, C. (1967)\(^2\). The model is also described in Gustafson, Å., Höglund, L., & Ågren, J. (1998)\(^3\) and Björklund, S., Donaghey, L. F., & Hillert, M. (1972)\(^4\).

LSW theory is strictly only valid for low volume fractions of the particle phase. The theory predicts that the normalized particle size distribution obtains a constant shape where the largest particles have a radius equal to 1.5 times the average particle radius.

The calculations are performed in one cell on a maximum size particle which thus is assumed to be 1.5 times the size of the average particle size. The matrix phase is on one side in contact with the maximum size particle and on the other the matrix phase is in local

---

\(^3\)'Simulation of carbo-nitride coarsening in multicomponent Cr-steels for high temperature applications'. In Advanced heat resistant steels for power generation. Conference (San Sebastian, Spain 27/04/1998).
equilibrium with an average sized particle. The effect of the surface energy is such that both the maximum size particle as well as the matrix phase grows.

The model allows you to perform coarsening simulations. You must explicitly set the DICTRA module to use this model with the command COARSENING_MODE.

To use this mode, configure the calculation as follows:

- Have one cell only, with a single particle that is 1.5 times larger than the average particle size.
- The matrix phase should be in contact with the maximum size particle on the left/lower side, and then the model specifies a local equilibrium with an average sized particle on the right/upper side.
- The surface energy then results in growth of both the maximum size particle and the matrix phase. Use the SET_SURFACE_TENSION command to enter the surface energy to enable coarsening.

**About the Pearlite Model**

This section is specific to Console Mode.

The pearlite model is automatically used if there is lamellar phase in a region.

**About Cooperative Growth**

This section is specific to Console Mode.

You can simulate the growth of pearlite in alloyed steels by calculating the Eutectoid reaction $\gamma \rightarrow \alpha + \beta$, where $\alpha$ and $\beta$ grow cooperatively as a lamellar aggregate into the $\gamma$ matrix.
Plotting Simulations in the POST Module

You can plot or tabulate the results of your simulation in the POST_PROCESSOR module, also called the POST module and accessed within the DICTRA module. The resulting diagram is on a plot tab in the Console Results window. Once the simulation results are plotted, you can then change its appearance in the Plot Properties window.

In this section:

- Plotting Simulation Results ................................................................. 56
- Editing the Plot Properties ................................................................. 57
- Saving Diagrams ............................................................................. 58
- Tabulating Simulation Results .......................................................... 58
Plotting Simulation Results

Plotting a diagram is to graphically represent how a dependent variable varies with an independent variable. The independent variable is either distance or time.

1. Complete all the steps to run your simulation.
2. At the DIC prompt type POST_PROCESSOR (or just POST).
3. Use SET_DIAGRAM_AXIS to specify the variables to plot on the X- and Y-axes of the diagram. One of the axes must be set to either TIME or DISTANCE.

   For example, to set the X-axis to plot the distance from the lower boundary of the calculation (rather than from the lower boundary of the current region) and the Y-axis to plot the weight-percent composition of the Si element, at the POST prompt type:

   ```
   SET_DIAGRAM_AXIS X DISTANCE GLOBAL
   SET_DIAGRAM_AXIS Y WEIGHT-PERCENT SI
   ```

4. You can specify a Z-axis, which is represented as tick marks on the curve in the XY-plane.
5. When one of the axes is set to TIME or DISTANCE, the variable automatically becomes the independent variable. If you do not want the independent variable plotted along an axis, use SET_INDEPENDENT_VARIABLE and set it to Time or Distance.
6. Simulation calculations depend on both time and a spatial coordinate; these variables must be fixed during the plotting process. Use SET_PLOT_CONDITION to set the variable to keep fixed. These variables can be set as the fixed plot condition:

   - **Time:** The integration time. More than one value can be entered using commas or spaces to separate the values. One graph is plotted for each value.
   - **Distance:** The distance in the system (from the lower boundary).
   - **Interface:** At the location of a certain interface between two phases.
   - **Integral:** The value of the plot condition is integrated over the phase, region or system volume.

7. Use PLOT_DIAGRAM to plot the results. The plot is added as a tab to the Console Results window.
The plot example below is from example exa2a in the "About the Examples" on page 17. Distance is set as the independent variable and the weight-percent of Ni is on the Y-axis. The plot condition is TIME: the plot shows four graphs, each with the spatial distribution of Ni in the region at the time steps 0, 1e5, 3e5, and 10e5.

8. To print the plotted graphs direct to a postscript-file, type Plot and a file name.
9. In the Plot window, right click the diagram and choose Properties to adjust its appearance and colors.

Also see "Editing the Plot Properties" below.

---

**Editing the Plot Properties**

To change the appearance of a plotted diagram, right click the diagram and select Properties. In the Plot Properties window you can change the fonts and colours, and add a title, for example.

You can also change the colour, stroke (solid/dashed/dotted/dash_dot) and line width of a particular series of lines in the plot by double-clicking one of the lines in the series. In this way, you can also toggle whether data points should be shown or not for a series of lines. The crosshair cursor turns into a cursor resembling a pointing hand when it is placed over a line that can be clicked but if you hold down the <Ctrl> key, this does not happen (the cursor continues to be shown as a crosshair).
To configure the default settings for plotting, from the main menu, select Tools→Options. For Console Mode click the Plotting tab.


**Saving Diagrams**

To save a plotted diagram you can do any of the following:

- Use MAKE_EXPERIMENTAL_DATAFILE to save all the data about the plotted diagram in an EXP-file. An EXP-file is a plain text file that describes the diagram in the DATAPLOT graphical language. Note that information about the underlying calculations that the diagram is based on is not saved in an EXP-file.
- Use DUMP_DIAGRAM to save the plot image to a PS, PDF, SVG, EMF, GIF, or PNG file.
- In the Console Results window, right click a plot and select Save Plot. From the list, choose the file format to save it in.
- Use PRINT_DIAGRAM to print a hard copy of the plot results.

See "DICTRA Commands" on page 3 in the Diffusion Module (DICTRA) Command Reference and the DATAPLOT User Guide included with this documentation set.

**Tabulating Simulation Results**

See "DICTRA Commands" on page 3 in the Diffusion Module (DICTRA) Command Reference.

1. Complete all the steps to run your simulation.
2. At the DIC prompt type POST_PROCESSOR (or just POST).
3. Use ENTER_SYMBOL Table to specify the variables to be shown in the table columns. Separate the variables by commas (,).
4. Use SET_INDEPENDENT_VARIABLE to specify the variable that the rows in the table should represent.
5. Use TABULATE to generate the table.
Troubleshooting

The following topics contain some general advice to consider in order to avoid having your simulation fail to converge when you calculate different kinds of simulations in the Diffusion Module (DICTRA).

In this section:

- Tips for a Successful Diffusion Simulation .......................................................... 60
- Moving Boundary Simulations ............................................................................ 62
- Cell Calculations ................................................................................................. 63
- Diffusion in Dispersed Systems .......................................................................... 63
- Cooperative Growth ............................................................................................ 63
Tips for a Successful Diffusion Simulation

Simplify your Simulation as much as possible

For example, if you have an alloy with five or six elements, first run a simulation with only the main elements. When this simulation works, you can then add more elements as necessary.

Start with a low accuracy and refine it on a second run

If you start with a high accuracy setting, then computing the simulation takes much longer, and problems are more likely. Check the profiles and the overall mass balance, and if the accuracy is insufficient then you can improve the accuracy values.

To change the accuracy:

- In Console Mode use "SET_ACCURACY on page 35 and increase or decrease Max relative error and Max absolute error.

- In Graphical Mode the setting is on the "Diffusion Calculator" on page 87 in the section Time step control.

Modify the grid or time step

If you get large fluctuations in the composition or phase boundary profiles, then you can try modifying the grid or the time step of the simulation. You can increase the time step by lowering the accuracy if automatic time step control is used (the default).

If you increase the tolerated relative and/or absolute error then the automatic time step control increases the time step.

- In Console Mode use the "SET_ACCURACY on page 35 command.

- In Graphical Mode the setting is on the "Diffusion Calculator" on page 87 in the section Time step control.

Integrate the PDEs

The composition or phase boundary profiles can often also be improved if the partial differential equations (PDEs) are integrated fully implicitly (i.e. Euler backward).
To integrate the PDEs in this way:

In Console Mode use "SET_SIMULATION_CONDITION" on page 41 to set the parameter Degree of Implicity when Integrating PDEs to a value of 1.

In Graphical Mode, the setting is on the "Diffusion Calculator" on page 87 on the Options tab. Under Simulation Conditions, you can try a different Time integration method. The default method is Trapezoidal, which is equivalent to a 0.5 numerical setting in Console Mode. If you choose Euler backward, this is equivalent to a 1.0 numerical setting in Console Mode.
Debug (Console Mode)

If your Console Mode simulation fails to converge, then debugging may give you some clues about the source of the failure. To receive more detailed information about what is happening during the simulation use the command "DEBUGGING" on page 8.

Moving Boundary Simulations

Grid Distribution

Check the grid distribution at the interfaces. If the grid is too coarse or too fine-grained then the fluxes may not be defined well.

Use Activities Instead of Potentials

Use activities instead of potentials when the content of one or more of the elements becomes very low. If you do this, then the activity approaches zero, which is easier to handle than a potential that approaches infinity.

In Console Mode, use SET_SIMULATION_CONDITION to set the parameter Vary potentials or activities to Activities.

In Graphical Mode the setting is on the "Diffusion Calculator" on page 87 in the section Classic model specific. From the list, choose activity [Use the activity of a component in order to find the correct tieline at the phase interface].

Starting Values

Use the automatic starting values when you run the simulation the first time. If the first time step does not converge try decreasing the starting values for the velocities. Alternatively, increase the duration of the first time step.

If the simulation fails during the first time step, then check how the starting values affect the residuals.

In Console Mode, use the command SET_SIMULATION_CONDITION and set the parameter NS01A PRINT CONTROL to 1.

When you adjust this setting, the software then prints the tried unknown value and the
residual for each flux balance equation in each iteration. The equations are organized so that the first unknown value is always the migration rate of the phase interfaces followed by the unknown potentials. All unknown values are scaled by the starting value or the calculated value in the previous time step.

**Cell Calculations**

This section is specific to Console Mode.

In cell calculations, determine start values for each cell separately and thereafter connect the individual cells. You can even start simulating in planar and/or cylindrical geometry in order to determine sufficient starting values if you want to use a spherical geometry.

**Diffusion in Dispersed Systems**

This section is specific to Console Mode.

If you simulate diffusion in a dispersed system and the homogenization model is turned off, then time integration is explicit. The maximum time step allowed, or the highest time step actually taken in the calculation, affects the final result of the simulation. This effect is most evident if one or more of the diffusing species have low solubility in the matrix phase. When this is the case, a supersaturation is created in the matrix phase during a diffusion step and if too large a time step is allowed, then too much supersaturation is created. Consequently, always check your results by performing a second simulation with a maximum time step that is ten times lower than in the first run. If there is large difference in results between the first and the second run, then decrease the time step again with a factor of ten and perform a third run. Repeat this process until the results can be trusted.

If a simulation fails because the program is not able to calculate an equilibrium, then try to calculate the initial equilibrium yourself using Thermo-Calc and enter the composition and fraction of each phase separately instead of having the DICTRA module calculate it. Also enter starting values for each phase with the command SET_ALL_START_VALUES.

Alternatively, you may force the software to use certain start values using SET_SIMULATION_CONDITION.

**Cooperative Growth**

This section is specific to Console Mode.

If your simulation fails to converge, try calculating the A1e temperature with Thermo-Calc and start your simulation at a temperature slightly below that temperature. Use the equations given in the interactive help in order to estimate S0 and the growth rate.
Introduction to the Diffusion Module (DICTRA)

The Diffusion Module (DICTRA) is an add-on module to the Thermo-Calc software package. It is used for simulation of diffusion controlled transformations in multicomponent systems. The simulations are both time- and space-dependent.

The Diffusion Module (DICTRA) is suitable for solving diffusion problems that include a moving boundary (so-called Stefan problems). The multicomponent diffusion equations in the various regions of a material are solved under the assumption that thermodynamic equilibrium holds locally at all phase interfaces. The concentration fields only vary along one spatial coordinate, but the geometry may be either planar, cylindrical or spherical.

In this section:

- About this Quick Start Guide ................................................................. 3
- Diffusion Module Terminology in Graphical Mode ............................... 3
- Region ........................................................................................................ 3
- Grid Types ............................................................................................... 3
- Phases ......................................................................................................... 4
- Composition .............................................................................................. 4
- Geometry and Coordinates ....................................................................... 4
- Boundary Conditions ................................................................................ 5
- Setting up a Diffusion Simulation in Graphical Mode ............................. 5
About this Quick Start Guide

The following introduces you to the basic concepts, steps and theory to start using the Diffusion Module (DICTRA). An understanding of this information is necessary to ensure accurate calculations.

More details about the use of DICTRA can be found in Andersson et al\(^1\) and Borgenstam et al\(^2\).

If you are not familiar with Graphical Mode, it is recommended you read the Diffusion Module User Guide and Thermo-Calc User Guide included with this documentation set.

Diffusion Module Terminology in Graphical Mode

The following definitions are useful to help you understand the examples in this guide. For more detailed information search or browse the online help (Help → Online Help).

These terms are specific to working in Graphical Mode. The overall simulation in Console Mode is comparable but there are some differences in terminology and functionality.

Region

In Graphical Mode, a system consists of one cell with one or multiple regions in which the diffusion problem is to be solved.

Grid Types

These grid types are used in diffusion simulations: linear, geometric and double geometric. When you are setting up the simulation, in either Console Mode or Graphical Mode, a region must have a grid defined.

---


Phases

Each region must contain at least one phase. The so-called homogenization model is used if multiple phases are added inside a region, then the average properties of the local phase mixture is used. Phase(s) can also be added to interphases of region(s) and then only participate in the simulation if the driving force for precipitation of the phase exceeds a predefined value. A new region is then created where the name of the region is set to the name of the phase but with $R$ added as a prefix.

Composition

Two types of composition variables are used in the configuration of the Diffusion Calculator: weight fraction or mole fraction.

The $u$-fractions are used in the diffusion equations. The $u$-fraction of a component $k$ is defined as

$$u_k = \frac{x_k}{\sum_{j \in S} x_j}$$

The summation is only performed over the substitutional elements. The choice of the volume fixed frame of reference in the calculations make it convenient to use a composition variable which is related to the volume. The definition of the $u$-fraction is based upon the assumption that a species may or may not contribute to the volume of a phase. An interstitial element is assumed to not contribute to the volume. Substitutional elements are assumed to contribute equally to volume. Weight fraction, mole fraction or $u$-fraction can be used when plotting the results from a simulation.

Geometry and Coordinates

The Diffusion Module (DICTRA) can only handle diffusion problems where compositions vary along one spatial coordinate. The geometry of your system can be planar, cylindrical or spherical.
The planar geometry corresponds to an infinitely wide plate of a certain thickness. If the system has a planar geometry then the lower boundary (the zero coordinate) is at the left side of the system. The upper boundary (the coordinate with the highest value) is at the right side of the system.

**Boundary Conditions**

Boundary conditions are conditions that define how matter behaves at the boundaries of your system. By default, matter is not allowed to cross the system boundaries.

In Graphical Mode, the boundary conditions cannot be changed and this corresponds to a closed system.

However, if this is required for your simulation, you can change this setting in Console Mode for both the lower boundary (left side/centre) and the upper boundary (right side/surface) of the system.

**Setting up a Diffusion Simulation in Graphical Mode**

When you are using the Graphical Mode version of the Diffusion Module (DICTRA), the steps to set up a simulation are a combination of adding Activity nodes (the System Definer, Diffusion Calculator and Plot Renderer are used in these examples) and then defining the applicable settings for each of these nodes in a Configuration window.

**Console Mode versus Graphical Mode**

If you are accustomed to using Console Mode this Quick Start Guide will help you become familiar with how to use the Graphical Mode interface.

The overall sequence of what you define in Graphical Mode for the Diffusion Module is similar to the process in Console Mode. However, instead of using commands you are adding nodes and then entering settings for each of the nodes. More advanced functionality is available in Console Mode, and some of the commands available in Console Mode are not needed in Graphical Mode because it is automatically integrated into the Activity nodes, e.g. the Diffusion Calculator.

The following is a general overview of the steps to set up the simulation.

1. Use the **Diffusion Simulation** template to add the System Definer, Diffusion Calculator and Plot Renderer activity nodes.
2. On the **System Definer**, you select the thermodynamic and kinetic databases and add elements, which automatically include all phases.
3. On the **Diffusion Calculator**, you set the geometry (by default the geometry is planar), add region(s) and enter grid(s) and phase(s) in the region(s). You then enter composition(s) of phase(s).

4. On the **Plot Renderer**, you choose what to plot and then run the simulation, i.e. you **Perform** the sequence of nodes you have defined in the tree to produce the output simulation.

The rest of this guide describes each step in more detail for single phase, moving phase boundary and multiphase simulations.
## Single Phase Simulations

**In this section:**

- About the Single Phase Simulation ................................................................. 8
- Theory for the Single Phase Simulation ............................................................. 8
- Setting Up the Single Phase Simulation ........................................................... 10
- System Definer Settings .................................................................................. 11
- Add a System Definer Node ............................................................................. 11
- Choose the Databases ....................................................................................... 12
- Choose the Elements ......................................................................................... 13
- Diffusion Calculator Settings ............................................................................ 14
- Define the Region and Composition Profiles .................................................... 14
- Define the Thermal Profile ................................................................................ 16
- Plot Renderer Settings ....................................................................................... 16
- Renaming the Nodes and Saving the Project ...................................................... 18
About the Single Phase Simulation

In a 100 μm wide planar domain, the single phase example simulates the diffusion of Fe and Ni at a temperature of 1400 K. At this temperature the material is fully austenitic, i.e. the only phase present is the so-called fcc (face centered cubic) phase (in Thermo-Calc the name of this phase is FCC_A1). Initially, there is a linear variation in Ni going from 10 mass-% on the left-hand side to 50 mass-% on the right-hand side.

The simulation time is slightly different between the modes. For Console Mode it is $10^5$ s and for Graphical Mode it is 30 hours.

By default the boundaries are closed. The plot generated shows the initial and final Ni profile.

![Graph](image)

**Schematic view of the initial state of Single Phase Diffusion example.** The width of the domain is 100 μm and there is a linear gradient in composition going from 10 to 50 mass-% Ni. There is a single region named Austenite that consists of an fcc phase.

Theory for the Single Phase Simulation

The flux of a component $k$ in the z-direction in an isobarothermal system is in general given by

$$J_k = \sum_{i=1}^{n} L_{ki} \frac{\partial \mu_i}{\partial z}$$
where $L_{ki}$ is a matrix of kinetic coefficients and $\mu_j$ is the chemical potential of component $i$. The correlation effects, i.e. the coupling of the flux of component $k$ to the chemical potential gradients of the other elements, are normally neglected

$$(L_{ki} = 0, k \neq i)$$

and thus

$$J_k = L_{kk} \frac{\partial \mu_k}{\partial z} = M_k c_k \frac{\partial \mu_k}{\partial z}$$

where $c_k$ is the concentration and $M_k$ the mobility of component $k$.

The equation for the flux is combined with the equation of continuity, which takes the following form in a planar domain,

$$\frac{\partial c_k}{\partial t} = -\frac{\partial}{\partial z} (-J_k)$$

which relates the local evolution of the concentration of $k$ to the divergence of the flux.

The expression for the flux can be expanded in terms of concentration gradients

$$J_k = -\sum_{i=1}^{n} M_k c_k \frac{\partial \mu_k}{\partial c_j} \frac{\partial c_j}{\partial z} = -\sum_{i=1}^{n} D_{kj} \frac{\partial c_j}{\partial z}$$

where the diffusion coefficient of component $k$ with respect to the concentration gradient of component $j$ has been introduced.

$$D_{kj} = M_k c_k \frac{\partial \mu_k}{\partial c_j}$$

The flux expressions above are given in the so-called lattice-fixed frame of reference. In practical calculations it is more common to use a volume-fixed frame of reference. For a discussion of these concepts, see Andersson and Ågren (1992).\(^\dagger\)

---

Setting Up the Single Phase Simulation

For the single phase example, you can open the example project file included with your installation to first see how it is set up:

1. Open Thermo-Calc.
2. From the main menu, select File → Open Examples or Help → Open Examples. The Graphical Mode folder opens by default.
3. Locate the Ex_19_Diffusion_Single_Phase.tcu file and double-click to open it.
4. The project opens in Thermo-Calc and adds this tree structure:

![Tree Structure](image)

5. Click the top Project node (renamed to Ex_19_Diffusion_Single_Phase). At the bottom of the Configuration window click Perform Tree.

The Event Log shows the progress of the calculations:

<table>
<thead>
<tr>
<th>Event Log</th>
</tr>
</thead>
<tbody>
<tr>
<td>11:24:43.145 INFO</td>
</tr>
<tr>
<td>11:24:43.146 INFO</td>
</tr>
<tr>
<td>11:24:43.201 INFO</td>
</tr>
<tr>
<td>11:24:43.202 INFO</td>
</tr>
<tr>
<td>11:24:43.203 INFO</td>
</tr>
<tr>
<td>11:24:43.204 INFO</td>
</tr>
<tr>
<td>11:24:43.214 INFO</td>
</tr>
<tr>
<td>11:24:43.215 INFO</td>
</tr>
<tr>
<td>11:24:43.216 INFO</td>
</tr>
<tr>
<td>11:24:43.217 INFO</td>
</tr>
</tbody>
</table>

When completed, the results are plotted in the Results window as shown below.
Output from the Single Phase example showing the initial and final Ni profile.

For the rest of the exercise, you will learn how to build this example step-by-step.

**System Definer Settings**

To learn more about the activity nodes and tree structure see 'Project Activities and the Tree Structure' in the Thermo-Calc User Guide.

The following describes how to set up the *Ex_19_Diffusion_Single_Phase.tcu* example from the beginning.

**Add a System Definer Node**

1. Open Thermo-Calc.
2. In the **Project** window, right-click **My Project** and select **Create New Activity → System Definer**.
3. In the **System Definer Configuration** window, you select the thermodynamic and kinetic databases to use and select the elements.

**Tip: The Diffusion Simulation Template**

For this first example the activity nodes are added one at a time. A faster way to add all the
nodes you need is to use the **Diffusion Simulation** template.

---

**Choose the Databases**

There are databases for different purposes and material types. This example uses two demonstration databases: **FEDEMO** (the thermodynamic iron-base database) and **MFDEMO** (the kinetic/mobility iron-base database).

1. In the System Definer **Configuration** window click the **Databases** list and select the **FEDEMO** database.
2. Click the **Add a database** button.
3. Select the **MFDEMO** database.

**Tip: Database Packages**

For this first example the databases are added one at a time. A faster way to add both the databases is to add a predefined database **Package**.
Choose the Elements

On the Elements tab, and based on the databases selected, you can select and review elements using a Periodic Table or Alphabetic List format. The demonstration databases have only a small number of elements to choose from.

1. In the Periodic Table, click Fe.
2. Click Ni.

When using the System Definer with the Diffusion Calculator, you can keep all phases selected on the Phases and Phase Constitution tab.
Diffusion Calculator Settings

After you have completed the settings for the System Definer you start defining the diffusion parameters on the Diffusion Calculator.

In any simulation at least one region must be defined. This is a named container that designates a certain part of the domain. In this case it is the whole domain. The name of a region is arbitrary and specified by you.

The use of regions becomes clearer in the context of moving phase boundary simulations.

A region must contain a numerical grid specified by width and type. In this example, a 10^{-4} m (1e-4 m) wide, linear (i.e. equidistant) grid is used with 50 grid points.

Define the Region and Composition Profiles

1. In the Project window, right click the System Definer node and select Create New Successor → Diffusion Calculator. A Diffusion Calculator node is added to the tree structure.

![Diffusion Calculator](image)

If you used the Diffusion Simulation template, then this activity node is already there. Click the Diffusion Calculator node to access the Configuration window settings.

2. You are now going to add the settings to the Configuration window on the Conditions tab. Keep the defaults for Composition unit (Mass percent) and Length unit (m). A Planar geometry is used for all the examples.

3. In the Region Name field, enter Austenite. This name is automatically updated on the tab.
Tip: Double-click the Region tab to name a region

Another way to enter the region name is to double-click the tab, enter a name and then press enter.

4. In the **Width** field replace the default with $10^{-4}$. Keep the defaults for number of points (50) and type of grid (Linear).

5. From the **Phase** list, select **FCC_A1**.

   The initial composition profile must be specified for all regions. Since there are only two elements, Fe and Ni, the initial composition profile must only be given for one of them.

6. Click **Edit** next to **Composition profiles**. Fe is chosen as the **Dependent component**.

   There are many ways to specify the composition profile, e.g. an arbitrary position dependent function. In this example, the default **Linear** type is used.
7. The initial profile for Ni is a **Linear** variation. In the **from** field enter 10 and in the **to** field enter 50. Click **Apply**.

   These settings mean that the profile goes from 10 (mass-%) on the lower/left hand side of the system to 50 (mass-%) on the upper/right hand side of the system.

**Define the Thermal Profile**

The default **Isothermal** profile is used for this example. A constant temperature of 1400 K is used during the simulation, which is run for 30 hours. Enter these values in the fields:

1. In the **Temperature** field, enter 1400. Keep **Kelvin** as the default unit.
2. In the **Simulation time** field, enter 30. Select **Hours** from the list.

There are no changes to the default settings on the **Options** tab. You can click the tab to see what settings are available and then search the Online Help for more information.

**Plot Renderer Settings**

After you have completed the settings for the **System Definer** and **Diffusion Calculator** you define the plot parameters and run (perform) the simulation.

1. In the **Project** window, right click the **Diffusion Calculator** node and select **Create New Successor** → **Plot Renderer**. A Plot Renderer node is added to the tree structure.

**EXAMPLE**
If you used the **Diffusion Simulation** template, then this activity node is already there. Click the **Plot Renderer** node to access the **Configuration** window settings.

For this first example, all the defaults are kept and there is only one setting to add. In most cases, either a specific position in the domain or one or more specific times must be specified depending on whether time or spatial position is chosen as independent (x-axis) variable.

2. In the time field, enter 0.0 before the 30.0, which is automatically taken from the Diffusion Calculator setting.

3. Click **Perform**. If you have entered everything correctly, you should get this plot showing the composition profile of Ni at the initial (0 hours) and final time (30 hours or 108,000 seconds).

**PLOT RESULT**
Renaming the Nodes and Saving the Project

You can rename the nodes in the tree at any time during the creation of a project. For this first example it was left until the end so you could become familiar with the System Definer, Diffusion Calculator and Plot Renderer settings. It is also important at this point to save the project. You can do this at any time and it is good practice to save your project often.

The following renaming can be done to match the example file included with your installation:

- When you rename a node, associated tabs are also renamed automatically. For example, when the Plot Renderer is renamed, so is the tab in the Results window.

1. Right-click the My Project node and select Rename.
2. In the New name field enter Diffusion_Single_Phase. Click OK. Continue renaming the other nodes.
3. Right-click the System Definer, select Rename and enter System with Fe Ni.
4. Right-click the Diffusion Calculator, select Rename and enter Diffusion single region Austenite.
5. Right-click the Plot Renderer, select Rename and enter Composition of Ni vs Distance.
6. Save the project. To do this, click the Save button and navigate to a location on your computer where you can easily find this project file.
Moving Phase Boundary Simulations

In this section:

About the Moving Phase Boundary Simulation ...................................................... 21
Theory for the Moving Phase Boundary Simulation .............................................. 21
Moving Phase Boundary Example Project ............................................................ 22
System Definer Settings ......................................................................................... 24
Add the Databases and the Elements .................................................................... 24
Diffusion Calculator Settings ................................................................................ 24
Add a Ferrite Region .............................................................................................. 25
Add an Austenite Region ....................................................................................... 26
Define the Thermal Profile .................................................................................... 27
Plot Renderer Settings ........................................................................................... 27
Add a Second Plot .................................................................................................. 28
About the Moving Phase Boundary Simulation

The growth of ferrite (bcc) into austenite (fcc) is simulated in this example. The austenite is assumed to be initially homogeneous with the composition Fe - 0.15 mass-% C and the transformation temperature is 1050 K. The initial thickness of the austenite is 2 mm and an initially very thin ferrite (1 nm) is also present at the start of the simulation. The initial state is as below.

A schematic graph of the carbon profile during the transformation is shown in the image below. Crusius et al (1992)¹ is recommended as further reading.

Theory for the Moving Phase Boundary Simulation

It is assumed that local equilibrium holds at the phase interface, i.e. the chemical potentials of all elements are continuous across the boundary, but the chemical potential gradients are in general discontinuous.

---

In order to maintain mass balance a set of flux balance equations must be satisfied at the phase interface:

\[ \nu^\alpha/\gamma (c_k^\alpha - c_k^\gamma) = J_k^\alpha - J_k^\gamma \quad k = 1, \ldots, n - 1 \]

where \( \nu \) is the interfacial velocity. The concentrations and the fluxes \( c \) and \( J \) are those at the interface on the \( \alpha \) and \( \gamma \) sides, respectively.

In the present case there are no degrees of freedom at the interface and the concentrations can be taken directly from a phase diagram. There is only one flux balance equation and the interface velocity can be evaluated once the fluxes at the interface are known. However, for ternary and higher systems the state at the interface must be found by some iterative procedure.

For more information on moving phase boundary problems, see, for example, Ågren (1982), Crusius et al. (1992) and Höglund (1997).

**Moving Phase Boundary Example Project**

For the moving phase boundary simulation, you can open the example project file included with your installation to see how it is set up.

1. Open Thermo-Calc.
2. From the main menu, select **File → Open Examples** or **Help → Open Examples**. The Graphical Mode folder opens by default.
3. Locate the file **Ex_20_Diffusion_Moving_Boundary.tcu** and double-click to open it.
4. The project opens in Thermo-Calc. Click the top Project node (renamed to **Ex_20_Diffusion_Moving_Boundary**). At the bottom of the **Configuration** window click **Perform Tree**.

**MODEL TREE**

---


When completed, the results are plotted in the **Results** window. There are two plot nodes, which creates two plots: The ferrite/austenite phase interface position as a function of time and the composition profile for Carbon.

**Plot Results**
System Definer Settings

This is a continuation from the Single Phase simulation and it describes how to set up the example file `Ex_20_Diffusion_Moving_Boundary.tcu`. In this example, the shortcuts explained for the Single Phase System Definer are used.

Add the Databases and the Elements

1. Open a new instance of Thermo-Calc.
2. In the My Project window click the Diffusion Simulation template icon.
3. In the System Definer Configuration window click the Package list and choose Demo: Steels and Fe-alloys (FEDEMO, MFDEMO).
4. In the Periodic Table, click Fe then C.
5. Rename the nodes. Right-click System Definer and rename it to System with Fe C.
6. Right-click My Project and give it the same name as the project e.g. Diffusion_Moving_Boundary.
7. Save the project file with a new name, such as DiffusionMovingBoundary.

Diffusion Calculator Settings

After you have completed the settings for the System Definer you define the diffusion calculation parameters.
The phase interface between ferrite and austenite is created by introducing an austenite region that is attached to the ferrite region. Regions are always separated by phase interfaces and must therefore always contain different phases.

In this simulation both the FCC_A1 and BCC_A2 phases are included. Both phases are assumed to be initially homogeneous, the bcc phase having 0.01 mass-% C and the fcc phase 0.15 mass-% C. These settings are entered on the Diffusion Calculator.

**Add a Ferrite Region**

1. In the **Project** window, click the **Diffusion Calculator** node.
2. Keep the default for **Composition unit** (Mass percent). Choose **μm** for the **Length unit**. A **Planar** geometry is used for all the examples.
3. Double-click the **Region** tab and enter **Ferrite**. Press <Enter>.

4. In the **Width** field enter **0.001 μm** and change the default number of points to **10**. Keep the default **Linear** grid type.

   The grid type for the ferrite region is the same as in the single-phase simulation example, i.e. equidistant.

5. From the **Phase** list select **BCC_A2**.
6. Click **Edit** next to **Composition profiles**. Fe is chosen as the **Dependent component** and the initial profile for **Component C** is a **Linear** variation.
7. Enter **0.01** in both fields to represent C going from 0.01 (mass-%) on the lower, left-hand side of the system to 0.01 (mass-%) on the upper, right-hand side of the system. Click **Apply**.
Add an Austenite Region

1. Next to Region, click the green add button. A new tab called Region is added.

If you add a region and then need to change the order, right-click the applicable tab and choose Move left or Move right.

2. In the Region Name field, enter Austenite. This name is automatically updated on the tab and above the grid points in a new section for the second region.

3. In the Width field enter 2000 μm.

4. In the next field (the number of points), enter 50.

5. Select a Geometric type of grid and enter 1.05 for the Ratio.

   For the austenite region the grid type is geometric. For these grids the grid point spacing changes by a constant factor between every grid point. In this case the spacing increases by 5%, i.e. a factor of 1.05, from the lower, left side for each grid point. It is usually good practice to have a denser grid close to moving boundaries where the composition profiles are expected to vary a lot during the simulation.

6. From the Phase list, select FCC_A1.

7. Click Edit next to Composition profiles. Enter 0.15 in both fields to represent Component C going from 0.15 (mass-%) on the lower, left-hand side of the system to 0.15 (mass-%) on the upper, right-hand side of the system. Click Apply. The Austenite grid shows the points.
The domain now consists of two regions: Ferrite and Austenite.

**Define the Thermal Profile**

The default isothermal profile is used.

1. In the Temperature field, enter 1050.
2. In the Simulation time field, enter 30. Choose Hours from the list.
3. Right-click Diffusion Calculator and rename it to Diffusion two regions Ferrite and Austenite.

As with the single phase example, the Options tab keeps all the defaults.

**Plot Renderer Settings**

After you have completed the settings for the System Definer and Diffusion Calculator you define the plot parameters.

1. In the Project window, click the Plot Renderer node.
2. Choose Time as the X-Axis variable and select Hours.
3. Choose **Position of interface** as the **Y-Axis variable**.
4. In the **Interface** list, keep the default **Ferrite/Austenite**.
5. Right-click **Plot Renderer** and rename it to **Position of interface vs time**.
6. Click **Perform** If you have entered the same settings the plot shows the ferrite/austenite phase interface position as a function of time. The plot has the parabolic appearance characteristic for many types of diffusion simulations.

*PLOT RESULT* from the example showing the phase interface position as a function of time.

![Plot Result](image)

**Add a Second Plot**

1. Right-click the **Diffusion Calculator** node. Remember it is renamed to **Diffusion two regions Ferrite and Austenite**.
2. From the **Create New Successor** list, click **Plot Renderer**.
3. In the new Plot Renderer node **Configuration window**, for the **X-Axis variable**, change the Distance units to **μm**.
4. Click to clear the **Automatic scaling** check box.
5. In the **Limits** fields, keep 0 as the lower limit, enter **2000** for the upper limit and **200** for **step**.
6. For the **Y-Axis variable**, keep the default Composition and choose **C** from the list.
7. Choose **Hours** as the **Time** unit and enter \(0.0 \ 1.0E-4 \ 30.0\) in the field.

8. Right-click **Plot Renderer** and rename it to **Composition profile C**.

9. Click **Perform** if you have entered the same settings the plot shows the composition profile of C.

**PLOT RESULT**
Multiphase Simulations

In this section:

- About the Multiphase Simulation ................................................................. 31
- Theory for the Multiphase Simulation .............................................................. 31
- Multiphase Example Project ........................................................................... 32
- System Definer Settings .................................................................................. 33
- Add the Databases and the Elements ............................................................... 34
- Diffusion Calculator Settings ........................................................................... 34
- Define the Ferrite and Austenite Regions ......................................................... 34
- Define the Thermal Profile ............................................................................... 35
- Choose the Homogenization Function ............................................................. 35
- Plot Renderer Settings ..................................................................................... 36
About the Multiphase Simulation

This example simulates the evolution of an Fe-Cr-Ni diffusion couple during a 100 hour heat treatment at 1100 °C (1373.15 K). Both end members of the diffusion couple are duplex ferrite plus austenite, but the majority phase is ferrite on the left-hand side and austenite on the right.

With this type of simulation it is assumed that the material is fully equilibrated at each grid point, i.e. the local phase fractions, phase compositions and so forth are obtained from an equilibrium calculation with the local overall composition as a condition.

**Schematic view of the initial state of the Multiphase example.** Two ternary Fe-Cr-Ni alloys form a diffusion couple. There is a single region (diffcouple) where both the bcc and fcc phases are entered. Both alloys are duplex bcc+fcc, but the majority phase is bcc (α) in the left-hand side alloy and fcc (γ) in the right.

Theory for the Multiphase Simulation

More details about the homogenization model for multiphase simulations can be found in Larsson and Engström (2006)\(^1\) and Larsson and Höglund (2009)\(^2\). As mentioned in the

---

\(^1\)“A homogenization approach to diffusion simulations applied to α + γ Fe–Cr–Ni diffusion couples,” *Acta Mater.*, vol. 54, no. 9, pp. 2431–2439.

\(^2\)“Multiphase diffusion simulations in 1D using the DICTRA homogenization model,” *Calphad.*, vol. 33, no. 3, pp. 495–501.
description of this simulation, it is assumed that the material is locally fully equilibrated and 
that the local phase fractions, phase compositions and so forth are obtained from an 
equilibrium calculation with the local overall composition as a condition. From a numerical 
point of view the homogenization model treats the multiphase material as a single phase 
having the “average”, or “effective”, properties of the local phase mixture.

When estimating the effective kinetics of a multiphase mixture the product of solubility and 
mobility in each phase is considered. It is therefore convenient to define

$$\Gamma_k^\phi = M_k^\phi c_k^\phi$$

for each phase $\phi$. The effective kinetics of the multiphase mixture is denoted and in this 
example it was evaluated using the lower Hashin-Shtrikman bound. The default method is a 
simple rule of mixtures

$$\Gamma_k^* = \sum_\phi f_\phi \Gamma_k^\phi$$

where $f_\phi$ is the volume fraction of $\phi$. The flux is obtained as

$$J_k = -\Gamma_k^* \frac{\partial \mu_k}{\partial z}$$

which replaces the single-phase equation

$$J_k = L_{kk} \frac{\partial \mu_k}{\partial z} = M_k c_k \frac{\partial \mu_k}{\partial z}$$

for multiphase simulations.

**Multiphase Example Project**

For the multiphase simulation, you can open the example project file included with your 
installation to see how it is set up.

1. Open Thermo-Calc.
2. From the main menu, select **File → Open Examples** or **Help → Open Examples**. The 
   Graphical Mode folder opens by default.
3. Locate the **Ex_21_Diffusion_Multiphase.tcu** file and double-click to open it.
4. The project opens in Thermo-Calc. Click the top Project node (renamed to `Ex_21_Diffusion_Multiphase`). At the bottom of the Configuration window click Perform Tree.

**MODEL TREE**

```
Ex_21_Diffusion_Multiphase
    System with Fe Cr Ni
    Diffusion Multiphase BCC FCC
    Phase fraction of FCC
```

When completed, the results are plotted in the RESULTS window.

**System Definer Settings**

This is a continuation from the previous examples and uses the short cuts already described. You can alternatively open a saved project and edit the settings.
Add the Databases and the Elements

1. Open a new instance of Thermo-Calc.
2. In the My Project window click the Diffusion Simulation template icon.
3. In the System Definer Configuration window click the Package list and choose Demo: Steels and Fe-alloys (FEDEMO, MFEDEMO).
4. In the Periodic Table, click Fe, then Cr and Ni.
5. Right-click System Definer and rename it to System with Fe Cr Ni.
6. Save the project file with a new name, e.g. DiffusionMultiphase.

Diffusion Calculator Settings

After you have made the settings to the System Definer, you add the diffusion calculation parameters.

Define the Ferrite and Austenite Regions

1. In the Project window, click the Diffusion Calculator node.
2. For Composition unit select Mole fraction.
   - Keep the default Length unit (m). A Planar geometry is used for all the examples.
3. In the Region Name field, enter Diffcouple.
4. In the Width field enter 0.003 and enter 60 points.
5. Select Double geometric as the grid type.
   - A double geometric grid is similar to the geometric grid used in the moving phase boundary example. The difference is that two geometrical factors are entered: one for the lower and one for the upper half of the region. In the lower half of the region the distance between subsequent grid points decreases by 15 % (0.85) and in the upper half it increases by 15 % (1.15). The resulting grid has a much larger grid point density toward the middle of the domain where there are sharp changes in composition.
6. Enter these values as follows. In the Lower ratio field enter 0.85 and in the Upper ratio field enter 1.15.
7. Choose FCC_A1 from the Phase list.
8. Next to Phase click the Add quantity button . From the Phase list select BCC_A2.
9. Click Edit next to Composition profiles. Fe is chosen as the Dependent component. Define Component Cr and Component Ni.
10. Choose **Step** for both the Cr and Ni elements.

11. In each of the fields for Cr *(from, to, step at)* enter 0.257, 0.423 and 0.0015, respectively.

12. In each of the fields for Ni *(from, to, step at)* enter 0.0647, 0.275 and 0.0015, respectively. Click **Apply**.

**EXAMPLE**

The resulting Cr profile is thus 0.257 on the left half of the domain and 0.423 on the right with a sharp step at the center (as shown in "About the Multiphase Simulation" on page 31).

**Define the Thermal Profile**

1. The default **Isothermal** profile is used for this example.

2. In the **Temperature** field, enter 1100 and choose **Celsius** from the list.

3. In the **Simulation time** field, enter 100 and choose **Hours** from the list.

4. Right-click **Diffusion Calculator** and rename it to **Diffusion Multiphase BCC FCC**.

**Choose the Homogenization Function**

The local kinetics of the multiphase mixture must be estimated by means of some function that may depend on the local phase fractions, phase compositions and the mobilities of the individual phases.

There are many such homogenization functions to choose from. In this particular example the **General lower Hashin–Shtrikman bound** *(Z. Hashin and S. Shtrikman (1962))¹* is a good choice.

1. To choose this homogenization function, go to the **Diffusion Calculator** and click the **Options** tab.

Homogenization is already automatically selected as the Default solver because multiple phases are selected in a region.

2. Go to the section Homogenization Model Specific from the Homogenization function list select General lower Hashin–Shtrikman bound.

### Plot Renderer Settings

After you enter the settings for the System Definer and Diffusion Calculator, you define the plot parameters. For this example you want to plot the mole fraction fcc phase as a function of distance at the end of the heat treatment.

The plot of phase fraction vs distance shows that a single phase fcc zone has formed and this was also observed experimentally, see A. Engström (1995).

1. Click the Plot Renderer node.
2. Click to clear the Automatic scaling check box.
3. Enter the Limits: 0.001 to 0.002 step 1.0E-4.
4. From the second Axis variable list, choose Phase fraction and FCC_A1.

---

5. Click **Perform** If you have entered the same settings you will get this **PLOT RESULT**.

6. Right-click **Plot Renderer** and rename it to **Phase fraction of FCC**.
References


Next Steps

Below are suggestions for you to learn more about using the Diffusion (DICTRA) Module.

- Browse the Online Help (Help → Online Help) or open one of the available PDFs included with your installation (Help → Open Manuals Folder).

- You have been working with in Graphical Mode. You might also want to try the *Diffusion Module Console Mode Quick Start Guide* (Help → Open Manuals Folder). This will further prepare you to work with the Console Mode examples (Help → Open Examples), which contain many simulation types and advanced functionality not available in Graphical Mode.

- You can also go to the Thermo-Calc training website to see if there are other options suited to you, such as a course or video tutorials.
Diffusion Module (DICTRA) Quick Start Guide - Console Mode

Thermo-Calc Version 2017a
Introduction to the Diffusion Module (DICTRA)

The Diffusion Module (DICTRA) is an add-on module to the Thermo-Calc software package. It is used for simulation of diffusion controlled transformations in multicomponent systems. The simulations are both time- and space-dependent.

The Diffusion Module (DICTRA) is suitable for solving diffusion problems that include a moving boundary (so-called Stefan problems). The multicomponent diffusion equations in the various regions of a material are solved under the assumption that thermodynamic equilibrium holds locally at all phase interfaces. The concentration fields only vary along one spatial coordinate, but the geometry may be either planar, cylindrical or spherical.

In this section:

- About this Quick Start Guide ................................................................. 3
- About the DICTRA File Formats .......................................................... 3
- Opening the Module and Macro Files .................................................. 4
- Opening the DICTRA Module in Thermo-Calc ..................................... 4
- Opening the Beginner Guide Examples .............................................. 4
- Basic Terminology .................................................................................. 6
- Cells and Regions in a System .............................................................. 6
- Regions and Grids .................................................................................. 7
- Phases ...................................................................................................... 7
- Composition ........................................................................................... 7
- Geometry and Coordinates ................................................................... 8
- Boundary Conditions ............................................................................. 9
- Setting up a Simulation in Console Mode ............................................. 9
About this Quick Start Guide

The following introduces you to the basic concepts, steps and theory to start using the Diffusion Module (DICTRA). An understanding of this information is necessary to ensure accurate calculations.

More details about the use of DICTRA can be found in Andersson et. al\textsuperscript{1} and Borgenstam et al\textsuperscript{2}.

If you are not familiar with Graphical Mode, it is recommended you read the Diffusion Module User Guide and Thermo-Calc User Guide included with this documentation set.

About the DICTRA File Formats

The Diffusion Module (DICTRA) in Console Mode uses different file formats: log, macro and workspace files.

When working with the DICTRA module in Graphical Mode, the file formats are the same as when using Thermo-Calc.

Log Files

Log files (*.LOG) are plain text files used to save a sequence of commands. Log files can be edited in a text editor.

Macro Files

Macro files (*.DCM) are plain text files used to save a sequence of commands that can be loaded and executed. Macro files can be edited in a text editor. When creating a command sequence, you add comments to the file by starting a line with @@.

Workspace Files

Workspaces files (*.DIC) allow you to save all the data in your current workspace. A


workspace contains all the data, specified settings and the result of any calculations performed. The saved data includes original and modified thermodynamic data, the last set of conditions and options, and the results of any simulations.

**Opening the Module and Macro Files**

You can go to into the Console Mode to explore the command options, or continue with this quick start guide, which uses macro files to demonstrate how to use the software.

**Opening the DICTRA Module in Thermo-Calc**

1. Open Thermo-Calc in Console Mode.

   By default, Thermo-Calc opens in the most recently used state. If it opens in Graphical Mode, on the toolbar, click **Switch to Console Mode**.

2. In the **SYS module**, type `GOTO_MODULE DICTRA`. For a list of all the available commands in the current module, at the prompt type a question mark (?) and press <Enter>. For a description of a specific command, type `Help` followed by the name of the command.

   ![Console](image)

   ```
   Thermo-Calc / DICTRA
   Only for use at Thermo-Calc Software
   Local contact pumba.thermocalc.se
   
   SYS:GOTO_MODULE DICTRA
   NO TIME STEP DEFINED
   DICTRA
   ```

**Opening the Beginner Guide Examples**

For the Console Mode examples included with your installation, you can open the `.DCM` files from the main menu. You can also open any macro file with a command or by dragging it into the Console window.

**Open a Macro File from the Examples Folder**

To open a specific macro file from the Examples folders included with your installation:

1. Open Thermo-Calc.
2. Confirm you are in Console Mode. If not, click the **Switch to Console Mode** button.
3. From the main menu, select **File → Open Examples** or **Help → Open Examples**. The Console Mode folder opens (these are the Thermo-Calc macro files).

4. Click the **Up One Level** button.
5. Double-click the **DICTRA** folder.

The three Quick Start example macros and the PDF guide are in the first folder called **Beginner Guide**.

**Using a Command in Console Mode**

At the **SYS** prompt, type MACRO_FILE_OPEN and press <Enter>. In the file dialogue window that opens, locate and select the macro file on your computer.

**Drag and Drop a Macro File into Console Mode**

For example, navigate to the **Beginner Guide** folder and then drag the file from its location into Thermo-Calc Console window.

**EXAMPLE**

![Drag the file from its location on your computer and drop it into the Thermo-Calc Console window](image)

The macro automatically runs after you drop it into the Console window.

**EXAMPLE**
Introduction to the Diffusion Module (DICTRA) ǀ 6 of 40

Double-click to Open a File

Navigate to the macro file location, for example where each set of file examples is in its own folder. When you double-click, it opens the file in a new instance of Thermo-Calc.

Basic Terminology

The following definitions are useful to help you understand the examples and commands in this guide. For more detailed information search or browse the online help (Help → Online Help).

Cells and Regions in a System

A system normally consists of one cell. This cell contains one or several regions in which the diffusion problem is to be solved. A system of diffusion equations is solved for each region. The size of the system is the sum of sizes of all the regions in all the system’s cells.

The interface between two regions typically moves as the result of a simulation, that is, the regions grow or shrink. Such an interface is called an inner interface. The boundary of a cell is called an outer interface and the condition of this type of interface may be affected by the choice of boundary conditions.

For some simulations it is useful to have several cells in a system. Matter can move between cells. However, it is assumed that there is diffusional equilibrium between all cells (this means that there are no differences in diffusion potentials between cells). In other words, the size of a cell is fixed during the simulation.

By default this is a closed system, which means that matter cannot move across its boundaries. However, you can change this setting for both the lower boundary (left
upper boundary (right side/surface) of the system. You can also set these boundary conditions to vary as a function of time, temperature and/or pressure.

**Regions and Grids**

A region contains one or more phases. If a region contains several phases one of those must be entered as a matrix phase whereas the others are entered as spheroid.

A region must also contain a number of grid points. The composition is only known at these grid points and the software assumes that the composition varies linearly between them. The amount and composition of all the phases present at a single grid point in a certain region are those given by thermodynamic equilibrium keeping the over-all composition at the grid point fixed.

These grid types are used in diffusion simulations: linear, geometric and double geometric. When you are setting up the simulation, in either Console Mode or Graphical Mode, a region must have a grid defined.

<table>
<thead>
<tr>
<th>Linear</th>
</tr>
</thead>
<tbody>
<tr>
<td>Geometric</td>
</tr>
<tr>
<td>Double geometric</td>
</tr>
</tbody>
</table>

**Phases**

Each region contains one or more phases. A phase can be of the matrix, spheroid or lamellar type. A phase can be introduced with the status active (the default) or inactive.

An inactive phase is a phase which does not participate in the calculations until it is stable. If a phase is inactive, then the driving force for precipitation of the phase is continuously monitored. When the driving force exceeds a predefined positive value, the phase take parts in the simulation and the phase automatically becomes active. A new region is then created and the formerly inactive phase is entered as the matrix phase of the new region. The name of the region is set to the name of the phase that just became active but with $R_{\_}$ added as a prefix.

**Composition**

For Graphical Mode, see "Diffusion Module Terminology in Graphical Mode" on page 3.
Two types of composition variables are used within the program: site-fractions and \( u \)-fractions, although you can also use weight fraction or mole fraction, for example.

The *site-fractions* are used to set up the problem and interface with POLY-3 (in Console Mode). The site fraction of a species \( k \), \( y_k \), is the fraction of equivalent lattice sites occupied by species \( k \). It is the only concentration variable that uniquely defines the composition and the constitution of a phase and it is necessary to use the site fraction in the storage of the data during a simulation.

The *\( u \)-fractions* are used in the diffusion equations. The \( u \)-fraction of a component \( k \) is defined as

\[
u_k = \frac{x_k}{\sum_{j \in S} x_j}
\]

The summation is only performed over the substitutional elements. The choice of the volume fixed frame of reference in the calculations make it convenient to use a composition variable which is related to the volume. The definition of the \( u \)-fraction is based upon the assumption that a species may or may not contribute to the volume of a phase. An interstitial element is assumed to not contribute to the volume. Substitutional elements are assumed to contribute equally to volume.

**Geometry and Coordinates**

The Diffusion Module (DICTRA) can only handle diffusion problems where composition vary along one spatial coordinate. The geometry of your system can be *planar, cylindrical* or *spherical*.

**Planar Geometry**

This geometry corresponds to an infinitely wide plate of a certain thickness. If the system has a planar geometry then the lower boundary (the zero coordinate) is at the left side of the system. The upper boundary (the coordinate with the highest value) is at the right side of the system.

**Cylindrical and Spherical Geometries**

- Cylindrical geometry corresponds to an infinitely long cylinder of a certain radius.
- Spherical geometry corresponds to a sphere with a certain radius.

By default for both geometries, the lower boundary (the zero coordinate) is at the centre of the cylinder/sphere. The upper boundary (the coordinate with the highest value) is at the *surface* of the cylinder/sphere. You can enter a left most coordinate that is larger than zero to allow for tube and hollow sphere geometries.
Boundary Conditions

Boundary conditions are conditions that define how matter behaves at the boundaries of your system. By default, matter is not allowed to cross the system boundaries.

In Graphical Mode, the boundary conditions cannot be changed.

In Console Mode you can change this setting for both the lower boundary (left side/centre) and the upper boundary (right side/surface) of the system.

Setting up a Simulation in Console Mode

Although there are several commands to learn to correctly set up a DICTRA module simulation, the sequence in which to proceed is basically the same:

1. Define and read thermodynamic and kinetic data.
2. Set global conditions (i.e. temperature, \( T \), and pressure, \( P \)).
3. Enter region(s).
4. Enter grid(s) in region(s).
5. Enter phase(s) in region(s).
6. Enter composition(s) of phase(s).
7. Set geometry (optional – by default, the geometry is planar).
8. Set boundary conditions (optional – by default, the boundaries are closed).
9. Set the simulation time.
10. Run the simulation.

For definitions of the above, see "Basic Terminology" on page 6. The following sections describe each step in more detail for these simulation types:

- "About the Single Phase Simulation" on page 11
- "About the Moving Phase Boundary Simulation" on page 23
- "About the Multiphase Simulation" on page 32
Single Phase Simulations

In this section:

- About the Single Phase Simulation ................................................................. 11
- Theory for the Single Phase Simulation ............................................................. 11
- Running the Single Phase Simulation ............................................................... 13
- Single-Phase Command Details ........................................................................ 13
About the Single Phase Simulation

In a 100 μm wide planar domain, the single phase example simulates the diffusion of Fe and Ni at a temperature of 1400 K. At this temperature the material is fully austenitic, i.e. the only phase present is the so-called fcc (face centered cubic) phase (in Thermo-Calc the name of this phase is FCC_A1). Initially, there is a linear variation in Ni going from 10 mass-% on the left-hand side to 50 mass-% on the right-hand side.

The simulation time is slightly different between the modes. For Console Mode it is $10^5$ s and for Graphical Mode it is 30 hours.

By default the boundaries are closed. The plot generated shows the initial and final Ni profile.

The flux of a component $k$ in the $z$-direction in an isobarothermal system is in general given by

$$ J_k = \sum_{i=1}^{n} L_{ki} \frac{\partial H_i}{\partial z} $$

Schematic view of the initial state of Single Phase Diffusion example. The width of the domain is 100 μm and there is a linear gradient in composition going from 10 to 50 mass-% Ni. There is a single region named Austenite that consists of an fcc phase.

Theory for the Single Phase Simulation

The flux of a component $k$ in the $z$-direction in an isobarothermal system is in general given by
where \( L_{kl} \) is a matrix of kinetic coefficients and \( \mu_j \) is the chemical potential of component \( i \). The correlation effects, i.e. the coupling of the flux of component \( k \) to the chemical potential gradients of the other elements, are normally neglected

\[
(L_{kl} = 0, k \neq i)
\]

and thus

\[
J_k = L_{kk} \frac{\partial \mu_k}{\partial z} = M_k c_k \frac{\partial \mu_k}{\partial z}
\]

where \( c_k \) is the concentration and \( M_k \) the mobility of component \( k \).

The equation for the flux is combined with the equation of continuity, which takes the following form in a planar domain,

\[
\frac{\partial c_k}{\partial t} = \frac{\partial}{\partial z} (-J_k)
\]

which relates the local evolution of the concentration of \( k \) to the divergence of the flux.

The expression for the flux can be expanded in terms of concentration gradients

\[
J_k = - \sum_{i=1}^{n} M_k c_k \frac{\partial \mu_k}{\partial c_j} \frac{\partial c_j}{\partial z} = - \sum_{i=1}^{n} D_{kj} \frac{\partial c_j}{\partial z}
\]

where the diffusion coefficient of component \( k \) with respect to the concentration gradient of component \( j \) has been introduced.

\[
D_{kj} = M_k c_k \frac{\partial \mu_k}{\partial c_j}
\]

The flux expressions above are given in the so-called lattice-fixed frame of reference. In practical calculations it is more common to use a volume-fixed frame of reference. For a discussion of these concepts, see Andersson and Ågren (1992)\(^1\).

Running the Single Phase Simulation

For the single phase simulation, you use an example macro file called `simplest_dictra.dcm`. Open this file in Console Mode as described in "Opening the Module and Macro Files" on page 4.

The simulation should automatically be set up, executed and finished within a matter of seconds. Results are plotted in the **Console Results** plot window.

![Graph showing weight percent Ni vs distance](image)

*Output from the Single Phase example showing the initial and final Ni profile.*

For the rest of the exercise, you will learn how to build this example step-by-step.

Single-Phase Command Details

To examine the commands in the macro file, you can either open the file `simplest_dictra.dcm` in a text editor or scroll to the top of the **Console** window.
In the following sections, the commands are discussed in the order they are executed. The first time a command appears it is listed in its general form in UPPERCASE and then using code font to detail the specific form of the example. For subsequent examples, only the new commands are detailed. All commands may be abbreviated as long as they are unambiguous.

You can also review the comments included in the example files. The first command you will use is shown in the macro file as follows:

**In a Text Editor**

<table>
<thead>
<tr>
<th>Comments</th>
<th>Commands</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>goto_module database_retrieval</td>
</tr>
</tbody>
</table>

**In Thermo-Calc**

<table>
<thead>
<tr>
<th>Comments</th>
<th>Commands</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>SYS: goto_module MODULE NAME: database_retrieval</td>
</tr>
</tbody>
</table>
**Single Phase - Specifying the Thermodynamic System**

Thermo-Calc Console Mode has several modules used for different purposes. In order to define the thermodynamic system the DATABASE_RETRIEVAL module is used.

```
GOTO_MODULE <MODULE>
goto_module database_retrieval
```

There are many databases for different purposes and material types. In this example the *fedemo* database is used. This is the thermodynamic iron demonstration database.

```
SWITCH_DATABASE <DATABASE>
switch_database fedemo
```

Determine what elements to use in the simulation, in this case Fe and Ni.

```
DEFINE_SYSTEM <LIST OF ELEMENTS>
define_system fe,ni
```

Only the FCC_A1 phase takes part in this simulation and therefore all phases are initially rejected (the wildcard * means all phases in this context) and then, with the next command, the FCC_A1 phase is restored.

```
REJECT <ELEMENTS, SPECIES, PHASES, CONSTITUENT OR SYSTEM> <LIST OF THE RELEVANT TYPE>
reject phases *
```

```
RESTORE <ELEMENTS, SPECIES, PHASES OR CONSTITUENTS> <LIST OF THE RELEVANT TYPE>
restore phases fcc_a1
```

The thermodynamic system now consists of the elements Fe and Ni and the fcc_a1 phase.

To actually read the data from file into computer memory the GET_DATA command must be executed.

```
GET_DATA
get_data
```

At this stage only the thermodynamic data is defined and read. The kinetic data (mobilities) are, in this case, stored in another database. This is normally the case though it is possible to have both thermodynamic and kinetic data in a single database.

To add data from a different database the APPEND_DATABASE command is used. The kinetic data in this example is stored in the *mfedemo* database. This is the kinetic iron demonstration database.
APPEND_DATABASE <DATABASE>
append_database mfedemo

The same sequence of commands used for thermodynamic data is used to read kinetic data from this database.

define_system fe,ni
reject phases *
restore phases fcc_al
get_data

Setting up the Single-Phase Simulation

The simulation set-up is performed in the DICTRA_MONITOR module.

goto_module
dictra_monitor

In this example only one global condition is set, temperature. The other global condition that can be set is pressure, but that is rarely done as the default value (1 atm) is set automatically and usually accepted.

SET_CONDITION <GLOBAL OR BOUNDARY>
set_condition global

The SET_CONDITION command is immediately followed by these sub-prompts:

<T OR P>
T

The T is for temperature. Then follows a standard procedure for entering temporally piece-wise functions:

<LOW TIME LIMIT> <FUNCTION> <HIGH TIME LIMIT> <Y/N> <IF Y, THEN NEXT FUNCTION> <...>
0 1400; * N

These prompts start with the low time limit, here zero (0), then the function (here the constant value 1400) closed by a semicolon (;), then the high time limit (here a wildcard * is entered), then a Y or a N depending on whether more functions will be entered (in this case N because only a single function is entered).

The wildcard * used for the upper time limit means that the entered function is valid for the whole simulation. What this means is that a constant temperature equal to 1400 K is used during the whole simulation.
In any simulation at least one *region* must be defined. This is a named container that designates a certain part of, in this case the whole, domain. The name of a region is arbitrary and specified by you.

```
ENTER_REGION <NAME OF REGION>
```

```
enter_region austenite
```

The use of regions becomes clearer in the context of so-called moving phase boundary simulations (see "About the Moving Phase Boundary Simulation" on page 23).

A region must contain a numerical *grid* specified by width and type.

```
ENTER_GRIDCOORDINATES
```

```
(NAME OF REGION FOR WHICH GRID IS TO BE ENTERED)
```

```
(WIDTH OF REGION)
```

```
(TYPE OF GRID)
```

```
(NUMBER OF GRID POINTS)
```

```
enter_grid_coordinates
```

```
austenite
```

```
1e-4
```

```
linear
```

```
60
```

In the entries above, a $10^{-4}$ m wide (1e-4), linear, i.e. equidistant, grid is used with 60 grid points. There are many types of grids, see below for examples, and for other types than the linear there are additional sub-prompts.

These grid types are used in diffusion simulations: linear, geometric and double geometric. When you are setting up the simulation, in either Console Mode or Graphical Mode, a region must have a grid defined.

<table>
<thead>
<tr>
<th>Linear</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Geometric</td>
<td></td>
</tr>
<tr>
<td>Double geometric</td>
<td></td>
</tr>
</tbody>
</table>
A region must contain one *active* phase of type *matrix*. The meaning of active/inactive and phase type is explained in the next examples.

```
ENTER_PHASE_IN_REGION

<ACTIVE OR INACTIVE>

<NAME OF REGION>

<PHASE TYPE IN REGION>

<PHASE NAME>

enter_phase_in_region
active
austenite
matrix
fcc_al
```

In this example only one phase participates, the *fcc_al* phase, and it must therefore be *active* and of type *matrix*.

The initial composition profile must be specified for all phases that take part in a simulation. Since there are only two elements, Fe and Ni, in the present simulation the initial *composition profile* must only be given for one of them.

```
ENTER_COMPOSITIONS

<REGION NAME>

<PHASE NAME>

<DEPENDENT COMPONENT>

<COMPOSITION TYPE>

<COMPONENT NAME>

<TYPE OF COMPOSITION PROFILE>

<COMPOSITION PROFILE DEPENDENT INPUT>

enter_compositions
austenite
fcc_al
fe
weight_percent
```
In the above entries, Fe is chosen as the dependent component and the initial profile for Ni is a linear variation going from 10 mass-% on the lower/left hand side of the system to 50 mass-% on the upper/right hand side of the system. The composition type can be chosen among a number of different types, e.g. weight percent or mole fraction. There are also many different ways of specifying the composition profile, e.g. an arbitrary position dependent function or reading it for each grid point from file. Here the simplest possible type is used a linear function.

Now you set the simulation time. If not specified the initial time is set to zero.

```
SET_SIMULATION_TIME
<SIMULATION_END_TIME>
<AUTOMATIC_TIMESTEP_CONTROL_Y/N>
<MAXIMUM_TIMESTEP>
<INITIAL_SIZE_OF_TIMESTEP>
<SMALLEST_ALLOWED_TIMESTEP>
set_simulation_time
1E5
Y
1E4
1E-7
1E-7
```

Here the simulation time is set to $10^5$ [s] ($1E5$), the maximum timestep size to $10^4$ ($1E4$) and the initial and smallest acceptable to $10^{-7}$ (both $1E-7$). The automatic timestep control should normally always be turned on, which it is by default (you answer Y above).

Now you save the workspace:

```
SAVE_WORKSPACES <FILENAME> <OVERWRITE_EXISTING_FILE Y/N>
```

```
save_workspaces simplest_dictra y
```
The command name SAVE_WORKSPACES can be misleading. The meaning of this command is roughly set result file. The set-up is saved immediately, but all results during the simulation are also saved to the selected file.

Running and Plotting the Simulation

The following command starts the simulation.

```
SIMULATE_REACTION
    simulate_reaction
```

In order to plot results it is necessary to enter the post processor sub-module (note that the GOTO_MODULE command is not used).

```
POST_PROCESSOR
    post_processor
```

In most cases, either a specific position in the domain or one or more specific times must be specified with the SET_PLOT_CONDITION command, depending on whether time or spatial position is chosen as independent (x-axis) variable.

```
SET_PLOT_CONDITION <CONDITION WITH ARGUMENTS>
    set_plot_condition time 0,1e5
```

Here, the composition profile of Ni at the initial and final time is plotted and thus time is chosen as plot condition.

In other cases distance can be given relative to, for example, a phase interface, hence the global specification in the following.

```
SET_DIAGRAM_AXIS <X OR Y> <AXIS QUANTITY>
    set_diagram_axis x distance global
```

In this example the only meaningful measure of distance is relative to the domain as a whole, i.e. the leftmost position is zero and the rightmost position corresponds to the width of the region (10^-4 m).

The dependent property to be plotted is mass-% Ni.

```
    set_diagram_axis y weight_percent ni
```

Then plot the diagram:

```
PLOT_DIAGRAM
    plot_diagram
```

In the Console Results plot window, graphs of the initial and final Ni profile display.
Finally, the SET_INTERACTIVE_MODE command is executed to return control to the user. If the command is absent in a macro the program terminates when the end of the macro file is reached.

```
SET_INTERACTIVE_MODE

set_interactive_mode
```
Moving Phase Boundary Simulations

In this section:

- About the Moving Phase Boundary Simulation .................................................. 23
- Theory for the Moving Phase Boundary Simulation ............................................. 23
- Run the Macro File and Learn the Commands ................................................... 24
About the Moving Phase Boundary Simulation

The growth of ferrite (bcc) into austenite (fcc) is simulated in this example. The austenite is assumed to be initially homogeneous with the composition Fe - 0.15 mass-% C and the transformation temperature is 1050 K. The initial thickness of the austenite is 2 mm and an initially very thin ferrite (1 nm) is also present at the start of the simulation. The initial state is as below.

![Diagram of initial state](image)

The set-up of the Moving Boundary example. There are two regions, Ferrite and Austenite, consisting of bcc and fcc, respectively.

A schematic graph of the carbon profile during the transformation is shown in the image below. Crusius et al (1992) is recommended as further reading.

![Graph of carbon profile](image)

Schematic view of the carbon profile during the transformation from austenite (γ) to ferrite (α) in the Moving Boundary example.

Theory for the Moving Phase Boundary Simulation

It is assumed that local equilibrium holds at the phase interface, i.e. the chemical potentials of all elements are continuous across the boundary, but the chemical potential gradients are in general discontinuous.

---

In order to maintain mass balance a set of flux balance equations must be satisfied at the phase interface:

\[ v^{\alpha/\gamma} \left( c_k^{\alpha} - c_k^{\gamma} \right) = J_k^{\alpha} - J_k^{\gamma} \quad k = 1, \ldots, n - 1 \]

where \( v \) is the interfacial velocity. The concentrations and the fluxes \( c \) and \( J \) are those at the interface on the \( \alpha \) and \( \gamma \) sides, respectively.

In the present case there are no degrees of freedom at the interface and the concentrations can be taken directly from a phase diagram. There is only one flux balance equation and the interface velocity can be evaluated once the fluxes at the interface are known. However, for ternary and higher systems the state at the interface must be found by some iterative procedure.

For more information on moving phase boundary problems, see, for example, Ågren (1982), Crusius et al. (1992) and Höglund (1997).

**Run the Macro File and Learn the Commands**

If the single phase example has just been run, then either restart the software program or open another Console window by clicking the green button with the plus sign.

At the SYS prompt, type `macro` (short for the MACRO_FILE_OPEN command) and press <Enter>. Locate and select the macro file called `simple_moving_boundary.dcm` as described in "Opening the Module and Macro Files" on page 4. The commands in the macro file set up, run and plot the simulation in the Console Results window.

In the macro file some abbreviations of the commands are used. You can shorten command names in an arbitrary manner as long as the abbreviations are unambiguous.

In the macro file most commands are first given as comments with the full name and then abbreviated. Commands that were not used in the single-phase simulation, or are used differently, are explained in more detail.

---

Comments in the macro file can be entered after two “at” symbols (@@). In most cases the arguments of a command can be entered on the same line as the command itself. See "Single-Phase Command Details" on page 13 for more information.

**Moving Phase - Specifying the Thermodynamic System**

This set of commands is the same as in the single-phase simulation example. Thermodynamic and kinetic data is read for Fe and C and the bcc and fcc phases.

```plaintext
@@ goto_module database_retrieval
  go da
@@ switch_database fedemo
  sw fedemo
@@ define_system fe,c
  def-sys fe c
@@ reject phase *
  rej ph *
@@ restore phase fcc_a1,bcc_a2
  rest ph fcc,bcc
@@ get_data
  get
@@ append_database mfedemo
  app mfedemo
@@ define_system fe,c
  def-sys fe c
@@ reject phase *
  rej ph *
@@ restore phase fcc_a1,bcc_a2
  rest ph fcc,bcc
@@ get_data
  Get
```

**Setting Up the Moving Phase Boundary Simulation**

The first region to be entered is entered in the same way as in the single-phase simulation.

```plaintext
@@ goto_module dictra_monitor
```

Moving Phase Boundary Simulations | 25 of 40
go d-m
@@ set_condition global T 0 1050; * N
set-cond glob T 0 1050; * N

A constant temperature equal to 1050K is used in this simulation.
@@ enter_region ferrite
ent-reg ferrite

The phase interface between ferrite and austenite is created by introducing a region called austenite that is attached to the ferrite region. Regions are always separated by phase interfaces and must therefore always contain different matrix type phases.

ENTER_REGION

<NAME OF REGION>

<NAME OF EXISTING REGION TO ATTACH TO>

<ATTACH TO THE RIGHT OF EXISTING REGION Y/N>

enter_region
austenite
ferrite
y

The domain now consists of two regions: ferrite and austenite.

As in the single-phase simulation example, the regions must contain both grids and one active phase of type matrix. These are entered separately for both regions.

enter-grid
ferrite
1e-9
linear
10
enter-grid
austenite
2e-3
geometric
50
1.05
In the above entries, the grid type for the ferrite region is the same as in the single-phase simulation example, i.e. equidistant. For the austenite region the grid type is called geometric and for these grids the grid point spacing changes by a constant factor between every grid point. In this case the spacing increases by 5%, i.e. a factor 1.05, from the lower/left side for each grid point.

These grid types are used in diffusion simulations: linear, geometric and double geometric. When you are setting up the simulation, in either Console Mode or Graphical Mode, a region must have a grid defined.

Now the initial composition of both phases is entered. In this case Fe is automatically chosen to be the dependent component.

```
enter-phase
active
ferrite
matrix
bcc
enter-phase
active
austenite
matrix
fcc
```

Both phases are assumed to be initially homogeneous, the bcc phase having 0.01 mass-% C and the fcc phase 0.15 mass-% C, as shown in the following:

```
enter-composition
ferrite
bcc
w-p
C
```
linear
0.01
0.01
enter-composition
austenite
fcc
w-p
C
linear
0.15
0.15

Set the simulation time and other parameters related to the time-step size.

set-simulation-time
1e5
Y
1e4
1E-7
1E-7

Finally, save the simulation set-up to file.

save simple_moving_boundary yes

**Running and Plotting the Moving Phase Simulation**

These commands are the same as in the single-phase example.

```
@simulate_reaction
sim
@ post_processor
post
```

The ferrite/austenite phase interface position as a function of time is plotted.
Output from the example simple_moving_boundary showing the phase interface position as a function of time.

As mentioned in the single phase example, in general either a specific spatial position or a specific time must be set as a plot condition. Here the phase interface is set as plot condition and it can be referenced as the lower interface of the austenite region or as the upper interface of the ferrite region.

**SET_PLOT_CONDITION**

**<TYPE OF PLOT CONDITION>**

**<FOR INTERFACE CONDITION, SPECIFY REGION>**

**<LOWER OR UPPER INTERFACE OF REGION>**

set-plot-condition
interface
ferrite
upper

Set time as x-axis variable

@@set-diagram-axis x time
s-d-a x time

Now set the interface position as y-axis variable
s-d-a y

POSITION_OF_INTERFACE

<SPECIFY REGION>

<LOWER OR UPPER INTERFACE OF REGION>

pos-of-int ferrite upper

@@ plot_diagram

plot

The plot has the parabolic appearance characteristic for many types of diffusion simulations.
Multiphase Simulations

In this section:

- About the Multiphase Simulation ................................................................. 32
- Theory for the Multiphase Simulation ............................................................ 32
- Run the Macro File and Learn the Commands ............................................. 33
About the Multiphase Simulation

This example simulates the evolution of an Fe-Cr-Ni diffusion couple during a 100 hour heat treatment at 1100 °C (1373.15 K). Both end members of the diffusion couple are duplex ferrite plus austenite, but the majority phase is ferrite on the left-hand side and austenite on the right.

With this type of simulation it is assumed that the material is fully equilibrated at each grid point, i.e. the local phase fractions, phase compositions and so forth are obtained from an equilibrium calculation with the local overall composition as a condition.

Theory for the Multiphase Simulation

More details about the homogenization model for multiphase simulations can be found in Larsson and Engström (2006) and Larsson and Höglund (2009). As mentioned in the

---

description of this simulation, it is assumed that the material is locally fully equilibrated and that the local phase fractions, phase compositions and so forth are obtained from an equilibrium calculation with the local overall composition as a condition. From a numerical point of view the homogenization model treats the multiphase material as a single phase having the “average”, or “effective”, properties of the local phase mixture.

When estimating the effective kinetics of a multiphase mixture the product of solubility and mobility in each phase is considered. It is therefore convenient to define

\[ \Gamma_k^\phi = M_k^\phi c_k^\phi \]

for each phase \( \phi \). The effective kinetics of the multiphase mixture is denoted and in this example it was evaluated using the lower Hashin-Shtrikman bound. The default method is a simple rule of mixtures

\[ \Gamma_k^* = \sum_\phi f_\phi \Gamma_k^\phi \]

where \( f_\phi \) is the volume fraction of \( \phi \). The flux is obtained as

\[ J_k = -\Gamma_k^* \frac{\partial \mu_k}{\partial z} \]

which replaces the single-phase equation

\[ J_k = L_{kk} \frac{\partial \mu_k}{\partial z} = M_k c_k \frac{\partial \mu_k}{\partial z} \]

for multiphase simulations.

**Run the Macro File and Learn the Commands**

At the SYS prompt, type `macro` and press <Enter>. Locate and select the macro file called `multiphase_example.dcm` as described in "Opening the Module and Macro Files" on page 4. The commands in the macro file should set up the simulation, run it and then produce a graph in the Console Results window.

Most of the set-up is the same as the single phase and moving phase boundary examples. Detailed comments are only given for the new commands for this simulation. See "Single-Phase Command Details" on page 13 for more information.
Specifying the Multiphase Thermodynamic System

Data for Fe, Cr and Ni and the fcc and bcc phases are read from the fedemo (thermodynamics) and mfedemo (kinetics) databases.

```go
da
sw fedemo
def-sys fe cr ni
rej ph *
rest ph bcc,fcc
get
app mfedemo
def-sys fe cr ni
rej ph *
rest ph bcc,fcc
get
```

Setting Up the Multiphase Simulation

Set the temperature $T$ during the simulation to 1100°C ($1373.15$ K) and enter a region diffcouple.

```go
dictra-monitor
set-cond glob T 0 1373.15; * N
ent-reg diffcouple
et-grid
diffcouple
3e-3
double
60
0.85
1.15
```

In the above example a so-called double geometric grid is used. This is similar to the geometric grid used in the moving phase boundary example, but instead two geometrical factors are entered, one for the lower and one for the upper half of the region. In the lower half of the region the distance between subsequent grid points decreases by 15% ($0.85$) and in the upper half it increases by 15% ($1.15$). The resulting grid has a much larger grid point density toward the middle of the domain.
As always, a region must contain exactly one active phase that is of type matrix. In this example it is arbitrary whether it is the bcc or the fcc phase that is entered as matrix.

```
enter-phase
active
diffcouple
matrix
fcc
```

The bcc phase is entered in the same manner as the fcc phase, except that the type is set as spheroid.

```
enter-phase
active
diffcouple
spheroid
bcc
```

The initial composition profile of the fcc phase is entered as a function of distance.

```
enter-composition
diffcouple
fcc
fe
m-f
cr
function
2.57e-1+(4.23e-1-2.57e-1)*hs(x-1.5e-3);
ni
function
6.47e-2+(2.75e-1-6.47e-2)*hs(x-1.5e-3);
```

In the above entries, the \( hs \) denotes the Heaviside step function that has the following properties:

\[
hs(x) = \begin{cases} 
0 & x < 0 \\
1 & x \geq 0 
\end{cases}
\]
The resulting Cr profile is thus 0.257 on the left half of the domain and 0.423 on the right with a sharp step at the center.

As shown in "About the Multiphase Simulation" on page 32.

The initial composition of the fcc phase is actually the initial overall composition. This is due to the choice of initial composition of the spheroid bcc phase.

```
ENTER_COMPOSITIONS
<REGION_NAME>
<PHASE_NAME>
<USE EQUILIBRIUM VALUE Y/N>
enter-comp
diffcouple
bcc
y
```

When entering the composition for a type spheroid phase it is possible to either, as here, let the composition of the matrix phase be the overall composition or manually enter a start composition and volume fraction.

The local kinetics of the multiphase mixture must be estimated by means of some function that may depend on the local phase fractions, phase compositions and the mobilities of the individual phases. The command for choosing the function to use is ENTER_HOMOGENIZATION_FUNCTION. There are many such homogenization functions to choose from. In this particular example the so-called lower Hashin–Shtrikman bound (Reference [8]) is a good choice.

```
ENTER_HOMOGENIZATION_FUNCTION
<ENTER FUNCTION NUMBER>
enter-homo-fun
1
```

Finally, set simulation time (100 h) and select the name of the result file:

```
set-sim-time
3.6e5
yes
```

---

3.6e4
1e-7
1e-7
save multiphase_example y

Running and Plotting the Multiphase Simulation Results

Run the simulation.

simulate

Go to the post processor.

post

Plot the mole fraction fcc phase as a function of distance at the end of the heat treatment.

set-plot-condition time last
set-diagram-axis x distance global
set-diagram-axis y npm(fcc)

Instead of explicitly entering the final time it is possible to use the keyword last. The npm of npm stands for number of moles of the phase argument and the m is the normalizing quantity (moles). The limits of an axis can be set with the SET_SCALING_STATUS command. You manually set the scaling of the axis and then restore automatic scaling:

SET_SCALING_STATUS
<X OR Y AXIS>
<USE AUTOMATIC SCALING Y/N>
<IF MANUAL SCALING, ENTER LIMITS>
set-scaling-status x n 1e-3 2e-3

Plot the diagram.

plot

The plot below shows that a single phase fcc zone has formed and this was also observed experimentally, see Reference [9].

Output from the multiphase_example showing the mole fraction fcc phase as a function of distance at the end of the heat treatment.
References


Next Steps

Below are suggestions for you to learn more about using the Diffusion (DICTRA) Module.

- Browse the Online Help (Help → Online Help) or open one of the available PDFs that is included with your installation (Help → Open Manuals Folder).
- You have been working with in Console Mode. You might also want to try the Diffusion Module Graphical Mode Quick Start Guide. (Help → Open Manuals Folder).
- Run other Console Mode examples (Help → Open Examples), which contain many simulation types and advanced functionality. It is a good starting point when you are thinking of creating a new simulation. When you are setting up a new simulation there are two recommended ways to proceed:
  - Copy and gradually adjust an existing macro file from the examples collection.
  - Enter the set-up directly while recording a log file. The command for recording a log file is SET_LOG_FILE and this should be done immediately when starting the program in the SYS module. The log file can then be used as a macro file by changing the file extension from LOG to DCM.
- You can also go to the Thermo-Calc training website to see if there are other options suited to you, such as a course or video tutorials.
Diffusion Module (DICTRA) Command Reference

Thermo-Calc Version 2017a
About This Guide

The guide is for users already familiar with Console Mode and it includes all the commands applicable to the Diffusion Module (DICTRA). It is a supplement to the Thermo-Calc Command Reference, which is included in this Diffusion Module Documentation Set.

How you proceed depends on your experience with the software as well as your level of expertise with diffusion problems. In addition to this guide, the following supplemental documentation and training resources can help you learn how to use the Diffusion Module (DICTRA) in Console Mode.

Documentation Resources

You can search or browse all the documentation available by going to Help → Online Help from inside the program. Also available with your installation is a PDF called the Diffusion Module Documentation Set. This contains some of the same information as the online help but is primarily related to this add-on module.

Quick Start Guides

If you are a new user, a good starting point is to go through the exercises found in the Console Mode Quick Start Guide included in this Documentation Set.

User Guide and Console Mode Examples

If you have no experience with Console Mode it is recommended you start with the Thermo-Calc User Guide. If you are familiar with Thermo-Calc Console Mode but want to learn more about the Diffusion Module in Console Mode, then two supplementary resources are the Diffusion Module User Guide and the Diffusion Module Console Mode Examples Guide.

These guides are included in this Documentation Set.

Training and Video Tutorials

Some of the Graphical Mode examples have video tutorials available either on our website or our YouTube channel. Watching those videos may help you with your simulation in Console Mode. Check back on a regular basis as we are always adding more videos. You may also decide to enroll in a training course or if you have several people interested have some on-site training.
## DICTRA Commands

**In this section:**

General Commands .......................................................... 6  
AMEND_CELL_DISTRIBUTION .......................................... 6  
AMEND_MOBILITY_DATA ................................................ 6  
CHECK_DIFFUSION_MATRIX ............................................ 7  
COARSENING_MODEL .................................................... 8  
CREATE_NEW_CELL ..................................................... 8  
DEBUGGING ................................................................. 8  
DELETE_REGION ........................................................... 9  
ENTER_COMPOSITIONS .................................................. 9  
ENTER_ENHANCEMENT_FACTOR ....................................... 11  
ENTER_GEOMETRICAL_EXPONENT .................................... 12  
ENTER_GRID_COORDINATES .......................................... 12  
ENTER_HEAT_TRANSFER_PARAMETER .................................. 14  
ENTER_HOMOGENIZATION_FUN ....................................... 15  
ENTER_LABYRINTH_FUNCTION ....................................... 17  
ENTER_MOBILITY_DATA ............................................... 17  
ENTER_MOBILITY_ESTIMATE ......................................... 19  
ENTER_PHASE_IN_REGION ............................................. 20  
ENTER_PHASE_IN_REGION - Lamellar Prompts ..................... 21  
ENTER_REGION .......................................................... 25  
GB_MODEL ................................................................. 26  
HOMOGENIZATION_MODEL ............................................ 26  
INPUT_SCHEIL_PROFILE .............................................. 28  
LIST_CONDITIONS ....................................................... 30
<table>
<thead>
<tr>
<th>Command</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>LIST_MOBILITY_DATA</td>
<td>30</td>
</tr>
<tr>
<td>LIST_MOBILITY_ESTIMATES</td>
<td>30</td>
</tr>
<tr>
<td>LIST_PROFILES</td>
<td>30</td>
</tr>
<tr>
<td>LIST_REGION</td>
<td>31</td>
</tr>
<tr>
<td>LIST_TIMESTEPS</td>
<td>31</td>
</tr>
<tr>
<td>MACRO_FILE_OPEN</td>
<td>31</td>
</tr>
<tr>
<td>PARA_EQUILIBRIUM_MODEL</td>
<td>32</td>
</tr>
<tr>
<td>POLY_COMMAND</td>
<td>32</td>
</tr>
<tr>
<td>POST_PROCESSOR</td>
<td>33</td>
</tr>
<tr>
<td>READ_WORKSPACES</td>
<td>33</td>
</tr>
<tr>
<td>SAVE_WORKSPACES</td>
<td>33</td>
</tr>
<tr>
<td>SELECT_CELL</td>
<td>34</td>
</tr>
<tr>
<td>SELECT_TIMESTEP</td>
<td>34</td>
</tr>
<tr>
<td>SET_ACCURACY</td>
<td>35</td>
</tr>
<tr>
<td>SET_ALL_START_VALUES</td>
<td>36</td>
</tr>
<tr>
<td>SET_CONDITION</td>
<td>36</td>
</tr>
<tr>
<td>SET_FIRST_INTERFACE</td>
<td>39</td>
</tr>
<tr>
<td>SET_INITIAL_TEMPERATURE</td>
<td>39</td>
</tr>
<tr>
<td>SET_INTERACTIVE_MODE</td>
<td>39</td>
</tr>
<tr>
<td>SET_NUMERICAL_LIMITS</td>
<td>39</td>
</tr>
<tr>
<td>SET_REFERENCE_STATE</td>
<td>41</td>
</tr>
<tr>
<td>SET_SIMULATION_CONDITION</td>
<td>41</td>
</tr>
<tr>
<td>SET_SIMULATION_TIME</td>
<td>43</td>
</tr>
<tr>
<td>SET_SURFACE_TENSION</td>
<td>44</td>
</tr>
<tr>
<td>SIMULATEREACTION</td>
<td>46</td>
</tr>
<tr>
<td>STORE_HOMOGENIZATION_DATA</td>
<td>46</td>
</tr>
</tbody>
</table>
SWITCH_MODEL ...........................................................................................................46
UTILITIES_HOMOGENIZATION ....................................................................................47
General Commands

These commands are universal in Console Mode.

<table>
<thead>
<tr>
<th>Command/Syntax</th>
<th>Description and Prompts</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;BACK&quot; ON PAGE 4</td>
<td>Return to the previous module. From the POST-processor you go back to the DICTRA-MONITOR module.</td>
</tr>
<tr>
<td>&quot;EXIT&quot; ON PAGE 4</td>
<td>Terminates the program and returns to the operating system. Unless a SAVE_WORKSPACES command has been given before all data entered is lost.</td>
</tr>
<tr>
<td>&quot;GOTO_MODULE&quot; ON PAGE 4</td>
<td>Module name&lt;br&gt;Select and go to another module. The name of the module must be given. In order to obtain a list of available modules give a return.</td>
</tr>
<tr>
<td>&quot;HELP&quot; ON PAGE 5 ?</td>
<td>Enter HELP or ? to either a list of all commands or specific help for a command by giving the command (abbreviated) Command&lt;br&gt;The command for which a description is wanted should be given. If the abbreviation is not unique a list of all matching commands are given.</td>
</tr>
</tbody>
</table>

**AMEND_CELL_DISTRIBUTION**

Use this to amend the cell distribution factor of the currently selected cell.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>AMEND_CELL_DISTRIBUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Cell distribution factor /4.446590813-323/ A parameter that determines the weight of the cell, it can be used to simulate a distribution of different cell sizes.</td>
</tr>
</tbody>
</table>

**AMEND_MOBILITY_DATA**

Use this command to change an existing parameter.

Also see "ENTER_MOBILITY_DATA" on page 17 for information about the parameter names and prompts.
### CHECK_DIFFUSION_MATRIX

Display the diffusion coefficient matrix for a phase at a given composition, pressure and temperature.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>CHECK_DIFFUSION_MATRIX</th>
</tr>
</thead>
</table>

Prompts

- **Output to screen or file** /Screen/

**Phase name**

Name of the phase for which the diffusion coefficient matrix is to be displayed.

**Concentration of**

Concentration of the component in U-fraction for which the diffusion coefficient matrix is to be displayed.

**Pressure**

Pressure for which the diffusion coefficient matrix is to be displayed.

**Temperature**

Temperature at which diffusion coefficient matrix is to be displayed.

Use one or several of the options:

- **D**: reduced diffusion matrix
- **L**: L matrix (diagonal)
- **P**: L' matrix
- **B**: L'' matrix
- **M**: MU(k) array
- **X**: dMU(k)/dCj matrix
- **0**: unreduced diffusion matrix
- **E**: Eigen values of matrix
**COARSENING_MODEL**

The model allows you to perform coarsening simulations. Use this command to explicitly set the DICTRA module to use this model.

Enable or disable the use of the simplified model for calculating Ostwald-ripening in multicomponent systems. This also must be used together with the "SET_SURFACE_TENSION" on page 44 command.

To use this mode, configure the calculation as follows:

- Have one cell only, with a single particle that is 1.5 times larger than the average particle size.
- The matrix phase should be in contact with the maximum size particle on the left/lower side, and then the model specifies a local equilibrium with an average sized particle on the right/upper side.
- The surface energy then results in growth of both the maximum size particle and the matrix phase. Use "SET_SURFACE_TENSION" on page 44 to enter the surface energy to enable coarsening.

Also see "About the Coarsening Model" on page 53 in the Diffusion Module User Guide.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>COARSENING_MODEL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Enable coarsening model /N/</td>
</tr>
<tr>
<td></td>
<td>The default is N. Enter Y to enable the use of this model.</td>
</tr>
</tbody>
</table>

**CREATE_NEW_CELL**

Create a new cell and attach it to the list of current existing cells.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>CREATE_NEW_CELL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Cell distribution factor</td>
</tr>
<tr>
<td></td>
<td>A parameter that determines the weight of the cell, this parameter can be used in order to simulate a distribution of different cell sizes.</td>
</tr>
</tbody>
</table>

**DEBUGGING**

Determines the debugging level. Depending on the value given, different amounts of information are written onto the output device. This can be used to determine what causes
the program to crash during a simulation.

### Diffusion Module (DICTRA) Documentation

### DICTRA Commands

<table>
<thead>
<tr>
<th>Syntax</th>
<th>DEBUGGING</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Debug level (Yes, No, 0, 1, 2, 3, 4) /N/</td>
</tr>
<tr>
<td></td>
<td>The level of debugging information to be displayed.</td>
</tr>
</tbody>
</table>

### DELETE_REGION

Delete a region and all its associated data from the current cell.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>DELETE_REGION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Region name</td>
</tr>
<tr>
<td></td>
<td>The region name to delete.</td>
</tr>
</tbody>
</table>

### ENTER_COMPOSITIONS

Enter the composition into the phases in a region.

The Diffusion Module (DICTRA) in Graphical Mode uses a Diffusion Calculator instead of the Console Mode commands. Some of the Console Mode functionality is available on the Diffusion Calculator, which is described in the *Thermo-Calc User Guide*. However, you cannot use both Graphical Mode and Console Mode in the same simulation.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>ENTER_COMPOSITIONS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompts</td>
<td>Region name</td>
</tr>
<tr>
<td></td>
<td>Name of the region into which the compositions are to be entered.</td>
</tr>
<tr>
<td></td>
<td>Phase name</td>
</tr>
<tr>
<td></td>
<td>Name of the phase in a region into which the compositions are to be entered.</td>
</tr>
<tr>
<td></td>
<td>Use equilibrium value</td>
</tr>
<tr>
<td></td>
<td>This is only for spheroid phases in simulations with dispersed phases. If this option is used the program automatically calculates the equilibrium fractions of the spheroid phase and its constitution at the start of the simulation.</td>
</tr>
<tr>
<td></td>
<td>Dependent substitutional species</td>
</tr>
<tr>
<td></td>
<td>A dependent substitutional species is required in order to be able to determine</td>
</tr>
</tbody>
</table>
### Syntax

<table>
<thead>
<tr>
<th>ENTER_COMPOSITIONS</th>
</tr>
</thead>
</table>

which species are independent. The program only queries for the compositions of the independent species.

Sometimes the dependent species is chosen by the program and thus this question is never given. This may be due to stoichiometric constraints or to the fact that it has been set already in the kinetics database due to the model selected for the diffusion.

### Dependent interstitial species

A dependent interstitial species is required in order to be able to determine which species are independent. The program only queries for the compositions of the independent species.

Vacancies are always regarded as dependent and therefore if vacancies are present in the phase then this question is never given.

### Composition type

Type of composition used for the constitution of the phase. Options are: SITE_FRACTION, MOLE_FRACTION, MOLE_PERCENT, WEIGHT_FRACTION, WEIGHT_PERCENT and U_FRACTION.

### Type

Type of composition profile to be entered, options are: LINEAR, READ_POINT_BY_POINT, FUNCTION, and GEOMETRIC.

- If READ_POINT_BY_POINT is chosen note the following. When compositions are read from a file it may often be the case that both grid coordinates and the composition at the grid points are given on the same line, e.g. the grid coordinates in the first column, the mole fraction of the first element at that grid point in the second column and so on. The column that contain the composition of a given element can then be specified in a macro file by, for example, having a line "read_point_by_point foo.dat 2". The "2" mean that the grid coordinates are in the 2nd column in the file foo.dat. In a corresponding manner the column that contain the grid point coordinates can be specified (see "ENTER_GRID_COORDINATES" on page 12).

- If FUNCTION is chosen the composition profile can be given as a
Syntax | ENTER_COMPOSITIONS
--- | ---
function of the global distance denoted X. Some useful functions are the error function denoted \( \text{erf}(X) \) and the Heaviside step-function denoted \( \text{hs}(X) \). For example the function \( 3+2\text{hs}(x-1e-4) \) provides a concentration of 3 at the left side and 5 at the right side with a sharp step in the concentration profile at \( 1e-4m=100\mu\text{m} \).

<table>
<thead>
<tr>
<th>Value of first point</th>
</tr>
</thead>
<tbody>
<tr>
<td>Composition in the first gridpoint. Values in between are interpolated linearly if a LINEAR type of profile is specified.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Value of last point</th>
</tr>
</thead>
<tbody>
<tr>
<td>Composition for the last gridpoint. Values in between are interpolated linearly if a LINEAR type of profile is specified.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Input file</th>
</tr>
</thead>
<tbody>
<tr>
<td>The input source from which to read the points when entering values point by point, default is TERMINAL.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Value of point</th>
</tr>
</thead>
<tbody>
<tr>
<td>The value of the point when entering values point by point.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Value of R in the geometrical serie</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use the same geometrical factor as for the geometrical grid.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Volume fraction of</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial volume fraction of a spheroid phase.</td>
</tr>
</tbody>
</table>

**ENTER_ENHANCEMENT_FACTOR**

Change the mobility of a specific element in a specific phase. The mobility of the element in the phase is multiplied by a factor which is specified as an argument to the command.

Syntax | ENTER_ENHANCEMENT_FACTOR
--- | ---
Prompt | Mobility enhancement factor for phase
**ENTER_GEOMETRICAL_EXPONENT**

The Diffusion Module (DICTRA) in Graphical Mode uses a Diffusion Calculator instead of the Console Mode commands. Some of the Console Mode functionality is available on the Diffusion Calculator, which is described in the *Thermo-Calc User Guide*. However, you cannot use both Graphical Mode and Console Mode in the same simulation.

Enter the geometrical exponent which defines the geometry of the system. The program handles one-dimensional geometries defined by the geometrical exponent. These geometries are:

- **Planar.** This corresponds to an infinitely wide plate of a certain thickness.
- **Cylindrical.** This corresponds to an infinitely long cylinder of a certain radius.
- **Spherical.** Sphere with a certain radius.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>ENTER_GEOMETRICAL_EXPONENT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Geometrical exponent</td>
</tr>
<tr>
<td></td>
<td>Enter an integer value between 0 and 2.</td>
</tr>
</tbody>
</table>

**ENTER_GRID_COORDINATES**

The Diffusion Module (DICTRA) in Graphical Mode uses a Diffusion Calculator instead of the Console Mode commands. Some of the Console Mode functionality is available on the Diffusion Calculator, which is described in the *Thermo-Calc User Guide*. However, you cannot use both Graphical Mode and Console Mode in the same simulation.

Enter the size and gridpoint distribution of the grid in each region separately. The size of the region is specified in the units that the diffusion data is entered in. The grid in a specific region may also be subdivided into several parts, where the type of each part is chosen independently, by first entering SUB_REGION as the overall grid type.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>ENTER_GRID_COORDINATES</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompts</td>
<td>Region name</td>
</tr>
<tr>
<td></td>
<td>Name of the region into which a grid is to be entered.</td>
</tr>
<tr>
<td></td>
<td>Width of region</td>
</tr>
<tr>
<td></td>
<td>The actual size of the region is entered.</td>
</tr>
</tbody>
</table>
## Syntax

<table>
<thead>
<tr>
<th>Syntax</th>
<th>ENTERGRIDCOORDINATES</th>
</tr>
</thead>
</table>

The size of the region is specified in units compatible with those of the diffusion data.

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td><strong>Type of grid to entered, options are:</strong></td>
</tr>
</tbody>
</table>

- **LINEAR**: For an equally spaced grid.
- **READ_POINT_BY_POINT**: Can be done either from the keyboard or from a predefined file. When grid coordinates are read from a file it may often be the case that both grid coordinates and the composition at the grid points are given on the same line, e.g. the grid coordinates in the first column, the mole fraction of the first component at that grid point in the second column and so on. The column that contain the grid coordinates can then be specified in a macro file by, for example, having a line "read_point_by_point 30 foo.dat 1". The "1" mean that the grid coordinates are in the 1st column in the file foo.dat (and "30" is the total number of grid points). In a corresponding manner the column that contain the composition of a specific component can be specified (see [*ENTER_COMPOSITIONS* on page 9](#)).
- **GEOMETRIC**: Yields a higher number of gridpoints at the lower end of the region if a geometrical factor larger than one is given and a higher number of gridpoints at the upper end of the region if the factor is smaller than one.
- **DOUBLE_GEOMETRIC**: Divides the region in two halves and generates a separate geometrical grid in each half. It gives a high number of gridpoints in the middle or at both ends of a region, two geometrical factors should be entered.

<table>
<thead>
<tr>
<th>Sub_region</th>
<th>If <strong>SUB_REGION</strong> is entered when you are prompted to enter the grid type, then the next prompt is</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>End coordinate in sub region</strong></td>
</tr>
</tbody>
</table>

Enter a value equal to or less than the total width of the region. You are then prompted for the number of grid points and the grid type to be used between the left-hand side of the region and the end coordinate. As long as the end coordinate is less than the total width of the region you are prompted for an end coordinate and the grid to be used in the sub region starting at the end of the former sub region. Thus, progressively higher end coordinates must be
### Syntax

<table>
<thead>
<tr>
<th>Syntax</th>
<th>ENTER_GRID_COORDINATES</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>entered and the final end coordinate must be equal to the total width of the region.</td>
</tr>
<tr>
<td>Number of points</td>
<td>The number of points present in the region. Please consider the interspacing of the grid when determining the number of points.</td>
</tr>
<tr>
<td>Input file</td>
<td>The input source from which to read the points when entering values point by point, default is TERMINAL.</td>
</tr>
<tr>
<td>Value of point</td>
<td>The value of the point when entering values point by point.</td>
</tr>
<tr>
<td>Value of R in the geometrical series</td>
<td>Value in the geometrical factor in the series determining the distribution of the grid points. A geometrical factor larger than one yields a higher density of gridpoints at the lower end of the region and a factor is smaller than one yields a higher density of gridpoints at the upper end of the region.</td>
</tr>
<tr>
<td>Value of R in the geometrical serie for lower part of region</td>
<td>The geometrical factor in the series for the lower (left) part of a region in a double geometrical grid</td>
</tr>
<tr>
<td>Value of R in the geometrical serie for upper part of region</td>
<td>The geometrical factor in the series for the upper (right) part of a region in a double geometrical grid.</td>
</tr>
</tbody>
</table>

### ENTER_HEAT_TRANSFER_PARAMETER

A model for thermos-migration simulates the thermal induced diffusion in temperature gradients. This model requires that the temperature depends on the length coordinate in the system and that the quantity heat of transport \(Q^*\), is entered.
**ENTER_HEAT_TRANSFER_PARAMETER**

**Prompt**
The phase for which the parameter is to be entered. This parameter is entered separately for each component in each phase.

The implementation and functionality of this model is described in Höglund, L. & Ågren, J. “Simulation of Carbon Diffusion in Steel Driven by a Temperature Gradient”. *J. Phase Equilibria Diffus.* 31, 212–215 (2010).

**ENTER_HOMOGENIZATION_FUN**

Use this with the homogenization model for multiphase simulations. The homogenization model is based on the assumption of local equilibrium at each node point, which yields the local chemical potentials at each node point from which the local chemical potential gradients may be estimated. The chemical potential gradients are the driving forces for diffusion. The local kinetics must also be evaluated by some averaging procedure, the choice of which is determined by this command. The local kinetics is evaluated by considering the product of mobility times u-fraction for each component in each phase and the volume fraction of each phase.

The Diffusion Module (DICTRA) in Graphical Mode uses a Diffusion Calculator instead of the Console Mode commands. Some of the Console Mode functionality is available on the Diffusion Calculator, which is described in the *Thermo-Calc User Guide*. However, you cannot use both Graphical Mode and Console Mode in the same simulation.

**Syntax**

<table>
<thead>
<tr>
<th>Syntax</th>
<th>ENTER_HOMOGENIZATION_FUN</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Prompt</strong></td>
<td>Enter homogenization function # /5/</td>
</tr>
<tr>
<td></td>
<td>Enter a digit between 1 and 14 (default is 5). The options corresponding to the numbers are listed below.</td>
</tr>
</tbody>
</table>

**Homogenization Functions**

Enter a digit between 1 and 14 (default is #5) to assign the homogenization function then follow the prompts. The homogenization functions are:
### Function name

<table>
<thead>
<tr>
<th>No.</th>
<th>Function name</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>General lower Hashin-Shtrikman bound*</td>
</tr>
<tr>
<td>2</td>
<td>General upper Hashin-Shtrikman bound*</td>
</tr>
<tr>
<td>3</td>
<td>Hashin-Shtrikman bound with prescribed matrix phase*</td>
</tr>
<tr>
<td>4</td>
<td>Hashin-Shtrikman bound with majority phase as matrix phase*</td>
</tr>
<tr>
<td>5</td>
<td>Rule of mixtures (upper Wiener bound)</td>
</tr>
<tr>
<td>6</td>
<td>Inverse rule of mixtures (lower Wiener bound)</td>
</tr>
<tr>
<td>7</td>
<td>Labyrinth factor $f$ with prescribed matrix phase</td>
</tr>
<tr>
<td>8</td>
<td>Labyrinth factor $f^2$ with prescribed matrix phase</td>
</tr>
<tr>
<td>9</td>
<td>General lower Hashin-Shtrikman bound with excluded phase(s) *</td>
</tr>
<tr>
<td>10</td>
<td>General upper Hashin-Shtrikman bound with excluded phase(s) *</td>
</tr>
<tr>
<td>11</td>
<td>Hashin-Shtrikman bound with prescribed matrix phase with excluded phase(s) *</td>
</tr>
<tr>
<td>12</td>
<td>Hashin-Shtrikman bound with majority phase as matrix phase with excluded phase</td>
</tr>
<tr>
<td>13</td>
<td>Rule of mixtures (upper Wiener bound) with excluded phase(s)</td>
</tr>
<tr>
<td>14</td>
<td>Inverse rule of mixtures (lower Wiener bound) with excluded phase(s)</td>
</tr>
</tbody>
</table>


### About the Homogenization Functions

The geometrical interpretation of the Hashin-Shtrikman bounds are concentric spherical shells of each phase. For the general lower Hashin-Shtrikman bound the outermost shell consists of the phase with the most sluggish kinetics and vice versa for the general upper bound. The geometrical interpretation of the Hashin-Shtrikman bounds suggest further varieties of the bounds, viz. *Hashin-Shtrikman bound with prescribed matrix phase* and *Hashin-Shtrikman bound with majority phase as matrix phase*, where the outermost shell consist of a prescribed phase or the phase with highest local volume fraction, respectively.
The geometrical interpretation of the Wiener bounds are continuous layers of each phase either parallel with (upper bound) or orthogonal to (lower bound) the direction of diffusion.

The labyrinth factor functions (described below) are only available in Console Mode.

The labyrinth factor functions implies that all diffusion takes place in a single continuous matrix phase. The impeding effect on diffusion by phases dispersed in the matrix phase is taken into account by multiplying the flux with either the volume fraction (Labyrinth factor \( f \) with prescribed matrix phase), or the volume fraction squared (Labyrinth factor \( f^2 \) with prescribed matrix phase), of the matrix phase.

The varieties with excluded phases (described below) are only available in Console Mode.

The varieties with excluded phases are useful in several respects. First, if a phase is modelled as having zero solubility for a component, the mobility of that component in that phase is undefined, which causes a (non-terminal) error. Setting a phase as excluded causes the mobility of all components in that phase to be set to zero. Second, often there are some major matrix solid solution phases and some minor precipitate phases. If the mobilities in the minor precipitate phases are zero the lower Hashin-Shtrikman bound is useless as it produces a kinetic coefficient of zero. However, using General lower Hashin-Shtrikman bound with excluded phase(s) the excluded phases are not considered when evaluating what phase has the most sluggish kinetics.

**ENTER_LABYRINTH_FUNCTION**

Enters a constant value or a function of temperature, pressure, or the volume fraction of the phase where diffusion occurs. This function increase or reduces the diffusion coefficient matrix. This function is primarily used when spheroid phases have been entered into a region. It may also be used for increasing or decreasing all diffusion coefficients in a certain matrix phase by a constant factor.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>ENTER_LABYRINTH_FUNCTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Region ( f(T,P,VOLFR,X) = )</td>
</tr>
</tbody>
</table>

**ENTER_MOBILITY_DATA**

Use this command to enter previously non-existing mobility parameters. If there is already a function is defined for the same parameter, it is deleted.

You can also use:
• "ENTER_ENHANCEMENT_FACTOR" on page 11 to enter a factor by which element mobilities are multiplied with.
• "ENTER_MOBILITY_ESTIMATE" on the next page to enter a rough mobility estimate for elements in specific phases. This can be useful for phases where there is no data in the database.

A valid parameter should have the general form of:

<Identifier> ( <Phase name> , <Component array> ; <Digit> )

The identifier must be followed by an opening parenthesis, a phase name, a comma and a component array. Optionally, the component array can be followed by a semicolon and a digit. The parameter name is terminated by a closing parenthesis.

These identifiers are legal:

- MQ (activation energy for mobility)
- MF (frequency factor for mobility)
- DQ (activation energy for diffusivity)
- DF (frequency factor for diffusivity)
- OQ (activation energy for mobility, ordered part)
- OF (frequency factor for mobility, ordered part).

The phase name must be followed by an & and directly following that the name of the diffusing specie.

The component array consists of a list of constituent names. Interaction parameters have two or more constituents separated by a comma. If the phase has sublattices at least one constituent in each sublattice must be specified. The constituents in different sublattices must be given in sublattice order and are separated by a colon.

After the component array a subindex digit can be specified after a semicolon. This digit must be in the range 0 to 9. The interpretation of the subindex depends on the excess model used for the phase. If no semicolon and digit is given the subindex value is assumed to be zero.
<table>
<thead>
<tr>
<th>Syntax</th>
<th>ENTER_MOBILITY_DATA</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Prompt</strong></td>
<td>Parameter: &lt;Parameter name&gt;</td>
</tr>
<tr>
<td></td>
<td>As explained above, specify a correct and complete parameter name, which should contain all the necessary parts of the general form:</td>
</tr>
<tr>
<td></td>
<td>&lt;Identifier&gt;(&lt;Phase&gt;,&lt;Component array&gt;;&lt;Digit&gt;)</td>
</tr>
<tr>
<td></td>
<td>If a parameter name is not acceptable or &lt;Enter&gt;, is pressed, the error message displays:</td>
</tr>
<tr>
<td></td>
<td>*** Error, please re-enter each part separately</td>
</tr>
<tr>
<td><strong>Examples</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• MQ(FCC,C,Fe:Va) Mobility of C in fcc Fe with interstitials.</td>
</tr>
<tr>
<td></td>
<td>• MQ(FCC,C,Fe,Cr;0) The regular parameter for Fe and Cr in fcc.</td>
</tr>
<tr>
<td></td>
<td>• MQ(FCC,C,Fe,Cr;1) The subregular interaction parameter (Redlish-Kister model).</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Identifier</th>
<th>Identifier /MQ/ &lt;MQ, MF, DQ, Df, OQ, OF&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>If this command is used one or more times, the previous value on this prompt is set as default. Press &lt;Enter&gt; for the same type identifier or specify a new type.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Phase Name</th>
<th>Phase name /FCC&amp;C/</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Each parameter is valid for a specific phase. The name of that phase must be supplied. The name must not be abbreviated. The phase name must be followed by an '&amp;' and directly following that, the name of the diffusion specie.</td>
</tr>
</tbody>
</table>

**ENTER_MOBILITY_ESTIMATE**

Use this command to enter a function yielding a mobility estimate for a specific element in a specific phase.

Also see "LIST_MOBILITY_ESTIMATES" on page 30.
ENTER_MOBILITY_ESTIMATE

Prompt
Mobility estimate for phase
Interactively enter a function yielding a mobility estimate for a specific element in a specific phase. This can be used to enter mobility estimates in phases for which there is no assessed data. Estimates entered here override database values.

ENTER_PHASE_IN_REGION

Enter a phase into a previously defined region.

Syntax
ENTER_PHASE_IN_REGION

Prompts
Active or Inactive phase
Type of phase entered. An inactive phase is a phase which does not participate in the calculations until it is stable. This is done by regarding the driving force for precipitation of the phase in an equilibrium calculation. The program then automatically retransforms the inactive phase into an active one.

Region name
Name of the region into which the phase is to be entered.

Phase type
Type of phase entered.
Legal types are:

- MATRIX
- LAMELLAR (see "ENTER_PHASE_IN_REGION - Lamellar Prompts" on the next page).
- SPHEROID: requires that a MATRIX phase has been previously entered.

Phase name
Name of the phase that is to be entered. A #-sign and a digit may append the phase name in order to specify the composition set number, e.g. FCC#2.

Composition set
Number of the composition set. This is needed if the phase has been amended to have more than one composition set and the number was not given directly on the phase name, see above.
Syntax | **ENTER_PHASE_IN_REGION**
---|---
Attach to region named
Enter the name of the region onto which the inactive phase is to be attached.

Attached to the right of
Enter Y to attach the inactive phase on the right side of the region else, enter N to attach on the left side.

Required driving force for precipitation
The required driving force (evaluated as DGM (phase) in POLY-3) to be used for determining whether an inactive phase is stable.

Condition type
Boundary condition used if the inactive phase becomes stable.

**ENTER_PHASE_IN_REGION - Lamellar Prompts**

The following are the "ENTER_PHASE_IN_REGION" on the previous page subprompts for Lamellar.

For a LAMELLAR type of phase, the pearlite calculation model is invoked. The following is displayed:

\[ \text{eutectoid reaction is "gamma"} \Rightarrow \text{"alpha" + "beta"} \]

This is to clarify what is meant with GAMMA, ALPHA and BETA in the specific sub-prompts that display as follows.

<table>
<thead>
<tr>
<th>Subprompts</th>
<th>LAMELLAR</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter name of &quot;alpha&quot; phase</td>
<td></td>
</tr>
<tr>
<td>Enter the GES phase name for the ALPHA phase of the eutectic/eutectoid decomposition product.</td>
<td></td>
</tr>
<tr>
<td>Enter name of &quot;beta&quot; phase</td>
<td></td>
</tr>
<tr>
<td>Enter the GES phase name for the BETA phase of the eutectic/eutectoid decomposition product.</td>
<td></td>
</tr>
<tr>
<td>Enter name of &quot;gamma&quot; phase</td>
<td></td>
</tr>
<tr>
<td>Enter the GES phase name for the GAMMA matrix phase.</td>
<td></td>
</tr>
<tr>
<td>Enter &quot;alpha&quot;/&quot;beta&quot; surface tension:</td>
<td></td>
</tr>
<tr>
<td>Subprompts</td>
<td>LAMELLAR</td>
</tr>
<tr>
<td>------------</td>
<td>----------</td>
</tr>
<tr>
<td></td>
<td>Enter function for the surface tension between the ALPHA and BETA phases, $\sigma_{\alpha/\beta}$</td>
</tr>
<tr>
<td></td>
<td>Enter &quot;alpha&quot;/&quot;gamma&quot; surface tension:</td>
</tr>
<tr>
<td></td>
<td>Enter function for the surface tension between the ALPHA and GAMMA phases, $\sigma_{\alpha/\gamma}$</td>
</tr>
<tr>
<td></td>
<td>Enter &quot;beta&quot;/&quot;gamma&quot; surface tension:</td>
</tr>
<tr>
<td></td>
<td>Enter function for the surface tension between the BETA and GAMMA phases, $\sigma_{\beta/\gamma}$</td>
</tr>
<tr>
<td></td>
<td>Optimum growth condition factor /2/:</td>
</tr>
<tr>
<td></td>
<td>Enter the Optimum-growth-rate-factor. Due to Zener's maximum growth rate criteria this factor has a value of 2 for volume controlled growth and 3/2 for boundary controlled growth. Due to Kirkaldy's extreme in entropy production criteria the values are 3 and 2, respectively.</td>
</tr>
<tr>
<td></td>
<td>Name of dependent element</td>
</tr>
<tr>
<td></td>
<td>Enter the name of the substitutional element to consider as the dependent one.</td>
</tr>
<tr>
<td></td>
<td>Growth model (Volume/Boundary/Kirkaldy) for element x</td>
</tr>
<tr>
<td></td>
<td>Select growth model to be used for element X. Choose between:</td>
</tr>
<tr>
<td></td>
<td>• Volume diffusion model</td>
</tr>
<tr>
<td></td>
<td>• Boundary diffusion model</td>
</tr>
<tr>
<td></td>
<td>• Kirkaldy's mixed mode diffusion model. Implies MIXED, see below.</td>
</tr>
<tr>
<td></td>
<td>df(x) = /Value/Automatic/Mixed/TDB/</td>
</tr>
<tr>
<td></td>
<td>Either input a numerical value on the pre-exponential factor DF or select one of the keywords:</td>
</tr>
<tr>
<td></td>
<td>• AUTOMATIC</td>
</tr>
<tr>
<td></td>
<td>• MIXED</td>
</tr>
<tr>
<td></td>
<td>• TDB</td>
</tr>
</tbody>
</table>
|            | AUTOMATIC is only available for element Carbon. It implies a mixed type

The k' or k'', as appropriate, are given by B. Jönsson (1992)\(^1\). MIXED means a mixed mode calculation using an effective diffusion coefficient. Coefficient k' or k'' is asked for, see below. TDB means calculate the diffusion coefficient for volume diffusion for element X from the parameters stored in the database.

\[ DQ(X) = \]

Input a numerical value on the activation energy DQ for element X.

\[ k' = \]

\[ k'' = \]

Input a numerical value on the k coefficient used to calculate the effective diffusion coefficient, use in MIXED mixed mode calculations, see B. Jönsson: Trita-Mac 478, 1992.

\[ DF_{\text{boundary}}(x) = \]

Input a numerical value on DF for boundary diffusion of element X in a mixed mode calculation.

\[ DQ_{\text{boundary}}(x) = \]

Input a numerical value on DQ for boundary diffusion of element X in a mixed mode calculation.

\[ DF_{\text{volume}}(x) = \]

Input a numerical value on DF for volume diffusion of element X in a mixed mode calculation. N.B. key word TDB may also be used, see TDB above.

\[ DQ_{\text{volume}}(x) = \]

### LAMELLAR

**Input a numerical value on DQ for volume diffusion of element X in a mixed mode calculation.**

**Automatic start values for the s0 determination /Y/:**

Enter Y if you want automatic start values for the unknown parameters in the S0 determination else enter N. S0 is the critical lamellar spacing for which the growth rate is zero.

**Critical thickness of "alpha" lamella:**

If you answered N this prompt displays. The critical thickness of ALPHA is about 0.9 of S0, which in turn is about 1/3 to 1/2 of the observed lamellar spacing S. For binary Fe-C alloys the observed pearlite lamellar spacing is approximately given by

\[ S = 1.75 \cdot 10^{-3} (A_{1e} - T)^{-1} \]

The equation may be used as a start value approx. for alloyed steels. However, use the A_{1e} temperature of the steel.

**Critical thickness of "beta" lamella:**

The critical thickness of BETA is about 0.1 of S0, see above.

**Automatic start values on potentials /Y/:**

Enter Y if you want automatic start values for the unknown potentials.

**Give potentials for "alpha"/"gamma" equil.**

If you answered N this prompt displays. Enter start values for the unknown potentials, MU, at the ALPHA/GAMMA phase boundary.

**Give potentials for "beta"/"gamma" equil.**

Enter start values for the unknown potentials, MU, at the BETA/GAMMA phase boundary.

**Growth rate \( v \):**

Enter a start guess on the growth rate. As a hint on what value to choose we recognize that for binary Fe-C alloys the pearlite growth rate is approximately given by:

\[ S = 8 \cdot 10^{-9} (A_{1e} - T)^{2} \]
**ENTER_REGION**

Enter a region into the system. Enter this before entering a grid or any phases.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>ENTER_REGION</th>
<th>Graphical Mode</th>
</tr>
</thead>
</table>
| Prompts | Region name | **Diffusion Calculator**
Name of a region to be entered. The name of the region can be arbitrarily chosen.

| | Attach to region named | **Conditions** tab under Region |
| | Name of a region to which the new region should be attached. |
| | Attached to the right of |
| | Relative position of the new region. To attach the new region to the right of the named region answer YES, to attach to the left answer NO. |
**GB_MODEL**

Grain-boundary and dislocation assisted diffusion is implemented by assuming that these contributed to the diffusion by using the same frequency factor and a modified bulk activation energy. The grain-boundaries and the dislocations contribute to the total amount of diffusion according to the weighted fractions.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>GB_MODEL</th>
</tr>
</thead>
<tbody>
<tr>
<td>The parameters are entered separately for each region in order to different expression for different phases.</td>
<td></td>
</tr>
<tr>
<td>The used expressions for the grain-boundary and dislocation contributions are:</td>
<td></td>
</tr>
<tr>
<td>( M_{gb} = M_0^{bulk} \cdot \exp(F_{redGB} \cdot Q^{bulk}/R/T) )</td>
<td></td>
</tr>
<tr>
<td>( M_{disl} = M_0^{bulk} \cdot \exp(F_{redDisl} \cdot Q^{bulk}/R/T) )</td>
<td></td>
</tr>
<tr>
<td>where</td>
<td></td>
</tr>
<tr>
<td>( M_0^{bulk} ): frequency-factor in the bulk</td>
<td></td>
</tr>
<tr>
<td>( Q^{bulk} ): activation energy in the bulk</td>
<td></td>
</tr>
<tr>
<td>( F_{redGB} ): Bulk diffusion activation energy multiplier (typical value 0.5)</td>
<td></td>
</tr>
<tr>
<td>( F_{redDisl} ): the bulk diffusion activation energy multiplier (typical value 0.8)</td>
<td></td>
</tr>
<tr>
<td>The weighted calculated value for the mobility ( M^{new} ) is then evaluated from:</td>
<td></td>
</tr>
<tr>
<td>( M^{new} = \delta/d \cdot M_{gb} + \rho \cdot b^2 \cdot M_{disl} + (1 - \delta/d - \rho \cdot b^2) \cdot M^{bulk} )</td>
<td></td>
</tr>
<tr>
<td>where</td>
<td></td>
</tr>
<tr>
<td>( \delta ): the grainboundary thickness (typical value 0.5 \cdot 10^{10})</td>
<td></td>
</tr>
<tr>
<td>( d ): the grainsize as a function of time and temperature (typical value 25 \cdot 10^{-6})</td>
<td></td>
</tr>
<tr>
<td>( \rho ): the dislocation density as a function of time and temperature</td>
<td></td>
</tr>
<tr>
<td>( b ): burgers vector (typical value 1 \cdot 10^{-10})</td>
<td></td>
</tr>
<tr>
<td>( M^{bulk} ): the mobility in the bulk (( \delta/d ) being the fraction of grain boundaries in the bulk and ( \rho \cdot b^2 ) being the fraction of dislocations in the bulk)</td>
<td></td>
</tr>
</tbody>
</table>

**HOMOGENIZATION_MODEL**

This command enables or disables the use of the homogenization model and its default settings. The homogenization model is used for multiphase simulations assuming that local
equilibrium holds at each node point. When entering phases into a region one of them is entered as MATRIX phase and all other phases as SPHEROID, but it does not matter which one is entered as matrix phase and it does not affect simulations. Homogenization model simulations differs from all other DICTRA module simulations in that it is implemented using an implicit finite volume method in order to increase numerical stability (degree of implicitness can be chosen using the "SET_SIMULATION_CONDITION" on page 41 command). Because of this, and other factors, homogenization model simulations generally run slower than other comparable simulations.

The Diffusion Module (DICTRA) in Graphical Mode uses a Diffusion Calculator instead of the Console Mode commands. Some of the Console Mode functionality is available on the Diffusion Calculator, which is described in the Thermo-Calc User Guide. However, you cannot use both Graphical Mode and Console Mode in the same simulation.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>HOMOGENIZATION_MODEL</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Enable homogenization</td>
</tr>
<tr>
<td></td>
<td>Y to enable the homogenization model.</td>
</tr>
<tr>
<td></td>
<td>Use default settings</td>
</tr>
<tr>
<td></td>
<td>Y to use default settings for the homogenization model. For N you are prompted as follows.</td>
</tr>
<tr>
<td></td>
<td>Add ideal flux contribution</td>
</tr>
<tr>
<td></td>
<td>Enter Y or N. For Y, enter a Fractional ideal flux contribution between zero and one. In multiphase regions the system loses degrees of freedom which may cause fluctuations in the composition profiles. This can be amended by adding a small ideal contribution to the fluxes. The ideal flux contribution should normally not be used.</td>
</tr>
<tr>
<td></td>
<td>Use interpolation scheme</td>
</tr>
<tr>
<td></td>
<td>Enter Y or N. The interpolation scheme may speed up simulations. For Y you are prompted with the following:</td>
</tr>
<tr>
<td></td>
<td>• Enter the number of steps in composition space. In the limit where an infinite number of steps are used, exactly the same solution is obtained as without the interpolation scheme. However, excellent results can be obtained with a reasonable discretization.</td>
</tr>
<tr>
<td></td>
<td>• The discretization can be either linear or logarithmic. For the linear discretization the scheme is not used at node points where the content of one or more solutes fall below a certain critical value. For such</td>
</tr>
</tbody>
</table>
Diffusion Module (DICTRA) Documentation

**Syntax**

<table>
<thead>
<tr>
<th>HOMOGENIZATION_MODEL</th>
</tr>
</thead>
<tbody>
<tr>
<td>cases, where composition span many orders of magnitude, the logarithmic discretization can be tried.</td>
</tr>
<tr>
<td>• Enter the fraction of free physical memory to be used by the interpolation scheme.</td>
</tr>
</tbody>
</table>

**Use global minimization**

Enter Y or N whether global minimization should be used in equilibrium calculations. In general, using global minimization significantly increases the simulation time, but there is also a significantly reduced risk for non-converged equilibrium calculations.

**Refresh Jacobian every iteration**

Entering Y increases computational demand for each iteration, but may in some cases improve convergence rate.

**Default grid parameter values**

These settings only affect moving phase boundary simulations where the grid changes during the simulation. If you enter No, these you are prompted with the following:

- Geometrical coefficient. The geometrical coefficient used in each region.
- Fixed interface width. A value larger than zero makes interface widths fixed to that value.
- Grid fineness away from interface. A value other than one causes the grid away from the interface to be coarser (>1) or finer (<1) than what would be obtained just by the geometrical coefficient.
- Interface width fraction. If the interface width isn’t fixed the program aims for a width equal to this factor times the cell width.
- Consecutive critical time-steps to delete region. If the width of a region falls below a certain critical value and shrinks monotonically for this number of time-steps it is deleted.

**INPUT_SCHEIL_PROFILE**

As per normal procedure, and before entering the DICTRA monitor, you need to read thermodynamic and kinetic data to use this command.
This command takes a previously calculated Scheil segregation profile and performs most of the setup needed to use that profile in a simulation, for example a homogenizing heat treatment.

The command creates a region called SCHEIL_REGION. You then create a linear grid and enter the composition read from the file containing the segregation profile.

After issuing this command, you specify simulation time ("SET_SIMULATION_TIME" on page 43) and simulation temperature ("SET_CONDITION" on page 36, enter GLOBAL and variable T) to finalize setup.

In order to limit the computational effort, this feature cannot be combined with the fast diffusers option in the Scheil module.

Also search the online help and refer to the Diffusion Module (DICTRA) User Guide, Thermo-Calc User Guide and Thermo-Calc Console Mode Command Reference for detailed information about Scheil simulations.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>INPUT_SCHEIL_PROFILE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompts</td>
<td>Enter file location of Scheil segregation profile</td>
</tr>
<tr>
<td></td>
<td>In interactive mode (the command line), a file dialogue window opens. Navigate to the file containing the Scheil profile. Alternately, if you are working from a macro file, the line should contain the name of the file.</td>
</tr>
<tr>
<td></td>
<td>Enter width of region</td>
</tr>
<tr>
<td></td>
<td>Enter the width of the region [m] that contains the Scheil profile. This typically corresponds to the secondary dendrite arm spacing.</td>
</tr>
<tr>
<td></td>
<td>Enter main solid solution phase</td>
</tr>
<tr>
<td></td>
<td>Enter the name of one of the main solid solution phases. In the next prompt you can enter other phases that enter the simulation.</td>
</tr>
<tr>
<td></td>
<td>Should more phases be entered in the region</td>
</tr>
<tr>
<td></td>
<td>Enter Y to enter more phases then enter the phase name as prompted next.</td>
</tr>
<tr>
<td></td>
<td>Enter phase name</td>
</tr>
<tr>
<td></td>
<td>Enter the name of another phase that should be entered into the region.</td>
</tr>
</tbody>
</table>
### LIST_CONDITIONS

Lists the conditions set with the "SET_CONDITION" on page 36 command.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>LIST_CONDITIONS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Output file</td>
</tr>
<tr>
<td></td>
<td>File where the information is to be written.</td>
</tr>
</tbody>
</table>

### LIST_MOBILITY_DATA

Lists the mobility data from the database or entered interactively by the "ENTER_MOBILITY_DATA" on page 17 command.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>LIST_MOBILITY_DATA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Output file</td>
</tr>
<tr>
<td></td>
<td>File where the information is to be written.</td>
</tr>
<tr>
<td></td>
<td>This command does not work for encrypted databases.</td>
</tr>
</tbody>
</table>

### LIST_MOBILITY_ESTIMATES

Lists the mobility estimate entered interactively by the "ENTER_MOBILITY_ESTIMATE" on page 19 command.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>LIST_MOBILITY_ESTIMATES</th>
</tr>
</thead>
<tbody>
<tr>
<td>List the mobility estimate entered interactively.</td>
<td></td>
</tr>
</tbody>
</table>

### LIST_PROFILES

Lists the concentration profiles and grid coordinates in the cell.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>LIST_PROFILES</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompts</td>
<td>Name of region</td>
</tr>
<tr>
<td></td>
<td>Name of region(s) in which the profiles are to be listed.</td>
</tr>
<tr>
<td></td>
<td>Output file</td>
</tr>
<tr>
<td></td>
<td>File where the information is to be written.</td>
</tr>
<tr>
<td></td>
<td>Composition type</td>
</tr>
</tbody>
</table>
**Syntax** | **LIST_PROFILES**  
---|---  
Composition type in which the profiles are to be written. Legal composition types are:  
- SITE_FRACTION  
- MOLE_FRACTION  
- WEIGHT_FRACTION  
- U_FRACTION  

**Components**  
The output information may be limited to the specified components.

**Constituents**  
The output information may be limited to the specified constituents.

### LIST_REGION

List the names of the defined regions, active and inactive phases and the global coordinates of the interfaces.

**Syntax** | **LIST_REGION**  
---|---  
**Prompt** | **Output file**  
File where the information is to be written.

### LIST_TIMESTEPS

**Syntax** | **LIST_TIMESTEPS**  
---|---  
List time steps in the workspace and those stored on file during a simulation.  
This for the DICTRA module.

### MACRO_FILE_OPEN

Use this to predefine sequences of commands on a file and then execute them with the MACRO command. This is useful when the same calculation is made often with just small changes. One good case for applying this is when calculating diagrams from an assessment. With a macro file all commands can be stored on a file and you just type MACRO <filename>.
Syntax | MACRO_FILE_OPEN
--- | ---
Prompt | Macro filename
Give the name of the file with the macro commands. Default extension is DCM.
The macro file can contain any legal DICTRA module commands. The macro must be terminated with EXIT or in the SYS, DICTRA, POLY-3 or POST module with the command "SET_INTERACTIVE_MODE" on page 39.

### PARA_EQUILIBRIUM_MODEL

Turns on the para-equilibrium model in the simulation. Using this model implies that the local equilibrium assumption is no longer valid and that substitutional components are regarded as one composite component.

The model is limited to treating only one single moving interface in one cell.

| Syntax | PARA_EQUILIBRIUM_MODEL
--- | ---
Prompt | Enable paraeq
Enables or disables the use of this model by using one of the key words YES or NO.

Auto

Choose this to set it to the value at the region’s lower or upper boundary.

Value %
Enter a value followed by a percentage sign (%) to set it to a certain percentage from the moving boundary inside the region.

-Value
Enter a hyphen (-) followed by a value to set it to a fixed distance from the moving boundary.

Value
Enter a value to set the composition to that specific value,

### POLY_COMMAND

This command sends a string to the POLY-3 module interpreter where it is then executed.
An example of the use of this command is as follows. There are some differences in the default settings for equilibrium calculations based on whether the equilibrium calculation is performed from the DICTRA module or POLY. The changes in the defaults are performed automatically every time the DICTRA module is entered. By using this command it is possible to override those changes.

**POST_PROCESSOR**

Gives control to the post processor which has its own command repertoire.

Also see "POST PROCESSOR Commands" on page 50.

**READ_WORKSPACES**

The DICTRA, POLY-3 and GES5 workspaces can be read from a file where they must be already saved with a SAVE command. This file is not printable.

**SAVE_WORKSPACES**

The workspaces in DICTRA, POLY-3 and GES5 are saved on a file. Return to the state before the SAVE command by entering a READ command. The SAVE command should normally be given before starting a simulation with "SIMULATE_REACTION" on page 46.
**SAVE_WORKSPACES**

- **Syntax:** SAVE_WORKSPACES

- **Prompts:**
  - File name
  - Name of the file where the workspaces shall be saved on.
  - The default file extension is DIC.
  - Overwrite current file content
  - Proceed with save

  If there is already a file with this name and if you answer Y the previous content is overwritten. If you have results from SIMULATE_REACTION these are lost when SAVE is used. You may append several results by the SIMULATE_REACTION command without destroying the previous results but SAVE erases them all.

---

**SELECT_CELL**

Selects the current cell from the list of existing cells and enables you to enter and display data into that cell. This command is for the DICTRA.

Also see the POST PROCESSOR prompt of the same name "SELECT_CELL" on page 59.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SELECT_CELL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Number</td>
</tr>
</tbody>
</table>

- **Prompt:**
  - Specify the cell number by giving an integer or one of the key words NEXT or PREVIOUS.

---

**SELECT_TIMESTEP**

Select a time step from those stored on file during a simulation. The profiles can be listed and simulation can be continued from this time step.
### Syntax

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_ACCURACY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompts</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Prompt</th>
<th>SET_ACCURACY</th>
</tr>
</thead>
</table>

#### Set Timestep

The time step to be selected, legal syntax is:

- FIRST
- LAST
- time
- #nnn
- #?

When selecting a time no interpolation is performed but the time step closest to the time entered is selected. #nnn can be obtained from the number given by LIST_TIMESTEPS or by typing #?.

#### Delete all other timesteps

Clears the current workspace from all other time steps except the one selected. This is necessary if the simulation is to be continued from this time step.

---

**SET_ACCURACY**

Enter the accuracy requirements to use in the determination of the time step when using the automatic time step procedure. It may also be necessary to modify the parameters to control the removal of grid points and set manual starting values for velocities and potentials at the phase interfaces.

The Diffusion Module (DICTRA) in Graphical Mode uses a Diffusion Calculator instead of the Console Mode commands. Some of the Console Mode functionality is available on the Diffusion Calculator, which is described in the *Thermo-Calc User Guide*. However, you cannot use both Graphical Mode and Console Mode in the same simulation.
### SET_ACCURACY

Integration. This parameter must be chosen with some relation to the smallest concentration in the profiles.

### SET_ALL_START_VALUES

Enter starting values for various quantities, such as velocities and potentials.

#### Syntax

<table>
<thead>
<tr>
<th>Prompt</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SET_ALL_START_VALUES</strong>&lt;br&gt;Start value for velocity of interface&lt;br&gt;A starting value for velocity at the named interface is required.</td>
</tr>
<tr>
<td><strong>Start value for potential</strong>&lt;br&gt;A starting value for a potential at the named interface is required. If an AUTOMATIC value is specified the program attempts to determine a starting value and also selects a suitable component for which the potential is varied.</td>
</tr>
<tr>
<td><strong>Varying species in interface</strong>&lt;br&gt;The species which potential is treated as unknown.</td>
</tr>
<tr>
<td><strong>Automatic starting values for phase compositions</strong>&lt;br&gt;Compositions used as starting values in the equilibrium calculations using POLY-3. When using automatic starting values the compositions are taken from the entered profiles.</td>
</tr>
</tbody>
</table>

### SET_CONDITION

Define conditions to reduce the degrees of freedom at equilibrium or defines the boundary conditions at the outer rims of the system. Use it to set the temperature, pressure or heat extracted from the system.

Conditions can be a function of time and different time-dependent functions can be specified at different time intervals. The syntax for this is approximately the same as used in the GES to specify temperature ranges for thermodynamic parameters.

DICTRA uses a constant molar volume, which is included in the flux, i.e. the unit of flux as entered in boundary conditions is:

\[
\text{flux} \times \text{molar volume} = \text{mol} \times \text{m}^{-2} \times \text{s}^{-1} \times \text{m}^3 \times \text{mol}^{-1} = \text{m} \times \text{s}^{-1}
\]
**Syntax** | **SET_CONDITION**
---|---

global or boundary condition

Type of condition to be specified. A global condition is either pressure (P), temperature (T) or heat content removal (P) and may be specified as a function of time. Boundary conditions determine how the cell interacts with the world outside the cell.

**Variable**

Legal variables are pressure (P), temperature (T) or heat extracted (Q) as a function of time (TIME), or time-temperature-pairs (T-T-P) that specifies temperature at a specific time and lets the program calculate the cooling or heating rate. For Q the amount of extracted heat per time unit is normalized and the size of the system is normalized to 1 mole of atoms.

**Boundary**

Defines on which side of the system the boundary conditions are to be specified. Options are UPPER (the rightmost side of the system) and LOWER (the leftmost side of the system).

**Condition type**

Defines the type of boundary condition to be specified. The options may in most cases be functions of both TIME, T (temperature) and P (pressure). The default is CLOSED_SYSTEM which is equivalent to setting the fluxes of all components to zero at the boundary.

Options are:

- **FIX_FLUX_VALUE**: Enter functions that yield the flux times the molar volume for the independent components. May be a function of time, temperature and pressure.

- **STATE_VARIABLE_VALUE**: A legal expression in POLY-3 syntax that reduces the degrees of freedom. This type of boundary condition should be used with the uttermost care as no checks are done if it is a legal expression in advance.

- **POTENTIAL_FLUX_FUNCTION** and **ACTIVITY_FLUX_FUNCTION**: These types of boundary conditions are used to take into account the finite rate of a surface reaction. The flux for the independent components must be given in the format:

  \[ J_i = f_i(T,P,TIME) \times [ACTIVITY_i - g_i(T,P,TIME)] \]  

  or  

  \[ J_i = f_i(T,P,TIME) \times [POTENTIAL_i - g_i(T,P,TIME)] \]  

  where f and g may be
<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_CONDITION</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>functions of time (TIME), temperature (T), and pressure (P), and N is an integer.</td>
</tr>
<tr>
<td></td>
<td>The activities are those with user defined reference states. The function $f_k$ is the mass transfer coefficient, $g_k$ is the activity of the corresponding species in the gas and N is a stoichiometric coefficient.</td>
</tr>
<tr>
<td></td>
<td>• <strong>ITERATIVE_ACTIVITY_FLUX_FUNCTION:</strong> Same as activity flux function above. However, an iterative scheme is used to determine the flux. This method may be used instead of activity flux function when the latter has problems.</td>
</tr>
<tr>
<td></td>
<td>• <strong>CLOSED_SYSTEM:</strong> Corresponds to a fix flux value, which is set to zero at all times.</td>
</tr>
<tr>
<td></td>
<td>• <strong>MIXED_ZERO_FLUX_AND_ACTIVITY:</strong> The flux of selected components is set to zero and the activity of others may be set to a prescribed value.</td>
</tr>
<tr>
<td></td>
<td>• <strong>GAS:</strong> The flux of selected components is set to zero and the activity of others may be set to a prescribed value. This option is used for treating an expanding system, e.g. the growth of an external oxide scale.</td>
</tr>
<tr>
<td><strong>Low time limit</strong></td>
<td>The lower time limit to be used when entering a time dependent function.</td>
</tr>
<tr>
<td><strong>High time limit</strong></td>
<td>The upper time limit to be used when entering a time dependent function. An asterisk * indicates the high limit as infinity.</td>
</tr>
<tr>
<td><strong>Any more ranges</strong></td>
<td>To specify whether any additional time dependent functions exists or not.</td>
</tr>
<tr>
<td><strong>Type of condition for component</strong></td>
<td>The type of condition when setting a boundary condition of the type MIXED. Options are ZERO_FLUX and ACTIVITY.</td>
</tr>
</tbody>
</table>
**SET_FIRST_INTERFACE**

Set the coordinate of the first interface in the cell, when a value other than zero is required, for instance when simulating diffusion through a tube wall or a hollow sphere. The default value is zero.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_FIRST_INTERFACE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Coordinate for first interface</td>
</tr>
<tr>
<td></td>
<td>The coordinate to which the first interface is to be set.</td>
</tr>
</tbody>
</table>

**SET_INITIAL_TEMPERATURE**

This command is only used when the heat removal rate from the system is specified. It yields the initial temperature of the system. How the temperature then varies during the simulation is a result of the heat removed from the system.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_INITIAL_TEMPERATURE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Initial temperature /2000/</td>
</tr>
</tbody>
</table>

**SET_INTERACTIVE_MODE**

Useful in demonstration or macro files in order to stop the execution of the command file and pass over input focus to the keyboard.

- In the DICTRA module POST_PROCESSOR this is called SET_INTERACTIVE_MODE but it is the same command.

**SET_NUMERICAL_LIMITS**

Set parameters to control the integration, the solution of the flux balance equations, diffusion equations and the equilibrium calculation during the simulation.

The Diffusion Module (DICTRA) in Graphical Mode uses a Diffusion Calculator instead of the Console Mode commands. Some of the Console Mode functionality is available on the Diffusion Calculator, which is described in the *Thermo-Calc User Guide*. However, you cannot use both Graphical Mode and Console Mode in the same simulation.
<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_NUMERICAL_LIMITS</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Prompts</strong></td>
<td>Required sum of squares in NS01A</td>
</tr>
<tr>
<td></td>
<td>Required accuracy during the solution of the flux-balance equations.</td>
</tr>
<tr>
<td></td>
<td>Max number of calls to Calfun of NS01A</td>
</tr>
<tr>
<td></td>
<td>The maximum number of iterations when solving the flux-balance equations.</td>
</tr>
<tr>
<td></td>
<td>This number acts as a safety valve, a moderate choice is $10 \times (\text{number}_\text{of}_\text{interfaces} \times (\text{number}_\text{of}_\text{components} - 1))$ but use a larger value if necessary.</td>
</tr>
<tr>
<td></td>
<td>Step used by NS01A</td>
</tr>
<tr>
<td></td>
<td>A user supplied parameter which is used to calculate the estimates of the partial derivatives numerically when solving the flux-balance equations.</td>
</tr>
<tr>
<td></td>
<td>Max step used by NS01A</td>
</tr>
<tr>
<td></td>
<td>A parameter which must be set to a generous estimate of the 'distance' between the initial approximation and the required solution of the flux-balance equations.</td>
</tr>
<tr>
<td></td>
<td>Max number of equidistant points in a region</td>
</tr>
<tr>
<td></td>
<td>The number of equidistant parts in which a region is divided into that is required to describe the profile. This parameter is used by the procedure that removes unnecessary gridpoints from the profile during the simulation; the number of gridpoints is normally not allowed to be less than this number if a linear grid is used.</td>
</tr>
<tr>
<td></td>
<td>Fraction of region assigned to the interface</td>
</tr>
<tr>
<td></td>
<td>Fraction of a region at the region border that is to be regarded as part of the interface. This parameter is used by the procedure that removes unnecessary gridpoints from the profile during the simulation.</td>
</tr>
<tr>
<td></td>
<td>Smallest number used in scaling flux equations</td>
</tr>
<tr>
<td></td>
<td>The flux-balance equations are scaled by the velocities calculated in the previous time step. This number may however decrease to such a small value so that convergence may be affected. The scaling factor is therefore not allowed to decrease below this value.</td>
</tr>
<tr>
<td></td>
<td>Default driving force for inactive phases</td>
</tr>
<tr>
<td></td>
<td>Sets the necessary driving force needed before an inactive phase is allowed to start to precipitate.</td>
</tr>
</tbody>
</table>
SETREFERENCESTATE

The reference state for a component is important when using activities, chemical potentials and enthalpies and it is determined by the data. For each component the data must be referred to a selected phase, temperature and pressure the reference state. All data in all phases where this component dissolves must use the same reference state. However, different datasets may use different reference states for the same element. Thus one must mix data from different databases with caution.

By default activities etc. are computed relative to the reference state used by the database and this may thus differ depending on the database. You can select the reference state of a component if the reference state in the database is not suitable.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SETREFERENCESTATE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Component</td>
<td>The name of the component must be given.</td>
</tr>
<tr>
<td>Reference state</td>
<td>The name of a phase that must be either entered or dormant must be given. The component must be a constituent of this phase of course.</td>
</tr>
<tr>
<td>Temperature</td>
<td>Select the temperature for the reference state. The value * means the temperature used for the calculation.</td>
</tr>
<tr>
<td>Pressure</td>
<td>Select the pressure for the reference state.</td>
</tr>
</tbody>
</table>

SETSIMULATIONCONDITION

Set parameters used to control output and certain parameters during the simulation.
The Diffusion Module (DICTRA) in Graphical Mode uses a Diffusion Calculator instead of the Console Mode commands. Some of the Console Mode functionality is available on the Diffusion Calculator, which is described in the *Thermo-Calc User Guide*. However, you cannot use both Graphical Mode and Console Mode in the same simulation.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_SIMULATION_CONDITION</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>NS01A print control</td>
</tr>
<tr>
<td></td>
<td>Determines whether data should be printed about the iterative procedure to solve flux-balance equations. This parameter is normally set to 0 but can be set to 1 when difficulties with convergence occur. NS01A prints out the values used in the iterations and the residuals.</td>
</tr>
<tr>
<td></td>
<td>Flux correction factor</td>
</tr>
<tr>
<td></td>
<td>This parameter controls if the flux correction scheme should be used in the calculations. The value should normally always be 1.</td>
</tr>
<tr>
<td></td>
<td>Number of delta timesteps in calling MULDIF</td>
</tr>
<tr>
<td></td>
<td>This parameter specifies the number of equally large time steps that one time step should be subdivided into.</td>
</tr>
<tr>
<td></td>
<td>Check interface position</td>
</tr>
<tr>
<td></td>
<td>This parameter determines whether the time step is to be controlled by the phase interface displacement during the simulation.</td>
</tr>
<tr>
<td></td>
<td>Vary potentials or activities</td>
</tr>
<tr>
<td></td>
<td>Determines whether the program should use the potential or the activity of a component in order to find the correct tie line at the phase interface. The potential or the activity is varied by the program and is set in order to reduce the degrees of freedom at the local equilibrium.</td>
</tr>
<tr>
<td></td>
<td>Allow automatic switching of varying element</td>
</tr>
<tr>
<td></td>
<td>Determines whether the program is allowed to itself switch the component that is used to reduce the degrees of freedom at the local equilibrium. The scheme used is that of choosing the components which activities or potentials varied most during the previous time step.</td>
</tr>
<tr>
<td></td>
<td>Save workspace on file</td>
</tr>
<tr>
<td></td>
<td>This parameter determines whether the workspaces are to be saved to file during the course of the simulation. Options are Y to always save to file, N to never save to file, or ## to save every n\textsuperscript{th} time to file where ## is an integer</td>
</tr>
<tr>
<td>Syntax</td>
<td>SET_SIMULATION_CONDITION</td>
</tr>
<tr>
<td>-----------------</td>
<td>------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>value ranging from 0 to 99.</td>
</tr>
<tr>
<td></td>
<td>Degree of implicity when integrating PDEs</td>
</tr>
<tr>
<td></td>
<td>Normally a value of 0.5 (trapezoidal rule) should be used. However, if large fluctuations</td>
</tr>
<tr>
<td></td>
<td>occur in the profiles it may be necessary to use the value 1.0 (Euler backwards).</td>
</tr>
<tr>
<td></td>
<td>• 0.0 Euler forwards</td>
</tr>
<tr>
<td></td>
<td>• 0.5 Trapezoidal rule</td>
</tr>
<tr>
<td></td>
<td>• 1.0 Euler backwards</td>
</tr>
<tr>
<td></td>
<td>Max timestep change per timestep</td>
</tr>
<tr>
<td></td>
<td>Factor specifying the maximum increase in the time step taken from one time step to</td>
</tr>
<tr>
<td></td>
<td>another. For example, if 2 is entered the maximum time step is twice as long as the</td>
</tr>
<tr>
<td></td>
<td>previous time step taken.</td>
</tr>
<tr>
<td></td>
<td>Use forced starting values in equilibrium calculation</td>
</tr>
<tr>
<td></td>
<td>This command mainly concerns the calculation of the equilibrium when using the</td>
</tr>
<tr>
<td></td>
<td>disperse model where the equilibrium calculations sometimes fail due the abrupt changes</td>
</tr>
<tr>
<td></td>
<td>in the composition over the region. If y, then these equilibrium calculations are</td>
</tr>
<tr>
<td></td>
<td>performed using forced starting values in POLY_3.</td>
</tr>
<tr>
<td></td>
<td>Always calculate stiffness matrix in MULDIF</td>
</tr>
<tr>
<td></td>
<td>This determines how often the diffusion coefficient matrix is calculated when solving the</td>
</tr>
<tr>
<td></td>
<td>partial differential equations (PDE) of diffusion problem. The default setting is to</td>
</tr>
<tr>
<td></td>
<td>calculate the diffusion coefficient matrix, yielding the stiffness matrix, at each</td>
</tr>
<tr>
<td></td>
<td>iteration. However, when setting this parameter to N, it is only calculated at the first</td>
</tr>
<tr>
<td></td>
<td>iteration and a constant stiffness matrix is used to obtain the solution to the PDEs.</td>
</tr>
<tr>
<td></td>
<td>This then leads to an implicit solution and therefore the degree of implicitly is</td>
</tr>
<tr>
<td></td>
<td>automatically set to 1.</td>
</tr>
</tbody>
</table>

**SET_SIMULATION_TIME**

Enter the time specific conditions for a simulation.

The Diffusion Module (DICTRA) in Graphical Mode uses a Diffusion Calculator instead of the Console Mode commands. Some of the Console Mode functionality is available on the Diffusion Calculator, which is described in the *Thermo-Calc User Guide*. However, you cannot use both Graphical Mode and Console Mode in the same simulation.
<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_SIMULATION_TIME</th>
</tr>
</thead>
</table>
| Prompts | **End time for integration**  
The time up to which the simulation is to be carried out. |
| **Automatic timestep control** | Determines whether the time step should be controlled by an automatic procedure or not. If you answer N you are prompted for the fixed time step to use during the simulation. The time step determined by the automatic time step control procedure is controlled by the parameters set by the command "SET_ACCURACY" on page 35. |
| **Max timestep during integration** | The maximum time step allowed during the simulation. This is required when using the automatic procedure to determine the time step. |
| **Timestep during integration** | **Fixed time step used when the automatic time step procedure is disabled.** |
| **Initial timestep** | **Time step used as the initial time step.** |
| **Smallest acceptable timestep** | **The smallest time step allowed during the simulation. This is required when using the automatic procedure to determine the time step.** |

**SET_SURFACE_TENSION**

This command enters a distance- and velocity-dependent function which is added to the Gibbs energy of the phase at left side of each phase interface. This can then be used to emulate the effect of surface tension on the equilibrium between at the phase interface or limited phase mobility.
<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_SURFACE_TENSION</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Prompt</strong></td>
<td><strong>Function</strong></td>
</tr>
<tr>
<td>Enter a surface energy function which adds to the Gibbs Energy expression for the phase located at the lower (left) side of the interface. The expression is multiplied with the volume per mole substitutional atoms. This command is also used to simulate a limited interfacial mobility control where the energy function is a function of the interface velocity.</td>
<td></td>
</tr>
<tr>
<td>It is used to enter the surface energy to enable coarsening. However, it can also be used to simulate a case with a limited interfacial mobility.</td>
<td></td>
</tr>
<tr>
<td><strong>This function should only be used in spherical geometries if the function is solely dependent of the interface position.</strong></td>
<td></td>
</tr>
<tr>
<td>Function describing how the (surface) energy function varies with the particle radius and/or the interface velocity.</td>
<td></td>
</tr>
<tr>
<td>The classical expression for the surface energy contribution has the form of:</td>
<td></td>
</tr>
</tbody>
</table>
| \[
| \frac{2\sigma V_m}{r}
| \] |
| The molar volume should be given relative to the molar volume used by default in DICTRA, 1 x 10^{-5} (m^3/mole). The volume should also be given per mole of substitutional atoms. For a precipitate of type M_xC_y this means multiplying with a factor (y+x)/x. If we use M_6C as an example with surface tension 0.5 (J/m^2) and molar volume of 0.71 x 10^{-5} (m^3/mole), the entered function should be 2*0.5*0.71*(7/6)/X; |
| Commonly the surface tension function is defined as: |
| \[ \delta G = 2 \times \Sigma \times V_m / R \] |
| The function to be entered will then be: |
| 2*SIGMA/X; |
| A limited interface mobility can be expressed as: |
| \[ \delta G = v \times V_m / const \] |
| The function to be entered is then: |
| v/"const"; |
**SET_SURFACE_TENSION**

The expression is multiplied by the partial molar volume of the substitutional components.

**SIMULATE_REACTION**

This command starts the simulation. If given without any argument, you are prompted for certain values during simulations where phases appear or disappear.

**STORE_HOMOGENIZATION_DATA**

Read/write the interpolation scheme data to file. The interpolation scheme is an option of the homogenization model that is used to speed up simulations. Use if this option can speed up simulations further.

**SWITCH_MODEL**

Select if the "HOMOGENIZATION_MODEL" on page 26 should attempt to solve the problem if the classic model fails.

There are two solvers for moving phase boundary problems. The classic computationally efficient model and the more robust, but computationally more demanding, homogenization model. By default, the classic solver is tried first. If this fails, then the new solver is tried for a few time-steps before switching back to the classic solver, and so on.
The Diffusion Module (DICTRA) in Graphical Mode uses a Diffusion Calculator instead of the Console Mode commands. Some of the Console Mode functionality is available on the Diffusion Calculator, which is described in the *Thermo-Calc User Guide*. However, you cannot use both Graphical Mode and Console Mode in the same simulation.

### SWITCH_MODEL

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SWITCH_MODEL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompts</td>
<td>Enable automatic switch of model (Y/N)</td>
</tr>
<tr>
<td></td>
<td>Determine if automatic switching from the classic solver to the homogenization model is allowed.</td>
</tr>
</tbody>
</table>

#### UTILITIES_HOMOGENIZATION

Use this with the homogenization model for the available utilities.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>UTILITIES_HOMOGENIZATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompts</td>
<td>Set temperature according to solidus temperature</td>
</tr>
<tr>
<td></td>
<td>Set the global temperature such that it goes to a certain value $T{\text{target}}=T_{\text{sol}}-X$, where $X$ is an entered value. Also enter the rate by which the temperature approaches $T{\text{target}}$. The solidus temperature is determined with a +/- 1 K accuracy.</td>
</tr>
<tr>
<td></td>
<td>Input guesses of the minimum and maximum temperature to occur during the simulation. This utility can be useful to optimize homogenization heat treatments.</td>
</tr>
<tr>
<td></td>
<td>The liquid phase must be entered into the system.</td>
</tr>
<tr>
<td></td>
<td>Dump results to text files</td>
</tr>
<tr>
<td></td>
<td>Select Y to save simulation results to various text files. The names of these files are fixed and are saved to the current working directory.</td>
</tr>
<tr>
<td></td>
<td>Read initial composition from text file</td>
</tr>
<tr>
<td></td>
<td>Select Y to read initial composition from a text file XF.TXT that must be present in the working directory. The file should contain the mole fractions of all elements, in alphabetical order, starting from the first grid point, in the first region, in the first cell.</td>
</tr>
<tr>
<td></td>
<td>Enter ghost phase</td>
</tr>
</tbody>
</table>
|          | Select Y to force the so-called ghost phase to be created. This phase has full
<table>
<thead>
<tr>
<th>Syntax</th>
<th>UTILITIES_HOMOGENIZATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>solubility of all components and zero diffusivity. The Gibbs energy surface of the ghost phase is set above all other phases. The name of this phase is ZZDICTRA_GHOST. It can be used for numerical reasons. It is created automatically if there is a phase that lack solubility range of one or more components and then used internally by the program.</td>
<td></td>
</tr>
<tr>
<td>Enter inactive phases into one region</td>
<td></td>
</tr>
<tr>
<td>Select 1 to make all inactive phases at a given interface to be entered into a single multiphase region when any one of the phases becomes stable.</td>
<td></td>
</tr>
<tr>
<td>Explicitly set substitutional/interstitial</td>
<td></td>
</tr>
<tr>
<td>Select 1 to explicitly select for each element whether it should be substitutional or interstitial. There must be at least one substitutional element in each region. These settings only have effect for the homogenization model and results viewed in the post processor must be interpreted with care; use DUMP RESULTS TO TEXT FILES to get results corresponding to the settings entered here.</td>
<td></td>
</tr>
<tr>
<td>Save average finite volume composition</td>
<td></td>
</tr>
<tr>
<td>Save the average finite volume composition instead of a converted piece-wise linear composition.</td>
<td></td>
</tr>
<tr>
<td>Set constant phase addition</td>
<td></td>
</tr>
<tr>
<td>Add constant Gibbs energy contributions to phases (in J/mol formula unit).</td>
<td></td>
</tr>
<tr>
<td>Use element mobility prefactor</td>
<td></td>
</tr>
<tr>
<td>Enter constant factors which the mobilities of elements are multiplied with in all phases.</td>
<td></td>
</tr>
<tr>
<td>Enter element mobility estimate</td>
<td></td>
</tr>
<tr>
<td>Interactively enter a constant mobility estimate for specific elements in specific phases. This can be used to enter mobility estimates in phases for which there is no assessed data. Estimates entered here override database values.</td>
<td></td>
</tr>
<tr>
<td>Enter minimum save interval</td>
<td></td>
</tr>
<tr>
<td>Enter a minimum time interval (in seconds) that must pass between subsequent saved time-steps. This is useful in cases where a large number of small time-steps may occur in order to keep down the size of the result file.</td>
<td></td>
</tr>
<tr>
<td>Syntax</td>
<td>UTILITIES_HOMOGENIZATION</td>
</tr>
<tr>
<td>--------</td>
<td>--------------------------</td>
</tr>
<tr>
<td>Simplified evaluation of activity boundary condition</td>
<td></td>
</tr>
<tr>
<td>With this setting enabled the fluxes on boundaries are evaluated directly from the activity gradient, i.e. without taking into account the change of state on the boundary caused by the prescribed boundary activities.</td>
<td></td>
</tr>
<tr>
<td>Enter explicit limits on composition</td>
<td></td>
</tr>
<tr>
<td>Use this setting with caution to explicitly enter upper and lower limits on composition for all components (in mole fraction).</td>
<td></td>
</tr>
<tr>
<td>Enter chemical potential contribution</td>
<td></td>
</tr>
<tr>
<td>Enter a function (in valid poly-3 syntax) that is evaluated separately at all grid points and added to the chemical potential of all elements. The contribution affects the flux between grid points.</td>
<td></td>
</tr>
<tr>
<td>Do not balance external boundary fluxes</td>
<td></td>
</tr>
<tr>
<td>For all boundary conditions except type GAS, the flux of substitutional elements into the domain is balanced with the flux of the dependent substitutional elements such that the size of the domain is preserved. Enabling this setting disables the balancing of the substitutional fluxes.</td>
<td></td>
</tr>
<tr>
<td>Fix external boundary flux of dependent component</td>
<td></td>
</tr>
<tr>
<td>Enter a constant flux on the boundary of the dependent substitutional component. For all boundary conditions except type GAS, this flux is otherwise set to a value such that the net substitutional flux is zero.</td>
<td></td>
</tr>
<tr>
<td>Modified kinetics on boundary</td>
<td></td>
</tr>
<tr>
<td>Use this to modify the kinetics on the boundary and enter a factor. If the factor is greater/smaller than one, the mobilities of all elements on the boundary is set equal to the maximum/minimum mobility of all elements times the factor. This can be useful in order to quickly saturate an outermost finite volume.</td>
<td></td>
</tr>
</tbody>
</table>
POST PROCESSOR Commands

In this section:

Purpose and Methodology ....................................................................................... 52
Plot Condition and Independent Variable ............................................................... 52
APPEND EXPERIMENTAL_DATA .............................................................................. 53
DETERMINE_KIRK_PLANE ....................................................................................... 54
DIFFERENTIATE_VALUES ....................................................................................... 54
DUMP_DIAGRAM ..................................................................................................... 54
ENTER_SYMBOL ........................................................................................................ 55
INFORMATION .......................................................................................................... 56
INTEGRATE_VALUES ............................................................................................... 57
LABEL_CURVES ....................................................................................................... 57
LIST_PLOT_SETTINGS ............................................................................................ 57
LIST_REGION_NAMES .............................................................................................. 57
LIST_SYMBOLS ........................................................................................................ 57
LIST_TIME_STEPS .................................................................................................. 58
MAKE EXPERIMENTAL_DATAFILE ......................................................................... 58
PLOT_DIAGRAM ...................................................................................................... 58
PRINT_DIAGRAM ................................................................................................... 58
QUICK EXPERIMENTAL_PLOT ............................................................................... 59
REINITIATE_PLOT_SETTINGS ............................................................................... 59
SELECT_CELL ......................................................................................................... 59
SET_AXIS_LENGTH .................................................................................................. 60
SET_AXIS_PLOT_STATUS ........................................................................................ 60
SET_AXIS_TEXT_STATUS ......................................................................................... 60
SET_AXIS_TYPE ....................................................................................................... 61
SET_COLOR ........................................................................................................... 61
SET_DIAGRAM_AXIS ...................................................................................... 61
SET_DIAGRAM_TYPE .................................................................................... 63
SET_FONT .......................................................................................................... 63
SET_INDEPENDENT_VARIABLE ..................................................................... 64
SET_PLOT_CONDITION ..................................................................................... 64
SET_PLOT_FORMAT ........................................................................................... 66
SET_PLOT_OPTIONS .......................................................................................... 66
SET_PLOT_SIZE ................................................................................................. 67
SET_PREFIX_SCALING ....................................................................................... 67
SET_RASTER_STATUS ......................................................................................... 67
SET_SCALING_STATUS ....................................................................................... 68
SET_TIC_TYPE .................................................................................................... 68
SET_TITLE ........................................................................................................... 69
SET_TRUE_MANUAL_SCALING .......................................................................... 69
Purpose and Methodology

The purpose of the POST PROCESSOR is to read and process data from the internal data structure of the DICTRA module in order to present the result of a simulation in either* GRAPHICAL (command "PLOT_DIAGRAM" on page 58) or* TABULAR FORM (command "MAKE_EXPERIMENTAL_DATAFILE" on page 58).

Before plotting/printing, you have to specify what variables should be plotted on the diagram axis or printed in the table columns. For this purpose there is a command "SET_DIAGRAM_AXIS" on page 61. After having SET both X- and Y-axis variables, you have to SET also plot condition and independent variable. It is also possible to specify a Z-axis. Its values appear as tick marks on the XY-curve.

Plot Condition and Independent Variable

There are two free variables after a simulation done by the DICTRA module. One is the simulation TIME, the other is a DISTANCE in the system.

In general, when plotting a diagram you MUST set either type as fixed, i.e. the plot condition, use command "SET_PLOT_CONDITION" on page 64. The plot condition chosen is printed on a separate line above the diagram.

The other variable is then the independent variable, use command "SET_INDEPENDENT_VARIABLE" on page 64. The independent variable is used as stepping variable. It varies along the calculated curve.
Legal Plot Conditions

- **TIME**: Integration time
- **DISTANCE**: Distance in system. It may be a GLOBAL distance counted from the rightmost interface of the system. Alternatively, it may be LOCAL. The distance is then counted from the LOWER interface of the specific region prompted for.
- **INTERFACE**: At a certain interface. An interface is identified by the NAME of the adjacent region, with the addition that you will be prompted to specify if the interface is at the upper or lower end of the region.
- **INTEGRAL**: Is automatically SET when using an INTEGRAL VARIABLE as axis variable.
- **TIE_LINE**: At a certain interface. Allows you to plot a certain quantity from both sides of an interface. The typical application is for plotting tie-lines.

Legal Independent Variables

- **TIME**: Integration time. Is automatically SET when using an INTEGRAL VARIABLE' or TIME as axis variable.
- **DISTANCE**: Space coordinate. It may be GLOBAL. It is then counted from the rightmost interface of the system. Alternatively, it may be LOCAL. The distance is then counted from the LOWER interface of the specific region prompted for.

**APPEND_EXPERIMENTAL_DATA**

Add experimental data and text on a calculated diagram. The experimental data and text are added to a file prepared according to the syntax of the DATAPLOT graphical language. The picture generated from the data is superimposed on the ordinary graphical output from the POST PROCESSOR. The experimental data file can be created with an ordinary text editor. Another use of the APPEND_EXPERIMENTAL_DATA command is to superimpose plots from several independent calculations. For this purpose, there is a command "MAKE_EXPERIMENTAL_DATAFILE" on page 58 which dumps a calculated diagram on a file according to the DATAPLOT syntax. With the aid of a basic text editor many such files may be merged. Remember to have only one prologue section on the file (see below).

Also see "About DATAPLOT Files" on page 71.
<table>
<thead>
<tr>
<th>Syntax</th>
<th>APPEND_EXPERIMENTAL_DATA</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Prompts</strong></td>
<td>Use experimental (Y or N)</td>
</tr>
<tr>
<td></td>
<td>Specify whether the data from an experimental data file should be included in the next plot. If N, no experimental data is plotted.</td>
</tr>
<tr>
<td></td>
<td><strong>Experimental datafile</strong></td>
</tr>
<tr>
<td></td>
<td>Specify the name of the file with the experimental data. Default file extension is exp.</td>
</tr>
<tr>
<td></td>
<td><strong>Prologue number</strong></td>
</tr>
<tr>
<td></td>
<td>Select which prologue to use. In a prologue one may e.g. give the scaling of an axis, the axis texts, and so on. -1 gives a list of all prologues on the file. Read more about prologues below.</td>
</tr>
<tr>
<td></td>
<td><strong>Dataset number(s)</strong></td>
</tr>
<tr>
<td></td>
<td>Select from which dataset(s) data should be read. Several datasets may be given separated with commas or spaces. -1 gives a list of all datasets on the file.</td>
</tr>
</tbody>
</table>

**DETERMINE_KIRK_PLANE**

To use this command a certain time must be set as plot condition. You are prompted for the position of a plane at time zero. The position of the plane at the plot condition time is then calculated. The difference in position is equal to the Kirkendall shift, i.e. how much an inert marker would drift in the material due to a net flux of vacancies.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>DETERMINE_KIRK_PLANE</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Prompt</strong></td>
<td>Initial zero plane /-1/</td>
</tr>
</tbody>
</table>

**DIFFERENTIATE_VALUES**

<table>
<thead>
<tr>
<th>Syntax</th>
<th>DIFFERENTIATE_VALUES</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Differentiate the plotted curve.</td>
</tr>
</tbody>
</table>

**DUMP_DIAGRAM**

An alternative way to create plots. Supported graphical formats are PNG, BMP, PDF, JPEG and TIFF. The plot is saved to a file.
**ENTER_SYMBOL**

The information about this command is specific to the Diffusion Module (DICTRA) Console Mode. The ENTER_SYMBOL command is also available in the GIBBS, POLY3 and POST modules in Thermo-Calc.

Define a symbolic name to represent either a table or an 'arbitrary' function. Legal variables in functions and columns in tables are described in the sections state variables, auxiliary variables, integral variables or can be previously defined functions. Functions are a useful feature of the POST PROCESSOR to define quantities.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>ENTER_SYMBOL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompts</td>
<td>Function or table /Function/</td>
</tr>
<tr>
<td></td>
<td>Select what kind of symbol to enter.</td>
</tr>
<tr>
<td>Name</td>
<td>Each symbol has a unique name that must start with a letter and can have maximum 8 characters. If one wishes to enter the name and the value on the same line they must be separated with an equal sign =.</td>
</tr>
<tr>
<td>Function</td>
<td>Functions are evaluated from an expression of state variables, auxiliary variables, integral variables or previously defined functions. The expression is a Fortran-like expression and operators +, -, <em>, / and ** can be used (</em>* only with integer powers). Unary functions like LOG, LOG10, EXP, SIN, COS, ABS and ERF can also be used. An expression can be continued on more than one line. An expression should be terminated by a semicolon or an empty line.</td>
</tr>
</tbody>
</table>

**Examples of functions:**

POI (CEM, U) - POI (CEM, L);
The thickness of the region named CEMENTITE

AC (CR) / X (FCC, CR);
**Syntax**

**ENTER_SYMBOL**

The activity coefficient for Cr in phase FCC

\[ \text{SQRT(TIME)}; \]

The square root of the simulation time

&

The ampersand & sub-prompt displays if the function was not terminated by a semicolon. It allows a user to continue to write the function on the new line if one line is not enough for the function. If one has finished the function just press return again.

**Variable(s)**

When entering a table, specify what variables are to be in the various columns. Separate the variables with commas or space characters. At present a maximum of 15 columns are allowed.

- The independent variable is always printed in the first column.

- "Auxiliary Variables" on page 83, "Integral Variables" on page 80, and "State Variables" on page 77 for details and examples of the short names (mnemonics).

**INFORMATION**

Some general information about the POST PROCESSOR module is given.

**Syntax**

**INFORMATION**

Which subject

Select which subject you want additional information about. Type ? to get a list of topics.

- PURPOSE
- **STATE VARIABLES**
- **INTEGRAL VARIABLES**
- **AUXILIARY VARIABLES**
- PLOT CONDITION AND INDEPENDENT VARIABLE
- BASIC METHODOLOGY
**INTEGRATE_VALUES**

<table>
<thead>
<tr>
<th>Syntax</th>
<th>INTEGRATE_VALUES</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Integrate the plotted curve.</td>
</tr>
</tbody>
</table>

**LABEL_CURVES**

Create labels. Each label is explained with to the right of the diagram.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>LABEL_CURVES</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Label curves</td>
</tr>
<tr>
<td></td>
<td>Select Y or N.</td>
</tr>
<tr>
<td></td>
<td>For example: 1. X: X(CR); Y: TIME; PC:3 is read as 1 is a curve with X(CR) on the x-axis, TIME on the y-axis and plot condition PC according to value 3 specified on the plot condition line printed above the diagram.</td>
</tr>
</tbody>
</table>

**LIST_PLOT_SETTINGS**

<table>
<thead>
<tr>
<th>Syntax</th>
<th>LIST_PLOT_SETTINGS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Lists the present values of most parameters specifying the type of diagram to be plotted.</td>
</tr>
</tbody>
</table>

**LIST_REGION_NAMES**

Lists all region names defined.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>LIST_REGION_NAMES</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>All region names have a #-sign and the cell number appended.</td>
</tr>
</tbody>
</table>

**LIST_SYMBOLS**

Lists a specific or all symbols defined.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>LIST_SYMBOLS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Name</td>
</tr>
<tr>
<td></td>
<td>Give the name of a symbol or an asterisk * to list all defined symbols.</td>
</tr>
</tbody>
</table>
**LIST_TIME_STEPS**

This for the POST PROCESSOR module.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>LIST_TIME_STEPS</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Lists all integration time steps.</td>
</tr>
</tbody>
</table>

**MAKE_EXPERIMENTAL_DATAFILE**

Save graphical information in a file with the DATAPLOT format. To merge two or more diagrams from separate calculations, use this command to export it and add them together with a normal text editor.

- Also see "APPEND_EXPERIMENTAL_DATA" on page 53 and "About DATAPLOT Files" on page 71

<table>
<thead>
<tr>
<th>Syntax</th>
<th>MAKE_EXPERIMENTAL_DATAFILE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt Output file</td>
<td>Output file</td>
</tr>
<tr>
<td></td>
<td>File where the graphical information is written. Default file extension is exp</td>
</tr>
</tbody>
</table>

**PLOT_DIAGRAM**

Plot graphical information on the specified device using the plot format set by "SET_PLOT_FORMAT" on page 66.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>PLOT_DIAGRAM</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt Plot file</td>
<td>The name of the file or graphical device.</td>
</tr>
</tbody>
</table>

**PRINT_DIAGRAM**

Print the diagram using the printers defined in Windows. It is only available for a Windows operating system.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>PRINT_DIAGRAM</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Print the diagram using the printers defined in Windows. It is only available for a Windows operating system.</td>
</tr>
</tbody>
</table>
QUICK_EXPERIMENTAL_PLOT

Defines a pair of axes, sets the axis labels to X and Y, and scales both x- and y-axis between 0.0 and 1.0 unless a prologue is read from the data file.

It is similar to the APPEND_EXPERIMENTAL_DATA command but can be used when there is no graphical information to be plotted in the DICTRA module workspace.

Syntax

<table>
<thead>
<tr>
<th>Syntax</th>
<th>QUICK_EXPERIMENTAL_PLOT</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Also see "APPEND_EXPERIMENTAL_DATA" on page 53 for information about the format of the data file.

REINITIATE_PLOT_SETTINGS

Syntax

<table>
<thead>
<tr>
<th>Syntax</th>
<th>REINITIATE_PLOT_SETTINGS</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>All parameters describing the diagram are given as default values.</td>
</tr>
</tbody>
</table>

SELECT_CELL

Select the cell data to be processed. You can only plot data from one cell at a time. Type ? to get a list of valid cell numbers. This command is for the POST PROCESSOR.

Syntax

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SELECT_CELL</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Number</td>
</tr>
</tbody>
</table>

Number of the cell to be selected. Specify cell number by giving an integer or one of the key words NEXT or PREVIOUS.

Prompt

<table>
<thead>
<tr>
<th>Prompt</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Give the symbolic name of the table.</td>
</tr>
</tbody>
</table>

Tabulate

Tabulate a named table.

The independent variable is always printed in the first column.
Syntax | SELECT_CELL
--- | ---
Output file /Screen/
Select output device/file. Press Enter to get output on the screen.

**SET_AXIS_LENGTH**

Change the relative length of an axis, i.e. the number of tic-marks on the axis. The default number of tic-marks on an axis is 10 when the relative length is 1. The number of units per tic-mark must be a multiple of 1, 2, or 5 to obtain a reasonable scaling of an axis.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_AXIS_LENGTH</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompts</td>
<td>Axis</td>
</tr>
<tr>
<td></td>
<td>Specify the axis to set the axis length.</td>
</tr>
<tr>
<td></td>
<td>Axis length</td>
</tr>
<tr>
<td></td>
<td>Specify the relative axis length. The relative length 1 corresponds to 10 tic-marks on the axis.</td>
</tr>
</tbody>
</table>

**SET_AXIS_PLOT_STATUS**

Specify to plot a diagram axis. Use it to merge different diagrams on a pen-plotter or to obtain the diagram faster. The default to plot the axes.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_AXIS_PLOT_STATUS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Axis plot</td>
</tr>
<tr>
<td></td>
<td>Y or N to plot axis.</td>
</tr>
</tbody>
</table>

**SET_AXIS_TEXT_STATUS**

Change the axis text from the automatic text given by the axis specification to another text.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_AXIS_TEXT_STATUS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompts</td>
<td>Axis (X, Y or Z)</td>
</tr>
<tr>
<td></td>
<td>Specify which axis text status to change (if the axis type is INVERSE, X2 or Y2 may be used to set the corresponding opposite linear axis text).</td>
</tr>
<tr>
<td></td>
<td>Automatic axis text (Y or N)</td>
</tr>
</tbody>
</table>
### SET_AXIS_TEXT_STATUS

**Syntax**

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_AXIS_TEXT_STATUS</th>
</tr>
</thead>
</table>

Specify if automatic axis text is to be used or not.

| Axis text         | Enter axis text.     |

### SET_AXIS_TYPE

Select a linear, logarithmic or inverse axis.

**Syntax**

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_AXIS_TYPE</th>
</tr>
</thead>
</table>

**Prompts**

<table>
<thead>
<tr>
<th>Prompt</th>
<th>Axis (X, Y or Z)</th>
</tr>
</thead>
</table>

Specify which axis to change the axis type.

<table>
<thead>
<tr>
<th>Prompt</th>
<th>Axis type</th>
</tr>
</thead>
</table>

Specify which axis type to set. Select **LINEar** (default), **LOGarithmic** or **INVERSE**. Only the three first characters are needed.

### SET_COLOR

On devices that support colors/(line types), select different colors/(line types).

**Syntax**

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_COLOR</th>
</tr>
</thead>
</table>

**Prompt**

- Text and axis Color
- Diagram Color
- DATAPLOT Color

### SET_DIAGRAM_AXIS

Specify the axis variables of a plot. At least two axis variables (x and y) must be specified.

Also see "Auxiliary Variables" on page 83, "Integral Variables" on page 80, and "State Variables" on page 77 for lists of variables including its abbreviated name (i.e. the mnemonic) as well of the names of these variables.
<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_DIAGRAM_AXIS</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Prompts</strong></td>
<td></td>
</tr>
<tr>
<td>Axis (X, Y or Z)</td>
<td>Specifies the axis to set a variable.</td>
</tr>
<tr>
<td><strong>Variable</strong></td>
<td></td>
</tr>
<tr>
<td>Specifies the variable to plot along this axis. A variable is specified by its mnemonic (i.e. its abbreviated name) or by name. The variable types are None, Integral Variables, Functions, Auxiliary Variables or State Variables.</td>
<td></td>
</tr>
<tr>
<td>• <strong>NONE</strong>: Use this variable to clear an axis setting.</td>
<td></td>
</tr>
<tr>
<td>• <strong>INTEGRAL VARIABLES</strong>: A quantity obtained by integration in space over the whole system or over a specific region. In a planar geometry values are given per unit area, in a cylindrical geometry they are given per unit length, and in a spherical geometry they are absolute values. See &quot;Integral Variables&quot; on page 80 for examples.</td>
<td></td>
</tr>
<tr>
<td>• <strong>FUNCTIONS</strong>: These are identified by a name which is entered with the ENTER_FUNCTION command. Use the LIST_SYMBOLS command to get a list of valid function names.</td>
<td></td>
</tr>
<tr>
<td>• <strong>AUXILIARY VARIABLES</strong>: As a complement to state variables and integral variables the auxiliary variables are defined. The variables can be called by their mnemonic names, which are shown in the rightmost column. These are useful in user-defined functions. See &quot;Auxiliary Variables&quot; on page 83 for examples.</td>
<td></td>
</tr>
<tr>
<td>• <strong>STATE VARIABLES</strong>: State variables in the DICTRA POST module are similar to those defined in POLY-3. Examples of state variables are temperature, mole fraction, enthalpy, etc. In POLY-3 a general notation method based on character mnemonics is designed for a predefined set of state variables. See &quot;State Variables&quot; on page 77 for examples.</td>
<td></td>
</tr>
</tbody>
</table>

Depending on the axis variable some sub-prompts may be available.

| For component |                        |
| When an activity, flux, mole-, weight- or U-fraction or percent is plotted the name of the component must be supplied. |

| In region |                        |
| When the lamellar spacing, e.g. for pearlite, is plotted the name of the region must be supplied. |
### Syntax

**SET_DIAGRAM_AXIS**

For phase

When the lamellar thickness, e.g. for ferrite in pearlite, is plotted the name of the phase must be supplied.

Interface

When the velocity or the position of an interface is plotted the name of the interface must be given. An interface is identified by the name of the region on its upper side.

Type

When choosing distance as variable one has additionally to specify what type of distance. A distance may be GLOBAL, i.e. counted from the leftmost interface, or LOCAL, i.e. counted from the interface to the left of the region whose name you are prompted for.

Region name

Name of the region wherein the local distance is measured.

### SET_DIAGRAM_TYPE

Set the diagram to a square (the default) or triangular plot (Gibbs triangle).

#### Syntax

**SET_DIAGRAM_TYPE**

#### Prompts

**Triangular diagram**

Select Y for a triangular plot.

**Plot 3rd Axis**

For triangular plots is selected specify if a 3:rd axis, connecting the end points of the x- and y-axis is plotted.

**Clip along the 3rd axis**

Remove all lines outside the region limited by a line joining the end points of the X- and Y-axis.

### SET_FONT

Select the font to use for labels and numbers when plotting the diagram. For some devices (e.g. PostScript) there may be other fonts available and these are selected by the "SET_"
PLOT_FORMAT" on page 66 command.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_FONT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompts</td>
<td>Select Font number</td>
</tr>
<tr>
<td></td>
<td>Give the number for the font to select. Type ? to get an online list of the available fonts.</td>
</tr>
<tr>
<td></td>
<td>Font size</td>
</tr>
<tr>
<td></td>
<td>A value of 0.3 is recommended.</td>
</tr>
</tbody>
</table>

**SET_INDEPENDENT_VARIABLE**

There are two free variables after a simulation is done in the Diffusion Module (DICTRA). One is the simulation TIME, the other is a DISTANCE in the system. When plotting a diagram you must choose either one to vary along the curve, i.e. the independent variable, the other one is then the plot condition.

⚠️ When plotting integral quantities TIME should be the independent variable.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_INDEPENDENT_VARIABLE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompts</td>
<td>Variable</td>
</tr>
<tr>
<td></td>
<td>Select which variable TIME (integration time) or DISTANCE (space coordinate) to treat as the independent variable.</td>
</tr>
<tr>
<td></td>
<td>Type</td>
</tr>
<tr>
<td></td>
<td>When choosing distance as independent variable specify the type of distance. A distance may be GLOBAL, i.e. counted from the leftmost interface, or LOCAL, i.e. counted from the interface to the left of the region whose name you are prompted for.</td>
</tr>
<tr>
<td></td>
<td>Name of region</td>
</tr>
<tr>
<td></td>
<td>For a LOCAL distance supply the name of the region within which the distance is measured. Type a ?, to get a list of valid region names.</td>
</tr>
</tbody>
</table>

**SET_PLOT_CONDITION**

There are two free variables after a simulation is done in the DICTRA module. One is the simulation TIME, the other one is a DISTANCE in the system. In general, when plotting a
diagram you must choose either type as fixed (i.e. the plot condition), the other one is then the independent variable. However, when plotting integral quantities, plot condition is automatically set to INTEGRAL and TIME is chosen as independent variable. N.B. You cannot mix different kinds of plot conditions. However, for TIME and DISTANCE you may supply up to 15 different condition values, see sub-prompt VALUE(S) below. The plot condition chosen is printed on a separate line above the diagram.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_PLOT_CONDITION</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Condition</td>
</tr>
<tr>
<td></td>
<td>Specify the type of condition to set. Valid conditions are:</td>
</tr>
<tr>
<td></td>
<td>• NONE: Condition not set.</td>
</tr>
<tr>
<td></td>
<td>• TIME: Integration time.</td>
</tr>
<tr>
<td></td>
<td>• DISTANCE: Distance in system.</td>
</tr>
<tr>
<td></td>
<td>• INTERFACE: At a certain interface.</td>
</tr>
<tr>
<td></td>
<td>• INTEGRAL: Value is integrated over the phase/region/system volume</td>
</tr>
<tr>
<td></td>
<td>• TIE_LINE: Pair of values from both sides of certain interface.</td>
</tr>
<tr>
<td>Interface</td>
<td>Specify at which interface the condition should be set. FIRST and LAST refer to the leftmost and the rightmost interface of the system, respectively. Type ? to get a full list of relevant region names.</td>
</tr>
<tr>
<td>Type</td>
<td>When distance is chosen as plot condition specify the type of distance. A distance may be GLOBAL, i.e. counted from the leftmost interface, or LOCAL, i.e. counted from the interface to the left of the region whose name you are prompted for.</td>
</tr>
<tr>
<td>Name of region</td>
<td>Give the name of the region within which the distance is measured.</td>
</tr>
<tr>
<td>At upper interface of region</td>
<td>Give the name of the region which upper interface is specified for the TIE_LINE plotting. This plot-condition allows you to plot a certain quantity from both sides of an interface. The typical application is for plotting tie-lines.</td>
</tr>
</tbody>
</table>
**Syntax**

**SET_PLOT_CONDITION**

Specify if the condition is at the LOWER or UPPER interface of a region. The LOWER interface is placed on the left side of a region and the UPPER interface on its right side.

**Value(s)**

Supply up to 15 numerical values separated by commas or spaces for the condition set. If plot condition TIME was chosen FIRST, LAST or #n (where n is an integer number) may be specified. #? provides a list of time steps.

---

**SET_PLOT_FORMAT**

Adjust the format of the graphical output to another graphical device. Usually the default device is a Tektronix-4010 terminal. This default can be changed with the *[SET_PLOT_ENVIRONMENT]* on page 303 command in the SYSTEM MONITOR or by your TC.INI file, see separate documentation.

**Prompt**

Graphic device number

Depending on the available hardware different plot formats may be available. These are listed with a ?. With some formats there can be additional sub-prompts asking for e.g. font type and size.

---

**SET_PLOT_OPTIONS**

Toggle on/off the plotting options on the diagram.

**Prompts**

Plot header

Toggle the plot of the text above the diagram.

Plot logo

Toggle the plot of the logo at lower-left corner of the diagram.

Plot footer

Toggle the plot of the footer identifier text (only on postscript devices).

White contoured PS CHARs

Toggle the option of having a thin white contour around postscript characters
**SET_PLOT_OPTIONS**

(only on postscript devices).

Plot remote exponents

Toggle the plot of the remote exponents on the axis.

Plot cell #

Toggle the plot of the cell number text at the upper-right corner of the diagram.

Plot condition status

Toggle the plot of the plot-condition status line above the diagram.

---

**SET_PLOT_SIZE**

Specify a relative scale factor to change the size of the diagram. The default value of the scaling factor depends on what output device is chosen by the "SET_PLOT_FORMAT" on the previous page command. The default plot size is adjusted to the chosen device.

Syntax | SET_PLOT_SIZE
---|---
Prompt | Relative plot size
| Enter the relative scaling factor.

**SET_PREFIX_SCALING**

When prefix scaling is enabled the remote exponent for an axis is automatically chosen to have a value which is a multiple of three, i.e. ..., -6, -3, 0, 3, 6, ...

Syntax | SET_PREFIX_SCALING
---|---
Prompts | Axis (X or Y)
| Specify X- or Y- axis.
Use prefix scaling
| Enables or disables prefix scaling, Y or N. Give an integer value to select a prefix power of your own.

**SET_RASTER_STATUS**

Set to have a raster plotted in the diagram. Default is no raster plotted.
**SET_RASTER_STATUS**

Raster plot (Y or N) /Y/

Enables (Y) or disables (N) the raster plot.

**SET_SCALING_STATUS**

Choose between manual or automatic scaling on a specified axis. If manual scaling is chosen specify a minimum and a maximum value. Manual scaling can be used to magnify interesting parts of a diagram. When an axis variable is selected by the "SET_DIAGRAM_AXIS" on page 61 command the scaling status for the axis is always set to automatic scaling.

**SET_TIC_TYPE**

Change the size of the tic marks and the placement either inside or outside of the axis.
## SET_TITLE

Specify a title that displays on all listings and diagrams from the POST PROCESSOR.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_TITLE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Title</td>
</tr>
<tr>
<td></td>
<td>Enter the title to include on all output. There is a maximum length of about 60 characters.</td>
</tr>
</tbody>
</table>

## SET_TRUE_MANUAL_SCALING

Set to manual scaling instead of the default where the tic marks on the axis are placed in even intervals using the whole axis length. The scaling routine adjusts the given minimum and maximum values slightly to accomplish this. The command works like a toggle. To reset the scaling behavior just repeat the command a second time.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_TRUE_MANUAL_SCALING</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt Axis (X or Y)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Specify the axis you want to toggle between automatic adjustment or avoiding the adjustment of the given maximum and minimum values.</td>
</tr>
</tbody>
</table>
DATPLOT Files

In this section:

About DATAPLOT Files ................................................................. 71
About DATAPLOT Files

A DATAPLOT file can be divided into two sections. The prologue, which contains directives for manipulating the default settings on the diagram layout, and the dataset, which contains the actual data and any text to be plotted in the diagram. The sections may contain multiple PROLOGUE and DATASET statements, respectively.

Also see the DATPLOT User Guide included with this documentation set.

All prologues must be placed before the first DATASET statement.

The syntax must be used for the DATAPLOT file.

In general, each line in a DATAPLOT file must consist of a legal keyword plus its parameters or an XY coordinate pair.

An XY coordinate pair is two real numbers and an optional graphical operation code (GOC).
### Keywords for Prologues

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>PROLOGUE</td>
<td>inumb text</td>
</tr>
<tr>
<td>XSCALE</td>
<td>min max</td>
</tr>
<tr>
<td>YSCALE</td>
<td>min max</td>
</tr>
<tr>
<td>XTEXT</td>
<td>text</td>
</tr>
<tr>
<td>YTEXT</td>
<td>text</td>
</tr>
<tr>
<td>XTYPE</td>
<td>LIN, LOG or INV</td>
</tr>
<tr>
<td>YTYPE</td>
<td>LIN, LOG or INV</td>
</tr>
<tr>
<td>XLENGTH</td>
<td>rnumb</td>
</tr>
<tr>
<td>YLENGTH</td>
<td>rnumb</td>
</tr>
<tr>
<td>DIAGRAM_TYPE</td>
<td>TRIANGULAR or SQUARE</td>
</tr>
<tr>
<td>TIC_TYPE</td>
<td>rnumb</td>
</tr>
<tr>
<td>TITLE</td>
<td>text</td>
</tr>
</tbody>
</table>

### Keywords for Datasets

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>DATASET</td>
<td>inumb text</td>
</tr>
<tr>
<td>FONT</td>
<td>inumb</td>
</tr>
<tr>
<td>CHARSIZE</td>
<td>rnumb</td>
</tr>
<tr>
<td>COLOR</td>
<td>inumb</td>
</tr>
<tr>
<td>GLOBALSIZE</td>
<td>inumb</td>
</tr>
<tr>
<td>LFSIZE</td>
<td>rnumb</td>
</tr>
<tr>
<td>LINETYPE</td>
<td>inumb</td>
</tr>
<tr>
<td>BLOCK</td>
<td>Select one X and one Y variable</td>
</tr>
<tr>
<td>GOC=C3,DEFGOC;</td>
<td>X=C1+273.15; Y=LOG10(C2);</td>
</tr>
<tr>
<td>Keyword</td>
<td>Parameters</td>
</tr>
<tr>
<td>-------------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>BLOCK</td>
<td>GOC=C3,DWR; X1=C1+273.15; X2=C1; Y=C1+C2*4.184;  or multiple X and one Y variable</td>
</tr>
<tr>
<td>BLOCK</td>
<td>GOC=C4,MWAS; X=C1+273.15; Y1=C2*4.184; Y2=C3;  or one X and multiple Y variables</td>
</tr>
<tr>
<td>BLOCK</td>
<td>GOC=C5,DWA; X1=C1; X2=C4; Y1=C2*4.184; Y2=C3;  or multiple XY pairs</td>
</tr>
<tr>
<td>BLOCKEND</td>
<td></td>
</tr>
<tr>
<td>DRAWLINE</td>
<td>x,y x,y</td>
</tr>
<tr>
<td>TEXT</td>
<td>text or ~name (of a string, see below)</td>
</tr>
<tr>
<td>ATTRIBUTE</td>
<td>TOP, CENTER or BOTTOM</td>
</tr>
</tbody>
</table>
| STRING      | name text  
The text string may contain text formatting codes namely: ^S# to set font size, ^G for Greek font, ^F# to set font type, ^U# for positioning the text upwards, ^D# for positioning the text downwards, ^R# for positioning the text to the right, ^L# for positioning the text to the left, and finally ^N for printing without updating current position to the end of the character. These text formatting codes only work for soft fonts not hardcopy postscript fonts. |
| INCLUDE     | filename                                                                  |
| CLIP        | ON or OFF                                                                 |
| SYMBOLSIZE  | rnumb                                                                     |
| FUNCTION    | Y=203(X); or X=203(Y); <start end steps GOC>                             |
|             | The <> denotes an optional parameter.                                    |
| PAINT       | <code> <video> <mode>  
The <> denotes optional parameters. Paint the area enclosed by the current path in the current pattern. The current path starts at |
### Keyword Parameters

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>the last 'moveto' given and includes all subsequent 'draws'. Also see PCFUNCTION below. Default is &lt;code&gt;=0, &lt;video&gt;=NORMAL and &lt;mode&gt;=TRANSPARENT. To set a new current pattern supply any or all of the optional parameters. &lt;code&gt; is a single letter 0-9, A-Z or a-t (if &lt;code&gt;=t supply also a number in the range 0.00 - 1.00, e.g. PAINT t 0.25.) &lt;video&gt; is a string reading NORMAL or INVERSE. &lt;mode&gt; is a string reading TRANSPARENT or OPAQUE.</td>
<td></td>
</tr>
</tbody>
</table>

### PCFUNCTION

Y=203(X); or X=203(Y);  

<start end steps GOC>  
The <> denotes an optional parameter. May be used to add a function to the current path.

### Available GOCs

These are the available GOCs:

- **W**: World coordinates (* DEFAULT)
- **V**: Virtual coordinates
- **N**: Normalized plot box coordinates (NPC)
- **M**: Move to this XY (*)
- **D**: Draw to this XY
- **A**: XY is absolute values (*)
- **R**: XY are relative values
- **S**: Plot current symbol at XY
- **B**: Apply soft spines on the drawn curve (use only on BLOCK data)
- **S2**: Change current symbol to 2 and plot at XY
- **'**: Plot the following text at XY

### Example

```
700 2.54
50 1.91 WRDS
```
1.1 0.9 NS3
100 20'This is a text
BLOCK GOC=C3,MWAS; X=C1+273.15; Y=C2*4.184;
600 -1400 S1'text
700 -1500
BLOCKEND
# State, Integral and Auxiliary Variables

In this section:

- State Variables ................................................................. 77
- Intensive Properties .............................................................. 77
- Extensive Properties .............................................................. 77
- Integral Variables ................................................................. 80
- Auxiliary Variables ............................................................... 83
State Variables

State variables in the DICTRA POST module are similar to those defined in Thermo-Calc POLY-3 module. Examples of state variables are temperature, mole fraction, enthalpy, etc. In POLY-3 a general notation method based on character mnemonics is designed for a predefined set of state variables.

Also see "SET_DIAGRAM_AXIS" on page 61 and "ENTER_SYMBOL" on page 55 commands in the DICTRA POST module.

The numerical values of some state variables, e.g. activity, chemical potential, and the energetic extensive properties, are given relative to some reference state which has been defined in the thermodynamic database file. Sometimes you may have specified a reference state using "SETREFERENCESTATE" on page 224. To get numerical values relative to the user-defined reference state, append an R to the mnemonic names as defined.

### Intensive Properties

<table>
<thead>
<tr>
<th>Mnemonic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>T</td>
<td>temperature</td>
</tr>
<tr>
<td>P</td>
<td>pressure</td>
</tr>
<tr>
<td>AC(component)</td>
<td>activity</td>
</tr>
<tr>
<td>MU(component)</td>
<td>chemical potential</td>
</tr>
</tbody>
</table>

### Extensive Properties

NORMALIZATION of extensive properties: For all extensive properties a suffix can be added to the mnemonic name to indicate a normalized extensive property. The following tables describe each mnemonic.
**Extensive property `Z at each grid point**

<table>
<thead>
<tr>
<th>Mnemonic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Z</td>
<td>Extensive property `Z at each grid point.</td>
</tr>
<tr>
<td>ZM</td>
<td>Extensive property `Z per moles of atoms.</td>
</tr>
<tr>
<td>ZW</td>
<td>Extensive property `Z per mass (gram).</td>
</tr>
<tr>
<td>ZV</td>
<td>Extensive property `Z per volume (m³).</td>
</tr>
</tbody>
</table>

**Extensive property `Z for a phase at each grid point**

<table>
<thead>
<tr>
<th>Mnemonic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Z</td>
<td>Extensive property `Z for the current amount of the phase.</td>
</tr>
<tr>
<td>ZM</td>
<td>Extensive property `Z per mole of atoms of the phase.</td>
</tr>
<tr>
<td>ZW</td>
<td>Extensive property `Z per mass (gram) of the phase.</td>
</tr>
<tr>
<td>ZV</td>
<td>Extensive property `Z per volume (m³) of the phase.</td>
</tr>
<tr>
<td>ZF</td>
<td>Extensive property `Z per mole formula unit of the phase.</td>
</tr>
</tbody>
</table>

**Energetic extensive properties**

Suffixes M, W, V and F can be applied.

<table>
<thead>
<tr>
<th>Mnemonic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>S</td>
<td>entropy</td>
</tr>
<tr>
<td>S(phase)</td>
<td>entropy of a phase</td>
</tr>
<tr>
<td>V</td>
<td>volume</td>
</tr>
<tr>
<td>V(phase)</td>
<td>volume of a phase</td>
</tr>
<tr>
<td>G</td>
<td>Gibbs energy</td>
</tr>
<tr>
<td>G(phase)</td>
<td>Gibbs energy of a phase</td>
</tr>
<tr>
<td>H</td>
<td>enthalpy</td>
</tr>
</tbody>
</table>
### State, Integral and Auxiliary Variables

<table>
<thead>
<tr>
<th>Mnemonic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>H(phase)</td>
<td>enthalpy of a phase</td>
</tr>
<tr>
<td>A</td>
<td>Helmholtz energy</td>
</tr>
<tr>
<td>A(phase)</td>
<td>Helmholtz energy of a phase</td>
</tr>
</tbody>
</table>

#### Amount of components

Suffixes M, W and V can be applied.

<table>
<thead>
<tr>
<th>Mnemonic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>N(component)</td>
<td>Number of moles of a component.</td>
</tr>
<tr>
<td>N(phase,component)</td>
<td>Number of moles of a component in a phase.</td>
</tr>
<tr>
<td>B(component)</td>
<td>Mass of a component.</td>
</tr>
<tr>
<td>B(phase,component)</td>
<td>Mass of a component in a phase.</td>
</tr>
</tbody>
</table>

#### Total amount

Suffixes M, W and V can be applied.

<table>
<thead>
<tr>
<th>Mnemonic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>N</td>
<td>Number of moles</td>
</tr>
<tr>
<td>B</td>
<td>Mass</td>
</tr>
</tbody>
</table>

![The legal combination BW is not very interesting as it will always be unity. BV is the density](image)

#### Amount of a phase

Suffixes M, W and V can be applied.

The normalizing properties are calculated at each grid point.
## Mnemonic Description

<table>
<thead>
<tr>
<th>Mnemonic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NP(phase)</td>
<td>Number of moles of a phase.</td>
</tr>
<tr>
<td>BP(phase)</td>
<td>Mass of a phase.</td>
</tr>
<tr>
<td>VP(phase)</td>
<td>Volume of a phase.</td>
</tr>
<tr>
<td>Y(phase,species#sublattice)</td>
<td>site fraction</td>
</tr>
</tbody>
</table>

### Constitution

This quantity is dependent upon the model chosen for the phase.

<table>
<thead>
<tr>
<th>Mnemonic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Y(phase,species#sublattice)</td>
<td>site fraction</td>
</tr>
</tbody>
</table>

### Integral Variables

An integral variable is a quantity that has been obtained by integration in space over the whole system or over a specific region. In a planar geometry values are given per unit area, in a cylindrical geometry they are given per unit length, and in a spherical geometry they are absolute values.

Also see "SET_DIAGRAM_AXIS" on page 61 and "ENTER_SYMBOL" on page 55 commands in the DICTRA POST module.

The variable mnemonics are constructed in the following way.

- The first letter is always I for INTEGRAL VARIABLE.
- The second letter specifies quantity.
- The third letter is OPTIONAL and specifies the normalizing quantity.

### First and Second Letter

<table>
<thead>
<tr>
<th>Class</th>
<th>Quantity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>I</td>
<td>N</td>
<td>for number of moles</td>
</tr>
<tr>
<td>I</td>
<td>W</td>
<td>for mass</td>
</tr>
<tr>
<td>I</td>
<td>V</td>
<td>for volume</td>
</tr>
<tr>
<td>I</td>
<td>U</td>
<td>for number of moles of volume-contributing elements</td>
</tr>
<tr>
<td>II</td>
<td>S</td>
<td>for entropy</td>
</tr>
<tr>
<td>II</td>
<td>H</td>
<td>for enthalpy</td>
</tr>
<tr>
<td>II</td>
<td>G</td>
<td>for Gibbs energy</td>
</tr>
<tr>
<td>II</td>
<td>A</td>
<td>for Helmholtz energy</td>
</tr>
</tbody>
</table>
**Class I**

Integral quantities of CLASS=I may take 0-3 arguments.

The arguments MUST be given in 'falling' order of significance.

1. Region name
2. Phase name
3. Component name
Class II

Integral quantities of CLASS=II may take 0-2 arguments.
The arguments MUST be given in 'falling' order of significance.

1. Region name
2. Phase name

Third Letter - Normalizing Quantity

<table>
<thead>
<tr>
<th>Quantity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>N</td>
<td>for total number of moles in system</td>
</tr>
<tr>
<td>W</td>
<td>for total mass of system</td>
</tr>
<tr>
<td>V</td>
<td>for total volume of system</td>
</tr>
<tr>
<td>U</td>
<td>for total number of moles of volume-contributing elements in system</td>
</tr>
</tbody>
</table>

Examples

- IW(PEARLITE,BCC,CR) is the mass of CR in the BCC phase in region PEARLITE.
- IW(PEARLITE,BCC) is the mass of BCC phase in region PEARLITE. IW is the total mass in the system.
- IVV(Austenite) is the volume fraction of Austenite in a single cell calculation.
- IVV(2, Austenite) is the volume fraction of Austenite in Cell 2 for a multi cell calculation.

Auxiliary Variables

The following table lists auxiliary variables that are associated with both names and mnemonics.

Also see "SET_DIAGRAM_AXIS" on page 61 and "ENTER_SYMBOL" on page 55 commands in the DICTRA POST module.

Interface names are the same as the region names with the addition that you also have to specify if the interface is at the U(pper) or L(ower) end of the regions.
Name and Mnemonic Auxiliary Variables

<table>
<thead>
<tr>
<th>Name</th>
<th>Mnemonic</th>
<th>Argument</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACTIVITY</td>
<td>AC(component)</td>
<td>component</td>
</tr>
<tr>
<td>DISTANCE</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FLUX</td>
<td>JV(component)</td>
<td>component</td>
</tr>
<tr>
<td>LAMELLAR-SPACING</td>
<td>LS(name)</td>
<td>region name</td>
</tr>
<tr>
<td>LAMELLAR-THICKNESS</td>
<td>LT(name)</td>
<td>phase name</td>
</tr>
<tr>
<td>MOLE-FRACTION</td>
<td>X(component)</td>
<td>component</td>
</tr>
<tr>
<td>MOLE-PERCENT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>POSITION-OF-INTERFACE</td>
<td>POI(name,U/L)up*</td>
<td>interface name</td>
</tr>
<tr>
<td>TEMPERATURE-KELVIN</td>
<td>T</td>
<td></td>
</tr>
<tr>
<td>TEMPERATURE-CELSIUS</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>U-FRACTION</td>
<td>UF(component)</td>
<td>component</td>
</tr>
<tr>
<td>VELOCITY-OF-INTERFACE</td>
<td>VOI(name,U/L)up*</td>
<td>interface name</td>
</tr>
<tr>
<td>WEIGHT-FRACTION</td>
<td>W(component)</td>
<td>component</td>
</tr>
<tr>
<td>WEIGHT-PERCENT</td>
<td></td>
<td>component</td>
</tr>
</tbody>
</table>

Mnemonic Auxiliary Variables

There are also auxiliary variables that are only associated with a mnemonic.

<table>
<thead>
<tr>
<th>Mnemonic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GD</td>
<td>global distance</td>
</tr>
<tr>
<td>LD</td>
<td>local distance</td>
</tr>
<tr>
<td>M(phase,J)</td>
<td>mobility coefficient where J=diffusing specie</td>
</tr>
<tr>
<td>LOGM(phase,J)</td>
<td>$10 \log$ of the mobility coefficient</td>
</tr>
<tr>
<td>Mnemonic</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>DT(phase,J)</td>
<td>tracer diffusion coefficient where J=diffusing specie</td>
</tr>
<tr>
<td>LOGDT(phase,J)</td>
<td>10log of the tracer diffusion coefficient</td>
</tr>
<tr>
<td>DC(phase,J,K,N)</td>
<td>chemical diffusion coefficient where K=gradient specie, and N=reference specie</td>
</tr>
<tr>
<td>LOGDC(phase,J,K,N)</td>
<td>10log of chemical diffusion coefficient</td>
</tr>
<tr>
<td>DI(phase,J,K,N)</td>
<td>intrinsic diffusion coefficient</td>
</tr>
<tr>
<td>LOGDI(phase,J,K)</td>
<td>10log of intrinsic diffusion coefficient</td>
</tr>
<tr>
<td>JV(phase and/or specie)</td>
<td>flux in volume fixed frame of reference</td>
</tr>
<tr>
<td>JL(phase and/or specie)</td>
<td>flux in lattice fixed frame of reference</td>
</tr>
<tr>
<td>QC(phase,J,K,N)</td>
<td>Q=R(ln (DC{T1}) - ln (DC{T1+e}))/1/(T1+e) - 1/T1</td>
</tr>
</tbody>
</table>
Diffusion Module (DICTRA) Examples Guide

Thermo-Calc Version 2017a
About the Diffusion Module (DICTRA) Examples Collection

To learn more about how to use the software you can open and run the example projects (Graphical Mode) and macro files (Console Mode).

Graphical Mode Examples

Graphical Mode examples are available for Thermo-Calc and the add-on Diffusion Module (DICTRA) and Precipitation Module (TC-PRISMA). These are in the format of project files (*.tcu) and are included together in the same folder.

"Diffusion Calculator Examples (Graphical Mode)" on page 1

Console Mode Examples

Console Mode examples are available for Thermo-Calc and the Diffusion Module (DICTRA). The macro files are in the format of *.TCM and .DCM, respectively.

There are other file types when you are working in Console Mode. See "Thermo-Calc Console Mode File Types" on page 2 in the Console Mode Command Reference, and "About the DICTRA File Formats" on page 3 in the Diffusion Module Quick Start Guide.

"Opening the Setup, Run, and Plot Macro Files" on page 5

Quick Start Guide Examples

There is a Quick Start Guide available for both modes and included in this documentation set.
Diffusion Calculator Examples (Graphical Mode)

Graphical Mode examples are available for Thermo-Calc and the add-on Diffusion Module (DICTRA) and Precipitation Module (TC-PRISMA). These are in the format of project files (*.tcu) and are included together in the same folder.

"Opening Graphical Mode Project Files" on page 5 in the Thermo-Calc User Guide.

This guide includes the example descriptions and information about how to open the project file, which is different in Console Mode where the macro file can be opened in a text editor.

Opening a Project File

To open an example project file for Thermo-Calc and the add-on Diffusion Module (DICTRA) and/or Precipitation Module (TC-PRISMA):

1. Open Thermo-Calc.
2. Confirm you are in Graphical Mode. If not, click the Switch to Graphical Mode button.
3. From the main menu, select File → Open Examples or Help → Open Examples.
4. Navigate to the project file you want and double-click to open.
5. The Graphical Mode examples are stored without calculated results so you will want to run the example calculation and generate a plot or table. To do this, click the first node in the tree at the top of the Project window. Then right-click and select Perform now.

Example Descriptions

These examples are included and available user as indicated.
Homogenization of a Binary Fe-Ni Alloy

The single phase example simulates the diffusion of Fe and Ni at a temperature of 1400 K in a planar domain. At this temperature the material is fully austenitic, i.e. the only phase present is the so-called fcc (face centered cubic) phase. Initially, there is a linear variation in Ni going from 10 mass-% on the left-hand side to 50 mass-% on the right-hand side.

This example is available as a video tutorial on our website and YouTube channel.

Project File Name and availability

File name: Ex_19_Diffusion_Single_Phase.tcu

This example is part of the Diffusion Module (DICTRA) Quick Start Guide available to all users. A version of the example is also available for Console Mode.

Ferrite(bcc)/Austenite(fcc) Transformation in a Binary Fe-C Alloy

The moving phase example simulates the growth of ferrite (bcc) into austenite (fcc). The austenite is assumed to be initially homogeneous with the composition Fe - 0.15 mass-% C. The transformation temperature is 1050 K. The initial thickness of the austenite is 2 mm and an initially very thin ferrite (1 nm) is also present at the start of the simulation.

Project File Name and availability

File name: Ex_20_Diffusion_Moving_Boundary.tcu

This example is part of the Diffusion Module (DICTRA) Quick Start Guide available to all users. A version of the example is also available for Console Mode.

Evolution of an Fe-Cr-Ni Diffusion Couple

The multiphase example simulates the evolution of an Fe-Cr-Ni diffusion couple during a 100 hour heat treatment at 1100 °C (1373.15 K). Both end members of the diffusion couple are duplex ferrite plus austenite, but the majority phase is ferrite on the left-hand side and austenite on the right.

With this type of simulation it is assumed that the material is fully equilibrated at each grid point, i.e. the local phase fractions, phase compositions and so forth are obtained from an equilibrium calculation with the local overall composition as a condition.
More details about the homogenization model for multiphase simulations can be found in Larsson and Engström (2006)\(^1\) and Larsson and Höglund (2009)\(^2\). Experimental data is from Engström (1995)\(^3\).

**Project File Name and availability**

File name: *Ex_21_Diffusion_Multiphase.tcu*

This example is part of the *Diffusion Module (DICTRA) Quick Start Guide* and uses more than two elements, enabling it to be available to users with a valid license. A version of the example is also available for Console Mode.

**Fe-C Moving Boundary: Austenite to Ferrite**

This example simulates the Austenite to Ferrite transformation in a Fe-0.15mass%C steel during continues cooling. The simulation starts at a temperature where only Austenite is stable, Ferrite nucleates and grows into during cooling in the two phase region. Plots of the carbon composition profile and a thermal profile are generated.

**Project File Name and availability**

File name: *Ex_22_Diffusion_Fe-C_Moving_Boundary_Austenite_to_Ferrite.tcu*

This example uses more than two elements enabling it to be available to users with a valid license.

---


Diffusion Module (DICTRA) Examples (Console Mode)

To learn more about how to use the add-on software you can open and run the example files. These macro files (with the extension *.DCM) include comments, which you can either run in the Thermo-Calc program or open and read in a text editor.

If you read the macro file in a text editor, you do not see the output that Thermo-Calc gives in response to the commands stored in the macro file.

In this section:

Opening the Setup, Run, and Plot Macro Files ................................................................. 5
One Phase Examples ................................................................................................................. 6
Moving Boundary Examples ...................................................................................................... 10
Cell Calculation Examples ....................................................................................................... 22
Diffusion in Dispersed Systems Examples .............................................................................. 24
Cooperative Growth Example ................................................................................................. 29
Coarsening Example .................................................................................................................. 30
Kinetic Data Examples .............................................................................................................. 32
Deviation from Local Equilibrium Examples ........................................................................... 35
Diffusion in Complex Phases Examples .................................................................................. 38
Opening the Setup, Run, and Plot Macro Files

For the main set of examples (this is different for the Quick Start examples), there are three macro files: a setup, run and a plot. You must run these macros in order.

To begin, double-click the setup.DCM file to open it. It launches a new session of ThermoCalc and opens in Console Mode.

The Console Mode macro files are also compiled in a PDF.
Quick Start Guide Examples

These examples are used in the Diffusion Module Quick Start Guide (Console Mode). It is recommended you review this guide before going to the additional examples.

<table>
<thead>
<tr>
<th>File Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>simplest_dictra.dcm</td>
<td>Simple homogenization of a binary Fe-Ni alloy. Initially it is assumed to have a linear Ni-concentration profile.</td>
</tr>
<tr>
<td>simple_moving_boundary.dcm</td>
<td>Calculating a ferrite(bcc)/austenite(fcc) transformation in a binary Fe-C alloy</td>
</tr>
</tbody>
</table>

One Phase Examples

exa1 - Homogenization of a binary Fe-Ni alloy: Linear concentration profile

Simple homogenization of a binary Fe-Ni alloy. It is assumed there is initially a linear Ni-concentration profile.
**exa2a and exa2b - Homogenization of a binary Fe-Ni alloy**

- Example exa2a **Step Profile**: Simple homogenization of a binary Fe-Ni alloy. A Ni rich and a Ni lean alloy are put together and initially there is a step profile.
- Example exa2b **Time Integration**: This example is identical to a2a but instead it uses implicit time integration instead of the trapezoidal method for solving the PDEs.

The exa2b example uses the TCFE and MOBFE databases. These licenses are required to run the example.

**exa3 - Uphill diffusion in an Fe-Si-C alloy**

This is an example to simulate uphill diffusion in a ternary single phase austenite matrix due to the classical Darken experiment published by Darken, L. S. (1949). Diffusion of Carbon in
Austenite with a Discontinuity in Composition. Transactions of the American Society for Metals, AIME, 180, 430–438. 1

In this example, two pieces of austenite (3.80 wt%Si, 0.49 wt%C) and (0.05 wt%Si, 0.45 wt%C) are put together and are subsequently annealed at 1050 C for 13 days. As both pieces are austenite they must be entered into the same region. This is done by individually giving the compositions of Si and C in each grid point. These data are then stored to file.

This example uses the TCFE and MOBFE databases. These licenses are required to run the example.

\[ T = 1323 \, \text{K} \]

\[ \text{FCC} \rightarrow \text{FCC} \]

3.8% Si
0.49% C

0.05% Si
0.45% C

5E-2

exa4 - Carburization of binary Fe-C alloy: Comparison to an analytical erf solution

This is a simple binary simulation with one single phase region. The numerical simulation is compared with an analytical erf-solution. A special database is created (erf.tdb) where the diffusion coefficient is set to a concentration independent value.

---

1
**exa5 - Carburization of a binary Fe-0.15 wt% C alloy**

A mixture of 40% N2 and 60% cracked methanol is used as carrier gas. The carburizing "carbon potential" in the gas is 0.85 wt% and a surface reaction controls the flux of C at the surface.

**exa6 - Diffusion through a tube wall**

A simple example of diffusion through a tube wall. The tube-material is an Fe-0.6%Mn-0.7%Si-0.05%C alloy. On the inside wall a carbon activity of 0.9 is maintained whereas on the outside the C-activity is very low. This example demonstrates the use of the command SET-FIRST-INTERFACE as well as the use of MIXED boundary conditions.
This example uses the TCFE and MOBFE databases. These licenses are required to run the example.

**exa7 - Homogenization heat treatment**

The initial segregation profile is created from a Scheil calculation (see macro `create_initial_profile.TCM`). The command `INPUT_SCHEIL_PROFILE` in the DICTRA monitor performs most of the setup. Only time and temperature must be entered after the `INPUT_SCHEIL_PROFILE` command is executed.

**Moving Boundary Examples**
**exb1a - Austenite (γ) to ferrite (α) transformation in a binary Fe-C alloy**

This example calculates a ferrite (BCC)/austenite (FCC) transformation in a binary Fe-C alloy. The initial state is an austenite of 2 mm thickness. The composition of the austenite is Fe-0.15wt%C. After austenitization the specimen is quenched down to 1050K. The system is assumed closed, so no boundary conditions are set (a closed system is the default). Ferrite is expected to grow into the austenite. For this reason you start with a thin region with ferrite adjacent to the austenite.
**exb1b - Austenite (γ) to ferrite (α) transformation in a binary Fe-C alloy: Inactive α**

This is the same example as in exb1a but now the problem is with ferrite as an inactive phase adjacent to the initial austenite.

![Diagram of exb1b](image)

**exb1c - Austenite (γ) to ferrite (α) transformation in a binary Fe-C alloy: Gradual cool down to 1050K**

This is the same example as in exb1a and exb1b but now the simulation starts at a higher temperature and assumes a gradual cooling down to 1050 K.

When 1050 K is reached, the temperature is kept constant and thus has an isothermal transformation. As in exb1b, ferrite is in an inactive phase adjacent to the initial austenite.
**exb2 - Cementite dissolution in an Fe-Cr-C alloy**

This example calculates the dissolution of a spherical cementite particle in an austenite matrix.


In order to achieve the correct average composition in the calculation it is necessary to take into account the fact that the calculation is set up using the volume fraction of the phases. To calculate the initial state at the heat treatment temperature we need first to determine the state at the normalizing temperature. To calculate the volume fraction of the phases we need to enter a number of functions that calculate these quantities.

This example uses the MOBFE database. This license is required to run the example.

---

1
**exb3 - Dissolution of 23-carbide in an austenitic matrix**

This example calculates the dissolution of an M23C6 particle in an austenite matrix. A film of ferrite is allowed to nucleate around the carbide during the precipitation.
**exb4a - Solidification path of an Fe-18%Cr-8%Ni alloy: Eutectic reaction**

This example demonstrates the solidification path of an Fe-18%Cr-8%Ni alloy. A eutectic reaction is assumed, LIQUID -> BCC + FCC. Hence the BCC and FCC regions should be on separate sides of the liquid region. Comparison is made with both a Scheil-Gulliver simulation and equilibrium solidification conditions, both done in Thermo-Calc.

This example uses the MOBFE database. This license is required to run the example.

![Diagram of solidification path](image)

**exb4b - Solidification path of an Fe-18%Cr-8%Ni alloy: Peritectic reaction**

This example is the same as exb4a but now a peritectic reaction is assumed: LIQUID + BCC -> FCC. Hence the FCC region should appear in between the LIQUID and the BCC. Comparison is made with both a Scheil-Gulliver simulation and equilibrium solidification conditions, both done in Thermo-Calc.

This example uses the MOBFE database. This license is required to run the example.
\[ T = 1900 - 1 \times \text{Time} \text{ K} \]
**exb4c - Solidification path of an Fe-18%Cr-8%Ni alloy: Peritectic reaction, homogeneous liquid**

This example is the same as exb4b but now the diffusivity data is amended for the LIQUID and a very high value for the diffusivity is used in order to simulate a case where we assume that the composition in the LIQUID is always homogeneous. This case should be considered less realistic than exb4b. Comparison is made with both a Scheil-Gulliver simulation and equilibrium solidification conditions, both done in Thermo-Calc.

⚠️ This example uses the MOBFE database. This license is required to run the example.

**exb4d - Solidification path of an Fe-18%Cr-8%Ni alloy: Peritectic reaction, heat-flux controls the temperature**

This example is the same as exb4b but instead of controlling the temperature the amount of heat extracted is given. Comparison is made with both a Scheil-Gulliver simulation and equilibrium solidification conditions, both done in Thermo-Calc.

⚠️ This example uses the MOBFE database. This license is required to run the example.
exb5 - χ/α/χ Diffusion couple of Fe-Ni-Cr alloys

This example demonstrates the evaluation of a ternary Fe-Cr-Ni diffusion couple. A thin slice of α phase (38%Cr, 0%Ni) is clamped between two thicker slices of γ phase (27%Cr, 20%Ni). The assembly is subsequently heat treated at 1373K.


**exb6 - Microsegregation of phosphorus**

This example illustrates the effect of microsegregation of phosphorus during peritectic solidification in steel.

This example uses the TCFE and MOBFE databases. These licenses are required to run the example.
exb7 - Moving boundary problem with multiple phases on each side of the boundary

This example shows how to enter dispersed phases on either side of a phase interface. The particular case shows how the kinetics of a ferrite to austenite transformation is affected by simultaneous precipitation of niobium carbide. The transformation is caused by carburization.

This example uses the TCFE, SSUB and MOBFE databases. These licenses are required to run the example.
**Cell Calculation Examples**

**exc1 - Carbon cannon in ferrite/austenite (α/γ): Fe-C system, two-cell calculation**

This example simulates what happens to a ferrite plate that has inherited the carbon content of its parent austenite. The ferrite plate formed is embedded in an austenite matrix. This setup corresponds to a proposed mechanism for formation of Widmannstätten ferrite or for the ferrite phase of the bainite structure. It is assumed that the phase boundary between ferrite and austenite is immobile, this is achieved in the simulation by putting the ferrite and the austenite in two different cells.

exc2 - Cementite dissolution in an Fe-Cr-C alloy: Three particle sizes and three different cells

This example calculates the dissolution of cementite particles in an austenite matrix. This is the same as exc1 except that there are three particle sizes. Altogether six particles are considered using three different cells. This is to be able to represent some size distribution among the cementite particles.

This example uses the MOBFE database. This license is required to run the example.


---

1

2
Diffusion in Dispersed Systems Examples

**exd1a - Carburization of Ni-25%Cr alloy: Dispersed system model**

This example is about carburization of a Ni-25Cr alloy. In this case the M3C2 and M7C3 carbides are entered as spheroid phases in a FCC matrix. This simulation can be run with either the DISPERSED SYSTEM MODEL or the HOMOGENIZATION MODEL. In this example the DISPERSED SYSTEM MODEL is used.


---

1
This example uses the SSOL and MOB databases. These licenses are required to run the example.

**exd1b - Carburization of Ni-25%Cr alloy: Homogenization model**

This example is about carburization of a Ni-25Cr alloy. In this case the M3C2 and M7C3 carbides are entered as spheroid phases in a FCC matrix. It is similar to exd1a except the default HOMOGENIZATION MODEL is used and then ENTER_HOMOGENIZATION_FUNCTION should be used instead of ENTER_LABYRINTH_FUNCTION.


This example uses the SSOL and MOB databases. These licenses are required to run the example.
**exd2a - Diffusion couple of Fe-Cr-Ni alloys: Dispersed system model**

This example calculates the interdiffusion in a diffusion couple between a two-phase (FCC+BCC) and a single-phase (FCC) Fe-Ni-Cr alloy. Initially it has a step profile. This simulation can be run with either the DISPERSED SYSTEM MODEL or the HOMOGENIZATION MODEL. In this example the DISPERSED SYSTEM MODEL is used.


![Diagram of diffusion couple](image)

**exd2b - Diffusion couple of Fe-Cr-Ni alloys: Homogenization model**

This example calculates the interdiffusion in a diffusion couple between a two-phase (FCC+BCC) and a single-phase (FCC) Fe-Ni-Cr alloy. Initially it has a step profile. It is similar to exd2a except the default HOMOGENIZATION MODEL is used and then ENTER_HOMOGENIZATION_FUNCTION is used instead of ENTER_LABYRINTH_FUNCTION.


---


² Same as footnote 1.
**exd3 - Diffusion couple of Fe-Cr-Ni alloys: Homogenization model**


The homogenization model can be used for multiphase simulations like the dispersed system model, but unlike the dispersed system model there is no need to have a single continuous matrix phase and, furthermore, there is no need to limit the size of time-steps. The set-up is performed in the same manner as for the dispersed system model, which means that a certain phase is entered as the matrix phase and the other phases are entered as spheroidal, but the choice of matrix phase does not affect the simulation.

---

1 2
Cooperative Growth Example

exe1 - Growth of pearlite in an Fe-Mn-C alloy

This is an example of pearlite growth in an Fe-0.50wt%C-0.91wt%Mn steel.

This example uses the TCFE and MOBFE databases. These licenses are required to run the example.
Coarsening Example

Moving phase interface with $\alpha$ and $\beta$ in local equilibrium.

$$\frac{2\sigma \gamma_{\alpha\beta}}{r}$$ Interfacial energy contribution for $\alpha$ phase

Equilibrium as defined by the average composition in the system.

$$\frac{2\sigma \gamma_{\beta\alpha}}{r_p}$$ Interfacial energy contribution for $\beta$ phase
exf1 - Coarsening of M6C precipitate in an Fe-Mo-C alloy

This example calculates the Ostwald-ripening of a spherical M6C carbide in an austenite matrix.

This example uses the TCFE and MOBFE databases. These licenses are required to run the example.

T = 1173K

r_p = 0.228 μm
Kinetic Data Examples

exg1 - Checking mobilities and diffusivities in an Fe-Ni alloy

This is an example file to check the mobilities and diffusivities in an Fe-Ni alloy.

This example uses the TCFE and MOBFE databases. These licenses are required to run the example.
**exg2 - Optimization of mobilities in Ni-Al fcc alloys**

A file for reading thermodynamic data and setting up the kinetic parameters that are needed for an optimization of the FCC phase in the binary Ni-Al system.


This example uses the MOB database. This license is required to run the example.

\(^1\)
Experimental data
- phase diagram data
- activity measurements
- enthalpy measurements
- cp measurements
- etc.

Parrot

Experimental data
- tracer diffusivities
- chemical diffusivities
- etc.
Deviation from Local Equilibrium Examples

exh1 - Ferrite/austenite (α/γ) diffusion couple with interface mobility

This example calculates the growth of ferrite (α) into austenite (γ) with a limited interface mobility. This is done by adding a Gibbs-energy contribution to the ferrite using the SET-SURFACE-ENERGY command.
exh2 - Ferrite/austenite (α/γ) para-equilibrium in an Fe-Ni-C alloy

This example calculates the growth of ferrite (α) into austenite (γ) in an Fe-2.02%Ni-0.0885%C alloy using the para-equilibrium model. The results are compared with experimental information from Hutchinson, C. R., Fuchsmann, A., & Brechet, Y. (2004). The diffusional formation of ferrite from austenite in Fe-C-Ni alloys. Metallurgical and Materials Transactions A, 35(4), 1211–1221. https://doi.org/10.1007/s11661-004-0295-1.¹
**exh3 - Diffusion induced by a temperature gradient (thermomigration)**

This calculation shows how a temperature gradient induces diffusion.

\[
J_C = -\frac{u_C}{V_s} y_{V_a} M_{CV_a} \left( \frac{\partial \mu_C}{\partial x} + \frac{Q^*_C}{T} \frac{\partial T}{\partial x} \right)
\]

**Diffusion in Complex Phases Examples**
exi1 - Diffusion in a system with B2 ordering

In this example folder, there is also a datafile AlFeNi-data.TDB, which contains both a thermodynamic and kinetic description for the ordered and disordered bcc.

exi2 - Diffusion of carbon in cementite

This example demonstrates the use of the model for calculation of diffusion through a stoichiometric phase. The flux of a component in the stoichiometric phase is assumed to be proportional to the difference in chemical potential at each side of the stoichiometric phase multiplied with the mobility for the component in the phase. The mobility is assessed from experimental information and is basically the tracer diffusivity for the component.

This calculation is compared with experimental data where a sample of pure iron has been exposed to a gas atmosphere with a certain carbon activity. The weight gain is then measured as a function of time.


\[ J \sim \Delta \mu \]

exi3a - Diffusion in iron oxide (FeO)

This example shows the oxidation of an iron sample and the consequent growth of an oxide layer.

1
exi3b - Diffusion in iron oxide (FeO) with a grain boundary contribution

This example shows the oxidation of an iron sample and the consequent growth of an oxide layer using the grain boundary diffusion contribution model.
# Introduction to Thermo-Calc

This guide is an introduction to working with both *Graphical Mode* and *Console Mode* in Thermo-Calc.

**In this section:**

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Thermo-Calc Software</td>
<td>3</td>
</tr>
<tr>
<td>Graphical Mode vs Console Mode</td>
<td>3</td>
</tr>
<tr>
<td>About the File Types and Formats</td>
<td>5</td>
</tr>
<tr>
<td>Graphical Mode</td>
<td>5</td>
</tr>
<tr>
<td>Console Mode</td>
<td>5</td>
</tr>
<tr>
<td>Examples, Manuals and Materials Folders</td>
<td>9</td>
</tr>
<tr>
<td>The Thermo-Calc Modules and Activities</td>
<td>20</td>
</tr>
<tr>
<td>Displaying Thermo-Calc License Information</td>
<td>24</td>
</tr>
<tr>
<td>Using This Guide</td>
<td>25</td>
</tr>
</tbody>
</table>
The Thermo-Calc Software

The Thermo-Calc software is a sophisticated database and programming interface package used to perform thermodynamic calculations. It can calculate complex homogeneous and heterogeneous phase equilibria, and then plot the results as property diagrams and phase diagrams.

The Thermo-Calc software (also referred to as the Thermo-Calc program or the software to distinguish it from the company name) fully supports stoichiometric and non-ideal solution models and databases. These models and databases can be used to make calculations on a large variety of materials such as steels, alloys, slags, salts, ceramics, solders, polymers, subcritical aqueous solutions, supercritical electrolyte solutions, non-ideal gases and hydrothermal fluids or organic substances. The calculations take into account a wide range of temperature, pressure and compositions conditions.

Add-on modules

The Thermo-Calc program also includes add-on modules:

- The Diffusion Module (DICTRA) and DIC_PARROT is used to simulate diffusion controlled transformations in multicomponent systems.

- The Precipitation Module (TC-PRISMA) is used to simulate diffusion controlled multi-particle precipitation process in multicomponent and multi-phase alloy systems.

- Use online help for information about how to use Diffusion Module (DICTRA) and Precipitation Module (TC-PRISMA).

Graphical Mode vs Console Mode

There are two interfaces available in Thermo-Calc: **Graphical Mode** with a graphical user interface (GUI) and **Console Mode**, which uses a command line interface. Thermo-Calc and the Diffusion Module (DICTRA) are available in both modes, and the Precipitation Module (TC-PRISMA) is only available in Graphical Mode.

In Graphical Mode calculations are set up, carried out, and visualized as part of a project. The steps in the project are performed with activities. There are templates and a Wizard available to guide you through the process of defining the project.
In Console Mode you work with modules, which are managed using commands typed at a prompt. Some modules, called response-driven modules, ask you a series of questions that typically take you through the process of defining your system, setting calculation conditions, performing calculations and plotting the results.

Switching between modes

The first time you open Thermo-Calc, it defaults to Graphical Mode. For any future instance it defaults to the last mode used.

Along the top of the GUI is the GRAPHICAL MODE TOOLBAR where you switch between modes.

In Console Mode, except for the SWITCH TO GRAPHICAL MODE button, the toolbar is not used.

See "Main Menu and Toolbar" on page 33 in the Thermo-Calc User Guide for information about the Tools, Window and Help menus, which are available in both modes.

File extensions

The file extensions are different based on the mode you are in (Graphical vs. Console). In Console Mode the extensions are also based on whether you are working with Thermo-Calc or the Diffusion Module (DICTRA).

In Graphical Mode, the Thermo-Calc project files have the extension *.tcu. This includes the examples for the add-on Diffusion Module (DICTRA) and Precipitation Module (TC-PRISMA).

In Console Mode, Thermo-Calc macro files have a *.TCM extension and the Diffusion Module (DICTRA) file extension is *.DCM. In addition to macro files in Console Mode the are also Log files and Workspace files, which also differ.

Can I work with both modes at the same time?

The two modes can be run simultaneously, but there is no communication between them.
What you do in Graphical Mode does not affect the state of the Console Mode session and vice versa. One exception is the plot settings. See "Global Settings: Graphical and Console Mode-Plotting" on page 228 in the Thermo-Calc User Guide.

Data optimization and thermodynamic / kinetic assessments

Although many calculations can be done in either mode, data optimization and thermodynamic or kinetic assessments are only available in Console Mode.

About the File Types and Formats

The file formats (and the file extensions / suffixes) are based on whether you are working in Graphical or Console Mode, and in Console Mode, whether you are working with Thermo-Calc and/or the Diffusion Module (DICTRA).

Graphical Mode

In Graphical Mode you work with one file type, a project file, which has a *.tcu file extension. This is applicable to Thermo-Calc and the add-on modules.

Console Mode

In Console Mode there are file types (macro, log and workspace) and extensions (TCM, LOG, POLY3, GES5, PAR and POP) to be aware of. For Thermo-Calc Console Mode the file types are described in "Log, Macro and Workspace Files" on page 154 in this guide.

For DICTRA Console Mode see File Formats as described in the Diffusion Module (DICTRA) User Guide.

Opening Graphical Mode Project Files

"Opening Console Mode Macro Files" on the next page

How to Open any Project File

There are different ways to open project files.

In Thermo-Calc:

- From the main menu select File → Open Project.
- On the toolbar, click the Open button or press <Ctrl+O> on the keyboard. Then navigate to the file on your computer and click Open.
On your computer:

- Navigate to the project file and double-click to open it.

**How to Open an example project**

To open an example project file for Thermo-Calc and the add-on Diffusion Module (DICTRA) and/or Precipitation Module (TC-PRISMA):

1. Open Thermo-Calc.
2. Confirm you are in Graphical Mode. If not, click the **Switch to Graphical Mode** button.
3. From the main menu, select **File → Open Examples** or **Help → Open Examples**.
4. Navigate to the project file you want and double-click to open.
5. The Graphical Mode examples are stored without calculated results so you will want to run the example calculation and generate a plot or table. To do this, click the first node in the tree at the top of the **Project** window. Then right-click and select **Perform now**.

**Opening Console Mode Macro Files**

"Opening Graphical Mode Project Files" on the previous page

**How to Open Macro Files**

The macro files (with the extension *.TCM) include comments, which you can either run in Thermo-Calc or open and read in a text editor.

You can open the macro files (*.TCM or *.DCM files) in different ways.

- From the main menu,
- Using a command,
By dragging and dropping the file into the Console window, or

Navigate to the file location on your computer and double-click to open it. If you already have Thermo-Calc open, this opens a new instance of the software.

You can also read the commands listed in the macro file using a text editor.

If you only open and read the macro file in a text editor, you do not see the output that Thermo-Calc gives in response to the commands stored in the macro file.

**How to Open a macro From the Main Menu**

To open an example macro file for Thermo-Calc:

1. Open Thermo-Calc.
2. Confirm you are in Console Mode. If not, click the **Switch to Console Mode** button.
3. From the main menu, select **File → Open Examples** or **Help → Open Examples**. The Console Mode folder opens with the Thermo-Calc examples in separate folders.

   **Name**
   
   - tces01
   - tces02
   - tces03
   - tces04
   - tces05
   - tces06

   For the Diffusion Module (DICTRA) examples (*_.DCM macro files), click the **Up One Level** button and then double click the **DICTRA** folder.

4. In the folder, double-click the *_.TCM file or click **Open**.
5. Follow the prompts in the Console window i.e. keep pressing <Enter> to run the macro and produce a plot in the **Console Results** window.

**How to open a macro Using a Command**

At the **SYS** prompt, type **MACRO_FILE_OPEN** and press <Enter>. In the file dialogue window
that opens, navigate to and select the macro file to open.

**how to Drag and Drop a Macro File into the Console Window**

For example, on your computer, navigate to the examples folder. Drag the file from its location into the Thermo-Calc Console window. When you release (drop) the file, the macro starts running. Follow the prompts in the Console window i.e. keep pressing <Enter> to run the macro and produce a plot in the **Console Results** window.

**EXAMPLE**

![Example Image]
Examples, Manuals and Materials Folders

There are several ways to access the examples, manuals (containing PDF documentation) and materials data folders.

<table>
<thead>
<tr>
<th></th>
<th>Main Menu</th>
<th>System Definer</th>
<th>From the Windows Start Menu</th>
<th>On your computer</th>
<th>Website</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manuals (PDF documentation)</td>
<td>x</td>
<td>-</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Examples (project and macro files)</td>
<td>x</td>
<td>-</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Materials</td>
<td>-</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
</tbody>
</table>

From the Main Menu

Once your Thermo-Calc software is installed you can open the Examples and PDF
documentation (Manuals) from the main menu:

- To open the PDF documentation select Help → Open Manuals Folder. See "About the PDF Documentation" on page 13. Note for Linux openSUSE users:¹
- To open the Examples based on whether you are in Console Mode or Graphical Mode, select File → Open Examples or Help → Open Examples.

¹This link is not functional. To access the folder, navigate to the default location based on your installation type.
From the System Definer (Materials Only)

When you are working with the "System Definer" on page 57 you can open the default Materials folder included with your installation.

At the bottom of the window under Material, click Load material to navigate to a material file.

EXAMPLE
Start Menu (Windows Only)

On Windows, once Thermo-Calc is installed, you can locate the Examples and Materials folders, plus all the Manuals using the shortcuts located in the Start menu. Go to **Start → All Programs** or **All Apps → Thermo-Calc** and click **Examples, Manuals, or Materials** as required to open the applicable folder.

On Your Computer (All Operating Systems)

The PDFs, example files and materials xml files are included with your installation in a folder location based on the operating system.

In the table, `<user>` stands for the username and `<version>` for the version of Thermo-Calc, for example 2017a.

<table>
<thead>
<tr>
<th>OS</th>
<th>User type</th>
<th>Default directory</th>
</tr>
</thead>
</table>
| Windows          | Normal user                      | Users\<user>\Thermo-Calc\<version>  
|                  |                                  | Users\<user>\Documents\Thermo-Calc\<version>  
|                  |                                  | My documents                                                                     |
|                  | Administrator                     | Program Files\Thermo-Calc\<version>  
|                  |                                  | Users\Public\Documents\Thermo-Calc\<version>  
|                  |                                  | Public documents                                                                  |
| Mac              | Administrator (user name and password required) | Examples and manuals in /Users/Shared/Thermo-Calc/<version>  
|                  |                                  | To go to this folder, in Finder, from the **Go** main menu select **Go to folder**. Enter the above file path and click **Go**. |
| Linux            | Non root user                     | home/<user>/Thermo-Calc/<version>                                                 |
|                  | Root user                         | usr/local/Thermo-Calc/<version>                                                   |

Website

You can download the PDF documentation and examples from the website.
2. From the menu, select Support → Documentation and navigate to the applicable section.

**About the PDF Documentation**

There is PDF documentation available as part of your installation. This is the same information as that contained in the online help, just in a different format.

"Examples, Manuals and Materials Folders" on page 9

**Database Information Sheets**

The database information sheets are included in the online help system and in a Manuals sub-folder. You can also download these from the Thermo-Calc website.

**PDF Documentation Sets and Guides**

- **Installation Guides**: Includes the quick install guides for Standalone Windows and Mac installations as well as the full installation guide for all platforms and installation types.


- **Property Model Development Framework**: This PDF guide contains details about setting up a development environment so you can build custom property models in Thermo-Calc.


• **TQ-Interface Programmer Guide**: The TQ-Interface is available as a way to make Thermo-Calc an integral part of application programs such as those for process simulation, microstructure evolution modeling and materials property prediction.

• **TC Toolbox for MATLAB® Programmer Guide**: Use this to enable communication between Thermo-Calc and MATLAB to be able to retrieve thermodynamic and kinetic quantities.

• **TC-API Programmer Guide**: This is the Thermo-Calc API that can be used by programmers to set up your own applications to work with Thermo-Calc.

*About the Examples*

To learn more about how to use the software you can open and run the example projects (Graphical Mode) and macro files (Console Mode).

*Graphical Mode Examples*

Graphical Mode examples are available for Thermo-Calc and the add-on Diffusion Module (DICTRA) and Precipitation Module (TC-PRISMA). These are in the format of project files (*.tcu) and are included together in the same folder.

A brief description of all the examples, and how to access them, is in the [Graphical Mode Examples Guide](#), which you can find in this documentation set or by searching the online help.

*Console Mode Examples*

Console Mode examples are available for Thermo-Calc and the Diffusion Module (DICTRA). The *macro* files are in the format of *.TCM and *.DCM, respectively.

*There are other file types when you are working in Console Mode. See "Thermo-Calc Console Mode File Types" on page 2 in the Console Mode Command Reference, and About the File Formats in the Diffusion Module Quick Start Guide.*
Thermo-Calc Examples

A brief description of the Thermo-Calc examples, and how to access them, is in "About the Thermo-Calc Console Mode Examples" on page 2 in the Thermo-Calc Console Mode Examples Guide.

Diffusion Module (DICTRA) Examples

A brief description of the Diffusion Module examples (both Graphical Mode and Console Mode), and how to access them, is in the Diffusion Module (DICTRA) Examples Guide.

TQ-Interface and TC-Toolbox for MATLAB Examples

There are examples for the TQ-Interface and TC-Toolbox for MATLAB available as described in "Examples, Manuals and Materials Folders" on page 9. You can also find information about these in the respective user guides or by searching the online help.

About the Material Files

"Examples, Manuals and Materials Folders" on page 9

When you are working with the "System Definer" on page 57 you can open the default Materials folder included with your installation. The files are in .xml format and the data contained are from some common alloys. You can also save and create your own materials files from the System Definer, or copy the xml files to the Materials folder.

Aluminum Alloys

<table>
<thead>
<tr>
<th>Alloy</th>
</tr>
</thead>
<tbody>
<tr>
<td>UNS_A95005</td>
</tr>
<tr>
<td>UNS_A96053</td>
</tr>
</tbody>
</table>

Cast Iron Alloys

<table>
<thead>
<tr>
<th>Alloy</th>
</tr>
</thead>
<tbody>
<tr>
<td>UNS_F10007</td>
</tr>
<tr>
<td>Alloy</td>
</tr>
<tr>
<td>--------------</td>
</tr>
<tr>
<td>UNS_F33101</td>
</tr>
</tbody>
</table>
## Nickel Alloys

<table>
<thead>
<tr>
<th>Alloy</th>
</tr>
</thead>
<tbody>
<tr>
<td>UNS_N06600</td>
</tr>
<tr>
<td>UNS_N6600</td>
</tr>
<tr>
<td>UNS_N06625</td>
</tr>
<tr>
<td>UNS_N06690</td>
</tr>
<tr>
<td>UNS_N07001</td>
</tr>
<tr>
<td>UNS_N07718</td>
</tr>
<tr>
<td>UNS_N08800</td>
</tr>
<tr>
<td>UNS_N08825</td>
</tr>
</tbody>
</table>
### Solder Alloys

<table>
<thead>
<tr>
<th>Alloy</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASTM_25A</td>
</tr>
<tr>
<td>ASTM_96TS</td>
</tr>
<tr>
<td>UNS_L50134</td>
</tr>
<tr>
<td>UNS_L54321</td>
</tr>
</tbody>
</table>

### Steel Alloys

**Austenitic Stainless Steel**

<table>
<thead>
<tr>
<th>Alloy</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASTM_304_(UNS_S30400)</td>
</tr>
<tr>
<td>ASTM_304L_(UNS_S30403)</td>
</tr>
<tr>
<td>ASTM_304LN_(UNS_S30453)</td>
</tr>
<tr>
<td>ASTM_316_(UNS_S31600)</td>
</tr>
<tr>
<td>ASTM_316L_(UNS_S31603)</td>
</tr>
<tr>
<td>ASTM_316LN_(UNS_S31653)</td>
</tr>
<tr>
<td>ASTM_317L_(UNS_S31703)</td>
</tr>
<tr>
<td>UNS_J92710</td>
</tr>
<tr>
<td>UNS_S30908</td>
</tr>
</tbody>
</table>

**Duplex Stainless Steel**
<table>
<thead>
<tr>
<th>Alloy</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>UNS_S31803_A</td>
<td></td>
</tr>
<tr>
<td>UNS_S32750_A</td>
<td></td>
</tr>
<tr>
<td>UNS_S32750_B</td>
<td></td>
</tr>
<tr>
<td><strong>High Speed Steel</strong></td>
<td></td>
</tr>
<tr>
<td>ASTM_M10_A5</td>
<td></td>
</tr>
<tr>
<td><strong>High Temperature Steel</strong></td>
<td></td>
</tr>
<tr>
<td>UNS_S31008</td>
<td></td>
</tr>
<tr>
<td><strong>HSLA Steel</strong></td>
<td></td>
</tr>
<tr>
<td>UNS_K12000</td>
<td></td>
</tr>
<tr>
<td><strong>Low Carbon Steel</strong></td>
<td></td>
</tr>
<tr>
<td>UNS_H61180</td>
<td></td>
</tr>
<tr>
<td><strong>Maraging Steel</strong></td>
<td></td>
</tr>
<tr>
<td>UNS_K92810</td>
<td></td>
</tr>
<tr>
<td><strong>Martensitic Stainless Steel</strong></td>
<td></td>
</tr>
<tr>
<td>ASTM_420</td>
<td></td>
</tr>
<tr>
<td>UNS_J82090</td>
<td></td>
</tr>
<tr>
<td>UNS_J91639</td>
<td></td>
</tr>
<tr>
<td>UNS_S44004</td>
<td></td>
</tr>
</tbody>
</table>
**Alloy**

- Tool Steel
  - UNS_T30106
  - UNS_T30109
- Training Steel
  - Ferritic
  - M7_Steel

**Titanium Alloys**

- UNS_R54520
- UNS_R56260

**My Materials**

This is where you can add your own material files to be able to load it to the System Definer. When you are in the System Definer Configuration window, you define your material then click **Save material as**. You can save the profile to this folder or create a folder with a new name.

**The Thermo-Calc Modules and Activities**

Although many calculations can be done in either Graphical or Console Mode, only data optimization and thermodynamic or kinetic assessments are available in Console Mode. Conversely, only the Property Model Calculator is available in Graphical Mode.
For the Console Mode only commands see "The Console Mode Interface" on page 140 and the Thermo-Calc Console Mode Command Reference included with this documentation set.

**Modules and Activities** briefly describes the available modules. The specific modules, using the names in the table, are accessed through Console Mode. For Graphical Mode, the underlying principles, and the final calculations, are incorporated into the projects and activities. Some modules require additional licenses.

**Modules and Activities**

The first and second columns are the Console Mode module names. The third column indicates whether there is an equivalent activity available in Graphical mode.

<table>
<thead>
<tr>
<th>Full Module Name in Console Mode</th>
<th>Short Name</th>
<th>Graphical Mode Activity</th>
<th>Primary Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>BINARY_DIAGRAM_EASY</td>
<td>BIN</td>
<td>&quot;Binary Calculator&quot; on page 131</td>
<td>Calculate binary phase diagrams. Access to specific databases designed for BIN, such as TCBIN, is required.</td>
</tr>
<tr>
<td>DATABASE_RETRIEVAL</td>
<td>DATA</td>
<td>&quot;System Definer&quot; on page 57</td>
<td>Select appropriate databases, define chemical systems and retrieve the data required for calculations.</td>
</tr>
<tr>
<td>DICTRA_MONITOR</td>
<td>DICTRA</td>
<td>&quot;Diffusion Calculator&quot; on page 87</td>
<td>Run simulations of diffusion controlled transformations in Thermo-Calc using the Diffusion Module (DICTRA). An additional license is required for this feature.</td>
</tr>
<tr>
<td>DIC_PARROT</td>
<td>DIC_PARROT</td>
<td>Console Mode only</td>
<td>This is the data optimization module for the Diffusion Module (DICTRA). It allows you to assess experimental data and use such data to optimize calculations. An additional license is required for this feature.</td>
</tr>
<tr>
<td>Full Module Name in Console Mode</td>
<td>Short Name</td>
<td>Graphical Mode Activity</td>
<td>Primary Functions</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-----------</td>
<td>-------------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>EDIT_EXPERIMENTS</td>
<td>ED_EXP</td>
<td>Console Mode only</td>
<td>Part of the PARROT submodule, use it to edit experimental data points to make reliable optimizations.</td>
</tr>
<tr>
<td>GIBBS_ENERGY_SYSTEM</td>
<td>GIBBS</td>
<td>Console Mode only</td>
<td>Handles thermodynamic models and quantities. Generally you do not need to use this module, but you can get information about models, and list, add or amend the thermodynamic parameters in use.</td>
</tr>
<tr>
<td>PARROT</td>
<td>PARROT</td>
<td>Console Mode only</td>
<td>A data optimization module to assess experimental data and use the data to optimize calculations.</td>
</tr>
<tr>
<td>not available</td>
<td>-</td>
<td>&quot;Precipitation Calculator&quot; on page 97</td>
<td>Set the conditions for, and perform, a precipitation calculation.</td>
</tr>
<tr>
<td>not available</td>
<td>-</td>
<td>&quot;Property Model Calculator&quot; on page 64</td>
<td>You can evaluate models simultaneously over a range of compositions and cross plot the results. You can then conduct an uncertainty analysis and plot the results as either a histogram or as a probability plot.</td>
</tr>
<tr>
<td>POLY-3</td>
<td>POLY</td>
<td>&quot;Equilibrium Calculator&quot; on page 78</td>
<td>Equilibrium calculation module. Specify conditions and make calculations.</td>
</tr>
<tr>
<td>POST_PROCESSOR</td>
<td>POST</td>
<td>&quot;Plot Renderer&quot; on page 102</td>
<td>For post-processing and plotting of calculation results. Modify property and phase diagrams, add labels, change the diagram colours, etc. Submodules to POLY-3 and DICTRA module for example.</td>
</tr>
<tr>
<td>Full Module Name in Console Mode</td>
<td>Short Name</td>
<td>Graphical Mode Activity</td>
<td>Primary Functions</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>------------</td>
<td>-------------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>POTENTIAL_DIAGRAM</td>
<td>POTENTIAL</td>
<td>&quot;Ternary Calculator&quot; on page 133</td>
<td>Calculate and plot gas potential diagrams in a ternary system. The potential of two gas species are used as the diagram axes.</td>
</tr>
<tr>
<td>POURBAIX_DIAGRAM</td>
<td>POURBAIX</td>
<td>Console Mode only</td>
<td>Calculate and plot pH-Eh diagrams (Pourbaix diagrams) and property diagrams for heterogeneous interaction systems involving aqueous solutions.</td>
</tr>
<tr>
<td>REACTOR_SIMULATOR_3</td>
<td>REACTOR</td>
<td>Console Mode only</td>
<td>Simulate chemical reaction processes in several feed-forward steady-state stages or in several dynamic stages.</td>
</tr>
<tr>
<td>SCHEIL_SIMULATION</td>
<td>SCHEIL</td>
<td>&quot;Scheil Calculator&quot; on page 135</td>
<td>Simulate and plot Scheil-Gulliver solidification processes with no diffusion in the solid phases and with/without consideration of back diffusion of interstitial components (such as C, N, O, S).</td>
</tr>
<tr>
<td>SYSTEM_UTILITIES</td>
<td>SYS</td>
<td>Console Mode only</td>
<td>In Console Mode, interact with the operating system and change environmental settings. Create and execute MACRO files.</td>
</tr>
<tr>
<td>TABULATE_REACTION</td>
<td>TAB</td>
<td>Console Mode only</td>
<td>Tabulate properties of chemical reactions and substances (stoichiometric or solution phases).</td>
</tr>
<tr>
<td>TERNARY_DIAGRAM</td>
<td>TERN</td>
<td>&quot;Ternary Calculator&quot; on page 133</td>
<td>Calculate ternary phase diagrams.</td>
</tr>
</tbody>
</table>
## Displaying Thermo-Calc License Information

You can start (and install) the software without a valid Thermo-Calc license but you cannot do any calculations. To show information about the available and installed licenses, from the main menu select Help → Show License Info.

Also see the Thermo-Calc Installation Guide.

This is an example of part of a License Information window for a local installation.

<table>
<thead>
<tr>
<th>License Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>build: 10686 created: Thu Feb 23 17:29:02 2017</td>
</tr>
<tr>
<td>Log generated at: 29-02-2017 12:19:56</td>
</tr>
<tr>
<td>Safenet environment variables</td>
</tr>
<tr>
<td>LSHOST: NO-GEN</td>
</tr>
<tr>
<td>LSVRC: C:\Program Files/Thermo-Calc/2017a\lservroc</td>
</tr>
<tr>
<td>Local (silent) info</td>
</tr>
<tr>
<td>hostname:</td>
</tr>
<tr>
<td>license version:</td>
</tr>
<tr>
<td>ethernet:</td>
</tr>
<tr>
<td>ip address: #1</td>
</tr>
<tr>
<td>ip address: #2</td>
</tr>
<tr>
<td>dns name: #1</td>
</tr>
<tr>
<td>dns name: #2</td>
</tr>
</tbody>
</table>

For a network license, under each license type with instances checked out, there is a list of who checked out each license.

In Graphical Mode, an instance is checked out when an Equilibrium Calculator activity is created, and checked back in when that Equilibrium Calculator is removed.

In Console Mode, an instance is checked out when you enter the POLY module and is checked back in when you exit the POLY module. In the example, two users, amanda and nli, have licenses checked out.

- The **Features** column is a list of the specific software, databases and API licenses purchases.
- The **Version** is an internal version number for the feature.
- The **number of licenses** column is how many instances of each license type available
to be checked out simultaneously.

- The **in use** column shows how many license instances are checked out.

**Console Mode License Restrictions**

- If you start Thermo-Calc without a valid Thermo-Calc license you cannot leave the SYS module.
- If all the licenses are checked out for a network client installation of Thermo-Calc, you may not be able to enter the POLY or DICTRA modules until a license is available.
- To enter the DICTRA and the DIC_PARROT modules, you need a valid Diffusion Module (DICTRA) license key.
- If you enter and use either the DIC_PARROT module or the PARROT module, then you cannot enter the other module in the same session. You must close down Thermo-Calc and launch the program again to enter the other data optimization module.

**Network Computer License Restriction**

If you have a network computer installation of Thermo-Calc, then you may not be able to do any calculations even if you have access to a valid network license file. This is because others who are part of your network installation may have checked out all allowed instances of the software.

If you are running a network installation of Thermo-Calc, you can see how many instances of the client licenses are currently checked out and how many of them are left. You can also see which client computers have checked out the licenses.

**Using This Guide**

If you are a new user, Graphical Mode is a good way to learn how to work with Thermo-Calc. Depending on what you want to simulate, Console Mode can have more functionality but until you are comfortable with the concepts, it is recommended you start in Graphical Mode.

Additional documentation and training material is described in "Help Resources" on page 12.

**Graphical Mode**

"The Graphical Mode Interface" on page 27 introduces you to the GUI layout and the
workflow. In "Graphical Mode Projects" on page 46, it goes into more detail about how to set up and run your projects (with the Quick Start Wizard), using templates, scheduling jobs and creating activities. "Graphical Mode Activities" on page 56 specifically describes how to set up each type of available activity in the tree structure.

For both Graphical and Console mode, "Changing Global Settings" on page 218 gives information about adjusting global user settings.

**Console Mode**

In general, Console Mode has more functionality than Graphical Mode but the underlying concepts are the same. There are, however, command lines and extensive details applicable to this mode. This guide is only the beginning of the learning objectives. In particular, refer to the Thermo-Calc Console Mode Command Reference for details about all the commands available.

In this guide it is a basic introduction to the layout of the Command windows, as described in "The Console Mode Interface" on page 140.

Several topics describe and give an example of the calculation types:

- "Equilibrium Calculations" on page 163
- "Property Diagrams" on page 168
- "Phase Diagrams" on page 172
- "Scheil Simulations" on page 176
- "T0 Temperature Simulations" on page 182
- "Paraequilibrium" on page 185
- "Potential Diagrams" on page 189
- "Aqueous Solutions" on page 193
- "Console Mode TAB Module" on page 203

Then in "Console Mode POST Module" on page 208 there is an overview of plotting.

For both Graphical and Console mode, "Changing Global Settings" on page 218 gives information about adjusting global user settings.
The Graphical Mode Interface

These topics introduce you to the concepts and terminology of Graphical Mode and describe the basic workflow.

In this section:

- The GUI Layout .......................................................... 28
- Project Activities and the Tree Structure .................................. 29
- Activity Successor and Predecessor Nodes .................................. 30
- Creating Activities and Successors ............................................ 31
- Graphical Mode Workflow .................................................. 33
- Main Menu and Toolbar ..................................................... 33
- Graphical Mode Menu and Toolbar Options ............................... 34
- Saving and Opening Project Files .......................................... 36
- Project Activity Nodes ....................................................... 36
- Project and Activity Menus .................................................. 38
- Organising the Windows on the Desktop ................................... 41
- Moving Nodes in the Tree and Using the Grid ............................. 42
- Zooming In and Out ................................................................ 43
- Node Status Markers .......................................................... 44
The GUI Layout

Open Thermo-Calc to view the default GUI layout for Graphical Mode. You can easily reorganize the windows.

Also see "Organising the Windows on the Desktop" on page 41.

The windows are:

1. **Project**: Create, manipulate and navigate between the activities that make up a project.

2. **Configuration**: Shows the settings that can be configured for the currently selected activity.

3. **Results**: Shows the results of a calculation, either plotted as a diagram or displayed in table format. In this example, there is a Plot Renderer tab in the Results window.

4. **Scheduler**: Displays information about jobs, such as calculations, that are being performed or are scheduled to be performed. You can cancel scheduled jobs and if a job has failed, then you can view information about the error.

5. **Event Log**: By default this window is closed but it displays during calculation processes. You can always open it to view progress of calculations and to troubleshoot.

**Graphical Mode Windows**

In this example, the Results window also has a Plot Renderer tab. You can also have a Table Renderer tab.
Project Activities and the Tree Structure

In a project, a set of linked activities is called a tree. A result calculated within a tree is fed as input into the next activity in the tree. Consequently, if you have an Equilibrium Calculator with another Equilibrium Calculator as its successor, the successor takes the calculation results of the predecessor as the starting values for its calculation. When working with activities in the Project window these are also referred to as nodes (or activity nodes) in the tree structure.

Also see "Activity Successor and Predecessor Nodes" on the next page for definitions.

The example below shows a My Project node with two trees. In each tree, settings and calculation results are propagated downward until the calculation and the visualisation of the results are completed in the Plot Renderer nodes.

The system definitions, settings and calculation results of the two trees are independent of each other.

EXAMPLE
Activity Successor and Predecessor Nodes

An activity node located below another activity node in a tree is referred to as that activity’s successor. An activity located above another activity is called that activity’s predecessor. A predecessor is performed before the predecessor’s successors and its result is fed forward to any successor activities.

**EXAMPLE**

For example, to calculate and display a phase diagram, create a branch with three linked activities: A System Definer activity linked to an Equilibrium Calculator activity, which in turn is connected to a Plot Renderer activity.

See the example below that shows that Binary Calculator 1 is a predecessor to the successors, Plot Renderer 2 and Table Renderer 1.

You can determine the available successors by right-clicking a node in the Project window and choosing options from the menus.
EXAMPLE

Also see "Creating Activities and Successors" below.

Creating Activities and Successors

You can create a new activity in these ways:

- In the Project window, right-click an activity and choose Create New Activity (My Project node only) or Create New Successor (all other nodes).
- Select the activity you want to create from the submenu.
- At the bottom of the Configuration window, click Create New Activity or Create New Successor and select the activity to create.

Predecessors and Successors by Activity

<table>
<thead>
<tr>
<th>Activity</th>
<th>Possible Predecessors</th>
<th>Possible Successors</th>
</tr>
</thead>
<tbody>
<tr>
<td>My Project</td>
<td>None; this is the first node of the tree structure</td>
<td>System Definer, Binary Calculator, Ternary Calculator, Experimental File Reader. Also choose templates from this level.</td>
</tr>
<tr>
<td>&quot;System Definer&quot; on page 57</td>
<td>My Project, System Definer</td>
<td>Property Model Calculator, Equilibrium Calculator, Precipitation Calculator, Scheil Calculator</td>
</tr>
<tr>
<td>Activity</td>
<td>Possible Predecessors</td>
<td>Possible Successors</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>--------------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td>&quot;Property Model Calculator&quot; on page 64</td>
<td>System Definer</td>
<td>Plot Renderer, Table Renderer</td>
</tr>
<tr>
<td>&quot;Equilibrium Calculator&quot; on page 78</td>
<td>System Definer, Equilibrium Calculator</td>
<td>Equilibrium Calculator, Plot Renderer, Table Renderer</td>
</tr>
<tr>
<td>&quot;Precipitation Calculator&quot; on page 97</td>
<td>System Definer</td>
<td>Plot Renderer, Table Renderer</td>
</tr>
<tr>
<td>&quot;Diffusion Calculator&quot; on page 87</td>
<td>System Definer</td>
<td>Plot Renderer</td>
</tr>
<tr>
<td>&quot;Plot Renderer&quot; on page 102</td>
<td>Property Model Calculator, Equilibrium Calculator, Precipitation Calculator, Diffusion Calculator, Binary Calculator, Ternary Calculator, Scheil Calculator, Experimental File Reader</td>
<td>None</td>
</tr>
<tr>
<td>&quot;Table Renderer&quot; on page 128</td>
<td>Equilibrium Calculator, Property Model Calculator, Precipitation Calculator, Binary Calculator, Scheil Calculator</td>
<td>None</td>
</tr>
<tr>
<td>&quot;Experimental File Reader&quot; on page 131</td>
<td>My Project</td>
<td>Plot Renderer</td>
</tr>
<tr>
<td>&quot;Binary Calculator&quot; on page 131</td>
<td>My Project</td>
<td>Plot Renderer, Table Renderer</td>
</tr>
</tbody>
</table>
### Activity Table

<table>
<thead>
<tr>
<th>Activity</th>
<th>Possible Predecessors</th>
<th>Possible Successors</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Ternary Calculator&quot; on page 133</td>
<td>My Project</td>
<td>Plot Renderer</td>
</tr>
<tr>
<td>&quot;Scheil Calculator&quot; on page 135</td>
<td>System Definer</td>
<td>Plot Renderer, Table Renderer</td>
</tr>
</tbody>
</table>

### Graphical Mode Workflow

You can set up a tree in the Project window (starting with the My Project node) and then perform all the activities at once, or create and perform one activity at a time.

The typical workflow is to:

1. **Define a System**: Create a "System Definer" on page 57 activity (in the Project window) where you select a database and the elements to have as system components (in the Configuration window).

2. **Set up and run a calculation**: Create an "Equilibrium Calculator" on page 78 activity (a successor to the System Definer), where calculation conditions are set (temperature, pressure, etc.). This is where axis variables are set to create a property or phase diagram. These settings are also made in the Configuration window. You can also add a "Property Model Calculator" on page 64, "Precipitation Calculator" on page 97, "Diffusion Calculator" on page 87 or "Scheil Calculator" on page 135.

3. **Visualize the results**: Create either a "Plot Renderer" on page 102 or a "Table Renderer" on page 128 activity in the Project window. When calculated, this creates a plot or table in the Results window. The results are shown in a Plot Renderer or a Table Renderer tab.

You need to **Perform** a Plot Renderer or a Table Renderer activity to visualize the calculation results from an Equilibrium Calculator.

### Main Menu and Toolbar

The **File** menu and toolbar are reserved for Graphical Mode but in Console Mode the **Tools**, **Window** and **Help** menus have the same options.
In Console Mode you use commands to access the other options. These are discussed in "The Console Mode Interface" on page 140.

### Graphical Mode Menu and Toolbar Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Action(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Create a new project.</td>
<td>Click New on the toolbar&lt;br&gt;Select File → New Project&lt;br&gt;Press &lt;Ctrl+N&gt;</td>
</tr>
<tr>
<td>Open</td>
<td>Open an existing project. See &quot;Saving and Opening Project Files&quot; on page 36</td>
<td>Click Open on the toolbar&lt;br&gt;Select File → Open Project&lt;br&gt;Press &lt;Ctrl+O&gt;.</td>
</tr>
<tr>
<td>Open Examples</td>
<td>Open the examples folder based on whether you are in Console Mode or Graphical Mode.</td>
<td>Select File → Open Examples or Select Help → Open Examples</td>
</tr>
<tr>
<td>Save</td>
<td>Save a project. See &quot;Saving and Opening Project Files&quot; on page 36.</td>
<td>Click Save on the toolbar&lt;br&gt;Select File → Save Project&lt;br&gt;Press &lt;Ctrl+S&gt;.</td>
</tr>
<tr>
<td>Save Project As...</td>
<td>Save an existing project with a new name.</td>
<td>Select File → Save Project As...</td>
</tr>
<tr>
<td>Switch to Console Mode</td>
<td>Launch Console Mode and the command prompt.</td>
<td>Click the button to exit Graphical Mode and open Console Mode.</td>
</tr>
<tr>
<td>Switch to Graphical Mode</td>
<td>Launch Graphical Mode to work with the GUI version.</td>
<td>Click the button to exit Console Mode and open Graphical Mode.</td>
</tr>
<tr>
<td>Append Project</td>
<td>Combine two projects into one project file. See &quot;Saving and Opening Project Files&quot; on page 36</td>
<td>Select File → Append Project</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
<td>Action(s)</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Exit</td>
<td>Exit the program.</td>
<td>In the upper right-corner of the program, click the X. Select File → Exit</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Press &lt;Ctrl+Q&gt;.</td>
</tr>
<tr>
<td>Options</td>
<td>Change the global defaults for a variety of settings. See &quot;Changing Global Settings&quot; on page 218.</td>
<td>Select Tools → Options</td>
</tr>
<tr>
<td>Database Checker</td>
<td>Open the Database Checker, a program to check that the syntax of Thermo-Calc database files is correct. This is for advanced users who develop and manage databases.</td>
<td>Select Tools → Database Checker</td>
</tr>
<tr>
<td>Window menu</td>
<td>Highlight a specific window on the GUI</td>
<td>From the Window menu, select an option to refocus on that specific window.</td>
</tr>
<tr>
<td>Online Help</td>
<td>Open the online help system where you can browse or search all the Thermo-Calc documentation.</td>
<td>Select Help → Online Help</td>
</tr>
<tr>
<td>Open Manuals Folder</td>
<td>Open the folder on your computer that has the PDF documentation and guides.</td>
<td>Select Help → Open Manuals Folder</td>
</tr>
<tr>
<td>Show License Info</td>
<td>Open the License Information window.</td>
<td>Select Help → Show License Info</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
<td>Action(s)</td>
</tr>
<tr>
<td>----------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-----------------------------------------------------</td>
</tr>
<tr>
<td>Check for update</td>
<td>Check the Thermo-Calc Software website for updates to the software.</td>
<td>Select Help → Check for update</td>
</tr>
<tr>
<td></td>
<td>Also see &quot;Displaying Thermo-Calc License Information&quot; on page 24 and the Thermo-Calc Installation Guide</td>
<td></td>
</tr>
</tbody>
</table>

**Saving and Opening Project Files**

Thermo-Calc Graphical Mode uses project files with the file name suffix `.tcu`. The add-on Diffusion Module (DICTRA) and/or Precipitation Module (TC-PRISMA) also use the same file format in Graphical Mode.

For information about file formats in Console Mode, see "About the File Types and Formats" on page 5.

To save your project and all its settings and results, on the toolbar click Save. Select to Include calculated results in the project file (the default) as required.

To open a Thermo-Calc project file, on the toolbar click Open and select the project file in the Open file window.

You can only have one project file open at a time. However, you can attach (append) the trees from additional project files to the topmost My Project node. To append an additional project file in this way, from the main menu select File → Append Project and open a project file.

Also see "Saving Plots" on page 122 and Saving Tabulated Data for the "Table Renderer" on page 128.

**Project Activity Nodes**

The section below is a brief description of the project activity types. When working with activities in the Project window these are also referred to as nodes.
These are the project activity nodes available in Graphical Mode.

<table>
<thead>
<tr>
<th>Activity type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;System Definer&quot; on page 57</td>
<td>Define a certain thermodynamic system and read it from file into memory.</td>
</tr>
<tr>
<td>&quot;Property Model Calculator&quot; on page 64</td>
<td>Choose one or more general models to predict and optimize material properties. You can evaluate models simultaneously over a range of compositions and cross plot the results. You can then conduct an uncertainty analysis and plot the results as either a histogram or as a probability plot.</td>
</tr>
<tr>
<td>&quot;Equilibrium Calculator&quot; on page 78</td>
<td>Set thermodynamic conditions and define axis variables when a series of equilibrium calculations are to be performed in one or more dimensions.</td>
</tr>
<tr>
<td>&quot;Precipitation Calculator&quot; on page 97</td>
<td>Set the conditions for, and perform, a precipitation calculation using the Precipitation Module (TC-PRISMA).</td>
</tr>
<tr>
<td>&quot;Diffusion Calculator&quot; on page 87</td>
<td>Using the Diffusion Module (DICTRA), this activity is where you set the geometry, add one or more regions, enter grids and phases in the regions, and then enter compositions of phases.</td>
</tr>
<tr>
<td>&quot;Plot Renderer&quot; on page 102</td>
<td>Determine the layout of non-text based output.</td>
</tr>
<tr>
<td>&quot;Table Renderer&quot; on page 128</td>
<td>Use it for text-based output.</td>
</tr>
<tr>
<td>&quot;Binary Calculator&quot; on page 131</td>
<td>Use it for some calculations involving two components only. It is like a combination of System Definer and Equilibrium Calculator activities with adaptations to simplify the configuration of calculations on binary systems.</td>
</tr>
</tbody>
</table>

To perform this activity, you need a database designed for the Binary Calculator, such as the TCBIN database.
### Activity type

<table>
<thead>
<tr>
<th>Activity type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Ternary Calculator&quot; on page 133</td>
<td>Use it for some calculations involving three components. It is like a combination of System Definer and Equilibrium Calculator activities with adaptations to simplify the configuration of calculations on ternary systems. To get a reliable result you need a database that fully assesses binary and ternary systems.</td>
</tr>
<tr>
<td>&quot;Scheil Calculator&quot; on page 135</td>
<td>Perform Scheil-Gulliver calculations (also known as Scheil calculations). A default Scheil calculation is used to estimate the solidification range of an alloy assuming that i) the liquid phase is homogeneous at all times and ii) the diffusivity is zero in the solid. However, it is possible to disregard the second assumption for selected components.</td>
</tr>
<tr>
<td>&quot;Experimental File Reader&quot; on page 131</td>
<td>Read experimental data files (*.EXP). This type of file contains information specifying a plotted diagram, written in the DATAPLOT graphical language. Also see the DATPLOT User Guide.</td>
</tr>
</tbody>
</table>

### Project and Activity Menus

When working in the Project window you can right-click nodes to open menus with the available actions. For example, click the My Project node to open the menus. Most nodes in the tree have a common menu with differences due to placement in the tree and the activity type.

The menu for the My Project node.
Menu Options for Activities

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Action (s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create New Activity</td>
<td>Add System Definer, Binary Calculator, Ternary Calculator, and Experimental File Reader nodes.</td>
<td>Right-click <strong>My Project</strong> and from the <strong>Create New Activity</strong> menu choose an option.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
<td>Action(s)</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Create New Activity → Use Template | See "Creating Activities and Successors" on page 31. | Right-click **My Project** and from the **Create New Activity → Use Templates** menu choose an option.  
The templates are also available on the **Configuration** window, which you can access by clicking the **My Project** node, or from the **Window** menu. |
| Create New Successor        | Choose from the available templates to use the Wizard or add predefined nodes.  
See "Creating a Project from a Template" on page 49. | Right-click one of these nodes **System Definer**, **Property Model Calculator**, **Equilibrium Calculator**, **Precipitation Calculator**, **Diffusion Calculator**, **Binary Calculator**, **Ternary Calculator** or **Experimental File Reader**, and from the **Create New Successor** menu choose an option. |
<p>| Add a Predecessor           | Add a successor to the selected node.                                        | Right-click a node to add a predecessor to it (when available).                                                                                                                                 |
| Perform Now or Perform Later | Perform a calculation or create a plot or table immediately, or schedule it for a time in the future. See &quot;Using the Scheduler&quot; on page 53. | Right-click any node.                                                                                                                                 |
| Rename                      | Change the name of the node.                                                 | Right-click any node.                                                                                                                                 |</p>
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Action (s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remove</td>
<td>Delete the selected node from the tree.</td>
<td>Right-click any node except My Project.</td>
</tr>
<tr>
<td>Clone</td>
<td>Duplicate the selected node and add it to the same tree. See &quot;Cloning Activities and Trees&quot; on page 50.</td>
<td>Right-click any node except My Project.</td>
</tr>
<tr>
<td>Clone tree</td>
<td>Duplicate a tree and add it to My project.</td>
<td>Right-click any node except My Project.</td>
</tr>
<tr>
<td>Apply Auto Layout</td>
<td>Apply an automatic layout to the nodes in the tree.</td>
<td>Right-click any node.</td>
</tr>
<tr>
<td>Snap to Grid</td>
<td>Snap a node to align it with the grid. See &quot;Moving Nodes in the Tree and Using the Grid&quot; on the next page.</td>
<td>Right-click any node.</td>
</tr>
<tr>
<td>Show Grid</td>
<td>Turn the grid on or off in the Project window.</td>
<td>Right-click any node.</td>
</tr>
<tr>
<td>Zoom In, Zoom Out, Reset Zoom</td>
<td>Zoom in and out of the Project window or reset the zoom to the default.</td>
<td>Right-click any node.</td>
</tr>
</tbody>
</table>

**Organising the Windows on the Desktop**

The windows on the Thermo-Calc desktop can be fixed or free-floating. By default, the windows are fixed and open.

- One exception is the **Event Log** window, which is set to auto-hide by default.
When a window is fixed it can also be set to auto-hide. Auto-hiding means that the window is minimized when you select another window. The minimized window is then shown either along the bottom or side of Thermo-Calc. A free-floating window is shown on top of the other windows and can be moved outside the frame of Thermo-Calc.

**Resetting the Desktop Layout**

To return to the standard desktop layout, from the main menu, select **Windows → Reset Windows**.

**Floating, Hiding and Minimizing Windows in the GUI**

For each window you can rearrange, resize, minimize and close it. At the top right corner are the buttons listed in the table.

<table>
<thead>
<tr>
<th>Button(s)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="toggle" /> <img src="image" alt="free-float" /></td>
<td>Click to toggle on/off free-floating</td>
</tr>
<tr>
<td><img src="image" alt="toggle" /> <img src="image" alt="auto-hide" /></td>
<td>Click to toggle on/off auto-hide.</td>
</tr>
<tr>
<td><img src="image" alt="minimize" /></td>
<td>Click to minimize an open window that has auto-hide turned on. The window automatically minimizes if another window is selected.</td>
</tr>
<tr>
<td><img src="image" alt="close" /></td>
<td>Click to close the window. You can open the window again from the Window main menu.</td>
</tr>
</tbody>
</table>

**Moving Nodes in the Tree and Using the Grid**

In the Project window, you can work with the activity nodes in these ways.
Select and Move Individual Nodes

- Click an activity node to select it.
- To move activities, click and hold the activity node and move the cursor.

Select Several Nodes at a Time

- To select several activity nodes, hold down <Ctrl> while clicking on each node you want to select.
- Click and hold the mouse button and draw a square around the activity nodes to select. Both the name and the icon that represents an activity must be within the square.

Show Grid and Snap to Grid

To show a grid of light-grey cross-hairs overlaid on a project, click Show Grid in the toolbar. Click the button again to turn the grid off. Or right-click in the Project window and select Show Grid.

Click Snap to Grid in the toolbar or right-click in the Project window and select Snap to Grid to automatically position each activity in the Project window at a cross-hairs point in the grid.

The Project window with the grid turned on and activity nodes moved from the default location. These nodes are snapped to the grid.

Zooming In and Out

In the Results window (where the plots are):
• Use the mouse scroll wheel to zoom in and out.
• Click and drag the mouse from left to right to highlight an area of the plot to zoom into a specific point. Use the scroll wheel to continue zooming in or out.
• Click and drag the mouse from right to left reset the plot to its default view. You can also click Perform Tree again.

In the Project window (where the activity nodes are):

• Right-click and select Zoom In or Zoom Out.
• To go back to the default zoom, select Reset Zoom.

**Node Status Markers**

Status markers indicate whether an activity is ready to be performed, is being performed, or has been performed. The markers are overlaid on the activity nodes in the Project window. The status markers are displayed on a System Definer node.

Also see "Results Window Status Markers" on page 128

**Node Status Markers for the Project and Scheduler Windows**

<table>
<thead>
<tr>
<th>Window</th>
<th>Status marker</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project window</td>
<td><img src="image" alt="No status marker" /></td>
<td>No status marker means the activity is ready to be performed (it has not been performed).</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Yellow triangle" /></td>
<td>A yellow triangle means the activity cannot be run. The necessary configurations for the activity may not be set or other prerequisites are not met.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Green disc" /></td>
<td>A green disc means the activity is performed.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Red circle with a dial" /></td>
<td>A red circle with a dial (a clock face) means the activity is currently being performed.</td>
</tr>
<tr>
<td>Window</td>
<td>Status marker</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Scheduler window</td>
<td></td>
<td>No status marker means the activity (the job) is scheduled to be performed (the job has not started).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>A yellow triangle means there an error happened during the activity job.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>A green disc means the activity (the job) performed successfully.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>A green right-facing arrow means the activity (the job) is being performed.</td>
</tr>
</tbody>
</table>
Graphical Mode Projects

These topics describes how you create, perform and link activities.

In this section:

- The Quick Start Wizard ................................................................. 47
- Creating a Project with the Quick Start Wizard .............................. 47
- Creating a Project from a Template .............................................. 49
- Cloning Activities and Trees ....................................................... 50
- Performing Projects, Trees and Activities .................................... 52
- Using the Scheduler ..................................................................... 53
- The Event Log ............................................................................. 54
The Quick Start Wizard

Even before you understand how to work with Thermo-Calc projects, the Quick Start wizard helps you set up a project and run calculations in Graphical Mode. You can set up, calculate and visualize any of the following:

- Single point equilibrium
- Property diagram
- Phase diagram
- Scheil solidification simulation

See "Creating a Project with the Quick Start Wizard" below

Creating a Project with the Quick Start Wizard

To set up, perform and visualize a calculation using the Quick Start wizard:

1. In the Configuration window click Quick Start. If you cannot see the Quick Start button, first click My Project in the Project window.

2. In the Select Project Type window click to select the type of calculation to perform. Single point equilibrium, Property diagram, Phase diagram or Scheil solidification simulation. Click Next.
3. In the **Define Systems** window, choose an available **Database**.

![](image1.png)

4. Click to select **Elements** check boxes to include as system components. To add elements from an existing material file, click the **Material file** button to enter the file path to a material file or click the **Select Material File** button (to the right of the field) to navigate to a file on the computer.

5. Click **Next**.

   The **Select Conditions** window has different options depending on the Project type and the elements selected.

   In this example figure, using a **Single Point Equilibrium**, choose the **Composition unit** and under **Condition Definitions** specify the values of the state variables in the system.

![](image2.png)

   For a **Property diagram** or **Phase diagram**, specify the **Axis Definitions** of the stepping or mapping operation. Choose minimum and maximum values for the variable(s) (select **Linear – min no. of steps**, **Linear – max step size** or **Logarithmic – scale factors**) and whether it is **Normal** or **Separate phases**.

   For a **Scheil solidification simulation**, and where applicable, select **Fast diffuser** to account for back-diffusion of any fast-diffusing elements.

6. Click **Finish**.

7. Click to expand the **Event Log** window to see information about the progress of the calculation.
8. The diagram is plotted in a **Plot Renderer** tab in the **Results** window. If you have calculated a single-point equilibrium, then a **Table Renderer** tab shows information about the equilibrium.

![Diagram](image1)

<table>
<thead>
<tr>
<th>System</th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Moles</td>
<td>1.00000</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mass</td>
<td>12.01154</td>
<td></td>
<td>[g]</td>
<td></td>
</tr>
<tr>
<td>Temperature</td>
<td>1000.0000</td>
<td></td>
<td>[K]</td>
<td></td>
</tr>
<tr>
<td>Total Gibbs Energy</td>
<td>-12559.53136</td>
<td></td>
<td>[J]</td>
<td></td>
</tr>
<tr>
<td>Enthalpy</td>
<td>11784.43824</td>
<td></td>
<td>[J]</td>
<td></td>
</tr>
<tr>
<td>Volume</td>
<td>5.39784E-6</td>
<td></td>
<td>[m³]</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Component</th>
<th>Mole Fraction</th>
<th>Mass Fraction</th>
<th>Activity</th>
<th>Potential</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fe</td>
<td>0.00002</td>
<td>0.00010</td>
<td>0.00619</td>
<td>-42278.5055</td>
</tr>
<tr>
<td>C</td>
<td>0.99998</td>
<td>0.99990</td>
<td>0.21816</td>
<td>-12653.8945</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Stable Phases</th>
<th>Mole</th>
<th>Mass</th>
<th>Volume Fraction</th>
</tr>
</thead>
<tbody>
<tr>
<td>BCC_A2#1</td>
<td>0.00002</td>
<td>0.00012</td>
<td>0.00003</td>
</tr>
</tbody>
</table>

9. To save the project, click **Save** on the main toolbar. To save a diagram or table, right-click the diagram or table and select **Save As**.

**Creating a Project from a Template**

Use a **Template** to create all the activities for a certain type of calculation. In the **Project** window click the **My Project** node to display the templates in the **Configuration** window.

**Configuration Window Templates**

When you click a template, an activity tree is added to the Project window. You can then configure and perform the activities or the project.
For example, if you click **Property Diagram**, a tree is added to the **My Project** node with **System Definer**, **Equilibrium Calculator** and **Plot Renderer** nodes.

**PROPERTY DIAGRAM TEMPLATE**

You can also select templates from the Project window. Right-click the **My Project** node and choose templates from the **Create New Activity → Use Template** submenu.

**USE TEMPLATE**

Cloning Activities and Trees

As described in *[Creating Activities and Successors](page_31)*, you can clone a single activity or the selected activity and all the activities that come after it (successors). The predecessor of the selected activity also is the predecessor of the clone.

Cloned activities are configured exactly like the activities that they were cloned from, and any results of calculations or plots are also cloned. To clone a selected activity, right-click the activity and select **Clone**.

For example, if you clone the Equilibrium Calculator in this project the result is an **Equilibrium Calculator 2** created as a successor to **System Definer 1**.

The following applies to clones.

- The new Equilibrium Calculator has the same settings for conditions, functions and options as its Equilibrium Calculator 1 clone.
- If the Equilibrium Calculator is already performed, then the calculation results are cloned.
- If the activity is a Plot Renderer or a Table Renderer, then the plot or table is cloned.
- If you want to clone all the successor activities that follow a selected activity, then right-click and select **Clone Tree** instead.
Cloning an Equilibrium Calculator Activity Node

Equilibrium Calculator Clones and Successors

If you create an Equilibrium Calculator as a successor to another Equilibrium Calculator, then the successor inherits all the settings for conditions, functions and options from its predecessor. In this respect, it is similar to a clone.

The Equilibrium Calculator successor is different from a clone in that it does not inherit any calculated results and it is a successor to the Equilibrium Calculator instead of a successor to its predecessor.

The calculated result from an Equilibrium Calculator that is the predecessor to another Equilibrium Calculator is the starting value for the latter’s calculation. The clone of an Equilibrium Calculator on the other hand, does not receive any data as input from the Equilibrium Calculator that it is cloned from.

Performing Projects, Trees and Activities

You can trigger the performance of an activity (also called a job) and all the activities below it in the same tree in either the Project or Configuration window. In the Project window you
can also perform a single activity without performing its successors or perform the whole project (all the activity trees).

In the **Configuration** window, click **Perform Tree** to perform the currently selected activity and all the activities below it. If there are no activities below the selected activity, then the button says **Perform** instead.

All activities that must be completed as prerequisites are automatically performed first. For example, if you Perform Tree for a Plot Renderer, then the predecessors, Equilibrium Calculator and System Definer, are automatically performed before the Plot Renderer.

In the **Project** window, you can do any of the following:

- **Perform an activity**: Right-click the activity and select **Perform Now**, or **Perform Later** and schedule a time to perform the activity.
- **Perform an activity and all activities below it in the tree**: Right-click any node in the tree and select **Perform Tree Now**. Or select **Perform Tree Later** and schedule a time for all activities in the tree to be performed.
- **Perform a project**: Right-click **My Project** and select **Perform Now** or **Perform Later** and schedule a time to perform all project activities in the tree.

If there is an error during the performance of an activity, icons display status markers, which are described in "**Node Status Markers** on page 44."

### Using the Scheduler

The **Scheduler** window has activity information about current or scheduled jobs. A **job** is any activity you have selected to be performed. The Scheduler also indicates if there is an error during a job and when a job has stopped. If you have set an activity, tree or project to be performed at a later time then this is also listed.

**About the Scheduler jobs**

- Whenever you trigger the performance of a whole project, tree or individual activity, all the activities to be performed are shown under a job heading.
- When all the activities belonging to a job are completed the job and its activities disappear from the Scheduler window.
- If there is an error during the performance of an activity, icons for that job and activity remain in the Scheduler window until removed.
Also see "Node Status Markers" on page 44.

**EXAMPLE**

Managing the Schedule

In the Scheduler window, you can cancel scheduled jobs, remove errors and show information about errors.

- To cancel all jobs, right-click the **Scheduled Jobs** label or the cogwheel icon, and select **Cancel All Jobs**.
- To remove (clear) all failed activities and jobs, right-click the **Scheduled Jobs** label or the cogwheel icon, and select **Clear All Errors**.
- To cancel a specific job, right-click the job label (for example, **Job no 1**) and select **Cancel Job**.
- To remove (clear) a specific failed job, right-click the job label (for example, **Job no 1**) and select **Cancel Job**.
- To open a window with error details, right-click the label for the failed job (for example, **Job no 1**), and select **Show Error Log**.

**The Event Log**

The **Event Log** window is closed by default. Click the **Event Log** window once to expand it or select it from the **Window→Event Log** menu. Double-clicking the window maximizes it.

Information about what Thermo-Calc is processing or doing is in blue text and error or warning messages are in red text.

To specify the level of detail in the Event Log, from the main menu select **Tools→Options**. In the **General** tab set the **Log level** slide bar to anything between **Debug** (most detailed) and **Error** (least detailed).
Also see "Changing Global Settings" on page 218.

**This example shows information, warnings and errors.**
Graphical Mode Activities

These topics describe the activity types and has instructions for procedures tied to specific activities.

In this section:

<table>
<thead>
<tr>
<th>Activity</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Definer</td>
<td>57</td>
</tr>
<tr>
<td>The System Definer Settings</td>
<td>57</td>
</tr>
<tr>
<td>Property Model Calculator</td>
<td>64</td>
</tr>
<tr>
<td>Property Model Calculator Workflow</td>
<td>65</td>
</tr>
<tr>
<td>Equilibrium Calculator</td>
<td>78</td>
</tr>
<tr>
<td>Diffusion Calculator</td>
<td>87</td>
</tr>
<tr>
<td>Precipitation Calculator</td>
<td>97</td>
</tr>
<tr>
<td>Precipitation Calculator Settings</td>
<td>98</td>
</tr>
<tr>
<td>Plot Renderer</td>
<td>102</td>
</tr>
<tr>
<td>The Configuration Window</td>
<td>103</td>
</tr>
<tr>
<td>Table Renderer</td>
<td>128</td>
</tr>
<tr>
<td>Experimental File Reader</td>
<td>131</td>
</tr>
<tr>
<td>Binary Calculator</td>
<td>131</td>
</tr>
<tr>
<td>Ternary Calculator</td>
<td>133</td>
</tr>
<tr>
<td>Scheil Calculator</td>
<td>135</td>
</tr>
<tr>
<td>Scheil Calculator Advanced Settings</td>
<td>137</td>
</tr>
</tbody>
</table>
System Definer

In a System Definer activity, you select the database to use to retrieve thermodynamic data and define which elements the system has as components. You can also select the species to include as well as change the reference temperature and pressure for your components.

Also see "Creating Activities and Successors" on page 31 for a list of possible successors and predecessors for this activity.

The System Definer Settings

**Configuration Window**

![Configuration Window](image)

**Choose Database(s) or a Database Package**

At the top of the Configuration window you can choose to add one or more databases by clicking the Add a database button. You can also choose a predefined or custom database package from the Package list. Depending on your license, there are predefined database packages available to select.

You can also click Remove this database button as required.
Also see "Global Settings: System Definition (System Definer)" on page 222 to learn how to create a database package.

If you have chosen a database package and then remove or change a database, a message displays Selected databases and selected package may differ. This means that the original package you selected, which added preset databases, does not match the databases you are using for the project. For information about how to clear the message, see "Global Settings: System Definition (System Definer)" on page 222.

There are several settings tabs available for the System Definer activity.

The following example uses the FEDEMO and MFDEMO databases and Example 12 available with the Graphical Mode Examples.

**Elements**

On the **Elements** tab, and based on the databases or database package selected, you can select and review elements using a **Periodic Table** or **Alphabetic List** format. Unavailable elements are greyed out on the Periodic Table view.

**Periodic Table**

In this example, using the demonstration databases FEDEMO and MFDEMO, there are only a select number of elements to choose from.
Alphabetic List

<table>
<thead>
<tr>
<th>Element</th>
<th>FEDEMO</th>
<th>MFDEMO</th>
</tr>
</thead>
<tbody>
<tr>
<td>I</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>C</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Cr</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Fe</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Mn</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Ni</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>VA</td>
<td>✔</td>
<td>✔</td>
</tr>
</tbody>
</table>

Material Composition

On the Periodic Table page, you can also define the material composition:

At the bottom of the window, click Load material to open a material file. The default folder opens to the Materials folder included with your installation.
"About the Material Files" on page 15 and "Examples, Manuals and Materials Folders" on page 9

You can also click Save material as to save the material you defined, for example Ferritic.

Also see "Global Settings: System Definition (System Definer)" on page 222 to learn how to create your own database packages.

If you Load a material file and then change the composition, a message displays The composition has changed. This means that the original values/composition does not match the values you are using for the project. The message is cleared by either reloading the material file or editing the composition field to the original value.

**Species**

On the Species tab for each database you can select and edit the Species.
At the bottom of the window, click **Add new species** and enter the name of species in the field.
Phases and Phase Constitution

At the top of the **Phases and Phase Constitution** tab for each database, you can review and edit the **Status** (Entered or Dormant) for the selected **Phases**. Select the **Check/uncheck all** check box to toggle between the options.

To review the **Phase constitution** for a specific phase, click it in the **Phase** list (for example **BCC_A2**) and its details are displayed at the bottom of the window. Click **Edit** then click an element to select or reject a constituent. The last remaining constituent on a sublattice cannot be rejected.
Components

The Components tab is where you can review and edit the Component, Reference phase, Reference temperature, and Reference pressure. Click to toggle the SER (Stable Element Reference) check box on and off. Then choose a Reference phase from the list and edit accordingly.

Data Sources

Data sources are not available until the activity has been performed. Click Perform Tree to display available data sources.

Description

The Description tab displays a description of the selected database(s). In this example, MFEDEMO.

Creating a System Definer Activity

This topic describes how to define a system; specifically how to select one or more databases and define the elements in the system.
To change the default database or create a database package, see "Global Settings: System Definition (System Definer)" on page 222.

Also see "About the Database Files" on page 214.

1. Right-click My Project and from the menu select Create New Activity→ System Definer.
2. In the Project window, click the "System Definer" on page 57 activity node.
3. In the Configuration window, from the Databases menu choose Database(s) or a Database Package.

Options:
- Select <User database> to define your own.
- You can choose to add one or more databases by clicking the Add a database button.
- From the Package list, choose a predefined database package to add multiple databases at a time. Depending on your license, there are predefined database packages available to select.

4. Select the Elements tab to choose the elements in the Periodic Table or use the Alphabetic List to choose elements for the system.
5. As required click the tabs to make edits: Species, Phases and Phase Constitution, and Components. The Data Sources and Description tabs provide information based on the database.
6. Click Perform to start the System Definer activity immediately and retrieve thermodynamic data about the system. Click the Event Log window to watch the progress of the job.

**Property Model Calculator**

A Property Model Calculator allows you to predict and optimize material properties. A set of general models is available to use: a "Phase Transition Model" on page 73, "Driving Force Model" on page 74, "Interfacial Energy Model" on page 74, "Coarsening Model" on page 75, and an "Equilibrium Model" on page 77.

Experienced users can also create custom property models. See the Introduction to the Property Model Development Framework for details.

You can evaluate models simultaneously over a range of compositions and cross plot the results. You can then conduct an uncertainty analysis and plot the results as either a histogram or as a probability plot. The Configuration window for a Property Model
Calculator using the *Phase transition* model is shown and described in "Defining the Property Model Calculator" on page 68.

**Property Model Calculator Workflow**

When a project is first being designed, it is recommended you test it by first performing a **Single** calculation type. This verifies that the configuration of the model is valid, otherwise you will get a *Not a Number* result in "Event Log Window" on page 146 window indicating the calculation did not work correctly.

Once the Single calculation type performs successfully, you can experiment with other calculation types such as **Grid**, **Min/Max** or **Uncertainty**. Best practice for both Grid and Uncertainty is to start with a small number of steps (Grid) or samples (Uncertainty) to confirm that it works before increasing the number of steps or samples.

In general, the workflow for the different models will differ. A recommended start point is to do a Property Diagram calculation to determine what phases you get and where the transitions are before setting up the Property Model Calculator. You can create a Property Diagram using the Quick Start wizard or a template.

Also see "The Quick Start Wizard" on page 47 and "Creating a Project from a Template" on page 49.

For examples using the Property Model Calculator, see examples 10, 11, and 12 in **Graphical Mode Examples**.
Configuration Window

Configuration Settings

<table>
<thead>
<tr>
<th>Setting/Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Composition unit</td>
<td>Choose a unit: <strong>Mass percent</strong>, <strong>Mole percent</strong>, <strong>Mass fraction</strong> or <strong>Mole fraction</strong></td>
</tr>
<tr>
<td><strong>Condition Definitions</strong></td>
<td>Choose a unit (<strong>Kelvin</strong>, <strong>Celsius</strong> or <strong>Fahrenheit</strong>) and then enter a value for the <strong>Temperature</strong> and <strong>Composition</strong>. The values entered in Condition Definitions are used as the start values for the different calculation types.</td>
</tr>
<tr>
<td>Setting/Button</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Calculation Type</strong></td>
<td>Choose a calculation type: Single (no axes), One axis, Grid, Min/Max or Uncertainty. Select Single to calculate a single point. Select One axis to vary a quantity on the X-axis. Select a Grid to evaluate two axis variables of the selected quantities in the specified range and number of steps. The Min/Max calculation evaluates the property model(s) for all variations of the selected quantities at the given limits. The Mean field is as defined under Condition Definitions for the respective quantity. The total minimum and maximum of the model(s) results are shown in the Event log. The Uncertainty calculation evaluates the property model(s) where the values of the quantities are sampled from Gaussian distributions. The Mean field is as defined under Condition Definitions for the respective quantity. The result is visualized as a histogram or normal probability plot by adding a Plot Render activity.</td>
</tr>
<tr>
<td><strong>Single calculation</strong></td>
<td>For the Single calculation type no further settings are required. The results from this calculation are displayed in the Event Log.</td>
</tr>
<tr>
<td><strong>Axis Definition</strong></td>
<td>For One axis, select a Quantity to vary along the X-axis, for example, Temperature then enter a Min, Max and Number of steps.</td>
</tr>
<tr>
<td><strong>Grid Definitions</strong></td>
<td>For the Grid calculation type, define the two axes variables using the fields and menus: Quantity, Min, Max and Number of steps. The number of steps along with the minimum and maximum values for the axes define a grid. For each grid point the selected models are evaluated.</td>
</tr>
<tr>
<td><strong>Min/Max Definitions</strong></td>
<td>For the Min/Max calculation type, click to select the applicable check boxes under Quantity to enable or disable an axis. The Mean field is as defined under Condition Definitions for the respective quantity. Enter numerical values in the Δ Min/Max fields to evaluate the change to the quantity. The highest and lowest value of each selected model results are shown in the Event log.</td>
</tr>
</tbody>
</table>
### Setting/Button | Description
--- | ---
**Sampling of Data from Gaussian Distributions** | For the Uncertainty calculation type, click to select the applicable check boxes under Quantity to vary this quantity. The Mean field is for the distribution function as defined under Condition Definitions for the respective quantity. ΔMin/Max is the 95% confidence interval.

**Sampling Parameters** | For the Uncertainty calculation type, choose a number of Standard deviations where you want to Truncate the distribution. Choose the Total number of samples.

Also see "About the Uncertainty Calculations" on the next page for more detail.

**Defining the Property Model Calculator**

1. From the left side of the Configuration window, click to select one or more of the check boxes under the General Models folder.

   A tab with the same name as the property model opens in the right side of the window under Condition Definitions. When you select more than one model, a matching tab is added in the same order that the check box is selected.

   ![Configuration window](image)

2. Enter the settings described in the following table for the Condition Definitions and for each Calculation Type (Single, Grid, Min/Max, and Uncertainty). For each model on the Configuration tab, select or enter settings as required. Click the Description tab for more information about the model and refer to the individual sections for details.
"Phase Transition Model" on page 73
"Driving Force Model" on page 74
"Interfacial Energy Model" on page 74
"Coarsening Model" on page 75
"Equilibrium Model" on page 77

About the Uncertainty Calculations

The following example uses the "Phase Transition Model" on page 73 and an Uncertainty Calculation Type to describe how the sampling of data is performed. The example (which is example 10 in Graphical Mode Examples) predicts the transition temperature to the unwanted brittle Sigma phase and shows how the temperature is influenced by changes to a steel alloy’s composition.

The Uncertainty calculation in Thermo-Calc uses the values (the mean) entered for quantities in the Condition Definitions section as the starting point to estimate, within a certain probability, the true variation of the quantity.

An example of a Gaussian distribution is shown. The mean is at the peak of the curve (labelled $\mu$). The standard deviation ($\sigma$) is a plus and minus range, $\pm 1\sigma$, $\pm 2\sigma$ or $\pm 3\sigma$, of the variance from the mean.

Gaussian Distribution, the 3-Sigma Rule

As long as the number of events (the sample size) is very large, then the Gaussian distribution function can be used to describe physical events. A Gaussian distribution is assumed to describe how each quantity varies in an uncertainty calculation.

In Thermo-Calc, the mean of the quantity’s distribution is defined in the *Condition Definitions* section. The **Mean** is then used in the *Sampling of Data from Gaussian Distributions* section as the starting point for how much you want to deviate from this value.

**Condition Definitions and Sampling Settings**

The mean defined in Condition Definitions is used during the sampling.
The values entered in the Δ Min/Max fields are the resulting width of the distribution corresponding to the 95% confidence interval (approximately $\mu \pm 2\sigma$) shown in Gaussian distribution, the 3-sigma rule. This confidence interval means that approximately 95% of the sampled values will fall within these limits.

The default value for truncating the distribution is set at 3 standard deviations in the Sampling Parameters section. This is also where you set the Total number of samples. The default is 200. In order to maintain a Gaussian distribution for the varied quantities, this number should not be too low.

**Sampling Parameter Settings**

You can experiment by varying the conditions and the number of samples to see the distribution results smooth out as is to be expected based on the Central Limit Theorem. For example, on the Plot Renderer the variable is set to measure the Composition of Ni. The initial sample size uses the default, 200, and then, as in the example below where the sample size is increased to 300, 400, 600, 800, and 1000 to show how the plot follows the Gauss distribution.
Histogram Plot

This is a series of histogram plots of the uncertainty calculations sampling data from Gaussian distributions. It compares the Ni composition where the total sample size is increased to show how the model follows the Gauss distribution.

Normal Probability Plot

You can also plot the results as a Normal probability. Continuing with this example, on the Property Model Calculator Configuration window the X-Axis variable is plotted as Composition and the Y-Axis variable is plotted as the Normal probability.
This is a normal probability plot example of the uncertainty calculations sampling data from Gaussian distributions. It compares the Ni composition where the total sample size is 200. The sampled data (blue line) closely follows the ideal normal distribution (red line). Deviations are naturally larger at the tails (≈1%Ni and ≈2%Ni) since the number of samples are fewer there compared to the center of the distribution.

**Phase Transition Model**

By varying set conditions, the **Phase Transition** model calculates the point when a new phase may form. The model is useful to determine melting temperature, boiling temperature or solubility limits. It returns the phase transformation temperature, or composition, depending on the varied condition.

For an example of a phase transition model, see example 10 in [Graphical Mode Examples](#).
Define the:

- **Matrix phase** - The single phase region to start in. Select 'Any phase' to use the phases that take part of the initial equilibrium or choose a specific phase.
- **Phase to form** - For the new phase to be formed, select 'Any phase' or choose a specific phase.
- **Condition to vary** – Choose whether to vary a composition or temperature condition when calculating the phase transition.
- **Search direction** - For the composition or temperature condition being varied, choose the Search direction to be in a **Positive, Negative, or Positive and Negative** direction.
- **Upper search limit** and **Lower search limit** - These values also relate to the search direction, where an estimated change to the released condition implies where a new phase is expected.

The start value (given in Condition Definitions) and phase transition point need to be within these limits, otherwise the model returns **Not a Number** as result. For example, a start temperature is 1100 K then the limits need to be outside these, e.g. 500-1500.

**Driving Force Model**

The **Driving Force** model calculates the thermodynamic driving force for a phase.

- **Matrix phase**: Choose a **Matrix phase**, the single phase region to start in. Select 'Any phase' to use the phases that take part of the initial equilibrium or choose a specific phase.
- **Precipitate phase**: Choose a **Precipitate phase** to calculate its driving force.

The calculation result is the driving force divided by RT.

For an example of a driving force model, see example 12 in **Graphical Mode Examples**.

**Interfacial Energy Model**

Use the **Interfacial Energy** model to estimate the interfacial energy between a matrix phase and a precipitate phase using thermodynamic data from a CALPHAD database. The approximation model is based on Becker's bond energy approach and is also available in Precipitation Module (TC-PRISMA). In the actual calculation, the coefficients taken distinguish between only bcc and fcc structure for the (110) and (111) lattice plane, respectively.
For other planes and/or other phases, the estimate is approximate. In most situations, it is recommended to perform calibrations against some experimental data because the interfacial energy is dependent on so many factors that are ignored in the estimation, for example entropy, incoherency, orientation, and curvature, etc. Uncertainty factors must also be considered as thermodynamic data in CALPHAD databases are not always accurate.

Select the **Matrix phase** and **Precipitate phase** to return the interfacial energy [J/m²].

For an example of an interfacial energy model, see example 11 in [Graphical Mode Examples](#).

### Estimation of coherent interfacial energy

Interfacial energy is an important parameter used in precipitation simulations to calculate the rates of nucleation, growth/dissolution, and coarsening. The value of interfacial energy can vary dramatically (usually between 0.01 to 2.0 J/m²).

The extended Becker’s model functions to estimate coherent interfacial energy by using thermodynamic data from existing CALPHAD thermodynamic databases:

$$\sigma_c = \frac{n_s z_s \Delta E_s}{N_z z_i}$$

where $\sigma_c$ is the coherent interfacial energy, $n_s$ is the number of atoms per unit area at the interface, $z_s$ is the number of cross bonds per atom at the interface, $z_i$ is the coordination number of an atom within the bulk crystal lattice, and $\Delta E_s$ is the energy of solution in a multicomponent system involving the two phases being considered. (Reference 1).

### Coarsening Model

The **Coarsening** model calculates the coarsening rate coefficient $K$ (m³/s) of a spherical precipitate phase in a matrix phase.

- **Matrix phase**: Choose the **Matrix phase**.
- **Precipitate phase**: Choose a **Precipitate phase** to calculate its coarsening rate.

Returns the coarsening rate coefficient [m³/s] for the precipitate phase and the interfacial energy [J/m²] between matrix and the precipitate phase.

This model requires that the thermodynamic and kinetic databases used include descriptions of molar volume of the matrix and precipitates as well as mobilities for the matrix phase.

---

For an example of a coarsening model, see example 11 in Graphical Mode Examples.
**Particle Coarsening**

In the coarsening regime where the driving force is capillarity, the change of mean particle radius evolves according to the equation:

$$ \bar{r}^3 - \bar{r}_0^3 = K t $$

Following Morral and Purdy, the rate constant of precipitating $\beta$ phase in a multicomponent $\alpha$ phase is

$$ K = \frac{8 \sigma_{\alpha \beta} v_{\alpha \beta}}{9} \left[ c^\beta_i - c^\alpha_i \right]^T [M]^{-1} \left[ c^\beta_i - c^\alpha_i \right] $$

The mobility matrix $M$ is not the same as the mobilities that can be obtained directly from the Diffusion Module (DICTRA). The $M$ matrix instead corresponds to the $L''$ matrix as defined by Andersson and Ågren.

Using the $u$-fractions that is defined as

$$ u_k = \sum_{j \in S} x_j $$

where the summation only is performed over the substitutional elements give the final equation for the coarsening rate coefficient.

$$ K = \frac{8 \sigma_{\alpha \beta} v_{\alpha \beta}}{9} \left[ u^\beta_i - u^\alpha_i \right]^T \left[ L''_{jk} \right]^{-1} \left[ u^\beta_k - u^\alpha_k \right] $$

The interfacial energy $\sigma$ is calculated using the extended Becker’s model (that also is available as a separate Property Model Calculator model)

**References**


**Equilibrium Model**

The Equilibrium model calculates the equilibrium for the given conditions. Optionally define additional **Function Definitions**. All quantities that normally can be obtained from an equilibrium calculation can also be obtained when plotting the results, as well as the defined functions.
Equilibrium Calculator

An Equilibrium Calculator allows you to set the conditions for, and perform, a calculation. The Configuration window for an Equilibrium Calculator has these tabs:

- **Conditions**: Set the conditions for your calculation that define the stepping or mapping axis variables. This tab can be viewed in a simplified mode and in an advanced mode. See "Equilibrium Calculator Conditions Settings" on the next page.

- **Functions**: Define your own quantities and functions, which you then can calculate and plot. See "Calculating and Plotting Functions" on page 86.

- **Options**: Modify numerical settings that determine how equilibria are calculated, as well as how stepping and mapping calculations are performed. See "Equilibrium Calculator Options Settings" on page 83.

The **Options** tab is where you can locally define specific Equilibrium Calculator settings. These settings can also be applied globally. From the main menu select Tools → Options and click the Activities tab. Then click Calculation. See "Global Settings: Calculation (Equilibrium Calculator)" on page 226 for some more information.

See "Creating Activities and Successors" on page 31 for a list of possible successors and predecessors for this activity. An Equilibrium Calculator that is the successor of another Equilibrium Calculator inherits all the Configuration window settings of the predecessor.

For an example of how serially coupled Equilibrium Calculators can be used, see example 6 in "Equilibrium Calculator Examples" on page 13.
Configuration Window

Configuration Window

Equilibrium Calculator Conditions Settings

Conditions and axis variables for the Equilibrium Calculator are set in the Conditions tab of the Configuration window. The tab can be viewed in two modes: simplified (the default) or advanced.

The conditions to set depend on the type of calculation.

See "Equilibrium Calculator Examples" on page 13: Example 1 is a single-point equilibrium calculation; Example 2 is a stepping calculation; Example 5 is a mapping calculation.

In advanced mode, you can add and remove conditions as well as set additional axis definitions. However, the number and types of conditions set must still conform to the Gibbs’ phase rule. The Number of missing conditions is field, at the top of the tab shows how many conditions that you have left to set. If the number is negative, then that number of conditions need to be removed.

Setting Conditions for Simplified Mode

The following table briefly describes what you can set on the Conditions tab in simplified mode. Click Switch to advanced mode for more options.
# The Conditions Tab

<table>
<thead>
<tr>
<th>Setting or Condition</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Composition unit</td>
<td>Choose from <strong>Mass percent</strong>, <strong>Mole percent</strong>, <strong>Mass fraction</strong> or <strong>Mole fraction</strong>.</td>
</tr>
<tr>
<td><strong>Condition Definitions</strong></td>
<td>Specify the values (and units) of the state variables: <strong>Temperature</strong>, <strong>Pressure</strong>, and <strong>System size</strong>.</td>
</tr>
<tr>
<td><strong>Calculation Type</strong></td>
<td><strong>Single equilibrium</strong> (no axes), <strong>Property diagram</strong>, <strong>Property grid</strong> or <strong>Phase diagram</strong>. For the <strong>Single</strong> calculation type no further settings are required. The results from this calculation are displayed in the <strong>Event Log</strong>.</td>
</tr>
</tbody>
</table>
| **Axis Definitions** | **Property diagram**: Define the axis variable using these fields and menus: **Quantity**, **Min**, **Max**, **Step division** and **Type**.  
**Property grid**: Define the two axis variables using these fields and menus: **Quantity**, **Min**, **Max** and **Number of steps**. |

**Conditions Tab, Simplified Mode Settings**

These are the settings on the Equilibrium Calculator Conditions tab in Simplified Mode.
<table>
<thead>
<tr>
<th>Setting or Condition</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Phase diagram</strong></td>
<td>Define the two axis variables using these fields and menus: <strong>Quantity</strong>, <strong>Min</strong>, <strong>Max</strong>, <strong>Step division</strong> and <strong>Type</strong>.</td>
</tr>
<tr>
<td></td>
<td>If the Equilibrium Calculator already has a Plot Renderer as a successor and you change the stepping/mapping quantities, then the quantities represented on the X- and Y-axis are automatically updated in the Plot Renderer.</td>
</tr>
<tr>
<td>Number of steps (Property grid)</td>
<td>Set a fixed <strong>Number of steps</strong>. The number of steps along with the minimum and maximum values for the axes define a grid. For each grid point an equilibrium is calculated.</td>
</tr>
<tr>
<td>Type and Step division (Property diagram and Phase diagram)</td>
<td><strong>Type</strong> options: Linear - min no. of steps, Linear - max step size and Logarithmic - scale factor.</td>
</tr>
<tr>
<td></td>
<td>For Linear - min no. of steps, the <strong>Step division</strong> value specifies a minimum number of steps that is calculated between the minimum and maximum value during the stepping/mapping operation.</td>
</tr>
<tr>
<td></td>
<td>For Linear - max step size, the <strong>Step division</strong> sets the maximum size of each step. For Logarithmic - scale factor, <strong>Step division</strong> specifies the scale factor of a logarithmic function that distributes the steps from the initial equilibrium to the minimum and maximum values defined.</td>
</tr>
</tbody>
</table>

**Calculating with a Fixed Phase (Advanced Mode)**

This describes how to use the advanced mode to set a phase to be fixed at a certain amount. This allows you to, for example, find out at what temperature a material starts to melt. If you set the phase to be fixed to liquid phase at zero amount, and do not define the temperature state variable, then you can calculate at what temperature the material enters a state where the liquid phase is no longer zero (that is, when it starts to melt).
How to Calculate with a Fixed Phase

For a fixed phase equilibrium calculation, it is recommended to serially couple the Equilibrium Calculators. This is where one Equilibrium Calculator activity is the successor to another Equilibrium Calculator activity that performs an ordinary equilibrium calculation, and then, for the condition you are interested in, you make a rough estimate of the value. This gives the fixed phase calculation better starting values.

1. Right-click a node that can add an Equilibrium Calculator to your project. See "Creating Activities and Successors" on page 31 for a list.
2. In the Project window, click the Equilibrium Calculator activity node.
3. In the Configuration window, click Switch to advanced mode.

If the Default calculation mode is globally set to Advanced then by default the Configuration window is already in advanced mode. See "Changing Global Settings" on page 218.

4. Under Condition Definitions, click the Add quantity button.
5. Select Fix phase from the first menu.
6. Select the phase that you want to fix in the second menu, and set the amount of that phase you want to fix the phase to. For example, if you want to know when your material starts to melt, set the phase to LIQUID and the value to 0.0:

![Configuration Window](image)

Above the condition definitions, the Number of missing conditions is field is probably -1. This means that you must remove one condition.

7. To remove a condition, either click the remove button, or click to clear the checkbox. For example, if you want to know at what temperature your material starts to melt, then you cannot have a fixed temperature, in which case the temperature condition is not selected:
The **Number of missing conditions** is field displays 0. When you have set all your conditions, you can perform the Equilibrium Calculator (now or later).

**Equilibrium Calculator Options Settings**

These settings are for the "Equilibrium Calculator" on page 78 and are located on the Configuration window, Options tab.

These settings can be changed locally for a specific Equilibrium Calculator or globally in the Options settings (from the main menu select Tools → Options. Click the Activities tab then click Calculation).

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default calculation mode</td>
<td>Simplified (the default) or Advanced</td>
</tr>
<tr>
<td>Default calculation type</td>
<td>Single equilibrium (the default), Property diagram, Phase diagram or Property grid</td>
</tr>
<tr>
<td></td>
<td><strong>Single equilibrium and property grid</strong></td>
</tr>
<tr>
<td>Setting</td>
<td>Options</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Global minimization</td>
<td>The check box is selected by default to ensure that the most stable minimum under the specified conditions is computed.</td>
</tr>
<tr>
<td>Max no of iterations</td>
<td>By default, the program tries 500 iterations before it gives up. As some models give computation times of more than 1 CPU second/iteration, this number is also used to check the CPU time and the calculation stops if 500 CPU seconds/iterations are used.</td>
</tr>
<tr>
<td>Max grid points</td>
<td>Coarse (2000 grid points, the default), Medium (20,000 grid points), Fine (200,000 grid points), or Custom (set your own number of grid points).</td>
</tr>
<tr>
<td>Required accuracy</td>
<td>The default is 1.0E-6. This is a relative accuracy, and the program requires that the relative difference in each variable must be lower than this value before it has converged. A larger value normally means fewer iterations but less accurate solutions. The value should be at least one order of magnitude larger than the machine precision.</td>
</tr>
<tr>
<td>Smallest fraction</td>
<td>The default is 1.0E-12. This is the value assigned to constituents that are unstable. It is normally only in the gas phase you can find such low fractions. The default value for the smallest site-fractions is 1E-12 for all phases except for IDEAL phase with one sublattice site (such as the GAS mixture phase in many databases) for which the default value is always as 1E-30.</td>
</tr>
<tr>
<td>Approximate driving force for metastable phases</td>
<td>The check box is selected by default, which means the metastable phases are included in all iterations. However, these may not have reached their most favourable composition and thus their driving forces may be only approximate.&lt;br&gt;&lt;br&gt;If it is important that these driving forces are correct, click to clear the check box to force the calculation to converge for the metastable phases.</td>
</tr>
<tr>
<td>Setting</td>
<td>Options</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Force positive definite phase Hessian</td>
<td>The check box is selected by default.</td>
</tr>
<tr>
<td>Control stepsizes</td>
<td>The check box is selected by default</td>
</tr>
<tr>
<td><strong>Property diagram</strong></td>
<td></td>
</tr>
<tr>
<td>Global minimization</td>
<td>The check box is selected by default to ensure that the most stable minimum under the specified conditions is computed.</td>
</tr>
<tr>
<td>Global test interval</td>
<td>Every 10\textsuperscript{th} eq (the default), Always or Custom</td>
</tr>
<tr>
<td><strong>Phase diagram</strong></td>
<td></td>
</tr>
<tr>
<td>Global minimization</td>
<td>The check box is selected by default to ensure that the most stable minimum under the specified conditions is computed.</td>
</tr>
<tr>
<td>Global test interval</td>
<td>At node points (the default), Every 10\textsuperscript{th} eq, Always or Custom</td>
</tr>
<tr>
<td>Generate starting points automatically</td>
<td>The check box is selected by default</td>
</tr>
<tr>
<td>Use inside meshing points</td>
<td>Click to select the check box as required</td>
</tr>
<tr>
<td>No of meshes along an axis</td>
<td>The default is 3</td>
</tr>
</tbody>
</table>
Calculating and Plotting Functions

The Functions tab allows you to define your own functions that can be plotted in a Plot Renderer.

For an example of how you can use functions that you yourself define, see example 7 in "Equilibrium Calculator Examples" on page 13.

How to Calculate and Plot Functions

1. Create an Equilibrium Calculator node and click it in the Project window.
2. In the Configuration window click the Functions tab.
3. Under Quantity Definitions, define Q1. Click the add button to Add a new quantity. Then from the lists, choose the variable for each quantity to define. The quantities are called Q1, Q2, Q3 and so on. In this example, the quantity Q1 is defined as the Amount of phase, with No normalization, LIQUID in Mole units.

![Configuration window showing Equilibrium Calculator with Function Definitions]({"image": "Configuration_window.png"})

4. Under Function Definitions, click the add button to add a new function. In the left field edit the default name of each function and enter the function itself in the right field after the equal sign. In this example, the quantity defined as Q1 is renamed to fraction_solid, which gives as its output the fraction of solid phase (1-Q1).

![Configuration window showing Equilibrium Calculator with Function Definitions]({"image": "Configuration_window.png"})

You can also use Console Mode syntax when entering the function. For example, the function above can be entered as 1-NP(LIQUID).

5. To plot the defined function, right-click Equilibrium Calculator and choose Create new successor→Plot Renderer.
6. Click the Plot Renderer node. In the tab for the Equilibrium Calculator that contains the function, set an Axis variable to Function, then from the menu select the defined function. In this example the Y-axis is set to plot the value of the function fraction_solid.

When run, the Plot Renderer plots the value of the function.
Diffusion Calculator

The Diffusion Calculator is available with two elements if you do not have the additional Diffusion Module (DICTRA) license. With the add-on module you can use all available elements as per the licensed database selected.

A Diffusion Calculator allows you to set the conditions for, and perform, a diffusion calculation. The Configuration window for a Diffusion Calculator has these tabs:

- **Conditions**: Set the conditions for your calculation that define the geometry, regions, phases, grids, composition profiles and the thermal profile.

- **Options**: Modify the simulation conditions such as the choosing the default solver (automatic or homogenization) and the time integration method. Also define the time step controls and if you choose homogenization as the solver, define further settings such as the interpolation scheme and whether to use global minimization or not.

    See "Diffusion Calculator Options Settings" on page 92.

The following Configuration window is from the Graphical Mode Quick Start Guide. It is using project example file Ex_20 - Diffusion of a Moving Boundary.

**EXAMPLE**
The following sections list the settings available from the **Conditions** tab. For the Options tab, see "**Diffusion Calculator Options Settings**" on page 92.

You can edit the defaults for some of these settings by going to **Tools → Options → Graphical Mode → Diffusion**. Also see "**Global Settings: Diffusion (Diffusion Calculator)**" on page 226.
The Diffusion Module (DICTRA) in Console Mode has commands to perform some of the settings also available on the Diffusion Calculator. Where possible the name of the command is indicated. All the commands are described in the *Diffusion Module (DICTRA) Command Reference*.

### General

See also these Console commands: ENTER_COMPOSITIONS and ENTER_GEOMETRICAL_EXPONENT

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Composition unit</td>
<td>Choose from Mass percent, Mole percent, Mass fraction or Mole fraction.</td>
</tr>
<tr>
<td>Length unit</td>
<td>Choose m, µm or nm.</td>
</tr>
<tr>
<td>Geometry</td>
<td>Choose Planar, Spherical or Cylindrical. For Cylindrical, also enter a value for the First interface position. With a cylindrical or spherical geometry, the system’s zero coordinate (left boundary) is at the centre of the cylinder or sphere. The highest coordinate (right boundary) is defined by the cylinder or sphere radius.</td>
</tr>
</tbody>
</table>

### Region

See also these Console commands for some of the equivalent settings: ENTER_COMPOSITIONS and ENTER_GRID_COORDINATES

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left and Right Interface boundary</td>
<td>Toggle between hiding and showing the Left interface boundary or Right interface boundary.</td>
</tr>
<tr>
<td></td>
<td>Click the Add quantity or Remove quantity buttons as required to add a Phase and then enter a value for the Driving force as required. The default driving force is $1.0E-5$.</td>
</tr>
<tr>
<td>Name</td>
<td>Enter a Name for the region in the field. For example, enter Austenite. This name is automatically updated on the tab and above the grid points</td>
</tr>
<tr>
<td>Setting</td>
<td>Options</td>
</tr>
<tr>
<td>------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>graphic. You can also double-click the tab to enter the name.</td>
<td></td>
</tr>
<tr>
<td>Width</td>
<td>Enter a numerical value in the Width field. The unit is the one selected for the Length unit.</td>
</tr>
<tr>
<td>Points</td>
<td>Enter a numerical value in the points field. The default is 50.</td>
</tr>
<tr>
<td>Select a type of grid, Linear, Geometric or Double geometric.</td>
<td>Choose Geometric for a grid that yields a varying density of grid points in the region. Then enter a Ratio to determine the distribution. A geometrical factor larger than one yields a higher density of grid points at the lower end of the region and a factor smaller than one yields a higher density of grid points at the upper end of the region. Choose Double geometric to have a high number of grid points in the middle or at both ends of a region. Then specify two geometrical factors, the Upper ratio for the distribution in the lower (left) part of a region, and Upper ratio for the distribution in the upper (right) part of a region.</td>
</tr>
<tr>
<td>Phase</td>
<td>Choose a Phase from the list. The available options are defined in the System Definer. At least one phase that dissolves all system elements must be selected. Click the Add quantity or Remove quantity buttons as required.</td>
</tr>
<tr>
<td>Composition profile</td>
<td>Click Edit to open the Initial Composition window. Select a Dependent component for which the composition does not need to be given. The available options depend on the phase description. For each Component choose one of these options: Linear: enter a range in the from and to fields.</td>
</tr>
</tbody>
</table>
### Setting Options

- **Step**: enter a range in the **from** and **to** fields. Enter a numerical value in the **step at** field. The unit is the one selected for the **Length unit**.
- **Function**: Enter a composition function in the field using SI units. Some useful functions are the error function denoted erf(X) and the Heaviside step-function denoted hs(X). For example the function \(3+2hs(x-1e^{-4})\) provides a concentration of 3 at the left side and 5 at the right side with a sharp step in the concentration profile at 1e-4m=100mm.

Click **Apply** when you are done.

### Thermal Profile

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Isothermal</td>
<td>Use an <strong>Isothermal</strong> thermal profile to do a diffusion simulation at constant temperature. Enter a <strong>Temperature</strong> and select the unit as <strong>Kelvin</strong>, <strong>Celsius</strong> or <strong>Fahrenheit</strong>. Enter a <strong>Simulation time</strong> and select the unit as <strong>Seconds</strong>, <strong>Minutes</strong>, <strong>Hours</strong> or <strong>Days</strong>.</td>
</tr>
<tr>
<td>Non-Isothermal</td>
<td>For the <strong>Non-isothermal</strong> thermal profile, select a <strong>Temperature unit</strong> and <strong>Time unit</strong> from the lists. Enter a value for the <strong>Simulation time</strong>. Click <strong>Edit thermal Profile</strong>. Here the <strong>Temperature</strong> and <strong>Time</strong> coordinates of thermal profile points are entered. You can also click <strong>Import</strong> to add your own thermal profile. <strong>EDIT THERMAL PROFILE WINDOW</strong> This image is from example 22 - <em>Diffusion Fe-C moving Boundary Austenite to Ferrite</em>.</td>
</tr>
</tbody>
</table>
**Diffusion Calculator Options Settings**

The following settings are available on the **Options** tab for aDiffusion Calculator.

- You can edit the defaults for some of these settings by going to **Tools → Options → Graphical Mode → Diffusion**. Also see "Global Settings: Diffusion (Diffusion Calculator)" on page 226.

- The Diffusion Module (DICTRA) in Console Mode has commands to perform some of the settings also available on the Diffusion Calculator. Where possible the name of the command is indicated. All the commands are described in the *Diffusion Module (DICTRA) Command Reference*.

**Simulation Conditions**

See also these Console commands for some of the equivalent settings: HOMOGENIZATION_MODEL, SWITCH_MODEL, SET_SIMULATION_CONDITION, and SET_NUMERICAL_LIMITS.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default solver</td>
<td><strong>Automatic</strong> or <strong>Homogenization</strong>.</td>
</tr>
</tbody>
</table>
### ABOUT THE HOMOGENIZATION SOLVER

The homogenization solver (called the homogenization model in Console Mode) is useful when you want to simulate long-range diffusion through a multiphase mixture, under the assumption that local equilibrium holds at each node point.

**Trapezoidal or Euler backwards.**

The default is *Trapezoidal*. However, if large fluctuations occur in the profiles it may be necessary to use the more stable but less accurate *Euler backwards*.

**Yes, No or Every nth.**

Select *Every nth* to enter a value in the field. This setting is determine if the results are to be saved on file during the course of the simulation.

- **Yes** to always save on file
- **No** to never save on file
- **Every nth** to save every n\(^{th}\) time to file. Then enter an integer value ranging from 0 to 99.

**Use forced starting values in eq. calculations**

Select the check box to have these equilibrium calculations performed using forced starting values.

**Default driving force for inactive phase**

Enter a value in the field. The required driving force (evaluated as \(DGM_{(ph)}\)) to be used for determining whether an inactive phase is stable. \(DGM\) is the variable for the driving force that is already divided by RT, and it is dimensionless. The default is 0.01.

Also see *"Suffixes" on page 341* in the *Thermo-Calc Console Mode Command Reference.*
**Timestep Control**

See also these Console commands for some of the equivalent settings: SET_ACCURACY, SET_SIMULATION_TIME, and SET_SIMULATION_CONDITION.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max relative error</td>
<td>Enter a value in the field. The default is 0.05.</td>
</tr>
<tr>
<td>Max absolute error</td>
<td>Enter a value in the field. The default is 1.0E–5.</td>
</tr>
<tr>
<td>Time step</td>
<td>Enter values in the fields.</td>
</tr>
<tr>
<td>- Initial. What is used as the initial time step. The default is 1.0E–7.</td>
<td></td>
</tr>
<tr>
<td>- Smallest allowed. The smallest time step allowed during the simulation. This is required when using the automatic procedure to determine the time step. The default is 1.0E–7.</td>
<td></td>
</tr>
<tr>
<td>- Max % of simulation time. The default is 10.</td>
<td></td>
</tr>
<tr>
<td>Factor specifying the maximum increase in the time step taken from one time step to another</td>
<td>For example, if 2 is entered the maximum time step is twice as long as the previous time step taken. Enter a value in the field. The default is 2.</td>
</tr>
</tbody>
</table>

**Classic Model Specific**

See also these Console commands for the equivalent settings: SET_SIMULATION_CONDITION and SET_NUMERICL>LIMITS.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use the [activity or potential] of a component in order to find the correct tieline at the</td>
<td></td>
</tr>
</tbody>
</table>
Setting

phase interface.
Determines whether the program should use the potential or the activity of a component in order to find the correct tie line at the phase interface. The potential or the activity is varied by the program and is set in order to reduce the degrees of freedom at the local equilibrium.

Required accuracy during the solution of the flux balance equations. The default is $1.0 \times 10^{-16}$.

Homogenization Model Specific

This section is available when Homogenization is selected (or automatically selected) as the Default solver. These settings are available on the Options tab.

See also these Console commands for some of the equivalent settings: ENTER_HOMOGENIZATION_FUN and HOMOGENIZATION_MODEL.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Homogenization function</td>
<td>Several functions are available. The default is Rule of mixtures (upper Wiener bound). See &quot;About the Homogenization Functions&quot; on the next page.</td>
</tr>
<tr>
<td>Use global minimization</td>
<td>Select the check box for global minimization used in equilibrium calculations. In general, using global minimization significantly increases the simulation time, but there is also a significantly reduced risk for non-converged equilibrium calculations.</td>
</tr>
<tr>
<td>Interpolation scheme</td>
<td>When the homogenization model is used, simulations are run using an implicit finite volume method to increase numerical stability. Because of this, and other factors, homogenization model simulations generally run slower than other comparable simulations.</td>
</tr>
</tbody>
</table>
Setting | Options
--- | ---
You can reduce simulation time with the **Use Interpolation scheme** check box. The check box is selected by default.

[Logarithmic or Linear] discretization with [number of] steps in each dimension.

- For the linear discretization the scheme is not used at node points where the content of one or more solutes fall below a certain critical value. For such cases, where composition span many orders of magnitude, the logarithmic discretization can be tried.
- Enter the number of steps in composition space. In the limit where an infinite number of steps are used, exactly the same solution is obtained as without the interpolation scheme. However, excellent results can be obtained with a reasonable discretization. The default is 10000 steps.

Memory to use

This is the fraction of free physical memory to be used by the interpolation scheme.

Select **Megabyte** or **Fraction of free** and then enter a value in the field.

**About the Homogenization Functions**

The geometrical interpretation of the Hashin-Shtrikman bounds are concentric spherical shells of each phase. For the general lower Hashin-Shtrikman bound the outermost shell consists of the phase with the most sluggish kinetics and vice versa for the general upper bound. The geometrical interpretation of the Hashin-Shtrikman bounds suggest further varieties of the bounds, viz. *Hashin-Shtrikman bound with prescribed matrix phase* and *Hashin-Shtrikman bound with majority phase as matrix phase*, where the outermost shell consist of a prescribed phase or the phase with highest local volume fraction, respectively.

The geometrical interpretation of the Wiener bounds are continuous layers of each phase either parallel with (upper bound) or orthogonal to (lower bound) the direction of diffusion.

The labyrinth factor functions (described below) are only available in Console Mode.

The labyrinth factor functions implies that all diffusion takes place in a single continuous matrix phase. The impeding effect on diffusion by phases dispersed in the matrix phase is taken into account by multiplying the flux with either the volume fraction (*Labyrinth factor f*)...
with prescribed matrix phase), or the volume fraction squared (Labyrinth factor $f^{**2}$ with prescribed matrix phase), of the matrix phase.

The varieties with excluded phases (described below) are only available in Console Mode.

The varieties with excluded phases are useful in several respects. First, if a phase is modelled as having zero solubility for a component, the mobility of that component in that phase is undefined, which causes a (non-terminal) error. Setting a phase as excluded causes the mobility of all components in that phase to be set to zero. Second, often there are some major matrix solid solution phases and some minor precipitate phases. If the mobilities in the minor precipitate phases are zero the lower Hashin-Shtrikman bound is useless as it produces a kinetic coefficient of zero. However, using General lower Hashin-Shtrikman bound with excluded phase(s) the excluded phases are not considered when evaluating what phase has the most sluggish kinetics.

**Precipitation Calculator**

The Precipitation Calculator is available with two elements if you do not have the additional Precipitation Module (TC-PRISMA) license. With the add-on module you can use all available elements.

A Precipitation Calculator allows you to set the conditions for, and perform, a precipitation calculation. The Configuration window for a Precipitation Calculator has these tabs where you define the settings:

- **Conditions**: Set the conditions for your calculation that define the Matrix and Precipitate phases. Choose the Calculation Type.
- **Options**: Modify Numerical Parameters that determine how the conditions are calculated. The Growth rate model can be set to Simplified or Advanced mode.

Example
Precipitation Calculator Settings

The table lists all the settings available from the **Conditions** and **Options** tabs.

![Precipitation Calculator Interface]

You can edit the defaults for some of these settings by going to **Tools → Options → Graphical Mode → Precipitation**.

<table>
<thead>
<tr>
<th>Name</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Composition unit</td>
<td>Choose from <strong>Mass percent</strong>, <strong>Mole percent</strong>, <strong>Mass fraction</strong> or <strong>Mole fraction</strong>.</td>
</tr>
</tbody>
</table>

**Matrix Phase**

**Phase**: Choose a phase from the list. The list is based on the settings for the System Definer. When setting up your system, choose a matrix phase with kinetic data available in the database.
Name | Details
--- | ---
| Only phases with kinetic data can be selected as the matrix phase. If the list is empty, go to the System Definer to make sure that both thermodynamic and kinetic databases are selected and defined. See "System Definer" in the Thermo-Calc User Guide or search the Online Help.

Click **Show details** to view these additional settings for the Matrix Phase:

- **Molar volume**: Choose the default to take the value from the Database or User-defined to enter another value. Database is available in the list when the molar volume for the phase is defined in the thermodynamic database.
- **Grain radius**: Enter a numerical value and choose a unit from the list. The default is 1.0E-4 m.
- **Grain aspect ratio**: Enter a numerical value. The default is 1.0.
- **Dislocation density**: Enter a numerical value. The default is 5.0E12 m⁻³.
- **Mobility enhancement prefactor**: Enter a numerical value.
- **Mobility enhancement activation energy**: Enter a numerical value.

**Precipitate Phase**

**Phase**: Choose a phase from the list. The list is based on the settings for the System Definer.

The phases available to choose have both thermodynamic and kinetic data. If the list is empty, go to the System Definer to make sure that both types of databases are selected and defined. See "System Definer" in the Thermo-Calc User Guide or search the Online Help.

**Nucleation sites**: Choose one of the following from the list.

- **Bulk, Grain boundaries, Grain edges, Grain corners, or Dislocations**. Click to select the **Calculate from matrix settings** check box if you want to calculate the number density of sites from the matrix grain size or dislocation density.
- For Grain boundaries, Grain edges and Grain corners, enter the **Wetting angle** in addition to the matrix settings.
- To enter a specific value for the number of nucleation sites, deselect the check box.
### Interfacial energy

Choose **Calculated** to use the estimated value and then enter a different **prefactor** value if you want to adjust the estimated value. You can also choose **User defined** to enter a value in J/m².

Click **Show details** to view these additional settings:

- **Molar volume**: Choose the default to take the value from the **Database** or **User-defined** to enter another value. **Database** is available in the list when the molar volume for the phase is defined in the thermodynamic database.
- **Phase boundary mobility**: Enter a numerical value.
- **Phase energy addition**: Enter a numerical value.
- **Approximate driving force**: Select the check box to include this if simulations with several compositions sets of the same phase create problems.

## Calculation Type

<table>
<thead>
<tr>
<th>Calculation Type</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Isothermal</strong></td>
<td>Use an <strong>Isothermal</strong> calculation type to do a precipitation simulation at constant temperature. Enter a <strong>Temperature</strong> and <strong>Simulation time</strong>.</td>
</tr>
<tr>
<td><strong>Non-isothermal</strong></td>
<td>For the <strong>Non-isothermal</strong> calculation type, select a <strong>Temperature unit</strong> and <strong>Time unit</strong> from the lists. Enter a value for the <strong>Simulation time</strong>. Click <strong>Thermal Profile</strong>. Here the <strong>Temperature</strong> and <strong>Time</strong> coordinates of thermal profile points are entered. A minimum of two points is required. You can also click <strong>Import</strong> to add your own thermal profile from an Excel spreadsheet. <strong>EDIT THERMAL PROFILE WINDOW</strong></td>
</tr>
</tbody>
</table>
## TTT diagram

Use a **TTT-diagram** calculation type to do a precipitation simulation of the time-temperature-transformation (TTT).

Enter **Min**, **Max**, and **Step** values for the **Temperature** and choose a **Unit** from the list.

**Max simulation time**: Enter a numerical value and choose a **Unit** from the list.

**Stop criterium**: Choose **Volume fraction of phase** or **% of equilibrium fraction** and then enter a numerical value in the field. For each temperature, the simulation stops when the stop criterium is fulfilled or if the maximum simulation time is reached, whichever happens first.

### Numerical Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max time step fraction</td>
<td>The maximum time step allowed for time integration as fraction of the simulation time. The default is 0.1.</td>
</tr>
<tr>
<td>No. of grid points over one order of magnitude in radius</td>
<td>Default number of grid points for every order of magnitude in size space. The default is 150.0.</td>
</tr>
<tr>
<td>Max no. of grid points over one order of magnitude in radius</td>
<td>The maximum allowed number of grid points in size space. The default is 200.0.</td>
</tr>
<tr>
<td>Name</td>
<td>Details</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Min no. of grid points over one order of magnitude in radius</td>
<td>The minimum allowed number of grid points in size space. The default is 100.0.</td>
</tr>
<tr>
<td>Max relative volume fraction of subcritical particles allowed to dissolve in one time step</td>
<td>The portion of the volume fraction that can be ignored when determining the time step. The default is 0.01.</td>
</tr>
<tr>
<td>Max relative radius change</td>
<td>The maximum value allowed for relative radius change in one time step. The default is 0.01.</td>
</tr>
<tr>
<td>Relative radius change for avoiding class collision</td>
<td>Set a limit on the time step. The default is 0.5.</td>
</tr>
<tr>
<td>Max overall volume change</td>
<td>This defines the maximum absolute (not ratio) change of the volume fraction allowed during one time step. The default is 0.001.</td>
</tr>
<tr>
<td>Max relative change of nucleation rate in logarithmic scale</td>
<td>This parameter ensures accuracy for the evolution of effective nucleation rate. The default is 0.5.</td>
</tr>
<tr>
<td>Max relative change of critical radius</td>
<td>Used to place a constraint on how fast the critical radius can vary, and thus put a limit on time step. The default is 0.1.</td>
</tr>
<tr>
<td>Min radius for a nucleus to be considered as a particle</td>
<td>The cut-off lower limit of precipitate radius. The default is 5.0E-10 m.</td>
</tr>
<tr>
<td>Max time step during heating stages</td>
<td>The upper limit of the time step that has been enforced in the heating stages. The default is 1.0 s.</td>
</tr>
</tbody>
</table>

**Plot Renderer**

The Plot Renderer is where you define the settings and output results in a diagram that displays in the Results window. The available Plot Renderer settings are based on the System Definer and calculator activity node predecessors (e.g. Equilibrium, Scheil, and Property
Model Calculators). Setting availability is also determined by the calculation type. There are also other "Plotting Options" on page 114.

**Plot Renderer for the Add-On Modules**

If you have an add-on Diffusion Module (DICTRA) and/or Precipitation Module (TC-PRISMA), there can be additional functionality available on the Plot Renderer. See "Diffusion Calculator Plot Renderer" on page 108 and "Precipitation Calculator Plot Renderer" on page 111.

**The Configuration Window**

The following is an example of the Configuration window for a Plot Renderer that is the successor to an Equilibrium Calculator.

The options along the top are available for most of the calculation types (e.g. phase diagrams, property diagrams, min/max, uncertainty and so forth). For an Equilibrium Property Grid calculation type and a Property Model Calculator Grid calculation you can also choose a Plot type.
Examples of Calculation Type Differences

- If you choose a Property grid (Equilibrium Calculator) or Grid (Property Model Calculator) type, select a Plot type and whether to Interpolate the data or not.
- For a Property Model Calculator Uncertainty calculation type, you choose an Axis type: Frequency, Histogram or Normal probability.
- For other calculators (e.g. Equilibrium, Binary, and Scheil) there are different axis types available such as Linear, Logarithmic, Logarithmic 10, and Inverse.
- If you are plotting a Property grid (Equilibrium Calculator) or Grid (Property Model Calculator) then the X- and Y-axes always represent the quantities that define the calculation axes, but you need to set a variable for the Z-axis (the axis perpendicular to the plane defined by the X- and Y-axes).
## Plot Toolbar

<table>
<thead>
<tr>
<th>Setting/Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save Diagram</td>
<td>Save the plot diagram.</td>
</tr>
<tr>
<td>Show Triangular</td>
<td>Display the diagram in triangular form, with the X-axis along the base and the Y-axis along the left side. Such a diagram is often useful if you want to plot the fractions of two components in a ternary diagram.</td>
</tr>
<tr>
<td>Show Grid</td>
<td>Overlay a grid on the diagram.</td>
</tr>
<tr>
<td>Switch Axes</td>
<td>Show the plotting X axis variable on the diagram’s Y-axis, and the Y axis variable on the diagram’s X-axis.</td>
</tr>
<tr>
<td>Retain Labels</td>
<td>Toggle the default to keep labels displaying on the plot. By default labels are retained.</td>
</tr>
</tbody>
</table>

## Plot Settings

<table>
<thead>
<tr>
<th>Setting/Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tie lines</td>
<td>Select how many tie lines to be plotted in the diagram. Every $n^{th}$ number of tie line is plotted, where $n$ is the number set here. Consequently, the higher the number, the fewer the number of plotted tie lines in the diagram.</td>
</tr>
<tr>
<td>Setting/Button</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Legend option</td>
<td>Select whether the diagram’s legend displays the Stable phases, the Axis quantity, or choose Off for no legend.</td>
</tr>
<tr>
<td>Legend style</td>
<td>You can select a Legend style for the Stable phases or Axis quantity selected for Legend option. Choose None, All, Constitution description, or Ordering description. Also see &quot;About Legend Styles&quot; on page 117.</td>
</tr>
<tr>
<td>Plot type (property grid or grid)</td>
<td>This menu is available if the Plot Renderer is a successor to either an Equilibrium Calculator that is set up to calculate a Property grid or a Property Model Calculator that is calculating a Grid. On a Heat map diagram, each equilibrium calculation in the grid is represented by a colour-coded pixel, where dark red represents the highest Z-axis variable value and dark blue represents the lowest Z-axis variable value. On a Contour diagram, Z-axis variable values are traced with curves in the same way that height values are traced with curves on a topographical map. The colors used originate from the different data series. From the Interpolate list, choose to interpolate data Never (the default), Once, Twice or 3 times. This means points are put in between calculated points in the grid and interpolated instead of calculated in the calculation engine.</td>
</tr>
<tr>
<td>Interpolate (property grid or grid)</td>
<td>Choose how many points of data to interpolate on a grid or property grid to improve curve smoothness – Never, 20x20, 50x50, or 100x100. Try different settings for your own set of data.</td>
</tr>
</tbody>
</table>
### Setting/Button | Description
---|---
Axis variable | Set the state variable you want plotted along the X-axis and the Y-axis. If the stepping/mapping variables are changed in the Equilibrium Calculator that precedes the Plot Renderer, then the variables to be plotted along the diagram’s X- and Y-axis are automatically updated to the appropriate quantities.
Axis type | Select the type of axis scale: **Linear**, **Logarithmic**, **Logarithmic 10** or **Inverse**.
Limits | Specify the range along the axis to show in the plot. In the fields, enter the minimum and maximum values of the axis variable. You can also determine the **step** size between the tick marks along each axis. Select the **Automatic scaling** check box to allow the program to set the limits.
Contour values and Use custom contour values (Z-axis, contour plots). | The **Use custom contour values** check box is available when **Contour** is selected as the **Plot type**. Select this check box to enter one or a series of numbers in the **Contour values** field. Numbers can be separated by a space, colon (:), semicolon (;) or comma (,).
Add an axis 📊 and Remove this axis 📊 buttons. | Use these buttons to add additional X- and/or Y-axes to a plot or to merge plots (to overlay one plot with another in the same diagram). When merging plots, you define this variable as the Z-axis. See "**Plotting Options** on page 114" for details.

**Diffusion Calculator Plot Renderer**

The following is information about the settings available for a Plot Renderer when it is a successor to a "**Diffusion Calculator** on page 87". Also see "**Plot Renderer** on page 102".

**x-axis Variable**

Select the variable for the x-axis: **Distance** or **Time**.
• For **Distance** also choose a unit (m, μm, or nm) and what region to include. The list contains the regions defined on the Diffusion Calculator or you can choose **All regions**.

• For **Time** choose a unit (Seconds, Minutes, Hours, or Days).

**y-axis Variable**

Select the variable to plot on the y-axis. The available options are based on choices such as whether **Distance** or **Time** is chosen for the x-axis, whether isothermal or non-isothermal is selected, whether there is a homogenization solver, or if there is one or more regions.

**Distance along the x-axis**

If **Distance** is plotted along the x-axis, then by default the **Composition** is plotted along the y-axis.

• From the center list, choose the component to plot, or select **All**.

• From the next list, choose the unit to be **Mass percent**, **Mole percent**, **Mass fraction**, **Mole fraction**, or **u-fraction**.

**Time along the x-axis (one region)**

If **Time** is plotted along the x-axis, then choose the y-axis variable to plot plus the additional settings:

• **Total phase fraction**: **By volume** or **By mass**. Then select a phase from the list.

• **Total fraction of element**: **By mole** or **By mass**. Then select a component from the list.

• **Total fraction of element in phase**: **By mole** or **By mass**. Then select a component and a phase from the lists.

• For a non-isothermal thermal profile **Temperature** is available: **Kelvin**, **Celsius**, or **Farenheit**.

**Distance along the x-axis (Homogenization)**

If **Distance** is plotted along the x-axis and a Homogenization solver is being used, then choose **Composition** or **Phase fraction** to plot on the y-axis. Then select the applicable settings.

• Choose the component to plot, or select **All** and the unit **Mass percent**, **Mole percent**, **Mass fraction**, **Mole fraction**, or **u-fraction**.
• Choose **By mole** or **By mass** then select a component from the list.

**Time along the x-axis (two or more regions)**

If **Time** is plotted along the x-axis, then choose the y-axis variable to plot plus the additional settings:

• **Total phase fraction**: **By volume** or **By mass**. Then select a phase from the list.
• **Total fraction of element**: **By mole** or **By mass**. Then select a component from the list.
• **Total fraction of element in phase**: **By mole** or **By mass**. Then select a component and a phase from the lists.
• **Composition at interface**: **Mass percent**, **Mole percent**, **Mass fraction**, **Mole fraction**. Then choose a **Region** and whether it is **Upper** or **Lower** and a component.
• **Position of interface**: Choose a unit (m, μm, or nm) and the interface.
• **Velocity of interface**: Choose a unit (m, μm, or nm) and the interface.
• **Width of region**: Choose a unit (m, μm, or nm) and the interface.
• For a **Non-isothermal** profile, **Temperature** is available. Choose a unit **Kelvin**, **Celsius** or **Fahrenheit**.

**Axis Type**

Select the type of axis scale: **Linear**, **Logarithmic**, **Logarithmic 10** or **Inverse**.

**Limits**

Specify the range along the axis to show in the plot. In the fields, enter the minimum and maximum values of the axis variable. You can also determine the **step** size between the tick marks along each axis.

Select the **Automatic scaling** check box to allow the program to set the limits.

**Time**

When the x-axis variable is **Distance**, choose a **Time** unit (**Seconds**, **Minutes**, **Hours**, or **Days**).

**Add and Remove Axes**

Use the **Add an axis** and **Remove this axis** buttons to add additional X- and/or Y-axes to a plot or to merge plots (to overlay one plot with another in the same diagram).
**Precipitation Calculator Plot Renderer**

The following is information about the settings available for a Plot Renderer when it is a successor to a "Precipitation Calculator" on page 97. Also see "Plot Renderer" in the Thermo-Calc User Guide or search for it in the Online Help.

There are also specific settings related to non-isothermal simulations that are detailed in this topic.

**Plot Settings**

<table>
<thead>
<tr>
<th>Setting/Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Legend option</td>
<td>Select whether the diagram’s legend displays On or Off.</td>
</tr>
</tbody>
</table>

**Axis variable**

Set the state variable you want plotted along the X-axis and the Y-axis.

Select the **Separate multimodal PSD** check box to enter settings for **Points**, **Excess kurtosis**, **Valley depth ratio** and **Minimum peak**.

**Axis type**

Select the type of axis scale: **Linear**, **Logarithmic**, **Logarithmic 10** or **Inverse**.

**Limits**

Specify the range along the axis to show in the plot. In the fields, enter the minimum and maximum values of the axis variable. You can also determine the **step** size between the tick marks along each axis.

Select the **Automatic scaling** check box to allow the program to set the limits.

**Unit (Time X Axis)**

Choose a **Unit** : **Seconds**, **Hours**, or **Days**.

**Add an axis and Remove this axis buttons.**

Use these buttons to add additional X- and/or Y-axes to a plot or to merge plots (to overlay one plot with another in the same diagram). When merging plots, you define this variable as the Z-axis.

**Non-Isothermal Simulations**

When doing non-isothermal simulations it is common that particles grow in different generations. This results in multi-modal size distributions. To correctly estimate the
properties of these different generations of particles you need to separate the peaks of multi-modal distributions.

When the **Separate multimodal PSD** check box is selected on a Plot Renderer activity for the Precipitation Calculator, the size distribution is evaluated at the given time steps and checked for multi-modal peaks. These are separated and used to calculate the specified property.

It can be applied on the following plot properties:

- Mean radius
- Size distribution
- Number density
- Volume fraction

**Points**

This field is available when **Mean radius**, **Number density** or **Volume fraction** is selected as the **Axis variable**. Since the evaluation of multi-modality at each time step is costly, you can specify how many evaluation **Points** to use. The points are geometrically distributed over the time scale where nucleated particles are found. The default is 40 points.

**Time**

This field is available when **Size distribution** is selected as the **Axis variable**. Enter one or a series of numbers in the field, separated by a space, colon (:), semicolon (;) or comma (,).

**Example**

For example, if you enter **100.0, 1000.0 and 1.0E7** in the field:
When you click **Perform** the three times are plotted:

**Excess Kurtosis**

The **Excess kurtosis** number specifies the sensitivity when the program evaluates whether a curve is bimodal or not. The evaluation process calculates the excess kurtosis of the given size distribution and compares it with the input value. If the value is lower than the given value, the distribution is split. The excess kurtosis is a statistical measure that measures how **peaked** and how **heavy tail** a distribution has. For the definition used see [http://en.wikipedia.org/wiki/Kurtosis](http://en.wikipedia.org/wiki/Kurtosis). The default is 25.0.

**Minimum Separation Limit (Valley Depth Ratio)**

The **Minimum Separation Limit** is a rough method to prevent that noise or wiggles are interpreted as different distributions. If a local minima is encountered above this value the following peak is not interpreted as a new distribution. The valley depth ratio is the ratio of the minimum separation limit to the peak value. The default is 0.01.

**Minimum Peak**

Any separated peak below the entered **Minimum peak** value is removed. The default is 100000.0.
**Plotting Options**

The "Plot Renderer" on page 102 is a dynamic activity node with options such as being able to:

- add more than one Plot Renderer to its predecessor node (i.e. one of the calculator activities),
- add axes to the plots, and
- merge results in one plot.
**Plots can have more than one predecessor**

A Plot Renderer can have several predecessors (if you want to plot several calculations in the same diagram), in which case there are several tabs in the Configuration window, one for each predecessor.

Several Plot Renderer activities (as well as Table Renderer activities) can be shown in the Results window as different tabs. The figure is from Graphical Mode example 4.

Also see "Plotting Several Calculations in One Diagram" on page 123 for details.

Add axes to plots

You can add additional X- and/or Y-axes to a plot to compare two or more variables at the same time as in the figure.

Also see "Adding Axes to a Diagram" on page 124 for details.

*Two variables plotted on the Y-axis.*
**Merge results in one plot**

You can merge (or overlay) calculated results for several variables into one plot. This is similar to adding an axis, but instead of displaying different variables along the X- and/or Y-axes, the same X and Y variables are used to compare the third variable (defined in the Plot Renderer as the Z-axis).

As in the figure (from example 12 in Graphical Mode Examples), the driving force and interfacial energy results are combined into one diagram. The X and Y axis is the same for both (Mass percent Cr/Mass percent Mn).

Also see "**Merging Plots into One Diagram**" on page 126 for details of how to combine diagrams.

*A contour plot showing both the driving force and interfacial energy calculation results comparing Mass percent Cr to Mass percent Mn.*
**About Legend Styles**

There are a variety of legend styles you can use to display detail about the phases.

The same legend styles are available for both Graphical Mode and Console Mode plots. For Console Mode, use the command CHANGE_LEGEND.

In Graphical Mode the label styles are defined when using the "Plot Renderer" on page 102. You can select a **Legend style** for the **Stable phases** or **Axis quantity** selected for **Legend option**.

When there is a legend in the diagram you can append constitution and/or ordering descriptions to the phase name.

If constituent description is included in the legend, then for each equilibria along a line in the diagram, the largest constituent fractions are summed until they are equal or greater than 0.6. This is done separately for each sublattice. If the equilibria along the line gets different sets of constituents these are all appended to the list for that sublattice.

The ordering description is only printed for partitioned phases (phases that have a disordered contribution) that begins with at least two identical sublattices (sublattices where the set of constituents are identical). **DISORD** (disordered) is shown if site fractions are identical between identical constituents on all identical sub lattices (with an error margin) otherwise **ORD** (ordered) is shown in the legend.

If ordering between equilibria in a line are different, then **ORD + DISORD** is shown in the legend.


**Legend Examples**

To show the differences between labels, the following uses the same example file that creates Figure 6 in [TCNi8 database extended information](#) document (found on the Thermo-Calc website).

When **All** is selected for this specific example the label includes the following:

![Legend Example Diagram]

Specifically:

- There are two disordered FCC phases (matrix and carbide), one ordered FCC (gamma prime), plus a phase Ni3TA_D0A (called Delta in Ni-alloys).
- ORDERING shows the different FCC phases.
- CONSTITUTION shows that FCC_L12#1 is NbC, FCC_L12#2 is matrix with Ni and Cr as major constituent, FCC_L12#3 is Ni3Al with Nb addition and Ni3TA_D0A is Nb-rich (eg. Ni3Nb).

**Label Style Choice Examples**

These examples are for each label style choice - None, All, Constitution or Ordering

The instructions are for when you are setting the options using the Plot Renderer. In Console Mode, you choose the options **(ALL, NONE, CONSTITUTION, or ORDERING)** after the command CHANGE_LEGEND.

When **None** is selected the legend includes the standard information about the phases.

![Label Style Choice Example 1]

When you select **All** the Constitution description and the Ordering description (when
there is ordering) are included.

When you select **Constitution description**, this is added to the standard description.

When you select **Ordering description** and when there is ordering, this is added to the standard description.

**Adding and Editing Plot Labels**

To add a label text at a certain point in a plot, right click the point, and select **Add Label**. For phase diagrams, the program suggests a label that you can keep or edit. The suggested label specifies the names of the stable phases at the coordinate where you clicked. For all other plot types, you enter your own text, which can either be Plain text or LaTeX formatted text.
Add Label Window

![Add Label Window Image]

**Label Formatting**

You can enter the label as **Plain text** or in **LaTeX-formatted text**. For **LaTeX-formatted text** enter or edit the text as required. For example, underscores (_) are added before the numbers to make subscripts in the label.

For a list of supported LaTeX commands, see: [http://www2.ph.ed.ac.uk/snuggletex/documentation/math-mode.html](http://www2.ph.ed.ac.uk/snuggletex/documentation/math-mode.html).

- By default when using LaTeX, you are in math mode and Thermo-Calc automatically interprets the entered text as math. The above link uses the dollar sign ($) in all the examples but this is NOT required. For example, if you enter \$E=mc^2\$ this is displayed including the $ instead of the equation.

**Entering a Mixture of Plain Text and Equations**

When you enter text using LaTeX formatted text it displays by default on the plot in italics and treats the text as an equation.

As in the following example, the top label does not display correctly because the label is a mixture of text (Mole-Fraction) and an equation (Al$_2$O$_3$). In the bottom image, when the same information is added as Plain text to the plot it now does not include the subscripts.
To add a mixture of plain text and equation text, you can exit math mode using the string \texttt{\textbackslash textrm} followed by the text to display enclosed in curly brackets. For example \texttt{\textbackslash textrm \{Mole-fraction \}Al\textsubscript{2}O\textsubscript{3}} results in the label as shown:

In this example, you need to add a space at the end of fraction in order to separate the text from the equation part of the label.

When working in Console Mode, you can also use the above windows on the Console Results window to add and edit labels. In addition, you can use the \texttt{ADD\_LABEL\_TEXT} command described in the \textit{Thermo-Calc Console Mode Command Reference}.

**Rotation Angle and Show Anchor**

By default the \texttt{Show anchor} check box is selected, which includes an arrow from the label point to the coordinates.

If you do not want the label oriented horizontally in the Plot Renderer tab, then specify the number of degrees of rotation in the \texttt{Rotation angle} field.

Click \texttt{OK} to add the label to the plot. You can also move a label by clicking and dragging it. The default anchor arrow is added to indicate the point that belongs to the label.

**Moving Labels in a Plot**

Drag and drop labels anywhere on the plot. The anchor arrow points to the point of origin.
Changing the Plot Properties

For global changes to the default settings plots see "Global Settings: Graphical and Console Mode-Plotting" on page 228. The settings are the same but applied to all new plots.

To make local changes to the appearance of a specific plot, in the Results window right-click a plot and select Properties. You can also edit some properties for individual plot lines (the color, the line width and type, and whether data points are included).

In the Results window, hover the mouse over a plot line. When it is over a line that can clicked the crosshair cursor turns into a pointing finger.

To prevent unintended edits, hold down <Ctrl> while moving the cursor around the plot to only display it as a crosshair.

Saving Plots

1. To save a diagram, at the top of the Configuration window click Save Diagram.
Or right-click the diagram in the **Results** window and select **Save As**.

2. In the **Save** window, navigate to where you want to save the plot, enter a **File name**, and choose the **File type** to save it in. Click **Save**.

**Plotting Several Calculations in One Diagram**

You can plot several calculations in the same diagram by adding extra predecessors to the Plot Renderer activity.

For examples where several calculations are plotted in one diagram, see Graphical Mode example tecx5.

To plot several calculations in one diagram, you must have, in addition to the Plot Renderer’s original predecessor, at least one available Plot Renderer predecessor in your project, for example, the additional predecessor can be an Equilibrium Calculator, Binary Calculator, Ternary Calculator, Scheil Calculator or Experimental File Reader.

**How to Plot Several Calculations in One Diagram**

1. In the **Project** window click the **Plot Renderer** node.

2. In the **Configuration** window click **Add Predecessor**. Or right-click the **Plot Renderer** and choose **Add Predecessor**.
3. Select a predecessor. When added, the extra predecessor is linked to the Plot Renderer. On the Plot Renderer’s Configuration window, the predecessors are shown as two tabs:

![Configuration window with two tabs](image)

4. Configure how you want each calculation plotted on the tabs in the **Configuration** window, then click to **Perform** the Plot Renderer activity.

The calculations are plotted in the same diagram in a tab in the **Results** window. If any of the axis variables of the plots differ, then the label and scale of all calculations are shown parallel to each other. The following screen shot shows a diagram in which two calculations with different plotting axes variables have been plotted.

![Diagram with two calculations](image)

**Adding Axes to a Diagram**

You can add additional X- and/or Y-axes to a plot to compare two or more variables at the same time.
1. In the Project window right-click the calculator node (e.g. an Equilibrium Calculator) and add a Plot Renderer node from the Create New Successor menu.

2. Click the Plot Renderer node.

3. In the Configuration window, define the plot. Available settings are based on the calculation type.

4. Click the Add an axis button. A new settings section is added underneath.

5. From the X Axis and/or Y Axis sections define another Axis variable and choose an Axis type.

6. Click Perform to plot both variables on the selected axis, in this example, the Y-axis.
Axis Example

In this example **Amount of phase** and **Volume** are selected as the Y-axis variables and **Temperature** as the X-axis variable.

Plot Example

_**Merging Plots into One Diagram**_

You can merge (or overlay) calculated results for several variables into one diagram. The same X and Y variables are used to compare the third variable (defined in the Plot Renderer as the Z-axis).
You cannot overlay heat map or frequency plots.

The following uses example 12 in Graphical Mode Examples to describe the steps to overlay two plots: the driving force and interfacial energy results are combined into one diagram. The X and Y axis is the same for both (Mass percent Cr/Mass percent Mn).

1. In the Project window right-click the calculator node (e.g. Property Model Calculator) and add a Plot Renderer node from the Create New Successor menu.
2. Click the Plot Renderer node.
3. In the Configuration window, define the plot. Available settings are based on the calculation type.

**Example**

In this example the Property Model Calculator is set to a Grid calculation type.

Choose On for the Legend option and Contour as the Plot type.

4. Click the Add an axis button. A new axes settings section is added underneath.
5. From the Z Axis section choose the Axis variable. In this example, Interfacial energy.
6. Click Perform to plot both on the same diagram.

**Plot Example**

In this case, a contour plot showing both the driving force and interfacial energy calculation
results comparing Mass percent Cr to Mass percent Mn.

![Graphical representation of Mass percent comparison](image)

**Results Window Status Markers**

If you have plotted a diagram and then modify something in the tree that the Plot Renderer is associated with, then a notification—an exclamation mark enclosed in a yellow triangle—is shown in the Plot tab.

Also see "Node Status Markers" on page 44.

**Table Renderer**

A Table Renderer visualizes calculation results in a table. Several Table Renderer activities (as well as Plot Renderer activities) can be shown in the Results window as different tabs.

You can only successfully tabulate the results of a single-equilibrium calculation or a stepping operation. The tabulated data from an equilibrium calculation is different from the tabulated data from a stepping calculation.

Also see "Creating Activities and Successors" on page 31 for a list of possible successors and predecessors for this activity.

**Tabulated Results from an Equilibrium Calculation**

The following tab shows the result of an equilibrium calculation (from example 1 in
Graphical Mode Examples).

<table>
<thead>
<tr>
<th>System</th>
<th>Molar Mass</th>
<th>Molar Mass</th>
<th>Molar Mass</th>
<th>Molar Mass</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>55.64392</td>
<td>100.00000</td>
<td>-42140.55264</td>
<td>24707.16603</td>
</tr>
<tr>
<td>Volume</td>
<td>7.29746E-6</td>
<td>[m³]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fe</td>
<td>0.00537</td>
<td>0.00000</td>
<td>0.00010</td>
<td>-0.22777,77189</td>
</tr>
<tr>
<td>C</td>
<td>0.00040</td>
<td>0.00180</td>
<td>0.21818</td>
<td>-1.2603,35450</td>
</tr>
</tbody>
</table>

Stable Phases

<table>
<thead>
<tr>
<th>BCC_A2#1</th>
<th>BCC_A2#1</th>
<th>BCC_A2#1</th>
<th>BCC_A2#1</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.99009</td>
<td>55.59691</td>
<td>0.99711</td>
<td>Composition and constitution</td>
</tr>
<tr>
<td>Composition</td>
<td>Composition</td>
<td>Composition</td>
<td>Composition</td>
</tr>
<tr>
<td>Fe</td>
<td>0.00928</td>
<td>0.00000</td>
<td>0.00016</td>
</tr>
<tr>
<td>C</td>
<td>0.00072</td>
<td>0.00000</td>
<td>0.00016</td>
</tr>
<tr>
<td>Constitution</td>
<td>Constitution</td>
<td>Constitution</td>
<td>Constitution</td>
</tr>
<tr>
<td>Fe</td>
<td>1.00000</td>
<td>0.00000</td>
<td>0.00000</td>
</tr>
<tr>
<td>C</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.00000</td>
</tr>
</tbody>
</table>

For each stable phase listed, from the Composition and constitution menu you can select the information to view. In this example, the maximum amount of information is shown and includes details about both composition and constitution for BCC_A2#1.

The default for the Phase description detail can be changed globally. From the main menu select Tools → Options and click the Activities tab. Then click Tabulation.

Setting Background Colours

To change the background colours of the table, in the Results window right-click a Table Renderer tab, and select Properties. Modify as required.
The defaults for these settings can be changed globally. From the main menu select **Tools → Options** and click the **Activities** tab. Then click **Tabulation**.

**Tabulated Results from a Stepping Operation**

The **Table Render 1** tab in the example shows the results of a stepping calculation (from example 2 in **Graphical Mode Examples**).

![Table Render 1](image)

**Configuration Window Settings**

You can edit the defaults for some of these settings by going to **Tools → Options → Graphical Mode → Tabulation**. Also see "**Global Settings: Tabulation (Table Renderer)**" on page 227.

**Defining the Table Columns**

In the **Configuration** window for the Table Renderer 1 node, set the level of detail for the Columns.

**Setting Number Format and Number of Decimal Digits**

The table results can be presented in ordinary decimal number format or with normalized scientific notion. The **Number format** defaults to **Auto** to use the most appropriate format based on the tabulated data. Or choose **Scientific** or **Decimal** to increase or decrease the number of **Decimal digits** used in the table. The default is 5 digits.
The defaults for these settings can be changed globally. From the main menu select **Tools → Options** and click the **Activities** tab. Then click **Tabulation**.

### Saving Tabulated Data

To save all the data in a table as a plain text file, in the **Configuration** window click **Save table** or in the **Results** window right-click in the table and select **Save As**.

To copy the data from a single cell of a table to the clipboard, right-click the cell and select **Copy**. To copy the whole table to the clipboard, select **Copy all**.

The data saved is what is shown in the **Table Renderer** tab. If data is calculated but not displayed it is not saved.

### Experimental File Reader

The Experimental File Reader activity can only be created from the top My Project node. This activity allows you to read an experimental data file (*.EXP). This type of file has information specifying a plotted diagram, written in the DATAPLOT graphical language.

Also see "[Creating Activities and Successors](#) on page 31" and the DATPLOT User Guide included with this documentation set.

### How to Plot an Experimental Data File

1. Right-click **My Project** and from the **Create New Activity** submenu choose **Experimental File Reader**.
2. In the **Configuration** window in the **EXP file** field, enter the name of the EXP-file to plot.
3. Click **Create New Successor** and select **Plot Renderer**. Or right-click the **Experimental File Reader** node and from the **Create New Successor** submenu choose **Plot Renderer**.
4. In the **Configuration** window click **Perform** or right-click the **Plot Renderer** node and select **Perform**.

### Binary Calculator

A Binary Calculator can be used for some calculations involving two components. You can think of this activity as a combination of a System Definer and an Equilibrium Calculator, but designed to simplify setting up and performing calculations on binary systems.
The Binary Calculator relies on some specifications that are not supported by all databases. You need a specially designed database for the Binary Calculator such as the TCBIN database.

For an example of how a Binary Calculator can be used in a project, see example 3 in Graphical Mode Examples.

Configuration Window

The following shows the Configuration window of a Binary Calculator activity.

![Configuration Window](image)

Configuration Settings

The table lists the available settings to configure before performing the calculation.

Also see "Creating Activities and Successors" on page 31 for a list of possible successors and predecessors for this activity.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select database</td>
<td>Select a database that contains specifications dedicated to the Binary Calculator.</td>
</tr>
</tbody>
</table>
### Setting | Description
--- | ---
Elements (periodic table) | In the periodic table, select the two elements that make up the components of the system.
Phases and Phase Constitution | This tab is the same as for a "System Definer" on page 57. See Phases and Phase Constitution for an example.
Data Sources | This tab is the same as for a "System Definer" on page 57. See Data Sources for an example.
Description | This tab is the same as for a "System Definer" on page 57. See Description for an example.

### Calculation Type

| Calculation Type | Description |
--- | ---
Phase diagram | Select to perform a mapping calculation. Click Calculate Phase Diagram to plot the results.
Gibbs energy curves | Select the Temperature and click Calculate Gibbs Energy Curves to calculate at a constant temperature over the whole composition range.
Activity curves | Select the Temperature and click Calculate Activity Curves to calculate at a constant temperature over the whole composition range.
Phase fractions | Select the Mole fraction and click Calculate Phase Fractions to calculate as a function of temperature at a constant composition.

### Ternary Calculator

A Ternary Calculator is used for some calculations involving three components. You can think of this activity as a combination of a System Definer and an Equilibrium Calculator, but designed to simplify setting up and performing calculations on ternary systems.

For an example of how a Ternary Calculator is used in a project, see example 4 in Graphical Mode Examples.
Also see "Creating Activities and Successors" on page 31 for a list of possible successors and predecessors for this activity.

Configuration Window

The following shows the Configuration window of a Ternary Calculator activity:

![Configuration Window](image)

Configuration Settings

The table lists the available settings that must be configured before performing the calculation.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select database</td>
<td>Select a database that contains specifications dedicated to the Ternary Calculator.</td>
</tr>
<tr>
<td>Elements (periodic table)</td>
<td>In the periodic table, select the three elements that make up the components of the system.</td>
</tr>
</tbody>
</table>
### Setting

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phases and Phase Constitution</td>
<td>This tab is the same as for a &quot;System Definer&quot; on page 57. See Phases and Phase Constitution for an example.</td>
</tr>
<tr>
<td>Data Sources</td>
<td>This tab is the same as for a &quot;System Definer&quot; on page 57. See Data Sources for an example.</td>
</tr>
<tr>
<td>Description</td>
<td>This tab is the same as for a &quot;System Definer&quot; on page 57. See Description for an example.</td>
</tr>
</tbody>
</table>

#### Calculation Types

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Isothermal section</td>
<td>Select the Temperature at which the ternary system is calculated for the whole composition range.</td>
</tr>
<tr>
<td>Monovariant lines</td>
<td>The variation of the liquid compositions with temperature is calculated.</td>
</tr>
<tr>
<td>Liquidus projection</td>
<td>Select the Temperature range (Min and Max) and an Interval. The projection liquid surface and the monovariant lines are calculated over the given temperature range.</td>
</tr>
</tbody>
</table>

### Scheil Calculator

The Scheil Calculator activity is used to perform simulations of Scheil (Scheil-Gulliver) solidification processes. By default, a Scheil calculation results in an estimation of the solidification range of an alloy. The calculation is based on the assumption that the liquid phase is homogeneous at all times and that the diffusivity is zero in the solid. However, it is possible to disregard the latter assumption for selected components.

By default, a Plot Renderer successor has the default plot axes Mole fraction of solid (X-axis) and Temperature Celsius (Y-axis). When these default axes are used in the Plot Renderer, the results of normal equilibria calculations are automatically plotted in the same diagram as the Scheil calculations.

See example 8 in Graphical Mode Examples.
Configuration Window

The main Configuration window of a Scheil Calculator activity is shown below and listed in the table. These settings must be configured before performing the calculation.

[Image of the Configuration window]

Configuration Settings

You can edit the defaults for some of these settings by going to Tools → Options → Graphical Mode → Scheil. Also see "Global Settings: Scheil (Scheil Calculator)" on page 227.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start temperature</td>
<td>Enter a Start temperature that is higher than the liquidus temperature of the alloy, in other words, the temperature at which the alloy is completely melted.</td>
</tr>
<tr>
<td>Temperature step</td>
<td>Enter a Temperature step. Decreasing the temperature step increases the accuracy, but the default value is usually adequate.</td>
</tr>
<tr>
<td>Temperature unit</td>
<td>Select the Temperature unit: Kelvin, Celsius or Fahrenheit.</td>
</tr>
<tr>
<td>Composition unit</td>
<td>Select the Composition unit: Mass percent, Mole percent, Mass fraction or Mole fraction.</td>
</tr>
<tr>
<td>Composition</td>
<td>This is based on what is entered in the &quot;System Definer&quot; on page 57.</td>
</tr>
<tr>
<td>Fast diffuser</td>
<td>Click to select the Fast diffuser check box to allow redistribution of this</td>
</tr>
</tbody>
</table>
component in both the solid and liquid parts of the alloy.

Scheil Calculator Advanced Options and Settings

Additional advanced settings are available as shown below and in the table:

Click **Show advanced options** to open this configuration window:

Scheil Calculator Advanced Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global minimization</td>
<td>By default the <strong>Global minimization</strong> check box is not selected. Click to select it to perform a global minimization test when an equilibrium is reached. This costs more computer time but the calculations are more robust.</td>
</tr>
<tr>
<td>Allow BCC→FCC</td>
<td>By default the <strong>Allow BCC → FCC</strong> check box is not selected. Select the check box to allow transformations in the solidified part of the alloy caused by each of the components specified to be a <em>fast diffuser</em>. It is recommended that you only select this for steels.</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Liquid phase</strong></td>
<td>The default in the list is the <strong>Liquid phase</strong> already defined in the database.</td>
</tr>
<tr>
<td><strong>Terminate on</strong></td>
<td>Enter a value to terminate the calculation on the <strong>Fraction of liquid phase</strong> or at a specific <strong>Temperature</strong>.</td>
</tr>
<tr>
<td><strong>Max. no. of iterations</strong></td>
<td>By default, the program tries 500 iterations before it gives up. As some models give computation times of more than 1 CPU second/iteration, this number is also used to check the CPU time and the calculation stops if 500 CPU seconds/iterations are used.</td>
</tr>
<tr>
<td><strong>Required accuracy</strong></td>
<td>The default is 1.0E-6. This is a relative accuracy, and the program requires that the relative difference in each variable must be lower than this value before it has converged. A larger value normally means fewer iterations but less accurate solutions. The value should be at least one order of magnitude larger than the machine precision.</td>
</tr>
<tr>
<td><strong>Smallest fraction</strong></td>
<td>The default is 1.0E-12. This is the value assigned to constituents that are unstable. It is normally only in the gas phase you can find such low fractions. The default value for the smallest site-fractions is 1E-12 for all phases except for IDEAL phase with one sublattice site (such as the GAS mixture phase in many databases) for which the default value is always as 1E-30.</td>
</tr>
<tr>
<td><strong>Approximate driving force for metastable phases</strong></td>
<td>In Console Mode, the default of 1E-30 is true unless you are using the command SET_NUMERICAL_LIMITS to reset an even-lower value (e.g. 1E-45, that is naturally enforced to all the phases in the system).</td>
</tr>
<tr>
<td></td>
<td>The check box is selected by default, which means the metastable phases are included in all iterations. However, these may not have reached their most favourable composition and thus their driving forces may be only approximate. If it is important that these driving forces are correct, click to clear the check box to force the calculation to converge for the metastable phases.</td>
</tr>
</tbody>
</table>
Also see "Creating Activities and Successors" on page 31 for a list of possible successors and predecessors for this activity and "Scheil Simulations" on page 176 in the Console Mode section.
The Console Mode Interface

The following is an introduction to the Console Mode’s user interface and the command line prompt.

Also see "The Graphical Mode Interface" on page 27 for information about that mode.

In this section:

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Console Mode Layout</td>
<td>142</td>
</tr>
<tr>
<td>Console Window</td>
<td>143</td>
</tr>
<tr>
<td>Editing the Default Console Directory</td>
<td>144</td>
</tr>
<tr>
<td>Console Mode Results Window</td>
<td>146</td>
</tr>
<tr>
<td>Event Log Window</td>
<td>146</td>
</tr>
<tr>
<td>Console Mode Workflow</td>
<td>147</td>
</tr>
<tr>
<td>Typical POLY Module Workflow</td>
<td>147</td>
</tr>
<tr>
<td>Performing Calculations in Console Mode</td>
<td>148</td>
</tr>
<tr>
<td>Using the Command Line Prompt</td>
<td>149</td>
</tr>
<tr>
<td>Moving Between Modules and Submodules</td>
<td>149</td>
</tr>
<tr>
<td>Entering Command Names or Abbreviations</td>
<td>150</td>
</tr>
<tr>
<td>Specifying Parameters</td>
<td>151</td>
</tr>
<tr>
<td>Wild Card Characters</td>
<td>152</td>
</tr>
<tr>
<td>Controlling Console Output</td>
<td>153</td>
</tr>
<tr>
<td>Command History</td>
<td>154</td>
</tr>
<tr>
<td>Log, Macro and Workspace Files</td>
<td>154</td>
</tr>
<tr>
<td>Log Files</td>
<td>154</td>
</tr>
<tr>
<td>Macro Files</td>
<td>155</td>
</tr>
<tr>
<td>Workspace Files</td>
<td>158</td>
</tr>
<tr>
<td>Main Menu Commands</td>
<td>159</td>
</tr>
</tbody>
</table>
Increasing the Buffer Size ................................................................. 160
Defining a System in Console Mode .................................................... 160
How to Define a System in Console Mode ............................................. 161
The Console Mode Layout

By default the first time you launch Thermo-Calc it opens in Graphical Mode. After this, the mode defaults to the most recent one. You can switch back and forth between modes. To open the Console Mode interface, click **Switch to Console Mode** on the toolbar.

The Console Mode User Interface

![Console Mode Interface Screenshot]

The currently selected window is called the *active* window. This has a darker title bar than the other windows. The windows are:

1. **Console**, with a **Console 1** tab.
2. **Console Results**, with a **Results Console 1** tab as well as a sub-tab (**Plot 1**), which is what is displayed in the window in the figure.
3. **Event Log**, which is the active window in this example.

**Console Tabs**

By default, the tabs are side-by-side:
You can toggle to view the tabs top-to-bottom/stacked (click the button) and back to side-by-side (click the button) or the button.

**Open Console Windows**

Open a specific window from the **Window** main menu, or select **Reset Windows** to return to the default window layout.

**Console Window**

By default the Console window is on the left-hand side of the console. This is where you enter commands. The window can have several Console tabs.

To open and close Console tabs:

- To open (or add), click the button, press <Ctrl+T> when the Console window is active, or right-click a tab header and select **New Console**.
- To close, click the button, press <Ctrl+W> or <Ctrl+F4>, or right-click the tab header and select **Close**.
- To close all tabs except one, right-click the header of the tab you want to keep and select **Close Other**.
- To close all tabs and open a new one, right-click the header of any tab and select **Close All**.

You can change the tab name, font and colours for an individual Console tab by right-clicking its header and selecting **Properties**.

**EXAMPLE**
Editing the Default Console Directory

You can add a startup parameter to a shortcut when launching Thermo-Calc on any of the platforms. When you launch the revised shortcut, the file path is set to a user-defined default directory. An example of why you might want to have a custom directory path is if you use batch projects or if you have macro files for batch jobs. The custom directory file path can also be viewed from within Console Mode.

ℹ️ The shortcut is only valid throughout the existing session; it is not saved as a default. Each time you want to use this file path you must launch Thermo-Calc from the customized shortcut.

The following uses Windows for the example.

**Setting up the Default Console Directory**

1. Right-click a shortcut to Thermo-Calc and click **Properties**.
2. In the **Thermo-Calc 2017a Properties** dialog, **Target** field, add the following to the end of the string: –r plus the “*path to the default directory*”. Include a space between the –r and path, and use quotation marks around the full file path. A simple example:

   ```
   -r “C:\Thermo-Calc_Macro_Files”
   ```

3. Click **Apply** and **OK**.

4. Launch Thermo-Calc from the shortcut where you added the parameter. You can confirm that it is set correctly from within Thermo-Calc.

**Viewing the File Path in Thermo-Calc**

1. Launch Thermo-Calc from the short cut where you added the parameter.

2. In Console Mode, right click the **Console** window and choose **Properties**.
3. In the **Console Properties** window the **Default directory** section displays the custom file path.

---

**Console Mode Results Window**

By default, the Console Results window is on the right-hand side of the screen. This is where plotted diagrams display. Each Console has its own Results tab in the Results window. All the plots and tables generated are presented in the Results tab.

- To open new **Plot** tabs press `<Ctrl>+<Shift>+T>` or click the add button.
- To open a new Plot tab for the currently active Console tab, press `<Ctrl>+<Shift>+T>`. To close the Plot tab, press `<Ctrl>+<Shift>+W>` or `<Ctrl>+<Shift>+F4>`.

**Event Log Window**

By default the Event Log window is collapsed (closed). It includes important information about the commands that run and are completed, including error messages. Click once to toggle it open and closed.
Console Mode Workflow

Working with Thermo-Calc involves moving between different modules. The workflow differs depending on the type of calculation:

- If you want to perform a calculation using the POLY module, you typically first retrieve thermodynamic data in the DATA module, perform the calculation in POLY, and visualize the results in the POST module. It is possible to define a system directly in POLY using "DEFINE_MATERIAL" on page 200 and "DEFINE_DIAGRAM" on page 196.

- If you want to calculate and plot a diagram using a response-driven module, such as POTENTIAL or SCHEIL, then you can go directly to that module. Response-driven modules prompt you to go through the steps to do the calculation and the required post-processing. These modules include BIN, TERN, POTENTIAL, POURBAIX, and SCHEIL. You typically end up in the POST module after having used a response-driven module. In the POST module you can modify the plots and save the diagram.

- If you want to tabulate a chemical substance, phase, or reaction, go directly to the TAB module.

Typical POLY Module Workflow

The following represents the typical workflow when you perform calculations in the POLY module. The solid arrows represent your typical movements between the modules. The dashed arrows represent the movement of data within Thermo-Calc.

The basic workflow is:
1. You are in the **SYS** module when you start Thermo-Calc in Console Mode.

2. In the **DATA** module define the system. Before performing a calculation, you must define the system and retrieve thermodynamic data. The data is retrieved from a database file (*.TDB or *.TDC).

3. The data needed to describe a system is then sent to the **GIBBS** module. This data is accessed by the **POLY** module when you instruct it to perform calculations.

4. In the **POLY** module, perform the calculations.
   - In POLY, the conditions are set for an equilibrium calculation (temperature, pressure, system composition, etc.), then an equilibrium calculation is done.
   - If you want to make a property or phase diagram, you set the conditions for a stepping or mapping operation and perform that operation.
   - This generates data that can be used to plot a property diagram (if a stepping operation is performed) or a phase diagram (if a mapping operation is performed).

5. In the **POST** module plot and visualize your data.
   - If a stepping or mapping operation is performed, then you can go to the POST module and plot a property or phase diagram.
   - The diagram can be plotted quickly using default settings, but you can also modify which variables to plot of the diagram axes and change the appearance of the diagram.
   - You can save the diagram either as a plain text file with data about all the coordinates or as an image file.

### Performing Calculations in Console Mode

Calculations can be performed either in the **POLY** module, or using some of the response-driven modules designed to perform specific types of calculations.

"About Equilibrium Calculations on page 164" describes generally how to calculate and plot Property Diagrams and Phase Diagrams. To calculate and plot a property diagram or a phase diagram, you must first calculate an equilibrium.

Additional sections of use include "About Scheil Simulations on page 177", "T0 Temperature Simulations on page 183", "About Paraequilibrium on page 186", "About Potential Diagrams on page 190", and "About Aqueous Solutions on page 194". Also search the online help or see "TABULATION_reaction Commands on page 306" and "Equilibrium Calculations with the POLY_3 Module on page 163" in the Thermo-Calc Console Mode Command Reference.
Using the Command Line Prompt

The command line prompt in the Console window tells you which module you are currently in. When Thermo-Calc is first opened in Console Mode, you are in the SYS module, which is indicated with the command line prompt SYS.

To use Console Mode, you type in commands at the command line prompt. The available commands depend on which module you are in. You can list the commands by typing ? at the prompt and then press <Enter>.

- "Moving Between Modules and Submodules" below
- "Entering Command Names or Abbreviations" on the next page
- "Specifying Parameters" on page 151
- "Wild Card Characters" on page 152
- "Controlling Console Output" on page 153
- "Command History" on page 154

Available SYS Module Commands

Alchemy

Moving Between Modules and Submodules

To go to a specific module, you typically use GOTO_MODULE (or just GOTO) followed by the name of the module. For example, to go to the DATA module, type GOTO DATA.

The exceptions are the submodules POST and ED-EXP:

- To go to the POST module, you must enter the POST command from within the POLY module or DICTRA module (if you have the add-on license).
• To go to "Experimental Data Files" on page 72, you must enter the ED-EXP command from within the PARROT module.

To go back to the previous module type Back. For example, if you are in the DATA module and entered it from the SYS module, when you type Back, you return to the SYS prompt. This command is also available to exit from the submodules POST and ED-EXP.

Without a valid Thermo-Calc license, you cannot leave the SYS module. To enter the DICTRA and DIC_PARROT modules, you also need a valid Diffusion Module (DICTRA) license key.

**Entering Command Names or Abbreviations**

The name of a command typically consists of terms linked with underscores, for example, "LIST_EQUILIBRIUM" on page 209. Note the following:

- UPPER or lower case letters are OK.
- Hyphens (-) instead of underscores (_) are OK, e.g. LIST-EQUILIBRIUM.
- You can abbreviate commands as long as it is unambiguous, e.g. when more than one command begins with LIST_, you need to type the next letter or word to distinguish between the commands.
- Each word can be abbreviated e.g., L_E for LIST_EQUILIBRIUM.

**Command Names and Abbreviations Examples**

These are examples of how you can abbreviate commands at the command line prompt.

<table>
<thead>
<tr>
<th>Command name</th>
<th>Abbreviation</th>
</tr>
</thead>
<tbody>
<tr>
<td>CALCULATE_EQUILIBRIUM</td>
<td>C-E</td>
</tr>
<tr>
<td>CALCULATE_ALL_EQUILIBRIA</td>
<td>C-A</td>
</tr>
<tr>
<td>LIST_EQUILIBRIUM</td>
<td>L-E</td>
</tr>
<tr>
<td>LIST_INITIAL_EQUILIBRIUM</td>
<td>LI-I-E</td>
</tr>
<tr>
<td>LOAD_INITIAL_EQUILIBRIUM</td>
<td>LO-I-E</td>
</tr>
<tr>
<td>LIST_PHASE_DATA CBCC</td>
<td>L-P-D CBC</td>
</tr>
<tr>
<td>LIST_PHASE_DATA CEMENTITE</td>
<td>L-P-D CEM</td>
</tr>
<tr>
<td>SET_ALL_START_VALUES</td>
<td>S-A-SS-AL</td>
</tr>
</tbody>
</table>
**Specifying Parameters**

Running a command typically requires that several parameter values are specified, which can be done directly in the command line after the command name. For example, to set an axis variable for a stepping or mapping operation, enter:

```
SET_AXIS_VARIABLE 1 X(FCC,FE) 0 0.89 0.025
```

You can also use `SET_AXIS_VARIABLE` and press <Enter>. At the command line prompt, you then specify the parameters one at a time.

On all command lines, you can enter a question mark (?) for help. For some parameters, enter two question marks (??) for more detailed information.

**Default Parameters Values**

When you are requested to specify a parameter, Thermo-Calc usually suggests an appropriate default value, which is displayed at the prompt between two slash signs (/). For example, this prompt means the default answer is **TERMINAL:**

```
OUTPUT FILE /TERMINAL/:
```

Press <Enter> to accept the default.

If you specify some parameters directly after the command name, then you can still choose to accept default values for some parameters.

To accept the default value for a parameter, type a comma (,) instead of a value for that parameter.
parameter. For the comma to be interpreted correctly, type a blank space on each side of the comma. However, if you accept the default values for several parameters that follow each other, then the commas can be typed in without blank spaces separating them: (, ,,) is interpreted in the same way as (, ,).

For some commands and parameters, Thermo-Calc treats the values previously assigned as default values if the command is used again. For example, if the first stepping or mapping axis variable is specified as:

```
SET_AXIS_VARIABLE 1 X(FCC,FE) 0 0.89 0.025
```

Then if you want to change a parameter value for this axis variable, type:

```
SET_AXIS_VARIABLE 1 , 0.1 ,,,
```

This changes the minimum value from 0 to 0.1 at which a stepping or mapping operation halts. The other parameter values remain the same. Consequently, what is typed is equivalent to:

```
SET_AXIS_VARIABLE 1 X(FCC,FE) 0.1 0.89 0.025
```

**Wild Card Characters**

You can sometimes use the asterisk (*) as a wild card character to, for example, refer to all components, phases, or species, when showing calculated properties in the POLY module, or when you set axis variables for plotting diagrams in the POST module.

When showing calculated properties in the POLY module, you can also use the dollar sign ($) to refer to all stable phases.

⚠️ For activity and/or chemical potential properties, the * and $ normally do not work properly as wild card characters.

**Wild Card Character Examples**

These are examples of the wild card characters you can use to search commands at the command line prompt.
### Command Table

<table>
<thead>
<tr>
<th>Command</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>SHOW_VALUE B(*)</td>
<td>Lists mass (gram) of all components in the system.</td>
</tr>
<tr>
<td>SET_AXIS_VAR Y B(*) *</td>
<td>Sets mass (gram) of all components in the system as Y-axis variable.</td>
</tr>
<tr>
<td>SHOW_VALUE MUR(*)</td>
<td>Lists chemical potentials of all components in the system.</td>
</tr>
<tr>
<td>SET_AXIS_VAR Y ACR(*) *</td>
<td>Sets activities of all components in the system as Y-axis variable.</td>
</tr>
<tr>
<td>SHOW_VALUE HM(*).T</td>
<td>Lists heat capacities of all phases.</td>
</tr>
<tr>
<td>SET_AXIS_VAR Y GM(*) *</td>
<td>Sets molar Gibbs free energies of all phases as Y-axis variable.</td>
</tr>
<tr>
<td>SHOW_VALUE TC($)</td>
<td>Lists curie temperature of all stable phases.</td>
</tr>
<tr>
<td>SHOW_VALUE W(<em>,</em>)</td>
<td>Lists mass fractions of all components in all phases.</td>
</tr>
<tr>
<td>SHOW_VALUE W($,*</td>
<td>Lists mass fractions of all components in all stable phases.</td>
</tr>
<tr>
<td>SHOW_VALUE W(FCC,*)</td>
<td>Lists mass fractions of all components in the FCC phase.</td>
</tr>
<tr>
<td>SHOW_VALUE W(*,FE)</td>
<td>Lists mass fractions of the Fe component in all phases.</td>
</tr>
<tr>
<td>SHOW_VALUE W($,FE)</td>
<td>Lists mass fractions of the Fe component in all stable phases.</td>
</tr>
<tr>
<td>SHOW_VALUE Y(<em>,</em>)</td>
<td>Lists site fractions of all species in all sublattices of all phases.</td>
</tr>
<tr>
<td>SHOW_VALUE Y($,*</td>
<td>Lists site fractions of all species in all sublattices of all stable phases.</td>
</tr>
<tr>
<td>SHOW_VALUE Y(<em>,</em></td>
<td>Lists site fractions of all species in all sublattices of all phases.</td>
</tr>
</tbody>
</table>

### Controlling Console Output

In response to a command Thermo-Calc may display a lot of text in the Console window.

- To pause the text on printing press <Ctrl+S>.
- To resume the printing on screen, press <Ctrl+Q>.
- When Thermo-Calc is performing a mapping operation, the results are continuously printed in the Console window. To terminate the calculation of the current region of the mapping and stop the output, press <Ctrl+C>.
Command History

- To scroll through the last twenty commands used, type two exclamation marks (!!) and press <Enter>.
- To repeat the last n commands, type ! followed by the number of previous commands to be executed again.
- To scroll through previous performed commands, use the Up (↑) or Down arrow (↓) keys.
- To read more information about the command history functionality in Thermo-Cal, type !? at the command line prompt.

Log, Macro and Workspace Files

For DICTRA Console Mode see File Formats in the Diffusion Module (DICTRA) User Guide

In Console Mode, Thermo-Cal uses different kinds of files, including:

- "Log Files" below (*.LOG)
- "Macro Files" on the next page (*.TCM or *.LOG)
- "Workspace Files" on page 158 in POLY (*.POLY3), GIBBS module (*.GES5), and the PARROT module (*.PAR and *.POP).

Log Files

Log files with the file extension *.LOG are plain text files used to save a sequence of commands. Log files can be edited in a text editor.

- To start saving your input into such a file, use SET_LOG_FILE in the SYS module, followed by the name of the file that you want to save your command sequence to.
- If you want to save the output in the log file as well, use SET_ECHO before the SET_LOG_FILE command. Doing this is useful if you want use the log file later as a macro file.

Macro Files

Macro files (with the file extension of either *.TCM or *.LOG) are plain text files used to save a sequence of commands that can be loaded and executed. Macro files can be edited in a text editor. When creating a command sequence, you add comments to the file by starting a line with @@.

Macro files include comments, which you can either run in Thermo-Calc or open and read in a text editor.

⚠️ If you only open and read the macro file in a text editor, you do not see the output that Thermo-Calc gives in response to the commands stored in the macro file. It is recommended you run the macro to view all the details.
Opening a Console Mode Example Macro File

To open an example macro file for Thermo-Calc:

1. Open Thermo-Calc.
2. Confirm you are in Console Mode. If not, click the Switch to Console Mode button.
3. From the main menu, select File → Open Examples or Help → Open Examples. The Console Mode folder opens with the Thermo-Calc examples in separate folders.

For the Diffusion Module (DICTRA) examples (*.DCM macro files), click the Up One Level button and then double click the DICTRA folder.

4. In the folder, double-click the *.TCM file or click Open.
5. Follow the prompts in the Console window i.e. keep pressing <Enter> to run the macro and produce a plot in the Console Results window.

Macro File Commands

Also see Example 12 in .

<table>
<thead>
<tr>
<th>Action</th>
<th>Command</th>
<th>Description and Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>To load a macro file</td>
<td>In the SYS module, &quot;MACRO_FILE_OPEN&quot; on page 5 followed by the name of the macro file.</td>
<td>Thermo-Calc starts the command sequence that the file contains.</td>
</tr>
<tr>
<td>Action</td>
<td>Command</td>
<td>Description and Comments</td>
</tr>
<tr>
<td>----------------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Regain control of the console</td>
<td>&quot;SET_INTERACTIVE&quot; on page 295</td>
<td>End a macro file with this command to have control of the Console returned to you.</td>
</tr>
<tr>
<td>Add comments to a macro file</td>
<td>Start a line with @?, or enclose it between an @ (-line and a @)-line.</td>
<td>When lines are enclosed the software ignores them when running the macro.</td>
</tr>
<tr>
<td>Open a macro file</td>
<td>MACRO_FILE_OPEN</td>
<td>When creating the log file, you can make a macro file load up to five other macro files.</td>
</tr>
<tr>
<td>Nest macro files inside of each other</td>
<td>MACRO_FILE_OPEN SET_INTERACTIVE</td>
<td>If a nested macro file ends with SET_INTERACTIVE, then Thermo-Calc resumes with the higher-level macro file at the command immediately following the MACRO_FILE_OPEN command that loaded and executed macro file that has just been terminated. If a nested macro file doesn’t end with SET_INTERACTIVE (but with an end-of-file character), then the console shuts down and the macro is stopped.</td>
</tr>
</tbody>
</table>

**Macro File Control Characters**

The @? character allows you to make a macro interactive by allowing input. At the @? character, which is placed where a parameter value or argument is normally put, Thermo-Calc prompts to input the value of a parameter or argument. You can enter a string immediately following the @? character. This string is presented to the user when prompted to enter the parameter value or argument. The entered value is used by Thermo-Calc as input to the command in question. For example, you can request the user to specify the temperature range of a stepping calculation by entering the following in a macro file:

```
SET_AXIS_VARIABLE 1 T @?Low-temperature-limit: @?High-temperature-limit:
```

You can also use up to nine variables in your macro file and prompt the user to enter values.
that can be assigned to these variables. Use the @n character when you want to prompt the user to provide a value to the variable, where the n is a digit between 1 and 9. You can then use this value by with the ##n character. For example, you can request the user to provide the first element of a system by entering the following in the macro file:

    ##3First-element?

You can then use this variable with the entering the character ##3 later in the macro file. For example, you can write:

    SET_AXIS_VARIABLE 1 x(#3) 0,1,.

Finally, there is the @6 pause character. Thermo-Calc pauses and waits for input from the user when this pause character is read from a macro file. Inserting pause characters is useful if you want to allow the user to monitor what is happening when Thermo-Calc is running the macro.

**Response-Driven Modules and Macros**

Macro files that are created while you use a *response-driven module* begin with the module-entering command (for example, Goto_Module Scheil) followed by a number of lines with responses to the module’s questions and requests. The file terminates with the commands "POST" on page 214 or "SET_INTERACTIVE" on page 295 (this command gives you back control of the Console). An empty line cannot be edited with any input rather than the default answer (to a specific question). Comment lines, commands to open other macro files, pause characters or input-controlling characters cannot be inserted between these empty lines (otherwise the response-driven module cannot be executed properly).

**Workspace Files**

Workspaces files allow you to save all the data in your current workspace. A workspace contains all the data, specified settings and the result of any calculations performed. The saved data includes original and modified thermodynamic data, the last set of conditions and options, and the results of any simulations. You use the command SAVE_WORKSPACES to create this file type, which is available in the POLY, GIBBS and PARROT modules.

When in Thermo-Calc Console Mode:

- POLY Module workspace files have the file extension *.POLY3.
- GIBBS Module workspace files have the file extension *.GES5.
- PARROT workspace files have two file extensions *.PAR and *.POP.

For DICTRA in Console Mode, the PARROT .POP files have the file extension *.DOP.
The workspace has all the settings specified and the result of any stepping or mapping operations performed after using SAVE_WORKSPACES. Consequently, the command opens a workspace in which all data is saved which is generated after the SAVE_WORKSPACE command is executed. The saved data includes original and modified thermodynamic data, the last set of conditions and options, and calculation results.

To load the data and calculation results of a workspace file, use the READ_WORKSPACES command available in the POLY module. The file can be used for calculation in POLY, visualization in POST, or data manipulation in GIBBS. You are also given the option in the POURBAIX and SCHEIL modules to open a previously saved workspace file. This allows you to make new POURBAIX or SCHEIL calculations on the same chemical system as before but with different temperature, pressure, and composition conditions, or to plot new property diagrams based on the previous calculations.

![For DICTRA Console Mode see File Formats in the Diffusion Module (DICTRA) User Guide](image)

**Main Menu Commands**

The **File** menu and toolbar are reserved for Graphical Mode.

In Console Mode you use commands to access these menu options. The **Tools**, **Window** and **Help** menus are described in "Main Menu and Toolbar" on page 33. If there is an equivalent command, it is listed in the table below.

<table>
<thead>
<tr>
<th>Option</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open files</td>
<td>In Thermo-Calc, drag and drop the file into the Console window.</td>
</tr>
<tr>
<td></td>
<td>In the SYS module: &quot;MACRO_FILE_OPEN&quot; on page 5</td>
</tr>
<tr>
<td></td>
<td>In the SYS module: &quot;OPEN_FILE&quot; on page 301</td>
</tr>
<tr>
<td>Save (workspace)</td>
<td>This command depends on the module you are in. Type ? at the prompt to</td>
</tr>
<tr>
<td></td>
<td>look for a command such as &quot;SAVE_GES_WORKSPACE&quot; on page 128 (GIBBS module)</td>
</tr>
<tr>
<td>Exit</td>
<td>In any module: EXIT</td>
</tr>
<tr>
<td>Close</td>
<td>In the SYS module: &quot;CLOSE_FILE&quot; on page 300</td>
</tr>
<tr>
<td>Display license info</td>
<td>In the SYS module: &quot;DISPLAY_LICENSE_INFO&quot; on page 300</td>
</tr>
</tbody>
</table>
Increasing the Buffer Size

Sometimes the output overflows the window text buffer (see "Controlling Console Output" on page 153). To increase the buffer size in a specific Console tab:

1. Right-click the Console tab header in the Console window (if this is the first Console tab, it is labeled Console 1).

2. Click Properties, and increase the Buffer size in the Console Properties window.

Defining a System in Console Mode

*Defining a system* means to select the chemical components and to retrieve thermodynamic data about those components from an appropriate database in order to do the calculations. You use database(s) with thermodynamic data and then define what system elements as components. Once the system is defined, you retrieve the system’s thermodynamic data from the database(s).

- If you use a *response-driven module* to perform your calculation, such as BIN or POURBAIX, then the module prompts you to select database(s) and define the system.
- When doing calculations in the POLY module, you typically have to manually select databases and define the system in the DATA module. However, it is also possible to define the system directly in POLY using "DEFINE_MATERIAL" on page 200 and "DEFINE_DIAGRAM" on page 196.

Also see "Database Commands" on page 11 in the *Thermo-Calc Console Mode Command Reference*. 
How to Define a System in Console Mode

1. Go to the DATA module. At the SYS prompt, use GOTO_MODULE and enter Data.

2. Change the default database unless you directly specify the name of the database as a parameter to the command. Type SWITCH_DATABASE and follow the prompts.

   The second part of the command prompt indicates the current default database. For example, if the prompt is TDB_TCFE8, then the current database is TCFE8.

3. Use DEFINE_ELEMENTS followed by a list of the elements that you want in your system. (To list the elements that are available in your current database, use LIST_DATABASE and choose Elements). For example, if you want to have Fe and C in your system, type:

   DEFINE_ELEMENTS Fe C

4. Use REJECT and choose Phases if you want to avoid retrieving any phases from the database. (To list the phases that are available in your current database, use LIST_DATABASE and choose Phases. To list the phases that can form in the defined system, use LIST_SYSTEM and choose Constituent.) For example, if you do not want the graphite phase to be retrieved, you type:

   REJECT PHASES GRAPHITE

   If the number of phases to include is much lower than the total number of phases, then it can be convenient to first Reject Phases * and then restore the phases to include using Restore Phases.

5. Use GET_DATA to search the database and send the thermodynamic data about your system to the GIBBS workspace.

   At this point you can proceed to the POLY module (with GOTO_MODULE POLY). However, you may want to add elements, phases and species to the GIBBS workspace from other databases. If so, then proceed to the next step.

6. Use APPEND_DATABASE to select the (additional) database from which you want to retrieve data. This command works exactly in the same way as the SWITCH_DATABASE command, with the exception that it does not reinitialize the DATA module and the GIBBS workspace, but instead appends or replaces the data that has already been retrieved with new data from the additional database.

7. Define your elements and specify whether to reject and restore any phases. Do this in exactly the same way when using the SWITCH_DATABASE command (see steps 2 and 3).
8. Use GET_DATA to search the database and add the thermodynamic data to the data that already exists in the GIBBS workspace.

9. Use APPEND_DATABASE again if you want to add data from yet another database. When you have retrieved all the data you need, you can proceed to the POLY module.
Equilibrium Calculations

In this section:

- About Equilibrium Calculations ................................................................. 164
- Calculating an Equilibrium ........................................................................... 166
- Calculating an Equilibrium with a Fixed Phase ........................................ 167
- Calculating an Equilibrium with Suspended or Dormant Phases .............. 167
About Equilibrium Calculations

An equilibrium describes what the composition of the end state of a system is, given a full specification of state variables such as temperature, pressure, initial composition, system size, etc. An equilibrium calculation is normally done in POLY-3 according to the Global Minimization Technique, which ensures that the most stable minimum under the specified conditions is computed.

For an equilibrium calculation to be performed, the state variables must all be set as conditions for the calculations. Such conditions include, for example, temperature, pressure, and system composition. When you calculate an equilibrium in the POLY module, you have to set these conditions manually.

Setting Conditions

Setting a condition normally involves giving a single state variable a specific value. For example, you can set the temperature to 1273.5 Kelvin (T=1273.5). Alternatively, setting a condition can involve giving a linear expression with more than one state variable a specific value. For example, you can set the mole fraction of the S component to be the same in the liquid and the pyrrohotite phases ($X_{\text{LIQ}, S} - X_{\text{PYRR}, S} = 0$).

The number of state variables that need to set is determined by the Gibbs Phase Rule. Typically, the state variables to give values to are:

- temperature (in K)
- pressure (in Pascal)
- system size in number of moles (in mole) or mass (in grams)
- the fraction of each component (in number of moles or mass)

If you fix the phase of the equilibrium and all but one of the state variables, you can discover the value of the other state variable at equilibrium.

It is possible to specify a set of conditions that does not have any equilibrium and the program detects this by failing to reach equilibrium during the calculation.

State Variables for Setting Conditions

The following table lists some of the available state variables you can use to set conditions:
<table>
<thead>
<tr>
<th>State Variable</th>
<th>SET_CONDITION Parameter</th>
</tr>
</thead>
<tbody>
<tr>
<td>temperature in the system (in K)</td>
<td>T</td>
</tr>
<tr>
<td>pressure in the system (in Pascal)</td>
<td>P</td>
</tr>
<tr>
<td>system size (mole number in moles)</td>
<td>N</td>
</tr>
<tr>
<td>system size (mass in grams)</td>
<td>B</td>
</tr>
<tr>
<td>number of moles of a component in the system</td>
<td>N(&lt;component&gt;)</td>
</tr>
<tr>
<td>mole fraction of a component in the system</td>
<td>X(&lt;component&gt;)</td>
</tr>
<tr>
<td>mass fraction of a component in the system</td>
<td>W(&lt;component&gt;)</td>
</tr>
<tr>
<td>activity of a component in the system</td>
<td>ACR(&lt;component&gt;)</td>
</tr>
<tr>
<td>chemical potential of a component in the system</td>
<td>MUR(&lt;component&gt;)</td>
</tr>
<tr>
<td>mole fraction of a component in a phase</td>
<td>X(&lt;phase&gt;,&lt;component&gt;)</td>
</tr>
<tr>
<td>mass fraction of a component in a phase</td>
<td>W(&lt;phase&gt;,&lt;component&gt;)</td>
</tr>
<tr>
<td>activity of a species referred to a phase at ambient temperature and pressure</td>
<td>ACR(&lt;species&gt;,&lt;phase&gt;)</td>
</tr>
<tr>
<td>chemical potential of a species referred to a phase at ambient temperature and pressure</td>
<td>MUR(&lt;species&gt;,&lt;phase&gt;)</td>
</tr>
<tr>
<td>enthalpy in the system (in J)</td>
<td>H</td>
</tr>
<tr>
<td>enthalpy of a phase (in J/mol)</td>
<td>HM(&lt;phase&gt;)</td>
</tr>
</tbody>
</table>
Equilibrium Information Example

```
POLY_3.m
OUTPUT TO SCREEN OR FILE /SCREEN/;
Options /NAME/;
Output from POLY-3, equilibrium = 1, label A0, database: TCF7

Conditions:
T=1000, P=1E5, X(C)=5%<br/>DEGREES OF FREEDOM = 0

Temperature 1000.00 K (726.85 C), Pressure 1.000000E+05<br/>Number of moles of components 1.000000E+00, Mass in grams 5.36552E+01<br/>Total Gibb energy -4.07971E+04, Enthalpy 2.41176E+04, Volume 7.21740E-06

Component | Moles | W-Fraction | Activity | Potential | Ref.stat<br/>
C | 5.0000E-02 | 1.1193E-02 | 2.1816E-01 | -1.2659E+04 | SEH<br/>Fe | 9.5000E-01 | 9.0881E-01 | 6.1895E-03 | -4.2279E+04 | SEH

BCC_A2 | Status ENTERED | Driving force 0.0000E+00<br/>Moles 9.5065E-01, Mass 5.3065E+01, Volume fraction 9.6917E-01, Mass fractions:<br/>Fe 9.3904E-01 | 1.5551E-04<br/>GRAPHITE | Status ENTERED | Driving force 0.0000E+00<br/>Moles 4.931E-02, Mass 5.9230E+01, Volume fraction 3.6881E-02, Mass fractions:<br/>C 1.0000E+00 | Fe 0.0000E+00
```

Calculating an Equilibrium

This topic explains how to calculate an equilibrium in POLY. To calculate an equilibrium means to calculate the equilibrium composition of your system, given a full specification of conditions that reduce the degrees of freedom of the calculation to zero.

If you are running a network client installation of Thermo-Calc and cannot enter the POLY module, this may be because all the license instances on that the license server makes available have been checked out.

Also see "Equilibrium Calculations with the POLY_3 Module" on page 163 in the Thermo-Calc Console Mode Command Reference.

1. Define your system (see "Defining a System in Console Mode" on page 160).
2. Go to the POLY module. At the SYS prompt, type GOTO_MODULE and enter POLY.
3. Use SET_CONDITION followed by conditions and value assignments to set the conditions of your calculation. For example, to set temperature, pressure, initial composition and system size for a Fe-Cr-C system, you might enter the following:

   ```
   SET_CONDITION T=1200 P=1E5 W(CR)=0.18 W(C)=0.0013 N=1
   ```

   This sets the temperature (T) to 1200 K, the pressure to 1 bar (100,000 Pascal), the mass fraction of Cr to 18 mole percent, the mass fraction of C to 0.13 weight percent, and the total amount of material to 1 mole. The fraction of Fe in the system is calculated from the fractions of Cr and C. You have to set the fraction of all the components in your system except one.
4. Use COMPUTE_EQUILIBRIUM to run the calculation.
5. Use LIST_EQUILIBRIUM to see the results of the calculation.

Calculating an Equilibrium with a Fixed Phase

There are many ways to calculate equilibriums in Thermo-Calc. The following is one example.

You can calculate an equilibrium that has a certain amount of a certain stable phase. Use "CHANGE_STATUS" on page 100 and choose Phase to specify the phase and the amount of that phase (in normalized mole number) that you want to set as fixed. For example, if you want to find out at what temperature a system starts to melt, enter the following:

```
CHANGE_STATUS PHASE LIQUID=FIX 0
```

You must leave the state variable whose equilibrium value you are interested in unspecified. However, if you have already specified that state variable, you can make it unspecified again by using "SET_CONDITION" on page 220 and set that state variable to NONE. For example, if you have given temperature a value, you can type:

```
SET_CONDITION T=NONE
```

The calculated equilibrium includes the value of the unspecified variable at which the equilibrium enters the phase that is fixed.

For an example where an equilibrium is calculated with a fixed phase, see Console Mode example tcex07. Go to "About the Thermo-Calc Console Mode Examples " on page 2 in the Thermo-Calc Console Mode Examples Guide.

Calculating an Equilibrium with Suspended or Dormant Phases

You can calculate an equilibrium under the assumption that one or several phases are SUSPENDED or DORMANT using CHANGE_STATUS and choose Phase. For example, to specify that all phases except one should be suspended, you can first suspend all phases and then enter a single phase in the following way:

```
CHANGE_STATUS PHASE *=SUSPENDED
CHANGE_STATUS PHASE FE_LIQUID=ENTERED
```

For an example where this is done, as well as where the status of phases is set to be dormant, see Console Mode example tcex10. Go to "About the Thermo-Calc Console Mode Examples " on page 2 in the Thermo-Calc Console Mode Examples Guide.
Property Diagrams

In this section:

- About Property Diagrams ................................................................. 169
- Calculating and Plotting a Property Diagram ..................................... 169
- Calculating a Property Diagram One Phase at a Time ........................ 171
- Calculating Several Properties in the Same Diagram ......................... 171
About Property Diagrams

When you calculate and plot a property diagram, there is only one independent state variable. Many different properties can be plotted as a function of this independent variable. For example, if the independent state variable is temperature, then the mole fractions of all phases can be plotted as a function of temperature. Or the composition of a specific phase may be plotted relative to temperature, or the activity of a component in the system as a whole or in a specific phase may be plotted relative to it.

A property diagram is plotted based on a series of equilibria that is computed while the value of one state variable is varied between a minimum and a maximum value. This variable is referred to as the stepping axis variable. In Thermo-Calc, first calculate one initial equilibrium, and then new equilibria are calculated at incremental steps in both directions on the stepping axis from the initial equilibrium. This continues until the stepping operation has covered the length of the axis between a minimum and a maximum value that is specified.

For an example of the calculation of a property diagram, see Console Mode example tcx08. Go to "About the Thermo-Calc Console Mode Examples" on page 2 in the Thermo-Calc Console Mode Examples Guide.

Calculating and Plotting a Property Diagram

This topic explains how to calculate a property diagram in POLY. To calculate a property diagram means to calculate a series of equilibria while the value of the stepping axis variable varies between a minimum and a maximum value. With the exception of the stepping axis variable, all the state variables that you set when you calculate the initial equilibrium retain the values when the new equilibria are calculated.

"Equilibrium Calculations with the POLY_3 Module" on page 163 in the Console Mode Command Reference.

1. Calculate an initial equilibrium in the POLY module (see "Equilibrium Calculations" on page 163).

2. Use SET_AXIS_VARIABLE to set the axis variable, the minimum and the maximum stepping variable values and the step length. The first parameter of SET_AXIS_VARIABLE is the axis number. Since a property diagram only has one axis variable, this is set to 1. For example, if you want to set the axis variable to temperature, and calculate an equilibrium at every 50 K between a minimum temperature of 100 K and a maximum temperature of 2000 K, enter

   SET_AXIS_VARIABLE 1 T 100 2000 50
An axis variable must be a state variable that is set when you calculated the initial equilibrium. For example, if you set the fraction of a component in number of moles, then you cannot set the mass fraction of this component as an axis variable. Also, the minimum stepping variable value must be smaller than, and the maximum value larger than, the value that you set the state variable to when calculating the initial equilibrium.

3. Use `STEP_WITH_OPTIONS` and choose `Normal` to perform the stepping operation.

Thermo-Calc lists the phase regions along the stepping axis, the phases contained in each region, and the number of equilibria calculated in that region. Each region is defined by the phases it contains.

The number of equilibria calculated is not just the number of steps that are performed according to the step length and the minimum and maximum values on the axis variable. This is because Thermo-Calc calculates extra equilibria when a new phase is discovered in order to determine the phase region boundary more precisely.

**EXAMPLE OF STEP WITH OPTIONS**

```
POLY_3:s-a-v 1 T 1000 2000 100
POLY_3:step
Option? /NORMAL/: No initial equilibrium, using default
Step will start from axis value 1000.00
...OK

Phase Region from 1000.00 for:
  BCC_A2
  GRAPHITE
Global check of adding phase at 1.01111E+03
Calculated 4 equilibria

Phase Region from 1011.18 for:
  BCC_A2
  FCC_A1
  GRAPHITE
Calculated 2 equilibria

Phase Region from 1011.18 for:
  FCC_A1
  GRAPHITE
Global test at 1.09000E+03 .... OK
Global check of removing phase at 1.15727E+03
Calculated 17 equilibria
```
4. To plot the diagram, use POST to open the POST module and then use PLOT_DIAGRAM. By default, the X-axis represents the stepping axis variable and Y-axis represents the sum of the mole fractions of all phases (NP(*)).

**Calculating a Property Diagram One Phase at a Time**

There are many ways to calculate property diagrams in Thermo-Calc. One example is where you can calculate a property diagram with a separate stepping operation being performed for each phase at a time in its default most stable composition (the major constitution). This is useful if you want to create a property diagram for a heterogeneous system with both ordered phases and their disordered pairs.

To calculate a property diagram one phase at a time, use "STEP_WITH_OPTIONS" on page 227 and when prompted choose One_phase_at_time to perform the stepping operation.

**Calculating Several Properties in the Same Diagram**

There are many ways to calculate property diagrams in Thermo-Calc. The following is another example. If you perform several stepping calculations after each other, the results of these calculations are all saved in your workspace file. This allows you to the following:

- Calculate (and then plot) missing parts of a specific property inside the first property diagram. These parts are calculated inside the range of the stepping variable with a different control condition.

- Calculate (and then plot) two or more sets of a specific property on the same property diagram for the same system. These can be calculated under different control conditions with stepping operations being performed across the same stepping axis variable range.

- Calculate phase boundary lines and then plot them in a corresponding phase diagram for the same system. This can be especially useful for some defined secondary phase-transitions. For example, if you want to find the phase boundary between BCC_A1 and BCC_B2, or the equal-Gm for two specific phases, or the equal-fraction or equal-activity for two specific phases of a certain species, then this can be useful.

Unless you have opened a new workspace file previously using SAVE_WORKSPACES, the results of the stepping calculations are saved in a RESULT.POLY3 file. To save the results of several stepping calculations in a file different from the workspace file that your results are currently saved to, then use SAVE_WORKSPACES before you perform the first stepping calculation.

SAVE_WORKSPACES overwrites and deletes the results of all previous stepping calculations.
Phase Diagrams

In this section:

- About Phase Diagrams ................................................................. 173
- Calculating and Plotting a Phase Diagram .................................. 173
- Calculating a Quasi-Binary Phase Diagram .................................. 175
- How to Calculate a Quasi-Binary Phase Diagram ....................... 175
- Calculating a Quasi-Ternary Phase Diagram ................................. 175
About Phase Diagrams

Phase diagrams have two or more independent axis variables. Any state variable that has already been set can be used as the mapping variable for a mapping calculation and then as the axis variable for a phase diagram. From a mapping calculation, many types of phase diagrams can be plotted, with one of the mapped variables as one axis variable, and with other mapped variables or any varied property (state or derived variables) or entered symbol (variables, functions or table values) as the other axis variables.

All phase diagrams consist of zero phase fraction lines. There are two distinct types of phase diagrams: those with the tie-lines in the plane of the diagram and those where the tie-lines are not in the plane. The former includes binary phase diagrams and ternary isotherms. The latter includes more general isopleth diagrams with one or more fixed extensive variables (normally, this is a composition). The BIN and TERN modules calculate binary and ternary phase diagrams. The POTENTIAL and POURABIX modules calculate the more general isopleth diagrams and other related diagrams.

The following topics describe how to calculate the types of phase diagrams in the "Equilibrium Calculations with the POLY_3 Module" on page 163 module. In POLY, you can calculate phase diagram for systems with up to 40 components and with thousands of phases. You can combine activity conditions and fixed phase status and fraction conditions in any way. Thermo-Calc can calculate any arbitrary 2D section through composition space.

There is no guarantee that the conditions set will result in a calculation that reaches an equilibrium.

For an example of the calculation and plotting of a phase diagram, see Console Mode example tcex04. Go to "About the Thermo-Calc Console Mode Examples " on page 2 in the Thermo-Calc Console Mode Examples Guide.

Calculating and Plotting a Phase Diagram

This topic describes how to calculate a phase diagram in the POLY module. The commands are described in "Equilibrium Calculations with the POLY_3 Module" on page 163 and "Plotting and Visualization with the POST Module " on page 240.

1. Calculate an initial equilibrium in the POLY module (see "Equilibrium Calculations" on page 163).
2. Use SET_AXIS_VARIABLE to set the first axis variable, its minimum and maximum mapping value and the length of each incremental step on this axis. The first parameter of SET_AXIS_VARIABLE is the axis number and is set to 1. For example, suppose you want the mass fraction of C as your first axis variable. You want it to
vary between 0 and 0.1, with the length of each incremental step being no more than 0.002. You then enter:

```
SET_AXIS_VARIABLE 1 W(C) 0 .1 0.002
```

An axis variable must be a state variable that is set when you calculated the initial equilibrium. For example, if you set the fraction of a component in number of moles, then you cannot set the mass fraction of this component as an axis variable.

3. Use `SET_AXIS_VARIABLE` to set the second axis variable and specify its minimum, maximum, and step length values. The axis number is set to 2. For example, suppose you want temperature as your second axis variable and you want it to vary between 900 K and 1900 K, with an incremental step of 25 K. You then enter:

```
SET_AXIS_VARIABLE 2 T 900 1900 25
```

4. If you want more than two axis variables, then use `SET_AXIS_VARIABLE` until you have set all the axis variables. You can set up to five axis variables. Axis variables 3, 4 and 5 must be set temperature, pressure or to the chemical potentials of components.

You may want to save your workspace with `SAVE_WORKSPACES` before you perform the mapping calculation. This saves the axis variables you have set. However, it overwrites the results of any previous stepping or mapping calculations done.

5. Use `MAP` to perform the mapping calculation. The console lists the phase region boundaries and the phases contained on one side of each boundary.

```
Phase region boundary 30 at:  1.363e+03  2.012e-01
    FCC_A1
    ** GRAPHITE
    Calculated.            3    equilibria
    Terminating at known equilibrium

Phase region boundary 31 at:  1.990e+03  2.526e-01
    LIQUID
    ** GRAPHITE
    Calculated.            13   equilibria
    Terminating at known equilibrium
```

6. To plot the diagram, use `POST` to open the `POST` module and then use `PLOT_DIAGRAM`. By default, the X-axis represents mapping axis variable 1 and the Y-axis represents mapping axis variable 2.
Calculating a Quasi-Binary Phase Diagram

There are many ways to calculate phase diagrams in Thermo-Calc. The following is an example where a quasi-binary phase diagram is used for calculations on a ternary system in which one component has an activity or chemical potential that is fixed (although if you have fixed a phase and the phase composition varies, then the activity or chemical potential may also vary). The tie-lines in a quasi-binary diagram are in the diagram’s plane of the diagram. This means that the calculation follows the lever rule as well as other rules.

For an example of a calculation of a quasi-binary phase diagram, see Console Mode example tcex17. Go to "About the Thermo-Calc Console Mode Examples " on page 2 in the Thermo-Calc Console Mode Examples Guide.

How to Calculate a Quasi-Binary Phase Diagram

Use CHANGE_STATUS to set the component that has a fixed activity or chemical potential. For example, suppose you want to compute a phase diagram for a Ca-Fe-O system in which the liquid oxide (Fe-LIQ) is in equilibrium with liquid Fe. You then enter:

```
CHANGE_STATUS FE-LIQ=FIX 0
```

Calculating a Quasi-Ternary Phase Diagram

There are many ways to calculate phase diagrams in Thermo-Calc. The following is an example of a quasi-ternary phase diagram used for calculations on a quaternary system where one component has a fixed activity or fixed chemical potential.

When calculating a quasi-ternary phase diagram it is necessary to set a condition on either activity or chemical potential of the fourth component. To specify a meaningful value it is recommended that you first change the component’s reference state using SET_REFERENCE_STATE. For example, to calculate a phase diagram for a quasi-ternary Fe-Cr-Ni-C system with fixed carbon activity, you can enter the following:

```
SET_REFERENCE_STATE C GRAPH ,, 
```

You must also use SET_CONDITION to set the activity of the component whose activity or chemical potential you have fixed. Do this by assigning a value to the ACR state variable. For example, if the component is carbon, you might enter

```
SET_CONDITION ACR(C)=0.002
```
Scheil Simulations

In this section:

About Scheil Simulations ................................................................. 177
Simulating a Scheil-Solidification .................................................. 178
Scheil Module State Variables ....................................................... 180
About Scheil Simulations

Thermo-Calc is primarily a program for performing equilibrium calculations, but some non-equilibrium transformations or partial-equilibrium transformations can be simulated. One example of such a transformation is a Scheil-Gulliver solidification.

In a Scheil-Gulliver solidification, the diffusion in the solid phases is assumed to be so slow that it can be ignored, while the diffusion in the liquid phase is assumed to be very fast. With this approximation, the conditions at the liquid/solid interface can be described as a local equilibrium.

By making a stepping operation on the temperature variable (or enthalpy or amount liquid phase) with small decrementing steps, the new composition of the liquid can be determined. After each step, the amount of formed solid phase is removed and the overall composition is reset to the new liquid composition. In effect, the whole system is described as a non-equilibrium state regarding various parts of solidified phases at various solidification stages.

The Scheil Module

You can simulate Scheil-Gulliver solidification processes with the SCHEIL module. When you enter the module, you are prompted to answer a series of questions about which database to use, what the major element is and in which amount. Thermo-Calc then displays a property diagram showing how the fraction of solid phase varies with temperature (in Celsius). You can then plot diagrams using other variables you are interested in. Do this by starting a new simulation, by opening an old file with the results of a previous simulation that you can plot differently. For example, you might be interested in plotting the fraction of remaining liquid against temperature, the fraction of each solid phase or the total of solid phases against temperature, the microsegregation in each solid phase, or the latent heat evolution against temperature.

It is possible to use the SCHEIL module to run a modified Scheil-Gulliver simulation that also takes back-diffusion of some fast-diffusing interstitial elements such as C or N into account, as well as BCC to FCC phase transformation phenomena.

Scheil Module Examples

- See Thermo-Calc Console Mode examples tcex15 and tcex30 in the Thermo-Calc Console Mode Examples Guide to simulate non-equilibrium transformations without considering fast-diffusion elements.

- See Thermo-Calc Console Mode example tcex48 in the Thermo-Calc Console Mode Examples Guide to simulate partial-equilibrium transformation with fast-diffusion elements taken into consideration. This example also shows how you can perform
lever-rule calculations (full-equilibrium transformations).

**Scheil and the Diffusion Module (DICTRA)**

If you also have a license for the Diffusion Module (DICTRA), you can import a previously calculated Scheil segregation profile into the software using the command INPUT_SCHEIL_PROFILE. Search the online help or see the *Diffusion Module (DICTRA) Command Reference*.

**Simulating a Scheil-Solidification**

Simulating a Scheil-Gulliver solidification process involves calculating the liquid composition of a higher-order multicomponent system at each step of a cooling process, and resetting the liquid composition as the composition of the entire system (after having removed all amount of solid phase).

"SCHEIL Module" on page 293 in the *Console Mode Command Reference*.

1. Use GOTO_MODULE_SCHEIL to enter the SCHEIL module.
2. Type START-WIZARD.
3. Specify which Database to use.
4. Specify the Major element or alloy in your system.

   For example, for a steel/Fe-alloy, enter Fe, for an Al-based alloy, enter Al, and for a Ni-based super alloy, enter Ni.

5. Set whether to specify the Composition input in mass (weight) percent (the default) or in Mole percent. Enter Y for mass percent and N for mole percent.

6. Specify the name of the 1st alloying element. You can directly specify mass or mole percent after the name (for example, enter Cr 5). If this is not specified, then you are prompted to enter it separately.

7. Specify the other alloying elements in the same way as you specify the first (for example, c 1).

8. After you have specified your last alloying element, press <Enter> when requested to specify the next element. This ends the process of defining the bulk composition of the alloy system.

   You can also specify all the alloying elements and their corresponding compositions on the same line when you are prompted to specify your first alloying element in Step 6. For example, you can enter Cr 5 Ni 1 Mo 0.5 C 0.01 N 0.02.
9. Specify the starting Temperature (C) in Celsius. The default is 2000.

   This value should be sufficiently high so that the solidification simulation starts with
   the alloy system in the liquid single-phase region.

10. Decide which phases (if any) to reject at the Reject phase(s) prompt. Enter the
     name of the phases to reject or press <Enter> for NONE.

11. Decide whether to Restore phase(s). You may want to restore a phase that you
     rejected when you ran the simulation earlier, or you may want to restore a phase
     that is rejected by default in your database. Enter the name of the phases to restore
     or press <Enter> for NONE.

12. When prompted OK? type N to go back to Step 9 to reconsider which phases to reject
     or restore. Type Y to continue.

     Thermodynamic data about the alloy system you defined is retrieved from the
     database.

13. At the Should any phase have a miscibility gap check prompt, press <Enter>
     for N or answer Y.

     If you answer Y, you are prompted to specify the Phase with miscibility gap. 
     Answer with a solution phase name(s) (in this example FCC is entered) as well as the 
     Major constituents for sublattice (for each sublattice site) (for this example, 
     Cr is entered for sublattice 1 and C for sublattice 2). In this example the Phase with 
     miscibility gap is LIQUID PHASE NAME: LIQUID.

14. Press <Enter> to specify another phase.

15. Specify the names of any Fast-diffusing components. Press <Enter> for NONE or
     type all the names on the same line then press <Enter>. If you do specify any fast-
     diffusing components, then you are prompted to set whether BCC to FCC phase
     transformations should be simulated.

     The Scheil-Gulliver solidification simulation runs, and the default diagram 
     (Temperature versus Mole Fraction of Solid) is automatically plotted in the Console 
     RESULTS WINDOW.
Scheil Module State Variables

Post processing is done the same way as POLY-3 (see "Equilibrium Calculations with the POLY_3 Module" on page 163), specific variables for plotting in the Scheil Module are listed.

The variables can be plotted along the X- and Y-axes. In the table, \( ph \) is an abbreviation of \textit{phase}, and \( el \) is an abbreviation of \textit{element}. Use the abbreviations of the variables when you specify what the X- and Y-axes represent in a diagram.

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>State variable</th>
</tr>
</thead>
<tbody>
<tr>
<td>T</td>
<td>Temperature in Celsius</td>
</tr>
<tr>
<td>NL/BL</td>
<td>Mole/mass fraction of liquid</td>
</tr>
<tr>
<td>NS/BS</td>
<td>Mole/mass fraction of all solid phases</td>
</tr>
<tr>
<td>NS(ph)/BS(ph)</td>
<td>Mole/mass fraction of a solid phase</td>
</tr>
<tr>
<td>W(ph,el)</td>
<td>Weight fraction of an element in a phase</td>
</tr>
<tr>
<td>X(ph,el)</td>
<td>Mole fraction of an element in a phase</td>
</tr>
<tr>
<td>Y(ph,el)</td>
<td>Site fraction of an element in a phase</td>
</tr>
<tr>
<td>NN(ph,el)</td>
<td>Distribution of an element in a phases</td>
</tr>
<tr>
<td>Abbreviation</td>
<td>State variable</td>
</tr>
<tr>
<td>--------------</td>
<td>--------------------------------------------------------------</td>
</tr>
<tr>
<td>NH/BH</td>
<td>Heat release and Latent heat per mole/gram</td>
</tr>
<tr>
<td>CP/BCP</td>
<td>Apparent heat capacity per mole/gram</td>
</tr>
<tr>
<td>NV/NV(ph)</td>
<td>Molar volume of the system or a phase</td>
</tr>
<tr>
<td>DS/DS(ph)</td>
<td>Average density of the system or a phase</td>
</tr>
<tr>
<td>BT</td>
<td>Apparent volumetric TEC of the system</td>
</tr>
</tbody>
</table>
T0 Temperature Simulations

In this section:

T0 Temperature Simulations ................................................................. 183
Making a T0 Temperature Simulation .................................................... 183
**T0 Temperature Simulations**

The T0-temperature is the temperature at which two phases have the same Gibbs energy for a certain composition in a multicomponent system. The T0-temperature is located within the two-phase field between the phases and it is the theoretical limit for a transformation without diffusion. T0-temperatures are often of interest if you want to understand how diffusionless transformations work. The T0 temperature in a multicomponent system with a fixed composition is temperature at which the tangent lines of the Gibbs energies of the two target phases are the same.

If the composition of one or two components varies, the common Gibbs energy for the two phases in partial equilibrium of a diffusionless transformation becomes a plane or surface, and the T0 temperature becomes a line or plane.

See Console Mode examples tcex23 and tcex41. Go to "About the Thermo-Calc Console Mode Examples " on page 2 in the Thermo-Calc Console Mode Examples Guide.

Also see "Making a T0 Temperature Simulation" below for step-by-step instructions. as well as "Console Mode POST Module" on page 208.

**Making a T0 Temperature Simulation**

This describes how to perform a T0 temperature simulation and apply a stepping calculation to its initial result.

Before you perform a T0 temperature calculation, you must have defined your initial system and be in POLY. The initial overall composition must have appropriate settings for the desired T0 temperature calculation for the two target phases.

See "Equilibrium Calculations with the POLY_3 Module" on page 163 in the Thermo-Calc Console Mode Command Reference.

1. Use SET_CONDITION to set the conditions of your calculation in the same way as when you calculate an ordinary equilibrium.
2. Use COMPUTE_EQUILIBRIUM to run the calculation. The calculation does not need to reach an equilibrium in which any of the target phases is stable.
3. When you have calculated your initial equilibrium, use ADVANCED_OPTIONS and choose T-zero.
4. When prompted, specify the names of the two target phases for which the T0 temperature (where the phases’ Gibbs energies are equal) is to be calculated.
5. If the T0 temperature between the two target phases is calculated, this temperature (in Kelvin) is shown in the Console window.

6. If you want to do a stepping calculation based on this initial T0 temperature calculation, then use SET_AXIS_VARIABLE to specify which state variable to use as the stepping variable. This is done the same way as when you calculate a normal property diagram.

When a T0 temperature simulation is run, you cannot set temperature as the stepping variable.

7. Use STEP_WITH_OPTIONS and choose T-zero to initiate the stepping calculation. You are prompted to specify the names of the target phases for which the T0 temperature is calculated.

During the STEP T-ZERO calculation procedure, the calculated T0 values are presented next to the stepping variable.

For example, part of the output might look like this:

```
Phase Region from 1.000000E-01 for:
BCC_A2
FCC_A1
  1.000000E-01  940.24
  9.250000E-02  941.20
  2.500000E-03  977.61
  7.500000E-09  979.34
```

When the stepping calculation has finished, you can move to the POST module and plot the T0 line against the stepping composition variable or another varying axis value. Or you can impose the calculated T0 line onto a normal phase diagram.
Paraequilibrium

In this section:

- About Paraequilibrium ................................................................. 186
- Calculating a Paraequilibrium ..................................................... 186
About Paraequilibrium

A paraequilibrium is a partial equilibrium where one interstitial component (such as carbon C and nitrogen N) in a multicomponent alloy can diffuse much faster than the other components (the substitutional elements, including the matrix element and alloying elements). The chemical potential for the interstitial component in two partially equilibrated phases is equal in such a case, but this is not true for the other components. In such a paraequilibrium state, it is possible to have a transformation that is partly without partitions, where a new phase of the mobile component can form with different content but where the slowly diffusing components retain their compositions.

A paraequilibrium calculation is useful when, for example, you want to study phase transformations in systems with large differences in the diffusivities of different elements. Transformations occurring under paraequilibrium states can be much more rapid than if full local equilibrium holds at the phase interface.

See Console Mode example tcex42. Go to "About the Thermo-Calc Console Mode Examples" on page 2 in the Thermo-Calc Console Mode Examples Guide.

Also see "Calculating a Paraequilibrium" below for step-by-step instructions.

Calculating a Paraequilibrium

This topic describes both how to calculate an initial paraequilibrium with two target phases, and how to base a stepping calculation on this initial calculation.

Before you do any paraequilibrium calculations, you must have defined your initial alloy system and be in POLY. The initial overall composition must have appropriate settings for the desired paraequilibrium calculation for the two target phases.

These commands are described in the Thermo-Calc Console Mode Command Reference included with this documentation set.

1. Use SET_CONDITION to set the conditions of your calculation just like when you calculate an ordinary equilibrium.

2. Use CHANGE_STATUS to set the status of the chosen interstitial components to SPECIAL. For example, if C is an interstitial component, enter:

   CHANGE_STATUS COMPONENTS C=SPECIAL
This gives you a clear picture on u-fractions of the substitutional and interstitial components, which are different from the overall composition in the system. The SPECIAL status means that the specified components are not included in summations for mole or mass fractions. Therefore, all the composition variables plotted from paraequilibrium calculations are u-fraction related quantities.

3. Use COMPUTE_EQUILIBRIUM to run the calculation.

4. When you have calculated your initial equilibrium, use ADVANCED_OPTIONS Paraequilibrium to perform the paraequilibrium calculation.

5. Specify the names of the target phases of the paraequilibrium state. For example, FCC#1 BCC and FCC#2 M23C6.

   Both phases must have similar interstitial/vacancy sublattices that the fast-diffusion interstitial components occupy. Both target phases should have phase constitution definitions that cover all the defined substitutional and interstitial components of the current alloy system.

6. Specify the names of one or more fast-diffusing components. These components must be located on the interstitial/vacancy sublattices in both of the chosen phases.

   Interstitial components (for instance C and N combined) may have significantly different behaviours depending on how they are partitioned in different structured phases.

   If the paraequilibrium between the two specified phases is successfully calculated, then a message is displayed, for example:

   \[
   \text{NP(FCC)} = 0.3586 \text{ with U-fractions } C = 2.71821E-02 \text{ N} = 4.1548129E-03 \\
   \text{NP(BCC)} = 0.6414 \text{ with U-fractions } C = 7.10061E-04 \text{ N} = 2.3781027E-04
   \]

   All other compositions are the same in both phases

   The first two lines show the phase amounts expressed in mole-percent \([\text{NP(phase)}]\) and the contents of the interstitial components C and N in each phase. These contents are expressed in u-fractions. The third line states that the compositions of the matrix component and all the remaining compositions (regarding substitutional components) are equal in the two target phases at the paraequilibrium state.

7. If you want to do a stepping calculation based on this initial paraequilibrium, then use SET_AXIS_VARIABLE to specify which state variable to use as the stepping variable. This is done exactly in the same way as when you calculate a normal property diagram.
8. Use `STEP_WITH_OPTIONS \rightarrow Paraequilibrium` to initiate the stepping calculation. You are prompted to specify the names of the target phases of the paraequilibrium states as well as the fast-diffusing components.

The stepping calculation is performed, and the different phase regions are listed with columns for the value of the stepping variable, the amounts of the two target phases, the u-fractions of interstitial(s) in each of the two phases, and the LNACR value(s) of the interstitial component(s).

**EXAMPLE**

This command calculates a paraequilibrium between two phases. You must calculate an equilibrium with the overall composition first.

- **Name of first phase**: fco_al
- **Name of second phase**: boq_a2
- **Fast-diffusing component**: /C1; C
- **Fast-diffusing component**: /NORM:
- **Output during stepping is**: axis value, phase amounts, u-fractions of interstitial(s) in phase 1 and 2, and LNACR value(s) of interstitial(s)

<table>
<thead>
<tr>
<th>Phase Region from</th>
<th>900.000</th>
<th>For</th>
</tr>
</thead>
<tbody>
<tr>
<td>fco_al</td>
<td>boq_a2</td>
<td></td>
</tr>
<tr>
<td>9.00000E+00-02</td>
<td>0.176</td>
<td>0.824</td>
</tr>
<tr>
<td>8.80000E+00-02</td>
<td>0.161</td>
<td>0.839</td>
</tr>
<tr>
<td>8.00000E+00-02</td>
<td>0.168</td>
<td>0.852</td>
</tr>
<tr>
<td>8.75000E+00-02</td>
<td>0.136</td>
<td>0.863</td>
</tr>
<tr>
<td>8.60000E+00-02</td>
<td>0.127</td>
<td>0.873</td>
</tr>
<tr>
<td>8.50000E+00-02</td>
<td>0.119</td>
<td>0.881</td>
</tr>
<tr>
<td>8.40000E+00-02</td>
<td>0.111</td>
<td>0.889</td>
</tr>
<tr>
<td>8.30000E+00-02</td>
<td>0.105</td>
<td>0.895</td>
</tr>
<tr>
<td>8.20000E+00-02</td>
<td>0.099</td>
<td>0.901</td>
</tr>
<tr>
<td>8.10000E+00-02</td>
<td>0.093</td>
<td>0.907</td>
</tr>
<tr>
<td>8.00000E+00-02</td>
<td>0.089</td>
<td>0.911</td>
</tr>
</tbody>
</table>

It is possible to now move to the POST module and plot some of the results of the calculation. For an example of a paraequilibrium calculation and how it can be plotted, see Console Mode example tcex23. Go to "About the Thermo-Calc Console Mode Examples" on page 2 in the Thermo-Calc Console Mode Examples Guide.
Potential Diagrams

In this section:

- About Potential Diagrams ................................................................. 190
- Calculating a Potential Diagram ......................................................... 190
- Calculating a Potential Diagram with Different Pressure .................. 191
About Potential Diagrams

If you have a metal-oxide/sulphide-gas interaction system, you might want to calculate a so-called potential phase diagram given certain temperature and pressure. A potential diagram uses the activities of two major species in the gaseous mixture phase as mapping variables. The activities (that is, the fugacities at 1 bar) of these two species are typically set as the X- and Y-axis when the diagram is plotted. The phase relations between the gaseous mixture and various metal forms, metal-oxides, metal-sulphides, or other metal-bearing solids, are represented by different fields controlled by these two potential quantities.

This topic describes how to calculate such potential diagrams with the POTENTIAL module, and how to later modify the pressure of such a calculation in POLY. The calculation done by the POTENTIAL module always assumes a pressure of 1 bar.

Calculating a Potential Diagram

You need access to a substance or solution database that contains a gaseous mixture phase, metals (or alloys), and solids such as metal-oxides, sulphides, sulphates, carbonates, silicates, nitrides or nitrates (stoichiometric or solution phases).

1. Use GOTO_MODULE and enter POTENTIAL.
2. Specify which substance or solution database to use. Any substance or solution database can be used that has a gaseous mixture phase, metals (or alloys), and solids such as metal-oxides, sulphides, sulphates, carbonates, silicates, nitrides, and nitrates (stoichiometric or solution phases).
3. Specify the matrix element (a metal) and the two gaseous species that define your metal-gas interaction system. The names of these components must be available in the database you are using.
4. Set the temperature (in Kelvin). (The pressure is always 1 bar.)

A potential diagram with the activities of the two gaseous species as mapping variables is calculated. These mapping variables are also set as the axis variables in the plotted diagram.

The following is an example diagram (from example 35 in the Console Mode Examples).
**Example**

A POLY3-file is also automatically saved in the current working directory with the default name POT.POLY3.

5. When the diagram is plotted, it opens the POST module where you can modify the plotted diagram in any way you like.

### Calculating a Potential Diagram with Different Pressure

It is possible to modify both the calculation and the plotted diagram that the POTENTIAL module generates in the POLY and POST modules. You can do this by opening a POLY3-file with the results from a POTENTIAL module calculation in either POLY or POST. You can modify the calculation in the same way that you can modify any ordinary mapping calculation or phase diagram. For example, this is useful for calculating a potential diagram at a pressure other than 1 bar.

"Equilibrium Calculations with the POLY_3 Module" on page 163 in the Console Mode Command Reference.

You must have calculated a potential diagram already, and have the saved POLY3-file available.
1. Use GOTO_MODULE and enter POLY.

2. Use READ followed by the name of the POLY3-file that contains the results of the potential diagram calculation that you want to modify.

3. This opens the workspace file and loads the previous settings and results. The activities of the two gaseous species is now part of the conditions, and these conditions are set as the mapping variables.

4. Use SET_CONDITION to specify the pressure under which you want the potential diagram to be calculated. For example, to set the pressure to 1000 bar, enter:

   SET_CONDITION P=1e8

5. Use COMPUTE_EQUILIBRIUM to compute the initial equilibrium.

   You may also want to use ADD_INITIAL_EQUILIBRIUM to calculate some additional equilibria that the mapping calculations are based on.

6. Use MAP to perform the mapping calculations.

7. Use GOTO_MODULE and enter POST to set conditions for visualization and to plot the diagram.
Aqueous Solutions

In this section:

About Aqueous Solutions ................................................................. 194
Calculating a Pourbaix Diagram ....................................................... 195
Plotting Additional Aqueous Solution Diagrams ............................... 198
Stepping Calculations in an Aqueous Solution .................................... 200
About Aqueous Solutions

Heterogeneous equilibrium calculations involving aqueous solutions are not different from other equilibrium calculations, but the setup of the equilibrium conditions and the reference states of the system is more complex. For example, the pH and Eh values of the aqueous solution phase are normally complex functions of bulk composition, temperature and pressure conditions.

For some simple systems, thermodynamic approximations of pH-Eh calculations can be used. But Thermo-Calc also has comprehensive thermodynamic models and databases for various non-ideal solution phases. These let you accurately calculate pH and Eh property diagrams (and many other types of property diagrams) in complex aqueous solutions in a variety of conditions.

A Pourbaix diagram is a pH-Eh phase diagram where the tie-lines are not in the plane. The chemical potentials or activities of two system components (H+ and EA) are used as mapping variables and the pH and Eh quantities are normally plotted on the X- and Y-axes of the diagram. You can use many other properties as axis variables in various property diagrams for the interaction system at a specific temperature and pressure. The phase relations between the aqueous solution and various metal forms, oxides, hydroxides, sulphides, sulphates, nitrates, silicates, carbonates and other solids, or gaseous mixtures, are represented as different fields defined by acidity and electric potential.

You can calculate Pourbaix diagrams with the Pourbaix module. The compositional definition and variations and the basic solvent and electron components H2O, H+1 and ZE are automatically determined by the aqueous solution phase in the Pourbaix module.

See Console Mode examples tcex40 and tcex53. Go to "About the Thermo-Calc Console Mode Examples" on page 2 in the Thermo-Calc Console Mode Examples Guide.

Key Components

These key components are defined as follows:

<table>
<thead>
<tr>
<th>Component</th>
<th>Component status</th>
<th>Reference state</th>
<th>Ref-T(K)</th>
<th>Ref-P(Pa)</th>
</tr>
</thead>
<tbody>
<tr>
<td>H2O</td>
<td>ENTERED</td>
<td>AQUEOUS</td>
<td>*</td>
<td>100000</td>
</tr>
<tr>
<td>H+1</td>
<td>ENTERED</td>
<td>SER</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ZE</td>
<td>ENTERED</td>
<td>REFERENCE_ELECTRODE</td>
<td>*</td>
<td>100000</td>
</tr>
</tbody>
</table>

Besides the aqueous solution phase, your system may also contain a gaseous mixture phase. Other neutral and charged gaseous species may also be constituents. For multicomponent
systems there are normally also some interacting solid phases (stoichiometric or solution) as the so-called secondary phases. These are typically the matrix and/or precipitate phases in the alloys of interest.

Some databases have been specially developed for the Pourbaix module’s diagram calculations. Such a database contains all necessary phases, i.e., an aqueous solution phase, a gaseous mixture phase, some alloy solid solution phases and some secondary solid phases. Databases developed for the Pourbaix module include PAQ (TCS Public Aqueous Solution Database) or PAQS (TGG Public Aqueous Solution Database).

If such a dedicated Pourbaix module is not used, then an aqueous solution database such as TCAQ (TC Aqueous Solution Database), AQS (TGG Aqueous Solution Database), or any user-specified aqueous databases can be used.

This database contains at least the AQUEOUS and REFERENCE_ELECTRODE phases. The aqueous solution database needs to be appended with additional required data and phases, such as interacting alloy (solid) solution phases and secondary (solid and liquid) phases. Additional data is from one or more databases, such as SSUB/SSOL/TCFE or other substances/solutions databases.

**Calculating a Pourbaix Diagram**

The POURBAIX module lets you construct Pourbaix diagrams and other types of property diagrams for heterogeneous interaction systems with aqueous solution phases.

When calculating a Pourbaix diagram, you need to have a database with an aqueous solution phase (that is, a phase with water as the dissolving solvent and with aqueous cation/anion and complex species as the dissolved solutes). Due to restrictions of aqueous solution models (SIT, HKF, Pitzer) used in the Thermo-Calc software, the aqueous solution database must be designed in the same Thermo-Calc database format as that used in the PAQ, PAQS, TCAQ and AQS databases for the aqueous solution phase.

Pourbaix diagram calculations are done in the advanced Pourbaix module.

"POURBAIX_DIAGRAM Commands" on page 274 in the Console Mode Command Reference.

**How to Calculate a Pourbaix Diagram**

1. At the SYS prompt, enter GOTO_MODULE POURBAIX.
2. At the Need any instruction on the POURBAIX module? prompt, press <Enter> to skip or enter Y to learn more.
3. Press <Enter> at the prompt Enforce a PAUSE after plotting when running a MACRO?.

4. Press <Enter> to accept the default 1 to Start a completely new POURBAIX diagram calculation or enter 3 to Open an old file and make another POURBAIX calculation.

To choose 3, you must have already done a Pourbaix calculation and have it saved in a POLY3-file. The new calculation uses the same system definition as the previous calculation, but the other conditions, such as the bulk composition, temperature and pressure, can be modified in the next step.

5. Type Y or N to set whether to Consider the GAS phase (gaseous mixture phase) in the calculation.

The gaseous mixture phase should at least contain H2O, O2 and H2. If a GAS phase is not considered, then only the interactions between the aqueous solution phase and various solid phases (alloy phases and secondary phases) are calculated. Such a calculation may not accurately present all the heterogeneous interactions. Some secondary phases are therefore usually needed. Such phases exist in the PAQ or PAQS Public Aqueous Solution Databases. They can also be appended from the SSUB/SSOL/TCFE or other appropriate substances/solutions databases.

6. Type Y or N to set whether to Use single database (Y) or a multiple database (N).

If you choose to use a single database, at the Combined Database: /PAQ2/ prompt specify a database that is specially developed for the Pourbaix module’s diagram calculations.

If you choose to use a multiple database, then you are prompted to specify an aqueous solution database and to append any additional required data and select necessary phases, such as various interacting alloy (solid) solution phases, and secondary (solid and liquid) phases, for example.

7. Specify all your solutes and the molality of each solute when prompted to do so. This can be done in terms of elements (such as Fe, Ni, Na, Cl, C or S) or arbitrary complex species (such as NaCl, CO2, CoCl3, Fe0.93S, NaSO4-1, or H2SO4). You can enter the element/species and the molarity on one line (for an example, NaCl 2.5).
The first letter of the element abbreviation must always be upper case. Any second letters must be lower case. When you have finished your specification, press <Enter> when asked to specify Next solute.

The definition of your system and its initial bulk composition is now presented.

8. Type Y to confirm the defined system and its bulk composition.

The thermodynamic data for your system is now retrieved from the database(s) chosen.

9. Answer the questions that you are prompted regarding various parameters of your calculation. You are asked to do any of the following:

- **Reject phase(s)** or **Restore phases(s)**
- **Check for miscibility gaps on any phase** (Should any phase have a miscibility gap check?)
- **Enforce the Global Minimization Technique in calculations?**
- **Save all functions, variables and tables in POLY3 file?**
- **Set numerical limits on the calculation**
- **Confirm defined conditions?**
- **Accept the default settings for two mapping variables**

8. The Pourbaix calculation starts. Answer the question Any missing phase boundary you could possibly think of? Type Y or N to set whether you want to add starting points to the calculation. If you suspect that the calculation has missed some phase boundaries, this may help the program to detect them.

9. Answer questions about how the diagram is plotted and how to save the results of your calculation. You are asked to do any of the following:

- **Change the pH/Eh steps for smoother curves?**
- **Zoom in on a specific region of the diagram**
- **Change the curve-label option for the diagram**
- **Add label-texts onto the Pourbaix diagram**
- **Change the subtitle of the diagram**
- **Change the axis-texts**
• Further refine the diagram in the POST Module
• Print the diagram (save a Hard copy of the diagram)
• Save the X-Y coordinates of curve on a text file
• Modify the diagram
• Calculate and plot another Pourbaix diagram (Any more diagram?)

Plotting Additional Aqueous Solution Diagrams

When you have calculated a Pourbaix diagram, you can plot additional diagrams based on the results of the same calculation, but with different axis variables than Ph and Eh.

The variables can be plotted along the X- and Y-axes. Use the abbreviations of the variables when you specify what the X- and Y-axes represent in a diagram. In the table, AQsp refers to the name of a specific aqueous species. The asterisk (*) can be used as a wild card character for all such species. If neither AQsp nor * is entered in parenthesis, then all species are searched.

You must have plotted a Pourbaix diagram to plot a diagram with other variables than Ph and Eh on the Y-axis and the X-axis. You can either plot such additional diagrams directly after having finished the plotting and saving/printing of a Pourbaix Ph-Eh diagram or by choosing option 2 (Open an old file and plot other property diagrams) when you enter the POURBAIX module and opening a POLY3 workspace file.

Abbreviations for Aqueous Solution Variables

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Variable</th>
</tr>
</thead>
<tbody>
<tr>
<td>pH</td>
<td>Acidity</td>
</tr>
<tr>
<td>Eh</td>
<td>Electronic Potential (V)</td>
</tr>
<tr>
<td>Ah</td>
<td>Electronic Affinity (kJ)</td>
</tr>
<tr>
<td>Pe</td>
<td>Electronic Activity (log10ACRe)</td>
</tr>
<tr>
<td>IS</td>
<td>Ionic Strength</td>
</tr>
<tr>
<td>TM</td>
<td>Total Concentration</td>
</tr>
<tr>
<td>Aw</td>
<td>Activity of Water</td>
</tr>
<tr>
<td>Oc</td>
<td>Osmotic Coefficient</td>
</tr>
<tr>
<td>Abbreviation</td>
<td>Variable</td>
</tr>
<tr>
<td>--------------</td>
<td>----------------------------------------------</td>
</tr>
<tr>
<td>MF(AQsp)</td>
<td>Mole Fractions of Aqueous Species</td>
</tr>
<tr>
<td>ML(AQsp)</td>
<td>Molalities of Aqueous Species</td>
</tr>
<tr>
<td>AI(AQsp)</td>
<td>Activities of Aqueous Species</td>
</tr>
<tr>
<td>RC(AQsp)</td>
<td>Activity Coefficients of Aqueous Species</td>
</tr>
</tbody>
</table>
How to Plot an Aqueous Solution Diagram

1. Type y when prompted whether to plot any more diagrams, or select option 2 when you enter the POURBAIX module.

2. Specify which variable you want the X-axis to represent. Use the abbreviation specified in the preceding table. When you specify the name of an aqueous species, you can use the asterisk (*) to select all species.

3. Specify which variable you want the Y-axis to represent. The diagram is then automatically plotted.

4. Answer questions about how the diagram is plotted and how to save it. You are asked to do any of the following:

   - change the axis-type (linear, logarithmic or inverse) on the X-axis or Y-axis
   - zoom in on a specific region of the diagram
   - change the curve-label option for the diagram
   - add label-texts onto the Pourbaix diagram
   - change the subtitle of the diagram
   - change the axis-texts
   - refine the diagram in the POST Module
   - print the diagram (save a hard copy)
   - save the X-Y coordinates of curve on a text file
   - modify the plotted diagram
   - calculate and plot another aqueous solution diagram

Stepping Calculations in an Aqueous Solution

Performing the stepping calculation overwrites all the previous settings and stepping results on the POLY3-file. To avoid this, use "SAVE_WORKSPACE" on page 289 to create a new workspace.

When you have calculated a Pourbaix diagram, you can use the saved results of the calculation (the POLY3-file), and make a property diagram based on stepping calculation.

Since the program normally sets the calculated initial equilibrium point as the starting point, the minimum value for the stepping variable must be specified as smaller or equal to the specific initial condition, and the maximum value as larger or equal to that condition. If pH is
set as the stepping variable, the program automatically calculates the equilibrium constant in logarithmic (log10Ka) of the electrolysis reaction H2O (water) = H+ + OH- for the real aqueous solution under the current temperature-pressure-composition conditions, and thus this constant log10Ka value is considered as the highest pH in specifying the maximum value along stepping. Subsequently, confirm or modify an increment factor with a default value; for pressure and mole of a component, specify the step in logarithmic (log10P or log10N).

**State Variable Abbreviations**

You can use any of these state variables as a stepping variable.

<table>
<thead>
<tr>
<th>State variable</th>
<th>Abbreviation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temperature (K)</td>
<td>T</td>
</tr>
<tr>
<td>Pressure (bar)</td>
<td>P</td>
</tr>
<tr>
<td>Acidity</td>
<td>pH</td>
</tr>
<tr>
<td>Electronic potential (V)</td>
<td>Eh</td>
</tr>
<tr>
<td>Mole number of a dissolving component (such as Fe, Na, Cl, or NaCl) in 1 kg of water.</td>
<td>N(Comp) (for example, (N(Fe)))</td>
</tr>
</tbody>
</table>

**How to Do a Stepping Calculation**

You must have plotted a Pourbaix diagram before making a stepping calculation on an aqueous solution.

1. Use GOTO_MODULE_POURBAIX to enter the POURBAIX module.
2. Type 4 to Open an old file and make another STEPPING calculation.
3. Choose which POLY3-file to load.
4. Specify the conditions of the calculation by answering the questions that follows.

   The system definition is the same as in the previous Pourbaix calculation, but you can modify conditions such as bulk composition, temperature and pressure, and change some component definitions if necessary.

5. Specify which variable to use as the stepping variable (see the preceding table), its minimum and maximum value, and the length of each incremental step.
The settings and stepping results are written to the opened POLY3-file, and a first default property diagram is plotted.
Console Mode TAB Module

In this section:

- Tabulation of Chemical Substances, Phases or Reactions ........................................... 204
- Tabulating a Reaction ........................................................................................................ 205
- Tabulating a Substance or Solution Phase at Fixed Composition ................................. 206
Tabulation of Chemical Substances, Phases or Reactions

The TABULATION_REACTION (TAB) module can be used to tabulate thermodynamic functions of any type of substance, stoichiometric phase or solution phase, or reaction. The module can tabulate thermodynamic functions of pure stoichiometric phases or solution phases at fixed composition, as well as various kinds of partial derivatives for a pure stoichiometric phase or solution phase at a given composition.

The TAB module begins by evaluating the most stable species of a substance in either a homogeneous state or in a reaction. Results are presented in a table or plotted as a graph.

Also see "Tabulating a Reaction" on the next page.

A reaction tabulation presents you with the following properties, on rows representing different temperature levels:

- Heat capacity change / Delta-Cp (Joule/K) in column 2.
- Enthalpy change / Delta-H (Joule) in column 3.
- Entropy change / Delta-S (Joule/K) in column 4.
- Gibbs energy change / Delta-G (Joule) in column 5.

In the case of a tabulation of a substance or solution phase at a fixed composition, the properties presented are the heat capacity, enthalpy, entropy and Gibbs energy, rather than the degree of change in those properties.

Also see "Tabulating a Substance or Solution Phase at Fixed Composition" on page 206.

You can add a 6th column to the table that shows the values of a property or user-defined function of your choice.

EXAMPLE
Tabulating a Reaction

A tabulation of a given chemical reaction provides you with data about the rate of change of the standard tabulation properties at various levels of temperature. You can also add a column for a property of your choice to the table.

1. Use GOTO_MODULE TAB to enter the TAB module.
2. If you want to add one thermodynamic functions to the tabulation calculation, which is present in a sixth column in the table, use ENTER_FUNCTION.

You are prompted to enter the name of the column that is given at its head, and the function itself. The following state variables can be used to define the function: G, H, S, T, P, V and H298.

3. Use TABULATE_REACTION followed by a formula that specifies of the reacting species and products to perform the tabulation calculation. The name of the elements must be entered in upper case letters only. Terminate the chemical reaction with a semi-colon. For example, you can enter:

```
TABULATE_REACTION 3H2+N2=2N1H3;
```
Elements that are designated with a single letter must be followed by a stoichiometry factor, even if this factor is 1. CO hence be interpreted as Cobalt rather than as carbon monoxide. Carbon monoxide is entered as C1O1 or O1C1.

4. Set the pressure, the range of temperature that you want the tabulation to cover, and change in temperature between each row in the table. You can also specify if you want to output the calculation results to an EXP-file and whether you want any graphical output, and if so, which column you want to be plotted against temperature.

The tabulation calculation is performed and you are given a table that shows the various properties at each temperature level within the range defined.

If you have chosen to receive graphical output, then the Console Results window presents a graph that plots the column of you chose (on the Y-axis) against temperature (on the X-axis). When this graph is plotted, you are now in the POST module, where you can modify the graph in various ways.

**Tabulating a Substance or Solution Phase at Fixed Composition**

A tabulation of a substance or solution phase at fixed composition provides you with data about the standard tabulation properties at various levels of temperature for a given chemical reaction. You can also add one extra property column of your choice to the table.

"TABULATION_REACTION Commands" on page 306 in the Console Mode Command Reference.

1. Use GOTO_MODULE TAB to enter the TAB module.
2. Use SWITCH_DATABASE to switch to a database that contains solution-based data, such as TCFE for example.

You cannot use the default SSUB database when tabulating substances or solution phases at a fixed composition.

3. If you want to add one thermodynamic function to the tabulation calculation, which is present in a sixth column in the table, use ENTER_FUNCTION.

You are prompted to specify the column header and the function itself. The following state variables can be used to define the function: G, H, S, T, P, V and H298.

4. Use TABULATE_SUBSTANCE followed by the name of the substance or solution phase to perform the tabulation calculation.
5. Set the pressure, the range of temperature that you want the tabulation to cover, and change in temperature between each row in the table. You can also specify if you want to output the calculation results to an EXP-file and whether you want any graphical output, and if so, which column you want to be plotted against temperature.

The tabulation calculation is performed and a table shows the various properties at each temperature level within the defined range.

If you have chosen to receive graphical output, then the Console Results window presents a graph that plots the column you chose (on the Y-axis) against temperature (on the X-axis). When this graph is plotted, you end up in the POST module, where you can modify the graph in other ways.
Console Mode POST Module

In this section:

- Console Mode Visualization ................................................................. 209
- Plotting Diagrams ............................................................................. 209
- Modifying Diagrams ......................................................................... 210
- Saving Diagrams ................................................................................ 212
- Loading Saved Diagrams .................................................................... 212
Console Mode Visualization

The results of a calculation in Thermo-Calc can be plotted by the post-processor module, also called the POST module. The diagram is presented in the Console Results window.

In the POST module, you can define and plot various kinds of diagrams based on a calculation. You can modify diagram type, which variables to plot on each axis and between which minimum and maximum values, append experimental data from an EXP-file, change labels and symbols in the diagram, zoom in on (and out from) a certain region in a diagram, etc.

If you calculate a property or phase diagram in POLY, then you have to open the POST module yourself. If your calculation was performed by a response-driven module such as SCHEIL or POURBAIX, then the plotting of a diagram based your calculation is part of the dialogue of questions and answers you have in that module (but under the hood, the response-driven module is actually utilizing the POST module to get the plotting done).

Plotting Diagrams

Plotting a diagram is to graphically represent how several variables (typically two variables) co-vary. Each axis in a property diagram or a phase diagram represents the value of one variable. The default variables represented by the X- and Y-axes are the following:

- If you plot a diagram based on the results of a mapping operation (a phase diagram), then by default the X- and Y-axes represent the mapping axis variables 1 and 2 (set using "SET_AXIS_VARIABLE" on page 218 in POLY).
- If you plot a diagram based on the results of a stepping operation (a property diagram), then by default, the X-axis represents the stepping variable (set using SET_AXIS_VARIABLE) and the Y-axis represents the sum of the mole fractions of all phases (that is, NP(*)).

"Equilibrium Calculations with the POLY_3 Module" on page 163 in the Console Mode Command Reference.

How to Plot a Diagram

To plot a diagram, you must have already made a stepping or mapping operation in POLY (or in some cases, made a calculation as part of some opening a response-driven module), and you must have entered the POST module.

The POST command is available inside POLY. Use POST to enter the POST module.
1. If you want to directly plot your diagram with the default variables represented by
the X- and Y-axes, type `Plot` and press <Enter>. This plots a property or phase
diagram with the default variables represented at each axis. If you do not want to
plot your diagram with these default variables, go to the next step.

2. Use `SET_DIAGRAM_AXIS` to set which variables to plot on the X-axis and the Y-axis. For
example, if you want to plot a phase diagram with pressure on the Y-axis and
temperature on the X-axis, type:

```
SET_DIAGRAM_AXIS X T
SET_DIAGRAM_AXIS Y P
```

3. Use `PLOT_DIAGRAM` to plot your diagram.

**Modifying Diagrams**

Modifying a diagram amounts to changing the settings that determine how the POST
module presents the calculated results and plots a new diagram. Suppose that you have
already plotted a binary phase diagram with the mapping axis variables temperature and
mole fraction of one of your components (the Fe component, say) on the X- and Y-axes. If
you then want to modify your diagram so that the Y-axis instead represents, say, the mass
fraction of Fe rather than the mole fraction, then you use "SET_DIAGRAM_AXIS" on page 259
to set diagram axis Y to `w(Fe)`, and then use "PLOT_DIAGRAM" on page 253.

There are many ways in which you can modify your diagram and how it is presented. Any
modification made in the plot settings is taken into account the next time you use PLOT.

**Modification Examples**

The following commands are described in the *Thermo-Calc Console Mode Command Reference*.

The following are some of the modifications you can make.

- Use "SET_TITLE" on page 270 to set add a title or to change an already existing title.
The title is displayed above the plotted diagram in the Console Results window.

- Use "ADD_LABEL_TEXT" on page 243 to add a label text that starts at a certain X-
and Y-coordinate. If you have plotted a phase diagram, then you can let Thermo-Calc
set the label text that specifies the names of the stable phases at that coordinate.

- Use "SET_AXIS_TYPE" on page 257 to set whether the scale of an axis is linear,
logarithmic or inverse.
• Use "SET_DIAGRAM_TYPE" on page 261 to plot a triangular diagram with the X-axis on the triangle’s base and the Y-axis on the triangle’s left side. Such a diagram is often useful if you want to plot the fractions of two components in a ternary diagram.

• Use "SET_SCALING_STATUS" on page 268 to modify the range of values that are displayed on an axis. In effect, you can use it to zoom in or out of the diagram. For example, to set the scale of the X-axis to range from 0 to 0.3, type:

  SET_SCALING_STATUS X N 0 0.3

The X specifies which axis to change the scaling on, the N turns off Thermo-Calc’s automatic scaling, and 0 and 0.3 specifies the minimum and maximum values on the scale. You can turn on automatic scaling again by setting the second parameter to Y.

SET_LABEL_CURVE_OPTION Example

Use "SET_LABEL_CURVE_OPTION" on page 263 to label each set of curves that have the same stable phases with a certain digit. A legend is also added, where you specify which phases each digit designates.

LTEXT vs LaTeX Commands for Labels

As of Thermo-Calc 2015a the LTEXT text formatting is replaced by LaTeX. For
existing users who may have plots and files that use the LTEXT format, and especially when using Console Mode, the following examples show the command changes from LTEXT and its LaTeX equivalent:

<table>
<thead>
<tr>
<th>Symbol or text format</th>
<th>LTEXT</th>
<th>LaTeX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subscripts in an axis text</td>
<td>S-A-TEXT Y N Mole-fraction Al^DO2$O^DO3$</td>
<td>S-A-TEXT Y N \text{Mole-fraction Al_2O_3}</td>
</tr>
<tr>
<td>Label with subscript</td>
<td>add .13 .15 n c-ZrO^DO2$</td>
<td>add .13 .15 n \text{c-ZrO_2}</td>
</tr>
<tr>
<td>Greek symbol</td>
<td>ADD .05 .50 N ^GRd$</td>
<td>ADD .05 .50 N \text{\delta}</td>
</tr>
</tbody>
</table>

Also see "Changing Global Settings" on page 218.

**Saving Diagrams**

When a diagram is plotted, there are several ways in which you can save it:

- Use "DUMP_DIAGRAM" on page 246 to save the diagram image to a PS, PDF, SVG, EMF, GIF, or PNG file. You are asked what format to save it in.
- To save the diagram image in a variety of image file formats, right click the diagram and select **Save Plot**.
- Use "PRINT_DIAGRAM" on page 254 to print a hard copy of the diagram.

Information about the underlying calculations that the diagram is based on is not saved in an EXP-file.

Also see the **DATAPLOT User Guide** included with this documentation set.

**Loading Saved Diagrams**

If you have previously saved a diagram in an EXP-file, then you can load and superimpose the diagram on another diagram. Both the following command requires you to specify which prologue and dataset(s) that are loaded from an experimental data file.

Use "APPEND_EXPERIMENTAL_DATA" on page 245 to plot selected data from an experimental data file (EXP-file). If you have set the axes of the diagram already, the labels on the diagram are not changed when you plot the additional data from the EXP-file, irrespectively of the data in that file.
Use "QUICK_EXPERIMENTAL_PLOT" on page 254 to plot selected data from an experimental data file (EXP-file). If you have set the axes of the diagram already, these settings are overwritten with the axes settings from the EXP-file.
About the Database Files

Encrypted vs Unencrypted Database Files

Any licensed databases purchased from Thermo-Calc Software are encrypted in files with the extension .TDC; these files cannot be edited. These are referred to as encrpted databases.

Unencrypted databases have the file extension .TDB and can be edited. For example, PURE5 or PG35 (the free databases) or a user-defined database file. If you plan to edit any of these files, see "Editing the Database Initialization File or Unencrypted Database File" on page 216 for information.

Database Installation Folder

Depending on the type of license and operating system, the encrypted Thermo-Calc databases and the database initialization file are located in a subfolder to the Thermo-Calc installation. For example, in a Windows standalone installation, you can find these in a folder called data (file path is C:\Program Files\Thermo-Calc<version>\data).

![Folder Structure](image.png)

Database Initialization File

In Windows, the database initialization file is called tc_initd.tdb. In Linux and Mac it is called initd.tdb. The file contains a list of all the databases available from Thermo-Calc Software. Individual licenses are still required to use each database.

The file is used differently by the program depending on whether you are working with databases in Console Mode or Graphical Mode. For this reason, editing the file can be problematic if you don’t understand the differences. See "About Cached Database Files (Graphical Mode only)" on the next page and "Editing the Database Initialization File or Unencrypted Database File" on page 216 for more information.

User Database Files

A user-defined database is considered to be an unencrypted database because you can make changes to it.
In Graphical Mode you can add user databases via the **Options → Graphical Mode → System definer** window. Once you have added the user database it is available from the database list in the System Definer Configuration window. See "Global Settings: System Definition (System Definer)" on page 222 to add a user database.

In Console Mode, users may decide to add their own user-defined database to the database initiation file, which then makes it available in the Console window. If you plan to edit this file, see "Editing the Database Initialization File or Unencrypted Database File" on the next page for important information.

**About Cached Database Files (Graphical Mode only)**

Also see Global Settings "**General**" on page 219 where you can set the default database directory path.

The first time you open a database in Graphical Mode it can take a little while for it to load, especially if it is one of the large databases such as TCFE or TCNI. However, the next time the database opens quickly because now the databases are cached, or stored, in Graphical Mode.

Think of a cache as an intermediate storage area. Once a database cache is established the file made easily accessible, even if you close the software program. It is the same concept as when you load a web page for the first time. The next time the page opens faster. This is also how it works for the databases in Thermo-Calc Graphical Mode.

Thermo-Calc caches the database files, both encrypted and unencrypted types, at two points – when you first open a database, sometimes called an *in-memory cache*, and then later as a *disk-based cache*. The disk-based cache is what speeds up database loading and it is at this point that Thermo-Calc refers to the database initialization file for information. The disk-based cache uses a lookup key to find the abbreviated database name (e.g. TCFE8 or TCNI8) contained in this initialization file.

**It is important to understand the way databases are cached in Graphical Mode to ensure best practices for those who also use Console Mode, especially if the database initialization file is edited. If you plan to edit this file, see Editing a Database Initialization File or Unencrypted Database File for important information.**
Editing the Database Initialization File or Unencrypted Database File

Some advanced users may decide to edit the database initialization file, for example to reorder the list of encrypted databases displaying in the Console window or to add their own user-defined database for use in Console Mode. It is important to understand that changes to this file impact the database caching process used in Graphical Mode (see "About Cached Database Files (Graphical Mode only)" on the previous page).

The following recommendations are also applicable if you edit an unencrypted database file, which includes user databases and free databases such as PURE5 or PG35.

Best Practice Recommendations

If you edit the database initialization file (tc.initd.tdb in Windows or initd.tdb in Mac and Linux), then:

- If a user database is added to the file, it is subject to the same caching as the encrypted databases. This means that further changes (to the user database) will not be detected when you are working with databases in the System Definer in Graphical Mode.

If you have a user database, which is subject to regular updates, then:

- If you make changes to a user database, you then need to clear the cache.
- It is recommended that you create a separate directory to store unencrypted database files.

If you edit an unencrypted database file included with the installation (such as the PURE5 and PG35 files):

- Do not edit the file in the installation folder. Instead make a local copy and load it into the application as a user database.

Database Checker

The Thermo-Calc software package includes a program to check that the syntax of unencrypted database files is correct. The program applies the syntax rules set out in the Database Manager User Guide and reports errors and issues warnings. This program is intended for advanced users who develop and manage databases.
Thermo-Calc accepts deviations from these syntax rules. This means that a database can work even if the Database Checker reports errors and warnings. For example, an error is reported if an abbreviated phase name is found, but phase name abbreviations are accepted by Thermo-Calc and its add-on modules.

The executable DatabaseChecker file is found in the Thermo-Calc home directory. The program can also be launched by selecting Tools→Database Checker from the main menu.

Also see the Database Manager User Guide.
Changing Global Settings

In the Options window (select Tools → Options) you can globally set general settings for Graphical Mode as well as default settings for any new activities for both Graphical Mode and Console Mode.

In this section:

- General .......................................................... 219
- General Global Settings ...................................... 219
- Graphical Mode - Default Units ................................. 221
- Graphical Mode: Activities .................................... 222
- Global Settings: Graphical and Console Mode-Plotting ........................................ 228
- Global Settings: Console Mode Default Appearance ........................................ 231
# General

These settings are for both Graphical and Console modes. To open this window, from the main menu select **Tools → Options**.

## General Global Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tooltips enabled</td>
<td>Select whether to turn on tooltips information. By default the <strong>Tooltips enabled</strong> check box is selected. This displays a small text box when you hover the cursor above some buttons or other items.</td>
</tr>
<tr>
<td>Localization</td>
<td>To change the GUI language from the <strong>Localization</strong> list choose <strong>English</strong> (the default), <strong>Swedish</strong>, <strong>Spanish</strong>, <strong>German</strong>, <strong>Russian</strong>, <strong>Chinese</strong>, <strong>Japanese</strong> or <strong>French</strong>.</td>
</tr>
<tr>
<td>Look and feel</td>
<td>To change the <strong>Look and feel</strong> of the GUI layout, choose <strong>Windows</strong> (the default), <strong>Metal</strong>, <strong>Nimbus</strong>, <strong>CDE/Motif</strong> or <strong>WindowsClassic</strong>.</td>
</tr>
<tr>
<td>Database directory</td>
<td>In the <strong>Database directory</strong> field, specify the path to the directory that contains the <strong>data</strong> directory. This is where the Thermo-Calc database directory called <strong>data</strong> is located. Do not specify the path to where the database files are found (that is, in the <strong>data</strong> directory).</td>
</tr>
</tbody>
</table>

**Modifying the Database Directory Path (Graphical Mode Only)**

Important Note: Database Directory Path (Graphical Mode only)

When you open a database for the first time, it is stored in a cache (an intermediate storage area), that is maintained even if you close the program. This improves the speed of loading the next time you open that database. The cache is used for all databases that are listed in the database initialization file, typically all the standard databases that are included with Thermo-Calc.
If you modify your own user-defined database, or if you choose to edit an unencrypted database, it is recommended that you create a separate directory to store these database files. This way the most recent version of the user-defined or edited databases are loaded into the program when the System Definer is performed.

Also see "About the Database Files" on page 214.

This is where the predefined and custom property models are saved and stored by default. Click Modify to open the default folder or to create a custom folder for your own models.

All property models (whether these are predefined or custom models) must be located in a subdirectory of the property model directory. For that reason it is recommended that you do not change the directory location.

See "Property Model Calculator" on page 64 for information about using the predefined models. Also see "Creating a New Property Model" in the Property Model Development Framework Guide for details about creating a custom model.

Select the level and type of information to display in the Event Log window using the Log level slide bar. Choose from a Debug, Info, Warning or Error level of detail.

From the Check update interval list, choose not to check (Don’t check, the default) or On startup. You can also manually check for updates – choose Help→Check for update.

Select the Use GES6 in Graphical Mode check box to enable this functionality.
Graphical Mode - Default Units

To open this window, from the main menu select **Tools → Options** and click the **Default Units** tab.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temperature</td>
<td>Kelvin (the default), Celsius or Fahrenheit</td>
</tr>
<tr>
<td>Pressure</td>
<td>Pascal (the default), Atmospheres or Bar</td>
</tr>
<tr>
<td>Amount</td>
<td>Mole (the default), Gram, Kilogram or Pound</td>
</tr>
<tr>
<td>Composition</td>
<td>Mass percent (the default), Mole percent, Mass fraction or Mole fraction</td>
</tr>
<tr>
<td>Energy</td>
<td>Joule (the default), Calorie or Electron volt</td>
</tr>
<tr>
<td>Volume</td>
<td>Cubic meter (the default), Cubic decimeter or Cubic centimeter</td>
</tr>
<tr>
<td>Density</td>
<td>Kilogram per cubic meter (the default) or Gram per cubic meter</td>
</tr>
<tr>
<td>Entropy</td>
<td>Joules per Kelvin (the default), Calorie per Kelvin or Electron volt per Kelvin</td>
</tr>
<tr>
<td>Length</td>
<td>Meter (the default), Micrometer or Nanometer</td>
</tr>
<tr>
<td>Time</td>
<td>Seconds (the default), Hours or Days</td>
</tr>
<tr>
<td>Setting</td>
<td>Options</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Reset to original settings</td>
<td>In the lower corner of the window, click the <strong>Reset to original settings</strong> button to restore the original settings. You may have to expand the window to view the button.</td>
</tr>
</tbody>
</table>

**Graphical Mode: Activities**

To open this window, from the main menu select **Tools → Options** and click the **Activities** tab.

There are **System definition, Calculation, Precipitation, Diffusion, Scheil, Plotting** and **Tabulation** settings windows.

For Plotting, the default settings are shared with the Graphical and Console Modes. Any changes you make also apply to the default settings on the **Console Mode → Plotting** tab in the **Options** window (and vice versa). See "**Global Settings: Graphical and Console Mode-Plotting**" on page 228 for details.

**Global Settings: System Definition (System Definer)**

When you create a new System Definer, the default databases are taken from these defaults. The database selections for each System Definer can then be configured individually. Once created, the specific (local) settings for a System Definer are not affected if you later make changes to the global defaults.

To open this window, from the main menu select **Tools → Options** and click the **Activities** tab. Then click **System definition**.

**EXAMPLE**
Also see "System Definer" on page 57, "Creating a Database Package" on the next page and "Clearing a Database Package Message" on page 225.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default database selection</td>
<td>Choose to define a <strong>Database</strong> or a <strong>Database package</strong>. If you choose <strong>Database</strong>, then select the default installed database to use globally for all System Definer nodes. For example, choose <strong>TCFE8</strong> or <strong>TCNI8</strong>. If you choose <strong>Database Package</strong>, select an option from the list. These Database Packages are defined in <strong>Database Packages</strong>.</td>
</tr>
<tr>
<td><strong>User Databases</strong></td>
<td></td>
</tr>
<tr>
<td>Database name</td>
<td>Click the <strong>Add</strong> button to add a custom database. After you have added the user database it is available from the list to choose as the default. Once a user database is added to the <strong>Database name</strong> list, you can also click the <strong>Remove</strong> button to delete it from your project.</td>
</tr>
<tr>
<td><strong>Database Packages</strong></td>
<td>Create and remove <strong>Database Packages</strong> by clicking the <strong>Add a database package</strong> button or <strong>Remove this database package</strong> button.</td>
</tr>
</tbody>
</table>
Setting | Options
--- | ---
 | The addition or removal of a database package does not take effect until a new System Definer node is defined.
 | Click **Show details** to display the list of databases included with the package. Click **Hide details** to only display the name of the package. See "Creating a Database Package" below.
 | In the lower corner of the window, click the **Reset to original settings** button to restore the original settings. You may have to expand the window to view the button.

**Creating a Database Package**

1. From the main menu select **Tools → Options**.
2. Click the **Activities** tab and click **System definition**.
3. Under **Database Packages**, click the **Add a database package** button.
4. Replace the default text with a name for the package, for example **My database package**.
5. Select a database from the **Choose database** list, for example, **TCN18**.
6. Click the **Add a database** button and from the **Choose database** list, select another database, for example, **TCAL4**.
7. Click **OK**. The Database Package is now available to choose as the default for new System Definer activities.
The package is available for new System Definer nodes defined after adding the package.

"Clearing a Database Package Message" below and "Global Settings: System Definition (System Definer)" on page 222.

Clearing a Database Package Message

Sometimes when working on the System Definer Configuration window, you may add or delete Databases. If you originally added a Database Package, the addition or removal of a database means that the original package you selected does not now match the databases you are using. To clear the message Selected databases and selected package may differ and reset the databases you need to either:

- Change the newly added database back to the one that matches the database package,
- Choose another package from the Package list, then select the package you want.

For example, from the Package list you select Demo: Steels and Fe-alloys.

This adds the FEDEMO and MFDEMO databases.

If you add or remove Databases, in this example MFDEMO is removed, then this does not match the Package and the message displays:
To clear the message, click the **Add a database** button and from the **Choose database** list, select the database that belongs with the package, in this example, **MFEDEMO**. The message is cleared.

You can also choose another package from the list, which changes the databases, and then re-select the original package to reset the message.

"Creating a Database Package" on page 224 and "Global Settings: System Definition (System Definer)" on page 222.

**Global Settings: Calculation (Equilibrium Calculator)**

When you create a new Equilibrium Calculator, its initial settings are taken from these defaults. The settings of each Equilibrium Calculator can then be configured individually. Once created, the specific (local) settings for an Equilibrium Calculator are not affected if you later make changes to the global defaults.

To open this window, from the main menu select **Tools → Options** and click the **Activities** tab. Then click **Calculation**.

See the "Equilibrium Calculator Options Settings" on page 83 for information about the settings.

You can reset the defaults. In the lower corner of the window, click the **Reset to original settings** button to restore the original settings. You may have to expand the window to view the button.

**Global Settings: Diffusion (Diffusion Calculator)**

When you create a new Diffusion Calculator, its initial settings are taken from these defaults. The settings for each Diffusion Calculator can then be configured individually. Once created, the specific (local) settings are not affected if you later make changes to the global defaults.

To open this window, from the main menu select **Tools → Options** and click the **Activities** tab. Then click **Diffusion**.

See "Diffusion Calculator" on page 87 for information about each setting.

You can reset the defaults. In the lower corner of the window, click the **Reset to original settings** button to restore the original settings. You may have to expand the window to view the button.
**Global Settings: Precipitation (Precipitation Calculator)**

When you create a new Precipitation Calculator, its initial settings are taken from these defaults. The settings for each Precipitation Calculator can then be configured individually. Once created, the specific (local) settings for a Precipitation Calculator are not affected if you later make changes to the global defaults.

To open this window, from the main menu select **Tools → Options** and click the **Activities** tab. Then click **Precipitation**.

See "Precipitation Calculator" on page 97 for information about each setting.

You can reset the defaults. In the lower corner of the window, click the **Reset to original settings** button to restore the original settings. You may have to expand the window to view the button.

**Global Settings: Scheil (Scheil Calculator)**

When you create a new Scheil Calculator, its initial settings are taken from these defaults. The settings of each Scheil Calculator can then be configured individually. Once created, the specific (local) settings for a Scheil Calculator are not affected if you later make changes to the global defaults.

To open this window, from the main menu select **Tools → Options** and click the **Activities** tab. Then click **Scheil**.

See "Scheil Calculator" on page 135 for information about each setting.

You can reset the defaults. In the lower corner of the window, click the **Reset to original settings** button to restore the original settings. You may have to expand the window to view the button.

**Global Settings: Tabulation (Table Renderer)**

When you create a new Table Renderer, its initial settings are taken from these default settings. The settings of each Table Renderer can then be configured individually. Once created, the settings of a Table Renderer are not affected by changes in the default settings.

To open this window, from the main menu select **Tools → Options** and click the **Activities** tab. Then click **Tabulation**.

See "Table Renderer" on page 128 for information about each setting.

You can reset the defaults. In the lower corner of the window, click the **Reset to original settings** button to restore the original settings. You may have to expand the window to view the button.
Global Settings: Graphical and Console Mode-Plotting

The default settings are shared with both modes. Any changes you make also apply to the default settings on the Console Mode → Plotting tab in the Options window (and vice versa).

To make local changes to the appearance of a specific plot, in the Results window right-click a plot and select Properties. In the Plot Properties window a variety of settings can be made.

You can also edit some properties for individual plot lines (the color, the line width and type, and whether data points are included). In the Results window, hover the mouse over a plot line. The crosshair cursor turns into a cursor resembling a pointing hand when it is over a line that can clicked. Alternatively, hold down the <Ctrl> key while you move the cursor around the plot to only display it as a crosshair and prevent unintended edits.

To globally configure the default settings for plotting, from the main menu select Tools → Options. Click the Graphical Mode → Activities tabs and then click the Plotting node.

When you create a new Plot Renderer, its initial settings are taken from these default settings. The settings can then be configured individually. Once created, the settings of a Plot Renderer are not affected by changes to the default global settings.

To configure the settings of an individual Plot Renderer rather than the default settings, right-click a plot in the Results window and select Properties from the menu.

Plot Renderer Settings for Console and Graphical Modes

These global settings are available for both Console and Graphical Modes.
<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Title</strong></td>
<td>Enter a title. Select <strong>Plain text</strong> (the default) or <strong>LaTeX formatted text</strong>. Click α button to add symbols. Click a symbol category (for example, Latin characters or Greek and math symbols). Then click to choose the symbol located on the right-hand side. When you select <strong>LaTeX formatted text</strong> you can use the LaTeX math text to enter text. See &quot;ADD_LABEL_TEXT&quot; on page 243 and &quot;Adding and Editing Plot Labels&quot; on page 119 for more details.</td>
</tr>
<tr>
<td>Title font, Legend font, Label font, Header font</td>
<td>Click <strong>Modify</strong> to edit the Font Name, Style, Size and Color.</td>
</tr>
<tr>
<td>Legend phase caption style</td>
<td>Choose <strong>All</strong>, <strong>Constitution description</strong> or <strong>Ordering description</strong>. See &quot;About Legend Styles&quot; on page 117 for details about these options.</td>
</tr>
<tr>
<td>Legend background color, Background color, Canvas color, Border color,</td>
<td>Click <strong>Modify</strong> to choose a color or enter a specific color.</td>
</tr>
<tr>
<td>Label format</td>
<td>Select Plain text (the default) or LaTeX formatted text.</td>
</tr>
<tr>
<td>Show anchor</td>
<td>By default, an anchor between the label and the plot point is displayed.</td>
</tr>
<tr>
<td>Retain labels (Graphical Mode only)</td>
<td>By default the check box is selected. Plot labels are kept (retained) when plots are updated. It can be applied globally or locally to individual plots.</td>
</tr>
<tr>
<td>Show header (Console Mode only)</td>
<td>Click to select the <strong>Show header</strong> check box to display the basic details about the plot along the top. This includes the date and time the plot is generated, the database used and the properties.</td>
</tr>
<tr>
<td>Border width</td>
<td>Choose a plot border width between 1 (thin, the default) and 10 (thick).</td>
</tr>
<tr>
<td>Setting</td>
<td>Options</td>
</tr>
<tr>
<td>-------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Color option</td>
<td>For the plot line colors, choose from the options in the list: Legacy, Printer friendly, JFree chart, Pastel, Medium dark, Bright dark, Vivid or Earth. This option is also available for specific plot lines. To change the color of an individual plot line double-click it in the Results window and use the color palette to define it or enter a specific color.</td>
</tr>
<tr>
<td>Line width</td>
<td>For the plot line width, choose from the options in the list. These options are also available for specific plot lines. To change an individual plot line width double-click it in the Results window.</td>
</tr>
<tr>
<td>Line type</td>
<td>This option is only available for individual plot lines. To change an individual plot line type double-click it in the Results window and choose an option from the list.</td>
</tr>
<tr>
<td>Show data points</td>
<td>Click to select the check box to display the data points on the plot lines. This option is also available for specific plot lines. To show data points on an individual plot line double-click it in the Results window and select the check box.</td>
</tr>
<tr>
<td>Data point marker size</td>
<td>Choose the data point marker size between 1 (small) and 10 (large). The default is 3.</td>
</tr>
<tr>
<td>Plot area size</td>
<td>The <strong>Fit the plot area size to the enclosing window</strong> option is selected by default. Excluding triangular plots, click Define the plot area size to enter a Plot area height and Plot area width.</td>
</tr>
<tr>
<td>Reset to original settings</td>
<td>In the lower corner of the window, click the <strong>Reset to original settings</strong> button to restore the original settings. You may have to expand the window to view the button.</td>
</tr>
</tbody>
</table>
Global Settings: Console Mode Default Appearance

To open this window, from the main menu select **Tools → Options**. To change the name, buffer size, fonts and colours for a specific Console window, right-click the label for that particular Console and select **Properties**.

**EXAMPLE**

![Options](image)

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Console name</td>
<td>The default is <strong>Console</strong> or enter another name to display</td>
</tr>
<tr>
<td>Buffer size</td>
<td>The default buffer size is 40,000. Also see &quot;Increasing the Buffer Size&quot; on page 160 to adjust locally when in Console Mode.</td>
</tr>
<tr>
<td>System output font</td>
<td></td>
</tr>
<tr>
<td>Command prompt font</td>
<td>Click <strong>Modify</strong> to open the Select Font window and makes changes to the font type, style, size or color as required.</td>
</tr>
<tr>
<td>User input font</td>
<td></td>
</tr>
<tr>
<td>Background color</td>
<td>Click <strong>Modify</strong> to open the Select Color window to choose a background color for the Console Mode window where you enter commands.</td>
</tr>
<tr>
<td>Default directory</td>
<td>Set the default directory where log files and workspace files are saved.</td>
</tr>
<tr>
<td>Reset to original settings</td>
<td>In the lower corner of the window, click the <strong>Reset to original settings</strong> button to restore the original settings. You may have to expand the window to view the button.</td>
</tr>
</tbody>
</table>
Technical Notes

In this section:

Technical Note: Pipe or Redirect Output Data from Console.exe .................................. 233
## Technical Note: Pipe or Redirect Output Data from Console.exe

<table>
<thead>
<tr>
<th>Audience:</th>
<th>Advanced Programmers and Users</th>
</tr>
</thead>
<tbody>
<tr>
<td>OS:</td>
<td>Windows, Linux, or Mac</td>
</tr>
<tr>
<td>Application:</td>
<td>For users who want to pipe or redirect data from the Thermo-Calc console.exe program.</td>
</tr>
</tbody>
</table>
| Command syntax: | $more my_commands.tcm | ./Console.sh -E > results.log  
OR  
$./Console.sh -E < my_commands.tcm > results.log |
| Command examples: | $more my_commands.tcm | ./Console.sh -E > results.log  
OR  
$./Console.sh -E < my_commands.tcm > results.log |

### Command line definitions

| | 
|---|---|
| **E** | For Linux and Mac users, the Emacs style editing feature must be disabled (turned off) using the switch -E in order for redirection and piping to work correctly with Thermo-Calc. For Windows this flag is not necessary. |
| **| Pipe command that forwards output data as input to subsequently defined programs. For example, more my_commands.tcm | ./Console.sh pipes the information from my_commands.tcm to the Console.sh script file. |
| **<>** | Redirection commands. The direction of each arrow indicates the flow of data. For example in ./Console.sh -E < my_commands.tcm > results.log, the contents of my_commands.tcm is used as input to the Console.sh script file and the resulting output is then written to results.log. |
Graphical Mode Examples Guide

Thermo-Calc Version 2017a
About the Graphical Mode Examples

Graphical Mode examples are available for Thermo-Calc and the add-on Diffusion Module (DICTRA) and Precipitation Module (TC-PRISMA). These are in the format of project files (*.tcu) and are included together in the same folder.

Also search the online help for "Opening Graphical Mode Project Files", which is in the Thermo-Calc User Guide.

This guide includes the example descriptions and information about how to open a Graphical Mode project file.

Watch the Video Tutorials

Many of the Graphical Mode examples have video tutorials available either on our website or on our YouTube channel.
Opening a Project File

To open an example project file for Thermo-Calc and the add-on Diffusion Module (DICTRA) and/or Precipitation Module (TC-PRISMA):

1. Open Thermo-Calc.
2. Confirm you are in Graphical Mode. If not, click the **Switch to Graphical Mode** button.
3. From the main menu, select **File → Open Examples** or **Help → Open Examples**.
4. Navigate to the project file you want and double-click to open.
5. The Graphical Mode examples are stored without calculated results so you will want to run the example calculation and generate a plot or table. To do this, click the first node in the tree at the top of the Project window. Then right-click and select **Perform now**.

---

All Graphical Mode examples are in the same folder. This includes add-on Diffusion Module (DICTRA) and/or Precipitation Module (TC-PRISMA) as well as the Thermo-Calc examples. However, some add-on module examples require additional licenses to run for more than two elements.
Graphical Mode Examples by Category

This guide includes descriptions of these examples:

<table>
<thead>
<tr>
<th>Category</th>
<th>Example number</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Binary System Examples&quot; on the next page</td>
<td>1, 2, 3</td>
</tr>
<tr>
<td>&quot;Ternary System and User-Defined Function Examples&quot; on page 9</td>
<td>4, 7</td>
</tr>
<tr>
<td>&quot;Equilibrium Calculator Examples&quot; on page 13</td>
<td>5, 6, 9 (a property grid calculation)</td>
</tr>
<tr>
<td>&quot;Property Model Calculator Examples&quot; on page 17</td>
<td>10, 11, 12</td>
</tr>
<tr>
<td>&quot;Scheil Calculator Example&quot; on page 11</td>
<td>8</td>
</tr>
<tr>
<td>&quot;Diffusion Calculator Examples&quot; on page 20</td>
<td>19, 20, 21 (the Quick Start Guide Examples)</td>
</tr>
<tr>
<td>&quot;Precipitation Calculator Examples&quot; on page 23</td>
<td>13, 14, 15, 16, 17, 18</td>
</tr>
</tbody>
</table>
Binary System Examples

Ex_01: Calculating a Single-Point Equilibrium

Project File and Video Tutorial Information

- File name: Ex_01_Single-point_equilibrium.tcu
- This example is included in the tutorial on our YouTube channel.

This example shows the result from a single-point equilibrium calculation in the Fe-C system. It demonstrates the use of the Equilibrium Calculator and generates a Table Renderer in the Results window. The number of equilibrium conditions is \( C+2 \) where \( C \) is the number of components, meaning that four conditions are needed in this example:

- **Temperature** is 1000 K
- **Pressure** is 101325 Pa
- **System size** is 1 mole
- **Mass percent carbon** is 0.1%

The displayed results of the calculation show that the BCC_A2 (ferrite) and GRAPHITE phases are stable for this set of equilibrium conditions.
Table Result

<table>
<thead>
<tr>
<th>System</th>
<th>Moles</th>
<th>Mass</th>
<th>Temperature</th>
<th>Total Gibbs Energy</th>
<th>Enthalpy</th>
<th>Volume</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1.00000</td>
<td>55.64392</td>
<td>1000.00000</td>
<td>-42141.28527</td>
<td>24706.54116</td>
<td>7.30619E-6</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Component</th>
<th>Mole Fraction</th>
<th>Mass Fraction</th>
<th>Activity</th>
<th>Potential</th>
</tr>
</thead>
<tbody>
<tr>
<td>C</td>
<td>0.00463</td>
<td>0.00100</td>
<td>0.21816</td>
<td>-12658.89428</td>
</tr>
<tr>
<td>Fe</td>
<td>0.99537</td>
<td>0.99900</td>
<td>0.00619</td>
<td>-42278.50542</td>
</tr>
</tbody>
</table>

Stable Phases

<table>
<thead>
<tr>
<th>Phase</th>
<th>Moles</th>
<th>Mass</th>
<th>Volume Fraction</th>
</tr>
</thead>
<tbody>
<tr>
<td>BCC_A2#1</td>
<td>0.99609</td>
<td>55.59692</td>
<td>0.99711</td>
</tr>
</tbody>
</table>

Ex_02: Stepping in Temperature in the Fe-C System

Project File and Video Tutorial Information

- File name: Ex_02_Step_in_temperature_in_Fe-C.tcu
- This example is included in the tutorial on our [YouTube](https://www.youtube.com) channel.

This example shows how the fractions of stable phases vary for an Fe-0.1 mass-% C alloy when the temperature is varied between 500 and 2000 K. It demonstrates the use of the Equilibrium Calculator. To allow temperature to vary, the corresponding **Axis Definition** check box is selected. In this example, results are displayed graphically using a Plot Renderer activity. If you want, you can use a Table Renderer to generate text results instead.
Plot Result

Ex_03: Fe-C Phase Diagrams

Project File and Video Tutorial Information

- File name: Ex_03_Fe-C_phase_diagram.tcu
- This example is included in the tutorial on our YouTube channel.

This example shows the stable Fe-C phase diagram (stable meaning that the graphite phase is entered in the calculation). The same diagram is calculated using the Binary Calculator activity and then using a System Definer and Equilibrium Calculator.

In both cases, a Plot Renderer is used to display results. The purpose of the Binary Calculator is to simplify common calculations for binary systems. In the Equilibrium Calculator two axes are defined: Mass percent C and Temperature. An axis variable must also be an equilibrium condition.

Plot Result

This shows the plot result of the System Definer and Equilibrium Calculator system.
Ternary System and User-Defined Function Examples

Ex_04: Fe-Cr-C Ternary Phase Diagram at 1000 K

Project File and Video Tutorial Information

- File name: Ex_04_Fe-Cr-C_ternary_phase_diagram.tcu
- This example is included in the tutorial on our YouTube channel.

This example shows a ternary phase diagram in the Fe-Cr-C system at 1000 K. Similar to Example 3 (in "Binary System Examples" on page 5), the same diagram is calculated using a Ternary Calculator and then using a System Definer and Equilibrium Calculator. Two Plot Renderer activities are added to create two plots.

Plot Result

This plot example shows the result of using the Ternary Calculator activity node.

Try practicing with two features on the Plot Renderer Configuration window. To toggle between a triangular and a rectangular diagram, click the Show Triangular button. To toggle the X and Y axis variables, press the Switch Axes button.
Ex_07: User-Defined Functions

Project File Information

File name: Ex_07_User_defined_functions.tcu

This example shows how to implement user-defined functions.

A series of equilibria for an Fe-Cr-C alloy are calculated by varying temperature between 500 and 3000 K. In the configuration window of the Equilibrium Calculator under the Functions tab, two identically meaning functions are defined, fraction solid and f solid, the values of which are plotted against temperature in two Plot Renderer activities. Functions can be entered in terms of Quantities Q1, Q2, Q3 and so forth, or by using the Thermo-Calc syntax.

Plot Result

This plot example shows the result of the fraction solid function.
Scheil Calculator Example

Ex_08: Scheil and Equilibrium Solidification

Project File and Video Tutorial Information

File name: Ex_08_Scheil_and_equilibrium固体ification.tcu.

For other examples of using Scheil, see our YouTube channel:

- Modified Austenitic Stainless Steel 18/8 Scheil Solidification Simulation
- Applications to Welding and Joining with Bonus Scheil Example

This example shows a comparison for an Al-Si alloy solidified under full local equilibrium and under the Scheil assumptions, i.e. zero diffusion in the solidified material and infinitely fast diffusion in the liquid. The example uses the Scheil Calculator and adds a Plot and Table Renderer.

Plot and Table Results

The plot compares the mole fraction of a solid vs temperature. The table provides the data, which you can export.

<table>
<thead>
<tr>
<th>Mole fraction of solid</th>
<th>Temperature [°C]</th>
</tr>
</thead>
<tbody>
<tr>
<td>-2.22045E-16</td>
<td>654.52000</td>
</tr>
<tr>
<td>-2.22045E-16</td>
<td>654.52000</td>
</tr>
<tr>
<td>-2.22045E-16</td>
<td>654.52000</td>
</tr>
<tr>
<td>0.00070</td>
<td>654.42600</td>
</tr>
<tr>
<td>0.16088</td>
<td>653.42600</td>
</tr>
<tr>
<td>0.27620</td>
<td>652.42600</td>
</tr>
<tr>
<td>0.36765</td>
<td>651.42600</td>
</tr>
<tr>
<td>0.43800</td>
<td>650.42600</td>
</tr>
<tr>
<td>0.49472</td>
<td>649.42600</td>
</tr>
<tr>
<td>0.54136</td>
<td>648.42600</td>
</tr>
</tbody>
</table>
Graphical Mode Examples Guide | 12 of 39
Equilibrium Calculator Examples

Other examples also use the Equilibrium Calculator. See "Binary System Examples" on page 5 and "Ternary System and User-Defined Function Examples" on page 9.

Ex_05: Stable and the Metastable Fe-C Phase Diagrams

Project File Name

File name: Ex_05_Fe-C_stable_and_metastable_phase_diagram.tcu

This example shows how to overlay results from two calculations in the same plot using the Equilibrium Calculator.

In Equilibrium Calculator 1 the stable phase diagram is calculated and in Equilibrium Calculator 2 the metastable phase.
Plot Results

The Plot Renderer activity is first created as a successor to Equilibrium Calculator 1. Then right-click the Plot Renderer node and select **Add predecessor** and the results from both equilibrium calculators are in the same plot. The metastable diagram is obtained by deselecting the graphite phase in the System Definer under the **Phases and phase constitution** tab.

![Diagram](image)

Ex_06: Serially Coupled Equilibrium Calculators

**Project File Name**

File name: *Ex_06_Serial_equilibrium_calculators.tcu*

Sometimes there are multiple solutions for a given set of equilibrium conditions. In other cases the equilibrium calculation does not converge. You can then aid the final calculation by, in effect, telling the software where it should start the search for the equilibrium.

This example shows how to serially couple two Equilibrium Calculator nodes together for more complex equilibrium conditions. For each calculation, the output is to a Table Renderer.

**Equilibrium Calculator 1**

In the first example, the objective is to calculate the equilibrium at 850°C where the mole fractions of the FCC A1 and BCC A2 phases are 0.5 each for an Fe-Cr-C steel with 10% chromium. In Equilibrium Calculator 1 a simple set of equilibrium conditions (temperature,
pressure, system size and composition) are used to find a carbon content where only the FCC A1 and BCC A2 phases are stable. The results from this preliminary calculation are displayed in Table Renderer 1.

**Equilibrium Calculator 2**

In Equilibrium Calculator 2 the carbon content equilibrium condition is replaced by the condition that the numbers of moles of the BCC A2 phase should be 0.5. The final result is displayed in Table Renderer 2. In this case, the final objective is to calculate the solidus temperature of an Fe-Cr-C steel with 10% Cr and 0.01% C.

**Equilibrium Calculator 3**

In Equilibrium Calculator 3 the state at 2000 K is calculated and the result is displayed in Table Renderer 3.

**Equilibrium Calculator 4**

In Equilibrium Calculator 4 the temperature equilibrium condition is replaced by the condition Fix phase / liquid / 0.0, meaning that liquid should be stable in an amount of zero moles, i.e. the solidus temperature. The final result is displayed in Table Renderer 4.

**Ex_09: Carbide Driving Force Heat Map**

**Project File Name**

File name: Ex_09_Heat_map_of_carbide_driving_force.tcu

This is an example of using property grid calculations to plot the driving force for a carbide as a function of two composition variables. With the property grid calculation type, a 2D grid is generated from the two calculation axes. After the calculation is done, an equilibrium is calculated in each grid point. A Plot Renderer connected to a property grid calculator plots the z-axis property for each equilibrium as a function of the two calculation axes. The final plot can be either a heat map or a contour plot.
Plot Result

![Graph result](image-url)
Property Model Calculator Examples

Experienced users can also create custom property models for use with the Property Model Calculator. See the Introduction to the Property Model Development Framework for details.

Ex_10: Phase Transition

Project File and Video Tutorial Information

- File name: Ex_10_Phase_Transition.tcu
- This example is included in the tutorial on our YouTube channel. Also see the video introduction to this feature.

The example uses the Property Model Calculator to predict the transition temperature to the unwanted brittle Sigma phase. The example shows how the temperature is influenced by changes to a steel alloy’s composition using the uncertainty calculation type and how to create either a histogram or probability plot.

Ex_11: Coarsening and Interfacial Energy

Project File and Video Tutorial Information

- File name: Ex_11_Coarsening_and_Interfacial_energy.tcu
- This example is included in the tutorial on our YouTube channel. Also see the video introduction to this feature.

The example uses the Property Model Calculator and both thermodynamic and kinetic demonstration steel databases. Using a grid calculation type it produces these plots: a heat map, a contour plot and a cross plot with contour (where both the interfacial energy and coarsening rate is shown). It also creates a property diagram to show the phase fractions vs time.

Plot Result Examples

Heat Map
**Ex_12: Driving Force and Interfacial Energy**

**Project File and Video Tutorial Information**

- File name: *Ex_12_Driving_force_and_Interfacial_energy.tcu*
- See the [video introduction](#) to this feature.

The example uses the Property Model Calculator and a thermodynamic demonstration steel database. Using a grid calculation type it produces a contour plot comparing the driving
force and interfacial energy.

**Plot Result**

A contour plot

![Contour Plot](image-url)
Diffusion Calculator Examples

Examples 19 and 20 are available to all users. The other examples require a Diffusion Module (DICTRA) license to calculate and plot results.

All examples use demonstration database packages included with your installation.

Homogenization of a Binary Fe-Ni Alloy

The single phase example simulates the diffusion of Fe and Ni at a temperature of 1400 K in a planar domain. At this temperature the material is fully austenitic, i.e. the only phase present is the so-called fcc (face centered cubic) phase. Initially, there is a linear variation in Ni going from 10 mass-% on the left-hand side to 50 mass-% on the right-hand side.

This example is available as a video tutorial on our website and YouTube channel.

Project File Name and availability

File name: Ex_19_Diffusion_Single_Phase.tcu

This example is part of the Diffusion Module (DICTRA) Quick Start Guide available to all users. A version of the example is also available for Console Mode.

Ferrite(bcc)/Austenite(fcc) Transformation in a Binary Fe-C Alloy

The moving phase example simulates the growth of ferrite (bcc) into austenite (fcc). The austenite is assumed to be initially homogeneous with the composition Fe - 0.15 mass-% C. The transformation temperature is 1050 K. The initial thickness of the austenite is 2 mm and an initially very thin ferrite (1 nm) is also present at the start of the simulation.
Evolution of an Fe-Cr-Ni Diffusion Couple

The multiphase example simulates the evolution of an Fe-Cr-Ni diffusion couple during a 100 hour heat treatment at 1100 °C (1373.15 K). Both end members of the diffusion couple are duplex ferrite plus austenite, but the majority phase is ferrite on the left-hand side and austenite on the right.

With this type of simulation it is assumed that the material is fully equilibrated at each grid point, i.e. the local phase fractions, phase compositions and so forth are obtained from an equilibrium calculation with the local overall composition as a condition.

More details about the homogenization model for multiphase simulations can be found in Larsson and Engström (2006) and Larsson and Höglund (2009). Experimental data is from Engström (1995).

Fe-C Moving Boundary: Austenite to Ferrite

This example simulates the Austenite to Ferrite transformation in a Fe-0.15mass%C steel during continues cooling. The simulation starts at a temperature where only Austenite is stable, Ferrite nucleates and grows into during cooling in the two phase region. Plots of the carbon composition profile and a thermal profile are generated.

---

Project File Name and availability

File name: Ex_22_Diffusion_Fe-C_Moving_Boundary_Austenite_to_Ferrite.tcu

This example uses more than two elements enabling it to be available to users with a valid license.
Precipitation Calculator Examples

Examples 13 and 16 are available to all users. The other examples require a Precipitation Module (TC-PRISMA) license to calculate and plot results.

All examples use demonstration database packages included with your installation. You can open the examples from the main menu: File → Open Examples or Help → Open Examples.

Ex_13: Isothermal Precipitation of Al₃Sc

This example simulates the kinetics of precipitation of Al₃Sc from an FCC_A1 solution phase. The simulation results can be compared with experimental data collected from Marquis and Seidman¹ and Novotny and Ardell².

This example is available as a video tutorial on our website and YouTube channel.

Details and Plot Example

<table>
<thead>
<tr>
<th>System</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Database package</td>
<td>Demo: Aluminum-based alloys (ALDEMO, MALDEMO)</td>
</tr>
<tr>
<td>Elements</td>
<td>Al, Sc</td>
</tr>
<tr>
<td>Matrix phase</td>
<td>FCC_A1</td>
</tr>
<tr>
<td>Precipitate phases</td>
<td>AL3SC</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Conditions</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Composition</td>
<td>Al-0.18Sc Mole percent</td>
</tr>
<tr>
<td>Temperature</td>
<td>350° C</td>
</tr>
<tr>
<td>Simulation time</td>
<td>1.0E7 seconds</td>
</tr>
</tbody>
</table>

**Diffusion Module (DICTRA) Documentation**

<table>
<thead>
<tr>
<th>Nucleation sites</th>
<th>Bulk</th>
</tr>
</thead>
</table>

**Precipitate Phase Data Parameters**

<table>
<thead>
<tr>
<th>Interfacial energy</th>
<th>Calculated</th>
</tr>
</thead>
</table>

**Other**

<table>
<thead>
<tr>
<th>Calculation type</th>
<th>Isothermal</th>
</tr>
</thead>
<tbody>
<tr>
<td>File name</td>
<td>Ex_13_Precipitation_Al-Sc_AL3SC.tcu</td>
</tr>
</tbody>
</table>

**Plot Results**

--

**Ex_14: Stable and Metastable Carbides - Isothermal**

This example simulates the kinetics of precipitation of both stable and metastable carbides from ferrite phase. It demonstrates that metastable carbides (cementite, M7C3) may first emerge and then disappear and the stable phase (M23C6) prevails.
Details and Plot Example

This example uses the Equilibrium Calculator and a property diagram to determine how the phases change with temperature. We are interested in the carbide precipitation at 1053K where only the carbide M23C6 is stable according to the equilibrium calculation. The Precipitation Calculator is used to do an isothermal calculation of the three phases (cementite, M23C6 and M7C3) where cementite and M7C3 are metastable phases.

<table>
<thead>
<tr>
<th>System</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Database package</td>
<td>Demo: Steels and Fe-alloys (FEDEMO,MFEDEMO)</td>
</tr>
<tr>
<td>Elements</td>
<td>Fe, C, Cr</td>
</tr>
<tr>
<td>Matrix phase</td>
<td>BCC_A2</td>
</tr>
<tr>
<td>Precipitate phases</td>
<td>Cementite, M23C6 and M7C3</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Conditions</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Composition</td>
<td>Fe-0.1C-12Cr Mass percent</td>
</tr>
<tr>
<td>Temperature</td>
<td>1053 K</td>
</tr>
<tr>
<td>Simulation time</td>
<td>400 000 seconds</td>
</tr>
<tr>
<td>Nucleation sites</td>
<td>Grain boundaries</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Matrix Phase Data Parameters</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Grain radius</td>
<td>1.0E-4 m</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Precipitate Phase Data Parameters</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Interfacial energy</td>
<td>Cementite 0.167 J/m^2, M23C6 0.252 J/m^2, M7C3 0.282 J/m^2</td>
</tr>
</tbody>
</table>

Other

<table>
<thead>
<tr>
<th>Calculation type</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>File name</td>
<td>Ex_14_Precipitation_Fe-Cr_Cementite-M7C3-M23C6</td>
</tr>
</tbody>
</table>
**Ex_15: Stable and Metastable Carbides - TTT Diagram**

In this example, the kinetics of precipitation of both stable and metastable carbides is calculated from the ferrite phase. It demonstrates that metastable carbides may first emerge and then disappear and the stable phase prevails.

**Details and Plot Example**

This example uses the Equilibrium Calculator and a property diagram to determine how the phases change with temperature. Using this result, the Precipitation Calculator is used to do a TTT (Time-Temperature-Transformation) diagram calculation of the three phases (cementite, M23C6 and M7C3) at the grain boundaries.

**System**

<table>
<thead>
<tr>
<th>Database package</th>
<th>Demo: Steels and Fe-alloys (FEDEMO and MFDEMO)</th>
</tr>
</thead>
</table>
**Elements**  | Fe, C, Cr  
---|---  
**Matrix phase**  | BCC_A2  
**Precipitate phases**  | Cementite, M23C6 and M7C3  

**Conditions**  
**Composition**  | Fe-0.1C-12Cr Mass percent  
**Temperature**  | 500° to 800° C with 25°C steps  
**Max. simulation time**  | 1.0E8 seconds  
**Nucleation sites**  | Grain boundaries  

**Matrix Phase Data Parameters**  
**Grain radius**  | 1.0E-4 m  

**Precipitate Phase Data Parameters**  
**Interfacial energy**  | Cementite 0.167 J/m², M23C6 0.252 J/m², M7C3 0.282 J/m²  

**Other**  
**Calculation type**  | TTT diagram  
**Stop criterium**  | Volume fraction of phase is set to 0.0001  
**File name**  | Ex_15_Precipitation_Fe-Cr_TTT_Cementite-M7C3-M23C6
**Ex_16: Precipitation of Iron Carbon Cementite**

Simulate the kinetics of precipitation of carbides from a BCC Fe solution phase. This example is based on Wert (1949)\(^1\).

**Details and Plot Example**

This example uses two Experimental File Reader activities with the Precipitation Calculator and an isothermal calculation, to plot the volume fraction of the cementite phase.

<table>
<thead>
<tr>
<th>System</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database package</td>
</tr>
</tbody>
</table>

---

### Elements
- Fe, C

### Matrix phase
- BCC_A2

### Precipitate phase
- Cementite

### Conditions
<table>
<thead>
<tr>
<th>Composition</th>
<th>Fe-0.016C mass percent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temperature</td>
<td>102°C</td>
</tr>
<tr>
<td>Simulation time</td>
<td>600 000 seconds</td>
</tr>
<tr>
<td>Nucleation sites</td>
<td>Dislocations</td>
</tr>
</tbody>
</table>

### Matrix Phase Data Parameters
| Grain aspect ratio | 1.0 |

### Precipitate Phase Parameters
| Interfacial energy  | 0.24 J/m²   |
| Dislocation density | 1.5e11 m⁻³  |

### Other
| Calculation type     | Isothermal   |
| Growth rate model    | Advanced (on the Options tab) |
| File name            | Ex_16_Precipitation_Fe-C_Cementite |
Volume Fraction

Ex_17: Precipitation of $\gamma'$ in Ni Superalloys - Isothermal

This example simulates the kinetics of precipitation of $\gamma'$ phase from $\gamma$ phase. The simulation results can be compared with experimental data collected from Sudbrack et al.\textsuperscript{1}.

Details and Plot Examples

This example uses three Experimental File Reader activities with the Precipitation Calculator. It does an isothermal calculation to plot the volume fraction, mean radius and number density of the cementite phase.

DIS_FCC_A1 needs to be selected on the System Definer. Search the online help for **About Ordered Phases** in the *Precipitation Module (TC-PRISMA) User Guide* for details.

<table>
<thead>
<tr>
<th>System</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Database package</strong></td>
<td>Demo: Nickel-based Super Alloys (NIDEMO and MNIDEMO)</td>
</tr>
<tr>
<td><strong>Elements</strong></td>
<td>Ni, Al Cr</td>
</tr>
<tr>
<td><strong>Matrix phase</strong></td>
<td>DIS-FCC_A1 (see note above about how to select this phase)</td>
</tr>
<tr>
<td><strong>Precipitate phase</strong></td>
<td>FCC_L12#2</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Conditions</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Composition</strong></td>
<td>Ni-9.8Al-8.3Cr Mole percent</td>
</tr>
<tr>
<td><strong>Temperature</strong></td>
<td>800° C</td>
</tr>
<tr>
<td><strong>Simulation time</strong></td>
<td>1 000 000 seconds</td>
</tr>
<tr>
<td><strong>Nucleation sites</strong></td>
<td>Bulk</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Precipitate Phase Data Parameters</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Interfacial energy</strong></td>
<td>0.012 J/m²</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Other</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Calculation type</strong></td>
<td>Isothermal</td>
</tr>
<tr>
<td><strong>File name</strong></td>
<td>Ex_17_Precipitation_Ni-Al-Cr_Isothermal_Gamma-Gamma_prime</td>
</tr>
</tbody>
</table>
Volume Fraction

Graphical Mode Examples Guide | 32 of 39
Number Density

![Graphical Mode Examples Guide](image)
Mean Radius

![Graphical Mode Examples Guide](image)

Ex_18: Precipitation of $\gamma'$ in Ni Superalloys - Non-isothermal

This example simulates the kinetics of precipitation of $\gamma'$ phase from $\gamma$ phase in Ni-8Al-8Cr and Ni-10Al-10Cr at.% alloys during continuous cooling. The simulation results can be compared with experimental results from Rojhirunsakool et al.\(^1\).

Details and Plot Examples

In these examples the Separate multimodal PSD check box is selected on the Plot Render to plot the mean radius and size distributions of the two compositions.

Plotting the size distribution from the final simulation time of 1470 seconds, you can see there are several peaks, although these are not completely separated. Use the 'Separate

---

multimodal PSD' check box on the Plot Renderer to separate the peaks. Then adjust the Valley depth ratio setting to 0.05 to separate into two peaks as shown in the Ni-10Al-10Cr plot example. You can experiment with this setting to see how the size distribution evolves with time, for example, try entering several values as plot times '400 600 1470'.

DIS_FCC_A1 needs to be selected on the System Definer. Search the online help for About Ordered Phases in the Precipitation Module (TC-PRISMA) User Guide for details.

<table>
<thead>
<tr>
<th>System</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Database package</strong></td>
<td>Demo: Nickel-based Super Alloys (NIDEMO and MNIDEMO)</td>
</tr>
<tr>
<td><strong>Elements</strong></td>
<td>Ni, Al, Cr</td>
</tr>
<tr>
<td><strong>Matrix phase</strong></td>
<td>DIS_FCC_A1 (see note above about how to select this phase)</td>
</tr>
<tr>
<td><strong>Precipitate phase</strong></td>
<td>FCC_L12#2</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Conditions</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Composition (Ni-8Al-8Cr)</strong></td>
<td>Ni-8Al-8Cr Mole percent</td>
</tr>
<tr>
<td><strong>Composition (Ni-10Al-10Cr)</strong></td>
<td>Ni-10Al-10Cr Mole percent</td>
</tr>
<tr>
<td><strong>Temperature</strong></td>
<td>0.23 K/s cooling rate</td>
</tr>
<tr>
<td><strong>Simulation time</strong></td>
<td>1470 s (Ni-8Al-8Cr), 3300 s (Ni-10Al-10Cr)</td>
</tr>
<tr>
<td><strong>Nucleation sites</strong></td>
<td>Bulk</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Matrix Phase Data Parameters</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Mobility enhancement prefactor</strong></td>
<td>5.0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Precipitate Phase Data Parameters</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Interfacial energy</strong></td>
<td>0.023 J/m²</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Other</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Calculation type</strong></td>
<td>Non-isothermal</td>
</tr>
<tr>
<td><strong>Separate multimodal PSD for 8Al-8Cr</strong></td>
<td>On the Plot Renderer, the Valley depth ratio is set to 0.05 for both plots. The number of points is increased to 200 for an average radius plot.</td>
</tr>
<tr>
<td><strong>Separate multimodal PSD for 10Al-10Cr</strong></td>
<td>On the Plot Renderer, the Valley depth ratio is set to 0.18 for both plots.</td>
</tr>
<tr>
<td><strong>File name</strong></td>
<td>Ex_18_Precipitation_Ni-Al-Cr_Non-isothermal_Gamma-Gamma_prime</td>
</tr>
</tbody>
</table>
Mean Radius Ni-8Al-8Cr

![Graph of Mean Radius Ni-8Al-8Cr](image)

- Blue line: Mean radius of FCC.L12#2 (Buk) PSD 1
- Red line: Mean radius of FCC.L12#2 (Buk) PSD 2
Mean Radius Ni-10Al-10Cr

![Graphical representation of mean radius Ni-10Al-10Cr over time.](image)
Size Distribution (PSD) Ni-8Al-8Cr
Size Distribution (PSD) Ni-10Al-10Cr

![Size Distribution Graph](image-url)
About the Thermo-Calc Console Mode Examples

"About the Graphical Mode Examples" on page 2

There are many examples to examine and to help you learn Thermo-Calc in Console Mode.

Opening the Macro File

To open an example macro file for Thermo-Calc:

1. Open Thermo-Calc.
2. Confirm you are in Console Mode. If not, click the Switch to Console Mode button.
3. From the main menu, select File → Open Examples or Help → Open Examples. The Console Mode folder opens with the Thermo-Calc examples in separate folders.
4. In the folder, double-click the *.TCM file or click Open.
5. Follow the prompts in the Console window i.e. keep pressing <Enter> to run the macro and produce a plot in the Console Results window.

All the macro files and the outputs are also combined into one file that you can search and read. This is available as a PDF.

Each topic below has a brief description of the example and includes some or all of the commands used in the macros. As you progress through the examples, sometimes only new commands are highlighted.
<table>
<thead>
<tr>
<th>Topic</th>
<th>TCEX Examples included</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Examples of Binary Systems&quot; on the next page</td>
<td>1, 4, 10, 11, 13, 16, 18, 26, 34, 51</td>
</tr>
<tr>
<td>&quot;Examples Using Functions and Variables&quot; on page 19</td>
<td>2, 44</td>
</tr>
<tr>
<td>&quot;Examples of the Gibbs Energy System (GES) Module&quot; on page 22</td>
<td>31, 38, 39, 49, 52</td>
</tr>
<tr>
<td>&quot;Examples of Multicomponent Systems&quot; on page 17</td>
<td>6, 7, 47</td>
</tr>
<tr>
<td>&quot;Example using the PARROT and EDIT_EXPERIMENT Modules&quot; on page 27</td>
<td>36a</td>
</tr>
<tr>
<td>&quot;Pourbaix Module Examples&quot; on page 33</td>
<td>40, 53</td>
</tr>
<tr>
<td>&quot;Examples of Property and Potential Diagrams&quot; on page 16</td>
<td>8, 35</td>
</tr>
<tr>
<td>&quot;Examples of Scheil-Gulliver Calculations&quot; on page 25</td>
<td>15, 30a, 30b, 31, 48</td>
</tr>
<tr>
<td>&quot;Examples with Specialized Databases&quot; on page 31</td>
<td>20, 22, 25, 27, 29, 50</td>
</tr>
<tr>
<td>&quot;General Examples Using the Steel Database&quot; on page 13</td>
<td>9, 23, 28, 32, 37, 41</td>
</tr>
<tr>
<td>&quot;Example of the Tabulate Reaction (TAB) Module&quot; on page 29</td>
<td>12, 24</td>
</tr>
<tr>
<td>&quot;Examples of Ternary Systems&quot; on page 9</td>
<td>3, 5, 14, 17, 19a, 19b, 21, 33, 42, 43, 45, 46,</td>
</tr>
</tbody>
</table>
Examples of Binary Systems

The commands are described in the *Thermo-Calc Console Mode Command Reference*. All the links are to that guide (unless indicated otherwise), which is part of this documentation set. Or use the online help to navigate more easily.

All the macro files and the outputs are also combined into one file that you can search and read. This is available as a PDF.

tcx01 - Calculating the binary Fe-C phase diagram

This example calculates the binary Fe-C phase diagram using the BINARY module.

These commands are used:

<table>
<thead>
<tr>
<th>Command</th>
<th>Page</th>
<th>Command</th>
<th>Page</th>
<th>Command</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;BINARY_DIAGRAM Module&quot;</td>
<td>10</td>
<td>&quot;LIST_EQUILIBRIUM&quot;</td>
<td>209</td>
<td>&quot;LIST_STATUS&quot;</td>
<td>210</td>
</tr>
<tr>
<td>&quot;INFORMATION&quot;</td>
<td>5</td>
<td>&quot;LIST_CONDITIONS&quot;</td>
<td>209</td>
<td>&quot;CHANGE_STATUS&quot;</td>
<td>186</td>
</tr>
<tr>
<td>&quot;COMPUTE_EQUILIBRIUM&quot;</td>
<td>190</td>
<td>&quot;SET_DIAGRAM_AXIS&quot;</td>
<td>259</td>
<td>&quot;SET_TIELINE_STATUS&quot;</td>
<td>269</td>
</tr>
<tr>
<td>&quot;PLOT_DIAGRAM&quot;</td>
<td>253</td>
<td>&quot;SET_SCALING_STATUS&quot;</td>
<td>268</td>
<td>&quot;SET_LABEL_CURVE_OPTION&quot;</td>
<td>263</td>
</tr>
<tr>
<td>&quot;ADD_LABEL_TEXT&quot;</td>
<td>243</td>
<td>&quot;MODIFY_LABEL_TEXT&quot;</td>
<td>252</td>
<td>&quot;HELP&quot;</td>
<td>5</td>
</tr>
</tbody>
</table>

tcx04 - The Fe-Cr miscibility gap

This example calculates the miscibility gap in the Fe-Cr system.

These commands are used:

<table>
<thead>
<tr>
<th>Command</th>
<th>Page</th>
<th>Command</th>
<th>Page</th>
<th>Command</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;SWITCH_DATABASE&quot;</td>
<td>22</td>
<td>&quot;DEFINE_SYSTEM&quot;</td>
<td>15</td>
<td>&quot;REJECT&quot;</td>
<td>18</td>
</tr>
<tr>
<td>&quot;GET_DATA&quot;</td>
<td></td>
<td>&quot;AMEND_PHASE&quot;</td>
<td></td>
<td>&quot;LIST_STATUS&quot;</td>
<td>210</td>
</tr>
</tbody>
</table>
**tcex10 - How to avoid Cr2O3 clogging in a continuous casting process**

The example calculates an equilibrium with suspended or dormant phases and shows how to avoid Cr2O3 clogging in a continuous casting process.

This uses the SLAG database. A license is required to run the example.

The origin of this example is that a manufacturer wanted to increase the Cr content of a material from 18 to 25 weight percent but the continuous casting of this material was problematic because solid Cr2O3 was formed. Using Thermo-Calc to calculate the equilibria in the steel/slag system, a simple correction was found: modify the Mn or Si content to decrease the oxygen potential.

In Thermo-Calc, you can FIX a phase with zero amount to simulate how to avoid forming this phase. You then release one of the conditions, usually one of the compositions, and this composition is determined by the equilibrium calculation.

These commands are used:

1. "DEFINE_SYSTEM" on page 15
2. "AMEND_PHASE_DESCRIPTION" on page 93
3. "GET_DATA" on page 16
4. "SET_CONDITION" on page 220
5. "LIST_CONDITIONS" on page 209
6. "LIST_STATUS" on page 210
7. "CHANGE_STATUS" on page 186
8. "COMPUTE_EQUILIBRIUM" on page 190
9. "SET_NUMERICAL_LIMITS" on page 296
10. "LIST_EQUILIBRIUM" on page 209
11. "SET_REFERENCE_STATE" on page 224
12. "SHOW_VALUE" on page 227

**tcex11 - Oxidation of Cu2S with H2O/O2 gas mixture**

This example demonstrates the oxidation of Cu2S with H2O/O2 gas mixture. Thermo-Calc is
used to find the optimum O/H ratio (i.e. oxygen potential) as certain oxygen potential values can desulphurize Cu2S without forming copper oxides.

In Thermo-Calc, the problem reduces to perform equilibria calculations in a Cu-S-H-O system. The amounts of the components should be kept to correct ratio corresponding to Cu2S and H2O using a command `SET_INPUT_AMOUNTS` in POLY3. Initially, O/H = 0.5 is given. Optimum O/H ratio is calculated with the desired calculation conditions. For example, to simulate one phase disappearing, you can FIX the phase with zero amount.

These commands are of also of note and used in this example:

- "SET_NUMERICAL_LIMITS" on page 296
- "SETREFERENCE_STATE" on page 224
- "SHOW_VALUE" on page 227
**tcex13 - The binary Al-Ti phase diagram and its G curve**

This example calculates an Al-Ti binary phase diagram and G curve using the BINARY module.

These commands are of note and used in this example:

- "BINARY_DIAGRAM Module" on page 10
- "SET_ALL_START_VALUES" on page 217

**tcex16 - Second order transition of the Al-Fe system**

This example calculates the second order transition line in the Bcc field of the Al-Fe system.

This uses the SSOL database. A license is required to run the example.

These commands are of note and used in this example:

<table>
<thead>
<tr>
<th>Command</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;REJECT&quot;</td>
<td>18</td>
</tr>
<tr>
<td>&quot;RESTORE&quot;</td>
<td>20</td>
</tr>
<tr>
<td>&quot;ADVANCED_OPTIONS&quot;</td>
<td>174</td>
</tr>
<tr>
<td>&quot;SET_SCALING_STATUS&quot;</td>
<td>268</td>
</tr>
<tr>
<td>&quot;MAKE_EXPERIMENTAL_DATAFILE&quot;</td>
<td>252</td>
</tr>
<tr>
<td>&quot;DEFINE_SYSTEM&quot;</td>
<td>15</td>
</tr>
<tr>
<td>&quot;LIST_EQUILIBRIUM&quot;</td>
<td>209</td>
</tr>
<tr>
<td>&quot;APPEND_EXPERIMENTAL_DATA&quot;</td>
<td>245</td>
</tr>
<tr>
<td>&quot;STEP_WITH_OPTIONS&quot;</td>
<td>227</td>
</tr>
</tbody>
</table>

**tcex18 - A3 temperature of a steel**

This example calculates the A3 temperature of a steel and examines the influence of each alloying element on this temperature.

A3 temperature is the temperature where ferrite starts to form from austenite. You can easily read A3 from an Fe-C phase diagram. However, for complex multicomponent steels no simple diagram can be used. Using POLY, it is easy to find out the influence of each alloying element on the A3 temperature. This information is useful if you want to modify the compositions of a steel but keep A3 unchanged.

This uses the TCFE database. A license is required to run the example.

These commands are of note and used in this example:
tcex26 - The As-Ga phase diagram: Plotting the partial pressures of a gas species

This is an example of plotting the partial pressures of a gas species along the solubility lines in the As-Ga phase diagram. The calculation makes it possible to monitor the input gases to a process of depositing solid As-Ga.

These commands are of note and used in this example:

- "REJECT" on page 18
- "RESTORE" on page 20
- "SET_DIAGRAM_AXIS" on page 259
- "SET_SCALING_STATUS" on page 268
- "SET_AXIS_TEXT_STATUS" on page 256
- "SET_LABEL_CURVE_OPTION" on page 263

tcex34 - The Al-Zn phase diagram and its G curve

This example uses the BINARY module to calculate the phase diagram and G curves in the Al-Zn system.

tcex51 - Calculation of molar volume, thermal expansivity and density

This example uses the POLY3 module to calculate the molar volume, thermal expansivity and density of the FCC_A1, BCC_A2 LIQUID and liquid phases of C-Fe.

This uses the TCFE database. A license is required to run the example.
Examples of Ternary Systems

The commands are described in the *Thermo-Calc Console Mode Command Reference*. All the links are to that guide (unless indicated otherwise), which is part of this documentation set. Or use the online help to navigate more easily.

All the macro files and the outputs are also combined into one file that you can search and read. This is available as a PDF.

tcex03 - Calculating an isothermal section with the TERNARY module

This example calculates an isothermal section using the TERNARY module.

These commands are used:

- "TERNARY_DIAGRAM Module" on page 331
- "AMEND_PHASE_DESCRIPTION" on page 93
- "ADD_LABEL_TEXT" on page 243
- "PLOT_DIAGRAM" on page 253
- "SET_DIAGRAM_AXIS" on page 259
- "SET_DIAGRAM_TYPE" on page 261
- "SET_AXIS_TYPE" on page 257
- "SET_REFERENCE_STATE" on page 224
- "CHANGE_STATUS" on page 186
- "SET_SCALING_STATUS" on page 268


tcex05 - Calculating a vertical section in the Al-Cu-Si system

This example calculates a vertical section in the Al-Cu-Si system as well as a vertical section from Al to 30% Mg2Si.

In addition to various commands used in the previous examples, the "LIST_AXIS_VARIABLE" on page 208 command is used.

tcex14 - Variations in solidification of an Al-Mg-Si alloy

This example calculates the heat and heat capacity variations during solidification of an Al-Mg-Si alloy.

These commands are of note and used in this example:
"LIST_SYSTEM" on page 17
"LISTCONDITIONS" on page 209
"SET_AXIS_TEXT_STATUS" on page 256

**tcex17 - The pseudo-binary system - CaO-SiO2**

This example calculates the pseudo-binary system CaO-SiO2 using the Oxide Demo database.

The oxide demo (Oxdemo) database can be used both for pseudobinary systems like the one in this case, CaO-SiO2, or for full ternary systems like Ca-Fe-O.

These commands are of note and used in this example:

<table>
<thead>
<tr>
<th>Command</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;LIST_SYSTEM&quot;</td>
<td>17</td>
</tr>
<tr>
<td>&quot;REJECT&quot;</td>
<td>18</td>
</tr>
<tr>
<td>&quot;RESTORE&quot;</td>
<td>20</td>
</tr>
<tr>
<td>&quot;AMEND_PHASE_DESCRIPTION&quot;</td>
<td>93</td>
</tr>
<tr>
<td>&quot;LIST_STATUS&quot;</td>
<td>210</td>
</tr>
<tr>
<td>&quot;DEFINE_COMPONENTS&quot;</td>
<td>196</td>
</tr>
<tr>
<td>&quot;SET_CONDITION&quot;</td>
<td>220</td>
</tr>
<tr>
<td>&quot;COMPUTE_EQUILIBRIUM&quot;</td>
<td>190</td>
</tr>
<tr>
<td>&quot;LIST_EQUILIBRIUM&quot;</td>
<td>209</td>
</tr>
</tbody>
</table>

**tcex19a and tcex19b - Mapping of univariant equilibria with the liquid in Al-Cu-Si**

This example shows how to map univariant equilibria with the liquid in Al-Cu-Si.

- Part A. Step-by-step calculation using POLY.
- Part B. Using the TERNARY module, you can get the information on invariant reactions, such as temperature and compositions.

These commands are of note and used in these examples:

<table>
<thead>
<tr>
<th>Command</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;DEFINE_SYSTEM&quot;</td>
<td>15</td>
</tr>
<tr>
<td>&quot;GET_DATA&quot;</td>
<td>16</td>
</tr>
<tr>
<td>&quot;AMEND_PHASE_DESCRIPTION&quot;</td>
<td>93</td>
</tr>
<tr>
<td>&quot;SET_CONDITION&quot;</td>
<td>220</td>
</tr>
<tr>
<td>&quot;LIST_CONDITIONS&quot;</td>
<td>209</td>
</tr>
<tr>
<td>&quot;ADVANCED_OPTIONS&quot;</td>
<td>174</td>
</tr>
</tbody>
</table>
"SAVE_WORKSPACES" on page 54
"READ_WORKSPACES" on page 214
"MAKE_EXPERIMENTAL_DATAFILE" on page 252
"APPEND_EXPERIMENTAL_DATA" on page 245
"TERNARY_DIAGRAM Module" on page 331

**tcex21 - Calculating a ternary isotherm in Fe-Cr-Ni**

This example calculates a ternary isotherm in Fe-Cr-Ni with a user-defined database.

These commands are of note and used in this example:

- "DEFINE_SYSTEM" on page 15
- "GET_DATA" on page 16
- "SET_CONDITION" on page 220
- "SET_DIAGRAM_TYPE" on page 261

**tcex33 - An Fe-Cr-C isopleth**

This example is a benchmark calculation of an isopleth in the Fe-Cr-C system.

**tcex42 - Paraequilibrium calculation - Formation of Para-pearlite - Isopleth**

This example uses an Fe-Mn-C system at 2.5%Mn Mass u-fraction to show a paraequilibrium calculation where there is formation of para-pearlite. It is an isopleth calculation and shows the `STEP_WITH_OPTIONS` command using the PARAEQUILIBRIUM option.

- This uses the TCFE database. A license is required to run the example.

**tcex43 - Paraequilibrium calculation - Formation of Para-pearlite - Isothermal**

This example uses an Fe-Mn-C system at 700 C to show a paraequilibrium calculation where there is formation of para-pearlite. It is an isothermal calculation and shows the `STEP_WITH_OPTIONS` command using the PARAEQUILIBRIUM option.

This uses the TCFE database. A license is required to run the example.

**tcex45 - 3D-plot with the gamma volume in the Fe-Cr-C system**

This example calculates the gamma volume in the Fe-Cr-C system and plots it in 3D.

To view the generated file, `tcex45.wrl`, install a WRML (Wirtual Reality Modelling Language) viewer to the web browser. WRML viewers can be downloaded from various sites, e.g. [www.parallelgraphics.com](http://www.parallelgraphics.com) or [www.sim.no](http://www.sim.no).

The **"ADVANCED_OPTIONS" on page 174** (present phase option) command is of note and used in this example.

**tcex46 - 3D-plot with the liquidus surface of the Fe-Cr-C system**

This example calculates the liquidus surface of the Fe-Cr-C system and plots it in 3D.

The **"ADVANCED_OPTIONS" on page 174** (present phase option) command is of note and used in this example.

To view the generated file, `tcex46_tri.wrl` and `tcex46_sqrt`, install a WRML (Wirtual Reality Modelling Language) viewer to the web browser. WRML viewers can be downloaded from various sites, e.g. [www.parallelgraphics.com](http://www.parallelgraphics.com) or [www.sim.no](http://www.sim.no).

This uses the TCFE database. A license is required to run the example.
General Examples Using the Steel Database

The commands are described in the Thermo-Calc Console Mode Command Reference. All the links are to that guide (unless indicated otherwise), which is part of this documentation set. Or use the online help to navigate more easily.

All the macro files and the outputs are also combined into one file that you can search and read. This is available as a PDF.
**tcex09 - Calculating a dew point with the POLY3 module**

This is an example calculating the dew point in the POLY3 module. The "STEP_WITH_OPTIONS" on page 227 and "MAP" on page 212 commands are of note and used in this example.

**tcex23 - Calculating a paraequilibrium and the T0 temperature in a low alloyed steel**

This example calculates a paraequilibrium and the T0 temperature in a low alloyed steel.

This uses the TCFE database. A license is required to run the example.

**tcex28 - Pitting Resistance Equivalence (PRE) for a duplex stainless steel**

This example calculates the Pitting Resistance Equivalence (PRE) for a duplex stainless steel.

This uses the TCFE database. A license is required to run the example.

These commands are of note and used in this example:

- "REJECT" on page 18
- "RESTORE" on page 20
- "DEFINE_ELEMENTS" on page 14
- "AMEND_PHASE_DESCRIPTION" on page 93
- "EVALUATE_FUNCTIONS" on page 208
- "SET_START_CONSTITUTION" on page 226
- "COMPUTE_TRANSITION" on page 193

**tcex32 - Calculating oxide layers on steel**

This example calculates oxide layers on a steel and shows how to append databases.

This uses the TCFE and SSUB5 databases. These licenses are required to run the example.

These commands are of note and used in this example:

- "SET_START_CONSTITUTION" on page 226
- "SET_REFERENCE_STATE" on page 224
- "APPEND_DATABASE" on page 12

**tcex37 - Calculating an isothermal section in Console Mode**

This example shows how the command lines to enter to calculate an isothermal section using Console Mode and the POLY3 module.

**tcex41 - Calculating a solubility product**

Calculation of a solubility product. Shows the **STEP_WITH_OPTIONS** command using the T-ZERO option.

This uses the TCFE database. A license is required to run the example.

These commands are of note and used in this example:

- "DEFINE_ELEMENTS" on page 14
- "REINITIATE_PLOT_SETTINGS" on page 255
- "SET_DIAGRAM_AXIS" on page 259
Examples of Property and Potential Diagrams

The commands are described in the *Thermo-Calc Console Mode Command Reference*. All the links are to that guide (unless indicated otherwise), which is part of this documentation set. Or use the online help to navigate more easily.

All the macro files and the outputs are also combined into one file that you can search and read. This is available as a PDF.

Property Diagrams

tcx08 - Property diagrams for a high speed steel

This example shows how to calculate property diagrams for a high speed steel i.e. phase fraction plots, activity vs temperature, and so forth.

This uses the TCFE database. A license is required to run the example.

These commands are of note and used in this example:

- "DEFINE_DIAGRAM" on page 196
- "DEFINE_ELEMENTS" on page 14
- "AMEND_PHASE_DESCRIPTION" on page 93
- "REINITIATE_PLOT_SETTINGS" on page 255

Potential Diagram

tcx35 - Calculating a potential diagram

"About Potential Diagrams" on page 190 in the *Thermo-Calc User Guide*.

This example uses the POTENTIAL module to calculate a potential diagram. Note that there are no commands for this module, you just follow the prompts.
Examples of Multicomponent Systems

The commands are described in the *Thermo-Calc Console Mode Command Reference*. All the links are to that guide (unless indicated otherwise), which is part of this documentation set. Or use the online help to navigate more easily.

All the macro files and the outputs are also combined into one file that you can search and read. This is available as a PDF.

tcex06 - An isopleth in low alloyed Fe-Mn-Si-Cr-Ni-C steel

This example calculates a multicomponent phase diagram using the `DEFINE_MATERIAL` command in POLY and the TCFE steel database. The material contains 1.5 %Cr + 0.4 %Mn + 3.5 %Ni + 0.3 %Si and 1 %C (by weight). These conditions and the temperature are set by the `DEFINE_MATERIAL` command.

After the first equilibrium results, a phase diagram is calculated with one axis variable as temperature and the other as the carbon content.

This uses the TCFE database. A license is required to run the example.

tcex07 - Single equilibria in low alloyed Fe-Mn-Si-Cr-Ni-C steel

This example shows how to calculate a single equilibria in a low alloyed Fe-Mn-Si-Cr-Ni-C steel. There are two general ways to perform a single equilibrium calculation:

- Get data from a database, then in POLY use `SET_CONDITION` and `COMPUTE_EQUILIBRIUM`.
- Go directly to POLY and use `DEFINE_MATERIAL`.

The `COMPUTE_TRANSITION` command is also used to determine the temperature or composition where one phase forms or disappears. It is the same as the `CHANGE_STATUS` → `SET_CONDITION` → `COMPUTE_EQUILIBRIUM` sequence of commands.

A "STEP_WITH_OPTIONS" on page 227 command using the option `normal` is also used in addition to the other commands that should be becoming more familiar as you work through the examples.

This uses the TCFE database. A license is required to run the example.

tcex47 - 3D-quaternary plot with the gamma volume in the Fe-Cr-V-C system at 1373K

3D-quaternary diagram that calculates the gamma volume in the Fe-Cr-V-C system at
1373K.

To view the generated file, *tcex47.wrl*, install a WRML (Wirtual Reality Modelling Language) viewer to the web browser. WRML viewers can be downloaded from various sites, e.g. [www.parallelgraphics.com](http://www.parallelgraphics.com) or [www.sim.no](http://www.sim.no).
Examples Using Functions and Variables

The commands are described in the *Thermo-Calc Console Mode Command Reference*. All the links are to that guide (unless indicated otherwise), which is part of this documentation set. Or use the online help to navigate more easily.

All the macro files and the outputs are also combined into one file that you can search and read. This is available as a PDF.
**tcex02 - Plotting thermodynamic functions**

This example shows how to plot thermodynamic functions in unary, binary and ternary systems. It also involves working with partial derivatives and partial quantities.

This uses the SSOL database. A license is required to run the example.

These commands are used:

- "GOTO_MODULE" on page 4
- "GET_DATA" on page 16
- "SET_CONDITION" on page 220
- "SWITCH_DATABASE" on page 22
- "AMEND_PHASE_DESCRIPTION" on page 93
- "LIST_EQUILIBRIUM" on page 209
- "DEFINE_SYSTEM" on page 15
- "COMPUTE_EQUILIBRIUM" on page 190
- "SET_AXIS_VARIABLE" on page 218
- "SAVE_WORKSPACES" on page 54
- "STEP_WITH_OPTIONS" on page 227
- "SET_DIAGRAM_AXIS" on page 259
- "ENTER_SYMBOL" on page 247
- "PLOT_DIAGRAM" on page 253
- "SET_LABEL_CURVE_OPTION" on page 263
- "REJECT" on page 18
- "RESTORE" on page 20
- "LIST_SYSTEM" on page 17
- "LIST_STATUS" on page 210
- "CHANGE_STATUS" on page 186
- "SHOW_VALUE" on page 227
- "SET_INTERACTIVE" on page 295

**tcex44 - Exploring variables and functions**

This example uses variables and functions to predict properties e.g. proof strength for an austenitic stainless steel at elevated temperatures (20-550C). The example was created using an expression from Eliasson, J., & Sandström, R. (2000). Proof strength values for austenitic stainless steels at elevated temperatures. Steel Research, 71(6–7), 249–254. https://doi.org/10.1002/srin.200001224.

---

1
This uses the TCFE database. A license is required to run the example.
Examples of the Gibbs Energy System (GES) Module

The commands are described in the *Thermo-Calc Console Mode Command Reference*. All the links are to that guide (unless indicated otherwise), which is part of this documentation set. Or use the online help to navigate more easily.

All the macro files and the outputs are also combined into one file that you can search and read. This is available as a PDF.

tcx31 - Using the GES module to calculate CVM

Using the Gibbs energy system (GES) module, this example calculates the CVM and compares it with the sublattices of a fictitious A B system. You also learn how to overlay diagrams from two calculations.

These [GES commands](#) are of note and used in this example:

- "ENTER_ELEMENT" on page 101
- "ENTER_SPECIES" on page 112
- "ENTER_SYMBOL" on page 113
- "ENTER_PHASE" on page 110
- "ENTER_PARAMETER" on page 143
- "LIST_PHASE_DATA (from GIBBS)" on page 148


tcx38 - Calculating the Morral “rose”

This example uses the Gibbs energy system (GES) module to calculate the Morral rose, which are miscibility gaps.

These commands are of note and used in this example:

- "REINITIATE" on page 127
- "ENTER_ELEMENT" on page 101
- "AMEND_ELEMENT_DATA" on page 81
- "ENTER_PARAMETER" on page 143
- "ENTER_PHASE" on page 110


tcx39 - Calculating reversible Carnot cycles of a heat engine

This example shows how to calculate the reversible Carnot cycle of a heat engine using one
mole of an ideal gas with two fictitious species A and A2. The GES, POLY3 and POST modules are used.

One application of the Second Law is to the efficiencies of heat engines, pumps and refrigerators. Whenever there is a difference of temperature, work can be produced - the principle of heat engines. The Gibbs energy also enables the prediction of the maximum work that a process may achieve. The goal of this example is to help relate the results to different thermodynamic quantities.

These commands are of note and used in this example:

- "REINITIATE" on page 127
- "ENTER_SPECIES" on page 112
- "ENTER_PHASE" on page 110
- "ENTER_PARAMETER" on page 143
- "SET_PLOT_FORMAT" on page 264

**tcex49 - Quasichemical model using the Gibbs energy system (GES) module**

This example shows how to enter parameters for a FACT quasichemical liquid model and how to calculate the sulfur activity using the GIBBS_ENERGY_SYSTEM (GES) module commands.

![Solution Models in the GIBBS Module](https://example.com)

This uses the TCFE database. A license is required to run the example.

These commands are of note and used in this example:

- "ENTER_ELEMENT" on page 101
- "AMEND_ELEMENT_DATA" on page 81
- "ENTER_SPECIES" on page 112
- "ENTER_SYMBOL" on page 113
- "ENTER_PARAMETER" on page 143
- "SET_REFERENCE_STATE" on page 224
- "SHOW_VALUE" on page 227

**tcex52 - Changing the excess models for interaction parameters in a solution phase**

![Solution Models in the GIBBS Module](https://example.com)
This example shows how to change the excess models for binary and ternary interactions in a solution phase, either

- through direct interactive amendments of phase descriptions within the GIBBS
  ENERGY_SYSTEM (GES) module, or

- enforced by specific type-definitions given in a database file retrieved by the DATABASE_RETRIEVAL module (also called the TDB module).

For binary excess models, the example changes it from the default R-K model to a Mixed-Excess-Model. The phase has to be a substitutional phase in this case.

For ternary extrapolation models, the example changes it from the default R-K-M model to a Toop_Kohler model.
Examples of Scheil-Gulliver Calculations

The commands are described in the *Thermo-Calc Console Mode Command Reference*. All the links are to that guide (unless indicated otherwise), which is part of this documentation set. Or use the online help to navigate more easily.

All the macro files and the outputs are also combined into one file that you can search and read. This is available as a PDF.

tcex15 - Simulating the solidification of a Cr-Ni alloy with the SCHEIL module

This is an example of a solidification simulation of a Cr-Ni alloy. There is no back diffusion in the solid, i.e. Scheil-Gulliver model is used.

This uses the TCFE database. A license is required to run the example.

These commands are of note and used in this example:

<table>
<thead>
<tr>
<th>Command</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;START_WIZARD&quot;</td>
<td>297</td>
</tr>
<tr>
<td>&quot;COMPUTE_TRANSITION&quot;</td>
<td>193</td>
</tr>
<tr>
<td>&quot;ADD_INITI EQUILIBRIUM&quot;</td>
<td>166</td>
</tr>
<tr>
<td>&quot;ENTER_SYMBOL&quot;</td>
<td>247</td>
</tr>
<tr>
<td>&quot;ADVANCED_OPTIONS&quot;</td>
<td>174</td>
</tr>
<tr>
<td>&quot;STEP_WITH_OPTIONS&quot;</td>
<td>227</td>
</tr>
<tr>
<td>&quot;MAKE_EXPERIMENTAL_DATAFILE&quot;</td>
<td>252</td>
</tr>
<tr>
<td>&quot;CHANGE_STATUS&quot;</td>
<td>186</td>
</tr>
</tbody>
</table>

**tcex30a and 30b - Scheil calculation for an Al-4Mg-2Si-2Cu alloy**


These examples show two ways to do a Scheil calculation for an Al-4Mg-2Si-2Cu alloy. In part A, you use the POLY3 module and the STEP_WITH_OPTIONS command with an EVALUATE option. Then in part B you use the SCHEIL module commands to do the same thing.

**tcex31 - Using the GES module to calculate CVM**

Using the Gibbs energy system (GES) module, this example calculates the CVM and
compares it with the sublattices of a fictitious A B system. You also learn how to overlay diagrams from two calculations.

These GES commands are of note and used in this example:

- "ENTER_ELEMENT" on page 101
- "ENTER_SPECIES" on page 112
- "ENTER_SYMBOL" on page 113
- "ENTER_PHASE" on page 110
- "ENTER_PARAMETER" on page 143
- "LIST_PHASE_DATA (from GIBBS)" on page 148

**tcex48 - SCHEIL solidification with C back diffusion**

This is an example of Scheil solidification with C back diffusion in solid phases. The results are compared between a simple Scheil and equilibrium calculations. See "SCHEIL Module" on page 293 for a list of the commands for this module.
Example using the PARROT and EDIT_EXPERIMENT Modules

The commands are described in the *Thermo-Calc Console Mode Command Reference*. All the links are to that guide (unless indicated otherwise), which is part of this documentation set. Or use the online help to navigate more easily.

All the macro files and the outputs are also combined into one file that you can search and read. This is available as a PDF.

tcex36a - Using the PARROT and EDIT EXPERIMENTS modules

The example is divided into parts corresponding to the files in the `tcex36a` folder. It is recommended you read `tcex.36.readme` before continuing with this advanced exercise.

Also see the *Data Optimization User Guide*.

Each problem has "selected" experimental data. The example uses a fictitious binary A-B system where element A is BCC until it melts. Element B is BCC up to 1100 K and FCC above. There is a compound A2B stable in a limited temperature range.

- The creation of the "setup" file is described (`tcex36a.TCM`) where you enter the elements and phases into the Gibbs Energy System (GES) module
- The creation of the experimental data file is described (`tcex 36b.TCM`). When you run the TCEX36a macro, the contents of this macro file is automatically launched and the experimental data file created.
- The actual run in the PARROT module in order to obtain the result (`tcex 36cpd.TCM`)

There are many commands used in this advanced example (listed in alphabetical order):

<table>
<thead>
<tr>
<th>Command</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;ADVANCED_OPTIONS&quot;</td>
<td>174</td>
</tr>
<tr>
<td>&quot;AMEND_ELEMENT_DATA&quot;</td>
<td>81</td>
</tr>
<tr>
<td>&quot;AMEND_PHASE_DESCRIPTION&quot;</td>
<td>93</td>
</tr>
<tr>
<td>&quot;APPEND_EXPERIMENTAL_DATA&quot;</td>
<td>245</td>
</tr>
<tr>
<td>&quot;COMPILE_EXPERIMENTS&quot;</td>
<td>137</td>
</tr>
<tr>
<td>&quot;COMPUTE_ALL_EQUILIBRIA&quot;</td>
<td>37</td>
</tr>
<tr>
<td>Command</td>
<td>Page</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>&quot;CONTINUE_OPTIMIZATION&quot;</td>
<td>138</td>
</tr>
<tr>
<td>&quot;CREATE_NEW_EQUILIBRIUM&quot;</td>
<td>195</td>
</tr>
<tr>
<td>&quot;CREATE_NEW_STORE_FILE&quot;</td>
<td>139</td>
</tr>
<tr>
<td>&quot;DEFINE_COMPONENTS&quot;</td>
<td>196</td>
</tr>
<tr>
<td>&quot;EDIT_EXPERIMENTS&quot;</td>
<td>139</td>
</tr>
<tr>
<td>&quot;ENTER_PARAMETER&quot;</td>
<td>143</td>
</tr>
<tr>
<td>&quot;ENTER_PHASE&quot;</td>
<td>110</td>
</tr>
<tr>
<td>&quot;LABEL_DATA&quot;</td>
<td>48</td>
</tr>
<tr>
<td>&quot;LIST_ALL_VARIABLES&quot;</td>
<td>145</td>
</tr>
<tr>
<td>&quot;LIST_PHASE_DATA&quot;</td>
<td>122</td>
</tr>
<tr>
<td>&quot;LIST_RESULT&quot;</td>
<td>149</td>
</tr>
<tr>
<td>&quot;MACRO_FILE_OPEN&quot;</td>
<td>5</td>
</tr>
<tr>
<td>&quot;OPTIMIZE_VARIABLES&quot;</td>
<td>154</td>
</tr>
<tr>
<td>&quot;QUICK_EXPERIMENTAL_PLOT&quot;</td>
<td>254</td>
</tr>
<tr>
<td>&quot;READ_WORKSPACES&quot;</td>
<td>214</td>
</tr>
<tr>
<td>&quot;RESCALE_VARIABLES&quot;</td>
<td>156</td>
</tr>
<tr>
<td>&quot;SAVE_PARROT_WORKSPACES&quot;</td>
<td>156</td>
</tr>
<tr>
<td>&quot;SAVE_WORKSPACES&quot;</td>
<td>54</td>
</tr>
<tr>
<td>&quot;SELECT_EQUILIBRIUM&quot;</td>
<td>216</td>
</tr>
<tr>
<td>&quot;SET_ALL_START_VALUES&quot;</td>
<td>217</td>
</tr>
<tr>
<td>&quot;SET_ALTERNATE_CONDITION&quot;</td>
<td>57</td>
</tr>
<tr>
<td>&quot;SET_ALTERNATE_MODE&quot;</td>
<td>156</td>
</tr>
<tr>
<td>&quot;SET_FIX_VARIABLE&quot;</td>
<td>158</td>
</tr>
<tr>
<td>&quot;SET_OPTIMIZING_VARIABLE&quot;</td>
<td>159</td>
</tr>
<tr>
<td>&quot;SET_STORE_FILE&quot;</td>
<td>162</td>
</tr>
<tr>
<td>&quot;SET_WEIGHT&quot;</td>
<td>66</td>
</tr>
</tbody>
</table>
**Example of the Tabulate Reaction (TAB) Module**

The commands are described in the *Thermo-Calc Console Mode Command Reference*. All the links are to that guide (unless indicated otherwise), which is part of this documentation set. Or use the online help to navigate more easily.

![All the macro files and the outputs are also combined into one file that you can search and read. This is available as a PDF.](image)

**tcex12 - Tabulation of thermodynamic data for reactions**

This example shows a number of independent cases using the TABULATE_REACTION (TAB) module to tabulate thermodynamic data for reactions.

![This uses the SSUB database. A license is required to run the example.](image)

These commands are of note and used in this example:

<table>
<thead>
<tr>
<th>Command</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;TABULATE_REACTION&quot;</td>
<td>page 320</td>
</tr>
<tr>
<td>&quot;DEFINE_SPECIES&quot;</td>
<td>page 14</td>
</tr>
<tr>
<td>&quot;ENTER_FUNCTION&quot;</td>
<td>page 307</td>
</tr>
<tr>
<td>&quot;QUICK_EXPERIMENTAL_PLOT&quot;</td>
<td>page 254</td>
</tr>
<tr>
<td>&quot;SET_SCALING_STATUS&quot;</td>
<td>page 268</td>
</tr>
<tr>
<td>&quot;LIST_SUBSTANCES&quot;</td>
<td>page 310</td>
</tr>
<tr>
<td>&quot;TABULATE_SUBSTANCE&quot;</td>
<td>page 322</td>
</tr>
</tbody>
</table>

**tcex24 - Simulation of the silicon arc furnace using the REACTOR module**

This is a simple reactor model with output of gases at the top and output of condensed phases at the bottom. The gas phase from one segment flows to higher segments, 80% reacts in the first above, 15% in the second above and 5% in the third above.

The condensed phases flow downwards and all of it goes to the next lowest segment. Heat can be added at any module. The only way to specify the initial state of the reactants added to the reactor is to specify their heat content.

![This uses the SSUB database. A license is required to run the example.](image)

These commands are of note and used in this example:
<table>
<thead>
<tr>
<th>Example</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;DEFINE_SPECIES&quot;</td>
<td>14</td>
</tr>
<tr>
<td>&quot;CREATE_STAGE_BOXES&quot;</td>
<td>286</td>
</tr>
<tr>
<td>&quot;CREATE_DIVIDERS&quot;</td>
<td>285</td>
</tr>
<tr>
<td>&quot;CREATE_PIPES&quot;</td>
<td>285</td>
</tr>
<tr>
<td>&quot;START_SIMULATION&quot;</td>
<td>290</td>
</tr>
</tbody>
</table>
Examples with Specialized Databases

The commands are described in the *Thermo-Calc Console Mode Command Reference*. All the links are to that guide (unless indicated otherwise), which is part of this documentation set. Or use the online help to navigate more easily.

All the macro files and the outputs are also combined into one file that you can search and read. This is available as a PDF.

tcex20 - Adiabatic decompression in a geological system

This example calculates the adiabatic decompression in a geological system using the geochemical database (PGEO.TDB).

These commands are of note and used in this example:

<table>
<thead>
<tr>
<th>Command</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;DEFINE_SYSTEM&quot;</td>
<td>15</td>
</tr>
<tr>
<td>&quot;DEFINE_COMPONENTS&quot;</td>
<td>196</td>
</tr>
<tr>
<td>&quot;SET_INPUT_AMOUNTS&quot;</td>
<td>222</td>
</tr>
<tr>
<td>&quot;LIST_CONDITIONS&quot;</td>
<td>209</td>
</tr>
<tr>
<td>&quot;SET_CONDITION&quot;</td>
<td>220</td>
</tr>
<tr>
<td>&quot;SHOW_VALUE&quot;</td>
<td>227</td>
</tr>
</tbody>
</table>


tcex22 - Calculating an adiabatic flame temperature

This example examines a heat balance when C3H8 is burned in oxygen by calculating the adiabatic flame temperature.

This uses the SSUB database. A license is required to run the example.


tcex25 - Simulating the refinement of steel

This example is based on a typical steel refining process. Raw iron used to produce steel usually has high carbon and silicon content, which is why oxygen is blown into the furnace to burn off carbon. Lime (CaO) is added to form a slag with silica, and the slag can be removed. Alloying elements, such as Mn, Ni, Cr and V are added to produce the desired steel. Since the reaction between O and C increases the temperature, scrap iron is added in order to keep the temperature constant (it is assumed the furnace is isolated and no heat is lost to the environment).

This example simulates blowing oxygen into a liquid steel of one metric ton (1e6 grams) with 4 w/o C, 2 w/o Si and 1 w/o Mn. 100 moles of CaO (equivalent to 5.6 kg) is added.
Keeping the enthalpy constant is the way to simulate the isolation of the furnace. The oxygen reacts with carbon and increases the temperature. After blowing a certain amount of oxygen, scrap iron is added to keep the temperature constant.

This uses the SLAG database. A license is required to run the example.

**tce27 - Calculating chemical vapor depositions (CVD)**

This example calculates the chemical vapor deposition (CVD).

This uses the SSUB database. A license is required to run the example.

These commands are of note and used in this example:

- "DEFINE_COMPONENTS" on page 196
- "SET_CONDITION" on page 220
- "ADD_INITIAL_EQUILIBRIUM" on page 166
- "LIST_AXIS_VARIABLE" on page 208
- "LIST_INITIAL_EQUILIBRIA" on page 210

**tce29 - Calculating the speciation of a gas**

This example shows how to calculate the speciation of a gas.

This uses the SSUB database. A license is required to run the example.

These commands are of note and used in this example:

- "SET_INPUT_AMOUNTS" on page 222
- "LIST_CONDITIONS" on page 209
- "SET_CONDITION" on page 220

**tce50 - Quasichemical Model using the Database Retrieval (TDB) module**

This example shows the quasichemical model using the DATABASE_RETRIEVAL module (also called the TDB module).

The example replicates figures 3 and 4 from Kongoli, F., Pelton, A. D., and Dessureault, Y. (1998)\(^1\).

---

Pourbaix Module Examples

All the macro files and the outputs are also combined into one file that you can search and read. This is available as a PDF.

tcex40 - Using the POURBAIX Module
This is the first in a series of examples to demonstrate the advanced POURBAIX module calculations and graphical processing.

It is recommended you read the text file TCEX40-README.txt, which is located in the Extended subfolder.

Also see the Pourbaix Diagrams Educational Material Guide.

Example TCEX40 automatically calculates and plots a Pourbaix diagram for 0.001 m Fe in a 0.1 m NaCl aqueous solution at 25C and 1 bar. A so-called Pourbaix diagram is actually a phase diagram with independently-varied acidity (pH) and electropotential (Eh), for a heterogeneous interaction system at a certain bulk composition (that is by default always set as 1 kg of water dissolving a specified amount of metals and other solutes), under a defined temperature and pressure condition.

For details about the additional examples in the Extended folder, see "Pourbaix Module Examples" above.

tcex53 - Pourbaix diagram calculations for a heterogeneous interaction system

Also see the Pourbaix Diagrams Educational Material Guide.

This example uses the PAQ2 or PAQS2 databases to calculate some Pourbaix diagrams. The DATABASE_RETRIEVAL (TDB), GIBBS_ENERGY_SYSTEM (GES), POLY3, and POST modules are used for the Fe-X-H2O-NaCl heterogeneous interaction system, where X = Cr-Ni-Co.

**Step 1: Single-Point Calculations for H2O-NaCl system**

To demonstrate how to define the molality of NaCl in an aqueous-bearing heterogeneous interaction system.
**Step 2: Single-Point Calculations for Fe-X (X = Cr-Ni-Co) system**

To demonstrate how to define the initial amount of alloy in an aqueous-bearing heterogeneous interaction system. In this example, we are interested in only the BCC_A2 and FCC_A1 phases in the Fe-based alloy.

**Step 3: Single-Point Calculations for Fe-Cr-Ni-Co + H2O-NaCl system**

**Step 4: Pourbaix Diagram Mapping for Fe-Cr-Ni-Co + H2O-NaCl system - define the variables**

From the same mapping calculations you arrive at by the end of the example, you can plot more diagrams using a variety of X-Y axis variables.

For a list of pre-defined symbols, go to the end of the tce53.TCM macro file (open it in a text editor).

**Extended Information about TCEX40A and TCEX40E**

In order to be able to subsequently run the TCEX40B (Main Option 2), TCEX40C (Main Option 3) and TCEX40D (Main Option 4), which open the previously-saved POURBAIX-type calculation POLY3 file, the user should make four copies of the resulting POURBAIX.POLY3 as TCEX40A.POLY3, TCEX40B.POLY3, TCEX40C.POLY3 and TCEX40D.POLY3.

However, this has to be properly done outsides of the TCCS software after the TCEX40A is executed. The reason is that, if saving the POLY3 workspace of the POURBAIX calculation results in the POLY3-module monitor (through the command sequence "GO PLOY3" and "SAVE TCEX40A.POLY3 Y"), all the initial equilibrium points and the mapping/stepping calculation results will be lost, and parts of the POLY3 file structure (e.g., some definitions of the previously defined POURBAIX-type calculation system) will be destroyed. In principle, before executing any Main Option (for calculations and graphical processing), it is highly recommended that the user shall save/rename/copy the previously-generated POLY3 file as another POLY3 file. Only in this way, it can avoid destroying the previous-saved POURBAIX-type calculation results.

Under Windows DOS-session (outside TCCS):

- copy POURBAIX.POLY3 TCEX40A.POLY3 (or TCEX40E.POLY3)
- copy POURBAIX.POLY3 TCEX40B.POLY3
- copy POURBAIX.POLY3 TCEX40C.POLY3
copy POURBAIX.POLY3 TCEX40D.POLY3

or inside TCCS (under Windows NT/2000/XP, but not Windows 95/98/ME):

- @copy POURBAIX.POLY3 TCEX40A.POLY3 (or TCEX40E.POLY3)
- @copy POURBAIX.POLY3 TCEX40B.POLY3
- @copy POURBAIX.POLY3 TCEX40C.POLY3
- @copy POURBAIX.POLY3 TCEX40D.POLY3

Under Linux/UNIX platforms (outside TCCS):

- cp POURBAIX.poly3 TCEX40A.poly3 (or TCEX40E.poly3)
- cp POURBAIX.poly3 TCEX40B.poly3
- cp POURBAIX.poly3 TCEX40C.poly3
- cp POURBAIX.poly3 TCEX40D.poly3

**Example TCEX40**

- Using PAQ2 or PAQS2 database;
- For the Fe-H2O-NaCl heterogeneous interaction systems
- With the Main Option 1
- Using the Single-Database Option, i.e., retrieving data from the PAQ2 [TCS Public Aqueous Solution (SIT) Database, v2.4; using the SIT aqueous solution model] or PAQS2 [TCS Public Aqueous Solution Database, v2.4; using the Complete Revised HKF aqueous solution model]; both of which contain an AQUEOUS solution phase and REF_ELECTRODE phase (as a reference for electron in aqueous electrolyte systems), as well as some data for various solid phases (solution or stoichiometric) and gaseous mixture phase. The PAQ2 and PAQS2 are specially designed for demonstrations of calculations of the so-called Pourbaix diagrams (i.e., pH-Eh plots) and other types of phase diagrams or property diagrams in some aqueous-bearing multicomponent heterogeneous interaction systems within the limited chemical framework of Fe-Co-Cr-Ni-C-N-S-H2O-NaCl, via the Single-Database Option in the advanced POURBAIX module or through the normal TDB-GES-PLOY-POST routine.

To further run the following Main Options:

- Main Option 2 for plotting many other property diagrams of the calculated interaction system;
Main Option 3 for making another POURBAIX calculation of the same chemical system but under a different P-T-X condition;
Main Option 4 for making a POLY3 STEPPING calculation of the same chemical system but varied with only one independent variable;

** The Main Options 2, 3 and 4 are not illustrated in this TCEX40 example.

Five more examples (TCEX40A, TCEX40B, TCEX40C, TCEX40D and TCEX40E) are also provided to demonstrate various options and features in the POURBAIX module and to show more advanced applications of the TCAQ2 and AQS2 aqueous solution databases [in the Multiple-Database Option, i.e., with appended data from the SSOL5 and SSUB5 databases].

**Example TCEX40A**

- Option 1
  - Using the Single-Database Option, i.e., retrieving data from the PAQ2 [TCS Public Aqueous Solution (SIT) Database, v2.4; using the SIT aqueous solution model] or PAQS2 [TCS Public Aqueous Solution Database, v2.4; using the Complete Revised HKF aqueous solution model]; both of which contain an AQUEOUS solution phase and REF_-ELECTRODE phase (as a reference for electron in aqueous electrolyte systems), as well as some data for various solid phases (solution or stoichiometric) and gaseous mixture phase. The PAQ2 and PAQS2 are specially designed for calculations of the so-called Pourbaix diagrams (i.e., Eh-pH plots) and other types of diagrams in aqueous-bearing multicomponent heterogeneous interaction systems, via the Single-Database Option in the POURBAIX module or through the normal TDB-GES-PLOY-POST routine.
  - A POLY3 file called POURBAIX.POLY3 is automatically saved.
  - For the purposes of recalling this file in other Main Options (as in the TCEX40B, TCEX40C & TCEX40D), the POURBAIX.POLY3 has to be renamed or copied as another file name (in this particular example, as TCEX40A.POLY3, and TCEX40B.POLY3, TCEX40C.POLY3 & TCEX40D.POLY3). Note that the renaming or copying has to be done outside TCCS, otherwise the POLY3 file structure will be destroyed. However, under WindowsNT/2000/XP environments, one can use MS-DOS commands to do so, e.g., @copy POURBAIX.POLY3 TCEX40B.POLY3
  - The Main Option 1 also provides the opportunity to plot many property diagrams along phase boundaries, after the default Pourbaix diagram is generated and refined (not necessarily going through the Main Option 2).

**Example TCEX40B**

- Demonstration of the Main Option 2 Graphical Processing (by plotting more diagrams);
various options for refining a plotted diagram (including direct interactions with the POST Module); Graphical processing of related property diagrams.

- Reading a previously saved POURBAIX.POLY3 file (or renamed as another name, for instance, the TCEX40B.POLY3), and then plotting some property diagrams for the previously calculated system.
- The loaded POLY3 file will not be modified by this Main Option. It is thus not necessary to save the file in another name; however, it is still recommended that the user to copy the TCEX40A.POLY3 (or TCEX40E.POLY3) as TCEX40B.POLY3 before the Main Option 2 is executed in this particular example.

**Example TCEX40C**

- Demonstration of the Main Option 3 Calculation (by modifying T-P-X conditions); graphical processing of a Pourbaix diagram.
- Reading a previously saved POURBAIX.POLY3 file (or renamed as another name, for instance, the TCEX40C.POLY3), and then making another POURBAIX-type calculation and graphical processing of a new Pourbaix diagram for the same chemical system but under a different P-T-X condition.
- The loaded POLY3 file will be rewritten according to the T-P-X settings in the new POURBAIX-type calculation. It is thus recommended to save the file in a new name outside of TCCS before this Main Option is proceeded (in this particular example, the TCEX40A.POLY3 is copied to TCEX40C.POLY3).
- The Main Option 3 also provides the opportunity to plot many property diagrams along phase boundaries, after the default Pourbaix diagram is generated and refined (not necessarily going through the Main Option 2).

**Example TCEX40D**

- Demonstration of the Main Option 4 Calculation (by utilizing various stepping variables); graphical processing of related property diagrams.
- Reading a previously saved POURBAIX.POLY3 file (or renamed as another name, for instance, the TCEX40D.POLY3), and then making some normal POLY3 STEPPING CALCULATIONs.
- The loaded POLY3 file will be rewritten according to the T-P-X and stepping variable settings in the stepping calculation. It is thus recommended to save the file in a new file name outside of TCCS before this Main Option is proceeded (in this particular example, the TCEX40A.POLY3 is copied to TCEX40D.POLY3).
- The resulting POLY3 file (in this example, TCEX40D.POLY3) can be subsequently called
by a Main Option 2 for plotting more property diagrams, or by another Main Option 4 for making other stepping calculations.

- The Main Option 4 also provides the opportunity to plot many property diagrams after the default Pourbaix diagram is generated and refined (not necessarily going through the Main Option 2).
- Exploration of the possibility of modifying the definitions for some desired system-components, through the direct and internal POURBAIX-POLY3 intersection, for a STEPPING (and/or MAPPING) calculation inside the POURBAIX Module.

**Example TCEX40E**

- Demonstration of the Main Option 1 Calculation with the Multiple-Database Option; graphical processing of a Pourbaix diagram.

  For a more complex application than in Example 40A.

  This example requires licenses to three types of commercial Thermo-Calc databases otherwise it cannot be run, i.e.,

  - A: TCAQ2 (TCS Aqueous Solution Database, v2.5; SIT model) or AQS2 (TGG Aqueous Solution Database, v2.5; HKF model);
  - B: SSUB4 (SGTE Pure Substances Database, v4) or TCMP2 (TCS Materials Processing Database, v2);
  - C: SSOL4 (SGTE Alloy Solutions Database, v4) or TCFE6 (TCS Steels/Fe-Alloys Database, v6) or ALIKE.

- This particular example uses the multiple-database combination of TCAQ2+SSUB4+SSOL4; among them, TCAQ2 database contains only an AQUEOUS solution phase (using the SIT model) and REF_ELECTRODE phase (as a reference state for electron in aqueous electrolyte systems), SSUB4 database is appended for the GASEous mixture phase and some pure solid phases (so-called secondary phases formed during aqueous-involving interaction processes), and SSOL database is also appended for various solid solution phases.

- A POLY3 file called POURBAIX.POLY3 is automatically saved. By reading this POURBAIX.POLY3 file (or renamed as another name), one can further run the following Main Options: Main Option 2 for plotting many other property diagrams of the calculated interaction system; Main Option 3 for making another POURBAIX calculation of the same chemical system but under a different P-T-X condition; Main Option 4 for making a POLY3 STEPPING calculation of the same chemical system but varied with only one independent variable; The Main Options 2, 3 and 4 are illustrated in the
TCEX40B, TCEX40C and TCEX40D examples.

- For the purposes of recalling this file in other Main Options (as in the TCEX40B, TCEX40C & TCEX40D), the POURBAIX.POLY3 has to be renamed or copied as another file name (in this particular example, as TCEX40A.POLY3, and TCEX40B.POLY3, TCEX40C.POLY3 & TCEX40D.POLY3). Note that the renaming or copying has to be done outside TCCS, otherwise the POLY3 file structure will be destroyed. However, under Windows environments, one can use MS-DOS commands to do so, e.g., @copy POURBAIX.POLY3 TCEX40B.POLY3

- The Main Option 1 also provides the opportunity to plot many property diagrams along phase boundaries, after the default Pourbaix diagram is generated and refined (not necessarily going through the Main Option 2).

- The POURBAIX module inside the TCCS software also accepts the AQS2 aqueous solution database (using the complete Revised HKF model) in the Multiple-Database Option, in addition to the TCAQ2 aqueous solution database (using the SIT model).

**Example TCEX53**

- Using PAQ2 or PAQS2 database; for the Fe-X-H2O-NaCl heterogeneous interaction systems (X = Cr-Ni-Co)

Note: The PAQ2 (TCS Public Aqueous Solution (SIT) Database, v2.4; using the SIT aqueous solution model) or PAQS2 (TCS Public Aqueous Solution Database, v2.4; using the Complete Revised HKF aqueous solution model) contains an AQUEOUS solution phase and REF_ELECTRODE phase (as a reference for electron in aqueous electrolyte systems), as well as some data for various solid phases (solution or stoichiometric) and gaseous mixture phase. Therefore, it can be used, via the Single-Database Option in the POURBAIX module or through the normal TDB-GES-PLOY-POST routine, for calculations of the so-called Pourbaix diagrams (i.e., pH-Eh plots) and other types of diagrams in aqueous-bearing multicomponent heterogeneous interaction systems.

Note: The initial bulk composition of Fe-based alloy in this demonstrating calculation is just preliminarily assigned, in which the BCC_A2 and/or FCC_A1 solution phase(s) are considered as of primarily interest. For practical calculations, one shall have more precise inputs for the initial bulk compositions of alloys.
Thermo-Calc Console Mode Command Reference

Thermo-Calc Version 2017a
Introduction to the Command Reference

In this section:

About the Console Command Reference .......................................................... 2
Thermo-Calc Console Mode File Types .......................................................... 2
About the Console Command Reference

This command reference is for Console Mode users of Thermo-Calc software. This guide describes the function and syntax of the commands available in the Thermo-Calc modules.

If you have the Diffusion Module (DICTRA) also see the Diffusion Module (DICTRA) Command Reference found in the Diffusion Module (DICTRA) Documentation Set PDF.

The commands available in all or most modules are described in "General Commands" on page 3.

The next topics are listed in alphabetical order based on the module names, then in each subtopic, the module commands.

Abbreviations Used in this Guide

- For the prompts, Y stands for Yes and N stands for No.
- TC is for Thermo-Calc. For example, default file names often start with tc.ini.

Thermo-Calc Console Mode File Types

In Console Mode, Thermo-Calc uses different kinds of files, including:

- Log Files (*.LOG)
- Macro Files (*.TCM or *.LOG)
- Workspace Files in POLY (*.POLY3), GIBBS module (*.GES5), and the PARROT module (*.PAR and *.POP).

For links to more information about this topic go to "Log, Macro and Workspace Files" on page 154 in the Thermo-Calc User Guide.

If you are working in Console Mode File Formats in the Diffusion Module (DICTRA) User Guide.
General Commands

In this section:

- BACK .................................................................................................................. 4
- EXIT .................................................................................................................. 4
- GOTO_MODULE ................................................................................................. 4
- HELP (? and ??) ............................................................................................... 4
- HELP ................................................................................................................. 5
- INFORMATION ................................................................................................. 5
- MACRO_FILE_OPEN .......................................................................................... 5
- SET_INTERACTIVE ............................................................................................ 8
BACK

Also see "GOTO_MODULE" below.

Syntax

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BACK</td>
<td>Switch control back to the most recent module. Going from the POST module (post-processor), BACK goes only to the TAB or POLY module (from where the POST module is entered).</td>
</tr>
</tbody>
</table>

EXIT

Syntax

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EXIT</td>
<td>Exit the program and return to the operating system. Use a save command before exiting otherwise all data and results are lost (in either the GIBBS, POLY, PARROT or REACTOR module).</td>
</tr>
</tbody>
</table>

GOTO_MODULE

Switch between modules. The name of the module must be typed. To get a list of available modules, press the <Enter> key.

Syntax

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GOTO_MODULE</td>
<td></td>
</tr>
</tbody>
</table>

Prompt

| Module name: <Module name> |

If the <Enter> key is pressed without typing a unique module name (or typing a ? mark) it prompts for the MODULE_NAME and lists the available modules.

HELP (? and ??)

Gives text help about the current prompt (whether this is the prompt of a module, or a prompt that requests you to specify the value of some parameter).

Syntax

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>? OR ??</td>
<td>For some commands and prompts, more detailed help is given when two ?? are entered.</td>
</tr>
</tbody>
</table>
**HELP**

Lists the available commands or explains a specified command. Specifying a unique command displays an explanation on screen. Typing a command abbreviation that is not unique lists all matching commands. Get the command information by typing a unique abbreviation or the complete command name.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>HELP</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Command: &lt;Command name&gt;</td>
</tr>
</tbody>
</table>

*Command name* is the name of the command (one of the-module commands) to get help.

If the <Enter> key is pressed without typing a command name, then all the available commands are listed.

**INFORMATION**

Get basic information about topics related to the module you are in.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>INFORMATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Which subject /Purpose/: &lt;Topic name&gt;</td>
</tr>
</tbody>
</table>

Specify a Subject (or its abbreviation as long as it is unique). Enter a question mark ? for a list of topics.

**MACRO_FILE_OPEN**

The macro file functionality is a way to predefined sequences of Thermo-Calc commands stored in a macro file (a basic text file usually with the default extension TCM for the Thermo-Calc Console Mode or DCM for DICTRA module) and then executing all of the sequences using this command (preceded by the macro file name). This command can be used within various modules (i.e. the SYS, POLY, PARROT and TAB modules in the Thermo-Calc (Console Mode) software; SYS, POLY, PARROT and DICTRA_Monitor).
**Syntax**

MACRO_FILE_OPEN

```markdown
<Name of a macro file *.tcm>
```

An *Open* window displays to specify the filename of the macro file (*.TCM) with the macro command, so that the path (in the *Look in* field) and *File name* can be specified.

The *Files of type* *.TCM* for Thermo-Calc (Console Mode) calculations and *.DCM* for DICTRA simulations, cannot be changed. Click *Open* or *Cancel* to continue.

If the macro file contains commands to set *.LOG* files, to save or read GIBBS, POLY or PARROT workspaces, switch user databases, compile experiments (from existing *.POP* files), create new *.PAR* files, append *.EXP* files, plot or dump diagrams, etc., a window (e.g. Save, Open, Print, etc.) displays on screen. If required, these windows can be avoided by issuing the file names (preferably with file-type extensions; if the files are not in the current working area where the macro is located, the appropriate and complete paths of the files should also be specified) and sometimes with the required options after the corresponding commands or parameters/options. For details, see the related commands and modules.

When using a macro file that intended to plot graphs on screen, but the command "SET_PLOT_FORMAT" on page 264 is used to alter the plotting environment from the default value, it is important to first use the command SET_PLOT_FORMAT again to change back to the default value.

---

See example tcex12 in the Thermo-Calc Console Mode Examples Guide.

This is useful when the same or similar calculations are made frequently with small changes [in terms of system definitions, data manipulations, conditions (for single points, stepping or mapping calculations), plotting settings, etc.). For example, use this feature when calculating phase/property diagrams during an assessment of thermodynamic data.

A macro file can be automatically generated by the Thermo-Calc (Console Mode) software, if in the SYS module the "SET_LOG_FILE" on page 303 command is used and a *.LOG* file name is given before any other SYS, DATA, TAB, GIBBS, POLY, POST, PARROT, or ED-EXP command or any special-module command (e.g. BIN, TERN, POTENTIAL, SCHEIL, POURBAIX, or REACTION). Such a *.LOG* file generated from the Thermo-Calc (Console Mode) software is a textual file, and using a textual editor (such as Notepad, WordPad, PFE, Emacs, vi, etc.) it can be edited, for example, by taking away unnecessary command lines, modifying some commands, settings and definitions, adding some pausing points, adding helpful commenting lines beginning with @@ signs, and so forth. Then save it as a macro file with the standard file extension TCM.
Experienced users can also write/edit an appropriate macro file for calculations/simulations, using any basic textual editor outside the Thermo-Calc program.

All commands can be used in a macro file. The file must be terminated with EXIT or be interrupted with SET_INTERACTIVE.

Within a macro file you can use comment-lines (for describing the problems and for explaining commands and inputs/outputs), which should always start with the @@ signs in the beginning of each comment-line. Such comment-lines help to document the macro file, while these are not considered as command lines and thus do not affect the proceeding of all the normal commands in modules of the Console Mode when the file is called by the Thermo-Calc Console Mode software.

You can put multiple-line comment-blocks in a macro file between the @ (" and @") signs. The former sign indicates where the comment begins and the latter sign indicates where the comment ends. A comment-block begins from a line started with the begin comment sign @ (and ends with the finish comment sign @); all the lines written in between are ignored, and the line started with @) is also ignored.

Another use for a macro file is to allow you to interact at some specific points, using the “@?” sign starting a text line (note that the text describing the expected user-specification/input should be written as a continuous string without any empty space), for user’s on-time specifications of arguments/parameters or inputs of parameter-values that are requested by a certain command. The macro temporally stops at the “@?” sign, prompt on screen the text given after “@?”, and waits for the specified argument/parameter/value. The Thermo-Calc (Console Mode) software then uses specified argument/parameter/value as the input(s) for the associated command. For example, you can input the values of lower and higher temperature limits for the second axis-variable as follows:

```
GO POLY-3
SET-AXIS-VAR 2 T @?Low-temperature-limit:
@?High-temperature-limit:
```

You can have macro-variables denoted by the signs of @#n (for definition) and ##n (for usage); and up to nine variables inside a single macro file. Such a macro-variable can be assigned with its desired value, as for example:

```
@#3First-element?
```

This writes the text (note that the text describing the expected user specification/input is written as a continuous string without any empty spaces) after the “@#3” sign as prompted on screen and then wait for a specification. The input is assigned to the macro-variable ##3, which is directly called in different parts within the current macro file.

For example, the content of the macro-variable ##3 is inserted in the command:

```
DEFINE-SYSTEM ##3
```
It is also useful in more complicated commands, such as:

```
SET AXIS VAR 1 x(#3) 0 1,,,
```

This command sets the mole fraction of macro variable 3 as axis 1.

A macro file can have any number of pauses at the @& signs, for the purpose of checking the details/results of executing certain commands when running the macro file. However, you can also prevent the Thermo-Calc (Console Mode) software from temporarily stopping at any pause by typing any character (except for the Y character for confirming a Yes answer to a command prompt) after specifying the name of a macro file.

A macro file can have a maximum of five nested levels, i.e. a macro file can call another macro file, and if one sub-level macro is terminated by the command it resumes at the next command in the previous macro. If it is terminated by end-of-file, the Thermo-Calc (Console Mode) software stops.

This feature is especially useful for alloy design that requires many (hundreds) of calculations/simulations on similar material system/processes (specified in many different but appropriately-documented macro files that are organized in up to five levels) during a certain period of time (e.g. in an evening), you can run the main macro (on the top level) at a certain time (e.g. before leaving the office) and afterwards (e.g. next morning) you can systematically and efficiently check/compare/analyse the results (saved as graphical files, and/or EXP, TXT, XLS... files).

By adding the SYS command "SET_ECHO" on page 302 at the beginning of a macro file (or in the primary macro file on the top level if any sub-level(s) of macro files are used), it is useful to automatically display the complete/detailed meaning of various commands in all the sequential operations in the software, all enforced according to the macro file(s).

**SET_INTERACTIVE**

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_INTERACTIVE</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Resets the input and output units to the initial values, i.e. keyboard and screen. Add this as the last command to the macro files.</td>
</tr>
</tbody>
</table>
BINARY_DIAGRAM Commands

In this section:

- BINARY_DIAGRAM Module

10
**BINARY_DIAGRAM Module**

The BINARY_DIAGRAM module (short name, the BIN module) enables you to quickly calculate a simple binary phase diagram. Access to specific databases designed for BIN, such as TCBIN, is required.

To enter the module, at the SYS prompt type `GOTO_MODULE BINARY`. There are no other commands for this module. Follow the prompts to plot a diagram.

Also see the Graphical Mode equivalent to this command, *"Binary Calculator" on page 131* in the *Thermo-Calc User Guide*.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>BINARY_DIAGRAM</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompts</td>
<td>Database: /TCBIN/</td>
</tr>
<tr>
<td></td>
<td>First element</td>
</tr>
<tr>
<td></td>
<td>Second element</td>
</tr>
<tr>
<td></td>
<td>Phase diagram, Phase fraction (FE), G- OR A-curves (G/A): /Phase_Diagram/</td>
</tr>
</tbody>
</table>
Database Commands

These commands are related to the DATABASE_RETRIEVAL module, which is also known as the TDB module.

See example tce50 in the Thermo-Calc Console Mode Examples Guide.

Search the online help or see in the Thermo-Calc User Guide for step-by-step instructions to define a system.

In this section:

- AMEND_SELECTION .......................................................... 12
- APPEND_DATABASE ......................................................... 12
- DATABASE_INFORMATION .................................................. 14
- DEFINE_ELEMENTS ......................................................... 14
- DEFINE_SPECIES .......................................................... 14
- DEFINE_SYSTEM ............................................................ 15
- GET_DATA ......................................................................... 16
- LIST_DATABASE .............................................................. 16
- LIST_SYSTEM ................................................................. 17
- NEW_DIRECTORY_FILE ...................................................... 17
- REJECT ............................................................................. 18
- RESTORE .......................................................................... 20
- SET_AUTO_APPEND_DATABASE ........................................... 21
- SWITCH_DATABASE ......................................................... 22
AMEND_SELECTION

This command is for the DATABASE_RETRIEVAL module (also called TDB module).

Use this command after defining the elements, species or the system (with the commands "DEFINE_ELEMENTS" on page 14, "DEFINE_SPECIES" on page 14, or "DEFINE_SYSTEM" on page 15). The prompts allow changes to the predefined system. By answering Y or N, each of the selected elements, species or phases can be accepted or rejected (although this is not the case for the constituents or the entire system).

<table>
<thead>
<tr>
<th>Syntax</th>
<th>AMEND_SELECTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Keep &lt;Name1&gt; No/Quit /Yes/</td>
</tr>
<tr>
<td></td>
<td>Keep &lt;Name2&gt; No/Quit /Yes/</td>
</tr>
<tr>
<td>Options</td>
<td>Keyword-- Elements/Species/Phases name&amp;</td>
</tr>
<tr>
<td></td>
<td>Names of the pre-defined or pre-selected elements/species/phases</td>
</tr>
</tbody>
</table>

APPEND_DATABASE

This command is for the DATABASE_RETRIEVAL module (also called TDB module).

Append data from a file or additional database to the current set of data already read from another database. Data already read from another database and stored in the Gibbs energy system is kept in the GESS workspace.

This command also enters all additional parameters (phase constituents, G0 and interaction parameters, etc.) to already existing phases, and all existing parameters (phase constituents, excess model, G0 and interaction parameters, etc.) in the phase are replaced with the values retrieved from the appending database.

The command is equivalent to the SWITCH_DATABASE USER command sequence. It is also similar to "SWITCH_DATABASE" on page 22, but does not reinitialize the DATA module and GIBBS workspace.

All the directly connected databases as predefined by the original database initiation file (TC_INITD.TDB file in the /DATA/ area for Windows environments, or the initd.tdb file in the \data\ area for Linux), or by a user-specified database initiation file after using "NEW_DIRECTORY_FILE" on page 17, are listed after pressing <Enter> without giving any argument. You can supply your own database by giving the argument USER, the database name and the correct path if it is not located in the current working directory.
After the command is executed for the first time, the TDB_XYZ: prompt (XYZ stands for the name of the primary switched database) is changed to the APP: prompt to go to more commands related to appending data.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>APPEND_DATABASE</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Prompt</strong></td>
<td>Use one of these databases</td>
</tr>
<tr>
<td></td>
<td>PURE = SGTE pure element database</td>
</tr>
<tr>
<td></td>
<td>SSUB = SGTE substance database 1997</td>
</tr>
<tr>
<td></td>
<td>User = User-defined database</td>
</tr>
<tr>
<td></td>
<td>Database name /XYZ/: &lt;Additional database name&gt;</td>
</tr>
<tr>
<td><strong>Options</strong></td>
<td>Additional database name</td>
</tr>
<tr>
<td></td>
<td>The name of an existing database or a USER database definition file (**setup.TDB) that corresponds to the appending database.</td>
</tr>
<tr>
<td><strong>Notes</strong></td>
<td>If a USER database name or its path is not given on the same line of the APPEND_DATABASE command, or if the name or path is incomplete or incorrect, an Open window displays to open an appropriate database-setup. You can then open the USER database, or can cancel the open session; in the latter case, the program lists all predefined databases in the installation area, and you can select one of these or proceed with the USER option again for appending a desired database.</td>
</tr>
<tr>
<td></td>
<td>When this command is used in a macro (*.TCM) file, if the USER option is selected, the database setup file name (**setup.TDB) containing the setup definitions of the USER database, and its correct path, are required.</td>
</tr>
<tr>
<td></td>
<td>In Linux, the file name of a USER database, or one of the predefined names, can be used under the prompt FILENAME: This is a valid file name for the USER database definition file (**setup.tdb) or a predefined database name, with the correct path. The default file name extension is .tdb.</td>
</tr>
<tr>
<td></td>
<td>This command can be called more than once if appending two or more databases to the primary switched database.</td>
</tr>
<tr>
<td></td>
<td>After this command, the commands to define a system (in terms of either elements or species), to reject/restore phases or species, and retrieve data must be repeated; however, the second keywords and parameter values might have to be different from the previous ones.</td>
</tr>
</tbody>
</table>
DATABASE_INFORMATION

This command is for the DATABASE_RETRIEVAL module (also called TDB module).

<table>
<thead>
<tr>
<th>Syntax</th>
<th>DATABASE_INFORMATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>A short description of the current database is normally given by typing this command.</td>
</tr>
<tr>
<td></td>
<td>This can include information on covered systems, used models, valid ranges for parameters in temperature and composition, major applications, and so on.</td>
</tr>
</tbody>
</table>

DEFINE_ELEMENTS

This command is for the DATABASE_RETRIEVAL module (also called TDB module).

Define the system in terms of elements. All possible species that can be formed by the given elements are retrieved from the database. The names of elements must be separated with a space or comma. It is possible to use a wildcard * after a common part of element names so that all the elements, which start with that common part and are available in the currently switched or appending database, are defined in the system. Up to 40 elements can be defined into a single system.

Also see "Defining a System in Console Mode" on page 160 in the Thermo-Calc User Guide for step-by-step instructions to define a system with this command.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>DEFINE_ELEMENTS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Element &amp; &lt;Element1, Element2, …&gt;</td>
</tr>
<tr>
<td></td>
<td>A list of elements to be defined into the system.</td>
</tr>
</tbody>
</table>

When appending database(s), this command, or "DEFINE_SPECIES" below or "DEFINE_SYSTEM" on the next page must be repeated with the same or similar elements as defined in the first switched database.

DEFINE_SPECIES

This command is for the DATABASE_RETRIEVAL module (also called TDB module).
Define the system in terms of species. Only those species given are retrieved. The different names of species must be separated with a space or comma. It is possible to use a wildcard * after a common part of species names so that all the species, which start with that common part and are available in the currently switched or appending database, are defined in the system. Up to 1000 species can be defined in a single system.

Also see "Defining a System in Console Mode" on page 160 in the Thermo-Calc User Guide.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>DEFINE_SPECIES</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Species &amp; &lt;Species1, Species2, ...&gt;</td>
</tr>
<tr>
<td></td>
<td>A list of species to be defined in the system.</td>
</tr>
</tbody>
</table>

When appending database(s), this command, "DEFINE_ELEMENTS" on the previous page or "DEFINE_SPECIES" on the previous page must be repeated with the same or similar elements as defined in the first switched database.

**DEFINE_SYSTEM**

This command is for the DATABASE_RETRIEVAL module (also called TDB module).

Define the system in terms of either elements (equivalent to "DEFINE_ELEMENTS" on the previous page) or species (equivalent to "DEFINE_SPECIES" on the previous page). Certain databases have a default value of the keyword (as either ELEMENTS or SPECIES) reflecting what is most appropriate when defining a system.

The different names of elements or species must be separated with a space or comma. It is possible to use a wildcard * after a common part of elements or species names so that all the elements or species, which start with that common part and are available in the currently switched or appending database, are defined in the system.

When appending database(s), this command (or DEFINE_ELEMENTS or DEFINE_SPECIES) must be repeated with the same or similar elements as defined in the first switched database. Different databases might contain different elements and have different species definitions: avoid defining elements/species that are missing in the appending database(s). Otherwise, the program indicates these missing elements/species, and ignores them in subsequent steps. But additional elements/species, and additional phases not available in the first switched database can be defined and retrieved from the appending database(s). Up to 40 elements and 1000 species can be defined in a single system.
Also see "Defining a System in Console Mode" on page 160 in the Thermo-Calc User Guide for step-by-step instructions to define a system with this command.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>DEFINE_SYSTEM</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Elements: &lt;Element1, Element2, ...&gt;, or Species: &lt;Species1, Species2, ...&gt;</td>
</tr>
</tbody>
</table>

**Options**

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Species or Elements</td>
<td>Default keyword.</td>
</tr>
<tr>
<td>Element&amp;</td>
<td>Specify a list of elements for the defining system.</td>
</tr>
<tr>
<td>Species&amp;</td>
<td>Specify a list of species for the defining system.</td>
</tr>
</tbody>
</table>

**GET_DATA**

This command is for the DATABASE_RETRIEVAL module (also called TDB module).

Only after executing this command can you go to any of the application programs such as GES, POLY or DICTRA and use the retrieved data. When appending database(s), this command must be repeated in order to obtain the additional system definitions, parameters and functions.

**LIST_DATABASE**

This is a DATABASE_RETRIEVAL (TDB) command.

List all elements, species, phases or phase constituents in the database.
## LIST_DATABASE

**Syntax**

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Keyword</strong></td>
<td>One of the keywords Elements, Species, Phases or Constituent must be used to indicate what to list</td>
</tr>
<tr>
<td><strong>Elements</strong></td>
<td>All available elements, the reference state, atomic mass, H298-H0 and S298. Some elements have spaces in the column for the reference state. This implies that there are no parameters stored for this element.</td>
</tr>
<tr>
<td><strong>Species</strong></td>
<td>All available species together with the stoichiometric factors.</td>
</tr>
<tr>
<td><strong>Phases</strong></td>
<td>All available phases together with the number of sublattices and the number of sites in each sublattice.</td>
</tr>
<tr>
<td><strong>Constituent</strong></td>
<td>All available phases, the number of sublattices, the number of sites in each sublattice and the species dissolved in each phase. Species in different sublattices are separated with a colon (:). It is important to realize, for example, a phase can consist of Fe, Mo, V, and Cr, and its thermodynamic parameters can come from the binary systems Fe-Mo, Fe-V, Fe-Cr, and Mo-Cr. These data can give a relatively good description of the corners of the Fe-Cr-Mo system, but would most certainly give a bad one for the system Mo-Cr-V, due to the fact that the interaction parameters are, by default, set to zero, which originates from binary systems not included in the database.</td>
</tr>
</tbody>
</table>

### LIST_SYSTEM

This is a DATABASE RETRIEVAL (TDB) command.

List all elements, species, phases or phase constituents in the defined system. It works only after a system is defined.

**Syntax**

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Keyword</strong></td>
<td>One of the keywords Elements, Species, Phases or Constituent (as described in &quot;LIST_DATABASE&quot; on the previous page) must be used to indicate what to list</td>
</tr>
</tbody>
</table>

### NEWDIRECTORY_FILE

This command is for the DATABASE RETRIEVAL module (also called TDB module).
Open a new database initiation file (or called database directory file) generated by a local database manager or user, for accessing additional databases not predefined in the original database initiation file.

The original database initiation file is automatically copied by the installation script to the main database area, on a local computer for an independent installation locates or a connected server for a server installation.

- For Windows this is the TC_INITD (or TC_INITD.TDB) file in the \DATA\ area under the directory defined by the TCPATH parameter.
- For Linux, it is the inittdb file in /data/ area that is under the directory defined by the TC_DATA parameter. If the Thermo-Calc (Console Mode) is run on a Linux platform, the new database initiation file must be located in the current working directory.

If there are too many databases at one installation or if there are some user-specified databases for a particular purpose, a local database manager can generate additional database initiation files, or each user can have their own initiation file.

The command switches the working initialization of database groups in the DATA module among the original and additional database initiation files. The Thermo-Calc (Console Mode) can use additional database initiation files that define accessing paths to database groups (databases located in different subdirectories under the directory defined by the TCPATH or TC_DATA parameter). All directly accessible databases remain as in the same group, until this command is called or recalled.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>NEW_DIRECTORY_FILE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>File with database directory /tc_initd/: &lt;Database-initiation-file name&gt;</td>
</tr>
<tr>
<td></td>
<td>Another database-initiation-file name</td>
</tr>
<tr>
<td></td>
<td>The name of the next database initiation file (either additional or original) that is to be switched on as follows sessions.</td>
</tr>
<tr>
<td></td>
<td>If the file name or its path is not given on the same line of the NEW_DIRECTORY_FILE command, or if it is incomplete or incorrect, an Open window displays to specify the new database initiation file.</td>
</tr>
</tbody>
</table>

**REJECT**

This command is for the DATABASE_RETRIEVAL module (also called TDB module).
Reject elements, species, phases or phase constituents that can form from the defined elements and species. Phases/species/constituents that are possible to form in the defined system are removed from the list of system phases/species/constituents (shown by the command "LIST_SYSTEM" on page 17). Phases/species/constituents that are not included in the list cannot be entered without first being restored. The different names must be separated with a space or comma. You can use a wildcard * after a common part of names so that all the elements/species/phases/constituents that start with that common part and are available in the currently switched or appending database, are rejected from the defined system.

This command can also reject a defined system, and thus reinitiate the entire DATA module memory and GESS workspace.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>REJECT</th>
</tr>
</thead>
</table>
| Prompt 1 | (keyword = ELEMENTS or SPECIES or PHASES)  
If keyword: <Name1, Name2, ...> |
| Prompt 2 | (if keyword = CONSTITUENT)  
Phase: <Phase name>  
Sublattice number: <Sublattice number in the phase>  
Constituent: <Constituent(s) in the sublattice of the phase> |
| Prompt 3 | If keyword = SYSTEM the DATA module is reset to its initial state; GIBBS is reinitiated and data already entered to GESS is lost. |

<table>
<thead>
<tr>
<th>Options</th>
<th>Description and additional information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keyword</td>
<td>One of the keywords Elements, Species, Phases, Constituent or System must be used to indicate what is rejected.</td>
</tr>
<tr>
<td>Name&amp; Elements</td>
<td>Names of the pre-defined elements/species/phases/constituents/system</td>
</tr>
<tr>
<td>Elements</td>
<td>The given elements are rejected.</td>
</tr>
<tr>
<td>Species</td>
<td>The given species are rejected, making it impossible to form them from the defined elements.</td>
</tr>
<tr>
<td>Phases</td>
<td>The given phases are rejected, making it impossible to form them from the defined elements or species.</td>
</tr>
</tbody>
</table>
| Constituent | The given constituent in one phase are rejected. Add the following when prompted:  
Phase: The name of the phase containing the constituent to be rejected. |
**Diffusion Module (DICTRA) Documentation**

**Set Database Commands | 20 of 370**

**Syntax | REJECT**

<table>
<thead>
<tr>
<th>Sublattice number:</th>
<th>The sublattice where the constituent enters (the first sublattice is 1). The question is omitted if there exists only one possible sublattice.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Constituent:</td>
<td>The name(s) of the constituent(s) to be rejected.</td>
</tr>
</tbody>
</table>

**RESTORE**

This command is for the DATABASE_RETRIEVAL module (also called TDB module).

Restore already explicitly rejected elements, species, phases or constituents; it is the opposite of the command "REJECT on page 18" although it does not restore a completely rejected system.

Phases/species/constituents that are possible to form from the defined elements or species are entered to the list of system phases/species/constituents (shown by the command "LIST SYSTEM on page 17"). Phases/species/constituents that are not included on the list can now be added to the list. The different names must be separated with a space or comma. It is possible to use a wildcard * after a common part of names so that all the elements/species/phases/constituents, which start with that common part and are available in the currently switched or appending database, are restored in the defined system.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>RESTORE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt1</td>
<td>(if keyword = ELEMENTS or SPECIES or PHASES)</td>
</tr>
<tr>
<td></td>
<td>Keyword: &lt;Name1, Name2, ...&gt;</td>
</tr>
<tr>
<td>Prompt2</td>
<td>(if keyword = CONSTITUENT)</td>
</tr>
<tr>
<td></td>
<td>Phase: &lt;Phase name&gt;</td>
</tr>
<tr>
<td></td>
<td>Sublattice number: &lt;Sublattice number in the phase&gt;</td>
</tr>
<tr>
<td></td>
<td>Constituent: &lt;Constituent(s) in the sublattice of the phase&gt;</td>
</tr>
</tbody>
</table>

**Options | Description and Information**

<table>
<thead>
<tr>
<th>Keyword</th>
<th>One of the keywords Elements, Species, Phases or Constituent must be used to indicate what is rejected.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name&amp;</td>
<td>Names of the pre-defined elements, species, phases, and constituents</td>
</tr>
<tr>
<td>Syntax</td>
<td>SET_AUTO_APPEND_DATABASE</td>
</tr>
<tr>
<td>----------</td>
<td>--------------------------</td>
</tr>
<tr>
<td>Prompt</td>
<td>Database name /XYZ/: &lt;Additional database name&gt;</td>
</tr>
<tr>
<td>Option</td>
<td>Additional database name</td>
</tr>
</tbody>
</table>

This command is for the DATABASE_RETRIEVAL module (also called TDB module).

Enforce an automatic action that appends thermodynamic data from a chosen database regarding the system to the data you already have about the system from the current database (that is, the default database or the database last chosen with "SWITCH_DATABASE" on the next page or "APPEND_DATABASE" on page 12).

This is useful to simultaneously retrieve both thermodynamic and mobility data for a defined system when performing a DICTRA module simulation.

This command should be used before defining a system (with the commands "DEFINE_ELEMENTS" on page 14, "DEFINE_SPECIES" on page 14, or "DEFINE_SYSTEM" on page 15) and retrieving the data with the "GET_DATA" on page 16 command from the primary switched database.
It works in a way that is similar to the APPEND_DATABASE<DATABASE-NAME> command sequence, but only the phases that are also available in the primary switched database are appended. There is no possibility to manually list, reject and/or restore any phase that is available in the appending database. When retrieving data with the GET_DATA command afterwards, all the phases that exist in the appending database but not in the primary switched database are automatically rejected. The prompt is kept as for the primary switched database, TDB_XYZ: (where XYZ stands for the name of the primary switched database) until the execution of the GET_DATA command.

Therefore, to selectively append more phases from a secondary database to a system that is defined and retrieved from a primary switched database, then the APPEND_DATABASE command and sequential commands (such as DATABASE_INFORMATION, DEFINE_SYSTEM, DEFINE_ELEMENT, DEFINE_SPECIES, LIST_SYSTEM, REJECT, RESTORE and GET_DATA) should be used instead, before this command.

Although it is impossible to manually list, reject and restore any phase from the appending database, the DATA module automatically ignores all the phases that do not exist in both the primary switched database and the appending database, and append the data for the phases (that are also available in the primary switched database) from the appending database, as informed on screen when executing "GET_DATA" on page 16 afterwards.

**SWITCH_DATABASE**

This command is for the DATABASE RETRIEVAL module (also called TDB module).

Switch (or change) from the current database to a new one, and reinitialize the entire DATA module for defining a system and the GES5 workspace for storing retrieved data. All the directly connected databases as predefined by the original database initiation file, or by a user-specified database initiation file after using "NEW_DIRECTORY_FILE" on page 17, are listed by pressing the <Enter> key without giving any argument. You can also supply your own database by giving the argument USER and then the database name and its correct path if it is not located in the current working directory. The second part of the prompt TDB_XYZ indicates the present database XYZ.
<table>
<thead>
<tr>
<th><strong>Syntax</strong></th>
<th><strong>SWITCH_DATABASE</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Database name /xyz/: &lt;new database name&gt;</td>
</tr>
</tbody>
</table>

**Prompt**

Use one of these databases:

- **PURE** (SGTE pure element database)
- **SSUB** (SGTE substance database 1997)
- **USER** (user-defined database)

**Options**

<table>
<thead>
<tr>
<th><strong>Description and Information</strong></th>
</tr>
</thead>
</table>

**New database name**

The name of an existing database or a USER database definition file (**setup.TDB**).

The new database is specified by typing the abbreviation given in the front of one of the available predefined databases. When switching/appending databases or additionally purchased databases you can add these to the predefined database list in the database initiation file TC_INITD.TDB or initd.tdb of your installed software.

When this command is used in a macro (*.TCM) file, if the USER option is selected, the database setup file name (*setup.TDB) that contains the setup definitions of the USER database, and its correct path, must be provided.

**Filename**

In Linux, the filename of a USER database, or one of the predefined names, can be used under this prompt. A valid filename for the USER database definition file (**setup.tdb**) or a predefined database name, with the correct path. The default filename extension is .tdb.

If a USER database name or its path is not given on the same line of the SWITCH_DATABASE command, or if it is incomplete or incorrect, an Open window is displayed for the to-be-switched database.

The USER database is used without reinitializing the Gibbs energy system, data from different databases can thus be combined. Therefore, the SWITCH_DATABASE USER command sequence is equivalent to the APPEND_DATABASE USER command sequence. The result of a combination must be examined carefully, because differences in standard states, phase models and names can be disastrous. If the same parameters occur in several such switched or appended databases, the last one retrieved is used in the calculations. It is not advisable to use this method for large databases since these load slowly.

After this command, those commands for defining system (in terms of either elements or species), rejecting/restoring phases or species, retrieving data,
<table>
<thead>
<tr>
<th>Syntax</th>
<th>SWITCH_DATABASE</th>
</tr>
</thead>
</table>
| as well as for appending data from additional database(s), can be proceeded.
EDIT_EXPERIMENTS Commands

These commands are accessed through the PARROT module.

Some special commands are designed only for the ED_EXP module and can also be used in *.POP or *.DOP files.

In this section:

<table>
<thead>
<tr>
<th>Command</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Running the EDIT_EXPERIMENTS Command</td>
<td>27</td>
</tr>
<tr>
<td>ADVANCED_OPTIONS</td>
<td>27</td>
</tr>
<tr>
<td>COMPUTE_ALL_EQUILIBRIA</td>
<td>36</td>
</tr>
<tr>
<td>COMMENT</td>
<td>37</td>
</tr>
<tr>
<td>COMPUTE_ALL_EQUILIBRIA</td>
<td>37</td>
</tr>
<tr>
<td>COMPUTE_EQUILIBRIUM</td>
<td>38</td>
</tr>
<tr>
<td>CREATE_NEW_EQUILIBRIUM</td>
<td>40</td>
</tr>
<tr>
<td>DEFINE_COMPONENTS</td>
<td>40</td>
</tr>
<tr>
<td>DELETE_SYMBOL</td>
<td>41</td>
</tr>
<tr>
<td>ENTER_SYMBOL</td>
<td>41</td>
</tr>
<tr>
<td>EVALUATE_FUNCTIONS</td>
<td>44</td>
</tr>
<tr>
<td>EXPERIMENT</td>
<td>44</td>
</tr>
<tr>
<td>EXPORT</td>
<td>46</td>
</tr>
<tr>
<td>FLUSH_BUFFER</td>
<td>47</td>
</tr>
<tr>
<td>GRAPHICS_PLOT</td>
<td>47</td>
</tr>
<tr>
<td>IMPORT</td>
<td>47</td>
</tr>
<tr>
<td>LABEL_DATA</td>
<td>48</td>
</tr>
<tr>
<td>LIST_ALL_EQUILIBRIA</td>
<td>48</td>
</tr>
<tr>
<td>LIST_CONDITIONS</td>
<td>49</td>
</tr>
<tr>
<td>LIST_EQUILIBRIUM</td>
<td>49</td>
</tr>
<tr>
<td>LIST_STATUS</td>
<td>50</td>
</tr>
<tr>
<td>Command</td>
<td>Page</td>
</tr>
<tr>
<td>---------</td>
<td>------</td>
</tr>
<tr>
<td>LIST_SYMBOL</td>
<td>51</td>
</tr>
<tr>
<td>MAKE_POP_FILE</td>
<td>52</td>
</tr>
<tr>
<td>READ</td>
<td>53</td>
</tr>
<tr>
<td>READ_WORKSPACES</td>
<td>53</td>
</tr>
<tr>
<td>REINITIATE_MODULE</td>
<td>54</td>
</tr>
<tr>
<td>RESTORE_ALL_WEIGHTS</td>
<td>54</td>
</tr>
<tr>
<td>SAVE_WORKSPACES</td>
<td>54</td>
</tr>
<tr>
<td>SELECT_EQUILIBRIUM</td>
<td>55</td>
</tr>
<tr>
<td>SET_ALL_START_VALUES</td>
<td>55</td>
</tr>
<tr>
<td>SET_ALTERNATE_CONDITION</td>
<td>57</td>
</tr>
<tr>
<td>SET_CONDITION</td>
<td>60</td>
</tr>
<tr>
<td>SET_NUMERICAL_LIMITS</td>
<td>62</td>
</tr>
<tr>
<td>SET_REFERENCE_STATE</td>
<td>63</td>
</tr>
<tr>
<td>SET_START_CONSTITUTION</td>
<td>65</td>
</tr>
<tr>
<td>SET_START_VALUE</td>
<td>66</td>
</tr>
<tr>
<td>SET_WEIGHT</td>
<td>66</td>
</tr>
<tr>
<td>SHOW_VALUE</td>
<td>68</td>
</tr>
<tr>
<td>STORE_ALL_WEIGHTS</td>
<td>68</td>
</tr>
<tr>
<td>TABLE_HEAD, TABLE_VALUES and TABLE_END</td>
<td>68</td>
</tr>
<tr>
<td>TRANSFER_START_VALUES</td>
<td>70</td>
</tr>
</tbody>
</table>
Running the EDIT_EXPERIMENTS Command

To run the EDIT_EXPERIMENTS (ED_EXP) module:

- The first necessary command after entering the ED_EXP module for the first time (with "EDIT_EXPERIMENTS" on page 139 in the PARROT module) should always be READ_BLOCK in order to load the experimental data block from the current work *PAR-file for editing. Also, the read command must also be used prior to any other ED_EXP command if the module is reinitiated, or if no experimental data block has not previously been read from a work file compiled with a proper experimental data .POP/.DOP file, or if you want to change to another data block for editing.

- If any change is made in the ED_EXP module remember to use the command "SAVE_WORKSPACE" on page 289 before going BACK to the PARROT module.

Although the TABLE_HEAD, COMMENT and FLUSH_BUFFER commands are visible in the ED_EXP module, these cannot be used in the ED_EXP module; these are only functional in an *.POP or *.DOP file.

**ADVANCED_OPTIONS**

<table>
<thead>
<tr>
<th>Syntax</th>
<th>ADVANCED_OPTIONS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Which option? /Step_and_Map/: &lt;Option&gt;</td>
</tr>
</tbody>
</table>

Also see "ADVANCED_OPTIONS Descriptions" on page 168.

LIST_PHASE_ADDITION has no additional prompt.

**STEP_AND_MAP (the default)**

**Settings for MAP and STEP:**

Global test interval /0/: <Integer number>

**Settings for MAP:**

Automatically add initial equilibria /Y/: <Y or n>
Number of mesh along an axis /3/: <Integer number>
Use inside meshing points /N/: <Y or N>
Global test interval /0/: <Integer number>

The integer number determines how often the Global Minimization should be used during
STEP_WITH_OPTIONS and MAP calculations. If it is set to 0 (zero), the recommended global test interval is used: i.e. every tenth step and at each phase change during STEP calculations, and only at node points during MAP calculations. Any other positive integer number, n, suggests it performs a Global Minimization test at every n-th step during STEP and MAP calculations. Of course, the Global Minimization test is always carried out at a phase change or a node point. The Thermo-Calc software is installed with 0 (zero) as the default value, but such a configuration for the default value can be changed by using SET_TC_OPTIONS in the SYS module.

Automatically add initial equilibria /Y/: <Y or N>

When "ADD_INITIAL_EQUILIBRIUM" on page 166 is not used before MAP, a mesh of initial equilibrium points are added before the mapping itself takes place. This mesh is only available when two (2) axes are already defined. The default on start-up may be changed by SET_TC_OPTIONS in the SYS monitor.

Number of mesh along an axis /3/: <Integer number>

An integer for how many intervals of initial equilibrium points to be added along an edge in the diagram. For example, if set to 2 (two), initial equilibrium points are added at the beginning, center, and end of each axis-variable forming 2 intervals.

Use inside meshing points /N/: <Y or N>

If N the INITIAL_EQUILIBRIUM mesh consists of initial equilibrium points added only along the edge/border of the diagram defined by the axis-variables. If Y, the initial equilibrium points added are also added inside edge.
NONE

Take away any set advanced option in all subsequent single-point equilibrium and MAP/STEP calculations.

If there is any convergence problem in finding a stable solution, at any stage of an advanced option calculation conducted by an ADVANCED_OPTIONS command-sequence, these messages display:

Convergence problems, increasing smallest site-fraction from 1.00E-30 to hardware precision 2.00E-14. You can restore using SET-NUMERICAL-LIMITS

The smallest site fraction in the current POLY3 workspace is automatically increased from the default value 1.00E-30 to the hardware-dependent precision (under Linux, as 2.00E-14). For other subsequent POLY-module calculation in the current TC run, you can use the POLY command "SET_NUMERICAL_LIMITS" on page 296 to restore or reset the smallest site fraction to the previous or another preferred value, as well as to reset other numerical limits.

EQUILIBRIUM_CALCULATION

The following prompts affect the ways how the POLY optimization does the Ordinary POLY Minimization to reach the minimum of an equilibrium state.

Settings for the minimization of an equilibria:

Force positive definite phase Hessian /Y/: <Y or N>
Control stepsize during minimization /Y/: <Y or N>
Force positive definite phase Hessian /Y/: <Y or N>

Choose Y or N to determine how to reach the minimum of an equilibrium state in a normal POLY optimization procedure. This is related to the special quantity, the phase stability function QF (phase), for all kinds of phases in an equilibrium state [A phase stability function for a phase is negative when the phase composition is inside a spinodal, and positive everywhere else].

If the composition of a solution phase is inside its spinodal, the enforcement of positive definite eigenvalues of a Hessian matrix (i.e. by answering Y) makes the step be taken towards the minima rather than the local maxima. Furthermore, if an eigenvalue (for a phase) of the Hessian matrix is near 0.0, the step-size is large and the answering Y sets a lower limit to this eigenvalue, and reduces the step-size and improves the convergence. The POLY command-sequence SHOW_VALUE QF(phase) shows the size of the lowest eigenvalue of a phase in an equilibrium state.

By answering Y it might help the Ordinary POLY Minimization to converge, if there is such a
problem, especially if QF(phase) = 0 for phases.

By answering N the Ordinary POLY Minimization routine is applied.

For each phase in a defined system, the molar Gibbs energy of the phase is a function of the temperature-pressure condition and its composition:

\[ G_m(X) = G_m(T, P; y_1, y_2, ..., y_n) \]

Compute a Hessian matrix as which describes the curvature of the Gibbs energy curve of this phase at the defined composition X:

\[ \partial^2 G_m / \partial y_i \partial y_j \]

Diagonalize this matrix and call the Eigenvalues as e1, e2, ..., en. The QF(phase) quantity for this phase is the lowest of these eigenvalues divided by the same values for a corresponding ideal (stoichiometric) phase:

\[ QF(ph) = \min(\{e_1, e_2, ..., e_n\}) / \min(\{se_1, se_2, ..., se_n\}) \]

Here, se1, se2, ..., sen are the eigenvalues for the ideal phase. Therefore, for an ideal (stoichiometric) phase, the QF(phase) should always be 1.0.

Control stepsize during minimization /Y/: <Y or N>

Choose Y or N to determine whether to introduce a control of step-size while reaching the minimum of an equilibrium state in a normal POLY optimization procedure. By answering Y it might help the POLY optimization to converge, especially if when some site fractions are less than 1E-4.

GLOBAL_MINIMIZATION

The following prompts affect how the Global Minimization is done. Settings for global minimization:

Use global minimization as much as possible /Y/: <Y or N>
Use global minimization for test only? /N/: <Y or N>
Maximum number of gridpoints per phase /2000/: <Integer number>
Use global minimization as much as possible /Y/: <Y or N>

Choose Y or N to decide if using the Global Minimization Technique from start of calculation
or not. The default value on start-up may be changed by SET_TC_OPTIONS in the SYS module.

If \textit{Y} the calculation is done when possible (depending on the condition settings), and a Global Minimization test is always performed when an equilibrium is reached. This costs more computer time but the calculations are more accurate.

If \textit{N} the calculation is not used to reach the equilibrium state. \textit{Use global minimization for test only?} determines if the Global Minimization test is made against the calculated equilibrium states obtained by the Ordinary POLY Minimization calculation.

\textit{Use global minimization for test only?} /N/: <Y or N>

If \textit{Y} a calculated equilibrium state obtained by the Ordinary POLY Minimization calculation is tested against the Global Minimization Technique after it is reached; and if found it as unstable, there is an error message.

If \textit{N} the Global Minimization Technique is never tested for or done for all sequential calculations throughout the current TCC run. This implies that Global Minimization Technique is permanently turned off, and that consequently only the Ordinary POLY Minimization routine is used.

\textbf{Maximum number of gridpoints per phase /2000/:} <Integer number>

Specify the maximum number of grid points that are computed for each of the phases in the currently defined system, during the calculations enforced by the global minimization. More grid points give a higher robustness and take more computation time. The total number of computed grid points in all phases is limited to \textit{2E6}.

\textbf{IGNORE\_COMPOSI\_SET\_ORDER}

Ignore composition set order /N/

\textbf{NEW\_COMPOSITION\_SET}

The following prompts are to specify the additional composition set(s) to handle possible miscibility gap(s) of a certain solution phase:

\textbf{Phase with miscibility gap:} <Name of a phase>

Specify the name of the phase with miscibility gap.

\textbf{New highest composition set number /2/:} <#>

The default value is usually one higher than the current value. Each phase has initially one composition set. If a lower value is given, composition sets are deleted. You cannot take away the first composition set.
A message displays to show that you need to specify the composition for the composition set # (2,3,...).

Major constituent(s) for sublattice 1: /XX/: <YY>

The major constituents (YY) in each sublattice can be given. This may simplify giving start values when calculating the equilibrium as phases with miscibility gaps should have different major constituents for each composition set.

This prompt is repeated for each sublattice in the phase, sometimes even for all sublattices in the first composition set if such major constituents have not been specified.

**MAJOR_CONSTITUENT**

The following prompts are to specify the major constituent(s) on each of the sublattice sites for a composition set of a certain solution phase:

Phase name: <name of a phase>

Specify the name of the solution phase with a new set of major constituents.

Composition set number /1/: <#>

The default value for the composition set number (#) is usually /1/ as the other composition sets are given major constituents when creating them. Each phase has initially one composition set.

Major constituent(s) for sublattice 1: /XX/: <YY>

The major constituents (YY) on each sublattice of a solution phase can be given. This may simplify giving start values when calculating the equilibrium as phases with miscibility gaps should have different major constituents for each composition set.

This question is repeated for each sublattice in the phase.

**PHASE_ADDITION**

The following prompts are to specify the additional energy term (always being a constant) of a given phase.

Phase name: <Name of a phase>

Specify the name of the (stoichiometric or solution) phase with the addition.

Addition to G per mole formula unit: <xxxxx>

The value (xxxxx) given is added to the Gibbs energy of the (stoichiometric or solution)
phase. It can represent a nucleation barrier, surface tension, elastic energy or whatsoever.

- It is not composition-, temperature- or pressure-dependent.

**PRESENT_PHASE**

Specify the name of the present phase a the name of the phase that should be present at all calculated equilibria:

Present phase:
Phase name: <Name of a phase>

- Console Mode examples tcex45, tcex46 and tcex47 use this advanced option.

**T-ZERO_TEMPERATURE**

Name of first phase: <Phase A>
Name of second phase: <Phase B>

The names of phases A and B must be given, for which the T0 temperature (where the Gibbs energies are equal) is to be calculated.

If the T0 temperature between the two specified phases is successfully calculated, a message displays, e.g.

The T0 temperature is 840.82 K. Note: LIST-EQUILIBRIUM is not relevant

The first message shows the calculated T0 temperature between the two specified phases.
The second message indicates that after this option calculation with LIST_EQUILIBRIUM is irrelevant and does not list the equilibrium for the system at the T0-temperature.

**PARAEQUILIBRIUM**

Name of first phase: <Phase A>
Name of second phase: <Phase B>

The names of the two target phases A and B, between which the paraequilibrium state is to be calculated, must be entered subsequently or on the same (first) line at once then separated by an empty space, e.g. FCC#1 BCC or FCC#2 M23C6.

- You need to understand what you are dealing with in terms of calculating a paraequilibrium state between the two specified phases.
Specifically, there are four distinguished cases to understand: (1) both chosen phases must have similar interstitial/vacancy sublattices where the fast-diffusion interstitial component(s) occupy; (2) the choice on the target phase pair must be reasonable for the defined system and specified initial overall composition; (3) both target phases should have phase constitution definitions that cover all the defined substitutional and interstitial components of the current alloy system; or (4) it is impossible to calculate the paraequilibrium state between the target phase pairs with given interstitial component(s) in the currently defined system.

Fast diffusing component: /c/: <interstitial component(s)>

Fast diffusing component: /none/: <interstitial component(s)>

The name(s) of the fast-diffusing component(s) (C as the default single component) must be given at the above prompts subsequently or at the same (first) prompt. It is possible to specify more than one interstitial component as fast diffusion species.

Note the following:

Such specified interstitial component(s) must be appropriately defined according to the phase constitution definitions of the two selected phases: these must be located on the interstitial/vacancy sublattices in both chosen phases;

If there is only one fast-diffusing component which is carbon, press the <Enter> key to accept the default input at the first prompt; if the single fast-diffusing component is another element (e.g. N), type its name at the first prompt;

If there are two or more fast-diffusing components (e.g. C and N), type their names at the above prompts subsequently or at the same (first) prompt (separated by an empty space, such as C N);

To finish the input of fast-diffusing elements, accept NONE at a repeated prompt, i.e. by pressing <Enter> key to start the paraequilibrium point calculation;

If NONE or a non-existing component name is typed at the first prompt, it means no back diffusion is to be considered, and the para-equilibrium calculation is thus canceled entirely.

If the paraequilibrium state between the two specified phases is successfully calculated, the messages displays e.g.

NP(FCC) = 0.3586 with U-fractions C = 2.71821E-02 N = 4.1548129E-03
NP(BCC) = 0.6414 with U-fractions C = 7.10061E-04 N = 2.3781027E-04
All other compositions the same in both phases
Note: LIST-EQUILIBRIUM is not relevant

The first and second lines list the phase amounts expressed in mole-percent [NP(phase)] and the contents of the interstitial components C and N in a specific phase expressed in the so-
called u-fractions [u-f(\text{phase,C}) and u-f(\text{phase,N})], for the phase A (in this case as FCC) and phase B (in this case as BCC), respectively. The third line states that the compositions of the matrix component and all the remaining compositions (regarding substitutional components) in both the target phase A and target phase B are the same at the current paraequilibrium state, while these are not shown on screen. The last line indicates that after this advanced-option calculation the LIST_EQUILIBRIUM command is irrelevant and does not list the paraequilibrium state for the system at the current condition.

However, if the single-point calculation of the paraequilibrium state between the two specified phases has failed, these messages display:

*** Error 4 in ns0lad
*** Numerical error

This implies that the chosen target phase pair may be unreasonable for the defined alloy system or for the defined initial overall composition, or one or both phases may have inappropriate phase constitution definitions regarding the specified interstitial component (s). Then, you must either modify the settings of initial overall composition or specify the reasonable target phase pair with an appropriate choice of the fast diffusion interstitials in the defined alloy system.

**STABILITY_CHECK**

Stability check on? /y/: <y or n>

The default is \texttt{Y} to switch on the automatic stability check during all subsequent single-point equilibrium and MAP/STEP calculations. By answering \texttt{N}, there is no stability check in various calculations.

Check also for unstable phases? /y/: <Y or N>

If the automatic stability-check option is switched on choose to also check the stability for unstable phases. The default is \texttt{Y} and if an unstable phase is found to be located in a miscibility gas during a subsequent single-point equilibrium or MAP/STEP calculation, a warning message informs you to selectively make adjustments in the calculation settings [e.g. suspending the unstable phase, or using FORCED automatic start values for phase constituents by the S_A_S_V F command-sequence, or creating other composition sets, etc.]. By answering \texttt{N} the stability check is enforced only to stable phases in the system.

**TOGGLE_ALTERNATE_MODE**

Set alternate toggle to \texttt{DEFAULT}, \texttt{ALWAYS}, or \texttt{NEVER}?

Set global toggle to \texttt{DEFAULT}, \texttt{ALWAYS}, or \texttt{NEVER}?

\texttt{DEFAULT} means that the experiment points are calculated according to the Alternate
Technique depending on the SET_ALTERNATE command.

**ALWAYS** means the experiment points are always calculated according to the Alternate Technique even if the Alternate Mode is switched off in the PARROT module.

**NEVER** means the experiment points are calculated as normal equilibria even if you SET_ALTERNATE in the PARROT module.

### SHOW_FOR_T=

Temperature (K) /298.15/: <temperature_in_K>

Specify the new temperature condition (in K) under which the values of some specific state variable(s) or derived/partial variable(s) or defined symbol(s) for various thermodynamic properties of the entire system, of components, or of phases) in the currently-defined system (being in a *frozen* state) is shown on screen.

State Variable or symbol /VM/: <state variable or symbol name(s)>

Specify the name(s) of the desired state variable(s) or derived/partial variable(s) or defined symbol(s) for various thermodynamic properties of the entire system, of components, or of phases) in the currently-defined system. More than one state variable or symbol of interest can be simultaneously specified on the same line. For example, you can choose to show the values of VM or GM (i.e. molar volume or molar Gibbs energy of the entire system), or of VM(*) or HM(*).T (i.e. molar volumes or isobaric heat capacity of all phases), or of ACR(*), DGM(*) and LNACR(*,FCC) [i.e. activities of all system components, driving forces for all phases, and activities (in logarithm) of all system components in the FCC solution phase], under the new temperature condition (being in a frozen state).

### OUTPUT_FILE_FOR_SHOW

A window opens with a default name for the file tc_show.dat. Choose a location to save the file and click Open.

### COMPUTE_ALL_EQUILIBRIA

<table>
<thead>
<tr>
<th>Syntax</th>
<th>COMPUTE_ALL_EQUILIBRIA</th>
</tr>
</thead>
</table>

In ED_EXP and PARROT modules, each experiment is treated as an individual equilibrium with some measured values. These are created with "CREATE_NEW_EQUILIBRIUM" on page 195, and stored in an experimental data *.POP file and then compiled and saved in the POLY3 workspace of a PARROT work *.PAR file.
With COMPUTE-ALL-EQUILIBRIA, all equilibria from the current to the last experimental points are calculated. If an equilibrium calculation fails, the calculation is stopped at that equilibrium. Equilibria with weight zero is skipped.

A current or present experimental point means the latest selected or calculated one. Once used the current point turns to the last point in the data block; in such a case you first use "SELECT_EQUILIBRIUM" on page 216 so that the current point is switched to a desired one.

For this command there is always a list output on screen, which consists of six columns for all experimental points available in the current data block. The first column is the equilibrium identifier (a number) assigned by this command, the second the data label assigned with "LABEL_DATA" on page 48, the third the number of iterations, the fourth the current weight, and the fifth the current temperature. In the sixth column the fixed stable phases are listed together with any comment text given after a "COMMENT" on page 77 in the *.POP or *.DOP file.

If the weight is zero for an equilibrium columns 3-5 are replaced by the text <unused>. If the alternate mode is used for some experimental points, the listing is slightly different for such points. The 3-4 columns are displayed with *alt*, instead. If an alternate calculation is failed at one experimental point, the point is automatically assigned with a zero weight, and a warning message is shown above the data line (with all six columns).

**COMMENT**

This command is only used in the *.POP/*DOP files to write brief comments or descriptive information on a newly created equilibrium (experimental) data point or a set of points given in a table.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>COMMENT</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>A comment can have a maximum of about 60 characters written on the same line.</td>
</tr>
</tbody>
</table>

**COMPUTE_ALL_EQUILIBRIA**

In ED_EXP and PARROT modules, each experiment is treated as an individual equilibrium with some measured values. These are created with "CREATE_NEW_EQUILIBRIUM" on page 195, and stored in an experimental data *.POP file and then compiled and saved in the POLY3 workspace of a PARROT work *.PAR file.
With COMPUTE-ALL-EQUILIBRIA, all equilibria from the current to the last experimental points are calculated. If an equilibrium calculation fails, the calculation is stopped at that equilibrium. Equilibria with weight zero is skipped.

A current or present experimental point means the latest selected or calculated one. Once used the current point turns to the last point in the data block; in such a case you first use "SELECT_EQUILIBRIUM" on page 216 so that the current point is switched to a desired one.

For this command there is always a list output on screen, which consists of six columns for all experimental points available in the current data block. The first column is the equilibrium identifier (a number) assigned by this command, the second the data label assigned with "LABEL_DATA" on page 48, the third the number of iterations, the fourth the current weight, and the fifth the current temperature. In the sixth column the fixed stable phases are listed together with any comment text given after a "COMMENT" on page 77 in the *.POP or *.DOP file.

If the weight is zero for an equilibrium columns 3-5 are replaced by the text <unused>. If the alternate mode is used for some experimental points, the listing is slightly different for such points. The 3-4 columns are displayed with *alt*, instead. If an alternate calculation is failed at one experimental point, the point is automatically assigned with a zero weight, and a warning message is shown above the data line (with all six columns).

**COMPUTE_EQUILIBRIUM**

The full equilibrium state is calculated for the given set of conditions. The Global Minimization Technique is by default enforced in this command (C_E), while it can be disabled temporarily (for the current single-point equilibrium calculation) if using C_E – or C_E * command-combination, or permanently (for all the sub sequential single-point calculations or stepping/mapping calculations within the current TCC run) if having decisively switched it off by a user (or possibly in some special modules) through changing the minimization option using the "ADVANCED_OPTIONS" on page 174 → MINIMIZATION_OPTION command-sequence.
### Syntax

<table>
<thead>
<tr>
<th>Prompt</th>
<th><strong>COMPUTE_EQUILIBRIUM</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>The C_E command</strong> can be used, in order to enforce the ordinary POLY minimization routines in an equilibrium calculation; this is because of that the ordinary C_E command is now associated with the Global Minimization Technique, and only after the Global Minimization</td>
<td></td>
</tr>
<tr>
<td><strong>If technique is permanently switched off the C_E command makes no difference from the C_E – command-combination.</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Only certain types of equilibrium conditions</strong> [e.g. T, P, N(&lt;component&gt;), X(&lt;component&gt;), B, B(&lt;component&gt;), and W(&lt;component&gt;)] <strong>are fully supported in the Global Minimization mode</strong> (called <em>Direct Global Minimization</em>); and when other types of equilibrium conditions are used, after the initial POLY, a Global Minimization test and corrections are performed until the lowest minimum is found (called <em>Indirect Global Minimization</em>).</td>
<td></td>
</tr>
<tr>
<td><strong>If there is any problem with convergence, you may try the C_E * command-combination. The character * enforces the command to use an advanced technique to obtain a complex equilibrium. However, after a successful C_E * calculation, you may repeat the C_E command and can check the status of phases, species or components (with &quot;LIST_STATUS&quot; on page 210 (\rightarrow) CPS command-sequence) and equilibrium conditions (with &quot;LIST_CONDITIONS&quot; on page 209) and list out the calculation results (with &quot;LIST_EQUILIBRIUM&quot; on page 209), because such actions may tell you how to further modify various settings for your current calculation. This command-combination is not that useful anymore, because the Global Minimization Technique that is always associated with the C_E command is even more powerful and more precise in finding the most-stable equilibrium state in a complex heterogeneous interaction system; therefore, the C_E * command-combination is functional and can be used only after the Global Minimization mode has already been disabled temporarily or permanently.</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Some phases that are not stable in the current equilibrium state may not have their most favorable composition after this command, and thus their driving forces may not be correct. You can force the program to correctly calculate the driving forces of metastable phases, by giving repeated C_E commands until the number of iterations (that is shown on screen after this command) is reduced to 2.</strong></td>
<td></td>
</tr>
<tr>
<td>Also see the POLY command &quot;SET_NUMERICAL_LIMITS&quot; on page 296 which can set the approximate driving force for metastable phases option on or off in all the subsequent POLY calculations within the current TCC run.</td>
<td></td>
</tr>
</tbody>
</table>
Syntax | COMPUTE_EQUILIBRIUM
---|---

 If an equilibrium state for the defined system is not found, an error message is given.

You can try repeating this command a few times, or change some of settings for the numerical limits, for starting variables and starting values, for starting constitutions of certain phases and for reference states of certain components, or to verify some of the defined conditions.

**CREATE_NEW_EQUILIBRIUM**

During data-assessments using the PARROT/ED_EXP modules, you can, in the POLY module, create several equilibria with different sets of conditions and phases (but normally with the same set of components). By default, there is one equilibrium. To keep the set of conditions and phase for this equilibrium, create another one using this command, and use another set of conditions for that. Two equilibria may be useful to calculate easily the enthalpy difference between two states. In the PARROT module, the experimental information is stored as a sequence of equilibria.

**Syntax** | CREATE_NEW_EQUILIBRIUM
---|---

**Prompts**

Equilibrium number /2/: <A new equilibrium number>

Each equilibrium in the POLY3 workspace is identified by a unique integer number. Such an equilibrium number can be recalled with "SELECT_EQUILIBRIUM" on page 216.

Initiation code /2/:

When an equilibrium is created, you can choose to ENTER all components and phases (initiation code 2), ENTER the components only (initiation code 1) or SUSPEND everything (initiation code 0). No other values are legal.

The entered components and phases can later be changed with "CHANGE_STATUS" on page 100.

**DEFINE_COMPONENTS**

Change the set of components. By default, the elements are used as components. The set of components can be important because some conditions are set using components, for example, the amounts, activities or chemical potentials.
For example, in the system Fe-Si-O, you can define FEO, FE2O3 and SIO2 as components, thus replacing the default FE, SI and O.

This implies a command "REINITIATE_MODULE" on page 215 and it should be given as the first command in the POLY module.

### Syntax

<table>
<thead>
<tr>
<th>Command</th>
<th>Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>DEFINE_COMPONENTS</td>
<td>Give all new components / existing components:/ &lt;New components&gt;</td>
</tr>
<tr>
<td></td>
<td>The new components must be specified all on one line. These replace the existing component definitions.</td>
</tr>
<tr>
<td></td>
<td>The number of components cannot be changed with this command. Use &quot;CHANGE_STATUS&quot; on page 100 instead.</td>
</tr>
<tr>
<td></td>
<td>To keep some existing components, it is recommended that you also enter these on the line. Otherwise, the added new components may not be defined correctly. This is especially important if some components are built out of several elements.</td>
</tr>
<tr>
<td></td>
<td>The new components do not have to be present as species.</td>
</tr>
</tbody>
</table>

### DELETE_SYMBOL

This is a POLY3 module command.

Delete symbols (i.e. constants, variables, functions or tables. These symbols are entered with "ENTER_SYMBOL" on page 113.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>DELETE_SYMBOL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Name: &lt;Name of a symbol&gt;</td>
</tr>
<tr>
<td></td>
<td>Specify the name of the symbol to be deleted. Only one symbol can be deleted each time.</td>
</tr>
</tbody>
</table>

### ENTER_SYMBOL

This command is specific to the ED-EXP module.

Also see "ENTER_SYMBOL" on page 113 for the GIBBS Module and "ENTER_SYMBOL" on page 247 for the POLY and POST Modules.
Symbols are a useful feature modules to define quantities that are convenient. Symbols can be constants, variables, functions or tables.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>ENTER_SYMBOL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Constant, Variable, Function or Table? /Function/: &lt;keyword&gt;</td>
<td></td>
</tr>
<tr>
<td>The <strong>Keyword can be specified as</strong> CONSTANT, VARIABLE, FUNCTION or TABLE.</td>
<td></td>
</tr>
<tr>
<td>- CONSTANTS can only be entered once and is a means of using a name for a numeric value. For example, the value of 1 atmosphere in Pascal can be denoted by ( P_0 ) after the command ENTER CONSTANT ( P_0 = 101325 ). Defined constants can be used as values in condition assignments, for example, SET-COND ( P = P_0 ).</td>
<td></td>
</tr>
<tr>
<td>- FUNCTIONS are expressions of state variables or other functions. These expressions are saved, and whenever a function value is requested all functions are evaluated. The reason for this is that they may depend on each other.</td>
<td></td>
</tr>
<tr>
<td>- VARIABLES are similar to functions because they can also be expressions of state variables. However, contrary to functions, they are only evaluated when they are entered or if they are explicitly named in an &quot;EVALUATE_FUNCTIONS&quot; on page 208 command. It is possible to enter a variable with a new expression any time. This expression is evaluated directly and its value stored as the value of the variable. Defined variables can be used as values in the SET-CONDITION command.</td>
<td></td>
</tr>
<tr>
<td>- TABLES are used for listing results from the STEP or MAP commands. A table consists of a list of any number of state variables, functions or variables. Defined tables can also be used in the post-processor POST.</td>
<td></td>
</tr>
<tr>
<td>There is a special connection between tables and variables. If a variable is used in a table, it is evaluated for each line of the table in the TABULATE command or when the table is used in a plot.</td>
<td></td>
</tr>
<tr>
<td>Name: &lt;Name of the symbol&gt;</td>
<td></td>
</tr>
<tr>
<td>Each symbol has a unique name that must start with a letter and can have maximum 8 characters.</td>
<td></td>
</tr>
<tr>
<td>Legal characters include letters (either UPPER or lower case), digits and underscore __. Any other special character, such as parentheses ( and ), plus +, minus -, slash / or , full stop (.), are illegal for symbol names.</td>
<td></td>
</tr>
<tr>
<td>You can enter the symbol name and the value or function on the same line,</td>
<td></td>
</tr>
<tr>
<td>Syntax</td>
<td>ENTER_SYMBOL</td>
</tr>
<tr>
<td>------------</td>
<td>--------------</td>
</tr>
<tr>
<td>these must be separated with an equal sign =, for example, TC=T-273.15 or T_C=T273.15 which stands for a definition of temperature in Celsius. Otherwise, these questions are asked.</td>
<td></td>
</tr>
<tr>
<td>For different types of symbol (constant, function, variable or table), the questions have different prompts.</td>
<td></td>
</tr>
<tr>
<td>Function: &lt;Definition for a function or variable&gt;</td>
<td></td>
</tr>
<tr>
<td>Functions and variables are evaluated from an expression of state variables or other functions, constants or variables. The expression is a FORTRAN-like expression and operators +, -, <em>, = and ** can be used (</em>* only with integer powers).</td>
<td></td>
</tr>
<tr>
<td>Unary functions like LOG, LOG10, EXP, SIN, COS and ERF can also be used. An expression can be continued on more than one line. An expression should be terminated by a semicolon (;) or an empty line (by pressing &lt;Enter&gt; at the next prompt).</td>
<td></td>
</tr>
<tr>
<td>Examples of function expressions:</td>
<td></td>
</tr>
<tr>
<td>- GM(LIQUID): The Gibbs energy of liquid per mole component</td>
<td></td>
</tr>
<tr>
<td>- H.T/4.184: The heat capacity of the system in calories</td>
<td></td>
</tr>
<tr>
<td>- ACR(CR) /X(FCC,CR): The activity coefficient for Cr in FCC</td>
<td></td>
</tr>
<tr>
<td>- T-273.15: The temperature in Celsius</td>
<td></td>
</tr>
<tr>
<td>&amp;: &lt;Continuation of the definition for the symbol&gt;</td>
<td></td>
</tr>
<tr>
<td>The ampersand &amp; means that you can continue to write the function on the new line if one line is not enough for the function. If you finish the function press &lt;Enter&gt; again.</td>
<td></td>
</tr>
<tr>
<td>Value: &lt;Value for a constant&gt;</td>
<td></td>
</tr>
<tr>
<td>A constant can only be assigned a numeric value once.</td>
<td></td>
</tr>
<tr>
<td>Value or expression: &lt;Value of expression for a variable&gt;</td>
<td></td>
</tr>
<tr>
<td>A variable can be assigned a numeric value or an expression. An expression is evaluated immediately and discarded. Only the numeric value is kept. This gives a possibility to save a value between calculations with different conditions because all state variables and functions are evaluated for the new conditions.</td>
<td></td>
</tr>
</tbody>
</table>
Variable(s): <Variable(s) in a table>

A table consists of a list of state variables or functions. One way to obtain results from a STEP command is through a table.

Example:

    ENTER TABLE K=T,X(LIQ,C),X(LIQ,CR),ACR(C)

Which means that the table called K contains four columns, i.e. the temperature, the mole fractions of C and Cr in the LIQUID phase, and the activity of C.

To show the temperature in Celsius in a table, give the command ENTER FUNCTION TC=T-273; and then use the symbol TC in the table.

The ampersand & means that you can continue to write the table on the new line if one line is not enough for the table. If you finish the table press <Enter> again.

**EVALUATE_FUNCTIONS**

The value of one or more or all entered functions or variables are evaluated and listed.

Name(s): <Name(s) of defined function(s)>

The names of one or more entered functions or variables must be specified. By typing a wildcard *, all functions and variables are evaluated.

Variables are evaluated only if these are explicitly named.

**EXPERIMENT**

This command is used in original experimental data files (*.POP or *.DOP), but can also be given interactively inside the ED-EXP module, to change the value or uncertainty of an experiment or to add more experimental information.

An experiment usually consists of two parts with a colon (:) separating them:

- as a quantity relation, and
- as the uncertainty of the value for the quantity,
The quantity relation can be a normal POLY-module condition or an inequality (which is similar to condition but the relation between the quantity and given value is not in equality, i.e. < or >). The uncertainty can be expressed as an absolute value or relative to the value (x%).

An experiment that uses an inequality gives zero contribution to the sum of errors in the optimization procedure of PARROT if the value is on the right side. If the value is on the wrong side, the value after the colon determines how steeply the error increases with the value.

Syntax | EXPERIMENT
---|---
The experiment must be typed after the command. Several experiments can be given on the same line.
The syntax of EXPERIMENT is similar to a CONDITION. Usually, a state variable set equal to a value with a given uncertainty is specified after the colon (:). For example, T=1273.15:5.
An inequality, < or >, can also be used. For example: ACR(C)<-0.01:0.001, W(BCC,AG)>0.05:10%

Additional Information About the EXPERIMENT Command

A typical experiment added interactively specifies that a phase should not be stable in a certain experiment, because a phase may appear in a range of composition or of temperature where it has never been observed during the optimization. A phase is unstable if its driving force is negative, and you can add experimental information to enforce that. For example, you can suppress the HCP phase in an existing experimental point:

```
CHANGE-STATUS  HCP=DORMANT
EXPERIMENT  DGM(HCP)<-.001:.0001
```

DGM is the POLY variable for the driving force that is already divided by RT, and it is dimensionless. Only dormant phases can have driving forces larger than zero, as this indicates that these would be stable if allowed to form. The experiment in the above case tries to modify the model parameters to make the HCP phase unstable.

More general examples of experiment definitions:

```
EXPERIMENT  X(LIQ,PB)=.10:.01  X(FCC,PB)=0.02:.01
EXPERIMENT  ACR(PB)=0.8:5%
EXPERIMENT  T=700:5
```
The first experiment above describes a tie-line where the experimentally measured mole fraction of Pb is 0.1 in the liquid phase and 0.02 in the FCC phase, and its uncertainty is 0.01 for both measurements. The second experiment is that the activity of Pb should be 0.8 with an uncertainty of 5 percent.

The reference state of the component Pb must be set with the command "SET REFERENCE STATE" on page 224. The final one is that the temperature should be 700 K with an uncertainty of 5 degrees.

Experiments that are functions of states variable(s) must be described as the defined functions. For example:

```
ENTER FUNCTION HTR=HM(LIQUID)−HM(FCC);
EXPERIMENT HTR=7000:1000
```

**EXPORT**

This command is for the ED-EXP module.

Transfer/export a calculated value from an equilibrium to an optimizing variable in the PARROT workspace. Thus the value can be used, for example, in the Gibbs energy description of a phase. Of course, this variable should not be optimized (i.e. it should be set as a fixed variable in PARROT).

<table>
<thead>
<tr>
<th>Syntax</th>
<th>EXPORT</th>
</tr>
</thead>
</table>
| Prompt | Function name: <Function name>#<n>  
Specify the name of the function, the value of which should be transferred to a ∇ variable. The number (n) of the ∇ variable must be given after the function name, separated by hash character #.  
The function name is UPPER/lowercase sensitive, and it should normally be given in UPPER case. |
| Example | Enter_function strngy=gm(fcc).x(cu);  
Export strngy#6  
This transfers the value of the partial derivative of the Gibbs energy of the FCC phase with respect to the mole fraction of Cu to the optimizing variable 6 (i.e. v6). |
FLUSH_BUFFER

This command is only used in the *.POP/*.DOP files. It is needed if the number of experiments require more space than can be fitted into one buffer. When the PARROT program compiles experiments, it informs if any FLUSH commands are needed. The FLUSH_BUFFER command terminates the current block, save it to the work file and starts a new block. With the READ command in the EDIT-EXP module, you can select the block to edit.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>FLUSH_BUFFER</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>After a FLUSH_BUFFER command, the workspace is reinitiated and all functions or constants must be entered again in the *.POP file. You can take advantage of this; for example, you can use the FLUSH command to have blocks with different components in one *.POP file.</td>
</tr>
</tbody>
</table>

GRAPHICS_PLOT

This command can help create a experimental data file from the *.POP/*.DOP file. Several data sets and different symbols are allowed.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>GRAPHICS_PLOT</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>&lt;Dataset#&gt; &lt;X value&gt; &lt;Y value&gt; &lt;Symbol index&gt;</td>
</tr>
</tbody>
</table>

IMPORT

Transfer/import the value of one of the optimizing variables to a constant. Normally, it is directly used inside an experimental data (*.POP or *.DOP) file. It is the inverse of "EXPORT" on the previous page.

This is useful if several experiments are done at the same activity of a component, but this activity is not known. The activity should then be optimized and all equilibria with the same activity should use the same value. In this case the variable must be set as an optimizing variable, and an initial guess of the activity should be given. During the optimization, the PARROT program tries to find the activity that gives the best fit.

If an approximate value of the activity is known, it can be supplied as an experiment.

See example tcex36 in the Thermo-Calc Console Mode Examples Guide.
Syntax | IMPORT  
---|---
Prompt |

Constant name: <Constant name>#<n>

The value of the \( V \) variable must be assigned a symbolic constant. The number \( (n) \) of the \( V \) variable must be given after the constant name, separated by hash character #.

The constant name is UPPER/lowercase sensitive, and it should normally be given in UPPER case.

Example

Enter constant acu=0.1
Import acu#2

This transfers the value of the optimizing variable 2 (i.e. \( V_2 \)) to the constant ACU.

**LABEL_DATA**

Add a label to the experimental equilibrium point, either as a single point or several points given individually or in a table. The label is maximum four characters and must start with the letter A. Normally, it is directly used inside an experimental data (*.POP or *.DOP) file.

Several experimental equilibria can be given the same label, and the label can be used in the command "SET_WEIGHT" on page 66 to assign the same weight to all equilibria with the same label.

Syntax | LABEL_DATA  
---|---
Prompt |

Label? /A1/: a<bcd>

Specify a textual label (as maximum characters and must start with the letter A) for the current experimental equilibrium point(s).

**LIST_ALL_EQUILIBRIA**

This is an EDIT_EXPERIMENTS command.
### LIST_CONDITIONS

This is a PARROT module command.

In the PARROT module, generate a list of the current values of optimization conditions, as well as the current status of listing, either on screen or in a basic text file which can be opened and edited by a text editor.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>LIST_CONDITIONS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Output to screen or file /Screen/: &lt;File name&gt;</td>
</tr>
<tr>
<td></td>
<td>Press &lt;Enter&gt; to output to screen or on the list file under a specific file name.</td>
</tr>
</tbody>
</table>

### LIST_EQUILIBRIUM

This is a POLY3 module command.

The result (always in SI units) from the last calculated equilibrium is listed on screen or in a textual file.

You can also execute this command if no calculation is made or if the calculation fails. It is your responsibility to interpret the results accordingly.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>LIST_EQUILIBRIUM</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Output to screen or file /Screen/: &lt;File name&gt;</td>
</tr>
<tr>
<td></td>
<td>The name of the text file where the list of the calculation results shall be written.</td>
</tr>
<tr>
<td></td>
<td>Options /VWCS/: &lt;Option(s)&gt;</td>
</tr>
<tr>
<td></td>
<td>Select the output units and formats by optionally specifying a combination of these letters.</td>
</tr>
<tr>
<td>Syntax</td>
<td>LIST_EQUILIBRIUM</td>
</tr>
<tr>
<td>--------</td>
<td>-----------------</td>
</tr>
<tr>
<td>• <strong>Fraction order:</strong> $V$ means VALUE ORDER; $A$ means ALPHABETICAL ORDER.</td>
<td></td>
</tr>
<tr>
<td>• <strong>Fraction type:</strong> $W$ means MASS FRACTION; $X$ means MOLE FRACTION.</td>
<td></td>
</tr>
<tr>
<td>• <strong>Composition:</strong> $C$ means only COMPOSITION; $N$ means CONSTITUTION and COMPOSITION.</td>
<td></td>
</tr>
<tr>
<td>• <strong>Phase:</strong> $S$ means including only STABLE PHASES; $P$ means including ALL NON-SUSPENDED PHASES.</td>
<td></td>
</tr>
</tbody>
</table>

Default options are VWCS. If the output fraction type should be in mole fraction (rather than mass fraction), then give VXCS or type X (implying that in this case the options V, C and S are accepted as the listing manners for fraction order, composition and phase).

If accepting all the default options, or if accepting all the altered options that had already changed when using this command previously, you can type L_E,, or LIST_EQUILIBRIUM ,,,

LIST_EQUILIBRIUM displays ORD (ordered) or DISORD (disordered) (when available). See "CHANGE_LEGEND" on page 246 for details.

**LIST_STATUS**

This command is for the POLY and ED-EXP modules.

List the status of components, species or phases.
## LIST_STATUS

**Syntax**

<table>
<thead>
<tr>
<th>Syntax</th>
<th>LIST_STATUS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Specify what to list:</td>
</tr>
<tr>
<td></td>
<td>Option /CPS/: <code>&lt;keyword(s)&gt;</code></td>
</tr>
<tr>
<td></td>
<td>keyword = C or P or S, or any combination</td>
</tr>
<tr>
<td></td>
<td>• C means list component status</td>
</tr>
<tr>
<td></td>
<td>• P means list phase status</td>
</tr>
<tr>
<td></td>
<td>• S means list species status</td>
</tr>
<tr>
<td></td>
<td>• CS for both components and species</td>
</tr>
<tr>
<td></td>
<td>Default is CPS.</td>
</tr>
<tr>
<td></td>
<td>The results depend on the key word specified in the options for &quot;CHANGE_STATUS&quot; on page 100, a table with the current status of phases or species or components, or the combinations, is shown:</td>
</tr>
<tr>
<td></td>
<td>• For components, the statuses and reference states are listed.</td>
</tr>
<tr>
<td></td>
<td>• For species, only the status is listed.</td>
</tr>
<tr>
<td></td>
<td>• For ENTERED and FIXED phases, the status, driving forces and equilibrium amounts are listed.</td>
</tr>
<tr>
<td></td>
<td>The metastable phases are listed in descending order of stability.</td>
</tr>
<tr>
<td></td>
<td>To avoid long outputs only 10 metastable phases (in ENTERED status) are listed by lines, while all other less stable phases are merged onto one line. For DORMANT phases, their phase names and driving forces are listed. For SUSPENDED phases, only the phase names are listed.</td>
</tr>
</tbody>
</table>

### LIST_SYMBOL

- This is a GIBBS_ENERGY_SYSTEM (GES) command.

List the symbols available in the current GIBBS workspace, which are defined (retrieved from database in the DATA module, or directly entered in the GIBBS module) and used in TP-functions for the entered model parameters for various phases in the defined system.

- For encrypted commercial databases you may not be able to use this command to list any retrieved symbol.
**Syntax** | **LIST_SYMBOL**
--- | ---
Name: `<Symbol name>`
Specify a symbol name (either as the full name of a defined symbol, or as the first few common characters of several symbols which have names starting with such common characters).

Only those symbols that match this name are listed.

Or press `<Enter>` for a list of all the symbols defined (retrieved from database in the DATA module, or directly entered in the GIBBS module) for the current system, which are available in the current GIBBS workspace.

**Prompts**

Output to screen or file /Screen/: `<File name>`
Specify the name of a simple-textual file in which the entered symbols shall be written in a readable manner (such a basic textual file can later on be opened and edited by any text editor). The default value is the screen (by pressing `<Enter>`).

## MAKE_POP_FILE

It is possible in the ED_EXP module to make interactive changes and additions to the original experimental data file (the *.POP or *.DOP file).

To document or transfer the current or final experimental data to a *.POP/*.DOP file, you can use this command to write it to a new *.POP/*.DOP file or overwrite it on an old one.

Check this output carefully for errors. Tables in original *.POP/*.DOP files are written as individual experimental points. The output can be shown on screen or be saved as a new *.POP file where to write or overwrite the edited experimental information in a simple text format.

If an existing *.POP file name is specified, it is overwritten.

In the DICTRA module, a *.DOP file is written or overwritten.

**Syntax** | **MAKE_POP_FILE**
--- | ---
Output to screen or file /Screen/: `<POP/DOP-file name>`
Specify a name of the new *.POP/*.DOP file where to write or overwrite the edited experimental information in a simple text format.
READ

This command must be given each time the ED_EXP module is entered, unless it is already given once in ED_EXP and does not use "LIST_RESULT" on page 149 or "OPTIMIZE_VARIABLES" on page 154 in PARROT in between.

Syntax | READ
---|---
Prompt | Block number /#/: <n>
The number of data block that should be edited must be given. If there is no command "FLUSH_BUFFER" on page 77 in the original POP or DOP file, then there is only one data block with the number 1.

READ_WORKSPACE = READ

This command (previously named READ_BLOCK) is equivalent to "READ_WORKSPACE" on page 288 in the POLY module, but it only reads the POLY3 workspace from the work file set by "SET_STORE_FILE" on page 162 in the PARROT module.

READ_WORKSPACES

This command is used in both the POLY and GES (GIBBS) modules.

The POLY3 and GIBBS workspaces and the calculated results from the MAP and STEP commands can be READ from a file where they are saved with "SAVE_WORKSPACES " on the next page. Such an *.POLY3 file is not printable.

Syntax | READ_WORKSPACES
---|---
Options | File name is the name of a saved POLY3-file where the POLY3 and GIBBS workspaces shall be read from must be specified. You do not need to type the extension if it is the default *.POLY3 (Windows) or *.poly3 (Linux), otherwise type the whole POLY-file name.

A window opens so that the path (in the Look in field) and File name can be specified. The Files of type (i.e. POLY3) cannot be changed. Click Open to open the POLY3 and GIBBS workspaces from the saved *.POLY3 file.

When reading back an original POLY3 workspace that has already been saved as an *.POLY3 file in the current Thermo-Calc (Console Mode) run or had been
**REINITIATE_MODULE**

Ensures that the whole POLY module (and thus the entire POLY workspace) is reinitiated to the state as it was when first entered.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>REINITIATE_MODULE</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Description</strong></td>
<td>All the defined components, defined conditions, changed status, entered symbols, defined independent axis-variables, calculated starting equilibrium-points, added initial equilibrium points, stepped/mapped equilibrium data, and so forth, are removed completely. The saved file name is restored to the default.</td>
</tr>
</tbody>
</table>

**RESTORE_ALL_WEIGHTS**

Restore a specific weight-set (previously saved by "STORE_ALL_WEIGHTS" on page 68) and assign all the different experimental points in the current data block with the previously-set weights in the sequential assessments.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>RESTORE_ALL_WEIGHTS</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Prompt</strong></td>
<td>Set number (0 for list) /0/: &lt;weight-set number&gt;</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>The default value 0 is for a list on screen.</td>
</tr>
</tbody>
</table>

**SAVE_WORKSPACES**

This command is for the ED-EXP module.

In the PARROT workspace this command saves the current status of the EDIT_EXPERIMENT submodule before you switch back to the PARROT module. This is required when you want to save equilibria changes, including changes to conditions, experimental data, and/or computed equilibria results, as well as any newly added equilibria.
With this command all the changes made in the EDIT_EXPERIMENT submodule are saved in the PARROT workspace. This means you do not need to execute "SAVE_PARROT_WORKSPACES" on page 156 in the PARROT module.

However, when in the PARROT module, additional changes can only be saved with the SAVE_PARROT_WORKSPACES command even if they have been made prior to executing SAVE_WORKSPACES in the EDIT_EXPERIMENT module.

When you exit the EDIT_EXPERIMENT module (or Thermo-Calc), the next time the file is opened it is in the same state as when you executed the SAVE_WORKSPACES command. However, if you use "OPTIMIZE_VARIABLES" on page 154 the computed results are automatically updated.

### Syntax

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SAVE_WORKSPACES</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>&lt;File name&gt; &lt;Y or N&gt;</td>
</tr>
</tbody>
</table>

Sometimes good starting values ("SET_START_VALUE" on page 226) are required to successfully get or compute an equilibrium correctly. In this case, it is important to save the computed equilibrium in the PARROT workspace. It is important to remember that the computed results can be ruined by improper optimizations. For this reason, it is suggested you save the PAR file with a different name to back up the PARROT workspace.

### SELECT_EQUILIBRIUM

If you create more than one initial equilibrium (during data-assessments using the PARROT/ED_EXP modules), you can switch between them using this command.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SELECT_EQUILIBRIUM</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Number /Next/: &lt;Choice on equilibrium&gt;</td>
</tr>
</tbody>
</table>

Answer FIRST, LAST, NEXT, PREVIOUS or PRESENT.

Most commands affect only the PRESENT equilibrium. However, the commands "REINITIATE_MODULE" on page 215 and "DEFINE_COMPONENTS" on page 196 remove all the stored equilibria.

### SET_ALL_START_VALUES

Set start values, e.g. if the calculation fails or if you have a miscibility gap or ordering. If temperature and pressure are not conditions, you are asked for values of them. Then for each phase prompt on if it should be stable and on its constitution.
<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_ALL_START_VALUES</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>T /XXXX/: &lt;Temperature in K&gt;</td>
</tr>
<tr>
<td></td>
<td>If the temperature is not a condition, supply a guess of its final value (in K).</td>
</tr>
<tr>
<td></td>
<td>P /100000/: &lt;Pressure in Pa&gt;</td>
</tr>
<tr>
<td></td>
<td>If the pressure is not a condition supply a guess of its final value (in Pa).</td>
</tr>
<tr>
<td>Prompts</td>
<td>Automatic start values for phase constitutions? /N/: &lt;Y, N or F&gt;</td>
</tr>
<tr>
<td></td>
<td>Answer N (the default), Y or F (for force).</td>
</tr>
<tr>
<td></td>
<td>The reason for the F option is that in some cases the calculation has failed because</td>
</tr>
<tr>
<td></td>
<td>impossible conditions are set, e.g. ( W(C) = 1.5 ) ( W(C) ) is mass fraction</td>
</tr>
<tr>
<td></td>
<td>and must thus be less than unity]. The program tries to fulfil this condition by</td>
</tr>
<tr>
<td></td>
<td>putting maximum amount of carbon in all phases, but can fail anyway. When you detect</td>
</tr>
<tr>
<td></td>
<td>the error and set ( W(C) ) to 0.015, the calculation may still fail because it</td>
</tr>
<tr>
<td></td>
<td>could start from the previous values. To get back to ‘fresh’ start values, give the</td>
</tr>
<tr>
<td></td>
<td>answer F for FORCE.</td>
</tr>
<tr>
<td></td>
<td>If Y this command immediately terminates, and the program automatically sets the</td>
</tr>
<tr>
<td></td>
<td>start values for phase constitutions in all possible phases.</td>
</tr>
<tr>
<td></td>
<td>For N supply an initial amount of each entered phase and the major</td>
</tr>
<tr>
<td></td>
<td>constituents or site fraction of each constituent.</td>
</tr>
<tr>
<td></td>
<td>Should &lt;phase&gt; be stable /N/: &lt;Y/1 or N/2&gt;</td>
</tr>
<tr>
<td></td>
<td>A guess on if this phase should be stable or not is requested. All entered phases are</td>
</tr>
<tr>
<td></td>
<td>prompted for this question and next two.</td>
</tr>
<tr>
<td></td>
<td>You cannot have more phases stable than you have components,</td>
</tr>
<tr>
<td></td>
<td>but at least one (which dissolves all constituents) must be set as stable. For</td>
</tr>
<tr>
<td></td>
<td>backward compatibility, this question can be answered by 1 (for Yes) or 0 (for No).</td>
</tr>
<tr>
<td></td>
<td>The phase name may have a hash sign # followed by a digit, e.g. BCC_A2#2.</td>
</tr>
<tr>
<td></td>
<td>For phases with miscibility gaps, there should be two phases with the same name but</td>
</tr>
<tr>
<td></td>
<td>with different numbers after the hash sign.</td>
</tr>
<tr>
<td></td>
<td>Major constituent(s): &lt;Name of major constituent(s) in the phase&gt;</td>
</tr>
<tr>
<td></td>
<td>The constituent with the largest fraction in the phase should be specified. If</td>
</tr>
</tbody>
</table>
**SET_ALL_START_VALUES**

There are more than one constituent with a large fraction, give them all on the same line. If the default major constituents should be used answer with an asterisk (*). By giving $ the constitution is not changed. If there should be no major constituent give NONE and or if the major constituent(s) are improperly specified, you are asked for individual fractions in the phase.

```
Y(<phase>, <constituent>) / .XXXXXXXXXX/ : <.YYYYY>
```

The current value (.XXXXXXXXXX) is default. You can accept the default by pressing <Enter> or give a new value (.YYYYY).

The phase name or constituent name may have a hash sign # followed by a digit, e.g. Y(BCC_A2#2, FE), Y(BCC_A2#2, C#2). For phases with miscibility gaps, there should be two phases with the same name but with different numbers after the hash sign. For phases with sublattices, the constituents in sublattice 2 or higher is also be suffixed with a hash sign # followed by a digit.

---

**SET_ALTERNATE_CONDITION**

A special command used in the experimental data *.POP/*.DOP file but also possible in the ED_EXP module. It is used only when you have specified that the alternate mode is set in the PARROT module.

The command syntax is almost the same as for the POLY command "SET_CONDITION" on page 220 while the uncertainty should also be specified.

The alternate condition (including the normally POLY-module condition plus uncertainly; see below) must be given explicitly, but can be given on the same line or on separate lines with each one started with the command.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_ALTERNATE_CONDITION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>State variable expression: &lt;State variable name or linear expression&gt;</td>
</tr>
<tr>
<td></td>
<td>Give either a state variable or a linear expression of state variables.</td>
</tr>
<tr>
<td>Options</td>
<td><strong>Description and Information</strong></td>
</tr>
<tr>
<td>State variables</td>
<td>Some of the state variables that can be used in conditions are:</td>
</tr>
<tr>
<td></td>
<td>- T (temperature in the system)</td>
</tr>
<tr>
<td></td>
<td>- P (pressure in the system)</td>
</tr>
<tr>
<td></td>
<td>- N (system size in moles)</td>
</tr>
<tr>
<td>Syntax</td>
<td>SET_ALTERNATE_CONDITION</td>
</tr>
<tr>
<td>--------</td>
<td>-------------------------</td>
</tr>
</tbody>
</table>
| • B (system site in grams) <br> • W(<component>) (mole fraction of a component in the system) <br> • X(<component>) (fraction of a component in the system) <br> • ACR(<component>) (activity of a component in the system) <br> • MUR(<component>) (chemical potential of a component in the system) <br> • W(<phase>,<component>) (mole fraction of a component in a phase) <br> • X(<phase>,<component>) (mass fraction of a component in a phase) <br> • ACR(<phase>,<component>) (activity of a component in a phase) <br> • MUR(<phase>,<component>) (chemical potential of a component in a phase) <br> • H (enthalpy in the system) <br> • HM(<phase>) (enthalpy of a phase per mole) | Factor: <A factor for the state variable, or a continuation>  
This question means that the previous question was not answered. The program is then expecting a single state variable or a complete state variable expression, or the numeric factor in an expression with only one state variable. In a state variable expression a state variable may be preceded by a constant factor. An example of this is:  
2*MUR(FE)+3*MUR(O)=-35000  
This means that it should be a condition that two times the chemical potential of FE plus three times the chemical potential of O should be -35000 J/mol.  
State variable: <A specified state variable, or a continuation>  
This question is prompted if a single state variable name has not given in either the prompt State variable expression or Factor, or a state variable expression is given but the expression is incomplete, for example, T- or 2*MUR(FE)+, for which the program is then expecting a continuation of the unfinished expression. You need to specify a state variable or a complete state variable expression, or complete the unfinished state variable expression. If a numeric factor is given before this prompt, only one state variable can be specified; otherwise, the program only takes the first state variable to complete the expression (i.e. the factor times the state variable). |
<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_ALTERNATE_CONDITION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value /X/:</td>
<td>&lt;A numeric value, a constant or a variable&gt;</td>
</tr>
</tbody>
</table>

The value of the condition. This can be a numeric value, a constant or a variable. A suggestion is given as the default value. The special value **NONE** means that the condition is removed.

<table>
<thead>
<tr>
<th>Uncertainty /None/:</th>
<th>&lt;Uncertainty of the condition&gt;</th>
</tr>
</thead>
</table>

The uncertainty of the condition. This can be a numeric value, a constant or a variable. The default value **NONE** means that the uncertainty for the value specified above is zero. The uncertainty can either be expressed as an absolute value or relative to the value of the condition in percent (x%).

There are more state variables that can be used in conditions. For more information, type an **INFO STATE_VARIABLES** command in the POLY module. A condition is normally a value of a single state variable with its value.

**For example:**

- \( T=1273.15 \)
- \( P=1\times 10^5 \)
- \( X(C)=0.002 \)
- \( W(CR)=1.5 \)
- \( ACR(CR)=0.85 \)
- \( X(FCC,C)=0.001 \)
- \( H=-250000 \)
- \( HM(BCC)=-225000 \)

A condition can also be a value of a linear expression involving more than one state variable.

**For example:**

\[ X(LIQ,S) - X(PYRR,H) = 0 \]

This means that it is a condition that the mole fraction of \( S \) should be the same in the LIQUID and PYRRHOTITE phases. In practice that should be the congruent melting point.

After the equal sign only a numeric value is allowed.
**SET_CONDITION**

Specify the equilibrium conditions for the calculation. All kinds of state variables, as well as most of the M/W/V/F-suffixed state variables (for normalization) and R-suffixed state variables (with respect to chosen reference states), can be used as conditions. Beside temperature and pressure conditions, a multicomponent system can have mixed types of conditions; this brings the extreme flexibility and powerfulness to the complex calculations with the Thermo-Calc software system. You should repeat this command for a multicomponent system, till the degree of freedom in the defined system becomes zero. When a FIXED phase status is used on a specific phase (use "CHANGE_STATUS" on page 186), it is equivalent to one condition (implying that particular phase is stable in the defined system).

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_CONDITION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Each condition must be given explicitly, but can be given on the same line (separated by a comma (,) or an empty space) or on separate lines with each one started with the command.</td>
<td></td>
</tr>
</tbody>
</table>

**Example**

```
SET_COND T=1273, P=1E5, W(C)=.0015, X(LIQ,CR)=.22, ACR(N)=.2
```

or

```
SET_COND T=1273, P=1E5
SET_COND W(C)=.0015, X(LIQ,CR)=.22 ACR(N)=.2
```

In this example, the temperature is set to 1273 K, the pressure to 1 bar (1E5 Pascal), the mass (weight) fraction of C to 0.0015 and the mole fraction of Cr to 0.22 and the activity of N to 0.2.

**Prompt**

State variable expression: `<State variable name or linear expression>` or a linear expression of state variables.

Some of the state variables that can be used in conditions are:

- **T**: temperature in the system (in K)
- **P**: pressure in the system (in Pascal)
- **N**: system size (mole number in moles)
- **B**: system size (mass in grams)
- **N(<component>):** mole number of a component in the system
- **X(<component>):** mole fraction of a component in the system
- **W(<component>):** mass fraction of a component in the system
### Syntax

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_CONDITION</th>
</tr>
</thead>
<tbody>
<tr>
<td>• ACR(&lt;component&gt;): activity of a component in the system</td>
<td></td>
</tr>
<tr>
<td>• MUR(&lt;component&gt;): chemical potential of a component in the system</td>
<td></td>
</tr>
<tr>
<td>• X(&lt;phase&gt;,&lt;component&gt;): mole fraction of a component in a phase</td>
<td></td>
</tr>
<tr>
<td>• W(&lt;phase&gt;,&lt;component&gt;): mass fraction of a component in a phase</td>
<td></td>
</tr>
<tr>
<td>• ACR(&lt;species&gt;,&lt;phase&gt;): activity of a species in a solution phase</td>
<td></td>
</tr>
<tr>
<td>• MUR(&lt;species&gt;,&lt;phase&gt;): chemical potential of a species in a solution phase</td>
<td></td>
</tr>
<tr>
<td>• H: enthalpy in the system (in J)</td>
<td></td>
</tr>
<tr>
<td>• HM(&lt;phase&gt;): enthalpy of a phase (in J/mol)</td>
<td></td>
</tr>
</tbody>
</table>

There are many state variables that can be used in conditions. For more information, enter an INFO STATE_VARIABLES command. A condition is normally a value of a single state variable with its value.

**Example**

```
T=1273.15  P=1E5
X(C)=.002
W(CR)=0.5
ACR(CR)=0.85
X(FCC,C)=.001
H=-250000
HM(BCC)=-225000
```

A condition can also be a value of a linear expression involving more than one state variable. For example,

```
X(LIQ,S) - X(PYRR,S) = 0
```

This means that it is a condition that the mole fraction of S component should be the same in the LIQUID and PYRRHOTITE phases. In practice, that should be the congruent melting point.

> After the equal sign only a numeric value is allowed in the expression.

**Factor:** `<A factor for the state variable, or a continuation>`

This question means you did not answer the previous question. The program is
Calculation

This message only displays: Two times the chemical potential of \( \text{FE} \) plus three times the chemical potential of \( \text{O} \) should be -35000 J/mol.

**SET_CONDITION**

then expecting a single state variable or a complete state variable expression, or the numeric factor in an expression with only one state variable. In a state variable expression a state variable may be preceded by a constant factor. An example of this is:

\[
2 \times \text{MUR} (\text{FE}) + 3 \times \text{MUR} (\text{O}) = -35000
\]

This means that it should be a condition that two times the chemical potential of \( \text{FE} \) plus three times the chemical potential of \( \text{O} \) should be -35000 J/mol.

**State variable:** <A specified state variable, or a continuation>

This question is prompted if a single state variable name has not given in either the prompt State variable expression or Factor, or a state variable expression is given but the expression is incomplete, for example, \( T- \) or \( 2 \times \text{MUR} (\text{FE}) + \), for which the program is then expecting a continuation of the unfinished expression. You need to specify a state variable or a complete state variable expression, or complete the unfinished state variable expression. If a numeric factor is given before this prompt, only one state variable can be specified; otherwise, the program only takes the first state variable to complete the expression (i.e. the factor times the state variable).

**Value /X/:** <A numeric value, a constant or a variable>

The value of the condition. This can be a numeric value, a constant or a variable. A suggestion is given as the default value. The special value NONE means that the condition is removed; for example \( T=\text{NONE} \) takes away the temperature condition.

**SET_NUMERICAL_LIMITS**

Change the criteria for convergence. This is to speed up a calculation in a complex system.

If there is any convergence problem in finding a stable solution at any stage during a calculation procedure enforced by "COMPUTE_EQUILIBRIUM" on page 190, "STEP_WITH_OPTIONS" on page 227, "MAP" on page 212 or "ADVANCED_OPTIONS" on page 174), this message displays:

Convergence problems, increasing smallest site-fraction from 1.00E-30 to hardware precision 2.00E-14. You can restore using SET_NUMERICAL_LIMITS

This implies that smallest site fraction in the current POLY3 workspace is automatically increased from the default value 1.00E-30 to the hardware-dependent precision (under Linux, as 2.00E-14). For other subsequent POLY-module calculation in the current Thermo-Calc (Console Mode) run, you can use this command to restore or reset the smallest site
fraction to the previous or another preferred value, as well as to reset other numerical limits.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_NUMERIC_LIMITS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Maximum number of iterations /200/: &lt;xxx&gt;</td>
</tr>
<tr>
<td></td>
<td>By default, the program tries 500 iterations before it gives up. As some models give computation times of more than 1 CPU second/iteration, this number is also used to check the CPU time and the calculation stops if 500 CPU seconds/iterations are used.</td>
</tr>
<tr>
<td></td>
<td>Required accuracy /1E-6/: &lt;yyy&gt;</td>
</tr>
<tr>
<td></td>
<td>This is a relative accuracy, and the program requires that the relative difference in each variable must be lower than this value before it has converged. A larger value normally means fewer iterations but less accurate solutions. The value should be at least one order of magnitude larger than the machine precision.</td>
</tr>
<tr>
<td></td>
<td>Smallest fraction /1E-12/: &lt;zzz&gt;</td>
</tr>
<tr>
<td></td>
<td>This is the value assigned to constituents that are unstable. It is normally only in the gas phase you can find such low fractions.</td>
</tr>
<tr>
<td></td>
<td>The default value for the smallest site-fractions is 1E-12 for all phases, except for IDEAL phase with one sublattice site (such as the GAS mixture phase in many databases) for which the default value is always as 1E-30 (unless you have used the SET_NUMERIC_LIMITS command to reset an even-lower value (e.g. 1E-45, that is naturally enforced to all the phases in the system).</td>
</tr>
<tr>
<td></td>
<td>Approximate driving force calculation for metastable phases /Y/: &lt;Y or N&gt;</td>
</tr>
<tr>
<td></td>
<td>Normally the POLY module only requires that the set of stable phases is in equilibrium in order to terminate the iterations. The metastable phases are included in all iterations but these may not have reached their most favourable composition and thus their driving forces may be only approximate [corresponding to Y]. You can also force the calculation to converge for the metastable phases by answering N if it is important that these driving forces are correct, which may require more iterations, and the STEP and MAP command may also terminate due to bad convergence in a metastable phase.</td>
</tr>
</tbody>
</table>

**SET_REFERENCE_STATE**

The reference state for a component is important when calculating activities, chemical potentials and enthalpies. The reference state for a component is determined by the
database. For each component the data must be referred to a selected phase, temperature and pressure, i.e. the reference state. All data in all phases where this component dissolves must use the same reference state. However, different databases may use different reference states for the same element. Thus you must be careful when, for example, mixing data from different databases.

By default, activities, chemical potentials, etc. are computed relative to the reference state used by the database and this may thus differ depending on the database. With this command select the reference state for a component if the reference state in the database does not suit.

You can set the reference state for a component as SER, i.e. the Stable Element Reference (which is usually set as default for a major component in alloys that is dominated by the component). Under such a case, the temperature and pressure for the reference state is not needed and thus is not prompted.

In order to specify conditions in the specified reference state, you can append an R to the state variables. Thus, AC is the activity (of a system component or of a species in a phase) with respect to the default reference state, and ACR is the activity with respect to the selected reference state; MU is the chemical potential of a system component with respect to the default reference state, and MUR stands for the chemical potential with respect to the selected reference state. The AC and ACR variables, for both components in a system and species in a phase, can be specified in natural logarithm, e.g. LNAC(Fe), LNACR(C), LNAC(O2,GAS), LNACR(O2,GAS).

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_REFERENCE_STATE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompts</td>
<td>Component: &lt;Name of the component&gt;</td>
</tr>
<tr>
<td></td>
<td>The name of the component must be given.</td>
</tr>
<tr>
<td></td>
<td>Reference phase: &lt;Name of a phase used as the new reference state&gt;</td>
</tr>
<tr>
<td></td>
<td>The Name of a phase, that must be either ENTERED or DORMANT or SUSPENDED, must be given here. The component must, of course, be a constituent of this phase.</td>
</tr>
<tr>
<td></td>
<td>For a phase to be usable as reference for a component the component need to have the same composition as an end member of the phase. The reference state is an end member of a phase. For example, in the Fe-C system, BCC can be a reference state for Fe but not for C since BCC cannot exist as pure C.</td>
</tr>
<tr>
<td></td>
<td>If a component has the same composition as several end members of the chosen reference phase, then the end member is selected that at the specified temperature and pressure has the lowest Gibbs energy. For example, setting the reference state for component O as gas (one sublattice) with constituents</td>
</tr>
</tbody>
</table>
Syntax

<table>
<thead>
<tr>
<th>SET_REFERENCE_STATE</th>
</tr>
</thead>
</table>

O1, O2 and O3 results in O2 being the reference state if, at the present temperature, pure O2 has the lowest energy of O1, O2 and O3. If the reference state is set above a critical higher temperature, then O1 has the lowest energy and consequently become the reference state.

The actual calculation of the reference state is only performed when SET_REFERENCE_STATE is executed. For example, if GAS is chosen as the reference phase of component O at such a high temperature that O1 has the lowest energy, then O1 remains the reference state even at calculations performed at lower temperatures where O2 has a lower energy than O1.

Temperature */*: <Temperature for the reference state>

Select the temperature (in K) for the reference state. The wildcard value * means the current temperature is used for the calculation.

Pressure /1E5/: <Pressure for the reference state>

Select the pressure (in Pa) for the reference state. The wildcard value * means the current pressure is used for the calculation.

Examples

S-R-S Fe SER
S-R-S Cr FCC * 100000
S-R-S H2O AQUEOUS * 100000
S-R-S ZE REF_ELECTRODE * 100000

SET_START_CONSTITUTION

This command is similar to "SET_ALL_START_VALUES" on page 217, but is used for an individual phase that may have a wrong constitution.
**Syntax**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
</table>
| **SET_START_CONSTITUITION** | Phase name: <Name of a phase, and possible major constituent(s)>  
Specify the name of a phase for which the constitution shall be set.  
If there is a major constituent of the phase, you must specify this on the same line as the phase name. By giving an*, select the default major constituents. A $ means keeping the same constitution, and NONE means to give individual site-fractions. |
| **Y(Phase)#<Composition_set>,<Constituent>#<Sublattice>) /xxx/: <SF>** | The site fraction (SF) of the constituent shall be given. The default value xxx is the last calculated one. |

**SET_START_VALUE**

Set a start value of an individual variable.

This command is not often required as the automatic start values can be handled for most problems.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
</table>
| **SET_START_VALUE** | State variable: <Name of a state variable>  
The state variable must be given. |
| **Value** | Specify the value to be assigned the state variable as start value. |

**SET_WEIGHT**

Each experimental value has an uncertainty associated with it, specified by the value after the colon (:) with the command "EXPERIMENT" on page 44. During an optimization the absolute difference between the experimental and calculated values gives a contribution to the sum of error.

With the SET_WEIGHT command, you can change the scale of such a contribution (the uncertainty) for a single experimental point, or the contributions (all uncertainties) for a set of equilibria. The default weight is always unity. A value smaller than one means that the experiments should have less weight. A value larger than one that these should have higher weight. The special value zero means that the set of equilibria should be ignored in editing.
The weight may be needed to obtain a balance between different kinds of experiments. For example, if there are only five experimental values of the composition of a phase diagram but 500 experimental values of activities or enthalpies, then the five composition points may have to be given higher weight than unity, otherwise these are not well described by the optimizing procedure.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_WEIGHT</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Value /1/:</strong> &lt;Weight value&gt;</td>
</tr>
<tr>
<td></td>
<td>Specify a weight of the experiments in the specified equilibria (asked in the next prompt). The contribution to the sum of errors of these experiments are multiplied by this weight.</td>
</tr>
<tr>
<td></td>
<td>The weight is squared, thus use 0.7 to make the error half (0.49) as big, and 1.4 to make it twice (1.96) as large.</td>
</tr>
<tr>
<td></td>
<td><strong>Equilibria (range) or label(s) /Present/:</strong>&lt;Selection&gt;</td>
</tr>
<tr>
<td></td>
<td>Define the equilibria. These are available in the read data block from the current work file and are given the above-defined weight.</td>
</tr>
<tr>
<td></td>
<td>The selection may be given as a range but the equilibrium numbers must then be separated only by a minus sign.</td>
</tr>
<tr>
<td></td>
<td>The start and end equilibrium numbers must be available in the read data block read from the current work file.</td>
</tr>
<tr>
<td></td>
<td>For example, 5–101, means that all equilibria starting from the identifier 5 until the identifier 101. Some of numbers between these two identifiers may not exist in the data block.</td>
</tr>
<tr>
<td></td>
<td>The selection may also be given as one or more labels (which should be separated only by a space). All equilibria with the specified label(s) in the read data block are given the above-defined weight.</td>
</tr>
<tr>
<td></td>
<td>By pressing &lt;Enter&gt; to accept the default value present, the above defined weight is only assigned to the current or present experimental point (which is selected by the POLY command &quot;SELECT_EQUILIBRIUM&quot; on page 216).</td>
</tr>
<tr>
<td></td>
<td>If &quot;COMPUTE_ALL_EQUILIBRIA&quot; on page 37 is used but no specific equilibrium point is selected afterwards, the last point in the read data block remains the present point.</td>
</tr>
</tbody>
</table>
**SHOW_VALUE**

Show the current value of any state variable, function or variable.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SHOW_VALUE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td></td>
</tr>
</tbody>
</table>

State variable or symbol: `<Name(s) of state variable(s) or symbol(s)>`

A single or several state variables or symbols (entered functions or variables) can be specified.

The wildcard * can be used to denote all phases or all components.

You can use the dollar-sign $ to denote all stable phases. Thus, the command `SHOW W(*,*`) lists the mass fraction of all phases, whereas `SHOW W($,*`) lists the mass fraction of all stable phases.

If you SHOW a function, all functions are evaluated using the current values of the state variables. But if you SHOW a variable, it retains its value from the time it was ENTERED or last EVALUATED.

Therefore to save a value from one calculation to another, ENTER it to a variable. This is frequently done in the PARROT module to transfer values between equilibria.

**STORE_ALL_WEIGHTS**

Store a new weight-set that is the current situation of specified weights for all the different experimental points read from the currently-selected experimental data block in an assessment. This is useful when you want to try various weight-settings for some experimental points or for all the points, and then compare the assessment results from different weight-sets. Such a saved weight-set can be recalled and restored for all experimental data point with "RESTORE_ALL_WEIGHTS" on page 54 sequentially.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>STORE_ALL_WEIGHTS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td></td>
</tr>
</tbody>
</table>

Command line: `<Weight-set name>`

Give a weight-set name (comment line texts) for the current weight set for all experimental points.

**TABLE_HEAD, TABLE_VALUES and TABLE_END**

These commands are used only in the *.POP/*.DOP files. It represents a convenient way to enter many experimental measurements of the same type in a table format.
These commands should always be used together and in a sequence, meaning that a table should always start with the TABLE-HEAD command, then follows the TABLE-VALUES command, and finish by the TABLE-END command. Between the two TABLE-HEAD and TABLE-VALUES commands, there should exist some definition lines (e.g. on phase status, reference states, conditions, experiments, labels, etc.) for the experimental measurements of the current information type.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>TABLE_HEAD</th>
<th>TABLE_VALUES</th>
<th>TABLE_END</th>
</tr>
</thead>
</table>

**Prompt**

After the TABLE-HEAD command, there must be an equilibrium description similar to a single experimental equilibrium but with some special notation. Then, there is always a TABLE-VALUES command, after which the actual data is given in columns. At the end of each table, there must be a TABLE-END command.

The TABLE-HEAD command must be followed by a numeric value. This is used to generate unique numeric identifiers for all the equilibria in the table. The numeric identifier is incremented by one for each experimental (equilibrium) point in the table.

**Example**

An example of the use of a table for enthalpy measurements in the liquid is given here. Much more elaborate tables can be used

```
$ Enthalpies of mixing, Topor and Kleppa, Met Trans 1984 TABLE-HEAD 1
CREATE-NEW @@ 1
CHANGE-STATUS PHASE LIQ=FIX 1
SET-REFERENCE-STATE AU LIQ * 1E5
SET-REFERENCE-STATE CU LIQ * 1E5
SET-CONDITION P=1E5 T=1379 X(LIQ,AU)=@1
LABEL ALH
EXPER HMR=02:5%
TABLE-VALUES
0.0115 -322
```
### Syntax

<table>
<thead>
<tr>
<th>TABLE_HEAD</th>
</tr>
</thead>
<tbody>
<tr>
<td>TABLE_VALUES</td>
</tr>
<tr>
<td>TABLE_END</td>
</tr>
</tbody>
</table>

#### TABLE—VALUES

- 0.0563 -1520
- 0.8499 -2976
- 0.9002 -2114

#### TABLE—END

The equilibrium description between TABLE-HEAD and TABLE-VALUES is similar as for a single experiment, except for these details:

- @@ Used to automatically generate a series of identifying numbers instead of creating only one with the command "CREATE_NEW_EQUILIBRIUM" on page 195. The program automatically generates the identifying numbers starting after the number given after the TABLE-HEAD command (in this case it is 1).

- @1 values in the table are specified by an @ sign followed by a column number. In the above case, the mole fraction of Au in the liquid is in column 1 (see the line for SET-CONDITION). The columns may have other information than values, and you can use phase names or any text. If the text contains spaces or special characters, it must be surrounded by double quotes in the table, e.g. "ABC DEF&ghi".

- For the syntax checker all commands describing the equilibrium must be in UPPER case after the TABLE-HEAD command.

- After the TABLE-VALUES command, there should be one line for each experimental measurement of the same type giving the values or texts that should be copied into the places of the condition or experiment defined by @1, t, etc. You can have columns that are not used but there must be exactly the same number of columns of each line, otherwise the syntax checker gives an error message in the PARROT module.

---

**TRANSFER_START_VALUES**

In the ED_EXP module it is time consuming to calculate all equilibria when the optimization is sensitive to start values of the composition of the phases. Usually in one data block there are several experimental points with the same kind of equilibrium and each must have its start value set. When you manage to calculate equilibriums of such experimental points, this command is useful to transfer the site fractions from a successfully-calculated equilibria to the present experimental point.
<table>
<thead>
<tr>
<th>Syntax</th>
<th>TRANSFER_START_VALUES</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>From equilibrium /Previous/: &lt;Equilibrium number&gt;</td>
</tr>
</tbody>
</table>

The equilibrium number is the numeric identifier for the equilibrium from which the start values should be copied to the present experimental point. Previous is the default if you press <Enter>.
Experimental Data Files

In this section:

- Commands in the Experimental Data Files (*.POP, *.DOP) ........................................... 73
- TABLE_HEAD, TABLE_VALUES and TABLE_END ................................................................. 75
- COMMENT .......................................................................................................................... 77
- FLUSH_BUFFER ............................................................................................................... 77
Commands in the Experimental Data Files (*.POP, *.DOP)

In order to conduct an assessment for a system, the experimental data is described with a syntax, which is similar to the way that one calculates an equilibrium in the POLY module or you edit an experimental point in the ED_EXP module. Similar to a Thermo-Calc (TCC) macro file (*.TCM), an experimental data file (i.e. the *.POP or *.DOP file) is a basic text file and can be opened and edited by any text editor. For this reason, an *.POP or *.DOP file is not hardware dependent.

A POP or DOP file consists of various commands from the POLY and ED_EXP modules, as well some special commands which can only be used in such experimental data files. Various experimental information can be inputted in an *.POP or *.DOP file as different tables; the same type of experimental data are usually documented in the same table (see below).

An *.POP or *.DOP file is used in the PARROT module to provide experimental information for the optimization process, and is checked by a syntax checker when the PARROT command "COMPILE_EXPERIMENTS" on page 137 is proceeded.

Many POLY and ED_EXP commands can be directly used in a POP or DOP file. But there are some differences with the set of POLY or ED_EXP commands, and some specially designed commands as described in this topic can only be used in the *.POP or *.DOP files.
Frequently Used Commands

Most of the commands in the experimental data file are the same as in the POLY module. The most frequently used are listed below:

- "CREATE_NEW_EQUILIBRIUM" on page 195
- "CHANGE_STATUS" on page 186
- "SET_CONDITION" on page 220
- "SET_REFERENCE_STATE" on page 224
- "ENTER_SYMBOL" on page 247
- "SAVE_WORKSPACES " on page 54

As the last command in an *.POP or *.DOP file, you must always have the SAVE command.

Other Commands

Other legal commands from the POLY module that are used less often are:

- "DEFINE_COMPONENTS" on page 196
- "EVALUATE_FUNCTIONS" on page 208
- "SET_ALL_START_VALUES" on page 217
- "SET_NUMERICAL_LIMITS" on page 296
- "SET_START_VALUE" on page 226
- "ADVANCED_OPTIONS" on page 174

The DEFINE-COMPONENTS command must be always used as the first command in an *.POP or *.DOP file, as it automatically reinitiates the whole workspace.

Most of the special commands for the ED_EXP module are also often used in an *.POP or *.DOP file. For example:
The following special ED_EXP commands are illegal and should not be used in any *.POP or *.DOP file:

- COMPUTE-ALL-EQUILIBRIA
- MAKE-POP-FILE
- READ (READ-BLOCK OR READ-WORKSPACE)
- TRANSFER-START-VALUES

The special commenting identifier, i.e. a single dollar sign $ which starts a line, is used to document comment lines at any position in an *.POP or *.DOP file. You may remember that this feature is universally the same as in almost all kinds of text files in Thermo-Calc software, e.g. in *.TDB, *.DAT, *.TCM, *.POP/*.DOP and *.EXP files. Such a sign and all information after wards in the same comment line is skipped and ignored by the syntax checker. Therefore, you shall feel free to write such comment lines in any of these types of text files.

**TABLE_HEAD, TABLE_VALUES and TABLE_END**

These commands are used only in the *.POP/*.DOP files. It represents a convenient way to enter many experimental measurements of the same type in a table format.

These commands should always be used together and in a sequence, meaning that a table should always start with the TABLE-HEAD command, then follows the TABLE-VALUES command, and finish by the TABLE-END command. Between the two TABLEHEAD and TABLE-VALUES commands, there should exist some definition lines (e.g. on phase status, reference states, conditions, experiments, labels, etc.) for the experimental measurements of the current information type.
After the TABLE-HEAD command, there must be an equilibrium description similar to a single experimental equilibrium but with some special notation. Then, there is always a TABLE-VALUES command, after which the actual data is given in columns. At the end of each table, there must be a TABLE-END command.

The TABLE-HEAD command must be followed by a numeric value. This is used to generate unique numeric identifiers for all the equilibria in the table. The numeric identifier is incremented by one for each experimental (equilibrium) point in the table.

**Example**

An example of the use of a table for enthalpy measurements in the liquid is given here. Much more elaborate tables can be used

```plaintext
$ Enthalpies of mixing, Topor and Kleppa, Met Trans 1984 TABLE-HEAD 1
CREATE—NEW @@ 1
CHANGE-STATUS PHASE LIQ=FIX 1
SET-REFERENCE-STATE AU LIQ * 1E5
SET-REFERENCE-STATE CU LIQ * 1E5
SET-CONDITION P=1E5 T=1379 X(LIQ,AU)=@1
LABEL ALH
EXPER HMR=@2:5%
TABLE—VALUES
0.0115 -322
0.0563 -1520
0.8499 -2976
0.9002 -2114
TABLE—END
```

The equilibrium description between TABLE-HEAD and TABLE-VALUES is similar as for a single experiment, except for these details:

- @@ Used to automatically generate a series of identifying numbers
instead of creating only one with the command "CREATE_NEW_EQUILIBRIUM" on page 195. The program automatically generates the identifying numbers starting after the number given after the TABLE-HEAD command (in this case it is 1).

- @1 values in the table are specified by an @ sign followed by a column number. In the above case, the mole fraction of Au in the liquid is in column 1 (see the line for SET-CONDITION). The columns may have other information than values, and you can use phase names or any text. If the text contains spaces or special characters, it must be surrounded by double quotes in the table, e.g. “ABC DEF&ghi”.

- For the syntax checker all commands describing the equilibrium must be in UPPER case after the TABLE-HEAD command.

- After the TABLE-VALUES command, there should be one line for each experimental measurement of the same type giving the values or texts that should be copied into the places of the condition or experiment defined by @1, t, etc. You can have columns that are not used but there must be exactly the same number of columns of each line, otherwise the syntax checker gives an error message in the PARROT module.

**COMMENT**

This command is only used in the *.POP/*.DOP files to write brief comments or descriptive information on a newly created equilibrium (experimental) data point or a set of points given in a table.

**FLUSH_BUFFER**

This command is only used in the *.POP/*.DOP files. It is needed if the number of experiments require more space than can be fitted into one buffer. When the PARROT program compiles experiments, it informs if any FLUSH commands are needed. The FLUSH_BUFFER command terminates the current block, save it to the work file and starts a new block. With the READ command in the EDIT-EXP module, you can select the block to edit.
<table>
<thead>
<tr>
<th>Syntax</th>
<th>FLUSH_BUFFER</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>After a FLUSH_BUFFER command, the workspace is reinitiated and all functions or constants must be entered again in the *.POP file. You can take advantage of this; for example, you can use the FLUSH command to have blocks with different components in one *.POP file.</td>
<td></td>
</tr>
</tbody>
</table>
Gibbs Energy System (GES) Commands

In this section:

ADD_COMMENT ................................................................. 81
AMEND_ELEMENT_DATA ...................................................... 81
AMEND_PARAMETER ............................................................ 82
Solution Models in the GIBBS Module .................................. 85
AMEND_PHASE_DESCRIPTION ............................................... 93
AMEND_SYMBOL ............................................................... 97
CHANGE_STATUS .............................................................. 100
ENTER_ELEMENT ............................................................... 101
About the ENTER_PARAMETER Command .............................. 101
Defining the Parameter ...................................................... 102
ENTER_PARAMETER ............................................................ 105
About the ENTER_PHASE Command ...................................... 107
ENTER_PHASE ................................................................. 110
ENTER_SPECIES ............................................................... 112
ENTER_SYMBOL ............................................................... 113
LIST_CONSTITUENT ............................................................ 119
LIST_DATA .......................................................... 120
LIST_PARAMETER ............................................................... 121
LIST_PHASE_DATA ............................................................. 122
LIST_STATUS ................................................................. 122
LIST_SYMBOL ................................................................. 126
READ_GES_WORKSPACE .................................................... 126
REINITIATE ................................................................. 127
SAVE_GES_WORKSPACE .................................................... 128
SET_R_AND_P_NORM

................................................................................................................................................. 128
**ADD_COMMENT**

<table>
<thead>
<tr>
<th>Syntax</th>
<th>ADD_COMMENT</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Add a comment or make notes about parameters.</td>
</tr>
</tbody>
</table>

**AMEND_ELEMENT_DATA**

The data for an element (in the SER, the Stable Element Reference, state) can be changed by this command. It should only be used for the elements that do not have any data in the database because the element data available in the database is set by the database-developer for the purpose of internal consistency. Except for the mass, the other values have no influence on the calculations.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>AMEND_ELEMENT_DATA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompts</td>
<td></td>
</tr>
<tr>
<td>Element name: &lt;Element name&gt;</td>
<td>Specify the name of the element for which you want to change the data.</td>
</tr>
<tr>
<td>New stable element reference /ABCD/: &lt;Name of ser&gt;</td>
<td>Press &lt;Enter&gt; to accept the default SER or specify a new SER for the element. Important: The default name should not be changed if this data is retrieved from a database. This name is used when parameters for a phase are listed and the database assumes that the stable element reference is the same as in the database. Only if the element's data have not been fetched from a database, e.g. entered manually, can you enter a new SER.</td>
</tr>
<tr>
<td>New atomic mass /xx.xxxx/: &lt;yyyyyy&gt;</td>
<td>Press &lt;Enter&gt; to accept the default atomic mass or specify a new value for the element. The atomic mass of the element is given in g/mol.</td>
</tr>
<tr>
<td>New h(298.15)-h(0) /xxx.xxx/: &lt;yyyyy&gt;</td>
<td>Press &lt;Enter&gt; to accept the default H(298.15)-H(0) or specify a new value for the element. H(298.15)-H(0) is the enthalpy difference between 298.15 K and 0 K for the element in its SER state.</td>
</tr>
<tr>
<td>New s(298.15) /xx.xxxx/: &lt;yyyyy&gt;</td>
<td>Press &lt;Enter&gt; to accept the default S(298.15) or specify a new value for the element. S(298.15) is the absolute value of the entropy at 298.15 K for the element in its SER state.</td>
</tr>
<tr>
<td>Default element reference state symbol index /#: &lt;index&gt;</td>
<td></td>
</tr>
</tbody>
</table>
The index only changes the symbol, not any value. Normally the index is set correctly by the database. Only when manually entering data, you must set the index to get the correct symbol.

Specify an index for the default listing parameters (symbol), or press <Enter> to accept the pre-set index. 0 is for G, 1 is for H298 and 2 is for H0.

The index is to define the symbol printed in parameter listings. The symbol can be:

- G the data are referred to Gibbs energy at a variable temperature (also called lattice stability).
- H298 the data are referred to the enthalpy of the element at 298.15 K and 1 bar.
- H0 is the same as H298 but at the temperature 0 K.

**AMEND_PARAMETER**

This AMEND_PARAMETER command is for the GES module. There is also a PARROT module command with the same name ("AMEND_PARAMETER" on page 132).

Use this command to interactively change/amend the temperature-pressure function of a parameter. This is useful to correct typing errors because the old function is made available on the terminal for interactive editing. For most of these prompts, refer to "ENTER_PARAMETER" on page 143 for details.
<table>
<thead>
<tr>
<th>Syntax</th>
<th>AMEND_PARAMETER</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specify one of these legal identifiers as described for ENTER_PARAMETER.</td>
<td></td>
</tr>
<tr>
<td>Phase name (/ABCD/): &lt;Phase name&gt;</td>
<td></td>
</tr>
<tr>
<td>Specify the phase name.</td>
<td></td>
</tr>
<tr>
<td>Constituent (in sublattice # /ABC/): &lt;Species name&gt;</td>
<td></td>
</tr>
<tr>
<td>Specify the constituent name.</td>
<td></td>
</tr>
<tr>
<td>Interacting constituent (in sublattice # /xyz/): &lt;Species name&gt;</td>
<td></td>
</tr>
<tr>
<td>Specify the interacting constituent name: If there is no interacting constituent, press &lt;Enter&gt;.</td>
<td></td>
</tr>
<tr>
<td>Interacting constituent (in sublattice # /xyz/): &lt;Species name&gt;</td>
<td></td>
</tr>
<tr>
<td>If there are more than one interacting constituents, specify them; otherwise press &lt;Enter&gt;.</td>
<td></td>
</tr>
<tr>
<td>Degree /#/: &lt;Degree&gt;</td>
<td></td>
</tr>
<tr>
<td>Specify a numerical number as the degree of the phase parameter.</td>
<td></td>
</tr>
</tbody>
</table>

After the parameter name is specified correctly, the program lists its current definition (either present in the database or defined by the ENTER_PARAMETER command), such as:

```
L(PHASE2,AL,MO;1)=
298.15<T<2000.00: +5000
2000.00<T<4500.00: +4500
4500.00<T<6000.00: +4000
```

Then you are prompted to change the parameter definition, as shown below:

Do you want to change the number of ranges /NO/: <Y or N>

If you want to change the number of ranges for the chosen function, or change some of the temperature limits in the definition, for Y, retype both the low/high temperature limits and functions.

If you do not want to change the number of ranges but want to change the function(s) in one or more ranges, press <Enter> to accept the default N, then the whole definition of the chosen parameter in all ranges (if any) is listed on screen, such as:

```
DIFFERENT FUNCTIONS IN THESE RANGES
```
### Syntax

<table>
<thead>
<tr>
<th>AMEND_PARAMETER</th>
</tr>
</thead>
<tbody>
<tr>
<td>298.15&lt;T&lt;2000.00</td>
</tr>
<tr>
<td>2000.00&lt;T&lt;4500.00</td>
</tr>
<tr>
<td>4500.00&lt;T&lt;6000.00</td>
</tr>
</tbody>
</table>

The prompt is given:

Do you want to change range limits /No/: <Y or N>

If there is more than one range, this question is prompted press <Enter>.

Range number (0 to exit) /0/: <Range number>

If the function of a parameter is different in two or more temperature ranges, you must specify the range of the function of which you want to amend. Or press <Enter> or type 0 to exit this command without making any changes.

### Function:

The previous function is available for editing. The editing is performed within the general subroutine FOOLED, as described in "AMEND_SYMBOL" on page 134. This routine prompts as follows:

1:+:>

The prompt consists of the current position in the string and the character at that position between colons, (::).

### Commands

These commands can be given:

- Help: ?
- Move CP to last or first character: <+/-> A
- Delete characters from CP: <+,#characters> D
- Exit: E
- Find: <#occurrences> F<string>@
- Insert: I<string>@
- Move: <+,#positions> M
- Restore string: R
- Substitute: S<OLD>@<NEW>@
- Type string: T
Syntax | AMEND_PARAMETER
--- | ---
Where CP denotes the current position in string, # means number of, @ is a terminator of an input or search string.

When the string is typed the character at the current position is replaced by an underscore _.

To finish the editing of the current function, type ✏ at the prompt.

**Solution Models in the GIBBS Module**

The command "AMEND_PHASE_DESCRIPTION" on page 93 is used to specify/amend phase descriptions if a phase has a miscibility gap, uses a special excess energy model, or has a specific additional contribution to its Gibbs energy, for example.

This topic outlines the application of each option and includes important information about each command.

There are many solution models implemented in the GIBBS module (type INFO MODELS to see details about various thermodynamic models). However, these are switched on and handled differently via various GIBBS routines/commands:

- The first models the non-ideality as excess parts, i.e. by amending the phase’s EXCESS_MODEL and/or TERNARY_EXTRAPOLAT models.
- The second models the non-ideality as ADDITIONAL parts, i.e. by amending the phase’s other subjects in this command, e.g. MAGNETIC_ORDERING for the Magnetic Ordering Model, DISORDERED_PART for the CVM Approach in modelling chemical ordering/disordering phenomenon, QUASICHEM_IONIC for using a quasi-chemical entropy term for an ionic two-sublattice liquid solution phase, QUASICHEM_FACT00 or QUASICHEM_IRSID for describing a substitutional liquid solution phase, DEBYE_HUCKEL for the DHLL/SIT Model in describing a dilute aqueous solution phase, etc.
- The third implements the model entirely or partially into the GIBBS module and related database(s), such as for the electrostatic contribution in an AQUEOUS solution phase by the Complete Revised_HKF Model, the Murngham Model, Birch-Murngham Model or Generalized PVT Model for high-pressure/temperature volume contribution in a solid or liquid phase, the SUPERFLUID Model for the non-ideal EOS and non-ideal mixing in a gaseous mixture.

**NEW_CONSTITUENT**

Use this if you want to add a new constituent to a phase. It is illegal to add new constituents
to an ionic two-sublattice liquid phase.

**RENAME_PHASE**

Use this to change the names of some specific phases. For example, a phase called \textit{FE3O4\_S} may be better named \textit{Magnetite} to help identify it during the calculations and postprocessing. This is also a way to delete a phase by hiding it under a new name.

**SITE_RATIOS**

Use this to change the number of sites (i.e. the stoichiometric coefficients of various sublattices) in a sublattice phase.

**COMPOSITION_SETS**

Use this for solution phases that may have miscibility gap(s). However, this is less important today and often unnecessary to define additional composition set(s), since the implemented Global Minimization Technique can usually detect and add such composition set(s) in an automatic manner where it is really necessary during equilibrium calculations (of single-points, stepping or mapping).

**MAJOR_CONSTITUENT**

Use this to set major constituent(s) on each sublattice in each composition set for a solution phase. This is useful to make calculations converge faster because it may simplify giving start values when calculating the equilibrium as those phases with miscibility gaps should have different major constituents for each composition set. The databases often set major constituents for several phases automatically when data are retrieved.

**FRACTION_LIMITS**

Use this to limit the application range (in terms of mole-fractions of all the involved elements) of a particular solution phase. This is useful to avoid automatic creations (enforced by the Global Minimization Technique) of additional composition sets for some solution phases (such as AQUEOUS solutions or dilute Fe-based liquid mixtures) of which the used models [e.g. the SIT Model or the Complete Revised HKF Model for AQUEOUS solution, or the modified dilute solution parameters (plus a quadratic term, according to Hillert (1986) based on the SigworthElliot Model (Sigworth and Elliot, 1974) for Fe-rich liquid mixture] cannot be appropriately applied on a full scale.

Globally set the composition limits (in terms of mole fractions of various elements) in a specific solution phase, so that whenever the program finds a potential phase composition or
a new composition set of possible miscibility gap(s) but that is out of this globally-set composition range, the program automatically ignores such a phase composition in an equilibrium calculation. This can be done either permanently inside a database (by enforcing this option for amending the phase-description of the solution phase) or temporarily within the GIBBS module (by using this phase-description amendment option).

This is important for solution phases for which the thermodynamic models and assessed data for the phases are for specific composition ranges, for example, the FE_LIQUID phase in the SLAG database is only applicable for Fe-rich liquid mixture, and the AQUEOUS phase in the TCAQ/PAQ and AQS/PAQS databases is only applicable for H2O-dominant aqueous solution phase.

Specify the low and high mole-fraction limits for each of the elements possibly available within the considered phase (in the currently defined system, or in a certain database). Do this for all the possible elements (defined in the phase) in a single AMEND_PHASE_DESCRIPTION FRACTION_LIMITS command-sequence, for example:

```
TYPE_DEFINITION R GES AM_PH_DESC FE_LIQUID FRACTION_LIMITS Fe 0 0.6
    Ag 0 0.01 Al 0 0.05 Ca 0 0.05 Co 0 0.01 Cr 0 0.01
    Cu 0 0.02 Mg 0 0.05 Mn 0 0.05 Mo 0 0.05 Nb 0 0.05
    Ni 0 0.05 Pb 0 0.05 Si 0 0.10 Sn 0 0.02 Ti 0 0.05
    U 0 0.01 V 0 0.02 W 0 0.02 Zr 0 0.03
    B 0 0.01 C 0 0.01 H 0 0.01 N 0 0.01 O 0 0.01
P 0 0.01 S 0 0.01 !
```

**DISORDERED_PART**

This command is needed for the special treatment of chemically-ordered phases where the contributions from the disordered state are described by a phase without ordering sublattices (the disordered phase name must be specified).

Several checks are made that the ordered and disordered phases are compatible (sublattices, sites and constituents). A link is then created between the phases, and the disordered phase is hidden from application programs. The Gibbs energy for the ordered phase also includes the Gibbs energy for the disordered phase.

Phases which can have an order/disorder transformation have parameters split on two phases and are referred to as the two phase description in the GIBBS module. One of them has sublattices for chemical ordering, the other one represents the disordered state. Normally, the ordered BCC and FCC or HCP phases may have either 2 or 4 substitutional sublattice (plus one additional interstitial site), that are handled by the Two Substitutional-Sublattice Ordering Model or Four Substitutional-Sublattice Ordering Model, respectively.
Two phase means that the ordered phase has parameters that describe the ordering. The disordered phase has all parameters for the reference state and those for describing the disordered phase. The ordered phase may occur only in some systems whereas the disordered phase may occur frequently, typical examples are the disordered FCC and BCC which may become ordered as L12 or B2 in certain systems. In order to treat multicomponent systems where some subsystems have ordering it would be necessary to transform all parameters of BCC into a B2 model.

The parameters describing the disordered phase are not changed but the Gibbs Energy system is informed that the Gibbs Energy for the two phases should be added.

The method used calculates the Gibbs Energy of a two phase model with two or four substitutional sublattices for ordering.

\[ G_m = G_m^{\text{ord}}(y_1^+, y_1^-) + G_m^{\text{dis}}(x_1) - G_m^{\text{ord}}(y_1^+ = x_1, y_1^- = x_1) \]

The mole fractions \( x_i \) are calculated from the site fractions \( y_i \). The last term means that the contribution from \( G_{\text{mord}} \) in a disordered state (same site fraction, equal to the mole fraction, on both sublattices) is subtracted. The effect of this is that the parameters in the ordered phase have no contribution to the disordered state.

**MAGNETIC_ORDERING**

Change the magnetic ordering parameter for a certain phase with magnetic ordering contribution, in terms of its anti-ferromagnetic factor. By default this is \(-1\) for BCC phase and \(-3\) for all other phases (FCC, HCP, etc.). The fraction value of the total enthalpy (due to short-range ordering above the magnetic transition temperature) is by default 0.40 for BCC phase and 0.28 for all other phases (FCC, HCP, etc.).

**EXCESS_MODEL**

See example tcex52 in the *Thermo-Calc Console Mode Examples Guide*.

Use this to change the default Excess Model (for interaction energies) from the default (REDLICH-KISTER_MUGGIANU). The model handles the excess interaction energies in a solution phase is chosen from:

- REDLICH-KISTER_MUGGIANU: for binary (R-K) & ternary (R-K-M) interactions
- REDLICH-KISTER_KOHLER: for binary (R-K) & ternary (R-K-K) interactions
- FLORY-HUGGINS POLYMER MODEL: for interactions in a polymer mixture phase (F-...
**MIXED-EXCESS-MODELS:** (R-K default) for mixed binary excess model (R-K, Legendre & Polynom) of a substitutional solution phase

- **HKF:** for interaction in an AQUEOUS solution phase (HKF)
- **PITZER:** for interaction in an AQUEOUS solution phase (PIT)
- **CENTRAL_ATOM_MODEL:** for interaction in a liquid slag solution phase (C-A-M)

For extrapolations of excess energies from related binary systems to ternary or higher-order systems, the Redlich-Kister binary excess interaction parameters may be extrapolated with either a Muggianu extension (i.e. the default REDLICH-KISTER_MUGGIANU model) and a Kohler extension (i.e. the alternative REDLICH-KISTER_KOHLER model), where there is no ternary, quaternary or higher-order interaction parameter.

The REDLICHKISTER_KOHLER model is implemented only for ternary systems.

The MIXED-EXCESS-MODELS option works only for a substitutional phase with no sublattice (such as the metallic LIQUID phase) and it can be used to invoke asymmetrical simple or Legendre polynomial as binary excess energy models in addition to the default symmetrical Redlich-Kister model for the chosen pair of constituents in a substitutional phase with no sublattice. Asymmetrical here means that the power series depend only on one of the constituents, for example with expansions based on the \([1-2*X(B)]\) term rather than \([X(A)X(B)\])

Binary interaction parameters for such a pair of constituents must be entered prior to turning on the non-default Legendre or Polynom models.

**TERNARY_EXTRAPOLAT**

See example tcex52 in the Thermo-Calc Console Mode Examples Guide.

Use this to change the extrapolation method from the default REDLICH-KISTER_MUGGIANU to another extrapolation model. This method extrapolates from binary to ternary (and higher-order) excess interaction parameters in a solution phase and is chosen from:

- **MUGGIANU** for Muggianu Extrapolation from R-K parameters
- **TOOP-KOHLER** for Toop-Kohler Extrapolation Model
- **KOHLER-ALL** for Kohler Extrapolation Model
- **MUGGIANU_RESTOR** for Muggianu-Restor Extrapolation Model
Only when all the relevant binary excess energies in the current solution phase are treated by the default Redlich-Kister Model (i.e. the Mixed-Excess-Model should have not been used), the MUGGIANU_RESTOR method for ternary extrapolations is equivalent to the Redlich-Kister_Muggianu Model, or the KOHLER-ALL method to the RedlichKister_Kohler Model.

The default ternary extrapolation method MUGGIANU_RESTOR applies to a solution phase as a whole, whatever the binary excess model(s) enforced to each of individual binary pairs in the phase. In case that all the binary pairs in the phase use the default binary excess model REDLICH-KISTER, then the ternary extrapolation method becomes the so-called Redlich-Kister_Muggianu Model (in short as R-K-M), for extrapolations from binary parameters to ternary (and higher-order) excess energy terms; when no ternary L parameter is entered for that, such a default R-K-M Model is always used.

The KOHLER-ALL ternary extrapolation method can be turned on also for a solution phase as a whole, whatever the binary excess model(s) enforced to each of individual binary pairs in the phase. In case that all the binary pairs in the phase use the default binary excess model REDLICH-KISTER, then the ternary extrapolation method becomes the so-called Redlich-Kister_Kohler Model (in short as R-K-K), for extrapolations from binary parameters to ternary (and higher-order) excess energy terms; when no ternary L parameter is entered for that, such an R-K-K Model is used.

The TOOP-KOHLER ternary extrapolation method is applied in a special way: for a specific ternary system (e.g. A-B-C) in a solution phase, specify which two constituents as the so-called Kohler constituents and the remaining constituent as the so-called Toop constituent on a given sublattice. If for the A-B-C ternary system you have specified A and B, or B and A, as the Kohler constituents (entered as the basis constituent and first interacting constituent) and C as the Toop constituent, only the A-B binary interaction parameters are used in accordance with the Kohler ternary extrapolation formula for A-B-C ternary interaction, while any other binary interaction parameters involving the Toop species C (i.e. of A-C and B-C binaries) are used in line with the Toop-Kohler ternary extrapolation formula (for the A-C-B and B-C-A ternary interactions).

**DEBYE_HUCKEL**

To use the DHLL (Debye-Hückel Limiting Law) model and SIT (Specific Ionic Interaction Theory) model for a dilute AQUEOUS solution phase, switch the DEBYE_HUCKEL part on, and it removes previously set (if any) ADDITIONAL part on the non-ideality for the chosen AQUEOUS phase.

**HKF_ELECTROSTATIC**

To use the hypothetical electrostatic contribution for the chosen phase (it must be an
aqueous solution phase using the Complete Revised_HKF Model). It removes previously set (if any) ADDITIONAL part on the non-ideality for the chosen AQUEOUS solution phase.
QUASICHEM_IONIC

To use the Quasichemical-Ionic model for the chosen liquid phase, you must have already entered/retrieved a liquid phase as an ionic two-sublattice liquid solution phase (normally, that is the IONIC_LIQ phase), and then use this amending option to switch QUASICHEM_IONIC on. It creates a completely new liquid solution phase [namely the QUAS_IONIC phase which uses the Quasichemical Model for the entropy, according to Mats Hillert (2001: J of Alloys and Compounds, 320, 161-176)], while the original IONIC_LIQ phase remains in the system and is not changed by this option.

QUASICHEM_FACT00

To use the Quasichemical Model developed by Kongoli et al. in the F*A*C*T group in Montreal, you must have entered/retrieved a liquid phase using a normal substitutional liquid model with specified associates or species (on a single lattice site), and then turn on the option QUASICHEM_FACT00. This removes the previously-set (if any) ADDITIONAL part on the non-ideality for the chosen liquid phase.

See examples tceX49 and tceX50 in the Thermo-Calc Console Mode Examples Guide.

QUASICHEM_IRSID

To use the Kapoor-Frohberg-Gaye Quasichemical Cell Model (i.e. the Quasichemical Model developed by ISRID, France) for a liquid SLAG solution phase, you can use a normal liquid model with specified associates or species.

GLASS_TRANSITION

To use the special model for glass transition of a liquid phase. It removes previously set (if any) ADDITIONAL part on the non-ideality for the chosen liquid phase.

REMOVE_ADDITION

To remove all the selected ADDITIONAL part from the Gibbs energy description for the chosen phase. If preferred, set a specific phase-status bit for a phase, use the PHASE_BITS option as long you know the restrict meaning of each part of a phase-status bits.

DEFAULT_STABLE

Set phases as default-stable, which helps you to have a better guess of which phases that
should be stable at the first calculation.

**AMEND_PHASE_DESCRIPTION**

Specify/amend phase descriptions if a phase has a miscibility gap, uses a special excess energy model, or has a specific additional contribution to its Gibbs energy, for example.

Also see "Solution Models in the GIBBS Module" on page 85 for detailed information about this command and its options.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>AMEND_PHASE_DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompts</td>
<td>Phase name: &lt;Phase name&gt; Specify the name of the phase. Amend what /Composition_Set/: &lt;Subject&gt; Several subjects for the phase can be amended but most often this command is used to enter two or more composition sets for a phase. If a phase has a miscibility gap it is necessary to have two composition sets, one for each possible composition that can be stable simultaneously. Enter a question mark at the prompt to get a list of all possibly amended subjects for a phase.</td>
</tr>
<tr>
<td></td>
<td>There are no additional prompts for DEBYE_HUCKEL, HKF_ELECTROSTATIC, GLASS_TRANSITION, QUASICHEM_FACT00, QUASICHEM_ISRID, REMOVE_ADDITION, and DEFAULT_STABLE.</td>
</tr>
<tr>
<td>RENAME_PHASE</td>
<td>New phase name /ABCD/: &lt;Phase name&gt; Give a new phase name for the chosen phase, or press &lt;Enter&gt; to keep the default shown.</td>
</tr>
<tr>
<td>Site_ratios</td>
<td>Sites in first sublattice /XX/: &lt;YY&gt; Sites in second sublattice /XX/: &lt;YY&gt; Specify the site numbers for each of the prompted sublattices for the current phase. Press &lt;Enter&gt; to accept the previous definitions.</td>
</tr>
<tr>
<td>New_constituent</td>
<td>Sublattice /#/ : &lt;Sublattice number&gt; Specify the sublattice where the new constituents are located. Species: &lt;Species name&gt; Give a valid species name.</td>
</tr>
</tbody>
</table>
### Syntax

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
</table>
| **AMEND_PHASE_DESCRIPTION**   | **Composition_sets**<br>New highest set number /#/: <Set number n>  <br>The default value (#) is usually one higher than the current value. All phases have initially one composition set. If a lower value (i.e. lower than the default one) is given, that specific composition sets are deleted.  
You cannot take away the first composition set.  
Major constituent(s) for sublattice #:/AB/: <Major constituent(s)>  
Specify the new major constituent(s) for the sublattice #, or press <Enter> to accept the default which was automatically set according to the specified composition set of the phase.  
This prompt is repeated for all available sublattices in the chosen phase. The major constituents in each sublattice can be given. This may simplify giving start values when calculating the equilibrium as phases with miscibility gaps should have different major constituents for each composition set.  
Composition set /1/: <Composition set number>  
Give the composition set (digit number) for the chosen phase, or press <Enter> if you want to set major constituents for the specified composition set.  
Major constituent(s) for sublattice #:/AB/: <Major constituent(s)>  
Specify the new major constituent(s) for the sublattice #, or press <Enter> to accept the default which is automatically set according to the specified composition set of the phase.  
This prompt is repeated for all available sublattices in the chosen phase for the specified composition set.  
The major constituents in each sublattice can be specified. This is useful in order to make calculations converge faster and more easily (because it may simplify giving start values when calculating the equilibrium as those phases with miscibility gaps should have different major constituents for each composition set). The databases often set major constituents for several phases automatically when data are retrieved. |
<table>
<thead>
<tr>
<th>Syntax</th>
<th>AMEND_PHASE_DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Fraction limits</strong></td>
<td>Element : &lt;el1&gt; &lt;br&gt; Low fraction limit /0/ : &lt;Appropriate low limit&gt; &lt;br&gt; High fraction limit /1/ : &lt;Appropriate high limit&gt;  &lt;br&gt; Element : &lt;el2&gt; &lt;br&gt; Low fraction limit /0/ : &lt;Appropriate low limit&gt;  &lt;br&gt; High fraction limit /1/ : &lt;Appropriate high limit&gt;  &lt;br&gt; Element : &lt;eln&gt; &lt;br&gt; Low fraction limit /0/ : &lt;Appropriate low limit&gt;  &lt;br&gt; High fraction limit /1/ : &lt;Appropriate high limit&gt;</td>
</tr>
<tr>
<td><strong>Magnetic ordering</strong></td>
<td>The antiferromagnetic factor /XX/: &lt;YY&gt; &lt;br&gt; Specify the anti-ferromagnetic factor for the chosen phase. This should be −1 for BCC phase and −3 for all other phases (FCC, HCP, etc.). &lt;br&gt; Short range order fraction of the enthalpy /XX/: &lt;YY&gt; &lt;br&gt; The magnetic ordering is a second-order transformation and part of the enthalpy due to this transformation is due to short-range order. This value is the fraction of the total enthalpy that is due to short-range ordering above the magnetic transition temperature. &lt;br&gt; The default value (xx) is 0.40 for BCC phase, and 0.28 for all other phases (FCC, HCP, etc.).</td>
</tr>
<tr>
<td><strong>Disordered part</strong></td>
<td>Disordered phase name: &lt;Phase name&gt; &lt;br&gt; Give the disordered phase name for which there is no ordering sublattice.</td>
</tr>
<tr>
<td><strong>Excess_model</strong></td>
<td>Model name /ABCDEFG/: &lt;Model name&gt; &lt;br&gt; The default model is the pre-set model for the solution phase, normally the REDLICH-KISTER_MUGGIANU model, or choose another model for the phase to be amended: &lt;br&gt; - REDLICH-KISTER_MUGGIANU &lt;br&gt; - REDLICH-KISTER_KOHLER &lt;br&gt; - FLORY-HUGGINS POLYMER MODEL &lt;br&gt; - MIXED-EXCESS-MODELS (R-K default)</td>
</tr>
</tbody>
</table>
### Syntax

<table>
<thead>
<tr>
<th>AMEND_PHASE_DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>• HKF</td>
</tr>
<tr>
<td>• Pitzer</td>
</tr>
<tr>
<td>• CENTRAL_ATOM_MODEL</td>
</tr>
</tbody>
</table>

The MIXED-EXCESS-MODELS option has sub-options:

First (the independent) constituent: `<Constituent name>`

Second (the dependent) constituent: `<Constituent name>`

Specify the binary pair of constituents in the current substitutional solution phase (the first one as the so-called independent constituent, and the second one as the dependent constituent), for which you wish to change the binary excess model from the default REDLICH-KISTER model to another model (LEGENDRE or POLYNOM).

You are prompted with the first sub-option (i.e. First (the independent) constituent after you have specified the desired binary Excess model type). To make further changes of binary excess model for other specific binary pairs in the current substitutional solution phase, press <Enter> (implying that there are no more changes of binary excess model for all other possibly-remaining binary pairs that shall still use the default REDLICH-KISTER model).

**Excess model type:** /Legendre/: `<Desired binary excess model type>`

For the currently-specified binary pair, choose one the legal binary excess models: LEGENDRE, POLYNOM or REDLICH-KISTER. If the default binary excess model REDLICH-KISTER is used for a certain binary pair, you can either specify the model name (or in short as R-K) or press <Enter>. After this sub-option, it returns to the first sub-option **First (the independent) constituent**: either for further change(s) of binary excess model of any other binary pair(s) or for termination (by pressing <Enter>) in the MIXED-EXCESS-MODELS option.

**Extrapolation method:** /Toop-Kohler/: `<Ternary model>`

Choose a ternary extrapolation model for the current solution phase:

- TOOP-KOHLER for Toop-Kohler Extrapolation Model
- KOHLER-ALL for Kohler Extrapolation Model
- MUGGIANU_RESTOR for Muggianu-Restor Extrapolation Model
<table>
<thead>
<tr>
<th>Syntax</th>
<th>AMEND_PHASE_DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The TOOP-KOHLER option further prompts:</td>
</tr>
<tr>
<td></td>
<td>Constituent in sublattice #: &lt;Basis constituent name&gt;</td>
</tr>
<tr>
<td></td>
<td>First interaction constituent: &lt;Interacting constituent name&gt;</td>
</tr>
<tr>
<td></td>
<td>Toop constituent: &lt;Toop constituent name&gt;</td>
</tr>
<tr>
<td></td>
<td>Specify the so-called Kohler constituents (entered as the basis constituent and first interacting constituent) and Toop constituent on a given sublattice in the current solution phase.</td>
</tr>
<tr>
<td>Quasichem_ionic</td>
<td>To use the Quasichemical Model for the chosen liquid phase, you must first enter it as an ionic liquid phase, and then use this amending option. It creates a completely new phase, the original IONIC LIQUID phase remains in the system and is not changed.</td>
</tr>
<tr>
<td></td>
<td>Number of bonds/atom /2/: &lt;Number of bonds per atom&gt;</td>
</tr>
<tr>
<td></td>
<td>Specify the Z value (number of bonds per atom).</td>
</tr>
<tr>
<td>Status_bits</td>
<td>Correct the phase status bits. It is important to fully understand this command before using it:</td>
</tr>
<tr>
<td></td>
<td>New status word (in hexadecimal) /04204000/: &lt;New status bits&gt;</td>
</tr>
<tr>
<td></td>
<td>Also see &quot;LIST_STATUS&quot; on page 122 for information on the status bits.</td>
</tr>
<tr>
<td></td>
<td>Normally, these should never be changed in this way, because such phase status bits are automatically set on when all the phase descriptions (predefined in databases and amended in the GIBBS module) are defined properly. The only exceptions are for the Kapoor-Frohberg-Gaye cell model for liquid SLAG solution phase, which can be set only as 04208000; and for the complete Revised HKF AQUEOUS solution model, which can be set as 02084000.</td>
</tr>
</tbody>
</table>

**AMEND_SYMBOL**

This command is for the GES (GIBBS) and PARROT modules.

Interactively calculate the current values of a function or table (predefined by the switched database or previously entered with "ENTER_SYMBOL" on page 113) at the current
temperature and pressure condition, and also possible to modify the definitions of variables
or functions.

The current values of the temperature and pressure used to calculate the
functions or tables are the ones listed with "LIST_STATUS" on page 122. There is
no way to change the current temperature and pressure values interactively.

To modify the definitions of entered symbols (variable, functions or parameters), the
performance of this command is slightly different one from another, as described below:

- For variables, the values can be changed.
- For functions the low and high temperature limits in various ranges (if any), as well
  the expressions, can be changed.
- For parameters the low and high temperature limits in various ranges (if any), as well
  the expressions, can be changed.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>AMEND_SYMBOL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name: &lt;Symbol name&gt;</td>
<td></td>
</tr>
<tr>
<td>Specify the name of an entered symbol.</td>
<td></td>
</tr>
</tbody>
</table>
| For tables and functions (or parameters which are treated as functions after
  these are entered by the ENTER_SYMBOL command with the Parameter
  keyword, but not by the ENTER_PARAMETER command), after the symbol
  name is specified here, the program automatically calculates the values under
  the current temperature and pressure conditions, and lists the current values,
  such as: |   |
| FUNCTION VALUE  2.52500000E+01 |   |
| TABLE VALUE  1.56000000E+02 |   |
| For variables and functions (or parameters), there are additional prompts and
  depend on the symbol type. |   |
| For a variable, its current value is displayed, and you can change it to a new
  value: |   |
| Value /Current value/: <New value> |   |
| For a function (or a parameter entered as a symbol): |   |
| Do you want to change the number of ranges /No/: <Y or n> |   |
| To change the number of ranges for the function, or change some of the
  temperature limits in the definition, For Y, you must retype both the low/high
  temperature limits and functions (see all the remaining details in the ENTER_ |   |
**Syntax** | **AMEND_SYMBOL**  
---|---
SYMBOL command.  
If you do not want to change it, press <Enter> to accept the default. The definition of the chosen function in all ranges (if any) is listed, for example:

```
DIFFERENT FUNCTIONS IN THESE RANGES
298.15<T<2000.00
2000.00<T<4500.00
4500.00<T<6000.00
```

and this message displays:

Do you want to change range limits /No/: <Y or N>

If a function is different in two or more temperature ranges, you must specify the range of the function of which you want to amend. Or press <Enter> or type 0 to exit this command without making any change.

```
Range number (0 to exit) /0/: <Range number>
```

Function:

The previous function is available for editing. The editing is performed within the general subroutine FOOLED. This routine prompts as follows:

```
1:+:>
```

The prompt consists of the current position in the string and the character at that position between colons (::).

**Commands**  
These commands can be given:

- **Help**: ?
- **Move CP to last or first character**: <+-> A
- **Delete characters from CP**: <+-#characters> D
- **Exit**: E
- **Find**: <#occurrences> F<string>@
- **Insert**: I<string>@
- **Move**: <+-#positions> M
- **Restore string**: R
Diffusion Module (DICTRA) Documentation

Set

Gibbs Energy System (GES) Commands

Syntax

AMEND_SYMBOL

- Substitute: \textit{S<OLD>@<NEW>@}
- Type string: \textit{T}

where \textit{CP} denotes the current position in the string, \# means number of, @ is a terminator of an input or search string.

When the string is typed the character at the current position is replaced by an underscore _. To finish the editing of the current function, type \textit{E} at the prompt.

CHANGE_STATUS

For the GIBBS\_ENERGY\_SYSTEM module, the status of an element or species or phase can be either ENTERED or SUSPENDED. The suspended status can be either implicit or explicit. The implicitly suspended status can be set e.g. for a species if any of the elements in its chemical formula is explicitly suspended. A species that is implicitly suspended becomes entered automatically if all its elements are set entered. After this command, a message shows which elements/species/phases are suspended or restored (entered). Consequently, the status bits for the specified elements or species or phases are changed, as listed with "LIST_STATUS" on page 122.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>CHANGE_STATUS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompts</td>
<td>For Element, Species or Phase /Species/: &lt;Keyword&gt;</td>
</tr>
<tr>
<td></td>
<td>Specify the keyword (element, species or phase).</td>
</tr>
<tr>
<td></td>
<td>Suspend /Y/: &lt;Y or N&gt;</td>
</tr>
<tr>
<td></td>
<td>The status is changed from ENTERED to SUSPENDED (Y), or vice versa (N).</td>
</tr>
<tr>
<td></td>
<td>If an element is suspended all species with this element become implicitly SUSPENDED too. A phase may become implicitly suspended if all its constituents or all constituents in a sublattice are suspended.</td>
</tr>
<tr>
<td></td>
<td>List of elements/species/phases: &lt;Name of elements or species or phases&gt;</td>
</tr>
<tr>
<td></td>
<td>Specify the names or indices of those elements or species or phases that shall become suspended or active. For names, these should be separated by a space and terminated with a semicolon (;) or an empty line. For indices it is possible to give a range by separating two numbers by a hyphen (-). The list should be terminated by a semicolon (;). Example: 5 1 7-12 FE;</td>
</tr>
</tbody>
</table>
**ENTER_ELEMENT**

Specify a system interactively. The program searches the currently switched or preset database for data for the given elements. The data for the elements in the database are the:

- mass in g/mol
- name of the Selected Element Reference State (SER) which normally is the stable phase for the element at 298.15 K
- enthalpy difference for the element in the SER state at 298.15 K and zero K
- absolute entropy for the element in the SER state at 298.15 K.

The two predefined elements, i.e. electrons and vacancies, have the chemical symbols \(-\) and \(\text{VA}\), respectively. Initially, these are suspended but can be entered either by this command or "CHANGE_STATUS" on the previous page.

If an aqueous solution phase is involved, in the GIBBS module you enter a special aqueous electron called, ZE. This is specially designed for appropriately calculating the standard electric potential in the aqueous solution system.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>ENTER_ELEMENT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Element name: (&lt;\text{Element name}&gt;)</td>
<td>Specify several elements on one line. The name of an element is its chemical symbol. The chemical symbols must be separated by spaces. Fictitious element names are legal but naturally no data are found in the database for them.</td>
</tr>
</tbody>
</table>

An element name (maximum 2 characters) can either have its first letter in upper and the second (if any) in lower case (i.e. Lower Case Mode) or both letters can be in upper or lower case (i.e. Upper Case Mode). The Upper or Lower Case Mode is selected by the command "REINITIATE" on page 127, which removes all data, and should be executed before any other command.

**About the ENTER_PARAMETER Command**

For the PARROT Module, this command is the same and is described here. See "ENTER_PARAMETER" on page 143 for the command details.

In the descriptions of the standard thermochemical properties and special physical properties for a phase, there are a number of parameters which may depend on the temperature and pressure. The expressions for these parameters can be given in a free form as a sum of terms with powers of T and P and may also include the natural logarithm.
TP-functions. Identical parameters (in terms of parameter-names) are stored only once in the GIBBS workspaces.

The composition-dependence of the Gibbs energy is described in the GIBBS module by the internal data structure, which is created when the phase is entered (see "Gibbs Energy System (GES) Commands" on page 79). The Gibbs energy of a phase is always referred to one formula unit of the phase, i.e. the amount derived from the number of sites (i.e. the stoichiometric coefficient) for each sublattice. If vacancy is a constituent of a sublattice, the amount of matter per formula unit of the phase may vary with composition.

**Defining the Parameter**

A valid parameter should have the general form of:

```
<identifier>(<phase>, <constituent array>; <digit>) <xxx> <expression> <yyy>
<keyword Y or N> <zzz> !
```

The identifier must be followed by an opening parenthesis, a phase name, a comma and a constituent array. Optionally, the constituent array can be followed by a semicolon and a digit. The parameter name is terminated by a closing parenthesis. The parameter form is defined as:

- `<identifier>` is the parameter type;
- `<phase>` is the phase name (maximum 24 characters);
- `<constituent array>` is the specific constituent array in the phase;
- `<digit>` is the degree of composition-dependent interaction contribution (an integer number from 0 through 9), that is only for excess energy (L), Curie temperature (TC) and Bohr magneton number (BMAGN), as well as for volume-related parameters (V0 or VA or VB or VC or VK); if it is valued as zero, or if it is for the standard Gibbs energy (G) for which the degree is always zero, it can be omitted;
- `<expression>` is the mathematical relation to describe the parameter;
- `<xxx>` and `<yyy>` are the low and high temperature limits respectively for the applicable temperature range of the parameter expression;
- `<keyword Y or N>` is the indicator on if there is continuation for the parameter expression or not;
- `<zzz>` is the reference index/number for the assessment of this parameter;
- The exclamation point ! is used to indicate that the current parameter definition is ended.

**PARAMETER NAME**

The GES parameter name has a general form of:
Examples of parameter names:

- \texttt{G(GAS,C1O2)}: The Gibbs energy of formation of a CO2 molecule in gas.
- \texttt{G(FCC,FE:VA)}: The Gibbs energy of formation of fcc Fe with interstitials.
- \texttt{L(LIQ,Fe,Cr;0)}: The regular solution parameter for Fe and Cr in liquid.
- \texttt{L(LIQ,Fe,Cr;1)}: The sub-regular solution parameter.
- \texttt{TC(BCC,Fe:Va)}: The Curie temperature of bcc Fe.
- \texttt{BMAGN(BCC,Fe:Va)}: The Bohr magneton number parameter of bcc Fe.

The parameter name consists of several parts. The first is a type-identifier and these can be used:

- \texttt{G}: Standard energy parameter (Gibbs energy of formation) or for interaction parameters;
- \texttt{L}: Excess energy parameter (Gibbs energy of interaction) always used for interaction parameters;
- \texttt{TC}: Curie temperature for magnetic ordering;
- \texttt{BMAGN} or \texttt{BM}: Bohr magneton number for magnetic ordering (or Born function \( \omega_{Pr,Tr} \) for aqueous solute species).
- \texttt{VO}: Molar volume at 298.15 K and 1 bar (a numeric value only);
- \texttt{VA}: Integrated thermal expansivity, \( \int_{298.15}^{T} \alpha(T)dT \);
- \texttt{VB}: Bulk modulus at 1 bar;
- \texttt{VC}: Isothermal compressibility;
- \texttt{VK}: High-pressure fitting parameter.

\( \nabla \) When necessary quantities as \( H \) (enthalpy), \( S \) (entropy), \( V \) (Volume), \( F \) (Helmholtz energy), etc., can be calculated from the Gibbs energy.

**PHASE NAME**

Specifying the \texttt{PHASE NAME} in uppercase is recommended; however, if you prefer to write it as a mixture of uppercase and lowercase, it automatically converts all lowercase to uppercase, as the GIBBS module only recognises uppercase phase names. It is important that if a phase bears a legal phase-type (among \( G, A, Y, L, I, F \) and \( B \)) in its phase definition (already by the \texttt{PHASE} keyword; such as \texttt{GAS:G}, \texttt{LIQUID:L}, \texttt{SLAG:L}, \texttt{IONIC-LIQ:Y}, \texttt{SPINEL:I}, \texttt{FCC\_L12:F}, \texttt{HCP\_DO21:F}, \texttt{BCC\_B2:B}, \texttt{AQUEOUS:A}), such a valid phase-type code should not be
attached to the phase name when ENTER_PARAMETER is executed.

**CONSTITUENT ARRAY**

The constituent array consists of a list of constituent names. Interaction parameters have two or more constituents from the same sublattice separated by a comma. If the phase has sublattices, at least one constituent in each sublattice must be specified. The constituents in different sublattices must be given in sublattice order and are separated by a colon.

After the component array, a sub-index digit can be specified after a semicolon. This digit must be in the range 0 to 9. The interpretation of the sub-index depends on the excess energy model used for the phase. If no semicolon and digit are given, the sub-index value is assumed to be as zero.

The excess energy parameters, e.g. the regular/subregular (binary) parameter or ternary parameters, are multiplied with two or more fractions of the constituents from the same sublattice of the solution phase. These additional constituents must be given as interacting constituents (as the following prompt).

Solution phases with sublattices can have interacting constituents in each sublattice.

**INTERACTION PARAMETER**

An interaction parameter, which is used to describe the excess term of a quantity, must have two or more constituents that interact with each other on a specified sublattice site of the given phase. It is arbitrary which of these constituents is given as the first constituent and what is given as the interacting constituents. The software always sorts the constituents (in each sublattice) in alphabetical order when the parameter name is written as a prompt (for entering its parameter value) and when the parameter is listed (using the GIBBS commands "LIST_PARAMETER" on page 147 or "LIST_PHASE_DATA (from GIBBS)" on page 148). This is important for all asymmetric interaction parameters where the sign of the interaction parameter must depend on the appearance order.

Use an asterisk* to denote that the excess interaction parameter is independent of the constituents of a specific sublattice. For example, $L(\text{FCC\_L12, AL, NI; *})$ means that the interaction parameter is for the binary interaction between constituents AL and NI on the first sublattice in the FCC\_L12 solution phase, while it is independent of all constituents on the second sublattice. An interaction parameter in the list of constituents is always added to the Gibbs energy and the asterisk * is calculated with the term of $[1\Sigma y(\text{specified constituents})]$, which implies that in an A-B binary system these $L$ parameters are identical (but in higher-order systems, these are different):
• \( L(\text{phase}, A, B) \) is multiplied with \( X(A) \times X(B) \)

• \( L(\text{phase}, A, \ast) \) is multiplied with \( X(A) \times (1-X(A)) \)

• \( L(\text{phase}, B, \ast) \) is multiplied with \( X(B) \times (1-X(B)) \)

If you press <Enter> when you are asked for a parameter name or if you have improperly input the entire parameter name, you are asked for each of these items in the name.

**ENTER_PARAMETER**

This command is for both the GES and PARROT modules.

Also see "About the ENTER_PARAMETER Command" on page 139 for details about each of the options.

Use this command to enter TP-function(s) for a specific parameter for a phase interactively with this command. If there is already a parameter expression defined (for this parameter), that is deleted and replaced with newly entered one.

The entered TP-Function(s) for the parameter can be changed later with the command "AMEND_PARAMETER" on page 82.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>ENTER_PARAMETER</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameter: &lt;Parameter name&gt;</td>
<td></td>
</tr>
</tbody>
</table>

As explained in "About the ENTER_PARAMETER Command" on page 139, specify a correct and complete Parameter Name, which should contain all the necessary parts of the general form:

\(<\text{Identifier}>(<\text{Phase}>,<\text{Constituent array}>;<\text{Digit}>)\)

If a parameter name is not acceptable or <Enter>, is pressed, a message displays:

*** Error, please re-enter each part separately

and you are prompted for input for each required part for a parameter name.

<table>
<thead>
<tr>
<th>Options</th>
<th>Description or Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identifier (/X/): &lt;G or L, or TC, or BM, or V0 or VA or VB or VC or VK&gt;</td>
<td></td>
</tr>
</tbody>
</table>

If this command is used one or more times, the previous value on this prompt is set as default. Press <Enter> for the same type identifier or
### Syntax

<table>
<thead>
<tr>
<th>ENTER_PARAMETER</th>
</tr>
</thead>
<tbody>
<tr>
<td>specify a new type.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Phase name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phase name (/ABCD/): &lt;Phase name&gt;</td>
</tr>
<tr>
<td>Each parameter is valid for a specific phase only. The name of that phase must be supplied (maximum 24 characters). The name can be abbreviated.</td>
</tr>
<tr>
<td>Constituent (in sublattice # /ABC/): &lt;Species name&gt;</td>
</tr>
<tr>
<td>A parameter is identified by the constituents on a specified sublattice site of the given phase, the stoichiometric coefficients of which are multiplied with the parameter. The name of the constituent can be abbreviated.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Constituent</th>
</tr>
</thead>
<tbody>
<tr>
<td>It is the species name, not the stoichiometric formula required here.</td>
</tr>
<tr>
<td>If this command is used one or more times, the previous value on this prompt is set as default. Accept it by pressing &lt;Enter&gt; if the constituent is the same, or specify a new species name.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Interacting constituent</th>
</tr>
</thead>
<tbody>
<tr>
<td>For phases with several sublattices, the program asks for one constituent in each sublattice.</td>
</tr>
<tr>
<td>Interacting constituent (in sublattice # /XYZ/): &lt;Species name&gt;</td>
</tr>
<tr>
<td>If this command is used one or more times, the previous value on this prompt is set as default. Press &lt;Enter&gt; to accept it if the constituent is the same, or specify a new species name.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Degree</th>
</tr>
</thead>
<tbody>
<tr>
<td>Degree /#: &lt;Degree&gt;</td>
</tr>
<tr>
<td>Degree is model-dependent. Specify an integer number (a value from 0 through 9) as the degree of composition-dependent interaction contribution for the phase parameter. This is valid for excess energy ((L)), Curie temperature ((T_C)) and Bohr magneton number ((B_{MAGN})), as well as for volume-related parameters ((V_0, V_A, V_B, V_C) or (V_K)).</td>
</tr>
</tbody>
</table>
Syntax | ENTER_PARAMETER
---|---
For binary interaction parameters, the degree is usually the power in the Redlich-Kister expression. For ternary interaction parameters, it is usually the Hillert ternary index.
For a standard \( c \) parameter for a pure component (end-member) its degree should be always 0 and this prompt should not display.

After this prompt, the program echoes on the screen the full TP-Function of the phase parameter.

Low temperature limit /298.15/: <Lowest temperature limit in K>

Specify the lowest temperature limit (in Kelvin), or the lowest-pressure limit (in Pascal but entered as a negative number), for the current TP-Function.

Function: <Definition for a function>

A TP-Function consists of terms in \( T \) and \( P \).

& <Continuation of the definition for the current function>

Continuation of a TP-Function definition.

High temperature limit /6000/: <High temperature limit in K>

Specify the high temperature limit (in Kelvin), or the high-pressure limit (in Pascal; only if the lowest limit is entered as a negative number) for the current TP-Function.

Any more ranges /N/: <Y or N>

Enter \( Y \) for more function(s) or \( N \) to end this command.

About the ENTER_PHASE Command

With the command "ENTER_PHASE" on page 110, the phase name, phase-type, sublattice number, and constituents or constituent array(s) for the phase are entered into the GIBBS workspaces.

About Phase Names

A thermochemical system must have at least one phase (which is a homogeneous part of the
system with a uniform composition and structure). In the GIBBS module, any number of phases can be entered for a system and for each phase there must be a description of how its Gibbs energy varies with temperature, pressure and composition. A phase has a large amount of data connected to it, e.g. it starts with a phase name:

- It may be treated as a special phase-type;
- It may have structural information about sublattice(s), etc.,
- There must be a list of constituents (for a substitutional phase with no sublattice) or of constituent arrays (for a sublattice phase);
- There may be basic information on what kind of EXCESS_MODEL (polynomial expression) is used to describe the binary, ternary and/or higher-order interactions between constituents;
- There may be so-called Additional contributions to the Gibbs energy of the phase from special physical phenomena, e.g. magnetic ordering, hypothetical electrostatic interaction, and so forth;
- There must exist all the parameters required for the descriptions of thermochemical properties (i.e. \( G \) terms for standard Gibbs energies, and \( L \) terms for binary, ternary or higher-order interaction excess energies) and of some special physical properties (e.g. the Curie temperature \( T_C \) and Bohr magneton number \( BMAGN \) (or \( BM \)) for magnetic ordering, \( V_0-V_A-V_B-V_C-V_K \) parameters for volume contributions, Born functions for hypothetical electrostatic interaction in an aqueous solution phase) stored in connection with the phase.

**About Phase Type Code**

A G phase (gaseous mixture) or an A phase (aqueous solution) is usually treated as a substitutional phase without sublattice, and that an L phase (ordinary liquid solution) is normally (but not always) modelled as a substitutional phase without sublattice, too.

The F and B phase-types are useful for ordered FCC (or HCP) and BCC solution phases handled by the so-called Four Substitutional-Sublattice Ordering Model, which always requires that the solution phase must have four sublattices for substitutional ordering and can additionally have an interstitial sublattice.

For ordered FCC or HCP phases, these four substitutional sublattices represent four corners of the regular tetrahedron on these lattices all of which are the nearest neighbours. A **Normal 4-Sublattice Model** requires that all the G parameters for each of end-members with the same elements but distributed on different sites be given separately. However, as these corners are identical lattice points, the phase-type option F means that the G parameters need be given only once. The possible permutations are handled automatically. To be more
clarified: An A-B binary solution phase (with the element A locates on one sublattice site and B on three sublattice sites) treated by the Normal 4-Sublattice Model has to have 4 G parameters for 4 end-members, i.e. \( G(\text{phase},A:B:B:B) \), \( G(\text{phase},B:A:B:B) \), \( G(\text{phase},B:B:A:B) \) and \( G(\text{phase},B:B:B:A) \), because of that in the general case these G parameters can be different from each other. But for the FCC and HCP orderings, these are identical and thus all G parameters of such end-members need be given only once, and the possible permutations are then automatically handled by the GIBBS module. This significantly simplifies the usage of this model (Four Substitutional-Sublattice Ordering Model) in multicomponent alloys.

There are restrictions on the excess parameters allowed with the phase-type option F. You can only have excess parameters of these types:

\[
L(\text{phase},A,B:*:*:*;0...9) \\
L(\text{phase},A,B:C,D:*:*;0...9)
\]

The asterisk * means that the interaction parameter is independent on the constituents on its corresponding sublattice. No ternary interaction parameters (i.e. with three elements on one sublattice site) are allowed. The reason for this restriction is that it would be too complicated to handle all possible permutations. In the current Four Substitutional Sublattice Ordering Model, the binary interaction between A and B atoms is thus independent of the constituents on the other sublattices, where there are many other parameters to model the composition-dependence of the Gibbs energy (both in the ordered and disordered parts of the phase). The model for these ordered phases are always partitioned in a disordered part (with a single substitutional sublattice) and an ordered part (with four substitutional sublattices for ordering).

For ordered BCC phases, the phase-type option B means the same thing but the situation is more complicated, as the 4-sublattice ordering phase represents an irregular tetrahedron with two pairs of sites that are next nearest neighbours. Thus, for an A-B binary solution phase (with the element A locates on two sublattice site and B on other two sublattice sites) treated by the Normal 4-Sublattice Model, the end-member described by the G (phase,A:A:B:B) term has four nearest neighbour bonds between A and B atoms, whereas the end-member described by the G(phase,A:B:A:B) term has two nearest neighbour bonds between A and B atoms and two next nearest neighbour bonds.


The first end-member (described by the G(phase,A:A:B:B) term) represents B2- ordering and the second (described by the G(phase,A:B:A:B) term) stands for B32-ordering. There are two permutations of the G(phase,A:A:B:B) term and four permutations of the G(phase,A:B:A:B) term, automatically conducted in the Four Substitutional-Sublattice Ordering Model. And there are also two kinds of reciprocal interaction parameters, i.e.
An advanced feature with the phase-type options F and B is that a composition set that represents the solution phase has a suffix (indicating that it is really as an ordered or disordered phase) that is automatically added to its phase name in some listings of equilibrium calculations (when performing either single-point or stepping or mapping calculations, and when plotting the calculated property diagrams or phase diagrams). Such suffix indications can be:

- _L12 or _L10 for ordered FCC
- _A1 for disordered FCC
- _B2, _B32, _D03 or _L21 for ordered BCC
- _A2 for disordered BCC
- _D019 and _B19 for ordered HCP
- _A3 for disordered HCP

<table>
<thead>
<tr>
<th>Solution Phase</th>
<th>Suffix for Disordered Phase</th>
<th>Suffix for Ordered Phase</th>
</tr>
</thead>
<tbody>
<tr>
<td>FCC PHASE</td>
<td>PHASE_A1</td>
<td>PHASE_L12</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PHASE_L10</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PHASE_B2</td>
</tr>
<tr>
<td>BCC PHASE</td>
<td>PHASE_A2</td>
<td>PHASE_B32</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PHASE_D03</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PHASE_L21</td>
</tr>
<tr>
<td>HCP PHASE</td>
<td>PHASE_A3</td>
<td>PHASE_D019</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PHASE_B19</td>
</tr>
</tbody>
</table>

**ENTER_PHASE**

See "About the ENTER_PHASE Command" on page 107 for details about the phase-type and other prompts.

With this command, the phase name, phase-type, sublattice number, and constituents or constituent array(s) for the phase are entered into the GIBBS workspaces. However, for the remaining parts of thermodynamic descriptions (i.e. thermochemical and physical parameters, excess model, and possibly additional contribution term) for the phase, the GIBBS commands "ENTER_PARAMETER" on page 143 and "AMEND_PHASE_DESCRIPTION" on page 93, should be used sequentially.
Normally, data for a system are retrieved from the preset database after the elements and species are specified. This is automatically done through "GET_DATA" on page 16. In some cases, specify a phase interactively.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>ENTER_PHASE</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Options</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Phase name</strong></td>
<td>Name of phase: &lt;Phase name&gt;</td>
</tr>
<tr>
<td></td>
<td>The phase name is any string starting with a letter and containing only letters, digits or the underscore character. The phase name must be unique.</td>
</tr>
<tr>
<td></td>
<td>type code: &lt;Phase-type code&gt;</td>
</tr>
<tr>
<td></td>
<td>The Phase-type code must be specified for the phase if it is not an ordinary solution phase. Press &lt;Enter&gt; if the phase is ordinary.</td>
</tr>
<tr>
<td><strong>Phase-type</strong></td>
<td></td>
</tr>
<tr>
<td><strong>G</strong></td>
<td>Gaseous mixture phase.</td>
</tr>
<tr>
<td></td>
<td>There may only exist one gas phase in a system.</td>
</tr>
<tr>
<td><strong>A</strong></td>
<td>Aqueous solution phase.</td>
</tr>
<tr>
<td><strong>L</strong></td>
<td>Liquid solution phase but not A (aqueous) or Y (ionic liquid)</td>
</tr>
<tr>
<td><strong>Y</strong></td>
<td>Ionic liquid solution phase (that is specially treated by the Ionic Two Sublattice Liquid Model).</td>
</tr>
<tr>
<td><strong>I</strong></td>
<td>A phase with charged species but not G (gaseous), A (aqueous) or Y (ionic liquid).</td>
</tr>
<tr>
<td><strong>F</strong></td>
<td>An ordered FCC or HCP solution phase with four substitutional sublattices (additionally, such a phase can also have an interstitial sublattice).</td>
</tr>
<tr>
<td><strong>B</strong></td>
<td>An ordered BCC solution phase with four substitutional sublattices (additionally, such a phase can also have an interstitial sublattice).</td>
</tr>
<tr>
<td><strong>Sublattice number</strong></td>
<td>Number of sublattices /1/: &lt;Sublattice number&gt;</td>
</tr>
<tr>
<td></td>
<td>Phases with stoichiometric constraints usually have two or more sublattices. On each sublattice one or more species can be entered as constituents. The number of sublattices must not exceed 10. Substitutional phases with no sublattices are treated as phases with one sublattice.</td>
</tr>
</tbody>
</table>
Syntax | ENTER_PHASE
---|---
Number of sites on sublattice # /1/: <Site number>
For phases with sublattices, the ratio of the sites on each sublattice (donated with #) must be given. The program asks for values for all sublattices (by repeating this question for each sublattice), but these may have a common factor extracted. It is recommended to use integer numbers as sites if possible. For substitutional phases with no sublattices, this question does not show up.

Name of constituent: <Constituent name(s)>
For each sublattice specify at least one species as constituent. Several constituents can be given consequently (on the repeated prompt) or on the same line separated by a space. This question is repeated till pressing <Enter> or giving a semi-colon (;), meaning that the list of constituents is terminated by (;) or an empty line.

Will you add constituents later /N/: <Y or >
For Y add other constituents to the phase by specifying new components in e.g. an ENTER_PARAMETER command. The default is N or press <Enter>.
If illegal constituents are used, you get a message e.g. when parameters are entered.
Do you want a list of possible parameters /N/: <Y or Nn>
Enter Y for a list of all possible parameters up to the fifth interaction order for the entered phase.

**ENTER_SPECIES**

Specify a species from the already entered elements. The stoichiometry of the species is the chemical formula of the species. For each species, its name and chemical formula must be given.

> All elements are automatically entered simultaneously as species. The constituents of a phase must be species, but there is no thermochemical data associated with the species except as constituents of a phase.
### Syntax

<table>
<thead>
<tr>
<th>Syntax</th>
<th>ENTER_SPECIES</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Species name</strong>: &lt;Species name&gt;</td>
<td></td>
</tr>
<tr>
<td>Enter a unique species name. This is usually its chemical formula but it can be any string which starts with a letter and contains only letters or digits. Parenthesis () and an underscore _ are permitted. The combination /- or /+ used to denote charge.</td>
<td></td>
</tr>
</tbody>
</table>

### Species Names Examples

- NACL2, FE2O3, FE03/2, FE101.5, CA.5MG.5SI103, AL1H101_A1(OH), AL1H101_HA1O, C2H4O3_124TRIOXOLANE, NA+, SI04-4, H1/+1, H1O1/-1, AGC2N2-1. 

The species name can be used to separate isomers with the same stoichiometry, e.g. C2H2Cl2, (CHCl)2 cis, (CHCl)2 trans, CH2 CC12.

### Stoichiometry /Species name/: <Chemical formula>

The elements in the chemical formula are normally separated by stoichiometric numbers. Neither parenthesis () nor an underscore _ is allowed in the chemical formula, while the special combination /- or /+ can be used.

In upper case mode (see "REINITIATE" on page 127), the stoichiometric number unity can be excluded only if the element symbol consists of two letters. In lower case mode, the element must be typed with the first letter in UPPER case and the second in lower, and it is thus possible to distinguish CO (carbon monoxide) from Co (cobalt) without any stoichiometry number.

- All elements in a species must be entered prior to entering the species.

---

### ENTER_SYMBOL

This command is for the GES (GIBBS) module.

In the GIBBS module, a symbol can be used to represent a numeric quantity (e.g. a variable), a function, or a table. The entered symbol (with a symbol name of maximum eight characters) can be used later when parameters are entered, and this is a flexible way to manipulate thermodynamic functions. Symbols are especially useful if the same function or table is used in several thermochemical parameters. A parameter symbol is used to assign the values of phase parameters (which are defined with the command "ENTER"
PARAMETER" on page 143) to specific characterized symbols. If you want to define a constant quantity, enter it as a simple function with a constant value in all (temperature) ranges.

The symbols entered in the GIBBS module can also be listed and used in the "Optimizing with the PARROT Module" on page 130 (for data optimization) where you can use the GIBBS-entered symbols (variables, functions or parameters) to define parameters that shall be optimized.

Symbols entered in the GIBBS module are not the same symbols as defined in the POLY and POST modules.

Also see "ENTER_SYMBOL" on page 247 for the POLY and POST modules.

See example 44 in the Thermo-Calc Console Mode Examples Guide for an example of using variables and functions.
<table>
<thead>
<tr>
<th>Syntax</th>
<th>ENTER_SYMBOL</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Variable, function, table or parameter? /Function/: &lt;Keyword&gt;</td>
</tr>
<tr>
<td></td>
<td>The keyword can be a variable, function, table or parameter.</td>
</tr>
<tr>
<td></td>
<td>• Variables are similar to functions because these can also be expressions of</td>
</tr>
<tr>
<td></td>
<td>state variables. It is possible to enter a variable with a new expression</td>
</tr>
<tr>
<td></td>
<td>anytime.</td>
</tr>
<tr>
<td></td>
<td>• Functions are expressions of state variables or other functions.</td>
</tr>
<tr>
<td></td>
<td>• Tables are used for listing results. A table consists of a list of any</td>
</tr>
<tr>
<td></td>
<td>number of state variables, functions or variables.</td>
</tr>
<tr>
<td></td>
<td>• Parameter symbols are used to assign the values of phase parameters (which</td>
</tr>
<tr>
<td></td>
<td>are defined by the command ENTER_PARAMETER) to specific characterized</td>
</tr>
<tr>
<td></td>
<td>symbols. If the phase parameter is not defined yet, the parameter symbol</td>
</tr>
<tr>
<td></td>
<td>is assigned zero or a symbol which is valued as zero. In this way it is easy</td>
</tr>
<tr>
<td></td>
<td>to refer to entered phase parameters in further defining other phase</td>
</tr>
<tr>
<td></td>
<td>parameters.</td>
</tr>
<tr>
<td></td>
<td>Name: &lt;Name of the symbol&gt;</td>
</tr>
<tr>
<td></td>
<td>Each symbol has a unique name that must start with a letter and can have</td>
</tr>
<tr>
<td></td>
<td>maximum 8 characters.</td>
</tr>
<tr>
<td></td>
<td>The following prompts are based on the type of symbol.</td>
</tr>
<tr>
<td>Variable symbol</td>
<td>Value: &lt;Numeric value of a variable&gt;</td>
</tr>
<tr>
<td></td>
<td>Only a constant numeric value, not an expression, is accepted.</td>
</tr>
<tr>
<td>Function symbol</td>
<td>Enter the lower-temperature limit, the expression, an upper-temperature</td>
</tr>
<tr>
<td></td>
<td>limit and if there is another expression above this upper limit:</td>
</tr>
<tr>
<td></td>
<td>Low temperature limit /298.15/: &lt;Lowest temperature limit in K&gt;</td>
</tr>
<tr>
<td></td>
<td>Specify the lowest-temperature limit, below which its (first) expression</td>
</tr>
<tr>
<td></td>
<td>is not applicable. The default lowest limit of all kinds of data is 298.15 K</td>
</tr>
<tr>
<td></td>
<td>If a negative number is given as the lowest-temperature limit, it is assumed</td>
</tr>
<tr>
<td></td>
<td>that there are breakpoints in pressure for this function; in such a case, it</td>
</tr>
<tr>
<td></td>
<td>is interpreted as the lowest-pressure limit (in Pascal), and the other limits</td>
</tr>
<tr>
<td></td>
<td>in the current function are also taken as pressure limit values (in Pascal).</td>
</tr>
<tr>
<td></td>
<td>The temperature/pressure limits for the functions are checked during</td>
</tr>
<tr>
<td>Syntax</td>
<td>ENTER_SYMBOL</td>
</tr>
<tr>
<td>--------</td>
<td>--------------</td>
</tr>
<tr>
<td>calculations. An indicator is set if the actual temperature/pressure condition is below the lowest temperature/pressure limit or above the highest temperature/pressure limit; and in such a case, an extrapolation is conducted using the TP-FUNCTIONS valid in the nearest temperature/pressure range.</td>
<td></td>
</tr>
<tr>
<td>Function: &lt;Definition for a TP-function&gt;</td>
<td></td>
</tr>
</tbody>
</table>

A TP-Function consists of terms in T and P. The expression is a FORTRAN-like expression and operators +, -, *, = and ** can be used (** only with integer powers). Unary-functions LN or LOG (both for natural logarithm) and EXP (for exponential) can also be used. An expression can be continued on more than one line. A PT-function must be terminated by a semicolon (;) or an empty line. No more than 78 characters can be written on a line. If this is not sufficient space on one line, press <Enter> and continue on the next line. The program prompts with an ampersand & when a continuation is expected.

A function can have several temperature ranges, and a different expression (i.e. a TP-Function) for each region; if required, a single function can have up to ten different temperature ranges (and thus have up to ten different TP-Functions).

This question is repeated if the current function has more than one expression (TPFunction) in various temperature ranges [or pressure ranges; only if the lowest limit is entered as a negative number)].

& <Continuation of the definition for the current TP-Function>

This is for a continuation of the definition for the current TP-Function. The ampersand & means that you can continue to write the function on the new line if one line is not enough for the current TP-Function. If you are finished the current TP-Function, press <Enter> again.

High temperature limit /6000/: <High temperature limit in K>

For a TP-Function, specify the high-temperature limit, above which its current expression is not applicable. The default high-temperature limit for all kinds of data is always 6000 K.

This question is repeated if the function has more than one expression (TPFunction) in various temperature ranges.
### Syntax

<table>
<thead>
<tr>
<th>Syntax</th>
<th>ENTER_SYMBOL</th>
</tr>
</thead>
</table>

- All the temperature limits for the presently-be-entered TP-Function MUST be in an increasing order; otherwise the whole function is given a single value of zero.

- If a negative number is given as the lowest-temperature limit, it is interpreted as the low-pressure limit (in Pascal), and the high-temperature limit is also taken as the high-pressure limit (in Pascal) for the current TP-Function.

- The high-temperature/pressure limit for the current applicable expression (TPFunction) is the low temperature/pressure limit for the next range if several ranges are needed to describe the temperature/pressure-dependence of this function.

- The temperature/pressure limits for the functions are checked during calculations. An indicator is set if the actual temperature/pressure condition is below the lowest temperature/pressure limit or above the highest temperature/pressure limit; and in such a case, an extrapolation is conducted using the TP-Function valid in the nearest temperature/pressure range.

- Any more ranges /N/: <Y or N>

- Answer N to finish the definition of the current function. If Y the program asks for a new function valid above the last high temperature limit and below a new high temperature limit. The maximum number of temperature ranges is 10.

- Important note: Make sure that the function and its first derivatives are continuous across break points.

### Table

<table>
<thead>
<tr>
<th>Table symbol</th>
<th>Specify the low and high temperature limits, temperature step and tabled value at each specified temperature:</th>
</tr>
</thead>
</table>

- Low temperature limit /298.15/: <Low temperature limit in K>

- The lowest temperature where the table has a value.

- High temperature limit /6000/: <High temperature limit in K>

- The highest temperature where the table has a value.

- Step in temperature /100/: <Temperature step>

- The step in temperature between each value in the table. This step must be constant for the whole table. If a table cannot be described with a single
step it must be divided into several tables for different temperature ranges. The upper and lower limits are truncated to give reasonable values where the table values must be specified.

Table value at XX /YY/: <Table value>

The value of the table at the specified temperature (xx) must be given. The default value (yy) is the last value.

Input the correct name of a phase parameter (including its identifier, phase name, constituent and interacting constituent(s) in various sublattices (if exist), and degree of the parameter. Most of the settings are the same as in the "ENTER_PARAMETER" on page 143 command or the Function symbol prompts above.

Parameter: <Parameter name>

Specify a correct and complete parameter name, which should contain all the necessary parts of the general form:

<Identifier>(<Phase>,<Constituent array>;<Digit>)

If a parameter name is not acceptable or <Enter> is pressed, this error message displays:

*** Error, please re-enter each part separately

The program prompts for separate input for each required part for a parameter name.

Identifier (/X/): <G or L, or TC, or BM, or V0 or VA or VB or VC or VK>

Specify one of these types of legal identifiers.

Phase name (/abcd/): <Phase name>

Specify the phase name.

Constituent (in sublattice # /abc/): <Species name>

Specify the constituent name on the specified sublattice site of the given phase.

Interacting constituent (in sublattice # /XYZ/): <Species name>

Specify the interacting constituent name on the specified sublattice site of


<table>
<thead>
<tr>
<th>Syntax</th>
<th>ENTER_SYMBOL</th>
</tr>
</thead>
<tbody>
<tr>
<td>the given phase; if there is no interacting constituent, press &lt;Enter&gt;.</td>
<td></td>
</tr>
<tr>
<td>Interacting constituent (in sublattice # /XY2/): &lt;Species name&gt;</td>
<td></td>
</tr>
<tr>
<td>If there is more than one interacting constituent on the specified sublattice site of the given phase, specify them; otherwise press &lt;Enter&gt;.</td>
<td></td>
</tr>
<tr>
<td>Degree /#/: &lt;Degree&gt;</td>
<td></td>
</tr>
<tr>
<td>Specify an integer number (a value from 0 through 9) as the degree for the phase parameter.</td>
<td></td>
</tr>
<tr>
<td>Low temperature limit /298.15/: &lt;Lowest temperature limit in K&gt;</td>
<td></td>
</tr>
<tr>
<td>Specify the lowest-temperature limit (in Kelvin), or the lowest-pressure limit (in Pascal but entered as a negative number), for the current TP-Function.</td>
<td></td>
</tr>
<tr>
<td>Function: &lt;Definition for a function&gt;</td>
<td></td>
</tr>
<tr>
<td>Specify the desired TP-Function for the current temperature range (or current pressure range; only if the lowest limit is entered as a negative number).</td>
<td></td>
</tr>
<tr>
<td>&amp; &lt;Continuation of the definition for the current TP-function&gt;</td>
<td></td>
</tr>
<tr>
<td>Specify the desired TP-Function continuation for the current temperature range (or current pressure range; only if the lowest limit is entered as a negative number).</td>
<td></td>
</tr>
<tr>
<td>High temperature limit /6000/: &lt;High temperature limit in K&gt;</td>
<td></td>
</tr>
<tr>
<td>Specify the high-temperature limit (in Kelvin), or the high-pressure limit (in Pascal; only if the lowest limit is entered as a negative number) for the current TP Function.</td>
<td></td>
</tr>
<tr>
<td>Any more ranges /N/: &lt;Y or N&gt;</td>
<td></td>
</tr>
</tbody>
</table>

**LIST_CONSTITUENT**

This is a GIBBS_ENERGY_SYSTEM (GES) command.
LIST_DATA

This is a GIBBS_ENERGY_SYSTEM (GES) command.

All data for the current system that is defined (retrieved from database in the DATA module, or directly entered in the GIBBS module) within the current GIBBS workspace is written in a readable manner on the output file. If no output file is specified, the data display on screen.

The output data consists of a list of all elements and their data followed by a list of all phases and the data associated with each phase. The thermochemical parameters listed for each phase are always in SI units.

For encrypted commercial databases you may not be able to use this command to list any retrieved data. However, it can be used to list some basic definitions (such as phase models and phase-constituents) retrieved from an encrypted database, as well as all the references related to original assessments (but not thermodynamic parameters) for the currently-defined system.

Syntax | LIST_DATA
--- | ---
Output to screen or file /Screen/: <File name>

Prompts

Specify the name of a file in which the data shall be written in a readable manner. The default value is the screen (by pressing <Enter>).

Options?: <Option(s)>

Choose one or several of these options for output:

- N the output is written as a user database format.
- P the output is written as a macro file for future input. This is useful for creating *SETUP files for data assessments.
- S the symbols are suppressed.
- R the references for the parameters are listed (only for some databases in which references are available)
- L the output is written suitable for a LaTeX preprocessor.
## LIST_PARAMETER

This command is for both the GIBBS and PARROT modules.

List the TP-function(s) of a specific parameter for a phase. You must supply the name of the phase parameter:

The parameter name: `<Identifier>(<Phase>,<Constituent array>;<Digit>)`

For encrypted commercial databases, you may not be able to use this command to list any retrieved parameter.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>LIST_PARAMETER</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameter: <code>&lt;Parameter name&gt;</code></td>
<td></td>
</tr>
<tr>
<td>Specify a correct and complete parameter name, which should contain all the necessary parts of the general form: <code>&lt;identifier&gt;(&lt;phase&gt;,&lt;constituent array&gt;;&lt;digit&gt;)</code></td>
<td></td>
</tr>
<tr>
<td>See &quot;About the ENTER_PARAMETER Command&quot; on page 139 to learn how to define the Parameter Name.</td>
<td></td>
</tr>
<tr>
<td>If a parameter name is not acceptable or <code>&lt;Enter&gt;</code> is pressed, an error message displays:</td>
<td></td>
</tr>
<tr>
<td>*** Error, please re-enter each part separately</td>
<td></td>
</tr>
<tr>
<td>The program prompts for separate input for each required part for a parameter name.</td>
<td></td>
</tr>
<tr>
<td>Identifier (/X/): <code>&lt;G</code> or <code>&lt;L</code>, or <code>&lt;TC</code>, or <code>&lt;BM</code>, or <code>&lt;V0</code> or <code>&lt;VA</code> or <code>&lt;VB</code> or <code>&lt;VC</code> or <code>&lt;VK&gt;</code></td>
<td></td>
</tr>
<tr>
<td>Specify one of these types of legal identifiers.</td>
<td></td>
</tr>
<tr>
<td>Phase name (/ABCD/): <code>&lt;Phase name&gt;</code></td>
<td></td>
</tr>
<tr>
<td>Specify the phase name.</td>
<td></td>
</tr>
<tr>
<td>Constituent (in sublattice # /ABC/): <code>&lt;Species name&gt;</code></td>
<td></td>
</tr>
<tr>
<td>Specify the constituent name on the specified sublattice site of the given phase.</td>
<td></td>
</tr>
<tr>
<td>Interacting constituent (in sublattice # /XYZ/): <code>&lt;Species name&gt;</code></td>
<td></td>
</tr>
</tbody>
</table>
| Specify the interacting constituent name on the specified sublattice site of the given phase; if there is no interacting constituent, press `<Enter>`.
Syntax | LIST_PARAMETER
--- | ---
Interacting constituent (in sublattice # /XYZ/): <Species name>
If there is more than one interacting constituent on the specified sublattice site of the given phase, specify them; otherwise press <Enter>.
Degree /#: <Degree>
Specify a numerical number as the degree for the phase parameter.

**LIST_PHASE_DATA**

This is a GIBBS_ENERGY_SYSTEM (GES) command.

All data for a specific phase are written in a readable manner on screen. The thermochemical parameters listed for the phase are always in SI units.

For encrypted commercial databases you may not be able to use this command to list any phase data. However, this command can be used for listing some basic definitions (such as phase model and phase-constituents) for the specified phase, as well as all the references related to original assessments (but not thermodynamic parameters) for the currently-defined system.

Syntax | LIST_PHASE_DATA
--- | ---
Prompt | Phase name: <Phase name>
Specify a phase name (if abbreviated, it should be unique).

**LIST_STATUS**

This is a GIBBS_ENERGY_SYSTEM (GES) command.
<table>
<thead>
<tr>
<th>Syntax</th>
<th>LIST_STATUS</th>
</tr>
</thead>
<tbody>
<tr>
<td>For the GIBBS module, list the entered elements, phases and species with the status word. The command is included for system managers.</td>
<td></td>
</tr>
</tbody>
</table>

Each element, species, phase and symbol has a set of status bits. The values of these bits are listed with this command.

The bits are listed as hexadecimal, i.e. four bits are written as a hexadecimal number. Two hexadecimal numbers make a byte. In hexadecimal, 0 to 9 mean normal digits. A to F means values 10 to 15. The number \( \text{E4000000} \) has thus bit 1, 2, 3 and 6 equal to one. The bits are numbered starting with 1 for the most significant (leftmost) bit.
**Element Status Word**

Set the element status word (*Bit. Meaning*) if:

1. Element cannot be deleted (only vacancy and electron)
2. Suspended (inclusive OR of bit 3 and 4)
3. Explicitly suspended
4. Implicitly suspended (cannot occur for an element)

**Species Status Word**

Set species status word (*Bit. Meaning*) if:

1. Species record for an element (each element has a species record)
2. Suspended (inclusive OR of bit 3 and 4)
3. Explicitly suspended
4. Implicitly suspended (e.g. if a species element is suspended)
5. Charged (inclusive OR of bit 6 and 7)
6. Negative charge
7. Positive charge
8. Vacancy
9. Component (by default the elements are the components)

**Phase Status Word**

Set phase status word (*Bit. Meaning*) if:

1. Ideal (no sublattices and no excess parameters)
2. Suspended (inclusive OR of bit 3 and 4)
3. Explicitly suspended
4. Implicitly suspended (e.g. if all constituents suspended)
5. Gas phase
6. Liquid phase
7. Solution phase
8. Only one constituent (in each sublattice)
9. Ions (inclusive OR of bit 10 and 12)
10. New ionic liquid model (charge balance handled internally)
11. Constituents cannot be added
12. External charge balance needed
13. Aqueous model
14. Charged species (ions)
15. Dilute entropy
16. Last calculation exceeded temperature range for any parameter
17. Kapoor-Frohberg-Gaye cell model
18. Turbo calculation used
19. Turbo calculation impossible
20. Turbo calculation illegal
21. Phase is not ideal
22. Current site fractions saved
23. This phase is the ordered part
24. This phase is the disordered part (bit 2 and 3 also set)
25. Shadow phase with diffusion data
26. Error in ionic model
27. Sometimes
28. CVM-SRO (short-range ordering) entropy expression
29. CVM initialization is made
30. Used to test quasi-chemical ordering model
31. Major constituents check even if no miscibility gap (ordering)
32. Hoch-Arpshofen model

**Symbol Status Word**

Set symbol status word (Bit meaning) if:

1. Constant
2. Variable
3. Function
LIST_SYMBOL

This is a GIBBS_ENERGY_SYSTEM (GES) command.

List the symbols available in the current GIBBS workspace, which are defined (retrieved from database in the DATA module, or directly entered in the GIBBS module) and used in TP-functions for the entered model parameters for various phases in the defined system.

For encrypted commercial databases you may not be able to use this command to list any retrieved symbol.

Syntax

<table>
<thead>
<tr>
<th>LIST_SYMBOL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name: &lt;Symbol name&gt;</td>
</tr>
</tbody>
</table>

Prompts

Specify a symbol name (either as the full name of a defined symbol, or as the first few common characters of several symbols which have names starting with such common characters).

Only those symbols that match this name are listed.

Or press <Enter> for a list of all the symbols defined (retrieved from database in the DATA module, or directly entered in the GIBBS module) for the current system, which are available in the current GIBBS workspace.

Output to screen or file /Screen/: <File name>

Specify the name of a simple-textual file in which the entered symbols shall be written in a readable manner (such a basic textual file can later on be opened and edited by any text editor). The default value is the screen (by pressing <Enter>).

READ_GES_WORKSPACE

This command is specific to the GES (GIBBS) module.

The data area saved onto a *.GES5 file with "SAVE_GES_WORKSPACE" on page 128 is read back into the GIBBS workspace.
**Syntax**

<table>
<thead>
<tr>
<th>READ_GES_WORKSPACE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter a <strong>File name</strong> and specify the working directory where to save the file in the <strong>Look in</strong> field. Normally the default file-type in the <strong>Files of type</strong> field is the correct one for the GIBBS workspace format (i.e. *.GES5 file).</td>
</tr>
</tbody>
</table>

The saved *.GES5 files are unique for each CPU type, and therefore a *.GESS file saved on one CPU type cannot be read and used on another CPU type.

### REINITIATE

All data in the stored GIBBS workspace are erased, and all variables are initiated to their default values.

<table>
<thead>
<tr>
<th>REINITIATE</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Prompts</strong></td>
</tr>
<tr>
<td>Upper case only /Y/: &lt;Y or N&gt;</td>
</tr>
<tr>
<td>The name of elements and species can be either in only UPPER case (by typing Y or pressing &lt;Enter&gt;), or the elements with two letter names have the first letter in Upper and the second in lower case (by typing N).</td>
</tr>
</tbody>
</table>

In upper case mode all input in lower case is automatically converted to upper case.

<table>
<thead>
<tr>
<th>Lower temperature limit /298.15/: &lt;Lowest t in K&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>This value is used as the lower temperature limit when data are entered interactively.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Upper temperature limit /6000/: &lt;Highest t in K&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>This value is used as the upper temperature limit when data are entered interactively.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Default element reference state symbol index /1/: &lt;1 or 2 or 3&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specify a proper index for the default listing parameters (symbol), or press &lt;Enter&gt; to accept the preset index 1.</td>
</tr>
</tbody>
</table>

The **index** is for defining the symbol printed in listings of parameters. The symbol can be:

- ☀: the data are referred to Gibbs energy at a variable temperature (also called **Lattice Stability**).
**Syntax** | **REINITIATE**
---|---

- \( \text{H}298 \): the data are referred to the enthalpy of the element at 298.15 K and 1 bar.
- \( \text{H}0 \) is the same as \( \text{H}298 \) but at the temperature 0 K.

The index only changes the symbol, not any value. Normally the index is set correctly by the database. Only when manually entering data must you set the index to get the correct symbol. Set the index value to 0 to get the symbol \( \text{H}298 \) and to 2 to get \( \text{H}0 \).

**SAVE_GES_WORKSPACE**

This command is for the GES (GIBBS) module.

The data area used by the GIBBS workspace can be saved on a file (with a default extension GESS under MS-Windows, or ges5 under Linux). The default file name is RESULT.GESS or equal to the one used in a previous "READ_GES_WORKSPACE" on page 126 command.

**Syntax** | **SAVE_GES_WORKSPACE**
---|---

Enter a **File name** and specify the working directory where to save the file in the **Save in** field. Normally the default file-type in the **Files of type** field is the correct one for the GIBBS workspace format (i.e. *.GES5 file).

The output is unformatted and cannot be printed.

**SET_R_AND_P_NORM**

The value of the gas constant (\( R \)) is used to define the energy units that are used for input of data. On output, all data are in SI units. The value of the pressure 1 atm is used to interpret values of the pressure given by application programs.
<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_R_AND_P_NORM</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Prompts</strong></td>
<td>Value of gas constant in your energy units /8.31451/: &lt;New value&gt;</td>
</tr>
<tr>
<td></td>
<td>The default value of the gas constant is in SI units (i.e. 8.31451). If you change this value, it only affects the interpretation of energy data given interactively from the terminal, e.g. if the value is set to 1.98717 you can give values in Calories.</td>
</tr>
<tr>
<td></td>
<td>Value of one bar in your pressure units /100000/: &lt;New value&gt;</td>
</tr>
<tr>
<td></td>
<td>The value of the pressure given in application programs is divided by this value and then multiplied with the value of one bar expressed in Pascal before it is used inside the GIBBS module.</td>
</tr>
</tbody>
</table>
## Optimizing with the PARROT Module

In this section:

<table>
<thead>
<tr>
<th>Command</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>AMEND_PARAMETER</td>
<td>132</td>
</tr>
<tr>
<td>AMEND_SYMBOL</td>
<td>134</td>
</tr>
<tr>
<td>COMPILE_EXPERIMENTS</td>
<td>137</td>
</tr>
<tr>
<td>CONTINUE_OPTIMIZATION</td>
<td>138</td>
</tr>
<tr>
<td>CREATE_NEW_STORE_FILE</td>
<td>139</td>
</tr>
<tr>
<td>EDIT_EXPERIMENTS</td>
<td>139</td>
</tr>
<tr>
<td>About the ENTER_PARAMETER Command</td>
<td>139</td>
</tr>
<tr>
<td>Defining the Parameter</td>
<td>140</td>
</tr>
<tr>
<td>ENTER_PARAMETER</td>
<td>143</td>
</tr>
<tr>
<td>LIST_ALL_VARIABLES</td>
<td>145</td>
</tr>
<tr>
<td>LIST_CONDITIONS</td>
<td>147</td>
</tr>
<tr>
<td>LIST_PARAMETER</td>
<td>147</td>
</tr>
<tr>
<td>LIST_PHASE_DATA (from GIBBS)</td>
<td>148</td>
</tr>
<tr>
<td>LIST_RESULT</td>
<td>149</td>
</tr>
<tr>
<td>LIST_STORE_FILE</td>
<td>153</td>
</tr>
<tr>
<td>LIST_SYMBOL_INGES</td>
<td>154</td>
</tr>
<tr>
<td>OPTIMIZE_VARIABLES</td>
<td>154</td>
</tr>
<tr>
<td>READ_PARROT_WORKSPACES</td>
<td>154</td>
</tr>
<tr>
<td>RECOVER_VARIABLES</td>
<td>155</td>
</tr>
<tr>
<td>REINITIATE</td>
<td>155</td>
</tr>
<tr>
<td>RESCALE_VARIABLES</td>
<td>156</td>
</tr>
<tr>
<td>SAVE_PARROT_WORKSPACES</td>
<td>156</td>
</tr>
<tr>
<td>SET_ALTERNATE_MODE</td>
<td>156</td>
</tr>
<tr>
<td>SET_EXTERNAL_PARAMETER</td>
<td>157</td>
</tr>
</tbody>
</table>
SET_FIX_VARIABLE ................................................................. 158
SET_OPTIMIZING_CONDITION .................................................... 158
SET_OPTIMIZING_VARIABLE ..................................................... 159
SET_OUTPUT_LEVELS ................................................................. 160
SET_SCALED_VARIABLE ............................................................. 161
SET_STORE_FILE ......................................................................... 162
AMEND_PARAMETER

This AMEND_PARAMETER command is for the PARROT module. There is also a GES module command with the same name ("AMEND_PARAMETER" on page 82).

Interactively modify the TP-function(s) for a specific parameter for a phase with this command. This is useful in order to correct typing errors because the old function is made available for interactive editing on the terminal.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>AMEND_PARAMETER</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompts</td>
<td>Parameter: &lt;Parameter name&gt;</td>
</tr>
<tr>
<td></td>
<td>Specify a correct parameter name. If a parameter name is not acceptable or &lt;Enter&gt; is pressed, the error message displays:</td>
</tr>
<tr>
<td></td>
<td>*** Error, please re-enter each part separately</td>
</tr>
<tr>
<td></td>
<td>The program prompts for separate input for each part for a parameter name.</td>
</tr>
<tr>
<td></td>
<td>Identifier (/X/): &lt;G or L, or TC, or BM, or V0 or VA or VB or VC or VK&gt;</td>
</tr>
<tr>
<td></td>
<td>Specify one of these types of legal identifiers (see &quot;ENTER_PARAMETER&quot; on page 143).</td>
</tr>
<tr>
<td></td>
<td>phase name (ABCD/): &lt;Phase name&gt;</td>
</tr>
<tr>
<td></td>
<td>Specify the phase name.</td>
</tr>
<tr>
<td></td>
<td>constituent (in sublattice # /ABC/): &lt;Species name&gt;</td>
</tr>
<tr>
<td></td>
<td>Specify the constituent name.</td>
</tr>
<tr>
<td></td>
<td>interacting constituent (in sublattice # /XYZ/): &lt;Species name&gt;</td>
</tr>
<tr>
<td></td>
<td>Specify the interacting constituent name; if there is no interacting constituent, press &lt;Enter&gt;.</td>
</tr>
<tr>
<td></td>
<td>interacting constituent (in sublattice # /XYZ/): &lt;Species name&gt;</td>
</tr>
<tr>
<td></td>
<td>If there is more than one interacting constituent, specify these; otherwise press &lt;Enter&gt;.</td>
</tr>
<tr>
<td></td>
<td>degree /#/: &lt;Degree&gt;</td>
</tr>
<tr>
<td></td>
<td>Specify a numerical number as the degree of the phase parameter.</td>
</tr>
<tr>
<td></td>
<td>After the parameter name is specified correctly, the program lists its current</td>
</tr>
</tbody>
</table>
Syntax | AMEND_PARAMETER
---|---
definition (either preset in database or defined by the ENTER_PARAMETER command), such as:

L(PHASE2,AL,MG;1)=
298.15<T<2000.00: +5000
2000.00<T<4500.00: +4500
4500.00<T<6000.00: +4000

You are prompted to change the parameter definition:
do you want to change the number of ranges /No/: <Y or n>

To change the number of ranges for the chosen function, or change some of the temperature limits in the definition, by typing Y you have to retype both the low/high temperature limits and functions

If you do not want to change the number of ranges but want to change the function(s) in one or more ranges, press <Enter> to accept the default N the whole definition of the chosen parameter in all ranges (if any) is listed such as:

DIFFERENT FUNCTIONS IN THESE RANGES
298.15<T<2000.00
2000.00<T<4500.00
4500.00<T<6000.00

This message prompts:
do you want to change range limits /No/: <Y or n>

If there is more than one range, this question is prompted. Press <Enter>.

range number (0 to exit) /0/: <Range number>

If the function of a parameter is different in two or more temperature ranges, you must specify the range of the function of which you want to amend. Or press <Enter> or type 0 to exit this command without making any change.

Function
The previous function is available for editing. The editing is performed within the general subroutine FOOLED, as described in "AMEND_SYMBOL" on the next page. This routine prompts as follows:

1: +: >
### AMEND_PARAMETER

The prompt consists of the current position in the string and the character at that position between colons, (::).

**Commands**

These commands can be given:

- **Help:** ?
- **Move CP to last or first character:** <+-> A
- **Delete characters from CP:** <+-#characters> D
- **Exit:** E
- **Find:** <#occurrences> P<string>@
- **Insert:** I<string>@
- **Move:** <+-#positions> M
- **Restore string:** R
- **Substitute:** S<OLD>@<NEW>@
- **Type string:** T

where CP denotes the current position in string, # means number of, @ is a terminator of an input or search string.

When the string is typed the character at the current position is replaced by an underscore _.

To finish the editing of the current function, type E.

Give a range number to edit that function, or press <Enter> or type 0 to exit this command.

### AMEND_SYMBOL

This command is for the GES (GIBBS) and PARROT modules.

Interactively calculate the current values of a function or table (predefined by the switched database or previously entered with "ENTER_SYMBOL" on page 113) at the current temperature and pressure condition, and also possible to modify the definitions of variables or functions.
The current values of the temperature and pressure used to calculate the functions or tables are the ones listed with "LIST_STATUS" on page 122. There is no way to change the current temperature and pressure values interactively.

To modify the definitions of entered symbols (variable, functions or parameters), the performance of this command is slightly different one from another, as described below:

- For variables, the values can be changed.
- For functions the low and high temperature limits in various ranges (if any), as well the expressions, can be changed.
- For parameters the low and high temperature limits in various ranges (if any), as well the expressions, can be changed.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>AMEND_SYMBOL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name:</td>
<td>&lt;Symbol name&gt;</td>
</tr>
<tr>
<td>Specify the name of an entered symbol.</td>
<td></td>
</tr>
<tr>
<td>For tables and functions (or parameters which are treated as functions after these are entered by the ENTER_SYMBOL command with the Parameter keyword, but not by the ENTER_PARAMETER command), after the symbol name is specified here, the program automatically calculates the values under the current temperature and pressure conditions, and lists the current values, such as:</td>
<td></td>
</tr>
<tr>
<td>FUNCTION VALUE 2.52500000E+01</td>
<td></td>
</tr>
<tr>
<td>TABLE VALUE 1.56000000E+02</td>
<td></td>
</tr>
<tr>
<td>For variables and functions (or parameters), there are additional prompts and depend on the symbol type. For a variable, its current value is displayed, and you can change it to a new value:</td>
<td></td>
</tr>
<tr>
<td>Value /Current value/: &lt;New value&gt;</td>
<td></td>
</tr>
<tr>
<td>For a function (or a parameter entered as a symbol):</td>
<td></td>
</tr>
<tr>
<td>Do you want to change the number of ranges /No/: &lt;Y or n&gt;</td>
<td></td>
</tr>
<tr>
<td>To change the number of ranges for the function, or change some of the temperature limits in the definition, For Y, you must retype both the low/high temperature limits and functions (see all the remaining details in the ENTER_SYMBOL command.</td>
<td></td>
</tr>
</tbody>
</table>
| If you do not want to change it, press <Enter> to accept the default. The
### Syntax

<table>
<thead>
<tr>
<th>AMEND_SYMBOL</th>
</tr>
</thead>
</table>

Definition of the chosen function in all ranges (if any) is listed, for example:

```plaintext
DIFFERENT FUNCTIONS IN THESE RANGES
298.15<T<2000.00
2000.00<T<4500.00
4500.00<T<6000.00
```

And this message displays:

```
Do you want to change range limits /No/: <Y or N>
```

If a function is different in two or more temperature ranges, you must specify the range of the function of which you want to amend. Or press <Enter> or type 0 to exit this command without making any change.

Range number (0 to exit) /0/: <Range number>

Function:

The previous function is available for editing. The editing is performed within the general subroutine FOOLED. This routine prompts as follows:

```
1:+:
```

The prompt consists of the current position in the string and the character at that position between colons (::).

### Commands

These commands can be given:

- **Help**: ?
- **Move CP to last or first character**: <+/-> A
- **Delete characters from CP**: <+ #-characters> D
- **Exit**: E
- **Find**: <#occurrences> F<string>@
- **Insert**: I<string>@
- **Move**: <+ #-positions> M
- **Restore string**: R
- **Substitute**: S<OLD>@<NEW>@
- **Type string**: T
Syntax | AMEND_SYMBOL
--- | ---
where CP denotes the current position in the string, # means number of, @ is a terminator of an input or search string.

When the string is typed the character at the current position is replaced by an underscore _. To finish the editing of the current function, type E at the prompt.

**COMPIL_ EXPERIMENTS**

The descriptions of the experimental equilibria saved on a textual *.POP file, given as commands in the POLY and ED_EXP syntax, is compiled by this command into the PARROT structured data, i.e. stored into the current work *.PAR file which is created with "CREATE_NEW_STORE_FILE" on page 139, set by "SET_STORE_FILE" on page 162, or opened with "READ_PARROT_WORKSPACES" on page 154, all done before COMPILE_EXPERIMENTS.

This command also lists the compilation details on screen or onto a listing file (*.TXT).

If a syntax error in the commands is detected, the compilation is terminated. You need to correct the error in the *.POP file (using a textual editor) and recompile it with the *.PAR work (store) file.

After a successful compilation, the program translates all the experimental data points in the *.POP file into a graphical experimental data file (*.EXP) in the DATAPLOT syntax, which can be further edited and used as a graphical experimental data file (*.EXP) for the purposes of imposing onto calculated/plotted phase diagrams and/or property diagrams for comparisons during the assessment process.

Also see the **DATAPLOT User Guide** included with this documentation set.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>COMPIL_ EXPERIMENTS</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>A window displays to open the original experimental data file (*.POP). Enter a *.POP File name box, and specify the working directory in the Look in box. Normally the default file-type in the Files of type field is the correct one for the experimental data format (i.e. *.POP file). Click Open or Cancel button as applicable.</td>
</tr>
</tbody>
</table>

**Prompts**

Output to screen or file /Screen/: <*.pop file name>

A list of the source code in the *.POP file and error messages during compilation is written on screen (by pressing <Enter>) or on a list *.TXT file under a specific file name which can later on be opened and edited by any
**Syntax** | **COMPILE_EXPERIMENTS**
---|---
basic textual editor.

`initialize store file /y/: <y or n>`

After a successful compilation, the data in the POLY3 workspace is stored as a new block of equilibria on the current work (store) file. If you specify that the store file should be initiated before compilation (y), only the compiled block is stored on the current work file (consequently, the *.PAR file is updated). If a negative answer (n) is chosen here, the current work file is not changed.

A window displays to generate/store the graphical experimental data file (*.EXP) in the DATAPLOT syntax. Enter a *.EXP file name in the **File name** field and specify the working directory when opening the *.EXP file in the **Look in** field. Normally the default file type in the **Files of type** field is the correct one for the graphical experimental data format (i.e. *.EXP file). Click **Open** or **Cancel** as applicable.

**CONTINUE_OPTIMIZATION**

This command continues the optimization using the same Hessian matrix.

In some cases it is not possible to attempt continuation. For example, if the optimization has already converged or if the optimizing parameters or the set of experimental equilibria used in the current optimization runs are changed. The program gives a warning message if you try to continue when you make these changes.

**Syntax** | **CONTINUE_OPTIMIZATION**
---|---
**Prompts**
`Are you sure? /N/: <N or Y>`

Prior to this question, a message displays to confirm if it is OK to continue:

`It is safe to CONTINUE only after TOO MANY ITERATIONS and no change in variables and experiments ...`

You can accept the default (n) in order to cancel this special attempt.

`Number of iterations /N/: <Integral number of iteration>`

Specify an integral number for the optimization iteration. The specified iteration number is shown as the default number. The PARROT program tries this exact number of different sets of values of the optimizing variables without stopping the optimization even if it would have converged earlier or should give up earlier.
CREATE_NEW_STORE_FILE

This file is hardware dependent and cannot be read by any text editor.

Create a binary file to be used as a work file (also called store file) before any optimization can be done. The workspace used by the GIBBS, POLY and PARROT modules is stored automatically on the work file but not any experimental information. The binary work file has a default extension of PAR under MS-Windows or par under Linux/UNIX.

A work file that is created at a previous run can be used in the PARROT module with the other command SET-STORE-FILE.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>CREATE_NEW_STORE_FILE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt:</td>
<td><code>&lt;*.par file name&gt;</code></td>
</tr>
<tr>
<td></td>
<td>A Save window displays. Enter a File name and specify the working directory in the Save in field. Normally the default file-type in the Files of type field is the correct one for the PARROT workspace format (i.e. PAR file). Click Save or Cancel as applicable.</td>
</tr>
</tbody>
</table>

EDIT_EXPERIMENTS

Initialize and make available the sub-module for editing experimental equilibria, i.e. the ED_EXP module. All experimental equilibria compiled from the *.POP file can be accessed in the ED_EXP module.

The ED_EXP module is similar to the normal POLY module, but some commands are special and some POLY commands are not available. In the ED_EXP module, you can calculate each equilibrium separately or together, provide start values for equilibria which failed to converge, set weights, and modify the values of experiments or conditions.

Also see "Running the EDIT_EXPERIMENTS Command" on page 27.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>EDIT_EXPERIMENTS</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>You are now in this submodule and can start using the commands.</td>
</tr>
</tbody>
</table>

About the ENTER_PARAMETER Command

For the PARROT Module, this command is the same and is described here. See "ENTER_PARAMETER" on page 143 for the command details.
In the descriptions of the standard thermochemical properties and special physical properties for a phase, there are a number of parameters which may depend on the temperature and pressure. The expressions for these parameters can be given in a free form as a sum of terms with powers of \( T \) and \( P \) and may also include the natural logarithm and exponential function. This type of expression is called TP-functions. Identical parameters (in terms of parameter-names) are stored only once in the GIBBS workspaces.

The composition-dependence of the Gibbs energy is described in the GIBBS module by the internal data structure, which is created when the phase is entered (see "Gibbs Energy System (GES) Commands" on page 79). The Gibbs energy of a phase is always referred to one formula unit of the phase, i.e. the amount derived from the number of sites (i.e. the stoichiometric coefficient) for each sublattice. If vacancy is a constituent of a sublattice, the amount of matter per formula unit of the phase may vary with composition.

**Defining the Parameter**

A valid parameter should have the general form of:

\[
\langle \text{identifier} \rangle \langle \text{phase} \rangle, \langle \text{constituent array} \rangle; \langle \text{digit} \rangle \langle \text{expression} \rangle \langle \text{yyy} \rangle
\]

The identifier must be followed by an opening parenthesis, a phase name, a comma and a constituent array. Optionally, the constituent array can be followed by a semicolon and a digit. The parameter name is terminated by a closing parenthesis. The parameter form is defined as:

- \( \langle \text{identifier} \rangle \) is the parameter type;
- \( \langle \text{phase} \rangle \) is the phase name (maximum 24 characters);
- \( \langle \text{constituent array} \rangle \) is the specific constituent array in the phase;
- \( \langle \text{digit} \rangle \) is the degree of composition-dependent interaction contribution (an integer number from 0 through 9), that is only for excess energy (L), Curie temperature (TC) and Bohr magneton number (BMAGN), as well as for volume-related parameters (V0 or VA or VB or VC or VK); if it is valued as zero, or if it is for the standard Gibbs energy (G) for which the degree is always zero, it can be omitted;
- \( \langle \text{expression} \rangle \) is the mathematical relation to describe the parameter;
- \( \langle \text{yyy} \rangle \) and \( \langle \text{xxx} \rangle \) are the low and high temperature limits respectively for the applicable temperature range of the parameter expression;
- \( \langle \text{keyword} Y \text{ or N} \rangle \) is the indicator on if there is continuation for the parameter expression or not;
- \( \langle \text{zzz} \rangle \) is the reference index/number for the assessment of this parameter;
- The exclamation point ! is used to indicate that the current parameter definition is ended.
PARAMETER NAME

The GES parameter name has a general form of:

<identifier>{<phase>,<constituent array>;<digit>}

Examples of parameter names:

- G(GAS,C1O2): The Gibbs energy of formation of a CO2 molecule in gas.
- G(FCC,FE;VA): The Gibbs energy of formation of fcc Fe with interstitials.
- L(LIQ,Fe,Cr;0): The regular solution parameter for Fe and Cr in liquid.
- L(LIQ,Fe,Cr;1): The sub-regular solution parameter.
- TC(BCC,Fe:Va): The Curie temperature of bcc Fe.
- BMAGN(BCC,Fe:Va): The Bohr magneton number parameter of bcc Fe.

The parameter name consists of several parts. The first is a type-identifier and these can be used:

- G: Standard energy parameter (Gibbs energy of formation) or for interaction parameters;
- L: Excess energy parameter (Gibbs energy of interaction) always used for interaction parameters;
- TC: Curie temperature for magnetic ordering;
- BMAGN or BM: Bohr magneton number for magnetic ordering (or Born function ωPr,Tr for aqueous solute species).
- VO: Molar volume at 298.15 K and 1 bar (a numeric value only);
- VA: Integrated thermal expansivity, \( \int_{298.15}^{T} \alpha (T)dT\int_{298.15}^{T} \alpha (T)dT\)
- VB: Bulk modulus at 1 bar;
- VC: Isothermal compressibility;
- VK: High-pressure fitting parameter.

When necessary quantities as \( H \) (enthalpy), \( S \) (entropy), \( V \) (Volume), \( F \) (Helmholtz energy), etc., can be calculated from the Gibbs energy.

PHASE NAME

Specifying the PHASE NAME in uppercase is recommended; however, if you prefer to write it as a mixture of uppercase and lowercase, it automatically converts all lowercase to
uppercase, as the GIBBS module only recognises uppercase phase names. It is important that if a phase bears a legal phase-type (among G, A, Y, L, I, F and B) in its phase definition (already by the PHASE keyword; such as GAS:G, LIQUID:L, SLAG:L, IONIC-LIQ:Y, SPINEL:I, FCC_L12:F, HCP_D021:F, BCC_B2:B, AQUEOUS:A), such a valid phase-type code should not be attached to the phase name when ENTER_PARAMETER is executed.

CONSTITUENT ARRAY

The constituent array consists of a list of constituent names. Interaction parameters have two or more constituents from the same sublattice separated by a comma. If the phase has sublattices, at least one constituent in each sublattice must be specified. The constituents in different sublattices must be given in sublattice order and are separated by a colon.

After the component array, a sub-index digit can be specified after a semicolon. This digit must be in the range 0 to 9. The interpretation of the sub-index depends on the excess energy model used for the phase. If no semicolon and digit are given, the sub-index value is assumed to be as zero.

The excess energy parameters, e.g. the regular/subregular (binary) parameter or ternary parameters, are multiplied with two or more fractions of the constituents from the same sublattice of the solution phase. These additional constituents must be given as interacting constituents (as the following prompt).

Solution phases with sublattices can have interacting constituents in each sublattice.

INTERACTION PARAMETER

An interaction parameter, which is used to describe the excess term of a quantity, must have two or more constituents that interact with each other on a specified sublattice site of the given phase. It is arbitrary which of these constituents is given as the first constituent and what is given as the interacting constituents. The software always sorts the constituents (in each sublattice) in alphabetical order when the parameter name is written as a prompt (for entering its parameter value) and when the parameter is listed (using the GIBBS commands "LIST_PARAMETER" on page 147 or "LIST_PHASE_DATA (from GIBBS)" on page 148). This is important for all asymmetric interaction parameters where the sign of the interaction parameter must depend on the appearance order.

Use an asterisk* to denote that the excess interaction parameter is independent of the constituents of a specific sublattice. For example, L(FCC_L12, AL, NI: *) means that the interaction parameter is for the binary interaction between constituents AL and NI on the first sublattice in the FCC_L12 solution phase, while it is independent of all constituents on
the second sublattice. An interaction parameter in the list of constituents is always added to
the Gibbs energy and the asterisk * is calculated with the term of \[1\sum y(\text{specified}
\text{constituents})\], which implies that in an A-B binary system these \[L\] parameters are identical
(but in higher-order systems, these are different):

- \[L(\text{phase, A, B})\] is multiplied with \[X(A)\times X(B)\]
- \[L(\text{phase, A, *})\] is multiplied with \[X(A)\times (1-X(A))\]
- \[L(\text{phase, B, *})\] is multiplied with \[X(B)\times (1-X(B))\]

If you press <Enter> when you are asked for a parameter name or if you have improperly
input the entire parameter name, you are asked for each of these items in the name.

**ENTER_PARAMETER**

This command is for both the GES and PARROT modules.

Also see "About the ENTER_PARAMETER Command" on page 139 for details
about each of the options.

Use this command to enter TP-function(s) for a specific parameter for a phase interactively
with this command. If there is already a parameter expression defined (for this parameter),
that is deleted and replaced with newly entered one.

The entered TP-Function(s) for the parameter can be changed later with the command
"AMEND_PARAMETER" on page 82.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>ENTER_PARAMETER</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Prompts</strong></td>
<td>Parameter: &lt;Parameter name&gt;</td>
</tr>
<tr>
<td></td>
<td>As explained in &quot;About the ENTER_PARAMETER Command&quot; on page 139, specify a correct and complete Parameter Name, which should contain all the necessary parts of the general form:</td>
</tr>
<tr>
<td></td>
<td>&lt;Identifier&gt;(&lt;Phase&gt;,&lt;Constituent array&gt;;&lt;Digit&gt;)</td>
</tr>
<tr>
<td></td>
<td>If a parameter name is not acceptable or &lt;Enter&gt;, is pressed, a message displays:</td>
</tr>
<tr>
<td></td>
<td>*** Error, please re-enter each part separately</td>
</tr>
<tr>
<td></td>
<td>and you are prompted for input for each required part for a parameter name.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Options</th>
<th>Description or Information</th>
</tr>
</thead>
</table>

Optimizing with the PARROT Module | 143 of 370
<table>
<thead>
<tr>
<th>Syntax</th>
<th>ENTER_PARAMETER</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identifier</td>
<td>Identifier (/X/): &lt;G or L, or TC, or BM, or V0 or VA or VB or VC or VK&gt;</td>
</tr>
<tr>
<td></td>
<td>If this command is used one or more times, the previous value on this prompt is set as default. Press &lt;Enter&gt; for the same type identifier or specify a new type.</td>
</tr>
<tr>
<td>Phase name</td>
<td>Phase name (/ABCD/): &lt;Phase name&gt;</td>
</tr>
<tr>
<td></td>
<td>Each parameter is valid for a specific phase only. The name of that phase must be supplied (maximum 24 characters). The name can be abbreviated.</td>
</tr>
<tr>
<td>Constituent</td>
<td>Constituent (in sublattice # /ABC/): &lt;Species name&gt;</td>
</tr>
<tr>
<td></td>
<td>A parameter is identified by the constituents on a specified sublattice site of the given phase, the stoichiometric coefficients of which are multiplied with the parameter. The name of the constituent can be abbreviated.</td>
</tr>
<tr>
<td></td>
<td>It is the species name, not the stoichiometric formula required here.</td>
</tr>
<tr>
<td></td>
<td>If this command is used one or more times, the previous value on this prompt is set as default. Accept it by pressing &lt;Enter&gt; if the constituent is the same, or specify a new species name.</td>
</tr>
<tr>
<td>Interacting constituent</td>
<td>For phases with several sublattices, the program asks for one constituent in each sublattice.</td>
</tr>
<tr>
<td></td>
<td>Interacting constituent (in sublattice # /XYZ/): &lt;Species name&gt;</td>
</tr>
<tr>
<td></td>
<td>If this command is used one or more times, the previous value on this prompt is set as default. Press &lt;Enter&gt; to accept it if the constituent is the same, or specify a new species name.</td>
</tr>
<tr>
<td></td>
<td>To cancel the default value of the interacting constituent type NONE or the name of another constituent.</td>
</tr>
<tr>
<td></td>
<td>This question is repeated until all the interested interacting constituent(s) on a specific sublattice in the phase are specified, and finally an &lt;Enter&gt; is enforced.</td>
</tr>
<tr>
<td>Degree</td>
<td>Degree /#/: &lt;Degree&gt;</td>
</tr>
</tbody>
</table>
|              | Degree is model-dependent. Specify an integer number (a value from 0
Diffusion Module (DICTRA) Documentation

<table>
<thead>
<tr>
<th>Syntax</th>
<th>ENTER_PARAMETER</th>
</tr>
</thead>
<tbody>
<tr>
<td>through 9) as the degree of composition-dependent interaction contribution for the phase parameter. This is valid for excess energy ($L$), Curie temperature ($TC$) and Bohr magneton number ($BMAGN$), as well as for volume-related parameters ($V_0$, $VA$, $VB$, $VC$ or $VK$). For binary interaction parameters, the degree is usually the power in the Redlich-Kister expression. For ternary interaction parameters, it is usually the Hillert ternary index. For a standard $G$ parameter for a pure component (end-member) its degree should be always 0 and this prompt should not display.</td>
<td></td>
</tr>
<tr>
<td>After this prompt, the program echoes on the screen the full TP-Function of the phase parameter. Low temperature limit /298.15/: &lt;Lowest temperature limit in K&gt; Specify the lowest temperature limit (in Kelvin), or the lowest-pressure limit (in Pascal but entered as a negative number), for the current TP-Function. Function: &lt;Definition for a function&gt; A TP-Function consists of terms in $T$ and $P$. &amp; &lt;Continuation of the definition for the current function&gt; Continuation of a TP-Function definition. High temperature limit /6000/: &lt;High temperature limit in K&gt; Specify the high temperature limit (in Kelvin), or the high-pressure limit (in Pascal; only if the lowest limit is entered as a negative number) for the current TP-Function. Any more ranges /N/: &lt;Y or N&gt; Enter Y for more function(s) or N to end this command.</td>
<td></td>
</tr>
</tbody>
</table>

LIST_ALL_VARIABLES

This is a PARROT module command.
Create a list of the values and status of all variables in the PARROT workspace on screen or in a text file. After an optimization some statistical information is also written. The correlation matrix is written if that option is chosen.

Also see "SET_OUTPUT_LEVELS" on page 160.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>LIST_ALL_VARIABLES</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Output to screen or file /Screen/: &lt;File name&gt;</td>
</tr>
<tr>
<td></td>
<td>A list of the current values and status, as well statistical information (if after optimization) and the correlation matrix (optionally), for all variables is written on screen (by pressing &lt;Enter&gt;) or on the list file under a specific file name which can later on be opened and edited by basic text editor.</td>
</tr>
</tbody>
</table>

**Example Output**

The following is the listed variables for the example TCEX36, after the first optimization when having set all variables available for optimization.

```plaintext
== OPTIMIZING VARIABLES ==
AVAILABLE VARIABLES ARE V1 TO V00
VAR. VALUE       START VALUE       SCALING FACTOR
REL.STAND.DEV
V1   2.03729090E+04 2.03688352E+04 2.03688352E+04 3.41524152E+00
3.41524152E+00
V2   -2.94286372E+01 -2.94286372E+01 -2.94286372E+01 2.37944771E+00
2.37944771E+00
V11  -2.17373936E+04 -2.18095983E+04 -2.18095983E+04 3.97086303E-02
3.97086303E-02
V12  1.52107184E+01 1.51660547E+01 1.51660547E+01 5.84552327E-02
5.84552327E-02
V15  2.42082351E+01 2.45139169E+04 2.45139169E+04 5.00914471E+00
5.00914471E+00
V16  -8.38723972E+00 -8.83460472E+00 -8.83460472E+00 1.60961318E+01
1.60961318E+01
V17  3.08916533E+03 3.15802558E+03 3.15802558E+03 3.08916533E+00
9.63738108E+00
V19  2.20292586E+04 2.21385673E+04 2.21385673E+04 4.14274011E+01
4.14274011E+01 V20 -7.04217974E+00 -7.22424882E+00 -7.22424882E+00
7.22424882E+00 1.00561540E+02
NUMBER OF OPTIMIZING VARIABLES : 9
ALL OTHER VARIABLES ARE FIX WITH THE VALUE ZERO
THE SUM OF SQUARES HAS CHANGED FROM 8.00002729E+04 TO 8.00002719E+04
```
LIST_CONDITIONS

This is a PARROT module command.

In the PARROT module, generate a list of the current values of optimization conditions, as well the current status of listing, either on screen or in a basic text file which can be opened and edited by a text editor.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>LIST_CONDITIONS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Output to screen or file /Screen/: &lt;File name&gt;</td>
</tr>
<tr>
<td></td>
<td>Press &lt;Enter&gt; to output to screen or on the list file under a specific file name.</td>
</tr>
</tbody>
</table>

LIST_PARAMETER

This command is for both the GIBBS and PARROT modules.

List the TP-function(s) of a specific parameter for a phase. You must supply the name of the phase parameter:

The parameter name: <Identifier>({Phase},{Constituent array};<Digit>)

For encrypted commercial databases, you may not be able to use this command to list any retrieved parameter.
### Syntax

**LIST_PARAMETER**

<table>
<thead>
<tr>
<th>Prompt</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Parameter:</strong></td>
<td>&lt;Parameter name&gt;</td>
</tr>
<tr>
<td>Specify a correct and complete parameter name, which should contain all the necessary parts of the general form:</td>
<td>&lt;identifier&gt;(&lt;phase&gt;,&lt;constituent array&gt;;&lt;digit&gt;)</td>
</tr>
<tr>
<td></td>
<td>See &quot;About the ENTER_PARAMETER Command&quot; on page 139 to learn how to define the Parameter Name.</td>
</tr>
<tr>
<td>If a parameter name is not acceptable or &lt;Enter&gt; is pressed, an error message displays:</td>
<td>*** Error, please re-enter each part separately</td>
</tr>
<tr>
<td>The program prompts for separate input for each required part for a parameter name.</td>
<td></td>
</tr>
<tr>
<td><strong>Identifier (/X/):</strong></td>
<td>&lt;G or L, or TC, or BM, or V0 or VA or VB or VC or VK&gt;</td>
</tr>
<tr>
<td>Specify one of these types of legal identifiers.</td>
<td></td>
</tr>
<tr>
<td><strong>Phase name (/ABCD/):</strong></td>
<td>&lt;Phase name&gt;</td>
</tr>
<tr>
<td>Specify the phase name.</td>
<td></td>
</tr>
<tr>
<td><strong>Constituent (in sublattice # /ABC/):</strong></td>
<td>&lt;Species name&gt;</td>
</tr>
<tr>
<td>Specify the constituent name on the specified sublattice site of the given phase.</td>
<td></td>
</tr>
<tr>
<td><strong>Interacting constituent (in sublattice # /XYZ/):</strong></td>
<td>&lt;Species name&gt;</td>
</tr>
<tr>
<td>Specify the interacting constituent name on the specified sublattice site of the given phase; if there is no interacting constituent, press &lt;Enter&gt;.</td>
<td></td>
</tr>
<tr>
<td><strong>Interacting constituent (in sublattice # /XYZ/):</strong></td>
<td>&lt;Species name&gt;</td>
</tr>
<tr>
<td>If there is more than one interacting constituent on the specified sublattice site of the given phase, specify them; otherwise press &lt;Enter&gt;.</td>
<td></td>
</tr>
<tr>
<td><strong>Degree /#/:</strong></td>
<td>&lt;Degree&gt;</td>
</tr>
<tr>
<td>Specify a numerical number as the degree for the phase parameter.</td>
<td></td>
</tr>
</tbody>
</table>

### LIST_PHASE_DATA (from GIBBS)

This is a PARROT module command.
All data for a specific phase are written on screen. The thermochemical parameters listed for each phase are always in SI units.

### Syntax

<table>
<thead>
<tr>
<th>Syntax</th>
<th>LIST_PHASE_DATA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Phase name: &lt;Phase name&gt; Specify a phase name.</td>
</tr>
</tbody>
</table>

## LIST_RESULT

This is a PARROT module command.

List the result of the current optimization run on screen or in a specified file. The level of detail listed can be prescribed by the command "SET_OUTPUT_LEVELS" on page 160.

The LIST_RESULT command has an option `G` for creation of an experimental data file with two columns, one for the experimental value and the other for the calculated value. It allows plotting a diagram and visualizing the fitting results. The plot is automatically plotted and you can scale it giving commands in the POST module. The option `D` lists all experiments, including those with fulfilled inequalities which are suppressed with the default option `C`.

### Syntax

<table>
<thead>
<tr>
<th>Syntax</th>
<th>LIST_RESULT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Full, condensed, detailed or graphic format: /C/: &lt;C or D or F or G&gt; Choose a format.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• C (condensed) is the default.</td>
</tr>
<tr>
<td></td>
<td>• D (detailed) lists all experiments, including those with fulfilled inequalities (not included with the default condensed file).</td>
</tr>
<tr>
<td></td>
<td>• The G (graphical) format creates an experimental data file containing two columns, one with the experimental value and the other with the calculated value. This allows plotting of a diagram where all symbols should be on the diagonal if the fit is perfect. The plot is automatically plotted and you can scale it giving commands in the POST module.</td>
</tr>
<tr>
<td></td>
<td>• The F (full) format is obsolete but retained for backward compatibility.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Output to screen or file /Screen/: &lt;File name&gt;</td>
<td></td>
</tr>
</tbody>
</table>

A list of the current optimization results are written on screen (by pressing <Enter>) or on the list file under a specific file name which can later on be opened and edited by basic text editor.
Syntax | LIST_RESULT

<table>
<thead>
<tr>
<th>The output normally consists of these parts:</th>
</tr>
</thead>
<tbody>
<tr>
<td>• A title showing the data of the action;</td>
</tr>
<tr>
<td>• A message on successful optimization with the iteration number in the last optimization;</td>
</tr>
<tr>
<td>• A paragraph describing the optimization condition;</td>
</tr>
<tr>
<td>• A list of the latest set of optimized and fixed variables;</td>
</tr>
<tr>
<td>• A paragraph describing the optimization quality (some statistical information);</td>
</tr>
<tr>
<td>• A correlation matrix for all optimizing variables (optionally shown, pre-set by the SET_OUTPUT_LEVELS command);</td>
</tr>
<tr>
<td>• A list of all parameters (including their symbol names, status and current values or function expressions), and all phase descriptions (including phase name, model names, constituents, and phase's (G/L/TC/BM) expressions) predefined for each phase in the system (optionally shown, pre-set by the SET_OUTPUT_LEVELS command);</td>
</tr>
<tr>
<td>• A paragraph describing the alternate equilibria (and possible error during optimization);</td>
</tr>
<tr>
<td>• A detailed list on all the equilibrium points used in the current optimization. If the alternate-mode is used in the optimization, only an error value is shown. For normal-mode calculations, a list is shown for the experimental equilibrium numbers (first column) and corresponding original experimental data (second column, in the form quantity = value) which are used in optimization (i.e. non-zero weighted points). Such experimental data are by each point compared by the calculated value (third column) after the last optimization. Also listed are the experimental error (column 4), the difference between the calculated value and original experimental data (column 5), and the contribution to the sum of least square (column 6).</td>
</tr>
</tbody>
</table>

**Example Output**

The following is the listed result in the example tcex36 (in the *Thermo-Calc Console Mode Examples Guide*), after the first optimization based on the prescribed definitions in the TCEX36a.TCM and TCEX36b.TCM, but having set all variables available for optimization.
OUTPUT FROM PARROT.
=================================================================
*** SUCCESSFUL OPTIMIZATION. ***  NUMBER OF ITERATIONS: 10

== OPTIMIZING CONDITIONS ==

RELATIVE STANDARD DEVIATIONS FOR EXPERIMENTS: N
MINIMUM SAVE ON FILE: Y
ERROR FOR INEQUALITIES = 1.0000000E+00
RELATIVE STEP FOR CALCULATION OF DERIVATIVES = 1.0000000E-04

ARGUMENTS FOR SUBROUTINE VA05AD (HSL)

MAXFUN = 1  DMAX = 1.0000000E+02  H = 1.0000000E-04  ACC = (INITIAL
SUM OF SQUARES) * 1.0000000E-03

== OPTIMIZING VARIABLES ==

AVAILABLE VARIABLES ARE V1 TO V00

<table>
<thead>
<tr>
<th>VAR.</th>
<th>VALUE</th>
<th>START VALUE</th>
<th>SCALING FACTOR</th>
<th>REL.STAND.DEV</th>
</tr>
</thead>
<tbody>
<tr>
<td>V1</td>
<td>2.03749463E+04</td>
<td>2.03729090E+04</td>
<td>2.03729090E+04</td>
<td>3.41455863E+00</td>
</tr>
<tr>
<td>V2</td>
<td>-2.94286372E+01</td>
<td>-2.94286372E+01</td>
<td>-2.94286372E+01</td>
<td>2.37944774E+00</td>
</tr>
<tr>
<td>V11</td>
<td>-2.17395673E+04</td>
<td>-2.17373936E+04</td>
<td>-2.17373936E+04</td>
<td>3.98405298E-02</td>
</tr>
<tr>
<td>V12</td>
<td>1.52107184E+01</td>
<td>1.52107184E+01</td>
<td>1.52107184E+01</td>
<td>5.82861832E-02</td>
</tr>
<tr>
<td>V15</td>
<td>2.42106560E+04</td>
<td>2.42082351E+04</td>
<td>2.42082351E+04</td>
<td>5.07239609E-04</td>
</tr>
<tr>
<td>V16</td>
<td>-8.38723972E+00</td>
<td>-8.38723972E+00</td>
<td>-8.38723972E+00</td>
<td>1.69546796E+01</td>
</tr>
<tr>
<td>V17</td>
<td>3.08947424E+03</td>
<td>3.08916533E+03</td>
<td>3.08916533E+03</td>
<td>9.85220694E-00</td>
</tr>
<tr>
<td>V19</td>
<td>2.20314615E+04</td>
<td>2.20292586E+04</td>
<td>2.20292586E+04</td>
<td>4.16329629E+01</td>
</tr>
<tr>
<td>V20</td>
<td>-7.04217974E+00</td>
<td>-7.04217974E+00</td>
<td>-7.04217974E+00</td>
<td>1.03161466E+02</td>
</tr>
</tbody>
</table>

NUMBER OF OPTIMIZING VARIABLES : 9

ALL OTHER VARIABLES ARE FIX WITH THE VALUE ZERO

THE SUM OF SQUARES HAS CHANGED FROM 8.00002719E+04 TO 8.00002709E+04

DEGREES OF FREEDOM 45. REDUCED SUM OF SQUARES 1.7778380E+03

Number of alternate equilibria 14

SYMBOL   STATUS   VALUE/FUNCTION
R         80000000  8.3145100E+00
RTLNP     20000000  +R*T*LN(1E-05*P)
V1         48000000  2.0374946E+04
V2         48000000  -2.9428637E+01
V11        48000000  -2.1739567E+04
V12        48000000  1.5210718E+01
V15        48000000  2.4210656E+04
V16        48000000  -8.3872397E+00

Optimizing with the PARROT Module | 151 of 370
\begin{verbatim}
V17  48000000  3.0894742E+03
  21 V19  48000000  2.2031462E+04  22 V20  48000000  -7.0421797E+00

LIQUID
EXCESS MODEL IS REDLICH-KISTER_MUGGIANU
CONSTITUENTS: A, B

\begin{align*}
G(\text{LIQUID},A;0) - G(\text{BCC},A;0) & = 500.00 < T < 2000.00: +14000 - 10T \\
G(\text{LIQUID},B;0) - G(\text{BCC},B;0) & = 500.00 < T < 2000.00: +18000 - 12T \\
L(\text{LIQUID},A,B;0) & = 500.00 < T < 2000.00: +V11 + V12T \\
L(\text{LIQUID},A,B;1) & = 500.00 < T < 2000.00: +V13 + V14T
\end{align*}

A2B

2 SUBLATTICES, SITES 2: 1 CONSTITUENTS: A : B

\begin{align*}
G(A2B,A:B;0) - 2G(\text{BCC},A;0) - G(\text{BCC},B;0) & = \\
 & 500.00 < T < 2000.00: +V1 + V2T + V3T*\ln(T)
\end{align*}

BCC

EXCESS MODEL IS REDLICH-KISTER_MUGGIANU
CONSTITUENTS: A, B

\begin{align*}
G(\text{BCC},A;0) - G(\text{BCC},A;0) & = 500.00 < T < 2000.00: 0.0 \\
G(\text{BCC},B;0) - G(\text{BCC},B;0) & = 500.00 < T < 2000.00: 0.0 \\
L(\text{BCC},A,B;0) & = 500.00 < T < 2000.00: +V15 + V16T \\
L(\text{BCC},A,B;1) & = 500.00 < T < 2000.00: +V17 + V18T
\end{align*}

FCC

EXCESS MODEL IS REDLICH-KISTER_MUGGIANU
CONSTITUENTS: A, B

\begin{align*}
G(\text{FCC},A;0) - G(\text{BCC},A;0) & = 500.00 < T < 2000.00: 408 \\
G(\text{FCC},B;0) - G(\text{BCC},B;0) & = 500.00 < T < 2000.00: +3300 - 3T \\
L(\text{FCC},A,B;0) & = 500.00 < T < 2000.00: +V19 + V20T \\
L(\text{FCC},A,B;1) & = 500.00 < T < 2000.00: +V21 + V22T
\end{align*}

======== BLOCK NUMBER 1

DEFINED CONSTANTS

\begin{align*}
\text{DX} &= 2E-2, \text{ P0} = 101325, \text{ DH} = 500, \text{ DT} = 10
\end{align*}

DEFINED FUNCTIONS AND VARIABLES

\begin{align*}
\text{HTR} &= H_{\text{LIQUID}} - H_{\text{A2B}} \\
\text{Alternate equilibrium calculation} & = 0.4183 \\
\text{Alternate equilibrium calculation} & = 0.1932 \\
\text{Alternate equilibrium calculation} & = 0.1016 \\
\text{Alternate equilibrium calculation} & = 1.4354E-03 \\
\text{Alternate equilibrium calculation} & = 2.5063E-02
\end{align*}
\end{verbatim}
Alternate equilibrium calculation 8.3929E-03
Alternate equilibrium calculation 141.4
Alternate equilibrium calculation 141.4
Alternate equilibrium calculation 141.4
Alternate equilibrium calculation 141.4
Alternate equilibrium calculation 1.2532E-03
Alternate equilibrium calculation 5.4781E-04
Alternate equilibrium calculation 1.5404E-03
Alternate equilibrium calculation 141.4

ACR(B)=9.4E-1 0.9397 2.85E-02 -2.7745E-04 -9.7472E-03
ACR(B)=8.4E-1 0.8395 2.82E-02 -4.9038E-04 -1.7396E-02
ACR(B)=7.4E-1 0.7407 2.81E-02 7.3804E-04 2.6305E-02
ACR(B)=6.4E-1 0.6424 2.81E-02 2.3935E-03 8.5272E-02
ACR(B)=5.4E-1 0.5434 2.82E-02 3.4449E-03 0.1220
ACR(B)=4.4E-1 0.4428 2.85E-02 2.8265E-03 9.9024E-02
ACR(B)=3.4E-1 0.3394 2.90E-02 -5.8174E-04 2.0260E-02
ACR(B)=2.3E-1 0.2320 2.97E-02 2.0260E-03 6.8208E-02
ACR(B)=1.2E-1 0.1194 3.06E-02 -6.4192E-04 -2.0981E-02
HMR(LIQUID)=-1964 -1957. 5.00E+02 7.439 1.4878E-02
HMR( LIQUID)=-3500 -3478. 5.00E+02 21.67 4.3338E-02
HMR( LIQUID)=-4588 -4565. 5.00E+02 22.69 4.5382E-02
HMR( LIQUID)=-5239 -5217. 5.00E+02 21.50 4.3008E-02
HMR( LIQUID)=-5454 -5435. 5.00E+02 19.11 3.8216E-02
HMR( LIQUID)=-5233 -5217. 5.00E+02 15.50 3.1008E-02
HMR( LIQUID)=-4575 -4565. 5.00E+02 9.691 1.9382E-02
HMR( LIQUID)=-3481 -3478. 5.00E+02 2.669 5.3385E-03 118 HMR(LIQUID)=-1950 -1957. 5.00E+02 -6.561 -1.3122E-02

**LIST_STORE_FILE**

This is a PARROT module command.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>LIST_STORE_FILE</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Displays the name of the store file and its full path.</td>
</tr>
</tbody>
</table>
LIST_SYMBOL_IN_GES

This is a PARROT module command.

Lists TP-function(s) for the entered model parameters for phases in the system on screen. In many cases, the optimizing variables are parts of the TP-functions which in turn are entered in model parameters for various phases in the GIBBS workspace.

This command is a way to find out how the functions depend on the optimizing variables. In the PARROT module the list is only shown on screen, not written to any file (which the LIST_SYMBOL command in the GIBBS module does).

<table>
<thead>
<tr>
<th>Syntax</th>
<th>LIST_SYMBOL_IN_GES</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Name: &lt;Symbol name&gt;</td>
</tr>
<tr>
<td></td>
<td>Specify a symbol name.</td>
</tr>
<tr>
<td></td>
<td>Only those symbols that match this name are listed. Or press &lt;Enter&gt; for a list of all available symbols entered in the system.</td>
</tr>
</tbody>
</table>

OPTIMIZE_VARIABLES

Perform variable optimization. All system-definition data needed for the optimization is read from the current work file (*.PAR). The result of the optimization is automatically stored in the current work file.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>OPTIMIZE_VARIABLES</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Number of iteration /N/: &lt;Integral number of iteration&gt;</td>
</tr>
<tr>
<td></td>
<td>Specify an integral number for the optimization iteration. The specified iteration number is shown as the default number. The PARROT module tries this number of different sets of values of the optimizing variables unless it has converged earlier, or has given up earlier.</td>
</tr>
<tr>
<td></td>
<td>It initially takes a small step in each variable to find the steepest slope. You can give zero iteration to calculate the error in all selected experiments, and then use &quot;LIST_RESULT&quot; on page 149 to check how good (bad) the current fit is.</td>
</tr>
</tbody>
</table>

READ_PARROT_WORKSPACES

This command is used in the PARROT module.
Read the previous PARROT/GIBBS/POLY3 workspaces back to replace the current PARROT/GIBBS/POLY3 workspaces. It is useful if late changes made through various PARROT/GIBBS/POLY commands are not satisfactory.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>READ_PARROT_WORKSPACES</th>
</tr>
</thead>
<tbody>
<tr>
<td>The previous PARROT/GIBBS/POLY3 workspaces are always associated with the latest action to either open a work file by &quot;SET_STORE_FILE&quot; on page 162, or to create a work file by &quot;CREATE_NEW_STORE_FILE&quot; on page 139 (either interactively in the PARROT module or through a &quot;MACRO_FILE_OPEN&quot; on page 5 of an *SETUP.TCM file), or to update the work file by &quot;SAVE_PARROT_WORKSPACES&quot; on the next page.</td>
<td></td>
</tr>
</tbody>
</table>

Unlike the READ commands in other modules (e.g. GIBBS or PLOY), this command in the PARROT module does not ask for the file name where to read a previously opened/created/updated PARROT/GIBBS/POLY3 workspaces, for the reason described above.

⚠️ You cannot use this command if there is no work file opened or created already.

### RECOVER_VARIABLES

<table>
<thead>
<tr>
<th>Syntax</th>
<th>RECOVER_VARIABLES</th>
</tr>
</thead>
<tbody>
<tr>
<td>The values of all variables are set back to the start values.</td>
<td></td>
</tr>
</tbody>
</table>

### REINITIATE

⚠️ This command should not be used unless you want to destroy the current PARROT workspace. However, this PARROT command does not reinitiate the GIBBS/POLY3 workspaces.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>REINITIATE</th>
</tr>
</thead>
<tbody>
<tr>
<td>The workspace used by the PARROT program is reinitiated. All output and optimizing conditions are given their default values. All variables are set fixed with their value equal to zero.</td>
<td></td>
</tr>
</tbody>
</table>
RESCALE_VARIABLES

<table>
<thead>
<tr>
<th>Syntax</th>
<th>RESCALE_VARIABLES</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The current values of all the parameters are copied to their start values and the scaling factors for further optimization. Thus it should be done now and again, in particular if you think the optimization results are improved after the previous run(s), or if any variable changes more than a factor of 10.</td>
</tr>
</tbody>
</table>

SAVE_PARROT_WORKSPACES

This command is used in the PARROT module.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SAVE_PARROT_WORKSPACE</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>If the latest changes made through various PARROT/GIBBS/POLY commands are as required, use this command to save the current workspace (i.e. data area) used by the PARROT program (also including the current GIBBS and POLY3 workspaces), onto the present work *.PAR file which has already been opened by &quot;SET_STORE_FILE&quot; on page 162 or been created by &quot;CREATE_NEW_STORE_FILE&quot; on page 139 (either interactively in the PARROT module or through a MACRO_FILE_OPEN of an *SETUP.TCM file).</td>
</tr>
<tr>
<td></td>
<td>The PARROT/GIBBS/POLY3 workspaces are updated after each PARROT/GIBBS/POLY command. This means the current PARROT/GIBBS/POLY3 workspaces are always updated onto the latest work *.PAR file that is associated with the latest SET_STORE_FILE or CREATE_NEW_STORE_FILE command.</td>
</tr>
<tr>
<td></td>
<td>Unlike the SAVE commands in other modules (e.g. GIBBS or PLOY), this command in the PARROT module does not ask for the file name where to save the current PARROT/GIBBS/POLY3 workspaces, for the reason described above. You cannot use this command if there is no work *.PAR file opened or created already.</td>
</tr>
</tbody>
</table>

SET_ALTERNATE_MODE

Turn the alternate mode on or off. The alternate mode is described in "Optimizing with the PARROT Module" on page 130. It should be used only to optimize start values of the model parameters in the beginning of the assessment.

With the ALTERNATE mode is possible to include functions to be evaluated together with an alternate calculation and to select ALTERNATE mode for each experimental equilibrium.
SET_EXTERNAL_PARAMETER

This is a PARROT module command.

Optimize model parameters of the so-called external models, which may not be as fully-implemented/integrated parts inside the GIBBS system and thus are independently defined within user-specified/written source codes. This command makes links between the PARROT optimizing variables and external model parameters.

In order to be able to build the specified external model and to use this SET_EXTERNAL_PARAMETER command, it requires you to first write codes for a preferred external model (as it is not within the standard GIBBS system of the Thermo-Calc software) and then provide it to the consultancy team (consult@thermocalc.se) of Thermo-Calc Software Company in Stockholm for the purpose of including the external model in a separate DLL that is interactively connected to the Thermo-Calc software. Such a special service can/should only be provided under the restrictive condition that a specific Consultancy Project Contract is bilaterally agreed and signed in advance between users and Thermo-Calc Software.

Syntax

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_EXTERNAL_PARAMETER</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>External name: &lt;Parameter name in the external model&gt;</td>
</tr>
<tr>
<td></td>
<td>Correctly specify the parameter name defined within a specified/written external model.</td>
</tr>
<tr>
<td></td>
<td>As optimizing variable number: &lt;n&gt;</td>
</tr>
<tr>
<td></td>
<td>Give the number of the PARROT optimizing variable, which should have a unique link to the specified parameter name of the external model.</td>
</tr>
<tr>
<td></td>
<td>For example, @@ Link PARROT variables to CAM parameters:</td>
</tr>
<tr>
<td></td>
<td>SET-EXTER-PAR GT(SLAG_A,0-2,SI+4,CA+2) 1</td>
</tr>
<tr>
<td></td>
<td>SET-EXTER-PAR ET(SLAG_A,0-2,SI+4,CA+2) 2</td>
</tr>
<tr>
<td></td>
<td>SET-EXTER-PAR EXT(SLAG_A,0-2,SI+4,CA+2) 3</td>
</tr>
</tbody>
</table>
SET_FIX_VARIABLE

Prescribe a fixed value to a variable. The variable is considered as a constant at the optimization, usually after successful optimization runs for some specific variables (for some of the phases in the system). Such fixed variables can also be set back for further optimization run by using "SET_OPTIMIZING_VARIABLE" on the next page.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_FIX_VARIABLE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompts</td>
<td>Variable number: &lt;Variable number(s)&gt;</td>
</tr>
<tr>
<td></td>
<td>Specify the number of the variable. It is possible to give a range by giving two numbers with a hyphen in between (no spaces allowed), e.g. 1. The parameters within the limits are set fixed to their current values (no question of values).</td>
</tr>
<tr>
<td></td>
<td>Start value /xxxx.xxxxx/: &lt;A value to be fixed&gt;</td>
</tr>
<tr>
<td></td>
<td>Specify a numerical value to be fixed for the selected variable (only when one variable number is specified at the previous prompt). The current value for the selected variable is shown as default.</td>
</tr>
<tr>
<td></td>
<td>If a range of variable numbers is specified at the previous prompt, this question is not prompted, and the current values are used as fixed values.</td>
</tr>
</tbody>
</table>

SET_OPTIMIZING_CONDITION

Specify the conditions for the optimization. The default values are chosen automatically by the PARROT program, and in most cases these should not be changed.

The optimization stops when the sum of errors decreases by this value, even though it might be possible to increase it further with a new OPTIMIZE command.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_OPTIMIZING_CONDITION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompts</td>
<td>Relative standard deviation for experiments? /N/: &lt;Y or N&gt;</td>
</tr>
<tr>
<td></td>
<td>Choose whether the standard deviation of the experimental determinations are absolute values (N) or if these are used as relative weighting factors (Y). The estimated standard deviations of the optimized variables might be different for the two cases.</td>
</tr>
<tr>
<td></td>
<td>Min save on file? /Y/: &lt;Y or N&gt;</td>
</tr>
<tr>
<td></td>
<td>Specify whether the program should minimize the transfer of data to and from the current work file during the optimization:</td>
</tr>
<tr>
<td>Syntax</td>
<td>SET_OPTIMIZING_CONDITION</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>If Y, it speeds up the optimization. After optimization use the &quot;SAVE_PARROT_WORKSPACES&quot; on page 156 command to update the progress onto the current work file.</td>
<td></td>
</tr>
<tr>
<td>If minimum saving on file is not specified (n), the workspaces are stored on the current work file after every iteration in the optimization procedure.</td>
<td></td>
</tr>
<tr>
<td>Error for variable bounds: /1/: &lt;Return &gt;</td>
<td></td>
</tr>
<tr>
<td>This feature has not been implemented yet. Press &lt;Enter&gt;.</td>
<td></td>
</tr>
<tr>
<td>Relative step for calculation of derivatives: /1e-04/: &lt;xxx&gt;</td>
<td></td>
</tr>
<tr>
<td>In the calculation of the correlation matrix for equilibria with inaccuracy in the independent state variables, some numerical derivatives might have to be calculated.</td>
<td></td>
</tr>
<tr>
<td>Specify the relative step (xxx) for the calculation of these derivatives.</td>
<td></td>
</tr>
<tr>
<td>Maxfun (va05ad): /100/: &lt;n&gt;</td>
<td></td>
</tr>
<tr>
<td>The maximum number of iterations in the optimization. The same value set by the OPTIMIZE command.</td>
<td></td>
</tr>
<tr>
<td>Dmax (va05ad): /100/: &lt;n&gt;</td>
<td></td>
</tr>
<tr>
<td>An estimate of the maximum distance between the start and the final values of the variables. A smaller value makes the program vary the parameters with smaller factors.</td>
<td></td>
</tr>
<tr>
<td>h (va05ad): /1e-04/: &lt;xxx&gt;</td>
<td></td>
</tr>
<tr>
<td>The step used in the scaled variables for calculating numerical derivatives during the optimization.</td>
<td></td>
</tr>
<tr>
<td>acc/(initial sum of squares) (va05ad): /.001/: &lt;xxx&gt;</td>
<td></td>
</tr>
<tr>
<td>The break condition for the optimization. The accepted value is the difference between the true minimum and the calculated one.</td>
<td></td>
</tr>
</tbody>
</table>

**SET_OPTIMIZING_VARIABLE**

Specify which variable value should be estimated at the optimization. Such a variable can have a value of zero or another start value, or is fixed by "SET_FIX_VARIABLE" on the previous page prior to the previous optimization run.
For a good reference prior to this command, a list of all variables (which are used to define various parameters for phases in the optimizing system, as pre-entered in the *SETUP.TCM file or interactively entered in the GIBBS module) are obtained by using "LIST_ALL_VARIABLES" on page 145.

**SET_OPTIMIZING_VARIABLE**

Syntax: `SET_OPTIMIZING_VARIABLE`

**Prompts**
- **Variable number: <Variable number(s)>**
  - Specify the number(s) for the variable(s) to set. Any non-zero parameter within the range is allowed to be optimized. A parameter with a current value equal to zero must be specified explicitly here in order to be optimized.
  - Specify a range by giving two numbers connected by a hyphen (no space allowed!), e.g. 2-8. Under this circumstance, no question of start values are asked.

- **Start value /xxxx.xxxxx/: <A guess value>**
  - Specify a start guess of the optimum value (only when one variable number is specified at the previous prompt). The current numerical value for the selected variable is shown as default.

  ![Warning](This guess is critical as the initial guess of all parameters must make it possible to calculate the selected equilibria. If a range of variable numbers is specified at the previous prompt, this question is not prompted, and the current values (as start values) are not changed.)

**SET_OUTPUT_LEVELS**

Choose the type of information the PARROT module gives during the optimization procedure and when listing results.

Syntax: `SET_OUTPUT_LEVELS`

**Prompts**
- **List increment /1/: <Increment in iteration number>**
  - Specify the increment in iteration number for which information is listed on screen during the optimization. By giving a larger number it shortens the list.

- **List sum of squares: /Y/: <Y or N>**
  - Choose whether the sum of squares is listed on screen during the optimization
### SET_OUTPUT_LEVELS

**procedure.**

**List scaled variables: /Y/: <Y or N>**

Choose whether the scaled variable values are listed on the terminal during the optimization procedure.

**List weightened residuals: /N/: <N or Y>**

Choose whether the weighted residuals are listed on the terminal during the optimization procedure.

**List all parameters: /N/: <N or Y>**

Choose whether all parameters in the models are listed in "LIST_RESULT" on page 149.

**List correlation matrix: /N/: <N or Y>**

Choose whether the correlation matrix of the variables are listed with the commands LIST_RESULT and "LIST_ALL_VARIABLES" on page 145.

---

### SET_SCALED_VARIABLE

This command is similar to "SET_OPTIMIZING_VARIABLE" on page 159 in that it specifies start values for optimizing variables. The difference being it is functional for only one optimizing variable at one time. It also prescribes a minimum and maximum value for the variable. During the optimization runs, the variable value is limited within this min-max range.

Such a variable may have a value of zero or another start value, or may be fixed by "SET_FIX_VARIABLE" on page 158 prior to the previous optimization run. For a good reference prior to using this command, a list of all variables (which are used to define various parameters for phases in the optimizing system, as entered in the *SETUP.TCM file or interactively entered in the GIBBS module) is obtained by using "LIST_ALL_VARIABLES" on page 145.

#### Syntax

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_SCALED_VARIABLE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable number</td>
<td>&lt;Variable number(s)&gt;</td>
</tr>
</tbody>
</table>

**Prompts**

Specify the number for an optimizing variable to be set. Any non-zero parameter is allowed to be optimized, and a parameter with a current value equal to zero must be specified explicitly here in order to be optimized.

**Start value /xxxx.xxxxx/: <A guess value>**
## SET_SCALED_VARIABLE

Specify a start guess of the optimum value. The current numerical value for the selected variable is shown as default.

- **Min value** /xxxx.xxxxx/: *A guess value*
  
  Specify a minimum guess of the optimum value. It should be smaller than, at least equal to, the current start value for the selected variable.

- **Max value** /xxxx.xxxxx/: *A guess value*
  
  Specify a maximum guess of the optimum value. It should be larger than, at least equal to, the current start value for the selected variable.

### SET_STORE_FILE

Specify a store file (work file) to be used for compilation and optimization. The *.PAR work file must be created (["CREATE_NEW_STORE_FILE" on page 139](#)) as a store file. The GIBBS, POLY and PARROT workspaces are read from the specified store file (with a default extension of PAR).

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_STORE_FILE</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Prompt</strong></td>
<td>Enter an *.PAR file name in the <em>File name</em> field and specify the working directory in the <em>Look in</em> field. Normally the default file-type in the <em>Files of type</em> field is the correct one for the PARROT workspace format (i.e. *.PAR file). Click <em>Open</em> or <em>Cancel</em> as applicable.</td>
</tr>
</tbody>
</table>
# Equilibrium Calculations with the POLY_3 Module

In this section:

- About POLY3 - The Equilibrium Calculation Module ............................................. 165
- ADD_INITIAL_EQUILIBRIUM .............................................................................. 166
- ADVANCED_OPTIONS Descriptions ........................................................................... 168
- ADVANCED_OPTIONS ......................................................................................... 174
- AMEND_STORED_EQUILIBRIA ........................................................................... 184
- CHANGE_STATUS ................................................................................................. 186
- COMPUTE_EQUILIBRIUM ....................................................................................... 190
- COMPUTE_TRANSITION ......................................................................................... 193
- CREATE_NEW_EQUILIBRIUM ................................................................................ 195
- DEFINE_COMPONENTS .......................................................................................... 196
- DEFINE_DIAGRAM ............................................................................................... 196
- DEFINE_MATERIAL .............................................................................................. 200
- DELETE_INITIAL_EQUILIBRIUM ......................................................................... 204
- DELETE_SYMBOL .................................................................................................. 205
- ENTER_SYMBOL ................................................................................................... 205
- EVALUATE_FUNCTIONS ...................................................................................... 208
- LIST_AXIS_VARIABLE ........................................................................................... 208
- LIST_CONDITIONS ................................................................................................. 209
- LIST_EQUILIBRIUM .............................................................................................. 209
- LIST_INITIAL_EQUILIBRIA .................................................................................. 210
- LIST_STATUS ....................................................................................................... 210
- LIST_SYMBOLS ..................................................................................................... 211
- LOAD_INITIAL_EQUILIBRIUM .............................................................................. 212
<table>
<thead>
<tr>
<th>Command</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>MAP</td>
<td>212</td>
</tr>
<tr>
<td>POST</td>
<td>214</td>
</tr>
<tr>
<td>READ_WORKSPACES</td>
<td>214</td>
</tr>
<tr>
<td>RECOVER_START_VALUES</td>
<td>215</td>
</tr>
<tr>
<td>REINITIATE_MODULE</td>
<td>215</td>
</tr>
<tr>
<td>SAVE_WORKSPACES</td>
<td>215</td>
</tr>
<tr>
<td>SELECT_EQUILIBRIUM</td>
<td>216</td>
</tr>
<tr>
<td>SET_ALL_START_VALUES</td>
<td>217</td>
</tr>
<tr>
<td>SET_AXIS_VARIABLE</td>
<td>218</td>
</tr>
<tr>
<td>SET_CONDITION</td>
<td>220</td>
</tr>
<tr>
<td>SET_INPUT_AMOUNTS</td>
<td>222</td>
</tr>
<tr>
<td>SET_NUMERIC_LIMITS</td>
<td>223</td>
</tr>
<tr>
<td>SET_REFERENCE_STATE</td>
<td>224</td>
</tr>
<tr>
<td>SET_START_CONSTITUTION</td>
<td>226</td>
</tr>
<tr>
<td>SET_START_VALUE</td>
<td>226</td>
</tr>
<tr>
<td>SHOW_VALUE</td>
<td>227</td>
</tr>
<tr>
<td>STEP_WITH_OPTIONS</td>
<td>227</td>
</tr>
<tr>
<td>TABULATE</td>
<td>239</td>
</tr>
</tbody>
</table>
About POLY3 - The Equilibrium Calculation Module

Knowledge of the thermodynamic equilibrium is an important factor for understanding properties of materials and processes. With a database of thermodynamic model parameters, it is possible to predict such properties and also to obtain driving forces for diffusion-controlled phase transformations and other dynamic processes.

With the Equilibrium Calculation module, POLY3, it is possible to calculate many different kinds of equilibria and diagrams, in particular multicomponent phase diagrams.

Different types of databases can be used with the POLY module, and it can be used for alloys or ceramic systems, as well as gaseous equilibria, aqueous solution involved heterogeneous interaction systems. Up to 40 elements and 1000 species can be defined into a single system for equilibrium calculations.

All normal thermodynamic state variables can be used to set as conditions in calculating equilibria, and as axes in plotting diagrams. You can set the composition or any property of an individual phase as a condition. Any state variable can be varied along an axis in order to generate a diagram. During calculations of a diagram, complete descriptions of all calculated equilibria are stored, and in the diagram any state variable can be used as an axis.

The Global Minimization technique is used to ensure that the present minimum in an equilibrium calculation is the most stable minima for the specified conditions. This is based on the traditional GEM (Gibbs Energy Minimization) technique.

A Direct Global Minimization can be performed on conditions: N, n(comp), B, b(comp), w(comp), x(comp), T, and P, but not when combined conditions as e.g. w(a)-3*w(b)=1 are used or when an activity or potential condition is used. For all other types of conditions where regular minimization converges, Indirect Global Minimization, i.e. global test and corrections, if necessary, are performed until the lowest minimum is found.

- **Direct Global Minimization:** From the mesh of Gibbs energy, find the set of grid points that gives the lowest energy solution under the specified conditions. This set of grid points provides starting combination of phases and their constitutions for regular minimization to find the exact equilibrium solution. This solution is then subject to a global test as described below.

- **Indirect Global Minimization:** Under certain conditions, a direct approach is impossible. In this case, regular minimization is performed first and then a check is performed in order to see if the found local minimum is a global one by checking if all grid points are above the equilibrium Gibbs energy plane. If not, then recalculate by including these grid points until no grid point is above the equilibrium Gibbs energy plane from the previous step.
The full-scale and full-scope usage of the Global Minimization Technique has been extended from for only single-point calculations for all types of calculations (of single-points, property diagram stepping and phase diagram mapping) in Thermo-Calc.

The use of Global Minimization Technique may increase the computation time. The main cost in time comes from the calculation of Gibbs energy at each grid point generated by properly meshing the composition space for each entered phase. An additional (but much smaller) cost in time comes from finding the set of grid points in the above mesh that give the lowest energy solution. This solution is where POLY starts its ordinary minimization. When POLY has found an equilibrium, the equilibrium Gibbs energy surface is compared to the mesh to assure that no grid point is below the surface, i.e. a global minimization has been reached.

Global Minimization is performed by default in single-point or stepping or mapping equilibrium calculations.

Together with the PARROT module, the POLY module is also used for critical assessment of experimental data in order to develop thermodynamic databases. The POLY module uses the Gibbs Energy System (GES) for modeling and data manipulations of the thermodynamic properties of each phase.

**ADD_INITIAL_EQUILIBRIUM**

Add initial equilibrium points from which a phase diagram is calculated (through the "MAP" on page 212 command).

<table>
<thead>
<tr>
<th>Syntax</th>
<th>ADD_INITIAL_EQUILIBRIUM</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Direction /Default/: &lt;Direction code&gt; direction code (s) 1 or 2 for positive direction of axis 1 or 2, respectively; –1 or –2 for negative direction of axis 1 or 2, respectively; Default for all directions.</td>
</tr>
</tbody>
</table>

The direction is important when the initial equilibrium point is in a single-phase region or when the phase diagram is an isopleth (tie-lines not in the plane of calculation). In such cases, the program searches for a line in the diagram (i.e. a line where the amount of a phase is zero, imply that if it starts to become stable on one side of the line and disappear on the other side) in the given direction.

Normally, this command is not needed to calculate a property diagram (with the "STEP_ WITH_OPTIONS" on page 227 → NORMAL command-sequence). In many cases, the ADD_ INITIAL_EQUILIBRIUM command is not required for MAP commands either, as the mapping procedure starts from the current equilibrium state already calculated. In order to calculate a simple phase diagram, set the equilibrium conditions and the mapping axis variables, and
then give a MAP command. But if a phase diagram has disconnected lines, the ADD_INITIAL_EQUILIBRIUM command may still be needed to add two or more initial equilibria so that the MAP calculation starts from such initial equilibria at the specified directions to find all phase boundary lines.

This command becomes unnecessary in most cases, as the MAP routines that by default use the Global Minimisation Technique handles all the initial equilibrium points in a robust and automatic way. Therefore, you do not need to have a good guess of the starting point and to add any initial equilibrium point prior to the calculations of various types of phase diagrams. However, if preferred, use this command to add any initial equilibrium points in certain directions, the POLY module uses the specified starting point(s) and corresponding user-added initial equilibrium point(s) for a mapping calculation; in such a case, the automatic procedure in the rewritten MAP routines are not enforced while the Global Minimisation Technique can still be applied. Similar situations occur when a specific database, in which there are some definitions of initial-equilibrium adding direction(s) for accessed binary and/or ternary subsystems in its ACCESSSED_SYSTEM section, is used in the BINARY or TERNARY module for calculating a binary or ternary phase diagram.

The ADD_INITIAL_EQUILIBRIUM command with the default direction scans along the axis variables and generates start points each time the scanning procedure crosses a phase boundary. In addition, it generates four start points, scanning cross the middle of each axis, if there is any solubility line that does not reach the axes. At the MAP command, a search for lines in the diagram is made along each direction of the axis variables in the diagram. In this way, it should guarantee that all possible phase boundary lines in a phase diagram are found. Of course, it may take a little longer time to execute than using the minimum number of start points, as some lines may be calculated more than once. But the POLY module remembers all node points and subsequently stops calculations along a line when it finds a known node point.

It is also possible to create a sequence of start points from one initial equilibria by appending a > after the direction at the ADD command. For example:

```
Direction /Default/: 2>
Direction /Default/: -2>
```

This generates one start point for each set of phase change in the positive direction of the axis 2 (or negative direction of the axis 2); this ensures finding all possible phase boundary lines (not just the first one) along such an axis direction.

This is particularly useful when you have a phase diagram with several lines with no intersection. It is thus possible to calculate e.g. an isopleth for a much more limited composition range. It is also useful for calculating CVD diagrams and Pourbaix diagrams.

All the initial equilibrium points generated by the ADD_INITIAL_EQUILIBRIUM command (previously and presently; saved in the current POLY workspace) can be easily listed out on screen with "LIST_INITIAL_EQUILIBRIA" on page 210. A certain initial equilibrium point
(including its conditions and equilibrium results) can be loaded into the current equilibrium, if needed, with "LOAD_INITIAL_EQUILIBRIUM" on page 212. Any specific or all of the initial equilibrium points can be deleted from current POLY workspace, if desired, with "DELETE_INITIAL_EQUILIBRIUM" on page 204.

**ADVANCED_OPTIONS Descriptions**

Also see "ADVANCED_OPTIONS" on page 174 for information about the command.

These ADVANCED_OPTIONS can be set:

**EQUILIBRIUM_CALCUL**

Designed to decide how to perform the Ordinary POLY Minimization (i.e. the traditional Gibbs Energy Minimization) in the POLY module. By default, the Global Minimization Technique for various single point equilibrium calculations and for stepping or mapping calculations is used. You can use the advanced option "GLOBAL_MINIMIZATION" on page 295 to permanently turn off (for all sequential calculations throughout the current TCC run) the Global Minimization Technique and consequently use only the Ordinary POLY Minimization, and additionally adjust the ways to proceed the normal minimization (mainly in terms of how to control the steps in reaching Gibbs energy minima in an equilibrium state). When enforcing the Global Minimization Technique in the equilibrium calculations, you can further adjust the manners for assigning grid-points and for handling new possible compositional set(s) for solution phases during stepping/mapping; since the Global Minimization Technique also uses the normal POLY optimization routine for some calculations, it is also possible to change the ways on how to control the steps in reach Gibbs energy minima in an equilibrium state, in order to improve convergence.

**GLOBAL_MINIMIZATION**

Designed to decide how to perform the so-called Global Minimization in the POLY module. By default, the POLY module uses the Global Minimization Technique for various single-point equilibrium calculations and for stepping or mapping calculations. You can use this to permanently (for all sequential calculations throughout the current TCC run) turn off the Global Minimization Technique and consequently use only the Ordinary POLY Minimization, and additionally adjust the ways to proceed the normal minimization (mainly in terms of how to control the steps in reaching Gibbs energy minima in an equilibrium state). When enforcing the Global Minimization Technique in the equilibrium calculations, you can adjust the manners for assigning grid-points and for handling new possible compositional set(s) for solution phases during stepping/mapping; since the Global Minimization Technique also uses the normal POLY optimization routine for some calculations, it is also possible to change the
ways on how to control the steps in reach Gibbs energy minima in an equilibrium state, in order to improve convergence.
LIST_PHASE_ADDITION

The values set as additional contributions (given by PHASE_ADDITION) to Gibbs energy $G_m$ ($J/mol$ formula unit) to all the phases (stoichiometric or solution) are listed at the current calculated equilibrium.
**MAJOR_CONSTituENTS**

Use this to set the major constituent(s) of a composition sets in a miscibility gap of a solution phase. Normally, the major constituents are specified when a new composition set is created by the NEW_COMPOSITION_SET option; but for the first composition set, this option may be needed before using NEW_COMPOSITION_SET.

**NEW_COMPOSITION_SET**

A solution phase that can exist with two (or more) different compositions simultaneously must have two (or more) composition sets in its phase descriptions. Normally the database creates as many composition sets as is necessary but use this command to add or delete more composition sets. A complex solution phase in a defined multicomponent system can have up to 9 different composition sets for the purpose of appropriately handling its possible miscibility gap(s) under various temperature-pressure-composition conditions.

This option is unnecessary if the Global Minimization Technique is in use, as it can automatically detect all possible miscibility gap(s) for complex solution phases (normal or disordered/ordered phases) and then automatically add required composition sets for such phases in the defined system.

This option can automatically create composition sets also for disordered phase when it is executed for the ordered phase.

If you have your own data file, this option must be used to indicate that a solution phase can have a miscibility gap (or may exhibit some complex phase separations as to more than two composition sets), unless that the possibly-additional composition set(s) for the solution phase must have already been added inside the TDB file (through a TYPE_DEFINITION command to amend composition-set) or been manipulated through the GIBBS module (using the AMEND_PHASE_DESCRIPTION COMPOSITION_SET command-sequence). This option asks for default major constituents for the new sets and it is important that this is set correctly, otherwise the test for miscibility gaps may fail.

**OUTPUT_FILE_FOR_SHOW**

The name of a text file is asked for and all the results output from the command SHOW_VALUE is written to this file.

**PARAEQUILIBRIUM**

This calculates a paraequilibrium between two specific phases in an alloy system with one or more interstitial component(s) as fast diffusion species. Under the paraequilibrium state,
two partially-equilibrated phases have the same chemical potential (but different contents) for one or more interstitial components (such as C, N, O, S, etc., as individual or combined), along varied temperature or along a composition variable (of the matrix or one substitutional component) which has already set as the stepping variable with "SET_AXIS_VARIABLE" on page 218.

To ensure a successful point calculation of paraequilibrium state between two specific phases in a defined alloy system, it is important that you first have made a single-point equilibrium calculation with an initial overall composition in the current system before performing this advanced-option calculation; however, it is unnecessary to obtain an equilibrium in which either one or both of the target phases is stable. The initial overall composition must have a reasonable setting for the desired paraequilibrium calculation for the two target phases. This is especially true for cases where there are more than one interstitial components to be considered in the paraequilibrium state, because different interstitial components (for example C and N combined) may have significant different behaviors as partitioning into different structured phases; otherwise, for one chosen interstitial component the initial overall composition is OK for the paraequilibrium calculation between the specified two phases, but for other chosen interstitial component(s) it might be impossible to calculate the paraequilibrium state.

Note the following:

Always check if the chosen phases A and B have the exactly same definition of elements and if the chosen interstitial components are all in the vacancy sublattice sites of the two phases; otherwise, the program cannot find the paraequilibrium state (as it is impossible to correctly calculate u-fractions).

Always have a comprehensive understanding of the normal phase diagram for the currently investigated system, so that you make the appropriate choice of the phase pair and staring bulk composition for the system.

Always set the status of the chosen interstitial components as SPECIAL using the POLY command: "CHANGE_STATUS" on page 186 Component <interstitial component> = SPECIAL. By doing this, you get a clear picture of u-fractions of various substitutional and interstitial components, which are different from the overall composition in the system. The SPECIAL status means that specified component(s) are not included in summations for mole or mass fractions. Therefore, all the composition variables plotted from paraequilibrium calculations are u-fraction related quantities.

**PHASE_ADDITION**

Sometimes it is interesting to add a constant contribution to the Gibbs energy of a phase (stoichiometric or solution). This can be done in the Database Module (DATA) or Gibbs
Energy Module (GIBBS), for a stoichiometric phase, or for a pure end-member in a solution phase. However, if the addition is related to the equilibrium state, for example, strain energies or surface energies, interfacial energies or deformation energies, it may be more convenient to have this quantity related to the equilibrium state rather than the thermodynamic data.

Give a value of an addition to the Gibbs energy of a phase. The value should always be constant (implying that the addition is not a function of phase composition or temperature-pressure conditions in the equilibrium state) and always be given in the unit of J/mol formula unit of the phase.

**PRESENT_PHASE**

The phase specified must be stable at all equilibria calculated during a "MAP" on page 212 command. It is a way to limit the calculations of the monovariant lines in a ternary system to those in the liquidus surface. Normally such a calculation would have two compositional axes and a temperature axis and all monovariant lines, also those between 3 solids, would be mapped. If the liquid is set as PRESENT, only those with the liquid is mapped.

**SHOW_FOR_T**=

Display various thermodynamic properties (state variables, derived/partial variables or entered symbols) of the currently calculated (stable/meta-stable) equilibrium state but under a different temperature condition. This is useful for knowing, for example, a volume-related property of a frozen (stable/meta-stable) equilibrium state at a certain temperature, where the equilibrated phase assemblage and all the phase compositions are not adjusted while only the temperature condition is changed.

Use this option carefully. You must have successfully calculated a real equilibrium state under one temperature condition (normally the temperature for the last heat treatment). This can then be used to obtain the value(s) of any specified state variable(s) or derived/partial variable(s) or defined symbol(s) for thermodynamic properties of the entire system, of components, or of phases for the currently-defined system (being in a frozen state) under another temperature (normally at room temperature). No real equilibrium is re-calculated through this option, and thus the phase amounts and compositions in the system are the same as at the last real equilibrium calculation.

**STABILITY_CHECK**

In some composition ranges of a multicomponent system, it often happens that an unstable solution phase region locates inside a miscibility gap, and the stability limit (the spinodal curve or spinodal) may be not easy to find. A system inside a spinodal is thermodynamically
unstable with respect to compositional fluctuations, and the system may experience the spinodal decomposition (i.e. decomposing to a mixture of regions with the two stable compositions, one on each side of the miscibility gap).

This option makes it possible to automatically check internal stability of both stable and unstable phases in all subsequent single-point equilibrium and MAP/STEP calculations. It can find out if any phase is subject to spinodal decomposition during the subsequent calculations. If there is an unstable phase located inside a miscibility gap in a calculation, it gives a warning so that you suspend the unstable phase, or use FORCED automatic start values for phase constituents (i.e. "SET_ALL_START_VALUES" on page 217 → FORCE command-sequence), or create other composition sets; you can also ignore the warning message if you know that the unstable phase is not formed in the current calculations.

**STEP_AND_MAP**

This is the default and is used to determine how to perform Global Minimization test and how to handle initial equilibrium points.

**T-ZERO_TEMPERATURE**

This calculates the temperature when two specific phases have the same Gibbs energy, i.e. the so-called $T_0$ temperature. You must calculate an equilibrium state at an estimated temperature before performing this advanced-option calculation; however, it is unnecessary to obtain an equilibrium state in which either one or both of the target phases is stable.

**TOGGLE_ALTERNATE_MODE**

Toggle the ALTERNATE mode for experimental equilibrium calculation between DEFAULT, ALWAYS and NEVER, during data-assessments using the PARROT optimization.

**ADVANCED_OPTIONS**

<table>
<thead>
<tr>
<th>Syntax</th>
<th>ADVANCED_OPTIONS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Which option? /Step_and_Map/: &lt;Option&gt;</td>
</tr>
</tbody>
</table>

Also see "ADVANCED_OPTIONS Descriptions" on page 168.

LIST_PHASE_ADDITION has no additional prompt.

**STEP_AND_MAP (the default)**

Settings for MAP and STEP:
Global test interval /0/: <Integer number>

Settings for MAP:
Automatically add initial equilibria /Y/: <Y or n>
Number of mesh along an axis /3/: <Integer number>
Use inside meshing points /N/: <Y or N>
Global test interval /0/: <Integer number>

The integer number determines how often the Global Minimization should be used during STEP_WITH_OPTIONS and MAP calculations. If it is set to 0 (zero), the recommended global test interval is used: i.e. every tenth step and at each phase change during STEP calculations, and only at node points during MAP calculations. Any other positive integer number, n, suggests it performs a Global Minimization test at every n-th step during STEP and MAP calculations. Of course, the Global Minimization test is always carried out at a phase change or a node point. The Thermo-Calc software is installed with 0 (zero) as the default value, but such a configuration for the default value can be changed by using SET_TC_OPTIONS in the SYS module.

Automatically add initial equilibria /Y/: <Y or N>

When "ADD_INITIAL_EQUILIBRIUM" on page 166 is not used before MAP, a mesh of initial equilibrium points are added before the mapping itself takes place. This mesh is only available when two (2) axes are already defined. The default on start-up may be changed by SET_TC_OPTIONS in the SYS monitor.

Number of mesh along an axis /3/: <Integer number>

An integer for how many intervals of initial equilibrium points to be added along an edge in the diagram. For example, if set to 2 (two), initial equilibrium points are added at the beginning, center, and end of each axis-variable forming 2 intervals.

Use inside meshing points /N/: <Y or N>

If N the INITIAL_EQUILIBRIUM mesh consists of initial equilibrium points added only along the edge/border of the diagram defined by the axis-variables. If Y, the initial equilibrium points added are also added inside edge.

NONE

Take away any set advanced option in all subsequent single-point equilibrium and MAP/STEP calculations.

If there is any convergence problem in finding a stable solution, at any stage of an advanced option calculation conducted by an ADVANCED_OPTIONS command-sequence, these
messages display:

Convergence problems, increasing smallest site-fraction from 1.00E-30 to hardware precision 2.00E-14. You can restore using SET-NUMERICAL-LIMITS

The smallest site fraction in the current POLY3 workspace is automatically increased from the default value 1.00E-30 to the hardware-dependent precision (under Linux, as 2.00E-14). For other subsequent POLY-module calculation in the current TC run, you can use the POLY command "SET NUMERICAL LIMITS" on page 296 to restore or reset the smallest site fraction to the previous or another preferred value, as well as to reset other numerical limits.

**EQUILIBRIUM_CALCULATION**

The following prompts affect the ways how the POLY optimization does the Ordinary POLY Minimization to reach the minimum of an equilibrium state.

Settings for the minimization of an equilibria:

- Force positive definite phase Hessian /Y/: <Y or N>
- Control stepsize during minimization /Y/: <Y or N>
- Force positive definite phase Hessian /Y/: <Y or N>

Choose Y or N to determine how to reach the minimum of an equilibrium state in a normal POLY optimization procedure. This is related to the special quantity, the phase stability function QF (phase), for all kinds of phases in an equilibrium state [A phase stability function for a phase is negative when the phase composition is inside a spinodal, and positive everywhere else].

If the composition of a solution phase is inside its spinodal, the enforcement of positive definite eigenvalues of a Hessian matrix (i.e. by answering Y) makes the step be taken towards the minima rather than the local maxima. Furthermore, if an eigenvalue (for a phase) of the Hessian matrix is near 0.0, the step-size is large and the answering Y sets a lower limit to this eigenvalue, and reduces the step-size and improves the convergence. The POLY command-sequence SHOW VALUE QF(phase) shows the size of the lowest eigenvalue of a phase in an equilibrium state.

By answering Y it might help the Ordinary POLY Minimization to converge, if there is such a problem, especially if QF(phase)=0 for phases.

By answering N the Ordinary POLY Minimization routine is applied.

For each phase in a defined system, the molar Gibbs energy of the phase is a function of the temperature-pressure condition and its composition:
**Diffusion Module (DICTRA) Documentation**

**Equilibrium Calculations with the POLY_3 Module**

\[ G_m(X) = G_m(T, P, y_1, y_2, \ldots, y_n) \]

Compute a Hessian matrix as which describes the curvature of the Gibbs energy curve of this phase at the defined composition X:

\[ \partial^2 G_m / \partial y_i \partial y_j \]

Diagonalize this matrix and call the Eigenvalues as \( e_1, e_2, \ldots, e_n \). The QF(\text{phase}) quantity for this phase is the lowest of these eigenvalues divided by the same values for a corresponding ideal (stoichiometric) phase:

\[ QF(\text{ph}) = \min \{e_1, e_2, \ldots, e_n\} / \min \{se_1, se_2, \ldots, se_n\} \]

Here, \( se_1, se_2, \ldots, se_n \) are the eigenvalues for the ideal phase. Therefore, for an ideal (stoichiometric) phase, the QF(\text{phase}) should always be 1.0.

**Control stepsize during minimization** /\( Y \)/: <\( Y \) or \( N \)>

Choose \( Y \) or \( N \) to determine whether to introduce a control of step-size while reaching the minimum of an equilibrium state in a normal POLY optimization procedure. By answering \( Y \) it might help the POLY optimization to converge, especially if when some site fractions are less than \( 1E-4 \).

**GLOBAL_MINIMIZATION**

The following prompts affect how the Global Minimization is done. Settings for global minimization:

Use global minimization as much as possible /\( Y \)/: <\( Y \) or \( N \)>

Use global minimization for test only? /\( N \)/: <\( Y \) or \( N \)>

Maximum number of gridpoints per phase /2000/: <Integer number>

Use global minimization as much as possible /\( Y \)/: <\( Y \) or \( N \)>

Choose \( Y \) or \( N \) to decide if using the Global Minimization Technique from start of calculation or not. The default value on start-up may be changed by SET_TC_OPTIONS in the SYS module.

If \( Y \) the calculation is done when possible (depending on the condition settings), and a Global Minimization test is always performed when an equilibrium is reached. This costs more computer time but the calculations are more accurate.

If \( N \) the calculation is not used to reach the equilibrium state. Use global minimization
for test only? determines if the Global Minimization test is made against the calculated equilibrium states obtained by the Ordinary POLY Minimization calculation.

Use global minimization for test only? /N/: <Y or N>

If Y a calculated equilibrium state obtained by the Ordinary POLY Minimization calculation is tested against the Global Minimization Technique after it is reached; and if found it as unstable, there is an error message.

If N the Global Minimization Technique is never tested for or done for all sequential calculations throughout the current TCC run. This implies that Global Minimization Technique is permanently turned off, and that consequently only the Ordinary POLY Minimization routine is used.

Maximum number of gridpoints per phase /2000/: <Integer number>

Specify the maximum number of grid points that are computed for each of the phases in the currently defined system, during the calculations enforced by the global minimization. More grid points give a higher robustness and take more computation time. The total number of computed grid points in all phases is limited to 2E6.

**IGNORE_COMPOSI_SET_ORDER**

Ignore composition set order /N/

**NEW_COMPOSITION_SET**

The following prompts are to specify the additional composition set(s) to handle possible miscibility gap(s) of a certain solution phase:

Phase with miscibility gap: <Name of a phase>

Specify the name of the phase with miscibility gap.

New highest composition set number /2/: <#>

The default value is usually one higher than the current value. Each phase has initially one composition set. If a lower value is given, composition sets are deleted. You cannot take away the first composition set.

A message displays to show that you need to specify the composition for the composition set # (2,3,...).

**Major constituent(s) for sublattice 1: /XX/: <YY>**

The major constituents (YY) in each sublattice can be given. This may simplify giving start values when calculating the equilibrium as phases with miscibility gaps should have different
major constituents for each composition set.

This prompt is repeated for each sublattice in the phase, sometimes even for all sublattices in the first composition set if such major constituents have not been specified.

**MAJOR_CONSTITUENT**

The following prompts are to specify the major constituent(s) on each of the sublattice sites for a composition set of a certain solution phase:

Phase name: <name of a phase>

Specify the name of the solution phase with a new set of major constituents.

Composition set number /1/: <#>

The default value for the composition set number (#) is usually /1/ as the other composition sets are given major constituents when creating them. Each phase has initially one composition set.

Major constituent(s) for sublattice 1: /XX/: <YY>

The major constituents (YY) on each sublattice of a solution phase can be given. This may simplify giving start values when calculating the equilibrium as phases with miscibility gaps should have different major constituents for each composition set.

This question is repeated for each sublattice in the phase.

**PHASE_ADDITION**

The following prompts are to specify the additional energy term (always being a constant) of a given phase.

Phase name: <Name of a phase>

Specify the name of the (stoichiometric or solution) phase with the addition.

Addition to G per mole formula unit: <xxxxx>

The value (xxxxx) given is added to the Gibbs energy of the (stoichiometric or solution) phase. It can represent a nucleation barrier, surface tension, elastic energy or whatsoever.

It is not composition-, temperature- or pressure-dependent.

**PRESENT_PHASE**

Specify the name of the present phase a the name of the phase that should be present at all
calculated equilibria:

Present phase:
Phase name: <Name of a phase>

Console Mode examples tcex45, tcex46 and tcex47 use this advanced option.

**T-ZERO_TEMPERATURE**

Name of first phase: <Phase A>
Name of second phase: <Phase B>

The names of phases A and B must be given, for which the T0 temperature (where the Gibbs energies are equal) is to be calculated.

If the T0 temperature between the two specified phases is successfully calculated, a message displays, e.g.

The T0 temperature is 840.82 K. Note: LIST-EQUILIBRIUM is not relevant

The first message shows the calculated T0 temperature between the two specified phases.

The second message indicates that after this option calculation with LIST_EQUILIBRIUM is irrelevant and does not list the equilibrium for the system at the T0-temperature.

**PARAEQUILIBRIUM**

Name of first phase: <Phase A>
Name of second phase: <Phase B>

The names of the two target phases A and B, between which the paraequilibrium state is to be calculated, must be entered subsequently or on the same (first) line at once then separated by an empty space, e.g. FCC#1 BCC or FCC#2 M23C6.

You need to understand what you are dealing with in terms of calculating a paraequilibrium state between the two specified phases.

Specifically, there are four distinguished cases to understand: (1) both chosen phases must have similar interstitial/vacancy sublattices where the fast-diffusion interstitial component(s) occupy; (2) the choice on the target phase pair must be reasonable for the defined system and specified initial overall composition; (3) both target phases should have phase constitution definitions that cover all the defined substitutional and interstitial components of the current alloy system; or (4) it is impossible to calculate the paraequilibrium state between the target phase pairs with given interstitial component(s) in the currently defined
Fast diffusing component: /c/: <interstitial component(s)>
Fast diffusing component: /none/: <interstitial component(s)>

The name(s) of the fast-diffusing component(s) (C as the default single component) must be
given at the above prompts subsequently or at the same (first) prompt. It is possible to
specify more than one interstitial component as fast diffusion species.

Note the following:

Such specified interstitial component(s) must be appropriately defined according to the
phase constitution definitions of the two selected phases: these must be located on the
interstitial/vacancy sublattices in both chosen phases;

If there is only one fast-diffusing component which is carbon, press the <Enter> key to accept
the default input at the first prompt; if the single fast-diffusing component is another
element (e.g. N), type its name at the first prompt;

If there are two or more fast-diffusing components (e.g. C and N), type their names at the
above prompts subsequently or at the same (first) prompt (separated by an empty space,
such as C N);

To finish the input of fast-diffusing elements, accept NONE at a repeated prompt, i.e. by
pressing <Enter> key to start the paraequilibrium point calculation;

If NONE or a non-existing component name is typed at the first prompt, it means no back
diffusion is to be considered, and the para-equilibrium calculation is thus canceled entirely.

If the paraequilibrium state between the two specified phases is successfully calculated, the
messages displays e.g.

NP(FCC) = 0.3586 with U-fractions C = 2.71821E-02 N = 4.1548129E-03
NP(BCC) = 0.6414 with U-fractions C = 7.10061E-04 N = 2.3781027E-04
All other compositions the same in both phases
Note: LIST-EQUILIBRIUM is not relevant

The first and second lines list the phase amounts expressed in mole-percent [NP(phase)] and
the contents of the interstitial components C and N in a specific phase expressed in the so-
called u-fractions [u-f(phase,C) and u-f(phase,N)], for the phase A (in this case as FCC) and
phase B (in this case as BCC), respectively. The third line states that the compositions of the
matrix component and all the remaining compositions (regarding substitutional
components) in both the target phase A and target phase B are the same at the current
paraequilibrium state, while these are not shown on screen. The last line indicates that after
this advanced-option calculation the LIST_EQUILIBRIUM command is irrelevant and does not
list the paraequilibrium state for the system at the current condition.
However, if the single-point calculation of the paraequilibrium state between the two specified phases has failed, these messages display:

*** Error 4 in ns01ad
*** Numerical error

This implies that the chosen target phase pair may be unreasonable for the defined alloy system or for the defined initial overall composition, or one or both phases may have inappropriate phase constitution definitions regarding the specified interstitial component(s). Then, you must either modify the settings of initial overall composition or specify the reasonable target phase pair with an appropriate choice of the fast diffusion interstitials in the defined alloy system.
**STABILITY_CHECK**

Stability check on? /y/: <y or n>

The default is Y to switch on the automatic stability check during all subsequent single-point equilibrium and MAP/STEP calculations. By answering N, there is no stability check in various calculations.

Check also for unstable phases? /Y/: <Y or N>

If the automatic stability-check option is switched on choose to also check the stability for unstable phases. The default is Y and if an unstable phase is found to be located in a miscibility gas during a subsequent single-point equilibrium or MAP/STEP calculation, a warning message informs you to selectively make adjustments in the calculation settings [e.g. suspending the unstable phase, or using FORCED automatic start values for phase constituents by the S_A_S_V_F command-sequence, or creating other composition sets, etc.]. By answering N the stability check is enforced only to stable phases in the system.

**TOGGLE_ALTERNATE_MODE**

Set alternate toggle to DEFAULT, ALWAYS, or NEVER?

Set global toggle to DEFAULT, ALWAYS, or NEVER?

DEFAULT means that the experiment points are calculated according to the Alternate Technique depending on the SET_ALTERNATE command.

ALWAYS means the experiment points are always calculated according to the Alternate Technique even if the Alternate Mode is switched off in the PARROT module.

NEVER means the experiment points are calculated as normal equilibria even if you SET_ALTERNATE in the PARROT module.

**SHOW_FOR_T=**

Temperature (K) /298.15/: <temperature_in_K>

Specify the new temperature condition (in K) under which the values of some specific state variable(s) or derived/partial variable(s) or defined symbol(s) for various thermodynamic properties of the entire system, of components, or of phases) in the currently-defined system (being in a frozen state) is shown on screen.

State Variable or symbol /VM/: <state variable or symbol name(s)>

Specify the name(s) of the desired state variable(s) or derived/partial variable(s) or defined symbol(s) for various thermodynamic properties of the entire system, of components, or of phases) in the currently-defined system. More than one state variable or symbol of interest
can be simultaneously specified on the same line. For example, you can choose to show the values of VM or GM (i.e. molar volume or molar Gibbs energy of the entire system), or of VM(*) or HM(*).T (i.e. molar volumes or isobaric heat capacity of all phases), or of ACR(*), DGM(*) and LNACR(*,FCC) [i.e. activities of all system components, driving forces for all phases, and activities (in logarithm) of all system components in the FCC solution phase], under the new temperature condition (being in a frozen state).

**OUTPUT_FILE_FOR_SHOW**

A window opens with a default name for the file `tc_show.dat`. Choose a location to save the file and click Open.

**AMEND_STORED_EQUILIBRIA**

This command gives information about the calculated blocks (and phase regions included in blocks) after the STEP or MAP calculation(s). It allows you to list all or part of the calculation results, to suspend all or parts of the calculation results that are redundant or where metastable equilibria are calculated, and to restore all or parts of the calculation results (if having been suspended by another AMEND_STORED_EQUILIBRIA command).

The workspace for storing equilibria may overflow during stepping or mapping, and is then written to a file as blocks. Each block usually contains one or more ranges of equilibrium regions.

Use one these options:

- **L** to list the calculated equilibria (all or a specified block)
- **S** to suspend everything (all blocks and their regions)
- **Q** to suspend each set of equilibria individually (specified blocks and/or regions)
- **R** to restore everything (all blocks and their regions)

<table>
<thead>
<tr>
<th>Syntax</th>
<th>AMEND_STORED_EQUILIBRIA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompts</td>
<td>Name: &lt;Name of a defined table&gt;</td>
</tr>
<tr>
<td></td>
<td>List (L) the calculated equilibria, suspend everything (S) or suspend each set of equilibria individually (Q), or restore everything (R).</td>
</tr>
<tr>
<td></td>
<td>Block <em>/</em>: &lt;Block number&gt;</td>
</tr>
<tr>
<td></td>
<td>Specify a block number in the option L, S, Q or R. Or include all the blocks in the amending option, by accepting the wildcard * (press &lt;Enter&gt;).</td>
</tr>
<tr>
<td></td>
<td>For L, a block (if a block number is specified) or all the blocks (if the wildcard * is accepted/used), with the regions and the equilibrium details, that are</td>
</tr>
<tr>
<td>Syntax</td>
<td>AMEND_STORED_EQUILIBRIA</td>
</tr>
<tr>
<td>--------</td>
<td>-------------------------</td>
</tr>
<tr>
<td></td>
<td>calculated during stepping or mapping is listed on screen or in a textual file. For ( Q ), each ranger in a block (if a block number is specified) or in all blocks (if the wildcard * is accepted/used) then choose:</td>
</tr>
<tr>
<td></td>
<td>( S(\text{suspend}) \ K(\text{keep}) /K/ : &lt;S \text{ or } K&gt; )</td>
</tr>
<tr>
<td></td>
<td>For ( S ) or ( R ), if a block is specified, you are asked what region in the block should be suspended or restored. However, if the wildcard * is accepted/used, you are asked the following:</td>
</tr>
<tr>
<td></td>
<td>Really suspend all /N/: &lt;Y or N&gt;</td>
</tr>
<tr>
<td></td>
<td>Really restore all /N/: &lt;Y or N&gt;</td>
</tr>
<tr>
<td></td>
<td>If the answer is ( N ), the program asks for which block(s) and which region(s) in a certain block to execute the ( S ) or ( R ) action.</td>
</tr>
<tr>
<td></td>
<td>Really suspend all /N/: &lt;Y or N&gt;</td>
</tr>
<tr>
<td></td>
<td>( Y ) suspends everything.</td>
</tr>
<tr>
<td></td>
<td>Really restore all /N/: &lt;Y or N&gt;</td>
</tr>
<tr>
<td></td>
<td>( Y ) restore everything.</td>
</tr>
<tr>
<td></td>
<td>Range: &lt;Range(s) of region&gt;</td>
</tr>
<tr>
<td></td>
<td>Specify one or more ranges to be suspended (the ( S ) option) or restored (the ( R ) option). The wildcard * suspends or restores all ranges in the specified block.</td>
</tr>
<tr>
<td></td>
<td>In order to know the ranges the \textbf{LIST} option must first be used.</td>
</tr>
<tr>
<td></td>
<td>( S(\text{suspend}) \ K(\text{keep}) /K/ : &lt;S \text{ or } K&gt; )</td>
</tr>
<tr>
<td></td>
<td>The Query suspend option (( Q )) asks for each region in a certain block if it should be suspended or kept. Suspended regions are not included on sequentially generated plots.</td>
</tr>
<tr>
<td></td>
<td>Output file: /Screen/: &lt;File name&gt;</td>
</tr>
<tr>
<td></td>
<td>This prompt is only for listing (the ( L ) option), and after it the command is terminated. The file name must be given here; or accept the default Screen (terminal) by pressing &lt;Enter&gt;. A list of stored equilibria as various blocks (with all their ranges) are shown out on screen or the file.</td>
</tr>
</tbody>
</table>
**CHANGE_STATUS**

In the POLY module, set the status for components, species and phases in the defined system for all the sequential calculations (single-point, stepping and mapping) in equilibrium or local/partial equilibrium state. Each component, species and phase has a status. The default status is **ENTERED**.

The most important use is to calculate metastable equilibria and metastable phase diagrams by setting some phases (that would otherwise be stable) to the SUSPENDED or DORMANT phase-status. Another important applications is to calculate paraequilibria by setting some components to the SPECIAL component-status.

For a component and for a species, the status can be one of the following:

- **ENTERED** - the component(s) or species are included in the calculation. This is the default status.
- **SUSPENDED** - the component(s) or species are not considered in the calculation.
- **SPECIAL** means - specified component(s) are not included in summations for mole or mass fractions. It only works for component(s).

Only component(s) can have the status SPECIAL, which implies that these are not included in summations for mole or mass fractions.

For example, for the *u-fractions* or other normalized fractions, when one or more of the components are excluded from the summation, you must specify which component(s) should be excluded from the calculation of mole or mass fraction. This component status is particularly useful when calculating paraequilibrium states. Such component(s) are normally interstitial component, and must have the status SPECIAL. This is assigned by the CHANGE_STATUS command.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>CHANGE_STATUS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompts</td>
<td>For phases, species or components? /Phases/: &lt;keyword&gt;</td>
</tr>
<tr>
<td></td>
<td><em>Keyword</em> = phase or species or components</td>
</tr>
<tr>
<td></td>
<td>Phase name(s): &lt;Name(s) of the phase(s)&gt;</td>
</tr>
<tr>
<td></td>
<td>For phase as the keyword, the names of the phases that have their status changed must be given (all on one line). A comma or space must be used as separator. The status to be assigned to the phases can also be given on the same line if preceded with an equal sign =.</td>
</tr>
<tr>
<td>Syntax</td>
<td>CHANGE_STATUS</td>
</tr>
<tr>
<td>--------</td>
<td>---------------</td>
</tr>
<tr>
<td>![Icon]</td>
<td>An asterisk, *, can be used to denote all phases. The special notations *S, i.e. a wildcard * directly followed by an S, sign, means all suspended phases. In the same way, *D means all dormant phases, and *E means all entered phases.</td>
</tr>
<tr>
<td>Name(s): &lt;Name(s) of the Species or Component(s)&gt;</td>
<td>For species or components as the keyword, the names of the species or components that have their status changed must be given (all on one line). A comma or space must be used as separator. Similarly to the case of phase as the keyword, the status to be assigned to the species or components can also be given on the same line if preceded with an equal sign =. An asterisk, *, can be used to denote all species or components. The special notations *S, i.e. a wildcard * directly followed by an S, sign, means all suspended species or components. In the same way, *E means all entered species or components.</td>
</tr>
<tr>
<td>Status /Entered/: &lt;New status&gt;</td>
<td>The new status to be assigned must be given. For species, the values ENTERED or SUSPENDED can be used. For components, the status ENTERED, SUSPENDED or SPECIAL can be given. SPECIAL means that this component is excluded from sums for mole fractions and mass fractions, which is useful when calculating the ufractions or other normalized fractions of system components. For phases, the status ENTERED, SUSPENDED, DORMANT or FIXED can be given. DORMANT means the same as suspended but the driving force is calculated. FIXED means that it is a condition that the phase is stable at a certain amount. For example, for the ufractions, when one or more of the components are excluded from the summation, you must specify which component should be excluded from the calculation of the mole fraction. This component must have the status SPECIAL. This is assigned by the CHANGE_STATUS command: \texttt{Change_Status \text{comp C}_special}.</td>
</tr>
<tr>
<td>Start value, number of moles /0/: &lt;Initial amount&gt;</td>
<td>For ENTERED phases, an initial amount of the phase can be given. Normally, 0 is given if the phase is not likely to be stable, and 0.5 or 1 or any positive number if the phase could be stable, but such an initial amount is only used as the rough starting estimation in the equilibrium calculations.</td>
</tr>
</tbody>
</table>
### Syntax

**CHANGE_STATUS**

Number of moles /0/: <Equilibrium amount>

For FIXED phases, the equilibrium amount of the phase [always using an initial estimation being the NPF(phase) value which it is the normalized mole number of components (per mole formula unit) of the specific status-fixed phase] must be given. If the equilibrium amount is zero, then the phase is at its stability limit.

Special attentions should be paid when specifying a FIXED phase status in equilibrium calculations (for single points, stepping or mapping calculations), as described below:

The phase amount variables, NP(phase), BP(phase) and VP(phase), as well as all their M/W/V-suffixed quantities, should not be used as conditions. Instead, use the CHANGE_STATUS command to set a relevant condition, e.g. CHANGE_STATUS phase <phase>=fix <amount> where the fixed <amount> is roughly the same as the F-suffixed quantity NPF(phase).

The NPF(phase) quantity is the normalized mole number of components (per mole formula unit) of the specific phase in the defined system, which unlike other F-suffixed state variables [e.g. GF(phase), HF(phase) and DGF(phase)] cannot be directly applied in any POLY command, implying that it cannot be directly evaluated or listed/shown. If intended to shown such a normalized phase amount value in an equilibrium state, you should use a properly-entered symbol (function or variable), for example: NPFabc = NP(abc)/NA or NPFabc = NPM(abc)/NA*N. N is the total system size (in mole). The NA value is a quantity that is phase-dependent (and sometimes also equilibrium-dependent for ionic solution phases), and is the total atomic number in a mole-formula-unit of the specific phase abc (excluding interstitial component and, of course, vacancy). For example, the SIGMA, FCC, BCC and LIQUID phases (among others) in a defined Fe-Cr-Ni-C-N-O system (retrieved from a specific database) may be modeled by certain models, and their NA values must be evaluated in different ways, as described below:

- LIQUID (C,Cr,CrO3/2,Fe,FeO,FeO3/2,N,Ni,NiO)1 NA = 1
- FCC_A1 (Cr,Fe,Ni)1(Va,C,N,0)1 NA = 1
- BCC_A2 (Cr,Fe,Ni)1(Va,C,N,0)3 NA = 1
- SIGMA (Fe,Ni)8(Cr,Fe,Ni)18 NA = 30

If in the same Fe-Cr-Ni-C-N-O system the liquid solution phase is modeled by the Two-Sublattice Ionic Liquid Model, i.e.:

- IONIC_LIQ (Cr+3,Fe+2,Ni+2)p(VA,C,N,O-2,FeO3/2)q,7
### Syntax

```
CHANGE_STATUS
```

then the evaluation of its NA value becomes even more complicated:

\[
NA = p + q^*yC2 + q^*yN2 + q^*yO2Fe2 + q^*yFeO2 \quad 3/2
\]

where the stoichiometric coefficients \( p \) and \( q \) are also dependent upon the real equilibrium state (rather than having fixed values in the system). Similar situations occur for other (solid) phases which are described by a multiple sublattice model with ionic constituents, such as SPINEL and HALITE phases in some databases.

There is no strange thing when using a zero value [i.e. 0] in a FIXED phase-status, since it means the specified phase is stable in equilibrium state but has a zero-amount of mass in the equilibrium calculations; in other words, on a phase diagram, the specific phase is on a zero-fraction line (ZFL), i.e. it starts becoming stable on one side of a corresponding phase-boundary line or unstable on the other side of the same boundary. It is often and efficient to do so when calculating e.g. solidus equilibrium states.

However, when a non-zero value [it must always be positive; e.g. 1 or 0.5 or 0.3 or 1.5] is to be specified in a FIXED phase-status, it is unnecessarily the exactly same stable amount of the specific FIXED-status phase in a calculated equilibrium state any longer; instead, the <equilibrium amount> value is the NPF(phase) value that is only roughly used as the estimated starting-value of the FIXED-status phase in the equilibrium calculations.

Therefore, a FIXED-status for a liquid phase being unity does not necessarily imply that it is a liquidus equilibrium state (where the liquid phase is in equilibrium with some solid phases but the liquid phase takes all the mass in the defined system). A unity value for setting the liquid phase status in calculating liquidus equilibrium state can only be used when the liquid mixture phase is predefined as a single-sublattice solution phase (such as metallic liquid phase in multicomponent alloy systems) and the total system size as one mole (i.e. N=1).

When a phase is described by a solution model in which two or more sublattices are considered and these sublattice sites may also have different stoichiometric coefficients [meaning that the mixture phase could have more than one atom in formula [NA>1; see some examples above], the unity value should not be used when setting the FIXED status for the phase; instead, you should use an appropriate value that ranges from 0 to a NPF(phase) value that equals to or is smaller than 1/NA (if the total system size N=1) or 1/NA*N (if N differs from unity). For this reason, if a multicomponent system bears an IONIC LIQUID phase that is described by the Two-Sublattice Ionic Liquid Model
Diffusion Module (DICTRA) Documentation

Set Equilibrium Calculations with the POLY_3 Module

### Syntax

<table>
<thead>
<tr>
<th>Syntax</th>
<th>CHANGE_STATUS</th>
</tr>
</thead>
<tbody>
<tr>
<td>(or any other multiple-sublattice ionic solution phases), it is difficult to use a proper NPF(ION LIQ) value in setting its FIXED phase-status, because that should be less than (or equal to) the complex value of $\frac{N}{p + q\gamma C^2 + q\gamma N^2 + q\gamma O^2 + q\gamma FeO^2}{2}$.</td>
<td></td>
</tr>
</tbody>
</table>

### Examples

For example, to obtain the metallic fraction in a system with carbon as an interstitial component, you can set the component status for carbon as SPECIAL:

```
Change_Status comp C=special
```

The SUSPENDED status for components and species does not always work as expected.

For a phase, it may have one of these statuses:

- **ENTERED** - the phase(s) are included in the equilibrium calculations and these are stable if that minimizes the total Gibbs energy in the defined system. This is the default status for all phases already retrieved from the chosen database(s). An ENTERED phase-status is always associated with an initially-estimated amount [in mole number; normally, as 0 if the phase is not likely to be stable, and as 0.5 or 1 or any positive number if the phase could be stable] but it is only used as the rough starting value in the equilibrium calculations.

- **SUSPENDED** - the phase(s) are not considered in the equilibrium calculations.

- **DORMANT** - the phase(s) are not considered in the equilibrium calculations but their driving forces for precipitation are calculated.

- **FIXED** - it is an equilibrium condition that the status-fixed phase must be stable, and be in equilibrium at a specified amount [always using an initial estimation being the NPF(phase) value which it is the normalized mole number of components (per mole formula unit) of the specific status-fixed phase]. See more descriptions at the end of this command.

### COMPUTE_EQUILIBRIUM

The full equilibrium state is calculated for the given set of conditions. The Global Minimization Technique is by default enforced in this command (C_E), while it can be disabled temporarily (for the current single-point equilibrium calculation) if using C_E – or
C_E * command-combination, or permanently (for all the sub sequential single-point calculations or stepping/mapping calculations within the current TCC run) if having decisively switched it off by a user (or possibly in some special modules) through changing the minimization option using the "ADVANCED_OPTIONS" on page 174 $\rightarrow$ MINIMIZATION_OPTION command-sequence.
**Syntax**

**COMPUTE_EQUILIBRIUM**

The C_E command can be used, in order to enforce the ordinary POLY minimization routines in an equilibrium calculation; this is because of that the ordinary C_E command is now associated with the Global Minimization Technique, and only after the Global Minimization

If technique is permanently switched off the C_E command makes no difference from the C_E – command-combination.

Only certain types of equilibrium conditions \([e.g. \text{T}, \text{P}, \text{N}, \text{N}<\text{component}>, \text{X}<\text{component}>, \text{B}, \text{B}<\text{component}>, \text{and W}<\text{component}>)\) are fully supported in the Global Minimization mode (called *Direct Global Minimization*); and when other types of equilibrium conditions are used, after the initial POLY, a Global Minimization test and corrections are performed until the lowest minimum is found (called *Indirect Global Minimization*).

If there is any problem with convergence, you may try the C_E * command-combination. The character * enforces the command to use an advanced technique to obtain a complex equilibrium. However, after a successful C_E * calculation, you may repeat the C_E command and can check the status of phases, species or components (with "LIST_STATUS" on page 210 \(\rightarrow\) CPS command-sequence) and equilibrium conditions (with "LIST_CONDITIONS" on page 209) and list out the calculation results (with "LIST_EQUILIBRIUM" on page 209), because such actions may tell you how to further modify various settings for your current calculation. This command-combination is not that useful anymore, because the Global Minimization Technique that is always associated with the C_E command is even more powerful and more precise in finding the most-stable equilibrium state in a complex heterogeneous interaction system; therefore, the C_E * command-combination is functional and can be used only after the Global Minimization mode has already been disabled temporarily or permanently.

Some phases that are not stable in the current equilibrium state may not have their most favorable composition after this command, and thus their driving forces may not be correct. You can force the program to correctly calculate the driving forces of metastable phases, by giving repeated C_E commands until the number of iterations (that is shown on screen after this command) is reduced to 2.

Also see the POLY command "SET NUMERICAL LIMITS" on page 296 which can set the approximate driving force for metastable phases option on or off in all the subsequent POLY calculations within the current TCC run.
The syntax is:

<table>
<thead>
<tr>
<th>Syntax</th>
<th>COMPUTE_EQUILIBRIUM</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>If an equilibrium state for the defined system is not found, an error message is given.</td>
</tr>
<tr>
<td></td>
<td>You can try repeating this command a few times, or change some of settings for the numerical limits, for starting variables and starting values, for starting constitutions of certain phases and for reference states of certain components, or to verify some of the defined conditions.</td>
</tr>
</tbody>
</table>

### COMPUTE_TRANSITION

This command is a combination of the CHANGE_STATUS, SET_CONDITION and COMPUTE_EQUILIBRIUM commands. It allows a direct calculation when a new phase may form by varying one of the already-set conditions. It can be used only after at least one equilibrium is calculated successfully; otherwise, you are informed on the necessity of first making an equilibrium calculation to find out the stable phases under the current conditions.

When this command is used, the program calls the command "CHANGE_STATUS" on page 100 to temporarily change the phase status of a specified phase as FIXED at the zero amount, and at the same time to temporarily release one of the existing equilibrium conditions (which is chosen by you). The program calculates a new equilibrium in which that specific phase is stable but its equilibrium amount in the system is zero. The released condition is then assigned with a calculated value that ensures the calculated equilibrium. After wards, the program automatically changes the phase status of that specific phase back to ENTERED, and resets the temporarily released condition as one of the conditions and assigns it with the value that is calculated to ensure the zero-amount formation of that specific phase.

This command is useful to find melting temperature, boiling temperature, or solubility limits, and generally when you want to set the most optimal conditions for calculating an equilibrium where a specific phase becomes stable. It can also be used when you want to know exactly how far away the defined conditions are from the value that can ensure a zero-amount of a specific phase in the system when other conditions remain the same.

After a successful COMPUTE_TRANSITION calculation, you can issue a "COMPUTE_EQUILIBRIUM" on page 190 calculation to assure the calculated transitional equilibrium is a really stable one, and can also use "LIST_EQUILIBRIUM" on page 209 to see the details of transitional equilibrium state.
<table>
<thead>
<tr>
<th>Syntax</th>
<th>COMPUTE_TRANSITION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phase to form: &lt;Phase name&gt;</td>
<td></td>
</tr>
<tr>
<td>A new phase name, e.g. BCC that is expected to form, is specified here. This changes the status of this new phase to be FIXED as 0 amount, and the program shows the information such as:</td>
<td></td>
</tr>
<tr>
<td>You must remove one of these conditions</td>
<td></td>
</tr>
<tr>
<td>P=100000, T=800, N=1, X(FE)=.5 \hspace{0.5cm} DEGREE OF FREEDOM 0</td>
<td></td>
</tr>
<tr>
<td>If the key word ANY is used when prompted for Phase to form (instead of a specific phase name), it is possible to find out any new phase to be formed, in a given varying direction sign and at an estimated change of the released condition: a negative sign means at a lower value of the released condition any new phase is to be found, and a positive sign at a higher value; an estimated change of the released condition implies where any new phase is expected (but it is only estimated value, so any value within its reasonable scale would be enough). Such calculations can be repeated if required. This feature is useful to find out all possible phase transformations along a certain released condition.</td>
<td></td>
</tr>
<tr>
<td>Give the state variable to be removed /T/: &lt;One condition&gt;</td>
<td></td>
</tr>
<tr>
<td>One condition must be removed, in order to calculate the transition equilibrium where the specified (or any) new phase to be formed at a calculated value of this released variable.</td>
<td></td>
</tr>
<tr>
<td>Therefore, the message may display (after a successful calculation) if, for example, X(Fe) is entered:</td>
<td></td>
</tr>
<tr>
<td>To form BCC the condition is set to X(Fe)=.48605791769</td>
<td></td>
</tr>
<tr>
<td>This calculated value is assigned as the parameter of that removed condition, in this case, the X(Fe) variable. If the LISTCONDITIONS command is typed this message displays:</td>
<td></td>
</tr>
<tr>
<td>P=100000, T=800, N=1, X(Fe)=4.86057918E-1 \hspace{0.5cm} DEGREES OF FREEDOM 0</td>
<td></td>
</tr>
<tr>
<td>If the key word ANY (instead of a specific phase) is given as the phase name when it is prompted for Phase to form, the line is prompted for a given varying direction sign and an estimated change of the released condition before the calculation of transition equilibrium:</td>
<td></td>
</tr>
<tr>
<td>Estimated change (with sign) /1/: +/-#</td>
<td></td>
</tr>
</tbody>
</table>
Syntax | COMPUTE_TRANSITION
--- | ---
| A given varying direction sign and an estimated change of the released condition, in this case as \( X(\text{FE}) \), must be given here: a negative sign means at a lower value of the released condition any new phase is to be found, and a positive sign at a higher value; an estimated change of the released condition implies where any new phase is expected (but it is only estimated value, so any value within its reasonable scale would be enough). For example, if a combination of -0.02 is input, this message may display (after a successful calculation):

To form BCC_A2#1 the condition is set to \( X(\text{FE})=4.93708756187 \)

This calculated value is then assigned as the parameter of that removed condition, in this case, the \( X(\text{FE}) \) variable. The message is shown if the LIST_CONDITIONS command is typed:

\[ P=100000, \quad T=800, \quad N=1, \quad X(\text{FE})=4.93708756E-1 \]

DEGREES OF FREEDOM 0

**CREATE_NEW_EQUILIBRIUM**

During data-assessments using the PARROT/ED_EXP modules, you can, in the POLY module, create several equilibria with different sets of conditions and phases (but normally with the same set of components). By default, there is one equilibrium. To keep the set of conditions and phase for this equilibrium, create another one using this command, and use another set of conditions for that. Two equilibria may be useful to calculate easily the enthalpy difference between two states. In the PARROT module, the experimental information is stored as a sequence of equilibria.

Syntax  | CREATE_NEW_EQUILIBRIUM
--- | ---
Prompts | Equilibrium number /2/: <A new equilibrium number>
| Each equilibrium in the POLY3 workspace is identified by a unique integer number. Such an equilibrium number can be recalled with "SELECT_EQUILIBRIUM" on page 216.

Initiation code /2/:

When an equilibrium is created, you can choose to ENTER all components and phases (initiation code 2), ENTER the components only (initiation code 1) or SUSPEND everything (initiation code 0). No other values are legal.
**DEFINE_COMPONENTS**

Change the set of components. By default, the elements are used as components. The set of components can be important because some conditions are set using components, for example, the amounts, activities or chemical potentials.

For example, in the system Fe-Si-O, you can define FEO, FE2O3 and SIO2 as components, thus replacing the default FE, SI and O.

This implies a command "REINITIATE_MODULE" on page 215 and it should be given as the first command in the POLY module.

**DEFINE_DIAGRAM**

This allows automatic calculation and plotting of a diagram with a single command. It is the same as the DEFINE_MATERIAL command up to when the first equilibrium is calculated. The alloy OPTION feature is also available in this command to specify alloying compositions for a special alloy predefined by the OPTION keyword in a selected database (e.g. the TCNI Ni-based Superalloys Database).

Use this command to calculate all types of phase diagrams after specifying all composition value and an initial temperature (if temperature is used as an axis). However, for binary and ternary diagrams, the special BIN and TERN modules may be preferred.
It then lists all the independent variables for the defined system (i.e. temperature and the components) and asks for a variable as the X-axis. You must also specify a maximum and minimum for the X-axis. The second axis (Y-axis) can be another composition (or the temperature if that is not on the X-axis) from the independent variable list. The program then calculates and plots a phase diagram, as there are two independent quantities on the axes.

Alternatively, select a dependent quantity as the Y-axis variable from the second list on screen (e.g. the amount of all phases, composition of a specific phase, or fractions of a component in all phases), and the program calculates and plots how this quantity depends on the condition on the X-axis. This is a property diagram.

This command ends up within the POST module monitor. You can refine the calculated phase diagram or property diagram.

Moreover, many more property diagrams with axes other than compositions can also be plotted (after the calculation), using "SET_AXIS_VARIABLE" on page 218 in the sequent POST monitor.
<table>
<thead>
<tr>
<th>Syntax</th>
<th>DEFINE_DIAGRAM</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Prompts</strong></td>
<td>These prompts are given:</td>
</tr>
<tr>
<td></td>
<td>Same elements as before /Y/?  &lt;Y or N&gt;</td>
</tr>
<tr>
<td></td>
<td>Mole percent of &lt;Element&gt; /##/: &lt;Value&gt;</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>Mass percent of &lt;Element&gt; /##/: &lt;Value&gt;</td>
</tr>
<tr>
<td></td>
<td>Database /ABCDE/: &lt;Database name&gt;</td>
</tr>
<tr>
<td></td>
<td>Major element or alloy: &lt;Element name&gt;</td>
</tr>
<tr>
<td></td>
<td>Composition in mass (weight) percent? /Y/: &lt;Y or N&gt;</td>
</tr>
<tr>
<td></td>
<td>1st alloying element: &lt;Element name&gt;</td>
</tr>
<tr>
<td></td>
<td>Mass (weight) percent: &lt;Amount of the above specified element&gt;</td>
</tr>
<tr>
<td></td>
<td>2nd alloying element: &lt;Element name&gt;</td>
</tr>
<tr>
<td></td>
<td>Next alloying element: &lt;Element name&gt;</td>
</tr>
<tr>
<td></td>
<td>Mass (weight) percent: &lt;Amount of the above specified element&gt;</td>
</tr>
<tr>
<td></td>
<td>Temperature (c) /1000/: &lt;Temperature of interest in oc&gt;</td>
</tr>
<tr>
<td></td>
<td>Reject phase(s) /none/: &lt;List of phase(s) to be rejected&gt;</td>
</tr>
<tr>
<td></td>
<td>Restore phase(s) /none/: &lt;List of phase(s) to be restored&gt;</td>
</tr>
<tr>
<td></td>
<td>OK? /Y/: &lt;Y or N&gt;</td>
</tr>
<tr>
<td></td>
<td>Should any phase have a miscibility gap check? /N/: &lt;Y or N&gt;</td>
</tr>
<tr>
<td></td>
<td>Phase with miscibility gap: &lt;phase name&gt;</td>
</tr>
<tr>
<td></td>
<td>Major constituent(s) for sublattice #: /aa/: &lt;Constituent(s)&gt;</td>
</tr>
<tr>
<td></td>
<td>Phase with miscibility gap: &lt;Phase name&gt;</td>
</tr>
</tbody>
</table>

The first equilibrium is calculated, as with "DEFINE_MATERIAL" on page 200. Then a list of all independent conditions suitable to be chosen as X/Y-axis variables is given by the program.

<table>
<thead>
<tr>
<th>Prompt</th>
<th>Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quit? /y/:</td>
<td>&lt;y or n&gt;</td>
</tr>
</tbody>
</table>

This question is asked only when the axis variables are already defined, or if the command DEFINE_DIAGRAM is used. It then offers an opportunity to quit (Y) the calculation or to continue (N) the calculation but by defining other axes.

Give the number of the condition to vary /1/: <a condition index>
<table>
<thead>
<tr>
<th>Syntax</th>
<th>DEFINE_DIAGRAM</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Select one of the independent conditions by giving its index on the condition</td>
</tr>
<tr>
<td></td>
<td>list as the X-axis variable.</td>
</tr>
<tr>
<td></td>
<td>Minimum value /XXX/: &lt;minimum value for X-axis&gt;</td>
</tr>
<tr>
<td></td>
<td>Specify the minimum value of the chosen X-axis variable. A default value is</td>
</tr>
<tr>
<td></td>
<td>shown automatically by the program; press &lt;Enter&gt; to accept it or input</td>
</tr>
<tr>
<td></td>
<td>another value.</td>
</tr>
<tr>
<td></td>
<td>Maximum value /YYY/: &lt;maximum value for X-axis&gt;</td>
</tr>
<tr>
<td></td>
<td>Specify the maximum value of the chosen X-axis variable. A default value is</td>
</tr>
<tr>
<td></td>
<td>shown automatically by the program; press &lt;Enter&gt; to accept it or input</td>
</tr>
<tr>
<td></td>
<td>another value. Then another list with some dependent quantities is given by</td>
</tr>
<tr>
<td></td>
<td>the program, which can be selected as the Y-axis variable.</td>
</tr>
<tr>
<td></td>
<td>Give the number of the quantity on the second axis /#: &lt;##&gt;</td>
</tr>
<tr>
<td></td>
<td>Select one of the independent conditions or dependent quantities as the Y-axis</td>
</tr>
<tr>
<td></td>
<td>variable, by giving its corresponding index given on the condition lists.</td>
</tr>
<tr>
<td></td>
<td>🚓 It must be different from the X-axis variable already selected.</td>
</tr>
<tr>
<td></td>
<td>If selecting one of dependent quantities (by giving the corresponding number</td>
</tr>
<tr>
<td></td>
<td>from the second list) as the Y-axis, then a property diagram is to be</td>
</tr>
<tr>
<td></td>
<td>automatically calculated (through a normal stepping procedure) and generated.</td>
</tr>
<tr>
<td></td>
<td>For composition of a phase the phase name is asked for further specification</td>
</tr>
<tr>
<td></td>
<td>subsequently.</td>
</tr>
<tr>
<td></td>
<td>If selecting any of the other independent variables (conditions) on the first</td>
</tr>
<tr>
<td></td>
<td>list as the Y-axis, then a phase diagram is automatically calculated (through</td>
</tr>
<tr>
<td></td>
<td>a mapping procedure) and plotted.</td>
</tr>
<tr>
<td></td>
<td>Name of phase: /ABC/: &lt;phase name&gt;</td>
</tr>
<tr>
<td></td>
<td>This is prompted only in case of that the composition of a phase is selected</td>
</tr>
<tr>
<td></td>
<td>as the Y-axis variable. The phase name for which the composition varied along</td>
</tr>
<tr>
<td></td>
<td>with X-axis variable should be specified.</td>
</tr>
<tr>
<td></td>
<td>Multiple start points? /Y/: &lt;Y or N&gt;</td>
</tr>
<tr>
<td></td>
<td>This question is to confirm whether or not to let the program to automatically</td>
</tr>
<tr>
<td></td>
<td>generate and use multiple start points for mapping the defined phase.</td>
</tr>
</tbody>
</table>
**DEFINE_MODULE**

**DEFINE_DIAGRAM**

diagram.

Save file /RESULT/: <file name>

The file name where the calculations are stored (saved as a *.POLY3 file) should be specified; the default file name is RESULT.POLY3 (Windows) or RESULT.POLY3 (Linux).

**DEFINE_MATERIAL**

Read data for a system from a database in the POLY module. It is convenient to use for alloys when there is a major component and the amount of the other elements is known in mass (weight) fraction. The command reads the system from the specified database, sets the composition and temperature (and pressure equal to 1 bar) and calculates the equilibrium state before the prompting for a new command. You can list the results with "LIST_EQUILIBRIUM" on page 209 or set a new composition or set axis for a STEP or MAP command.

You cannot append data from different databases in this way. Use this command with data from a USER database.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>DEFINE_MATERIAL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompts</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Same elements as before /Y/? &lt;Y or N&gt;</td>
</tr>
<tr>
<td></td>
<td>This question is asked only if some data is already read from the database, or if the command DEFINE_MATERIAL or DEFINE_DIAGRAM is used. It then offers a convenient way to change the composition and temperature with one command.</td>
</tr>
<tr>
<td></td>
<td>This command only works properly in cases where the composition of the material system is already defined as in the mole-percent or mass-percent unit.</td>
</tr>
<tr>
<td></td>
<td>Mole percent of &lt;Element&gt; /##/: &lt;Value&gt;</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>Mass percent of &lt;Element&gt; /##/: &lt;Value&gt;</td>
</tr>
<tr>
<td></td>
<td>If you have decided to use the same materials system (available in the current POLY3 workspace) by accepting the default answer (Y) to the previous prompt Same elements as before /Y/?, one of the alternative prompts display for each of the components in the defined system, depending on how the composition is defined (either in mole-percent, or in mass-percent).</td>
</tr>
</tbody>
</table>
### Syntax

<table>
<thead>
<tr>
<th><strong>DEFINE_MATERIAL</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Prompts are repeated until all the defined components are completed. Then, the program prompts to specify the temperature condition.</strong></td>
</tr>
</tbody>
</table>

**Database /ABCDE/: <Database name>**

The database with the description for the material must be given, or press <Enter> if using the current database. It is possible to give a USER database.

**Major element or alloy: <Element name>**

The material must have a major element, usually the element which is present in the largest amount. The fraction of this element is not set but is the rest.

In some databases there are the alloys predefined. An alloy has a default major element and have limits of the amounts of the alloying elements. If you stay within these limits the calculation gives reasonable results.

**Composition in mass (weight) percent? /Y/: <Y or N>**

The default is that input is taken as mass percent, but it is possible to change to mole percent by answering N.

- **Composition should be given in PERCENT not FRACTION, as it is required for the W and X state variables in the "SET_CONDITION" on page 220 command.**

**1st alloying element: <Element name>**

The first alloying element must be given.

All alloying elements are asked for in a sequence. These can be given in any order. You must know if you are present as assessed systems in the database. There is no error or warning messages if data are missing. Check the documentation of the database selected.

If an alloy is selected, a list of legal alloying elements and their maximum percent is listed on-line.

**Mass (weight) percent: <Amount of the above specified element>**

The amount of the alloying element in mass (weight) percent. Using the DEFINE_MATERIAL command you cannot use the normal flexibility of Thermo-Calc for conditions, but all must be given in mass percent. However, you can after wards change the conditions using the SET_CONDITION command.
<table>
<thead>
<tr>
<th>Syntax</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>DEFINE_MATERIAL</strong></td>
<td></td>
</tr>
<tr>
<td>2nd alloying element: &lt;Element name&gt;</td>
<td>The second alloying element must be given. If only one, press &lt;Enter&gt;. If an element name is given then the program asks for its mass fraction.</td>
</tr>
<tr>
<td>Mass (weight) percent: &lt;Amount of the above specified element&gt;</td>
<td>The amount of the above specified alloying element in mass (weight) percent.</td>
</tr>
<tr>
<td>Next alloying element: &lt;Element name&gt;</td>
<td>Continue giving elements and mass (weight) fractions until all elements specified. When all alloying elements and their compositions (as in the above prompt) are specified, press &lt;Enter&gt; as answer to this question to finish the materials definition.</td>
</tr>
<tr>
<td>Temperature (C) /1000/: &lt;Temperature of interest in oC&gt;</td>
<td>POLY makes the first calculation after retrieving the data for this temperature. By pressing &lt;Enter&gt; to accept the default temperature. The value should be given in Celsius (oC). The pressure is set to 1 bar.</td>
</tr>
<tr>
<td>Reject phase(s) /None/: &lt;List of phase(s) to be rejected&gt;</td>
<td>This is a question generated by the database allowing you to select the phases. Normally, all phases should be included when you press &lt;Enter&gt;. If a phase is to be rejected, the name of the phase must be supplied. Several phase names can be specified in one line. It is possible to reject all phase by giving an asterisk *. If the number of phases to be included is much smaller than the total number of phases, it may be convenient to first reject all phases and then restore those that should be included. The question is repeated until you press &lt;Enter&gt; after rejecting all unwanted phases or an asterisk *.</td>
</tr>
<tr>
<td>Restore phase(s) /None/: &lt;List of phase(s) to be restored&gt;</td>
<td>You can restore phases that are accidentally or deliberately rejected. It may also be possible to restore some hidden phases. If phases are to be restored the name of the phases must be supplied. Several phase names can be specified in one line. It is possible to restore all phase by giving an asterisk *. The question is repeated until you press &lt;Enter&gt; after restoring all desired phases.</td>
</tr>
<tr>
<td>OK? /Y/: &lt;Y or N&gt;</td>
<td></td>
</tr>
</tbody>
</table>
### Syntax

<table>
<thead>
<tr>
<th>Syntax</th>
<th>DEFINE_MATERIAL</th>
</tr>
</thead>
<tbody>
<tr>
<td>All phases to be selected from the database are listed and the selection confirmed. If there are any errors or you want to amend the selection, answer N and you are returned to the question about rejecting phase(s). If the selection is confirmed by answering Y the software retrieves all thermodynamic data and available references from the chosen database.</td>
<td></td>
</tr>
<tr>
<td>Should any phase have a miscibility gap check? /N/: &lt;Y or N&gt;</td>
<td></td>
</tr>
<tr>
<td>The database usually creates two or more composition sets for phases that can have miscibility gaps. However, for some phases this is not done automatically, for example the miscibility gap in the bcc phase in Fe-Cr is usually ignored. But if it is important to include a Cr-rich bcc phase, specify this here. It costs some computation time and may make the subsequent MAP or STEP more difficult to converge.</td>
<td></td>
</tr>
<tr>
<td>If you do not want to have any phase with a miscibility gap in the calculation, press &lt;Enter&gt;. Then, the DEFINE_MATERIAL command starts calculating the equilibrium, and is terminated.</td>
<td></td>
</tr>
<tr>
<td>To set such a phase with miscibility gaps in the calculation, answer Y. Then the software asks questions about the phase names and their constitutions, such as:</td>
<td></td>
</tr>
<tr>
<td>Phase with miscibility gap: &lt;Phase name&gt;</td>
<td></td>
</tr>
<tr>
<td>You must supply the phase name, which has a miscibility gap under the specified system and conditions.</td>
<td></td>
</tr>
<tr>
<td>Major constituent(s) for sublattice #: /AA/: &lt;Constituent(s)&gt;</td>
<td></td>
</tr>
<tr>
<td>The software shows a default constituent in the sublattice #(1,2,3,...), according to the existing phase definition in the chosen database. You can specify one or more major constituents for the sublattice # in the phase.</td>
<td></td>
</tr>
<tr>
<td>This question is repeated until all sublattices are specified.</td>
<td></td>
</tr>
<tr>
<td>Phase with miscibility gap: &lt;Phase name&gt;</td>
<td></td>
</tr>
<tr>
<td>You can supply another phase name with a miscibility gap under the specified system and conditions, and answer the questions concerning the major constituent(s) in associated sublattice(s).</td>
<td></td>
</tr>
<tr>
<td>By pressing &lt;Enter&gt;, the command starts calculating the equilibrium, and then terminates.</td>
<td></td>
</tr>
</tbody>
</table>
DEFINE_MATERIAL

It is also possible to use this command to select an alloy from a specific database (e.g. the TCNI Ni-based Superalloys Database). Such alloys are predefined by the OPTION keyword inside the database, and have their default major elements and composition limits of their alloy elements.

Such alloys available in the selected database (at the prompt Database /ABCDE/ can be listed on the screen if typing a ? mark on the prompt Major element or alloy. When a specific predefined alloy (instead of a major element) is selected, the major element is staked from the alloy definition and shown on the screen (with a message like Alloy found with major element NI).

You can only specify alloying elements and the compositions (weight percent or mole percent). Typing a ? at any of the prompts for the alloying element names, e.g. 1st alloying element, 2nd alloying element, lists all the alloying elements and the composition limits in the alloy. If the composition of an alloying element is outside of its limit, there is a message (such as Amount above limit: 30.0000) and a prompt Override limit ? /N/. If you decide to enforce the override by answering Y on this prompt (i.e. accepting the over-limit alloying composition), another warning message (such as Amount of major element below limit: 70.0000) and prompt Override limit ? /N/. Then further decide if enforcing the overriding: if Y then accepting the major element’s composition below the limit; if N then using the predefined major element composition limit.

DELETE_INITIAL_EQUILIBRIUM

Delete ONE specific initial equilibrium point or ALL of the initial equilibria. The initial equilibria are used as starting points for all the sub-sequential MAP and STEP calculations.

Also see "ADD_INITIAL_EQUILIBRIUM" on page 166.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>DELETE_INITIAL_EQUILIBRIUM</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Number /All/: &lt;Number of an initial equilibrium&gt;</td>
</tr>
</tbody>
</table>

Specify the number of an initial equilibrium (as a specific digit e.g. 3, or ALL) to be deleted from the POLY3 workspaces. It is recommended to use "LIST_INITIAL_EQUILIBRIA" on page 210 to figure out the numbers for all the existing initial equilibrium points that have already been added (manually through "ADD_INITIAL_EQUILIBRIUM" on page 166, or automatically by some other
DELETE_INITIAL_EQUILIBRIUM

POLY commands) and stored in the current POLY3 workspace. By default, ALL the initial equilibrium points are deleted.

DELETE_SYMBOL

This is a POLY3 module command.

Delete symbols (i.e. constants, variables, functions or tables. These symbols are entered with "ENTER_SYMBOL" on page 113.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>DELETE_SYMBOL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Name: &lt;Name of a symbol&gt;</td>
</tr>
<tr>
<td></td>
<td>Specify the name of the symbol to be deleted. Only one symbol can be deleted each time.</td>
</tr>
</tbody>
</table>

ENTER_SYMBOL

This command is for both the POST and POLY modules in Console Mode.

Symbols are a useful feature of the POLY and POST modules to define quantities that are convenient. Symbols can be constants, variables, functions or tables.

Functions or tables (with defined functions as values) can be entered in the POST module after a stepping or mapping calculation, for purposes of plotting such entered functions or tables as axis variables.

Within the POLY module, symbols are normally defined prior to an equilibrium calculation (enforced by a C_E command), stepping calculation (enforced by the command "STEP_WITH_OPTIONS" on page 227) or mapping calculation (enforced by "MAP" on page 212). These can be entered after an equilibrium calculation; however, for defined functions, variable or tables, it requires using "EVALUATE_FUNCTIONS" on page 208 before showing the corresponding values in the calculated equilibrium state.

The symbols entered in the POST module are not saved in the currently-loaded POLY3 workspaces. Therefore, if you want to apply such symbols in other similar calculations for the same defined system, you must use the ENTER_SYMBOL command prior to the STEPPING or MAPPING calculation in the POLY module.

Also see "ENTER_SYMBOL" on page 113 for the GIBBS Module.
See example 44 in the *Thermo-Calc Console Mode Examples Guide* for an example of using variables and functions.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>ENTER_SYMBOL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Constant, Variable, Function or Table? /Function/: &lt;keyword&gt;</td>
<td></td>
</tr>
<tr>
<td>The <strong>Keyword</strong> can be specified as <strong>CONSTANT, VARIABLE, FUNCTION</strong> or <strong>TABLE</strong>.</td>
<td></td>
</tr>
<tr>
<td>- <strong>CONSTANTS</strong> can only be entered once and is a means of using a name for a numeric value. For example, the value of 1 atmosphere in Pascal can be denoted by ( P_0 ) after the command ENTER CONSTANT ( P_0=101325 ). Defined constants can be used as values in condition assignments, for example, SET-COND ( P=P_0 ).</td>
<td></td>
</tr>
<tr>
<td>- <strong>FUNCTIONS</strong> are expressions of state variables or other functions. These expressions are saved, and whenever a function value is requested all functions are evaluated. The reason for this is that they may depend on each other.</td>
<td></td>
</tr>
<tr>
<td>- <strong>VARIABLES</strong> are similar to functions because they can also be expressions of state variables. However, contrary to functions, they are only evaluated when they are entered or if they are explicitly named in an &quot;<strong>EVALUATE_FUNCTIONS</strong>&quot; on page 208 command. It is possible to enter a variable with a new expression any time. This expression is evaluated directly and its value stored as the value of the variable. Defined variables can be used as values in the SET-CONDITION command.</td>
<td></td>
</tr>
<tr>
<td>- <strong>TABLES</strong> are used for listing results from the STEP or MAP commands. A table consists of a list of any number of state variables, functions or variables. Defined tables can also be used in the post-processor POST.</td>
<td></td>
</tr>
</tbody>
</table>

There is a special connection between tables and variables. If a variable is used in a table, it is evaluated for each line of the table in the TABULATE command or when the table is used in a plot.

Name: <Name of the symbol>

Each symbol has a unique name that must start with a letter and can have maximum 8 characters.

Legal characters include letters (either UPPER or lower case), digits and underscore \(_\). Any other special character, such as parentheses ( and ), plus +, minus -, slash / or \( \), full stop (.), are illegal for symbol names.

You can enter the symbol name and the value or function on the same line,
**Syntax** | **ENTER_SYMBOL**
---|---
these must be separated with an equal sign =, for example, \( T_C = T - 273.15 \) or \( T_{C = 273.15} \) which stands for a definition of temperature in Celsius. Otherwise, these questions are asked.

For different types of symbol (constant, function, variable or table), the questions have different prompts.

**Function:** <Definition for a function or variable>

*Functions and variables* are evaluated from an expression of state variables or other functions, constants or variables. The expression is a FORTRAN-like expression and operators +, -, *, = and ** can be used (** only with integer powers).

Unary functions like \( \text{LOG}, \text{LOG10}, \text{EXP}, \text{SIN}, \text{COS} \) and \( \text{ERF} \) can also be used. An expression can be continued on more than one line. An expression should be terminated by a semicolon (;) or an empty line (by pressing <Enter> at the next prompt).

**Examples of function expressions:**

- \( \text{GM( LIQUID) } \): The Gibbs energy of liquid per mole component
- \( H.T/4.184 \): The heat capacity of the system in calories
- \( ACR(CR)/X(FCC,CR) \): The activity coefficient for Cr in FCC
- \( T-273.15 \): The temperature in Celsius

&: <Continuation of the definition for the symbol>

The ampersand & means that you can continue to write the function on the new line if one line is not enough for the function. If you finish the function press <Enter> again.

**Value:** <Value for a constant>

A *constant* can only be assigned a numeric value once.

**Value or expression:** <Value of expression for a variable>

A *variable* can be assigned a numeric value or an expression. An expression is evaluated immediately and discarded. Only the numeric value is kept. This gives a possibility to save a value between calculations with different conditions because all state variables and functions are evaluated for the new conditions.
**Syntax**

<table>
<thead>
<tr>
<th><strong>Syntax</strong></th>
<th><strong>ENTER_SYMBOL</strong></th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Variable(s):</th>
<th>&lt;Variable(s) in a table&gt;</th>
</tr>
</thead>
</table>

A *table* consists of a list of state variables or functions. One way to obtain results from a STEP command is through a table.

Example:

```
ENTER TABLE K=T,X(LIQ,C),X(LIQ,CR),ACR(C)
```

Which means that the table called *K* contains four columns, i.e. the temperature, the mole fractions of *C* and *Cr* in the LIQUID phase, and the activity of *C*.

To show the temperature in Celsius in a table, give the command ENTER FUNCTION TC=T-273; and then use the symbol TC in the table.

& <Continuation of the definition for the table>

The ampersand & means that you can continue to write the table on the new line if one line is not enough for the table. If you finish the table press <Enter> again.

---

**EVALUATE_FUNCTIONS**

The value of one or more or all entered functions or variables are evaluated and listed.

<table>
<thead>
<tr>
<th><strong>Syntax</strong></th>
<th><strong>EVALUATE_FUNCTIONS</strong></th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Name(s):</th>
<th>&lt;Name(s) of defined function(s)&gt;</th>
</tr>
</thead>
</table>

Prompt

The names of one or more entered functions or variables must be specified. By typing a wildcard *, all functions and variables are evaluated.

- Variables are evaluated only if these are explicitly named.

---

**LIST_AXIS_VARIABLE**

This is a POLY3 module command.

<table>
<thead>
<tr>
<th><strong>Syntax</strong></th>
<th><strong>LIST_AXIS_VARIABLE</strong></th>
</tr>
</thead>
</table>

Lists all the axis variables for a stepping or mapping calculation that have already been set by *"SET_AXIS_VARIABLE" on page 218*. 

---

Equilibrium Calculations with the POLY_3 Module | 208 of 370
**LIST_CONDITIONS**

This is a POLY3 module command.

All the conditions that are set by the command SET_CONDITION and the command-sequence CHANGE_STATUS PHASE = FIXED <0 or 1 or alike>, are listed. The current conditions are also listed by the command LIST_EQUILIBRIUM. The degree of freedom in the defined system is also shown up. If this is zero, you can perform a COMPUTE_EQUILIBRIUM command. If it is larger than zero, some more conditions are required, and you must further set additional ones, using "SET_CONDITION" on page 220 or "CHANGE_STATUS" on page 186. If it is negative, a user has defined too many conditions and needs to take away the unnecessary ones, using the SET_CONDITION command (with a value of NONE for the to-be-deleted condition) or CHANGE_STATUS command (i.e. changing a FIXED status of a phase to another type of phase status, ENTERED or DORMANT or SUSPENDED).

<table>
<thead>
<tr>
<th>Syntax</th>
<th>LIST_CONDITIONS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example</td>
<td>P=100000, T=800, N(NI)=1E-1, N=1</td>
</tr>
<tr>
<td></td>
<td>FIXED PHASES</td>
</tr>
<tr>
<td></td>
<td>FCC_A1=1 LIQUID=0  DEGREE OF FREEDOM 0</td>
</tr>
</tbody>
</table>

**LIST_EQUILIBRIUM**

This is a POLY3 module command.

The result (always in SI units) from the last calculated equilibrium is listed on screen or in a textual file.

You can also execute this command if no calculation is made or if the calculation fails. It is your responsibility to interpret the results accordingly.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>LIST_EQUILIBRIUM</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Output to screen or file /Screen/: &lt;File name&gt;</td>
</tr>
<tr>
<td></td>
<td>The name of the text file where the list of the calculation results shall be written.</td>
</tr>
<tr>
<td></td>
<td>Options /VWCS/: &lt;Option(s)&gt;</td>
</tr>
<tr>
<td></td>
<td>Select the output units and formats by optionally specifying a combination of these letters.</td>
</tr>
</tbody>
</table>
Syntax | LIST_EQUILIBRIUM
--- | ---

- **Fraction order:** V means VALUE ORDER; A means ALPHABETICAL ORDER.
- **Fraction type:** W means MASS FRACTION; X means MOLE FRACTION.
- **Composition:** C means only COMPOSITION; N means CONSTITUTION and COMPOSITION.
- **Phase:** S means including only STABLE PHASES; P means including ALL NON-SUSPENDED PHASES.

Default options are VWCS. If the output fraction type should be in mole fraction (rather than mass fraction), then give VXCS or type X (implying that in this case the options V, C and S are accepted as the listing manners for fraction order, composition and phase).

If accepting all the default options, or if accepting all the altered options that had already changed when using this command previously, you can type L_, E,, or LIST_EQUILIBRIUM ,,,

LIST_EQUILIBRIUM displays ORD (ordered) or DISORD (disordered) (when available). See "CHANGE_LEGEND" on page 246 for details.

**LIST_INITIAL_EQUILIBRIA**

This is a POLY3 module command.

List all the equilibria added with "ADD_INITIAL_EQUILIBRIUM" on page 166.

Syntax | LIST_INITIAL_EQUILIBRIA
--- | ---

All the initial equilibria are used for the MAP (and STEP) calculations.

**LIST_STATUS**

This command is for the POLY and ED-EXP modules.

List the status of components, species or phases.
Syntax | LIST_STATUS
--- | ---

**Prompt**

Specify what to list:

Option /CPS/: `<keyword(s)>`

keyword = C or P or S, or any combination

- C means list component status
- P means list phase status
- S means list species status
- CS for both components and species

Default is CPS.

The results depend on the key word specified in the options for "CHANGE_STATUS" on page 100, a table with the current status of phases or species or components, or the combinations, is shown:

- For components, the statuses and reference states are listed.
- For species, only the status is listed.
- For ENTERED and FIXED phases, the status, driving forces and equilibrium amounts are listed.

The metastable phases are listed in descending order of stability. To avoid long outputs only 10 metastable phases (in ENTERED status) are listed by lines, while all other less stable phases are merged onto one line. For DORMANT phases, their phase names and driving forces are listed. For SUSPENDED phases, only the phase names are listed.

**LIST_SYMBOLS**

For both the POLY and POST modules, list the definitions for all constants, functions, variables and tables.

In order to find the value of a function or variable, use "SHOW_VALUE" on page 227 or "EVALUATE_FUNCTIONS" on page 208. A table is tabulated with the TABULATE command.

Syntax | LIST_SYMBOLS
--- | ---

The defined variables are listed up together with the defined functions, but variable names are followed by a percentage sign %.
LOAD_INITIAL_EQUILIBRIUM

Copies all conditions and calculated results from a specific added initial equilibrium to the current equilibrium. The current conditions and calculation results are lost, and the newly loaded initial equilibrium point gets into the POLY workspace.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>LOAD_INITIAL_EQUILIBRIUM</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Number: &lt;Number of an initial equilibrium&gt;</td>
</tr>
<tr>
<td></td>
<td>Specify the number of an initial equilibrium to be loaded as current. The number can be found with &quot;$LIST_INITIAL_EQUILIBRIA&quot; on page 210.</td>
</tr>
</tbody>
</table>

MAP

This command starts the mapping procedure for making a calculation of phase diagrams in a defined multicomponent heterogeneous system, from one or more initial equilibria. A phase diagram is usually mapped within a specific space that is constructed by two (or more) defined independent mapping axis-variables.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>MAP</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>A phase diagram consists of mapped phase boundary lines/curves; on one side of each such phase-boundary line/curve, the amount of one specific stable phase is zero (i.e. the zero-fraction lines). From a single MAP calculation, many different types of phase diagrams in the defined multicomponent heterogeneous system can be plotted, with some desired properties (that vary along the calculated phase-region boundaries) plotted as X/Y-axis variables. All different types of phase diagrams are generated by the mapping calculations through this command.</td>
</tr>
</tbody>
</table>

Normally, you need to have calculated at least one initial equilibrium point and have also defined at least two independent varying variables (i.e. the controlling conditions in the system) that are set with "$SET_AXIS_VARIABLE" on page 218. You can also have three, or four or maximum five independent varying variables that are defined by the SET_AXIS_VARIABLE command).

This lists the current values of each of the independent axis variables for each of the calculated equilibrium points along each of the mapped phase boundaries, and also lists the corresponding information when the set of stable phases changes.
The Global Minimization Technique is by default enforced in this command while it can be disabled if having decisively switched it off (or possibly in some special modules) through changing the minimization option using the "ADVANCED_OPTIONS" on page 174 → MINIMIZATION_OPTION command-sequence. You can choose how often to do a Global Minimization test (via the Global Test Interval option) in the ADVANCED_OPTIONS STEP_ AND_MAP command-sequence.

During a MAP calculation, the values of mapped axis-variables for presenting each phase boundary (lines/points) of the calculated phase-regions are listed, and the corresponding stable-phase sets are shown up. You can terminate the mapping of a line by pressing a single <Ctrl-A> (Windows) or <Ctrl-C> (Linux). This can be useful in order to stop a longish calculation without losing what is already calculated.

If there is any convergence problem in finding a stable solution at a certain stage during a calculation procedure enforced by this command, these messages display on screen:

Convergence problems, increasing smallest site-fraction from 1.00E-30 to hardware precision 2.00E-14. You can restore using SET-NUMERICAL-LIMITS

This implies that smallest site fraction in the current POLY3 workspace is automatically increased from the default value 1.00E-30 to the hardware-dependent precision (under Linux, as 2.00E-14). For other subsequent POLY-module calculation in the current TC run, you can use the POLY command "SET_Numerical_limits" on page 296 to restore or reset the smallest site fraction to the previous or another preferred value, as well as to reset other numerical limits.

In particular, for phase diagrams with tie-lines in the plane (i.e. most binary systems and ternary isotherms), there is a MAP procedure which checks for the best phase to use as axis variables in order to ensure reasonable increments between the tie-lines. This produces smoother curves and also gives a better stability in finding adjacent phase-regions.

Complex miscibility gaps of various solution phases are automatically detected during a mapping calculation, and two or more composition sets for each of such solution phases are automatically generated as well, through an automatic Global Minimization Test procedure (by specifying a Global Test Interval value and confirming the Automatically add initial equilibria in the ADVANCED_OPTION STEP_AND_MAP command-sequence). As a particular case, such an automatic Global Minimization Test ensures that you can start calculating from high temperatures in an austenitic steel (metallic FCC_A1 solution phase) where the MC carbides/nitrides/carbonitrides (i.e. the C-/N-rich sides of the FCC_A1 miscibility-gap, often (while not always) being referred to as FCC_A1#2, FCC_A1#3, etc.) are not stable, and during the MAP command the MC carbides/nitrides/carbonitrides may first become metastable with a composition different from the metallic FCC_A1 phase and later also stable. The advanced mapping procedure (enforced by the Global Minimization Technique) inside the Thermo-Calc software (both the Console Mode and Graphical Mode) can efficiently and effectively handle complex miscibility gaps in multicomponent heterogeneous systems.
To get a complete phase diagram, sometimes it may be necessary to have multiple starting equilibrium-points, and/or to have added multiple initial-equilibrium points (through "ADD INITIAL EQUILIBRIUM" on page 166) inside various phase-region boundaries under certain direction(s).

### POST

<table>
<thead>
<tr>
<th>Syntax</th>
<th>POST</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switches to the post-processor (the POST module), which has its own command set.</td>
<td></td>
</tr>
</tbody>
</table>

See "Plotting and Visualization with the POST Module " on page 240 for all details.

### READ_WORKSPACES

This command is used in both the POLY and GES (GIBBS) modules.

The POLY3 and GIBBS workspaces and the calculated results from the MAP and STEP commands can be READ from a file where they are saved with "SAVE_WORKSPACES " on page 54. Such an *.POLY3 file is not printable.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>READ_WORKSPACES</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Options</strong></td>
<td><strong>File name</strong> is the name of a saved POLY3-file where the POLY3 and GIBBS workspaces shall be read from must be specified. You do not need to type the extension if it is the default *.POLY3 (Windows) or *.poly3 (Linux), otherwise type the whole POLY-file name. A window opens so that the path (in the Look in field) and File name can be specified. The Files of type (i.e. POLY3) cannot be changed. Click Open to open the POLY3 and GIBBS workspaces from the saved *.POLY3 file.</td>
</tr>
</tbody>
</table>

When reading back an original POLY3 workspace that has already been saved as an *.POLY3 file in the current Thermo-Calc (Console Mode) run or had been read from an existing POLY3 file under the current work area, while some additional changes in the settings may be made but do not need to be kept in further steps in the current Thermo-Calc (Console Mode) run or any diagram is plotted in the POST module, you can type READ,, or READ_WORKSPACE,,

---

Equilibrium Calculations with the POLY_3 Module | 214 of 370
RECOVER_START_VALUES

Syntax

<table>
<thead>
<tr>
<th>Syntax</th>
<th>RECOVER_START_VALUES</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Recovers the start values in equilibrium calculations.</td>
</tr>
</tbody>
</table>

REINITIATE_MODULE

Ensures that the whole POLY module (and thus the entire POLY workspace) is reinitiated to the state as it was when first entered.

Syntax

<table>
<thead>
<tr>
<th>Syntax</th>
<th>REINITIATE_MODULE</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>All the defined components, defined conditions, changed status, entered symbols, defined independent axis-variables, calculated starting equilibrium-points, added initial equilibrium points, stepped/mapped equilibrium data, and so forth, are removed completely. The saved file name is restored to the default.</td>
</tr>
</tbody>
</table>

SAVE_WORKSPACES

This command is for both the POLY3 and GES (GIBBS) modules.

Thermo-Calc allows saving the current status and workspaces of the program, including thermodynamic data, conditions, options and results from a single, stepping or mapping calculation on an *.POLY3 file. Do this for later use or when you need to terminate the current Thermo-Calc (Console Mode) run.

The POLY3 and GIBBS workspaces are saved on a file with this command. In the GIBBS workspace, all thermochemical data are stored. In the POLY3 workspace, all thermochemical data, all the last set of conditions and equilibrium state, changed status, entered symbols, advanced options, defined stepping/mapping variables, added initial equilibria, stepped/mapped results, etc., are stored, so it also contain the GIBBS workspace. After a SAVE_WORKSPACE command, you can always come back to exactly the state you had when you issued the SAVE_WORKSPACE command by giving a READ_WORKSPACE command.

After saving the POLY3 and GIBBS workspaces on a file, you can leave the program and at a later time READ the file and continue from the saved state.

A STEP or MAP command automatically saves the work file with the most lately specified name. Do not SAVE after a MAP or STEP.
The results from the STEP or MAP commands are destroyed by the SAVE_WORKSPACE command. You may append several results obtained by sequential STEP or MAP calculations without destroying the previous results, whilst SAVE_WORKSPACE erases them all. Keeping this in mind is important and useful particularly for calculating various isothermal (or isoplethal) sections and plotting them on the same diagram in a single Thermo-Calc run.

You may append several results by STEP or MAP without destroying the previous results but the SAVE command erases them all. To suspend some of the STEP or MAP results, use the AMEND_STORED_EQUILIBRIA command.

When you go to a response-driven module such as POTENTIAL or SCHEIL for example, a workspace file is automatically opened. In the workspace file, system definitions, conditions for the calculation, calculation results, and plot settings is saved. The file is saved in the current working directory, and is named after the name of the module that created it. For example, the POTENTIAL module saves a workspace file called POT.POLY3 (or POT.poly3 in Linux); the POURBAIX module saves a file called POURBAIX.POLY3; etc.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SAVE_WORKSPACES</th>
</tr>
</thead>
<tbody>
<tr>
<td>A file name must be specified. The default extension of the POLY workspace file is *.POLY3 (Windows) or *.poly3 (Linux), while you can have any other extension.</td>
<td></td>
</tr>
<tr>
<td>A Save window displays, so that the path (in the Save in field) and File name can be specified. The file type (i.e. POLY3) in the Files of type cannot be changed.</td>
<td></td>
</tr>
</tbody>
</table>

Options

When saving a POLY3 workspace under a name that already exists under the current work area, which is saved by default (after running a special module, e.g. BIN, TERN, POT, SCHEIL and POURBAIX) or in an earlier stage of the current Thermo-Calc (Console Mode) run or in a previous run (which is READ into the current POLY3 workspace), you can type SAVE,,y or SAVE_WORKSPACE,,y. However, this must also be avoided if some results from previous MAP or STEP calculations shall not be destroyed.

**SELECT_EQUILIBRIUM**

If you create more than one initial equilibrium (during data-assessments using the PARROT/ED_EXP modules), you can switch between them using this command.
**Syntax**  | **SELECT_EQUILIBRIUM**
---|---
Prompt | Number /Next/: <Choice on equilibrium>

**Answer** FIRST, LAST, NEXT, PREVIOUS or PRESENT.

Most commands affect only the **PRESENT** equilibrium. However, the commands "REINITIATE_MODULE" on page 215 and "DEFINE_COMPONENTS" on page 196 remove all the stored equilibria.

---

**SET_ALL_START_VALUES**

Set start values, e.g. if the calculation fails or if you have a miscibility gap or ordering. If temperature and pressure are not conditions, you are asked for values of them. Then for each phase prompt on if it should be stable and on its constitution.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_ALL_START_VALUES</th>
</tr>
</thead>
<tbody>
<tr>
<td>T /XXXX/: &lt;Temperature in K&gt;</td>
<td>If the temperature is not a condition, supply a guess of its final value (in K).</td>
</tr>
<tr>
<td>P /100000/: &lt;Pressure in Pa&gt;</td>
<td>If the pressure is not a condition supply a guess of its final value (in Pa).</td>
</tr>
<tr>
<td></td>
<td><strong>Prompts</strong></td>
</tr>
<tr>
<td>Automatic start values for phase constitutions? /N/: &lt;Y, N or F&gt;</td>
<td><strong>Answer</strong> N (the default), Y or F (for force).</td>
</tr>
<tr>
<td></td>
<td>The reason for the F option is that in some cases the calculation has failed because impossible conditions are set, e.g. $W(C)=1.5$ [$W(C)$ is mass fraction and must thus be less than unity]. The program tries to fulfil this condition by putting maximum amount of carbon in all phases, but can fail anyway. When you detect the error and set $W(C)$ to 0.015, the calculation may still fail because it could start from the previous values. To get back to ‘fresh’ start values, give the answer F for FORCE.</td>
</tr>
<tr>
<td></td>
<td>If Y this command immediately terminates, and the program automatically sets the start values for phase constitutions in all possible phases.</td>
</tr>
<tr>
<td></td>
<td>For N supply an initial amount of each entered phase and the major constituents or site fraction of each constituent.</td>
</tr>
<tr>
<td>Should &lt;phase&gt; be stable /N/: &lt;Y/1 or N/2&gt;</td>
<td>A guess on if this phase should be stable or not is requested. All entered phases are prompted for this question and next two.</td>
</tr>
</tbody>
</table>
## Syntax

### SET_ALL_START_VALUES

You cannot have more phases stable than you have components, but at least one (which dissolves all constituents) must be set as stable. For backward compatibility, this question can be answered by 1 (for Yes) or 0 (for No).

The phase name may have a hash sign # followed by a digit, e.g. BCC_A2#2. For phases with miscibility gaps, there should be two phases with the same name but with different numbers after the hash sign.

<table>
<thead>
<tr>
<th>Major constituent(s): &lt;Name of major constituent(s) in the phase&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>The constituent with the largest fraction in the phase should be specified. If there are more than one constituent with a large fraction, give them all on the same line. If the default major constituents should be used answer with an asterisk (*). By giving $ the constitution is not changed. If there should be no major constituent give NONE and or if the major constituent(s) are improperly specified, you are asked for individual fractions in the phase.</td>
</tr>
</tbody>
</table>

Y(<phase>,<constituent>) /.XXXXXXXXXX/: <.YYYY>

The current value (.XXXXXXXXXX) is default. You can accept the default by pressing <Enter> or give a new value (.YYYY).

The phase name or constituent name may have a hash sign # followed by a digit, e.g. Y(BCC_A2#2,FE), Y(BCC_A2#2,C#2). For phases with miscibility gaps, there should be two phases with the same name but with different numbers after the hash sign. For phases with sublattices, the constituents in sublattice 2 or higher is also be suffixed with a hash sign # followed by a digit.

## SET_AXIS_VARIABLE

In order to calculate a diagram, set at least one axis variable in a stepping calculation, or at least two axis variables in a mapping calculation. For property diagrams, one axis is enough; for phase diagrams two or more are necessary. Any condition that can be set to calculate an equilibrium can be used as an axis variable (with its lower and upper limits and step length) by using the SET_AXIS_VARIABLE command, and the POLY program does, after a STEP or MAP command, vary the value of the condition between the limits set on its related axis variable. As an extraordinarily unique and powerful feature of the Thermo-Calc software, up to five independent axis variables can possibly be used in a mapping calculation of a
multicomponent heterogeneous system; however, the axis numbers 3, 4 and 5 must have chemical potentials of components (or temperature or pressure) as conditions.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_AXIS_VARIABLE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Axis number /#/ :</td>
<td>&lt;An axis number&gt;</td>
</tr>
<tr>
<td>Specify a number between 1 and 5. The axis numbers 3, 4 and 5 must have chemical potentials of components (or temperature or pressure) as conditions.</td>
<td></td>
</tr>
<tr>
<td>Prompts</td>
<td></td>
</tr>
<tr>
<td>Condition /None/ :</td>
<td>&lt;One condition&gt;</td>
</tr>
<tr>
<td>Here the condition that should be varied along the axis must be given. The condition is specified as in &quot;SET_CONDITION&quot; on the next page, for example W(C) for mass fraction of carbon. By accepting NONE, the axis is removed.</td>
<td></td>
</tr>
<tr>
<td>Min value /0/ :</td>
<td>&lt;Min value&gt;</td>
</tr>
<tr>
<td>Specify the minimum value of the axis condition.</td>
<td></td>
</tr>
<tr>
<td>Max value /1/ :</td>
<td>&lt;Max value&gt;</td>
</tr>
<tr>
<td>Specify the maximum value of the axis condition.</td>
<td></td>
</tr>
<tr>
<td>Increment /.025/:</td>
<td>&lt;Step length&gt;</td>
</tr>
<tr>
<td>Specify the maximum step length. By default, this is 1/40 of the total axis length.</td>
<td></td>
</tr>
</tbody>
</table>

You can give the SET_AXIS_VARIABLE command without having set a condition on the axis variable. Under such circumstances, the relevant condition is automatically created and the value set between the minimum and maximum axis limits; however, as a side effect, the POLY module creates two conditions, P=1e5 and N=1 (these have not been defined as a condition yet), in case you set an axis variable which is not already a condition.

You can use a logarithmic axis during calculations. This is useful for low fractions like in a gas phase where 1e-7 to 1e-2 might be an interesting range. The pressure is also suitable for logarithmic step. You specify the logarithmic axis by giving an asterisk * after the increment value.

The increment in this case is treated as a factor.

For example,

S-A-V 1 P 1E5 1E25 5*

This makes axis 1 a logarithmic axis where the difference between two calculated values makes a factor 5.

The factor must be larger than 1.0.
In some cases, such as when the DEFINE_DIAGRAM command is used or a special advanced module (e.g. BIN, TERN, POT, SCHEIL or POURBAIX) is called, some axis variables are automatically set by the program, not necessarily by this command.

**SET_CONDITION**

Specify the equilibrium conditions for the calculation. All kinds of state variables, as well as most of the M/W/V/F-suffixed state variables (for normalization) and R-suffixed state variables (with respect to chosen reference states), can be used as conditions. Beside temperature and pressure conditions, a multicomponent system can have mixed types of conditions; this brings the extreme flexibility and powerfulness to the complex calculations with the Thermo-Calc software system. You should repeat this command for a multicomponent system, till the degree of freedom in the defined system becomes zero. When a FIXED phase status is used on a specific phase (use "CHANGE_STATUS" on page 186), it is equivalent to one condition (implying that particular phase is stable in the defined system).

### Syntax

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_CONDITION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Each condition must be given explicitly, but can be given on the same line (separated by a comma (,) or an empty space) or on separate lines with each one started with the command.</td>
<td></td>
</tr>
</tbody>
</table>

### Example

```
SET_COND T=1273, P=1E5, W(C)=.0015, X(LIQ,CR)=.22, ACR(N)=.2
```

or

```
SET_COND T=1273, P=1E5
SET_COND W(C)=.0015, X(LIQ,CR)=.22 ACR(N)=.2
```

In this example, the temperature is set to 1273 K, the pressure to 1 bar (1E5 Pascal), the mass (weight) fraction of C to 0.0015 and the mole fraction of Cr to 0.22 and the activity of N to 0.2.

### Prompt

- **State variable expression:** `<State variable name or linear expression>` or a linear expression of state variables.

- Some of the state variables that can be used in conditions are:
  - **T:** temperature in the system (in K)
  - **P:** pressure in the system (in Pascal)
  - **N:** system size (mole number in moles)
  - **B:** system size (mass in grams)
<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_CONDITION</th>
</tr>
</thead>
<tbody>
<tr>
<td>N(&lt;component&gt;):</td>
<td>mole number of a component in the system</td>
</tr>
<tr>
<td>X(&lt;component&gt;):</td>
<td>mole fraction of a component in the system</td>
</tr>
<tr>
<td>W(&lt;component&gt;):</td>
<td>mass fraction of a component in the system</td>
</tr>
<tr>
<td>ACR(&lt;component&gt;):</td>
<td>activity of a component in the system</td>
</tr>
<tr>
<td>MUR(&lt;component&gt;):</td>
<td>chemical potential of a component in the system</td>
</tr>
<tr>
<td>X(&lt;phase&gt;,&lt;component&gt;):</td>
<td>mole fraction of a component in a phase</td>
</tr>
<tr>
<td>W(&lt;phase&gt;,&lt;component&gt;):</td>
<td>mass fraction of a component in a phase</td>
</tr>
<tr>
<td>ACR(&lt;species&gt;,&lt;phase&gt;):</td>
<td>activity of a species in a solution phase</td>
</tr>
<tr>
<td>MUR(&lt;species&gt;,&lt;phase&gt;):</td>
<td>chemical potential of a species in a solution phase</td>
</tr>
<tr>
<td>H:</td>
<td>enthalpy in the system (in J)</td>
</tr>
<tr>
<td>HM(&lt;phase&gt;):</td>
<td>enthalpy of a phase (in J/mol)</td>
</tr>
</tbody>
</table>

There are many state variables that can be used in conditions. For more information, enter an INFO STATE_VARIABLES command. A condition is normally a value of a single state variable with its value.

**Example**

T=1273.15  P=1E5
X(C) = 0.02
W(CR) = 0.5
ACR(CR) = 0.85
X(FCC,C) = 0.01
H = -250000
HM(BCC) = -225000

A condition can also be a value of a linear expression involving more than one state variable. For example,

X(LIQ,S) - X(PYRR,S) = 0

This means that it is a condition that the mole fraction of S component should be the same in the LIQUID and PYRRHOTITE phases. In practice, that should be the congruent melting point.
### Syntax

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_CONDITION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Factor: &lt;A factor for the state variable, or a continuation&gt;</td>
<td></td>
</tr>
<tr>
<td>This question means you did not answer the previous question. The program is then expecting a single state variable or a complete state variable expression, or the numeric factor in an expression with only one state variable. In a state variable expression a state variable may be preceded by a constant factor. An example of this is:</td>
<td></td>
</tr>
<tr>
<td>( 2 \times \text{MUR(}FE\text{)} + 3 \times \text{MUR(O)} = -35000 )</td>
<td></td>
</tr>
<tr>
<td>This means that it should be a condition that two times the chemical potential of ( FE ) plus three times the chemical potential of ( O ) should be -35000 J/mol.</td>
<td></td>
</tr>
<tr>
<td>State variable: &lt;A specified state variable, or a continuation&gt;</td>
<td></td>
</tr>
<tr>
<td>This question is prompted if a single state variable name has not given in either the prompt ( \text{State variable expression} ) or ( \text{Factor} ), or a state variable expression is given but the expression is incomplete, for example, ( T= ) or ( 2 \times \text{MUR(}FE\text{)}+ ), for which the program is then expecting a continuation of the unfinished expression. You need to specify a state variable or a complete state variable expression, or complete the unfinished state variable expression. If a numeric factor is given before this prompt, only one state variable can be specified; otherwise, the program only takes the first state variable to complete the expression (i.e. the factor times the state variable).</td>
<td></td>
</tr>
<tr>
<td>Value /X/: &lt;A numeric value, a constant or a variable&gt;</td>
<td></td>
</tr>
<tr>
<td>The value of the condition. This can be a numeric value, a constant or a variable. A suggestion is given as the default value. The special value ( \text{NONE} ) means that the condition is removed; for example ( T=\text{NONE} ) takes away the temperature condition.</td>
<td></td>
</tr>
</tbody>
</table>

**SET_INPUT_AMOUNTS**

Specify how a system is made up from mixing of various substances. It is useful with a substance database. In the C-H-O-N system, you can, for example, give:

\[ S-1\text{A } N(H2)=10, \text{N(H2O)}=25, \text{N(C1O2)}=5, \text{N(N2)}=100 \]

The POLY module automatically converts this into conditions for the current set of components. In the case when the elements are defined as the components, the command above is equivalent to

\[ \text{SET-CONDITION } N(H)=70, \text{N(O)}=35, \text{N(C)}=5, \text{N(N)}=200 \]
Syntax | SET_INPUT_AMOUNTS
--- | ---
Quantity: <N(specie)> or B(specie)>

Prompts
You can give the amount also preceded with an equal sign = [e.g. N(H2)=10 or B(H2O)=1000], or press <Enter> for the next prompt on the amount of the quantity.

Amount: <Value of the quantity>
Specify the numerical value of the quantity.

You can give negative amounts in the SET-INPUT-AMOUNTS command.

**SET_NUMERICAL_LIMITS**

Change the criteria for convergence. This is to speed up a calculation in a complex system.

If there is any convergence problem in finding a stable solution at any stage during a calculation procedure enforced by "COMPUTE_EQUILIBRIUM" on page 190, "STEP_WITH_OPTIONS" on page 227, "MAP" on page 212 or "ADVANCED_OPTIONS" on page 174), this message displays:

Convergence problems, increasing smallest site-fraction from 1.00E-30 to hardware precision 2.00E-14. You can restore using SET-NUMERICAL-LIMITS

This implies that smallest site fraction in the current POLY3 workspace is automatically increased from the default value 1.00E-30 to the hardware-dependent precision (under Linux, as 2.00E-14). For other subsequent POLY-module calculation in the current ThermoCalc (Console Mode) run, you can use this command to restore or reset the smallest site fraction to the previous or another preferred value, as well as to reset other numerical limits.

Syntax | SET_NUMERICAL_LIMITS
--- | ---
Maximum number of iterations /200/: <xxx>

Prompt
By default, the program tries 500 iterations before it gives up. As some models give computation times of more than 1 CPU second/iteration, this number is also used to check the CPU time and the calculation stops if 500 CPU seconds/iterations are used.

Required accuracy /1E-6/: <yyy>
This is a relative accuracy, and the program requires that the relative difference in each variable must be lower than this value before it has converged. A larger value normally means fewer iterations but less accurate
## SET_NUMERICAL_LIMITS

The value should be at least one order of magnitude larger than the machine precision.

Smallest fraction /1E-12/: <zzz>

This is the value assigned to constituents that are unstable. It is normally only in the gas phase you can find such low fractions.

The default value for the smallest site-fractions is 1E-12 for all phases, except for IDEAL phase with one sublattice site (such as the GAS mixture phase in many databases) for which the default value is always as 1E-30 (unless you have used the SET_NUMERICAL_LIMITS command to reset an even-lower value (e.g. 1E-45, that is naturally enforced to all the phases in the system).

Approximate driving force calculation for metastable phases /Y/: <Y or N>

Normally the POLY module only requires that the set of stable phases is in equilibrium in order to terminate the iterations. The metastable phases are included in all iterations but these may not have reached their most favourable composition and thus their driving forces may be only approximate [corresponding to Y]. You can also force the calculation to converge for the metastable phases by answering N if it is important that these driving forces are correct, which may require more iterations, and the STEP and MAP command may also terminate due to bad convergence in a metastable phase.

---

## SET_REFERENCE_STATE

The reference state for a component is important when calculating activities, chemical potentials and enthalpies. The reference state for a component is determined by the database. For each component the data must be referred to a selected phase, temperature and pressure, i.e. the reference state. All data in all phases where this component dissolves must use the same reference state. However, different databases may use different reference states for the same element. Thus you must be careful when, for example, mixing data from different databases.

By default, activities, chemical potentials, etc. are computed relative to the reference state used by the database and this may thus differ depending on the database. With this command select the reference state for a component if the reference state in the database does not suit.

You can set the reference state for a component as SER, i.e. the Stable Element Reference (which is usually set as default for a major component in alloys that is dominated by the
component). Under such a case, the temperature and pressure for the reference state is not needed and thus is not prompted.

In order to specify conditions in the specified reference state, you can append an R to the state variables. Thus, AC is the activity (of a system component or of a species in a phase) with respect to the default reference state, and ACR is the activity with respect to the selected reference state; MU is the chemical potential of a system component with respect to the default reference state, and MUR stands for the chemical potential with respect to the selected reference state. The AC and ACR variables, for both components in a system and species in a phase, can be specified in natural logarithm, e.g. LNAC(Fe), LNACR(C), LNAC(O2,GAS), LNACR(O2,GAS).

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_REFERENCE_STATE</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Prompts</strong></td>
<td>Component: &lt;Name of the component&gt;</td>
</tr>
<tr>
<td></td>
<td>The name of the component must be given.</td>
</tr>
<tr>
<td></td>
<td>Reference phase: &lt;Name of a phase used as the new reference state&gt;</td>
</tr>
<tr>
<td></td>
<td>The name of a phase, that must be either ENTERED or DORMANT or SUSPENDED, must be given here. The component must, of course, be a constituent of this phase.</td>
</tr>
<tr>
<td></td>
<td>For a phase to be usable as reference for a component the component need to have the same composition as an end member of the phase. The reference state is an end member of a phase. For example, in the Fe-C system, BCC can be a reference state for Fe but not for C since BCC cannot exist as pure C.</td>
</tr>
<tr>
<td></td>
<td>If a component has the same composition as several end members of the chosen reference phase, then the end member is selected that at the specified temperature and pressure has the lowest Gibbs energy. For example, setting the reference state for component O as gas (one sublattice) with constituents O1, O2 and O3 results in O2 being the reference state if, at the present temperature, pure O2 has the lowest energy of O1, O2 and O3. If the reference state is set above a critical higher temperature, then O1 has the lowest energy and consequently become the reference state.</td>
</tr>
<tr>
<td></td>
<td>The actual calculation of the reference state is only performed when SET_REFERENCE_STATE is executed. For example, if GAS is chosen as the reference phase of component O at such a high temperature that O1 has the lowest energy, then O1 remains the reference state even at calculations performed at lower temperatures where O2 has a lower energy than O1.</td>
</tr>
<tr>
<td></td>
<td>Temperature /*/: &lt;Temperature for the reference state&gt;</td>
</tr>
</tbody>
</table>


**Syntax**

<table>
<thead>
<tr>
<th><strong>SET_REFERENCE_STATE</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Select the temperature (in K) for the reference state. The wildcard value * means the current temperature is used for the calculation.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Pressure /1E5/: &lt;Pressure for the reference state&gt;</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Select the pressure (in Pa) for the reference state. The wildcard value * means the current pressure is used for the calculation.</td>
</tr>
</tbody>
</table>

**Examples**

- S-R-S Fe SER
- S-R-S Cr FCC * 100000
- S-R-S H2O AQUEOUS * 100000
- S-R-S ZE REF_ELECTRODE * 100000

---

**SET_START_CONSTITUTION**

This command is similar to "SET_ALL_START_VALUES" on page 217, but is used for an individual phase that may have a wrong constitution.

**Syntax**

<table>
<thead>
<tr>
<th><strong>SET_START_CONSTITUTION</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Phase name: &lt;Name of a phase, and possible major constituent(s)&gt;</td>
</tr>
</tbody>
</table>

**Prompts**

- Specify the name of a phase for which the constitution shall be set.

- If there is a major constituent of the phase, you must specify this on the same line as the phase name. By giving an*, select the default major constituents. A $ means keeping the same constitution, and NONE means to give individual site-fractions.

\[ y(\text{Phase}##\text{Composition_set},\text{Constituent}##\text{Sublattice})/xxx/: <SF> \]

- The site fraction (SF) of the constituent shall be given. The default value xxx is the last calculated one.

---

**SET_START_VALUE**

Set a start value of an individual variable.

- This command is not often required as the automatic start values can be handled for most problems.
Syntax | SET_START_VALUE
--- | ---
Prompts | State variable: <Name of a state variable>
The state variable must be given.
| Value | Specify the value to be assigned the state variable as start value.

**SHOW_VALUE**

Show the current value of any state variable, function or variable.

Syntax | SHOW_VALUE
--- | ---
Prompt | State variable or symbol: <Name(s) of state variable(s) or symbol(s)>
A single or several state variables or symbols (entered functions or variables) can be specified.

The wildcard * can be used to denote all phases or all components.

You can use the dollar-sign $ to denote all stable phases. Thus, the command SHOW W(*,*) lists the mass fraction of all phases, whereas SHOW W($,*) lists the mass fraction of all stable phases.

If you SHOW a function, all functions are evaluated using the current values of the state variables. But if you SHOW a variable, it retains its value from the time it was ENTERED or last EVALUATED.

Therefore to save a value from one calculation to another, ENTER it to a variable. This is frequently done in the PARROT module to transfer values between equilibria.

**STEP_WITH_OPTIONS**

The STEP_WITH_OPTIONS (short name, STEP) command initiates the stepping procedure to make a calculation of property diagrams in a multicomponent heterogeneous system. A property diagram is usually stepped under one defined independent stepping axis-variable, and is often constructed by the defined independent mapping axis-variable against a chosen property (for the system, or for a specific phase, or for a certain species).

In the POLY module, it is possible to compute a series of equilibria with one condition as the stepping axis variable. This is achieved by first calculating a single equilibrium, and then selecting one of the conditions as the axis variable. The minimum and maximum value and
the incremental step along the axis must also be given. By default, the global minimization technique is used.

A property diagram consists of property lines that change (normally) along with the stepping axis-variable. From a single STEP calculation, many different types of property diagrams in the defined multicomponent heterogeneous systems can be plotted. Various types of property diagrams are generated by the stepping calculations. Also see "About Property Diagrams" on page 169 in the Thermo-Calc User Guide.

Normally, before the command can be invoked, you need to have already calculated an initial equilibrium point and set one independent variable (i.e. the controlling condition in the system). This is done using "SET_AXIS_VARIABLE" on page 218. You then list the current values of the axis variable for each calculated equilibrium, as well as the corresponding information when the set of stable phases changes.

By default, the global minimization technique is enabled, You can turn this off by using the command-sequence "ADVANCED_OPTIONS" on page 174 → GLOBAL_MINIMIZATION.

You can choose how often to do a global minimization test using the command-sequence ADVANCED_OPTIONS → STEP_AND_MAP → GLOBAL_TEST_INTERVAL.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>STEP_WITH_OPTIONS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Option? /Normal/: &lt;a chosen option, N, I, S, O, E, M, T, or P&gt;</td>
</tr>
<tr>
<td></td>
<td>N = Normal, I = Initial equilibria, S = Separate phases, O = One phase at a time, E = Evaluate, M = Mixed Scheil, T= T0, and P = Paraequilibrium</td>
</tr>
</tbody>
</table>

Normal (N)

When you accept the default, Normal (N), it allows a stepping calculation with the chosen independently-varying equilibrium condition (axis-variable). Only the step axis value is changed between each step.

When you repeat the STEP → NORMAL command-sequence, you can make several stepping calculations while still keep all the stepping-calculation results in the current POLY3 workspaces.

The calculation results are saved in the default RESULT.POLY3 file or you can specify to save it in the <MyName>.POLY3 file. This is as long as there is no SAVE_WORKSPACES command before the second set of command sequences (STEP → NORMAL). Repeated stepped results can be restored into the same current POLY3 workspaces/file.
The addition of several steps enables you to generate special types of property diagrams and to calculate and plot special phase boundary lines on phase diagrams, such as:

- The missing part(s) of a specific property [that are calculated under another controlling condition inside the range of the stepping-variable] on the same property diagram.
- Two or more sets of a specific property [that are calculated under different controlling conditions and stepped over the same stepping-variable range] on the same property diagram for the same system.
- Calculate some special phase-boundary lines [especially for some defined secondary phase transformations or alike, e.g. the BCC_A1 <-> BCC_B2 phase-boundary, or equal-Gm for two specific phases, or equal-fraction or equal-activity for a certain species in two specific phases, that shall be calculated under different controlling-conditions and also be stepped over different stepping variable(s)], and then plot (or impose) them onto a corresponding phase diagram (which can be resulted from several such STEP → NORMAL calculations or even from a separate MAP calculation) for the same system.

**Initial Equilibria (I)**

An initial equilibria is added at each calculated point. This can be useful, for instance, to generate a set of isothermal calculations.

When you choose I, an initial equilibrium is stored at each calculated equilibria. It is intended to generate a matrix of calculated initial equilibria, first stepped under a STEP INITIAL_EQUILIBRIA command-sequence and then repeated by another STEP NORMAL command-sequence (or even continued by a MAP command).

For example, you can first use the temperature condition as the stepping axis-variable with this option, which calculates a number of initial equilibrium points and automatically adds each one as an initial equilibria for another STEP → NORMAL command-sequence (or even for a MAP command). Before the second STEP command (i.e. the STEP → NORMAL command-sequence), you can chose a compositional condition as the new stepping axis-variable; then the STEP → NORMAL command-sequence uses those created starting equilibrium points (at different temperatures) and steps in such a new compositional variable. As a result, these two STEP commands together give a matrix of values.

**Separate Phases (S)**

In this way, you can calculate how the Gibbs energy for a number of phases varies for different compositions. This is particularly useful to calculate Gibbs energies for complex phases with miscibility gaps and for an ordered phase that is never disordered (e.g.
SIMGMA-phase, G-phase, MU-phase, etc.).

**One_Phase_at_Time (O)**

This option is recommended for STEPPING heterogeneous systems with both ordered phases and the disordered pairs.

When you choose O, the stepping calculation is conducted individually for one phase at a time. That is, it is stepped over the whole stepping variable range, but the stepping is repeated for all the entered phases in the defined system. This is particularly useful to properly step in composition for an equilibrium heterogeneous system with both ordered phases and the disordered pairs. Thus, instead of calculating for the same composition for each of the phases at each composition step, it starts the stepping in each of the phases in the default most-stable compositions (the major constitutions).

**Evaluate (E)**

> For Scheil-Gulliver simulations it is recommended you use the [SCHEIL module](#).

Evaluate E is an advanced option and is useful when additional conditions (instead of the stepping variable) require changing during a stepping calculation. It allows a stepping calculation in a single axis with simultaneous evaluation of one or more variables after each step. As variables can be used as conditions, it means that you can change the conditions during the stepping. After a successful EVALUATE calculation, you can go to the POST module to manually define and plot property diagrams.

The variables given are evaluated after each step, which may change other conditions. This can be useful to perform the Ordinary ScheilGulliver Approach (non-equilibrium transformations) for simulating alloy solidification without back diffusion of fast-diffusing interstitial components in solid phases. However, it is recommended you use the ["SCHEIL Module" on page 293](#).

Specify the prompt:

Variable name(s): <Variable name>

The names of the variables that shall be evaluated after each step must be typed here.

The miscibility gap test is automatically used during stepping (see ["ADVANCED OPTIONS" on page 174](#)) if a phase has two or more composition sets.

The miscibility gap test means that you can start calculating from high temperatures in a
steel where the MC carbide is not stable. During the calculation, the MC carbide first becomes metastable with a composition different from the metallic FCC phase and later also becomes stable.

See Console Mode example tces30A.

**Mixed_Scheil (M)**

For Scheil-Gulliver simulations it is recommended you use the [SCHEIL module](#).

This is an advanced stepping calculation designed for the Extended Scheil-Gulliver Approach (partial-equilibrium transformations) to simulate alloy solidifications with back-diffusion of one or more fast-diffusing interstitial components (such as C, N, O, S, etc.) in solid phases is performed. It also will consider BCC→FCC phase transformation (practically for steels) along the alloy solidification process.

To ensure a successful stepping calculation of mixed Scheil-Gulliver simulation of solidification process of a defined alloy system with a certain initial overall composition, it is important to note the following:

- For solution phases with possibility of miscibility gap existence, you have appropriately added the necessary composition set(s);
- You have already set the temperature condition as the stepping SET_AXIS_VARIABLE command, with minimum and maximum temperature points as well as an appropriate temperature step for the cooling process).
- There must be a composition condition for each of the back-diffusion components (i.e. fast-diffusing interstitial components, such as C, N and/or other elements) that are already defined in terms of mole-fraction or mass-fraction, e.g. \(X(C)\) and \(W(N)\). Otherwise, a stepping calculation with this option can fail.
- An initial equilibrium in which the LIQUID mixture phase is the only stable must be calculated. This is why it is good to start with a relatively high temperature condition for the initial equilibrium calculation. It is always necessary to reject or suspend the GAS mixture phase (if it exists) before the C-E and STEP commands, to avoid its formation along with LIQUID.
- In cases where fast-diffusing interstitial components are specified as back-diffusion components, you can choose to allow BCC→FCC phase transformation (practically for steels) during the alloy solidification process.
These are the prompts for this option:

**Fast diffusing components:** `<Fast diffusion interstitial(s)>`

Specify one or more interstitial component(s) as the back-diffusion component(s).

- If there is only one fast-diffusing interstitial component (e.g. C or N), type its name;
- If there are two or more fast-diffusing interstitial components (e.g. C, N and S), always type the names on the same line at once (separated by an empty space in between, e.g. C N S);
- If there is no fast-diffusing interstitial component to be considered, type NONE to ignore back diffusion entirely, meaning a normal Scheil-Gulliver simulation is performed.

Such specified back-diffusion interstitial component(s) must be appropriately defined according to the phase constitution definitions of some major alloy solution phases (e.g. FCC, BCC, HCP, etc.). These are located on the interstitial/vacancy sublattices in such alloy solution phases; otherwise, such a Scheil-Gulliver simulation may not make sense at all.

**Allow BCC --> FCC ? */Y/: <Y or N>**

Type Y or N to allow or not allow the BCC-->FCC phase transformation (which is usually a typical phenomenon along the cooling processes of steels/Fe-alloys).

During the calculation the simulated solidification path, including the locally-equilibrated phase assemblage (region), captured temperature condition (T in K), remaining liquid phase (NL, mole fraction), overall formed solid phases (NS, mole fraction) and latent heat formation (NH, J/mol) along the cooling process are shown after the information on starting temperature point of the alloy solidification process, e.g.

```
Solidification starts at 1743.15 K
Phase Region from 1.744150E+03 for: LIQUID
Phase Region from 1.742525E+03 for:
  LIQUID
  FCC_A1#1
    1742.5250  0.9960  0.0040  -1.1824
    1742.4000  0.9795  0.0205  -202.1585 . . . . . . .
Phase Region from 1.733150E+03 for:
  LIQUID
  BCC_A2
  FCC_A1#1
    1733.1500  0.3294  0.6707  -8032.6240
```
After a successful calculation, you can go to the POST module to manually define and plot property diagrams for the alloy solidification process according to the chosen Scheil-Gulliver model, or to impose existing relevant experimental information or other types of calculated solidification results [e.g. Scheil-Gulliver simulation with or without considering fast-diffusing interstitial component(s), full-equilibrium approach, or Diffusion Module (DICTRA)-type simulation with moving-boundary conditions] onto the same plotted property diagrams. Normally, the solidus temperature (T in Celsius) is set as one of the axis variables (usually as Y-axis in most cases), while the other plotted quantity on the other axis can be the amount of overall formed solid alloy phases (NS in mole-fraction or BS in mass-fraction), the amount of remaining liquid phase (NL in mole-fraction or BL in mass fraction), the heat of latent along the solidification process (NH in J/mol or BH in J/gram), among many other properties in the solidified alloy phases or in the whole alloy system.

**T-zero (T)**

For an example see Console Mode example 41.

This advanced option allows a stepping calculation of the so-called T0 (T-zero) line in a diffusionless transformation (where two specific partially-equilibrated phases have the same Gibbs energy) along a composition variable which has already set as the stepping variable with “SET_AXIS_VARIABLE” on page 218.

- The temperature condition cannot be set as the stepping variable if you want to make a STEP T-ZERO calculation.

Prior to performing the step T0 command sequence, and to ensure a successful calculation of T0 line between two specific phases after an initial equilibrium calculation in the current system, it is sometimes recommended to make a single T0 point calculation using ADVANCED_OPTIONS → T-ZERO.

Specify these prompts:

Name of first phase:  <Phase A>

Name of second phase:  <Phase B>

The names of the target phases, for which the Gibbs energies equal to each other at each point on the T0 line, must be entered.

During the calculation, the T0 values are shown after the corresponding scanned conditions.
(of the stepping composition variable), e.g.

<table>
<thead>
<tr>
<th>Phase Region from</th>
<th>1.000000E-01 for:</th>
</tr>
</thead>
<tbody>
<tr>
<td>BCC_A2</td>
<td></td>
</tr>
<tr>
<td>FCC_A1</td>
<td></td>
</tr>
<tr>
<td>1.000000E-01</td>
<td>940.24</td>
</tr>
<tr>
<td>9.250000E-02</td>
<td>941.20</td>
</tr>
<tr>
<td>. . . . .</td>
<td></td>
</tr>
<tr>
<td>2.500000E-03</td>
<td>977.61</td>
</tr>
<tr>
<td>7.500000E-09</td>
<td>979.34</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Phase Region from</th>
<th>1.000000E-01 for:</th>
</tr>
</thead>
<tbody>
<tr>
<td>BCC_A2</td>
<td></td>
</tr>
<tr>
<td>FCC_A1</td>
<td></td>
</tr>
<tr>
<td>1.000000E-01</td>
<td>940.24</td>
</tr>
<tr>
<td>1.075000E-01</td>
<td>939.62</td>
</tr>
<tr>
<td>. . . . .</td>
<td></td>
</tr>
<tr>
<td>2.950000E-01</td>
<td>1084.87</td>
</tr>
<tr>
<td>3.0000000E-01</td>
<td>1080.99</td>
</tr>
</tbody>
</table>

After a successful calculation, you can go to the POST module to plot the T0 line against the stepping composition variable or another varying axis, or to impose the calculated T0 line onto a normal phase diagram [normally plotted as a $T$-$X$ isopleth].

**Paraequilibrium (P)**

For an example see Console Mode examples 42 and 43.

This is an advanced option. Select P to calculate the paraequilibrium state between two specific phases (the *paraequilibrium lines*). It allows a stepping calculation of paraequilibrium lines where the chemical potential for one or more interstitial components (that are considered as back-diffusion elements, such as C and N) but not for the other(s) in two partially equilibrated phases are equal.

More than one interstitial component can be treated as fast-diffusion species (such as C, N, O, S, etc., as individual or combined) in a paraequilibrium stepping calculation.

The composition condition for the interstitial components cannot be set as the stepping variable if you want to make this calculation.

To ensure a successful stepping calculation of paraequilibrium states between two specific
phases in a defined alloy system, it is important to first make a starting-point equilibrium calculation with an initial overall composition in the current system. However, it is unnecessary to obtain an equilibrium in which either one or both of the target phases is stable.

The initial overall composition must have a reasonable setting for the desired paraequilibrium calculation for the two target phases. This is especially true where there is more than one interstitial component to be considered in the paraequilibrium state, because different interstitial components (for example C and N combined) may have significant different behaviours as partitioning into different structured phases; otherwise, for one chosen interstitial component the initial overall composition is OK for the paraequilibrium calculation between the specified two phases, but for other chosen interstitial component(s) it might be impossible to calculate the paraequilibrium state.

Always check if the chosen phaseA and phaseB have the exact same definition of elements and if the chosen interstitial components are all in the vacancy sublattice sites of the two phases; otherwise the program cannot find the paraequilibrium state (as it is impossible to correctly calculate u-fractions).

Always have a comprehensive understanding of the normal phase diagram for the currently investigated system, so that you make the appropriate choice of the phase pair and staring bulk composition for the system.

Always set the status of the chosen interstitial components as SPECIAL using the command:

```
CHANGE_STATUS COMPONENT <interstitial component> = SPECIAL
```

By doing this, you get a clear picture on u-fractions of various substitutional and interstitial components, which are different from the overall composition in the system. The SPECIAL status means that specified component(s) are not included in summations for mole or mass fractions. Therefore, all the composition variables plotted from the paraequilibrium calculations are u-fraction related quantities.

Always make a single-point paraequilibrium calculation by the command-sequence of ADVANCED_OPTIONS → PARAEQUILIBRIUM, prior to performing this STEP → PARAEQUILIBRIUM command-sequence, although this might not be always necessary for some systems.

With this stepping calculation specify the following:

Name of first phase:  <Phase A>
Name of second phase: <Phase B>

The names of the two target phases A and B, between which the paraequilibrium states establish, must be typed at the above two prompts subsequently or on the same (first) line at once (separated by an empty space, e.g. FCC BCC, FCC#2 M23C6).
It is important to understand that this is the calculation of a paraequilibrium state between the two specified phases.

Particularly, there are these issues to consider:

1. Both chosen phases must have similar interstitial/vacancy sublattices where the fast-diffusion interstitial component(s) occupy.
2. The choice on the target phase pair must be reasonable for the defined system and specified initial overall composition.
3. Both target phases should have phase constitution definitions that cover all the defined substitutional and interstitial components of the current alloy system; or
4. It is impossible to calculate the paraequilibrium state between the target phase pairs with given interstitial component(s) in the currently defined system.

Fast diffusing component: /C/: <Interstitial component(s)>
Fast diffusing component: /None/: <Interstitial component(s)>

The name(s) of the fast-diffusing interstitial component(s) (C as the default single component) must be given either one by one at each of the above prompts subsequently or in a combination (separated by an empty space in between, e.g. C N S) at the same (first) prompt; otherwise, press <Enter> key to start the paraequilibrium line stepping-calculation.

Note the following:

Such specified fast-diffusing interstitial component(s) must be appropriately defined according to the phase constitution definitions of the two selected phases: These must be located on the interstitial/vacancy sublattices in both chosen phases.

If there is only one fast-diffusing component which is carbon, press <Enter> to accept the default value (C) at the first prompt; if the single fast-diffusing interstitial component is another element (e.g. N), appropriately type interstitial component the name at the first prompt;

If there are two or more fast-diffusing components (e.g. C and N), type their names at the above prompts subsequently or at the same (first) prompt (separated by an empty space, such as C N);

To finish the input of fast-diffusing elements, accept NONE at a repeated prompt;

If NONE or a non-existing component name is typed at the first prompt, it means no back diffusion is to be considered, and the para-equilibrium calculation is thus cancelled entirely.

During the STEP → PARAEQUILIBRIUM calculation procedure, the calculated
paraequilibrium states include the:

- corresponding stepping conditions (e.g. temperature in K, or the stepping composition variable of the matrix component or of one of substitutional components) which has already set as the stepping variable by the SET_AXIS_VAR command);
- amounts of the phase A in mole number [i.e. NP(phaseA)];
- amounts of the phase B in mole number [i.e. NP(phaseB)];
- contents of the interstitial component(s) in the phase A expressed in u-fractions [i.e. \( u-f(\text{phaseA}, \text{component(s)}) \)];
- contents of the interstitial component(s) in the phase B expressed in u-fractions [i.e. \( u-f(\text{phaseB}, \text{component(s)}) \)];
- LNACR(component) value(s) for the interstitial(s).

After a successful STEP → PARAEQUILIBRIUM calculation, you can go to the POST module to plot a paraequilibrium phase diagram, or to impose the calculated paraequilibrium states onto a normal phase diagram [normally plotted as a T-X isopleth with one of the considered interstitial component(s) as the x-axis variable].

However, the stepping calculation procedure for the currently specified paraequilibrium states between the two specified phases may find difficulties at some steps due to some possible numerical problems (normally regarding to the u-fractions of the interstitial components under some composition ranges), or it may completely fails. In the latter case, it implies that the chosen target phase pair may be unreasonable for the defined alloy system or for the defined initial overall composition, or one or both phases may have inappropriate phase constitution definitions regarding the specified interstitial component(s) and substitutional components. Then, you must either modify the settings of initial overall composition or specify the reasonable target phase pair with an appropriate choice of the fast diffusion interstitials in the defined alloy system.
The figure above shows the plot of a paraequilibrium calculation of isopleths: Formation of para-pearlite in two Fe-based alloys, with equilibrium results appended.

The calculated paraequilibrium phase boundaries (black lines) are shown with tie-lines (in green-colour). In the Fe-2.5Mn-C alloy system, C is considered as fast diffusing interstitial component in the BCC+FCC and FCC+Cementite paraequilibrium stepping calculations; while in the Fe-3Cr-N alloy system, N is treated as fast diffusing interstitial components in the BCC+FCC and FCC+FCC_M1N (i.e. FCC#1+FCC#2) paraequilibrium stepping calculations.

During a STEP calculation, the value of the stepping axis variable for each calculated equilibrium is listed and also the set of stable phases.

You can stop the mapping of a line by pressing a single <Ctrl-A> (Windows) or <Ctrl-C> (Linux). This can be useful in order to stop a longish calculation without losing what is already calculated.

If there is any convergence problem in finding a stable solution at any stage during a calculation procedure enforced by a STEP_WITH_OPTIONS command-sequence, this message displays:

Convergence problems, increasing smallest site-fraction from 1.00E-30 to hardware precision 2.00E-14. You can restore using SET NUMERICAL LIMITS

This implies that smallest site fraction in the current POLY3 workspace is automatically increased from the default value 1.00E-30 to the hardware-dependent precision (under Linux, as 2.00E-14). For other subsequent POLY-module calculation in the current TC run, you can use the POLY command "SET NUMERICAL LIMITS" on page 296 to restore or reset the smallest site fraction to the previous or another preferred value, as well as to reset other numerical limits.

Complex miscibility gaps of various solution phases are automatically detected during a stepping calculation, and two or more composition sets for each of such solution phases are automatically generated as well, through an automatic Global Minimization Test procedure (by specifying a Global Test Interval value and confirming the Automatically add initial equilibria in the ADVANCED OPTION STEP_AND_MAP command-sequence). As a particular case, such an automatic Global Minimization Test ensures that you can now start calculating from high temperatures in an austenitic steel (metallic FCC_A1 solution phase) where the MC carbides/nitrides/carbonitrides (i.e. the C-/N-rich sides of the FCC_A1 miscibility-gap, often (while not always) being referred to as FCC_A1#2, FCC_A1#3, etc.) are not stable, and during the MAP command the MC carbides/nitrides/carbonitrides may first become metastable with a composition different from the metallic FCC_A1 phase and later also stable.

Occasionally, it may be necessary to have a specified increment other than the default value
for the defined stepping axis-variable, in order to calculate/plot a smoother property diagram.

To get a complete property diagram, sometimes (especially in some earlier Thermo-Calc versions) it may also be required to have more than one starting equilibrium-points (under another starting equilibrium condition), and repeat the stepping calculation over the same stepping axis-variable range (while without over-writing the same POLY3 workspaces via a SAVE_WORKSPACE command). However, using the current STEP procedure such a requirement become less necessary.

**TABULATE**

For any entered table, this command gives a table of values from equilibria calculated with a STEP command. It works only for a table that is entered in either the POLY or POST module.

Unlike the TAB module's command (also called "TABULATE" on page 315) it is not possible to plot columns from the tabulated tables. For this use normal POST commands.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>TABULATE</th>
</tr>
</thead>
</table>
| **Prompts** | **Name**: <Name of a table entered in either POLY or POST>  
Specify a table name that is entered in either the POLY or POST module.  
**Output on screen or file /Screen/:** <File name or return>  
Specify a file name if you want to save on a file the table values along the defined STEP calculation, or press <Enter> if want to see the table values displayed. |
Diffusion Module (DICTRA) Documentation

Set Plotting and Visualization with the POST Module

The POST module (post-processor) is available from the POLY module. See "Equilibrium Calculations with the POLY_3 Module" on page 163 for other information about the POLY module. Read "Using the POST Module" on page 242 before beginning.

In this section:

- Using the POST Module ............................................................. 242
- ADD_LABEL_TEXT ................................................................. 243
- APPEND_EXPERIMENTAL_DATA ............................................... 245
- CHANGE_LEGEND ........................................................................ 246
- DUMP_DIAGRAM ......................................................................... 246
- ENTER_SYMBOL ........................................................................ 247
- FIND_LINE .................................................................................. 250
- LIST_DATA_TABLE ...................................................................... 251
- LIST_PLOT_SETTINGS ............................................................... 251
- LIST_SYMBOLS .......................................................................... 251
- MAKE_EXPERIMENTAL_DATAFILE ............................................. 252
- MODIFY_LABEL_TEXT ................................................................ 252
- PLOT_DIAGRAM ......................................................................... 253
- PRINT_DIAGRAM ........................................................................ 254
- QUICK_EXPERIMENTAL_PLOT ................................................... 254
- REINITIATE_PLOT_SETTINGS .................................................... 255
- RESTORE_PHASE_IN_PLOT ....................................................... 255
- SELECT_PLOT ........................................................................... 255
- SET_AXIS_LENGTH ...................................................................... 256
- SET_AXIS_PLOT_STATUS ........................................................... 256
- SET_AXIS_TEXT_STATUS ............................................................ 256
- SET_AXIS_TYPE ......................................................................... 257
SET_COLOR .......................................................... 257
SET_CORNER_TEXT .............................................. 259
SET_DIAGRAM_AXIS .............................................. 259
SET_DIAGRAM_TYPE ............................................. 261
SET_FONT .......................................................... 262
SET_INTERACTIVE_MODE ......................................... 263
SET_LABEL_CURVE_OPTION .................................... 263
SET_PLOT_FORMAT ............................................... 264
SET_PLOT_OPTIONS ............................................. 264
SET_PLOT_SIZE .................................................. 266
SET_PREFIX_SCALING .......................................... 267
SET_RASTER_STATUS ............................................ 267
SET_REFERENCE_STATE ......................................... 267
SET_SCALING_STATUS .......................................... 268
SET_TIC_TYPE .................................................... 269
SET_TIELINE_STATUS ........................................... 269
SET_TITLE .......................................................... 270
SET_TRUE_MANUAL_SCALING ................................... 270
SUSPEND_PHASE_IN_PLOT ....................................... 270
TABULATE .......................................................... 271
Using the POST Module

Use the POST module after a "STEP_WITH_OPTIONS" on page 227 or "MAP" on page 212 calculation to generate graphical or tabulated presentations on screen or into files.

The graphical files are available in different formats (e.g. PS, EMF, PNG, BMP, PDF, JPG, TIF) or data forms (e.g. EXP, TAB and WRL). The graphical output can be phase diagrams, property diagrams, diffusion profiles and other types of plots. The tabulated presentation is into a basic text file (TXT) or a spreadsheet (e.g. an MS Excel file with an extension of .XLS).

The POST module is available through these modules:

- POLY
- TAB
- BIN
- TERN
- POT
- SCHEIL
- POURBAIX

Within the POST module, you can choose any state variable, any derived variable, or any entered symbol (functions or variable) as the X/Y-axis.

Also see "Thermodynamic Variables and Units" on page 332.

When a diagram is plotted, appearance parameters for defining a high-standard graph can be further specified, e.g. curve labelling options, diagram titles and subtitles, plot size, axis length, axis types, axis-tic type, tie-line status, automatic or manual scaling and zooming, semi-automatic or manual labelling on phase boundaries and phase regions, graphic formats, text fonts, colours, raster plot, etc.

You can append experimental data onto a plotted diagram. You can also save the coordinates onto a textual file, which can be edited and used as an experimental data file to be merged onto another diagram or as a part of a setup file for PARROT-module assessment.

Phases can be suspended or restored in a plotted diagram. The reference states for components can also be modified for the resulted diagrams. Moreover, you can translate a plotted property diagram (after a stepping calculation) into a tabulated form, such as a simple list on screen or a textual file, and a spreadsheet.
ADD_LABEL_TEXT

Add a text to an area in a phase diagram or a property diagram. The label is written starting from the specified coordinates. Optionally, you can also let the program automatically add the text by first calculating an equilibrium state at the specified coordinates and then making a label out of the stable phase names.

The label texts and coordinates, either added by this command or modified with "MODIFY_LABEL_TEXT" on page 252 (or manually edited in the Console Results window), are stored in the workspace, and these may later be saved onto an *.EXP file (with "MAKE_EXPERIMENTAL_DATAFILE" on page 252).

In some cases such an optional calculation for automatic phase region labeling may not work. It is not possible to automatically add labels for certain sets of axes, like entropy, enthalpy, pH, Eh, etc.

"Adding and Editing Plot Labels " on page 119 in the Thermo-Calc User Guide.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>ADD_LABEL_TEXT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompts</td>
<td>Give X coordinate in axis units: &lt;Value of the X coordinate&gt;</td>
</tr>
<tr>
<td></td>
<td>Specify the value of the X coordinate where the label is to start.</td>
</tr>
<tr>
<td></td>
<td>Give Y coordinate in axis units: &lt;Value of the X coordinate&gt;</td>
</tr>
<tr>
<td></td>
<td>Specify the value of the Y coordinate where the label is to start.</td>
</tr>
<tr>
<td></td>
<td>Automatic phase labels? /Y/: &lt;Y or N&gt;</td>
</tr>
<tr>
<td></td>
<td>If you answer Y, the program automatically calculates the equilibrium at the given coordinates and generates a label with the names of the stable phases. However, the automatic calculation works only for phase diagrams that are mapped with two axes in the POLY module, and sometimes it may not work correctly especially for complex heterogeneous interaction systems; in such cases, a message displays.</td>
</tr>
<tr>
<td></td>
<td>Text: &lt;Text for the label&gt;</td>
</tr>
<tr>
<td></td>
<td>If you answer N enter text at the prompt. You can enter simple text, use LaTeX, rotate the text, as well as adjust the font size.</td>
</tr>
</tbody>
</table>

The labels disappear if any axis is changed afterwards.
### Syntax | ADD_LABEL_TEXT
--- | ---
**LaTeX:** You can use LaTeX commands to enter text and symbols. First enter the command followed by the expression or string, for example to display Al2O3 as subscripts:

\latex Mole-fraction Al\_2O\_3

For a list of supported LaTeX commands, see [http://www2.ph.ed.ac.uk/snuggletex/documentation/math-mode.html](http://www2.ph.ed.ac.uk/snuggletex/documentation/math-mode.html).

By default when using the LaTeX command, you are in math mode and Thermo-Calc automatically interprets the entered text as math. The above link uses the dollar sign ($) in all the examples but this is NOT required. For example, if you enter $E=mc^2$ this is displayed including the $ instead of the equation.

To add a mixture of plain text and equation text, you can exit math mode using the string \textrm followed by the text to display enclosed in curly brackets. For example \latex \textrm{Mole-fraction } Al\_2O\_3 displays this label Mole-fraction \text{Al}_2\text{O}_3.

**Rotate the text:** If you want to rotate the label, start a text string with the rotation command (which is case sensitive and must be in lower case letters) then enter the number of degrees to rotate the label. For example, to rotate the label 45 degrees enter:

\rotation 45

To rotate the text and use LaTeX, the rotation command must be used first. For example:

\rotation 45 \latex Mole-fraction Al\_2O\_3

Rotates the text 45° and includes subscripts in the title Mole-fraction Al2O3.

**Text size:** / .35/: <Size for the label>

A smaller size of the text may be necessary to fit the label text into the diagram. A default size is given using the latest size in adding label texts, or .35 if the command is called for the first time. A recommended size is e.g. 0.25.
APPEND_EXPERIMENTAL_DATA

Add experimental data and text onto a calculated diagram. This is done by placing the experimental data and text on a formatted textual file (always having an extension of EXP) that is prepared outside of Thermo-Calc software (Console Mode and Graphical Mode), according to the syntax of the DATAPLOT Graphical Language.

The picture generated from the data is superimposed on the ordinary graphical output from the postprocessor. Such an experimental data file (*.EXP) may be created by an ordinary textual editor.

Another important usage of this command is to superimpose plots from several independent calculations. For this purpose, there is a command "MAKE_EXPERIMENTAL_DATAFILE" on page 252, which dumps a calculated diagram on an EXP file according to the DATAPLOT syntax. With the aid of a normal text editor, many such files may be merged together. Remember that you can only have one prologue section on each such EXP file.

Also see the DATAPLOT User Guide included with this documentation set.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>APPEND_EXPERIMENTAL_DATA</th>
</tr>
</thead>
</table>
| Prompts | Use experimental data (Y or N) /N/: <Y or N>  
Specify whether the data from an experimental data file should be included in the next plot. If the answer is c, no experimental data are plotted.  
An Open window displays to specify the name of the file with the experimental data.  
Prologue number: /0/: <Prologue number>  
Select which prologue to use. In a prologue, you can, for example, give the scaling of an axis, the axis texts, and so on.  
By answering -1, a list of all prologues on the file is given; and by 0, no experimental data are appended.  
Dataset number(s) /-1/: <Dataset number(s)>  
Select from which dataset(s) data should be read. Several datasets may be given separated with commas or spaces. By answering -1, a list of all datasets on the file is given; and by 0, no experimental data are appended. |
CHANGE_LEGEND

When there is a legend in the diagram you can append constitution and/or ordering descriptions to the phase name.

"LIST_EQUILIBRIUM" on page 209 also displays ORD (ordered) or DISORD (disordered) (when available).

In some cases the legend only shows the phase name for a line when the "SET_LABEL_CURVE_OPTION" on page 263 option is set to F.

Syntax

<table>
<thead>
<tr>
<th>Prompt</th>
<th>CHANGE_LEGEND</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set suffix for phase names in legend? (All, None, Constitution, Ordering)/None/:</td>
<td></td>
</tr>
<tr>
<td>When you select None the legend includes the standard information about the phases.</td>
<td></td>
</tr>
<tr>
<td>When you select All the Constitution description and the Ordering description (when there is ordering) are also included.</td>
<td></td>
</tr>
<tr>
<td>When you select Constitution, this is added to the standard description.</td>
<td></td>
</tr>
<tr>
<td>When you select Ordering and when there is ordering, this is added to the standard description.</td>
<td></td>
</tr>
</tbody>
</table>

Also see "About Legend Styles" on page 117 in the Thermo-Calc User Guide for examples of these labels.

DUMP_DIAGRAM

After a Thermo-Calc graph is created (and displays with the PLOT_DIAGRAM command) you can save (dump) a diagram to a file so you can quickly print it. It is similar to the PRINT_DIAGRAM command.

Similar to "PRINT_DIAGRAM" on page 254, it does not matter what graphic device is set up for the graph, this command is always able to convert the graph shown on screen to the selected graphic format.
Syntax | DUMP_DIAGRAM
--- | ---

**Prompt**

- **Output format/:** `<Format or return>`

Specify an appropriate graphic format for dumping the graph or pressing `<Enter>` to accept the default format.

- **A Save window opens if you have not specified a file name. Select a directory path and enter a File name. If a file with the specified name already exists, then you are prompted whether to overwrite the old file or not. The third argument of the command allows you to specify whether to overwrite (Y) the old file or not (N).**

> After the printing process is finished, the temporarily set graphic device for conversion and printing is switched back to the one set by the command "SET_PLOT_FORMAT" on page 264, so that you can save the graph in file(s) using "PLOT_DIAGRAM" on page 253.

**ENTER_SYMBOL**

- **This command is for both the POST and POLY modules in Console Mode.**

Symbols are a useful feature of the POLY and POST modules to define quantities that are convenient. Symbols can be constants, variables, functions or tables.

Functions or tables (with defined functions as values) can be entered in the POST module after a stepping or mapping calculation, for purposes of plotting such entered functions or tables as axis variables.

Within the POLY module, symbols are normally defined prior to an equilibrium calculation (enforced by a C_E command), stepping calculation (enforced by the command "STEP_WITH_OPTIONS" on page 227) or mapping calculation (enforced by "MAP" on page 212). These can be entered after an equilibrium calculation; however, for defined functions, variable or tables, it requires using "EVALUATE_FUNCTIONS" on page 208 before showing the corresponding values in the calculated equilibrium state.

The symbols entered in the POST module are not saved in the currently-loaded POLY3 workspaces. Therefore, if you want to apply such symbols in other similar calculations for the same defined system, you must use the ENTER_SYMBOL command prior to the STEPPING or MAPPING calculation in the POLY module.

- **Also see "ENTER_SYMBOL" on page 113 for the GIBBS Module.**
See example 44 in the *Thermo-Calc Console Mode Examples Guide* for an example of using variables and functions.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>ENTER_SYMBOL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Constant, Variable, Function or Table? /Function/: &lt;keyword&gt;</td>
<td></td>
</tr>
<tr>
<td>The <em>Keyword can be specified as CONSTANT, VARIABLE, FUNCTION or TABLE.</em></td>
<td></td>
</tr>
<tr>
<td>• CONSTANTS can only be entered once and is a means of using a name for a numeric value. For example, the value of 1 atmosphere in Pascal can be denoted by ( P_0 ) after the command ENTER CONSTANT ( P_0 = 101325 ). Defined constants can be used as values in condition assignments, for example, SET-COND ( P = P_0 ).</td>
<td></td>
</tr>
<tr>
<td>• FUNCTIONS are expressions of state variables or other functions. These expressions are saved, and whenever a function value is requested all functions are evaluated. The reason for this is that they may depend on each other.</td>
<td></td>
</tr>
<tr>
<td>• VARIABLES are similar to functions because they can also be expressions of state variables. However, contrary to functions, they are only evaluated when they are entered or if they are explicitly named in an &quot;EVALUATE_FUNCTIONS&quot; on page 208 command. It is possible to enter a variable with a new expression any time. This expression is evaluated directly and its value stored as the value of the variable. Defined variables can be used as values in the SET-CONDITION command.</td>
<td></td>
</tr>
<tr>
<td>• TABLES are used for listing results from the STEP or MAP commands. A table consists of a list of any number of state variables, functions or variables. Defined tables can also be used in the post-processor POST.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Prompt</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name: &lt;Name of the symbol&gt;</td>
</tr>
<tr>
<td>Each symbol has a unique name that must start with a letter and can have maximum 8 characters.</td>
</tr>
<tr>
<td>Legal characters include letters (either UPPER or lower case), digits and underscore _. Any other special character, such as parentheses ( and ), plus +, minus -, slash / or , full stop ., are illegal for symbol names.</td>
</tr>
<tr>
<td>You can enter the symbol name and the value or function on the same line,</td>
</tr>
</tbody>
</table>
these must be separated with an equal sign =, for example, \( TC = T - 273.15 \) or \( T_C = T - 273.15 \) which stands for a definition of temperature in Celsius. Otherwise, these questions are asked.

For different types of symbol (constant, function, variable or table), the questions have different prompts.

### Function: <Definition for a function or variable>

*Functions and variables* are evaluated from an expression of state variables or other functions, constants or variables. The expression is a FORTRAN-like expression and operators +, -, *, = and ** can be used (** only with integer powers).

Unary functions like \( \text{LOG}, \text{LOG10}, \text{EXP}, \text{SIN}, \text{COS} \) and \( \text{ERF} \) can also be used. An expression can be continued on more than one line. An expression should be terminated by a semicolon (;) or an empty line (by pressing <Enter> at the next prompt).

#### Examples of function expressions:

- \( \text{GM( LIQUID) } \): The Gibbs energy of liquid per mole component
- \( \text{H.T/4.184} \): The heat capacity of the system in calories
- \( \text{ACR(CR)/X(FCC,CR)} \): The activity coefficient for Cr in FCC
- \( T - 273.15 \): The temperature in Celsius

The ampersand \& means that you can continue to write the function on the new line if one line is not enough for the function. If you finish the function press <Enter> again.

### Value: <Value for a constant>

A *constant* can only be assigned a numeric value once.

### Value or expression: <Value of expression for a variable>

A *variable* can be assigned a numeric value or an expression. An expression is evaluated immediately and discarded. Only the numeric value is kept. This gives a possibility to save a value between calculations with different conditions because all state variables and functions are evaluated for the new conditions.
Syntax | ENTER_SYMBOL
--- | ---
Variable(s): &lt;Variable(s) in a table&gt;

A *table* consists of a list of state variables or functions. One way to obtain results from a STEP command is through a table.

Example:

```
ENTER TABLE K=T,X(LIQ,C),X(LIQ,CR),ACR(C)
```

Which means that the table called *K* contains four columns, i.e. the temperature, the mole fractions of *C* and *Cr* in the LIQUID phase, and the activity of *C*.

To show the temperature in Celsius in a table, give the command ENTER FUNCTION TC=T-273; and then use the symbol TC in the table.

& &lt;Continuation of the definition for the table&gt;

The ampersand & means that you can continue to write the table on the new line if one line is not enough for the table. If you finish the table press &lt;Enter&gt; again.

**FIND_LINE**

Identifies various property curves on a plotted property diagram (after a stepping calculation); it also works well in find stable phase regions on a phase diagram (after a mapping calculation).

Syntax | FIND_LINE
--- | ---
Prompts

```
X coordinate / 0.484623611/: &lt;Value of the X coordinate&gt;
```

Specify the value of the X coordinate where you want to find the details of property curve (or phase region).

```
Y coordinate / 0.5153737962/: &lt;Value of the Y coordinate&gt;
```

Specify the value of the Y coordinate where you want to find the details of property curve (or phase region).

The POST module displays the identified property (for a property curve on a property diagram), or the identified stable phase-assemblage (for a phase region on a phase diagram).
LIST_DATA_TABLE

This is a POST module command.

This command is used for listing various properties (i.e. the Y-axis variable on a property diagram) that change with an independent variable (i.e. the X-axis variable on a property diagram), which have already been defined in the POST module (and often are plotted on the Console Results window), but only after a STEP calculation.

The listing output can be either on screen or in a spreadsheet file in the MS Excel format (under specified file name with the default file extension of XLS), which can be further edited or used for graphical handling by opening the file (using the MS-Excel program) outside of the Thermo-Calc software system.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>LIST_DATA_TABLE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Output to screen or file /Screen/: &lt;File name or return &gt;</td>
</tr>
<tr>
<td></td>
<td>Specify a file name if you want to save on a spreadsheet file (in the MS Excel format, with the default extension of XLS) on which the already-defined properties on a property diagram (after a STEP calculation) is saved, or press &lt;Enter&gt; if want to see a simple textual table on screen (for the already-defined properties that change alone with an independent variable).</td>
</tr>
<tr>
<td></td>
<td>This command only works for a property diagram after a stepping calculation but not for any phase diagram after a mapping calculation.</td>
</tr>
</tbody>
</table>

LIST_PLOT_SETTINGS

This is a POST module command.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>LIST_PLOT_SETTINGS</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Lists the present values of most parameters specifying the type of diagram to be plotted.</td>
</tr>
</tbody>
</table>

LIST_SYMBOLS

For both the POLY and POST modules, list the definitions for all constants, functions, variables and tables.
In order to find the value of a function or variable, use "SHOW_VALUE" on page 227 or "EVALUATE_FUNCTIONS" on page 208. A table is tabulated with the TABULATE command.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>LIST_SYMBOLS</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The defined variables are listed up together with the defined functions, but variable names are followed by a percentage sign %.</td>
</tr>
</tbody>
</table>

**MAKE_EXPERIMENTAL_DATAFILE**

Write the graphical information onto screen or a formatted text file (always having an extension of .EXP) using the DATAPLOT graphical format. In order to merge two or more diagrams from separate calculations, you can write them out on files with this command, and then add/edit them together with a normal text editor.

Also see the DATPLOT User Guide included with this documentation set.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>MAKE_EXPERIMENTAL_DATAFILE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Output to screen or file /Screen/: &lt;Name of a file or return&gt;</td>
</tr>
<tr>
<td></td>
<td>Specify the name of the desired file. Accept SCREEN (press &lt;Enter&gt;) for a list. Otherwise, a file name where the graphical information is written must be given here. The default file extension is EXP (under MS Windows) or exp (under Linux).</td>
</tr>
</tbody>
</table>

**MODIFY_LABEL_TEXT**

Move a label created with the command "ADD_LABEL_TEXT" on page 243 to another position, or replace its text with another one.

The label texts and the coordinates, either added by ADD_LABEL_TEXT command or modified by this command or manually edited on the Console Results window, are stored in the workspace, and can be saved onto an *.EXP file (through "MAKE_EXPERIMENTAL_DATAFILE" above).
### PLOT_DIAGRAM

With this command, a calculated/plotted diagram is displayed if the default graphic device has already been defined by the "SET_PLOT_FORMAT" on page 264 command. It can also be saved onto a file.

The functionality of this command is shared in two ways:

- in PLOT_DIAGRAM for normal screen display and file saving and
- in "PRINT_DIAGRAM" on the next page (under MS-Windows environment) for direct hard-copy printing.
**Syntax** | **PLOT_DIAGRAM**
---|---
**Prompt** | Output to screen or file /Screen/: <Name of a file or return for screen>

Specify the name of the desired file (Note that under Linux, the prompt is PLOTFILE /SCREEN/). Consequently, a file with a proper extension for the selected graphic format (set by the SET_PLOT_FORMAT command) is saved under the current working directory. If no extension is given in the file name, the default extension e.g. ps for Postscript portrait/landscape modes, P7 or p7 for HPGL landscape, P8 or p8 for HPGL portrait, etc.) is automatically given to the file name.

If the default device is set (by the command SET_PLOT_FORMAT), you can either accept SCREEN to plot the graph in the Thermo-Calc Graph window on screen by pressing <Enter>, or save it on a file by giving a file name.

---

**PRINT_DIAGRAM**

**Syntax** | **PRINT_DIAGRAM**
---|---
**Prompt** | Print with high quality to a file after a Thermo-Calc graph is created (and is displayed with "PLOT_DIAGRAM" on the previous page). It has the same function as the Print Plot option on the Console Results windows.

---

**QUICK_EXPERIMENTAL PLOT**

This is similar to "APPEND_EXPERIMENTAL_DATA" on page 245 but can be used when there is no graphical information to be plotted in the POLY3 workspace. It defines a pair of axis, sets the axis labels to X and Y, and scales both X- and Y-axes between 0.0 and 1.0 unless a prologue is read from the DATAPLOT (*.EXP) data file.

Also see the *DATPLOT User Guide* included with this documentation set.

**Syntax** | **QUICK_EXPERIMENTAL PLOT**
---|---
**Prompts** | Prologue number: /0/: <Prologue number>

An Open window displays. Select the prologue to use. In a prologue, you can, for example, give the scaling of an axis, the axis texts, and so on. By answering -1, a list of all prologues on the file is given; and with 0, no experimental data are appended.

Dataset number(s) /-1/: <Dataset number(s)>
### REINITIATE_PLOT_SETTINGS

All parameters describing the diagram are given default values.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>REINITIATE_PLOT_SETTINGS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>All plot settings made in the POST module are deleted, and it returns to the initial settings when the POST module is entered.</td>
</tr>
</tbody>
</table>

### RESTORE_PHASE_IN_PLOT

Restores a phase previously suspended from the plot with "SUSPEND_PHASE_IN_PLOT" on page 270. It works only after at least one phase is suspended.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>RESTORE_PHASE_IN_PLOT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Phase name: &lt;Name of a phase&gt;</td>
</tr>
<tr>
<td></td>
<td>Give the name of the phase to be restored.</td>
</tr>
</tbody>
</table>

### SELECT_PLOT

Select a plot within the current Results tab in the Console Results window.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SELECT_PLOT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Plot &lt;N/New&gt;</td>
</tr>
<tr>
<td></td>
<td>Where ( N ) is a positive integer. Enter the number of the plot that is selected in the Console Results window (in the currently selected Results tab). If a plot with that number does not exist, it is created.</td>
</tr>
<tr>
<td></td>
<td>The default parameter value is ( \text{NEW} ). If this is entered, then a new plot is created. Create a new plot can also be done by pressing (&lt;\text{Ctrl}+\text{Shift}+\text{T}&gt;).</td>
</tr>
</tbody>
</table>
SET_AXIS_LENGTH

Change the real length of an axis in inches. The default number of tic-marks on an axis is 10 when the relative length is 1. The number and units per tic-mark must be a multiple of 1, 2 or 5 to obtain a reasonable scaling of an axis.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_AXIS_LENGTH</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Axis (X, Y or Z):</strong> &lt;Name of an axis&gt;</td>
</tr>
<tr>
<td>Prompt</td>
<td><strong>Specify which axis to set the length.</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Axis length /11.5/:</strong> &lt;New relative axis length&gt;</td>
</tr>
<tr>
<td></td>
<td>Specify the new real axis length in inches. The relative length 1 corresponds to 10 tic-marks on the axis.</td>
</tr>
</tbody>
</table>

SET_AXIS_PLOT_STATUS

Specify whether the axis title texts and axis label texts are to be plotted or not on a diagram. It does not work for the axis lines and tic-marks. If you want to plot a diagram without tic-marks, use "SET_TIC_TYPE" on page 269 first.

This can be used to merge different diagrams on a pen-plotter or to obtain the diagram faster. The default status is that all the set axes are to be plotted.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_AXIS_PLOT_STATUS</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Axis plot (Y or N) /Y/:</strong> (Y or N)</td>
</tr>
<tr>
<td></td>
<td>Specify to plot axis texts (Y) or no (N).</td>
</tr>
</tbody>
</table>

SET_AXIS_TEXT_STATUS

Change the axis text from the automatic text given by the axis specification to a text.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_AXIS_TEXT_STATUS</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Axis (X, Y or Z):</strong> &lt;Name of an axis&gt;</td>
</tr>
<tr>
<td>Prompt</td>
<td><strong>Specify which axis text status to change.</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Automatic axis text (Y or N) /N/:</strong> &lt;Y or N&gt;</td>
</tr>
<tr>
<td></td>
<td>Specify if automatic axis text is to be used (Y) or (N). If you answer N, enter axis text.</td>
</tr>
</tbody>
</table>
### SET_AXIS_TEXT_STATUS

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_AXIS_TEXT_STATUS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Axis text: &lt;Enter axis text&gt;</td>
<td>You can enter simple text, use LaTeX, rotate the text, as well as adjust the font size.</td>
</tr>
</tbody>
</table>

Also see "ADD_LABEL_TEXT" on page 243.

### SET_AXIS_TYPE

Change the axis type among linear, logarithmic and inverse axis.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_AXIS_TYPE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompts</td>
<td>Axis (X, Y or Z): &lt;Name of an axis&gt;</td>
</tr>
<tr>
<td></td>
<td>Specify which axis to change the axis type.</td>
</tr>
<tr>
<td></td>
<td>Axis type /Linear/: &lt;New axis type&gt;</td>
</tr>
<tr>
<td></td>
<td>Specify which new axis type to set. Select Linear (default), Logarithmic or Inverse. Only the three first characters are relevant.</td>
</tr>
</tbody>
</table>

### SET_COLOR

Some devices support colours or line thickness. With this command, select different colors or line types on some types of information on a diagram.

This command can fail if a chosen device does not support colors or line thickness.

This command gives four sequential prompts (i.e. Text and axis, Invariant equilibria, Tie-lines, and All other lines), with the Keyword and default option (both listed below). Depending on if the switched-on graphic device (by the SET_PLOT_FORMAT command) supports colors or line types, the POST automatically switches on the appropriate Keyword.
### Syntax

<table>
<thead>
<tr>
<th>Prompt</th>
<th>SET_COLOR</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text and axis keyword /Default option/ &lt;Return or new option&gt;</td>
<td></td>
</tr>
<tr>
<td>Invariant equilibria keyword /Default option/: &lt;Return or new option&gt;</td>
<td></td>
</tr>
<tr>
<td>Tie-lines color keyword /Default option/: &lt;Return or new option&gt;</td>
<td></td>
</tr>
<tr>
<td>Keyword of all other lines /Default option/: &lt;Return or new option&gt;</td>
<td></td>
</tr>
</tbody>
</table>

This is usually for the solubility lines.

---

The **Keyword** is either **Color** or **LineType**, depending on if color or line type is supported by the switched-on graphic device (by the "SET_PLOT_FORMAT" on page 264 command); the POST module **automatically switches on the appropriate** **Keyword**.

### Color Options

The options for **Color** are:

<table>
<thead>
<tr>
<th>BACKGROUND</th>
<th>BLUE</th>
<th>PURPLE</th>
<th>GRAY</th>
</tr>
</thead>
<tbody>
<tr>
<td>FOREGROUND (default)</td>
<td>YELLOW</td>
<td>GOLD4</td>
<td>ORANGERED3</td>
</tr>
<tr>
<td>RED (default for invariant equilibria)</td>
<td>MAGENTA</td>
<td>TURQUOISE4</td>
<td>MAROON</td>
</tr>
<tr>
<td>GREEN (default for tie lines)</td>
<td>CYAN</td>
<td>PINK</td>
<td>PLUM</td>
</tr>
<tr>
<td>SIENNA</td>
<td>OLIVEDRAB</td>
<td>SEAGREEN</td>
<td></td>
</tr>
<tr>
<td>ORANGE1</td>
<td>CORAL1</td>
<td>USERDEF</td>
<td></td>
</tr>
</tbody>
</table>

### LineType Options

The options for **LineType** are:
**SET_CORNER_TEXT**

Adds text to the corners on a plotted diagram. Normally, you can write such texts as a subtitle.

The primary database (not the appended ones) used in calculations and the calculated conditions are automatically plotted at the upper-left corner as a part of the header on all plotted diagram. Unless the plotting option WRITE CONDITIONS is switched off by the command "SET_PLOT_OPTIONS" on page 264, the calculated conditions are always written on plotted diagrams; and only when the plotting option PLOT HEADER is switched off by the command SET_PLOT_OPTION, the used database also always appear. Under such circumstance, avoid writing texts at the UPPER_LEFT corners.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_CORNER_TEXT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Corner/Lower_Left/: &lt;Return or new option&gt;</td>
</tr>
</tbody>
</table>

Choose an option:
- LOWER_LEFT
- UPPER_LEFT
- UPPER_RIGHT
- LOWER_RIGHT
- TOP_OF_TRIANGLE

Text: <Texts as a subtitle or a note>

Write the texts that are to be written on the specified diagram corner.

**SET_DIAGRAM_AXIS**

Specify an axis variable for a plot or a listing. To be able to plot a diagram, at least two axis variables (x and y) must be specified. In the Thermo-Calc Console Mode, three axes (x, y and z) can be specified for a diagram.
The axis variables in the plot can be different from the number of axis used for the mapping.

If you want to plot a phase diagram with tie-lines in the plane after a MAP calculation, then the composition axis must be mole-fraction or weight-fraction, or mole-percent or weight-percent of one specific component. You must not use the stable variable \( x(\text{comp}) \) or \( w(\text{comp}) \) even if that is what you used when calculating the diagram, because that only gives one side of the two-phase region. It may be sufficient to indicate that mole-fraction is the same as the stable variable \( x(^*,\text{comp}) \), and weight-fraction is the same as the stable variable \( w(^*,\text{comp}) \).

If you plot a phase diagram where the tie-lines are not in the plane after a MAP calculation, then mole-fraction and \( x(\text{comp}) \) are identical.

When you plot a property diagram after a STEP calculation and want a composition axis variable, you should normally use \( x(\text{comp}) \) and not mole-fraction.

The axis must have exactly the same number of columns, or one axis must have one column. In the first case the columns are plotted matching them one by one; in the latter all columns on one axis is plotted against the single column. For example, you can have the temperature on one axis and the amount of each phase on the other. The amount of each phase is the state variable \( \text{NP}^* \) in mole fraction or \( \text{BPW}^* \) for mass fractions of phases.

Automatic diagram axis: The POST module can set automatic diagram axis identical to those used in the "MAP" on page 212 command.

If the state variable \( x(\text{comp}) \) is used in a MAP calculation, then mole-fraction of the component is used as diagram axis; if a potential or some other state variables are used, then that is used as a diagram axis.

After a STEP calculation, automatic diagram axis is not set as there is only one axis used in the calculation.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_DIAGRAM_AXIS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Axis (X, Y or Z): &lt;Axis name&gt;</td>
<td>Specify which axis (X or Y or Z) to set with a variable.</td>
</tr>
<tr>
<td>Variable type: &lt;Variable name&gt;</td>
<td>Specify a variable for the chosen axis here.</td>
</tr>
<tr>
<td>Prompts</td>
<td>The valid variables are:</td>
</tr>
<tr>
<td></td>
<td>- TEMPERATURE-CELSIUS as temperature in oC</td>
</tr>
<tr>
<td></td>
<td>- TEMPERATURE as temperature in K</td>
</tr>
</tbody>
</table>
### Syntax

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_DIAGRAM_AXIS</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>•</td>
<td>PRESSURE as pressure in Pa</td>
</tr>
<tr>
<td>•</td>
<td>ACTIVITY for a component</td>
</tr>
<tr>
<td>•</td>
<td>LNACTIVITY for a component ([\ln(ACR(\text{component}))])</td>
</tr>
<tr>
<td>•</td>
<td>MOLE-FRACTION for a component</td>
</tr>
<tr>
<td>•</td>
<td>MOLE-PERCENT for a component</td>
</tr>
<tr>
<td>•</td>
<td>WEIGHT-FRACTION for a component</td>
</tr>
<tr>
<td>•</td>
<td>WEIGHT-PERCENT for a component</td>
</tr>
<tr>
<td>•</td>
<td>NONE to clear the axis</td>
</tr>
<tr>
<td>•</td>
<td>Any valid state variable including those with wildcards, e.g. NP(<em>) or x (</em>,component). Due to the use of wildcard * in such a state variable, the program asks for a column number.</td>
</tr>
<tr>
<td>•</td>
<td>Any entered function or variable.</td>
</tr>
<tr>
<td>•</td>
<td>Any entered table.</td>
</tr>
</tbody>
</table>

If you specify an entered table as the variable, then you are given these prompts:

For component: <Component name>

When an activity, mole or weight fraction or percent of a component shall be plotted, the component name must be supplied here.

Column number: <Column number(s)>

Specify the column number(s) in the chosen table that are to be plotted onto the earlier specified axis. For example:

- 1 for column 1
- 2, 3 for columns 2 and 3
- 2, 3 >5 for column 2,3 and all columns above column 5
- * for all columns

### SET_DIAGRAM_TYPE

Choose the diagram type as perpendicular plot or triangular plot (Gibbs triangle, especially for ternary systems). The default is with a perpendicular axes.
For phase diagrams of ternary or pseudo-ternary systems, it is usually need to plot isothermal sections as triangular grams. If desired, all lines outside the region limited by a line joining the end points of the X- and Y-axis is removed.

In order to create a 3D-plot file (in the VRML format, *.WRL) for a tetrahedron diagram, this command in the sequence SET_DIAGRAM_TYPE N Y should be used first.

**Syntax**

```
SET_DIAGRAM_TYPE
```

**Prompts**

- Triangular diagram (Y or N) /N/: <Y or N>
- Specify a triangular plot Y. Otherwise (by pressing <Enter> to accept N), perpendicular axis is set and this command is terminated. By default, perpendicular diagrams have (almost) the same scaling on both axes.
- Create tetrahedron WRML file (Y or N) /N/: <Y or N>
  - If a triangular plot is not selected (at the above prompt), answer Y in case a tetrahedron diagram is used to generate VRML (*.WRL) file by sequentially using the CREATE_3D_PLOTFILE command.
- Plot 3rd axis (Y or N) /N/: <Y or N>
  - If a triangular plot is selected, specify if a 3rd axis (by answering Y here), connecting the end points of the X- and Y-axes, is plotted.
- Clip along 3rd axis (Y or N) /N/: <Y or N>
  - If a triangular plot is selected, all lines outside the region limited by a line joining the end points of the X- and Y-axis are removed by answering Yes (Y).

---

**SET_FONT**

Select the font to use for labels and numbers when plotting the diagram under the currently selected graphic device ("SET_PLOT_FORMAT" on page 264). For some devices there may be other fonts available and these are selected by the SET_PLOT_FORMAT command.

**Syntax**

```
SET_FONT
```

**Prompts**

- Select font number /1/: <#>
  - Specify an available font number # as the default font for the current graphic device, or accept the font number 1 by pressing <Enter>. By typing a question mark ? here, the program lists the available fonts under the currently selected graphic device.
- Font size /.34/: <##>
<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_FONT</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The size of the chosen font is specified. A value around 0.34 is recommended.</td>
</tr>
</tbody>
</table>

## SET_INTERACTIVE_MODE

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_INTERACTIVE_MODE</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Resets the input and output units to their initial values, i.e. keyboard and screen.</td>
</tr>
<tr>
<td></td>
<td>Remember to add this as the last command to your MACRO files, in order to stop execution of the command file in the POST module. It has no meaning in interactive mode.</td>
</tr>
</tbody>
</table>

## SET_LABEL_CURVE_OPTION

Identify the curves drawn in the post-processor by marking each curve with a digit and then list the meaning of these digits beside the plot.

- The number of digits can be quite large in some cases. If so, use the SET_FONT command and reduce the font size; usually, 0.2 is sufficient.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_LABEL_CURVE_OPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Curve label option (A, B, C, D, E, F OR N) /A/: &lt;Option&gt;</td>
</tr>
</tbody>
</table>
|          | The options:  
  - A: List stable phases along line  
  - B: As A but curves with same fixed phase have same number  
  - C: List axis quantities  
  - D: As C but curves with same quantities have same number  
  - E: As B with changing colors  
  - F: As D with changing colors  
  - N: No labels  

This question is rather cryptic but usually the option B or E is good for phase diagrams (after a MAP command) and option D or F for property diagrams (after a STEP command). Those interested can try out the option A and C by themselves.
<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_LABEL_CURVE_OPTION</th>
</tr>
</thead>
</table>
|          | Option B or E lists the fixed phases along each curve, whereas option D or F gives the axis variables used along each curve. E provides varied colors for different stable-phase curves on phase diagrams (after a MAP command); F provides varied colors for different property curves on property diagrams (after a STEP command). The option N (NONE) disables all curve labels and lists. If, for example, you use T (temperature in K) as the variable axis in a STEP command and then plot the amount of stable phases (with "SET_DIAGRAM_AXIS" on page 259 Y NP (*)) on the Y-axis versus T-C on the X-axis, then the list may have lines like:
|          | 1: T-273.15, NP(LIQUID) |
|          | 2: T-273.15, NP(FCC_A1) |
|          | This means that for curve 1 the X-axis is T-273.15 (the same for all curves, of course) and NP(LIQUID) on the Y-axis. Curve 2 has the same X-axis but NP(FCC_A1) on the Y-axis. |

### SET_PLOT_FORMAT

Set the format of the graphical output to different graphical devices. The default graphic device is normally for screen output (number 22 - TCUNITE Driver). Legacy devices can still be used (1 for Windows and 9 for XWindow for Linux). This default graphic device value may also be altered with "SET_PLOT_ENVIRONMENT" on page 303 in the system monitor or by your TC.INI file.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_PLOT_FORMAT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Graphic device number /#/: &lt;Number of the device&gt;</td>
</tr>
<tr>
<td></td>
<td>Specify a graphic device number. Depending on the hardware, different plot formats (graphic devices) may be available. These are listed online by giving a question mark ?.</td>
</tr>
<tr>
<td></td>
<td>For some formats there can be additional sub-prompts, asking for if using (YES) or not using (NO) the fonts available for the chosen format, and if YES for further specifications, e.g. font type and size.</td>
</tr>
</tbody>
</table>

### SET_PLOT_OPTIONS

You are prompted for and can toggle on (Y) or off (N) the plotting of some options on all subsequently generated diagrams.
For the **Always initiate POST on re-entering** prompt, the default is Y which implies that the POST module automatically reinitiates whenever the POLY3 workspace is changed upon re-entering. If answered N the same diagram axis variables are kept even if the workspaces in the POLY module are read from or written to an *.POLY3 file. The N answer is useful when there are several sets of *.POLY3 files with the same calculation but for different sets of model parameters.

For the **Always solid line** prompt, the default answer is N which means that the POST module plots solid lines for stable phases but dashed lines for metastable phases. This is normally for plotting property diagram after a STEPPING calculation; however, when there is a metastable extrapolation in a phase region on a phase diagram after a MAPPING calculation, this is also enforced. When the alternative answer Y is chosen, all the lines are always plotted in solid lines.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_PLOT_OPTIONS</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Plot header /Y/: &lt;Y or N</strong></td>
</tr>
<tr>
<td></td>
<td>Toggle the plotting of the Thermo-Calc header text above a diagram.</td>
</tr>
<tr>
<td></td>
<td><strong>Plot logo /Y/: &lt;Y or N</strong></td>
</tr>
<tr>
<td></td>
<td>Toggle the plotting of the Thermo-Calc logotype at the lower-left corner of a diagram.</td>
</tr>
<tr>
<td></td>
<td><strong>Plot footer /Y/: &lt;Y or N</strong></td>
</tr>
<tr>
<td></td>
<td>Toggle the plotting of the footer identifier text at the right margin of a diagram.</td>
</tr>
<tr>
<td></td>
<td><strong>White-Contoured-PS-CHARS /Y/: &lt;Y or N</strong></td>
</tr>
<tr>
<td></td>
<td>This makes it possible to write PostScript characters in white contoured status.</td>
</tr>
<tr>
<td></td>
<td><strong>Plot remote exponent(s) /Y/: &lt;Y or N</strong></td>
</tr>
<tr>
<td></td>
<td>This sets (Y) or removes (N) the plotting of the remote exponent on the axis.</td>
</tr>
<tr>
<td></td>
<td><strong>Plot symbols at node points /0/: &lt;#</strong></td>
</tr>
<tr>
<td></td>
<td>This makes it possible to plot symbols at the node points on plotted lines on a diagram.</td>
</tr>
<tr>
<td></td>
<td><strong>Symbol size /.1/: &lt;.#</strong></td>
</tr>
<tr>
<td></td>
<td>Set the size of symbols which are plotted at the node points.</td>
</tr>
</tbody>
</table>
### SET_PLOT_OPTIONS

**Write condition? /Y/: <Y or N>**

The initial equilibrium conditions for the current calculations are automatically plotted at the upper-left corner as a part of the header. With this option switched off (by answering N), it makes possible to not write the calculated conditions on a plotted diagram.

**Write database name? /Y/: <Y or N>**

Primary database (not the appended ones) used in the current calculations are automatically plotted at the upper-left corner as a part of the header. With this option switched off (by answering N), it makes possible to not write the database name on a plotted diagram.

**Always initiate POST on re-entering: /Y/: <Y or N>**

Y lets the POST module automatically reinitiate whenever the POLY3 workspaces are changed upon re-entering. If answered N, the same diagram axis variables are kept even if the workspaces in the POLY module is read from or written to an *.POLY3 file. Answering N is useful when there are several sets of *.POLY3 files with the same calculation but for different set of model parameters.

**Always solid line: /N/: <Y or N>**

N allows the POST module to plot solid lines for stable phases but dashed lines for metastable phases. This is normally for plotting property diagram after a STEPPING calculation; however, when there is a metastable extrapolation in a phase region on a phase diagram after a MAPPING calculation, this is also enforced. When answered Y all the lines are always plotted in solid lines.

### SET_PLOT_SIZE

Change the size of the diagram by specifying a global plot size (as a relative scaling factor). The default value of the relative scaling factor is 1, while the real size of the plotted diagram depends on what output device is chosen with "SET_PLOT_FORMAT" on page 264. The default plot size (corresponding to the default global plot size 1) is adjusted to the chosen device.
Syntax  SET_PLOT_SIZE

Prompt  Global plot size /1/: <Relative scaling factor>
        Enter the relative scaling factor as a numerical number (e.g. 0.5, 0.8, 1.0, 1.5, etc.). By pressing <Enter>, the default relative scaling factor (1) is accepted.

SET_PREFIX_SCALING

Set the prefix scaling of remote exponents with certain powers (default is 3), by taking as argument with an axis name and a YES, or NO, or an integer number # (as the powers for the remote exponents):

NO switches off its action.

YES arranges the prefix scaling so that the axis scaling is done with the remote exponents being powers of three, i.e. ..., -6, -3, 0, 3, 6, ...

# sets the remote exponents as being powers of #.

Syntax  SET_PREFIX_SCALING

Prompt  Axis (X, Y or Z): <Name of an axis>
        Specify which axis is to have a prefix scaling.
        Use prefix scaling /Y/: (Y or N or #)
        Answer either Y or N or an integer number as described above.

SET_RASTER_STATUS

Plot a raster (i.e. with gridlines on both axis directions) in the diagram. The default status is no raster plotted.

Syntax  SET_RASTER_STATUS

Prompt  Raster plot (Y or N) /N/: <Y or N>
        Enable (Y) or disable (N) the raster plot.

SET_REFERENCE_STATE

The reference state for a component is important when calculating activities, chemical potentials and enthalpies. After calculating with "STEP_WITH_OPTIONS" on page 227 or "MAP" on page 212, the reference state for a component can also be changed for plotting.
various properties of the component in the entire system or in a specific phase by using this command. Afterwards, you can set diagram axes as chemical potential or activity quantities with the R suffix, i.e. MUR(comp), MUR(comp,ph), ACR(comp), ACR(comp,ph) or their common logarithms [e.g. LNACR(comp,ph)].

**Syntax**

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_REFERENCE_STATE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Component:</td>
<td>&lt;Name of the component&gt;</td>
</tr>
<tr>
<td>The name of the component must be given.</td>
<td></td>
</tr>
<tr>
<td>Reference state:</td>
<td>&lt;Name of a phase used as the new reference state&gt;</td>
</tr>
<tr>
<td>The name of a phase, that must be either ENTERED, DORMANT or SUSPENDED, is given here. The component must, of course, be a constituent of this phase.</td>
<td></td>
</tr>
<tr>
<td>A subtle problem is that if the component exists in several species in the phase, for example, oxygen as O, O2 and O3 in a gas. Normally, you would like to have the most stable species as reference state of oxygen, i.e. O2 in this case. When setting the reference state, a one-time calculation is made for the Gibbs energy. This is for all possible states with the pure component phase at the current temperature and the command selects the most stable one as the reference state.</td>
<td></td>
</tr>
<tr>
<td>Temperature <em>/</em>:</td>
<td>&lt;Reference temperature&gt;</td>
</tr>
<tr>
<td>Select the temperature (in K) for the reference state. The value * means the current temperature is used for the calculation.</td>
<td></td>
</tr>
<tr>
<td>Pressure /1E5/:</td>
<td>&lt;Reference pressure&gt;</td>
</tr>
<tr>
<td>Select the pressure (in Pa) for the reference state. The value * means the current pressure is used for the calculation.</td>
<td></td>
</tr>
</tbody>
</table>

**SET_SCALING_STATUS**

When an axis variable is selected by "SET_DIAGRAM_AXIS" on page 259, the scaling status for the axis is always set to automatic scaling. By this command, choose between manual or automatic scaling on a specified axis. If manual scaling is chosen, specify a minimum and a maximum value. Manual scaling can be used to magnify interesting parts of a diagram.
### SET_SCALING_STATUS

**Syntax**

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_SCALING_STATUS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompts</td>
<td>Axis (X, Y or Z): &lt;Name of an axis&gt;</td>
</tr>
<tr>
<td></td>
<td>Specify which axis that you want to set the scaling status.</td>
</tr>
<tr>
<td></td>
<td>Automatic scaling (Y or N) /N/: &lt;Y or N&gt;</td>
</tr>
<tr>
<td></td>
<td>Choose between automatic (Y) and manual scaling (N). For manual scaling specify these parameters:</td>
</tr>
<tr>
<td></td>
<td>Min value: &lt;Minimum value&gt;</td>
</tr>
<tr>
<td></td>
<td>The minimum value at the start point of the specified axis.</td>
</tr>
<tr>
<td></td>
<td>Max value: &lt;Maximum value&gt;</td>
</tr>
<tr>
<td></td>
<td>The maximum value at the end point of the specified axis.</td>
</tr>
</tbody>
</table>

### SET_TIC_TYPE

Change the drawing of the axis tics. You may alter the placement of tic marks on the axis, e.g. inside or outside or no tic marks. The size of tic marks cannot be altered by this command, but these are adjusted based on the selected graphic device and the defined relative scaling factor (global plot size).

**Syntax**

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_TIC_TYPE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>TIC Type /1/: &lt;1 or -1 or 0&gt;</td>
</tr>
<tr>
<td></td>
<td>The tic type 1 is default, i.e. the tics are drawn outside the diagram. -1 means that the tics are inside the diagram and 0 means no tics.</td>
</tr>
</tbody>
</table>

### SET_TIELINE_STATUS

If the tie-lines are in the plane of the calculation, you can select to plot the tie-lines in two-phase fields with this command.

**Syntax**

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_TIELINE_STATUS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Plotting every tie-line no. /0/: &lt;Number of tie-lines&gt;</td>
</tr>
<tr>
<td></td>
<td>The tie-lines plotted are not equally spaced by the graphics software. Instead, you can select to plot a subset of the calculated tie-lines, i.e. every one (1), every second (2), every three (3), etc. By accepting the default value 0, no tie-line is plotted.</td>
</tr>
</tbody>
</table>
**SET_TITLE**

Specify a title that displays on all listed tables and plotted diagrams from the POST module in the same run of Console Mode.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_TITLE</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Ttitle &lt;Title&gt;</td>
</tr>
<tr>
<td>Prompt</td>
<td>Enter the title you want to appear on all tabulation or graphic outputs.</td>
</tr>
<tr>
<td></td>
<td>There is a maximum length of about 60 characters for the title. You can enter simple text, use LaTeX, rotate the text, as well as adjust the font size.</td>
</tr>
<tr>
<td></td>
<td>Also see &quot;ADD_LABEL_TEXT&quot; on page 243.</td>
</tr>
</tbody>
</table>

**SET_TRUE_MANUAL_SCALING**

The tic-marks on the axes are normally placed in even intervals using the whole axis length. The scaling routine adjusts the given minimum and maximum values slightly to accomplish this. If such an automatic adjustment behaviour is unwanted, it can be avoided by using this command (followed by a message showing the TRUE MANUAL SCALING set for a specific axis).

The command works like a toggle. To reset the automatic scaling behaviour, repeat the command a second time for that specific axis (followed by a message saying the SEMI_MANUAL_SCALING set for the specific axis).

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_TRUE_MANUAL_SCALING</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Axis (X, Y or Z): &lt;Name of an axis&gt;</td>
</tr>
<tr>
<td>Prompt</td>
<td>Specify which axis (X or Y or Z) you want to toggle between automatic adjustments or avoid the adjustment of the given maximum and minimum values.</td>
</tr>
</tbody>
</table>

**SUSPEND_PHASE_IN_PLOT**

Specify that lines originating from the presence of a certain phase shall not be plotted on a diagram. If you want to bring the suspended phase back to the diagram, use "RESTORE_PHASE_IN_PLOT" on page 255.
SUSPEND_PHASE_IN_PLOT

Phase name: <Name of a phase>
Specify the name of the phase to be suspended from the diagram.

TABULATE

For any entered table, this command gives a table of values from equilibria calculated with a STEP command. It works only for a table that is entered in either the POLY or POST module.

Unlike the TAB module's command (also called "TABULATE" on page 315) it is not possible to plot columns from the tabulated tables. For this use normal POST commands.

Syntax | TABULATE
--- | ---
Prompt | Name: <Name of a table entered in either POLY or POST>
Specify a table name that is entered in either the POLY or POST module.

Output on screen or file /Screen/: <File name or return>
Specify a file name if you want to save on a file the table values along the defined STEP calculation, or press <Enter> if want to see the table values displayed.
POTENTIAL_DIAGRAM Module

In this section:

POTENTIAL_DIAGRAM ................................................................. 273
POTENTIAL_DIAGRAM

The POTENTIAL_DIAGRAM module (short name, the POTENTIAL module) is a potential phase diagram calculation module.

If you have a metal-oxide/sulphide-gas interaction system, you might want to calculate a so-called potential phase diagram given certain temperature and pressure. A potential diagram uses the activities of two major species in the gaseous mixture phase as mapping variables. The activities (that is, the fugacities at 1 bar) of these two species are typically set as the X- and Y-axis when the diagram is plotted. The phase relations between the gaseous mixture and various metal forms, metal-oxides, metal-sulphides, or other metal-bearing solids, are represented by different fields controlled by these two potential quantities.

To enter the module, at the SYS prompt type GOTO_MODULE POTENTIAL.

There are no commands for this module. Follow the prompts and see "About Potential Diagrams" on page 190 in the Thermo-Calc User Guide for details about how to calculate using potential diagrams.

See example tcex35 in the Thermo-Calc Console Mode Examples Guide.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>POTENTIAL_DIAGRAM</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompts</td>
<td>Database: /POT/</td>
</tr>
<tr>
<td></td>
<td>Press &lt;Enter&gt; and the program lists the available databases. Type one of the database names and press &lt;Enter&gt; to select. The following default elements are then based on the chosen database.</td>
</tr>
<tr>
<td></td>
<td>Matrix element: /Fe/</td>
</tr>
<tr>
<td></td>
<td>First potential species: /S1O2/</td>
</tr>
<tr>
<td></td>
<td>Second potential species: /O2/</td>
</tr>
<tr>
<td></td>
<td>Temperature: /1000/</td>
</tr>
</tbody>
</table>
POURBAIX_DIAGRAM Commands

Also search the online help or see the Pourbaix diagrams educational material and the Thermo-Calc User Guide.

In this section:

- POURBAIX_DIAGRAM Commands ......................................................... 275
- Pause Options ..................................................................................... 277
POURBAIX_DIAGRAM Commands

Also search the online help or see the Pourbaix diagrams educational material and the Thermo-Calc User Guide.

See examples tcex40 and tcex53 in the Thermo-Calc Console Mode Examples Guide.

After you enter the POURBAIX_DIAGRAM module, you are prompted with the following:

Need any instruction on the Pourbaix module? /N/:Y

If you answer \texttt{Y} the following notes are displayed.

- The Pourbaix diagram is actually a calculated equilibrium phase diagram mapped and plotted with the independently-varied electropotential (Eh, as defined with regard to the standard hydrogen electrode as its reference) and acidity (pH), that represents all the equilibrated phase boundaries among aqueous solution, gaseous mixture, and various primary and secondary solids (modelled as either complex solution or simple stoichiometric phases) in a certain multicomponent heterogeneous interaction system, under a defined T-P condition and a specific initial bulk composition (which is, by default, always set as 1 kg of water dissolving a specified amount of metals/ alloys and other acids/alkalines/salts).

- At least one database is required that contains an AQUEOUS solution phase (with thermodynamic data for water and various aqueous solutes), that shall be selected from TCAQ (PAQ) or AQS (PAQS) [which use the SIT Model or the Complete Revised HKF Model, respectively] within the Thermo-Calc database spectrum, or be chosen from an appropriate USER-specified database (it must be in the Thermo-Calc TDB format).

- Due to the restrictions of aqueous solution model used within Thermo-Calc, such a database must be designed in the same format as in the default TCAQ (PAQ) or AQS (PAQS) for AQUEOUS solution phase. Among others, one should keep in mind the following regulations:
  - The ELECTRON is defined as an special element (ZE) and as the only constituent in its reference phase REFERENCE_ELECTRODE (for determining the electro-potential that is defined as Eh with the standard hydrogen electrode as the reference), but it is not defined as an aqueous species;
  - The vacancy (VA) is unnecessary for AQUEOUS solution phase and it should be avoided in the definition of phase-constituents in the AQUEOUS phase;
  - The AQUEOUS solution phase should always be defined as a constitutional solution phase, implying that all the aqueous solution species must be included in a single
site, rather than in two or multiple sublattices.

- Beside the AQUEOUS solution phase, there shall exist a GAS mixture phase containing at least H2O1, O2 and H2; and for multicomponent systems, normally there shall also contain some solid (stoichiometric or solution) phases. Of course, if desired, you could also choose to calculate and generate a Pourbaix diagram without considering the GAS mixture phase entirely; however, such a plot is not really a complete Pourbaix diagram, due to the fact that thermodynamically-stable phase boundaries between the AQUEOUS solution phase and GAS mixture phase will then not be calculated at all!

- All the required thermodynamic data for calculations of Pourbaix diagrams or other diagrams must be retrieved either from one (Single) database which consists of an AQUEOUS solution phase, a GASeous mixture phase, a REF_ELECTRODE phase, and some SOLID phases (being solutions and/or stoichiometric compounds; for primary metals/ alloys and for secondary products formed from heterogeneous chemical/electrochemical interactions, or from several (Multiple) databases that respectively contain various solutions/compounds (as listed above).

Such databases suitable for calculations of aqueous-bearing heterogeneous interaction systems can be those default-prompted ones [i.e., in the Single-Database case, the PAQ or PAQS; and in the Multiple-Database case, the TCAQ or AQS as primarily-switched database, plus the SSUBx as firstly-appended one and the SSOLx as secondly-appended one if it is necessary; even more databases can be appended). Of course, you could also choose to append required data from other appropriate databases (such as TCFE, TCSLD, TCNI/TTNi, TCAL/TTAI, TCMG/TTMg, TTZr, TCMP, SLAG, etc.) for GASeous mixture phase and for various solid solution and stoichiometric compound phases. Furthermore, an experienced user can also utilize his/her own USER-specified databases in various cases.

- The current advanced POURBAIX-Module has been designed and developed in an efficient and effective way that it only requires the user to just answer some simple and necessary questions, rather than to go through basic modules (i.e., TDB, GES5, POLY3 and POST) and type the ordinary command-lines. Beside the default plotted Pourbaix diagram, it also allows the user to easily and quickly plot many different properties of the system, stable phases and aqueous species, varied along the calculated phase boundaries for the same defined heterogeneous interaction system. Moreover, it permits the user to directly change some plotting settings and manipulate all kinds of plotted diagrams.

- The current advanced POURBAIX-Module has been extended so that it is additionally able to directly perform a normal STEPPING calculation (varied with a specified independent variable) and to easily generate various types of property diagrams, for
the same heterogeneous interaction system that has been defined in a previous POURBAIX or TDB-GESS-PLOY3-POST calculation.

**Pause Options**

After this information is displayed, you are prompted:

Enforce a PAUSE after plotting when running a MACRO? /N/: 

If you answer Y the following options are displayed.

1. Start a completely new Pourbaix diagram calculation
2. Open an old file & plot other property diagrams
3. Open an old file & make another Pourbaix calculation
4. Open an old file & make another stepping calculation

**Option 1: Start a completely new Pourbaix diagram calculation**

Make a completely new POURBAIX diagram calculation and automatically plot a pH-Eh diagram. i.e., define a new chemical system; specify the T-P-X conditions; calculate the initial equilibria; perform the pH-Eh mapping calculation; plot pH-Eh & various property diagrams.

Consider the GAS phase in calculating a Pourbaix diagram? /Y/ 

Use single database? /Y/: 

Combined database: /PAQ2/: 

**DEFINE A CHEMICAL SYSTEM AND ITS INITIAL BULK COMPOSITION:**

Normally a Pourbaix diagram and related equilibrium property in a heterogeneous interaction system are calculated under a certain bulk composition which is usually 1 kg of water with defined amounts of dissolving solute substances. The solutes may either be completely dissolved into the aqueous solution, or be partially dissolved and simultaneously form some solid phases.

**CHEMICAL SYSTEM (ELEMENTS):**

Default defined elements (solvent H2O): H & O and specially assigned ZE(electron) & VA (vacancy).

Prompt specified elements (solutes ELEM): Fe Ni Co Cr C N S Na Cl

**INITIAL BULK COMPOSITION:** Default defined composition (solvent): 1.0 kg of H2O

Prompt specified composition (solutes): x mole of ELEM
Notes: For accepting a default value, just RETURN at prompt;
For changing to a specific value, enter it at prompt.

IMPORTANT NOTE for Entering Solutes in Chemical Formulas:
First element letter in UPPER case, and second lower case! such as NaCl CO2 CoCl3 Fe0.93S NaSO4-1 H2SO4

Mass of Water (weight) = 1 kg

**Option 2: Open an old file and plot other property diagrams**

Open an existing POLY3 file created by POURBAIX Module (from a previous POURBAIX calculation Option 1 or 3 or a previous STEPPING calculation Option 4), and just selectively plot other property diagrams. i.e., open the old GES and POLY3 workspaces; plot pH-Eh or various property diagrams.

File name /Pourbaix/
X-axis Variable: /PH/: 
Y-axis Variable: /EH/: 
Change axis type? /N/: 
Zoom in? /N/: 
Change curve-label option for the diagram? /N/: 
Add label-texts onto the specified diagram? /N/: 
Change the subtitle of the diagram? /N/: 
Change axis-texts? /N/: 
Further refine the diagram in POST module? /N/: 
Hard copy of the diagram? /N/: 
Save X-Y coordinates of curve on text file? /N/: 
Modify the diagram? /N/: 
Any more diagram? /N/: 

**Option 3: Open an old file and make another POURBAIX calculation**

Open an existing POLY3 file created by POURBAIX Module and make another POURBAIX diagram calculation i.e., open the old GES and POLY3 workspaces; adopt the defined chemical system; modify the T-P-X conditions; calculate the initial equilibria; perform the
pH-Eh mapping calculation; plot pH-Eh & various property diagrams.
Consider the GAS phase in calculating a Pourbaix diagram? /Y/: 
File name /C:\Users\hilary\DOCUME~1\POURBA~1.POL/: 
Enforce Global Minimization Technique in calculations? /N/: 
Save all functions, variables and tables in POLY3 file? /Y/: 
Set numerical limits? /N/: 
Set calculating parameters: 
List of default and pre-defined calculation conditions: 
Units: T in K, P in Pascal, B(H2O) in gram, N(ELEM) in mole 
T=298.15, P=1E5, B(H2O)=1000, N(H+1)=0, N(ZE)=0 
Degrees of freedom 0 
Confirm defined conditions? /Y/: 

Additional Information About Option 3
The default definitions of the Eh and pH quantities in the advanced POURBAIX-Module (and in the ordinary TDB-GES-POLY calculation routines) should ALWAYS be as below:

\[
\begin{align*}
\text{Eh} &= \text{MUR(ZE)}/\text{RNF} \\
\text{pH} &= -\log_{10}[\text{AI(H+1,AQUEOUS)}] \\
&= -\log_{10}[\text{ACR(H+1,AQUEOUS)\cdot AH2O}]
\end{align*}
\]

where RNF is the Faraday constant (96485.309 C/mol), and AH2O is the molecular weight of H2O (55.508435 g). MUR(ZE) is the electrochemical potential (ECP; in the unit of J/mol; w.r.t. the standard hydrogen electrode). ACR(H+1,AQUEOUS) is the site-fraction-based activity of the H+1 aqueous species in AQUEOUS solution phase, but AI(H+1,AQUEOUS) [that equals ACR(H+1,AQUEOUS)*AH2O] is the molality-based activity of the H+1 aqueous species that should be used for defining the pH quantity.

Within an aqueous-bearing heterogeneous interaction system, the fundamental system-components must be H2O, H+1 and ZE, which are corresponding to the basic elements O & H and the hypothetical electron (ZE) in the aqueous solution phase. For the additional chemical elements in the system, their corresponding system-components shall be defined as in their element forms (such as Fe, Cr, Mn, Ni, Na, Cl, S) or (for some) in their molecular forms (e.g., NaCl, H2S). The reference state for the H2O component must always be defined as the solvent species H2O in the AQUEOUS solution phase under the current temperature (*) and 100000 Pascal (i.e., 1 bar). The reference states for the H+1 and ZE components are by default set as their SER.
Various conventional properties of aqueous solute species I are converted in the following manners:

\[
ML = Y(AQUEOUS,I) \times AH2O/YH2O \\
RC = ACR(I,AQUEOUS) \times YH2O/Y(AQUEOUS,I) \\
AI = RC \times ML = ACR(I,AQUEOUS) \times AH2O
\]

where YH2O [i.e., \( Y(AQUEOUS,H2O) \)] and Y(AQUEOUS,I) are the site-fractions of solvent H2O and solute species I.

**LIST THE DEFINED AXIS-VARIABLES:**

- **Axis No 1:** LNACR(H+1)  
  **Min:** -34.532525  
  **Max:** 2.3025851  
  **Inc:** 0.8

- **Axis No 2:** MUR(ZE)  
  **Min:** -150000  
  **Max:** 200000  
  **Inc:** 7718.85

**NOTE:** The default settings (listed above) for two mapping variables [in terms of lnACR(H+1) and MUR(ZE), and their minimum/maximum values and increment steps] are covering the following pH-Eh ranges/steps:

- **pH:** 0.00 -> 14.00, at a step of 0.35
- **Eh:** -1.55 -> 2.07, at a step of 0.08 (V)

The maximum pH limit has been calculated precisely and determined automatically by the POURBAIX-Module, as a function of the temperature-pressure conditions and initial bulk compositions of the current defined interaction system.

Accept the default settings for two mapping variables? /Y/: 

Any missing phase boundary you could possibly think of? /N/: 

Change the pH/Eh steps for smoother curves? /N/: 

Zoom in? /N/: 

Change curve-label option for the diagram? /N/: 

Add label-texts onto the Pourbaix diagram? /N/: 

Change the subtitle of the diagram? /N/: 

Change axis-texts? /N/: 

Further refine the diagram in POST module? /N/: 

Hard copy of the diagram? /N/: 

Save X-Y coordinates of curve on text file? /N/: 

Modify the diagram? /N/: 

Any more diagram? /N/:
**Option 4: Open an old file and make another STEPPING calculation**

Open an existing POLY3 file created by POURBAIX Module (from a previous POURBAIX calculation Option 1 or 3 or a previous STEPPING calculation Option 4), and make a normal STEPPING calculation. i.e., open the old GES and POLY3 workspaces; adopt the defined chemical system; specify one of the T-P-X conditions as the stepping variable; calculate the initial equilibria; perform the stepping calculation; plot various property diagrams.

Because of that in a STEPPING calculation will change some system definitions in a POURBAIX-type POLY3 file, it is highly advisable to make a backup of the existing POURBAIX-type POLY3 file (which you are going to open in this STEPPING calculation) before you proceed the further steps; otherwise, the structure of the loaded POLY3 file will be alternated by the option "4", and consequently the existing POLY3 file may be not suitable for other POURBAIX-type calculation any longer. Therefore, if you have not done so, you should make the copy right now!

However, a POLY3 file which is modified by this option can be further used for another STEPPING calculation inside the POURBAIX Module (by a repeated Option 4) or in normal POLY3 Module.

File name /C:\Users\hilary\DOCUME~1\POURBA~1.POL/:
Enforce Global Minimization Technique in calculations? /N/:
Save all functions, variables and tables in POLY3 file? /Y/:
Set numerical limits? /N/:
   Set calculating parameters:
      List of Default and Pre-defined Calculation Conditions:
      ----------------------------------------------------------------------
      Units: T in K, P in Pascal, B(H2O) in gram, N(ELEM) in mole
      ----------------------------------------------------------------------
      T=298.15, P=1E5, B(H2O)=1000, N(H+1)=0, N(ZE)=0
      DEGREES OF FREEDOM 0
Further modify system definitions & conditions in POLY3 module? /N/:
Confirm defined conditions as the starting point? /Y/:

The following parameters are suitable for a STEPPING calculation for the defined aqueous-bearing system. Choose one of them as the stepping variable:

- T Temperature (C)
- P Pressure (bar)
- pH Acidity
Eh Electronic Potential (V)

\[ N(\text{Comp}) \text{ Mole of One Component} \]

where "Comp" is the name of a specific component as listed below. One should not use any key component (H2O or H+1 or ZE) as such a stepping variable, because of that their compositional definitions and variations are determined by the AQUEOUS solution phase in the POURBAIX Module.

An interacting component defined as an element (such as Fe or Na or Cl) can be selected as a stepping variable.

However, if you want to make a stepping calculation with a non-element chemical formula (such as NaCl or CaS2) as the stepping variable, one must have made some necessary modifications in the POLY3 Module, before reaching this point, by conducting some POLY3 commands as given below (as an example for the system Fe-Na-Cl-H-O):

```plaintext
POLY_3: def-component H2O H+1 ZE Fe NaCl Cl
POLY_3: set-ref-state H2O AQUEOUS * 1E5
POLY_3: set-ref-state ZE REF_ELEC * 1E5
POLY_3: change-status phase REF-ELEC=SUSPEND
POLY_3: set-cond b(H2O)=1000 n(H+1)=0 n(ZE)=0
POLY_3: set-cond P=1E5 T=298.15**
POLY_3: set-cond n(Fe)=1E-3 n(Cl)=0 n(NaCl)=3 **
```

** Here the P-T-n(Fe) conditions can be set as what you wanted, while the initial n(NaCl) value must be set as between its minimum and maximum values that you are interested in. Later on, it will be prompted for specifying the n(NaCl) Min-Max-Step values of the stepping calculation.

Stepping variable: /T/:
Minimum temperature (C) /15/:
Maximum temperature (C) /35/:
Increment in temperature (C) /1/:
Change axis type? /N/:
Zoom in? /N/:
Change curve-label option for the diagram? /N/:
Add label-texts onto the specified diagram? /N/:
Change the subtitle of the diagram? /N/:
Change axis-texts? /N/:
Further refine the diagram in POST module? /N/:
Hard copy of the diagram? /N/: 
Save X-Y coordinates of curve on text file? /N/: 
Modify the diagram? /N/: 
Any more diagram? /N/:
REACTOR_SIMULATOR_3 Commands

In this section:

CREATE_DIVIDERS ................................................................. 285
CREATEPIPES ................................................................. 285
CREATE_STAGE_BOXES ................................................................. 286
EXECUTE_POLY3_COMMAND ................................................................. 288
LIST_RECORDS ................................................................. 288
READ_WORKSPACE ................................................................. 288
SAVE_WORKSPACE ................................................................. 289
START_SIMULATION ................................................................. 290
CREATE_DIVIDERS

This is a command used with the REACTOR module.

Define the segment boundaries and the ways on how to distribute phases between various segments and to split the feeds of heat and mass.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>CREATE_DIVIDERS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompts</td>
<td>Number of dividers /4/: &lt;The number of dividers&gt;</td>
</tr>
<tr>
<td></td>
<td>Specify the number of dividers (boundaries between various segments) in the reactor. It is normally the segment number plus one: for example, if the stage box number is defined as 4, the divider number should be defined as 5.</td>
</tr>
<tr>
<td></td>
<td>Number of outputs for divider # /3/: &lt;The number of outputs&gt;</td>
</tr>
<tr>
<td></td>
<td>Specify the number of outputs for a specific divider #.</td>
</tr>
<tr>
<td></td>
<td>Percent of input to output 1 /100/: &lt;Percent of input&gt;</td>
</tr>
<tr>
<td></td>
<td>Define the percentage of input to the output 1 in the current divider #.</td>
</tr>
<tr>
<td></td>
<td>Percent of input to output ## /100/: &lt;Percent(s) of input(s)&gt;</td>
</tr>
<tr>
<td></td>
<td>Define the percentages of inputs to the outputs ## in the current divider #. It is repeated till the last output is specified.</td>
</tr>
</tbody>
</table>

CREATEPIPES

This is a command used with the REACTOR module.

Define the pipes between various segments and the ways on how the mass and heat transport between the surroundings (with the record number as 0) and the reactor, among various segments in the reactor, and along various dividers (segment boundaries in the reactor).
**CREATE_PIPES**

Syntax: `CREATE_PIPES`

From record: `<A record number>`

Specify a record number. If there are four segments in the reactor, these records are available:

- 0 surroundings
- 1-4 stage boxes (segments)
- 5-9 dividers (segment boundaries)

Pipe to record: `<Another record number>`

Specify another record number to which the mass or heat flows from the current record (specified above). Before this prompt, a message shown on the screen indicates what kind of mass or heat flow (according to the definitions of stage boxes and dividers, which have already been created prior to this command) should be specified in the pipe. This is repeated for all inputs and/or outputs for mass and/or heat in current record.

**CREATE_STAGE_BOXES**

This is a command used with the REACTOR module.

Create several reaction stages as boxes (segments), where the you define the feed in either mass input and initial temperature or heat input from surroundings, as well as the mass out and initial temperature in each of the segments.

Syntax: `CREATE_STAGE_BOXES`

Number of stage boxes /4/: `<The number of stage boxes>`

Specify the number of stage boxes in the reactor. Then define the feed of mass and/or energy (from surroundings to) the reactor.

Give feed to system: `<Feed>`

One feed (of mass or heat) to the reactor must be specified here. Two types of feeds can be used:

- As input amount of heat (enthalpy): `H=Value`.
- As input amount of specific species or element and its initial temperature: `N(SPECIES)=Value`, `Input temperature (in one line, or the input temperature in the next prompt)`.
<table>
<thead>
<tr>
<th>Syntax</th>
<th>CREATE_STAGE_BOXES</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input temperature /298.15/: &lt;Input temperature&gt;</td>
<td></td>
</tr>
<tr>
<td>Give feed to system: &lt;Feed&gt;</td>
<td></td>
</tr>
<tr>
<td>Specify other feeds (mass or energy) to the reactor. Press &lt;Enter&gt; to finish the feed inputs, and then:</td>
<td></td>
</tr>
<tr>
<td>Give for stage box #</td>
<td></td>
</tr>
<tr>
<td>Now start to define the type of stage box (segment is specifically numbered as #), and to specify a guess of initial temperature and an output for each phase in the segment.</td>
<td></td>
</tr>
<tr>
<td>Type of box/Equilibrium/: &lt;Type of box&gt;</td>
<td></td>
</tr>
<tr>
<td>Only the EQUILIBRIUM type is allowed. Press &lt;Enter&gt; to accept it.</td>
<td></td>
</tr>
<tr>
<td>Is the stage heat controlled? /Y/: &lt;Yes or No&gt;</td>
<td></td>
</tr>
<tr>
<td>Y means the current segment is heat controlled.</td>
<td></td>
</tr>
<tr>
<td>Initial guess of temperature? /1000/: &lt;Initial temperature&gt;</td>
<td></td>
</tr>
<tr>
<td>Give a guess of initial temperature (in K) for the current segment; press &lt;Enter&gt; to accept the default.</td>
<td></td>
</tr>
<tr>
<td>Give initial amount: &lt;Initial amount of mass or heat&gt;</td>
<td></td>
</tr>
<tr>
<td>The initial amount of mass and/or heat in the current segment can be specified here. Two types of initial amount can be used:</td>
<td></td>
</tr>
<tr>
<td>• As initial amount of heat (enthalpy): H=Value.</td>
<td></td>
</tr>
<tr>
<td>• As initial amount of specific species or element and its initial temperature: N(SPECIES)=Value, Input temperature (in one line, or the input temperature in the next prompt).</td>
<td></td>
</tr>
<tr>
<td>Input temperature /298.15/: &lt;Input temperature&gt;</td>
<td></td>
</tr>
<tr>
<td>Give initial amount: &lt;Initial amount of mass or heat&gt;</td>
<td></td>
</tr>
<tr>
<td>Specify initial amount (mass or energy) in the current segment. Press &lt;Enter&gt; to finish the initial amount inputs, and then this message displays:</td>
<td></td>
</tr>
<tr>
<td>Each phase may have a separate output, give these</td>
<td></td>
</tr>
<tr>
<td>Now start to define the output for each phase.</td>
<td></td>
</tr>
<tr>
<td>Phase name /Rest/: &lt;Name of phase&gt;</td>
<td></td>
</tr>
</tbody>
</table>
**Syntax** | **CREATE_STAGE_BOXES**  
--- | ---  
Specify a phase that has a separate output, e.g. GAS; by pressing <Enter> to accept that all REST phases do not have separate outputs. Then the program asks for further definitions of all the other segments (one by one), repeating some of the above questions, till the last segment in the reactor is defined.

---  
**EXECUTE_POLY3_COMMAND**

This is a command used with the REACTOR module.

**Syntax** | **EXECUTE_POLY3_COMMAND**  
--- | ---  
To directly use all kinds of POLY commands inside the REACTOR module. Any legal "Equilibrium Calculations with the POLY_3 Module" on page 163 can be entered.

---  
**LIST_RECORDS**

This is a REACTOR_SIMULATOR_3 module command.

**Syntax** | **LIST_RECORDS**  
--- | ---  
Lists all the already-created records for the reactor (including stage boxes, dividers, pipes, etc.).

---  
**READ_WORKSPACE**

This is a command used with the REACTOR module.

The REACTOR workspace (along with the related POLY3 and GIBBS workspaces) and the simulated results from the SIMULATE command can be read by this command from a binary file where they must be saved with "SAVE_WORKSPACE" on the next page. The *.RCT file is not printable.
**Syntax** | **READ_WORKSPACE**
---|---

**Options**

File name: The name of a saved *.RCT file where the REACTOR and POLY3/GIBBS workspaces shall be read from must be specified. You do not need to type the extension if it is the default .RCT, otherwise type the whole *.RCT file name.

An Open window displays if a file name is not given after the command or its path is incorrect, so that the path (in the Look in field) and File name can be specified. The **Files of type** (i.e. RCT) cannot be changed.

---

**SAVE_WORKSPACE**

This command is for the POLY3, GES (GIBBS), and REACTOR_SIMULATOR_3 modules.

The REACTOR (and POLY3/GIBBS) workspaces are saved on a file with this command. In the GIBBS workspace, all thermochemical data are stored. In the POLY3 workspace, all thermochemical data, all conditions, changed status, entered symbols, etc., are stored. In the REACTOR workspace, all definitions of multi-stage steady-state reactor and its distribution coefficients are saved, together with the GIBBS and POLY3 workspaces. After a SAVE command, you can always return to the state when you issued the SAVE command by giving a READ command.

After saving the REACTOR (and POLY3/GIBBS) workspaces on a file, you can leave the program and at a later time READ the file and continue from the saved state.

A START_SIMULATE command automatically saves on the work file with the most lately specified name. To avoid destroying the simulated results, do not SAVE after a START_SIMULATE command is enforced, similar to that you should not SAVE after a STEP or MAP command! You may append several results by START_SIMULATE without destroying the previous results but SAVE erases them all.

**Syntax** | **SAVE_WORKSPACE**
---|---

File name

A file name must be specified. The default extension of the RCT file is .RCT, while or any other extension as required.

A Save window displays if a file name is not given after the command, so that the path (in the Save in field) and File name can be specified. The **Files of type** (i.e. RCT) cannot be changed. If there is already a file with the same file name
START_SIMULATION

This is a command used with the REACTOR module.

Start the reactor simulation, and list the results for all iterations. The output for each iteration consists of the conditions set in each segment, and you can also select some state variables to list. After each loop, the temperatures in all segments are listed.

Syntax  START_SIMULATION

Prompts

Max number of loops /10/: <The max number of loops>

Give the max number of loops. The REACTOR module repeats the reactor simulation until this loop number is reached.

Output to screen or file /Screen/: <File name or return>

Decide on either listing simulation results on the screen (by pressing <Enter>) or saving them on an experimental file (with the default extension .EXP).

The conditions in each segment are not saved in the file, only on the screen.

Output variables /T BP($)/: <Variable name(s)>

Specify the variable name(s) that is also listed on the screen together with the conditions in each segment, or in the output experimental file.

Example Output

For a four-stage reactor, the output at a certain iteration may look like this:

\[
\begin{align*}
H &= -991745.1, \ P = 100000, \ N(C) = 2.8468936, \ N(N) = 6.78399966E-4, \ N(O) = 3.8171615, \\
N(SI) &= 1.77031 \\
\text{DEGREE OF FREEDOM} &= 0 \\
BP(GAS) &= 43.464341, \ BP(C1SI1_BETA) = 25.175981, \ BP(C_S) = 8.1588099,
\end{align*}
\]
BP(QUARTZ_S3)=68.193896
1.78803E+03
BP(GAS)=61.971213, BP(C1SI1_BETA)=38.144346, BP(QUARTZ_L)=66.230717 2.06569E+03
BP(GAS)=67.66262, BP(C1SI1_BETA)=35.480983, BP(QUARTZ_L)=58.219292
2.08691E+03
BP(GAS)=71.23129, BP(SI_L)=22.471787
2.20831E+03
H=-924751.87, P=100000, N(C)=2.0594558, N(N)=5.1.7999978E-4, N(O)=4.0142358,
N(SI)=2.7551438
DEGREE OF FREEDOM 0
BP(GAS)=43.464341, BP(C1SI1_BETA)=25.175981, BP(C_S)=8.1588098,
BP(QUARTZ_S3)=68.193896
1.78803E+03
BP(GAS)=61.971213, BP(C1SI1_BETA)=38.144346, BP(QUARTZ_L)=66.230717 2.06569E+03
BP(GAS)=67.66262, BP(C1SI1_BETA)=35.480983, BP(QUARTZ_L)=58.219292
2.08691E+03
BP(GAS)=71.23129, BP(SI_L)=22.471787
2.20831E+03
H=-813239., P=100000, N(C)=1.6592668, N(N)=3.5999988E-4, N(O)=3.7549293,
N(SI)=2.896635
DEGREE OF FREEDOM 0
BP(GAS)=43.464341, BP(C1SI1_BETA)=25.175981, BP(C_S)=8.1588098,
BP(QUARTZ_S3)=68.193896
1.78803E+03
BP(GAS)=61.971213, BP(C1SI1_BETA)=38.144346, BP(QUARTZ_L)=66.230717 2.06569E+03
BP(GAS)=67.66262, BP(C1SI1_BETA)=35.480983, BP(QUARTZ_L)=58.219292
2.08691E+03
BP(GAS)=71.23129, BP(SI_L)=22.471787
2.20831E+03
H=7374.6403, P=100000, N(C)=8.84911857E-1, N(N)=1.99999996E-4, N(O)=1.9379203,
N(SI)=1.853872
DEGREE OF FREEDOM 0
BP(GAS)=43.464341, BP(C1SI1_BETA)=25.175982, BP(C_S)=8.1588097,
BP(QUARTZ_S3)=68.193896
1.78803E+03
BP(GAS)=61.971213, BP(C1SI1_BETA)=38.144346, BP(QUARTZ_L)=66.230717 2.06569E+03
BP(GAS)=67.66262, BP(C1SI1_BETA)=35.480983, BP(QUARTZ_L)=58.219292
2.08691E+03
BP(GAS)=71.23129, BP(SI_L)=22.471787
2.20831E+03
10 1788.03 2065.69 2086.91 2208.31 0.00 0.00 0.00
SCHEIL Module

Search the online help or see the *Thermo-Calc User Guide* included with this PDF documentation set for details about how to calculate using Scheil either in Graphical Mode (the Scheil Calculator) and Console Mode (the wizard Scheil module).

If you also have a license for the Diffusion Module (DICTRA), you can import a previously calculated Scheil segregation profile into the software using the command INPUT_SCHEIL_PROFILE. Search the online help or see the *Diffusion Module (DICTRA) Command Reference Guide*.

In this section:

- BCC_TO_FCC_TRANSFORMATION ........................................... 294
- EVALUATE_SEGREATION_PROFILE ........................................ 294
- GLOBAL_MINIMIZATION .................................................. 295
- LIQUID_PHASE_NAME .................................................... 295
- SAVE_FILE_NAME .......................................................... 295
- SET_INTERACTIVE ......................................................... 295
- SET_NUMERICLAL_LIMITS ............................................... 296
- START_WIZARD ............................................................ 297
- TEMPERATURE_STEP .................................................... 298
- TERMINATION_CRITERIA ............................................... 298
BCC_TO_FCC_TRANSFORMATION

Use this command for the Scheil module to allow transformations in the solidified part of the alloy caused by each of the components specified to be Fast Diffuser. It is recommended that you only select this for steels.

Syntax

<table>
<thead>
<tr>
<th>Syntax</th>
<th>BCC_TO_FCC_TRANSFORMATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Allow bcc → fcc? /N/</td>
</tr>
<tr>
<td></td>
<td>The default is N. Enter Y to allow transformations.</td>
</tr>
</tbody>
</table>

EVALUATE_SEGREATION_PROFILE

Use this command in order to evaluate a segregation profile while performing the Scheil calculation. The Scheil calculation itself does not contain a spatial dimension. However, if it is assumed that the molar volume is constant and equal for all elements, and if a length is provided over which solidification occurs (for example the secondary dendrite arm spacing) then the generated profile corresponds to the segregation that would be obtained under the assumptions of a Scheil calculation. The grid is then equidistant and can be used as input for a DICTRAsimulation.

The generated text file contains, on each line, the mole fractions of all elements in alphabetical order at a certain grid point. If the composition is the same on several consecutive lines it means that the composition of the then remaining liquid has reached a state in which there are no degrees of freedom.

Syntax

<table>
<thead>
<tr>
<th>Syntax</th>
<th>EVALUATE_SEGRATION_PROFILE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Evaluate segregation profile? /N/</td>
</tr>
<tr>
<td></td>
<td>If the answer is Y a segregation profile will be evaluated and saved to disc. Note that this feature is not supported with back diffusion; if back diffusion is enabled no segregation profile will be generated.</td>
</tr>
<tr>
<td></td>
<td>Number of grid points /100/</td>
</tr>
<tr>
<td></td>
<td>Enter the number of grid points for the segregation profile.</td>
</tr>
<tr>
<td></td>
<td>A file dialogue window opens and allows you to specify the name of the file in which the segregation profile is written.</td>
</tr>
<tr>
<td></td>
<td>In a macro file it is possible to enter all arguments on a single line, e.g. EVALUATE_SEGRATION_PROFILE Y 100 XF.TXT, meaning that the segregation profile is evaluated over 100 grid points and saved to a file (XF.TXT) in the current working directory.</td>
</tr>
</tbody>
</table>
GLOBAL_MINIMIZATION

Use this command for the Scheil module to use global minimization.

Also see the POLY commands topic "ADVANCED_OPTIONS Descriptions" on page 168 for information about that GLOBAL_MINIMIZATION command.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>GLOBAL_MINIMIZATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Use global minimization? /N/</td>
</tr>
<tr>
<td></td>
<td>If Y, the Global Minimization is done when possible (depending on the conditions setting), and a Global Minimization test is performed when an equilibrium is reached. This costs more computer time but the calculations are more robust. If N the Global Minimization is not used to reach the equilibrium.</td>
</tr>
</tbody>
</table>

LIQUID_PHASE_NAME

Use this command for the Scheil module to use the liquid phase name from the database definitions or enter another phase name.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>LIQUID_PHASE_NAME</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Liquid phase name /Default/</td>
</tr>
<tr>
<td></td>
<td>Default selects the liquid phase from the database definitions, otherwise enter a phase name.</td>
</tr>
</tbody>
</table>

SAVE_FILE_NAME

Use this command for the Scheil module to save the file. The files get the console number added to this name, e.g. 005.-Scheil_006.poly3 and Scheil_segregation_profile.txt).

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SAVE_FILE_NAME</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Name of files to be saved, poly3 and segregation profiles.</td>
</tr>
</tbody>
</table>

SET_INTERACTIVE

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_INTERACTIVE</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Resets the input and output units to the initial values, i.e. keyboard and screen. Add this as the last command to the macro files.</td>
</tr>
</tbody>
</table>
SET_NUMERICAL_LIMITS

Change the criteria for convergence. This is to speed up a calculation in a complex system.

If there is any convergence problem in finding a stable solution at any stage during a calculation procedure enforced by "COMPUTE_EQUILIBRIUM" on page 190, "STEP_WITH_OPTIONS" on page 227, "MAP" on page 212 or "ADVANCED_OPTIONS" on page 174, this message displays:

Convergence problems, increasing smallest site-fraction from 1.00E-30 to hardware precision 2.00E-14. You can restore using SET_NUMERICAL_LIMITS

This implies that smallest site fraction in the current POLY3 workspace is automatically increased from the default value 1.00E-30 to the hardware-dependent precision (under Linux, as 2.00E-14). For other subsequent POLY-module calculation in the current Thermo-Calc (Console Mode) run, you can use this command to restore or reset the smallest site fraction to the previous or another preferred value, as well as to reset other numerical limits.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_NUMERICAL_LIMITS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Maximum number of iterations /200/: &lt;xxx&gt;</td>
</tr>
<tr>
<td></td>
<td>By default, the program tries 500 iterations before it gives up. As some models give computation times of more than 1 CPU second/iteration, this number is also used to check the CPU time and the calculation stops if 500 CPU seconds/iterations are used.</td>
</tr>
<tr>
<td></td>
<td>Required accuracy /1E-6/: &lt;yyy&gt;</td>
</tr>
<tr>
<td></td>
<td>This is a relative accuracy, and the program requires that the relative difference in each variable must be lower than this value before it has converged. A larger value normally means fewer iterations but less accurate solutions. The value should be at least one order of magnitude larger than the machine precision.</td>
</tr>
<tr>
<td></td>
<td>Smallest fraction /1E-12/: &lt;zzz&gt;</td>
</tr>
<tr>
<td></td>
<td>This is the value assigned to constituents that are unstable. It is normally only in the gas phase you can find such low fractions.</td>
</tr>
<tr>
<td></td>
<td>The default value for the smallest site-fractions is 1E-12 for all phases, except for IDEAL phase with one sublattice site (such as the GAS mixture phase in many databases) for which the default value is always as 1E-30 (unless you have used the SET_NUMERICAL_LIMITS command to reset an even-lower value (e.g. 1E-45, that is naturally enforced to all the phases in the system).</td>
</tr>
</tbody>
</table>
Syntax | **SET NUMERICAL LIMITS**
--- | ---

Approximate driving force calculation for metastable phases \( /Y/ \): 
\(<Y \text{ or } N> \)

Normally the POLY module only requires that the set of stable phases is in equilibrium in order to terminate the iterations. The metastable phases are included in all iterations but these may not have reached their most favourable composition and thus their driving forces may be only approximate [corresponding to \( Y \)]. You can also force the calculation to converge for the metastable phases by answering \( N \) if it is important that these driving forces are correct, which may require more iterations, and the STEP and MAP command may also terminate due to bad convergence in a metastable phase.

**START_WIZARD**

Use this command for the Scheil module to use the wizard with step-by-step prompts to create a Scheil simulation.

This wizard walks you through a basic Scheil simulation. You are prompted for settings including the major element or alloy, composition input in mass (weight) percent, the alloying elements, the temperature, fast diffusing components, and whether any phase should have a miscibility gap check.

Use the other commands to make changes to settings that are not included in this wizard.

- BCC_TO_FCC_TRANSFORMATION
- EVALUATESEGREGATION_PROFILE
- GLOBAL_MINIMIZATION
- LIQUID_PHASE_NAME
- SAVE_FILE_NAME
- STORED_COMPOSITION_TYPE
- TEMPERATURE_STEP
- TERMINATION_CRITERIA
Syntax

<table>
<thead>
<tr>
<th>Prompt</th>
<th>START_WIZARD</th>
</tr>
</thead>
</table>
| Database /<Default>/:  
Major element or alloy:  
Composition input in mass (weight) percent? /Y/:  
1st alloying element: Cr 10 C 1  
Next alloying element:  
Temperature (C) /2000/:  
Fast diffusing components: /None/: C  
Should any phase have a miscibility gap check? /N/: |

**TEMPERATURE_STEP**

Use this command for the Scheil module to define a temperature step.

Syntax

<table>
<thead>
<tr>
<th>Prompt</th>
<th>TEMPERATURE_STEP</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set temperature step (C) /1/</td>
<td></td>
</tr>
</tbody>
</table>

**TERMINATION_CRITERIA**

Use this command for the Scheil module to define the termination criteria for the fraction of liquid or temperature.

Syntax

<table>
<thead>
<tr>
<th>Prompt</th>
<th>TERMINATION_CRITERIA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fraction of liquid or Temperature (F or T)? /F/</td>
<td></td>
</tr>
<tr>
<td>Fraction of liquid / .01/</td>
<td></td>
</tr>
</tbody>
</table>
System Utilities Commands

In this section:

<table>
<thead>
<tr>
<th>Command</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABOUT</td>
<td>300</td>
</tr>
<tr>
<td>CLOSE_FILE</td>
<td>300</td>
</tr>
<tr>
<td>DISPLAY_LICENSE_INFO</td>
<td>300</td>
</tr>
<tr>
<td>HP_CALCULATOR</td>
<td>300</td>
</tr>
<tr>
<td>OPEN_FILE</td>
<td>301</td>
</tr>
<tr>
<td>SET_COMMAND_UNITS</td>
<td>301</td>
</tr>
<tr>
<td>SET_ECHO</td>
<td>302</td>
</tr>
<tr>
<td>SET_GES_VERSION</td>
<td>302</td>
</tr>
<tr>
<td>SET_INTERACTIVE_MODE</td>
<td>302</td>
</tr>
<tr>
<td>SET_LOG_FILE</td>
<td>303</td>
</tr>
<tr>
<td>SET_PLOT_ENVIRONMENT</td>
<td>303</td>
</tr>
<tr>
<td>SET_TC_OPTIONS</td>
<td>304</td>
</tr>
<tr>
<td>STOP_ON_ERROR</td>
<td>305</td>
</tr>
</tbody>
</table>
ABOUT

Syntax | ABOUT
-------|---------

Lists basic information about the development history and ownership of the Thermo-Calc software as well as version information.

CLOSE_FILE

Close an opened text file.

Syntax | CLOSE_FILE
-------|---------

Prompt

Unit number: <Unit number>

A unit number given in an OPEN_FILE command must be specified.

DISPLAY_LICENSE_INFO

Use this command to launch a license diagnostics program implemented in the SYS module. It detects the license information for the Thermo-Calc installations on the current client computer (and on the connected license server), and lists the details, including the current status of available license file and all its included license features for the current installation(s), as well as the Safenet Environment Variables and detailed Local (Client) Information, on screen or into a textual file (*.TXT).

This is useful for a list of license details, and to obtain basic technical support by sending the *.TXT file to support@thermocalc.se. If you are running a network client installation of Thermo-Calc, you can see how many of the client example licenses that are currently checked out and how many of them are left. You can also see which clients computers it is that have checked these client example licenses out.

Syntax | DISPLAY_LICENSE_INFO
-------|---------

Prompt

Output to screen or file /Screen/: <Mylicenseinfo.txt>

Press <Enter> to display a list of license information or into a *.TXT file under a specific file name which can later on be opened and edited by any basic text editor.

HP_CALCULATOR

This is the QBA simple interactive calculator using reverse Polish notations.
Available OPCODEs (HPC codes) are listed by entering the command HELP.

Use the BACK command to quit the HP_CALCULATOR and go back to the SYS module.

Input are numbers, + - * / and ^ and OPCODEs. Several numbers an operations can be given on one line. The content of the X register is displayed after each operation.

For example, to compute 2*EXP(1.5**3-30000/(8*1273)), you should input the following: 30000 8/1273/chs 1.5 3 ^ + exp 2 *

**OPEN_FILE**

A text file is opened for use in other commands where a unit number is necessary. The program automatically assigns a unit number.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>OPEN_FILE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>File name: &lt;File name&gt;</td>
</tr>
<tr>
<td></td>
<td>A legal file name must be specified.</td>
</tr>
</tbody>
</table>

**SET_COMMAND_UNITS**

This command is useful for reading inputs already prepared by a textual editor on a file. Such inputs can be a table of values or a large number of parameters. The file must be opened with "OPEN_FILE" above.

The first two lines of an input file are skipped before any input is read.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_COMMAND_UNIT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Input unit number /5/: &lt;Input unit number&gt;</td>
</tr>
<tr>
<td></td>
<td>Specify the input unit number returned from an OPEN_FILE command. The next command is taken from the file connected to this unit number. The last command on such a file must be EXIT or SET_INTERACTIVE when you are in POLY, POST or SYS module, in order to go back to read input from the keyboard. The default value is the current input unit.</td>
</tr>
<tr>
<td></td>
<td>Output unit number /6/: &lt;Output unit name&gt;</td>
</tr>
<tr>
<td></td>
<td>Specify the output unit number returned from an OPEN_FILE command.</td>
</tr>
</tbody>
</table>
**SET_ECHO**

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_ECHO</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Syntax</strong></td>
<td>SET_ECHO</td>
</tr>
<tr>
<td><strong>Prompt</strong></td>
<td>Add this command at the beginning of a Console Mode MACRO *.TCM file (or to the primary MACRO file on the top level if any sub-level(s) of MACRO files are used). Automatically displays on screen the complete details of various commands in all the sequential operations in the software, that are enforced according to the MACRO file(s).</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>This command is not applicable if MACRO files are not used.</td>
</tr>
</tbody>
</table>

**SET_GES_VERSION**

This command enables switching between the default standard version (5) Gibbs Energy System (GES) calculation engine and an experimental version (6).

If you are interested in participating and helping to test the experimental version of the calculation engine, please contact Thermo-Calc Software AB at info@thermocalc.se for more information about the changes. Make sure you compare/check your results as GES6 continues to be developed and improved.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_GES_VERSION</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Prompt</strong></td>
<td>USE GES VERSION 5 OR 6 /5/:</td>
</tr>
<tr>
<td><strong>Default</strong></td>
<td>The default is version 5.</td>
</tr>
</tbody>
</table>

**SET_INTERACTIVE_MODE**

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_INTERACTIVE_MODE</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Syntax</strong></td>
<td>SET_INTERACTIVE_MODE</td>
</tr>
<tr>
<td><strong>Prompt</strong></td>
<td>Resets the input and output units to their initial values, i.e. keyboard and screen.</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>Remember to add this as the last command to your MACRO files, in order to stop execution of the command file in the POST module. It has no meaning in interactive mode.</td>
</tr>
</tbody>
</table>
**SET_LOG_FILE**

Use it to save, in a basic text file, everything typed in the Thermo-Calc software. When having problems executing a command sequence, this command can be used to save the command typed onto a log file. The manager can then check what the problem might be.

This command also makes the system echo the full command for all commands typed. This feature is useful when demonstrating the system since the abbreviated commands are often difficult.

The saved log file can then be edited as a MACRO file by using a basic text editor. This is useful to run the MACRO file(s) for similar calculations (the same system but slightly varied temperature-pressure-composition conditions), or run the example MACRO files.

![Macro Files](Macro Files on page 155) in the *Thermo-Calc User Guide*.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_LOG_FILE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>A <strong>Save</strong> window opens to specify a file name for the <em>.LOG</em> file, so that the path (in the <strong>Save in</strong> field) and <strong>File name</strong> can be specified. If an <em>.LOG</em> file with the same name exists in the current working directory, it is overwritten. The <strong>Files of type</strong> (i.e. LOG) cannot be changed. Click <strong>Save</strong> or <strong>Cancel</strong> as applicable.</td>
</tr>
</tbody>
</table>

**SET_PLOT_ENVIRONMENT**

Allows you, preferably in the initiation file tc.ini, to set the plot devices you normally have access to as this can vary for different Thermo-Calc installations.

This command must be terminated with an empty line or two commas.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_PLOT_ENVIRONMENT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompts</td>
<td>Default plotdevice number /Default number/: &lt;Device number&gt;</td>
</tr>
</tbody>
</table>

The number given is unique for each type of graphical device. For plotting various types of Thermo-Calc graphs on screen, the default graphical device number should normally be selected. A question mark ? gives you a list of all available graphical devices used in the Thermo-Calc Console Mode.

<table>
<thead>
<tr>
<th>Prompts</th>
<th>Pseudo file name: &lt;Pseudo-file name&gt;</th>
</tr>
</thead>
</table>

The name given here is a symbol which can be used to refer to a physical graphics device when asked for graphical output file.
**Syntax** | **SET_PLOT_ENVIRONMENT**
---|---
Plotdevice number /1/: <Device number>  
The number that specifies the type of graphical device.
Plot file name: <File name or printer name>  
The name of the graphical device on system level (name of file or printer).

**Example**

```
SET_PLOT_ENVIRONMENT 1 lasp 5 a0tr,,
```

This example sets the default plot device number to 1, and defines an alias named `lasp` with plot device 5 and connected to a printer named `a0tr`.

---

**SET_TC_OPTIONS**

Predefine the default values of three general Thermo-Calc options for performing all the sequential single-points, stepping and mapping calculations.

**Syntax** | **SET_TC_OPTIONS**
---|---

**Prompts**

- Use_global_minimization /Y/: <Y or N>
  - If Y, it is done when possible (depending on the conditions setting), and a Global Minimization test is performed when an equilibrium is reached. This costs more computer time but the calculations are more robust. For N Global Minimization is not used to reach the equilibrium.

- Global_test_interval /0/: <An integer value>
  - The integer number determines how often the Global Minimization should be used during calculations with "STEP_WITH_OPTIONS" on page 227 and "MAP" on page 212. If it is set to 0 (zero), the recommended global test interval is used: i.e. every tenth step and at each phase change during STEP calculations, and only at node points during MAP calculations. Any other positive integer number, n, suggests it performs Global Minimization tests at every nth step during STEP and MAP calculations. Of course, the Global Minimization test is always carried out at a phase change or a node point. The Thermo-Calc Console Mode is initially configured with 0 (zero) as the default value, but such a configuration for the default value can be changed by this option.

- Automatically_add_initial_equilibria /Y/: <Y or N>
  - When "ADD_INITIAL_EQUILIBRIUM" on page 166 is not used before a MAP calculation, a mesh of INITIAL_EQUILIBRIUM are automatically added before
### Syntax

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SET_TC_OPTIONS</strong></td>
<td></td>
</tr>
</tbody>
</table>

The mapping procedure itself takes place. This mesh is only available when the two independent axis-variables have already been defined by the POLY command. |

| **Set_axis_variable** |  

For Y the POLY module always enforces the automatic procedures for adding initial equilibrium points during mapping. For N no initial equilibrium points are then added during mapping. |

### STOP_ON_ERROR

Useful for batch jobs in order to prevent that an erroneous sequence of commands to the program causes waste of computer activity.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>STOP_ON_ERROR</strong></td>
<td></td>
</tr>
</tbody>
</table>

Give the preferred argument (**ON** or **OFF**) after the STOP command. If the default argument ON is given, the program terminates after an illegal or ambiguous command. It is possible to reset the effect of this command by giving the argument OFF. |
TABULATION_REACTION Commands

"Tabulation of Chemical Substances, Phases or Reactions" on page 204 in the Thermo-Calc User Guide.

In this section:

- ENTER_FUNCTION .......................................................... 307
- ENTER_REACTION .......................................................... 308
- LIST_SUBSTANCES ....................................................... 310
- SET_ENERGY_UNIT ....................................................... 312
- SET_PLOT_FORMAT ......................................................... 312
- SWITCH_DATABASE ......................................................... 313
- TABULATE ................................................................. 315
- TABULATE_DERIVATIVES .............................................. 315
- TABULATE_REACTION .................................................. 320
- TABULATE_SUBSTANCE .................................................. 322
ENTER_FUNCTION

Used to define a new thermodynamic function to be included in the sixth column of tabular output. The last entered function is listed in the 6th column of all tables, and can be plotted (if choosing the Plot Column value 6) in all graphs, for all subsequently tabulated substances or reactions.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>ENTER_FUNCTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Name: &lt;Name&gt;</td>
</tr>
<tr>
<td></td>
<td>Function: &lt;Definition&gt;</td>
</tr>
<tr>
<td>Options</td>
<td>A limited number of state variables, G, H, S, T, P, V and H298 can be used in the function definition. For example, -(G-H)/T can be defined as a function which is identical to S for a substance or ΔS for a reaction, G+T<em>S-P</em>V can be defined as a function which is U (internal energy) for a substance or ΔU (internal energy change) for a reaction.</td>
</tr>
<tr>
<td></td>
<td>Name of the function (maximum 8 characters) and Definition of the function. A long function can be typed over several lines. A function should be terminated by a semicolon (;) or an empty line.</td>
</tr>
</tbody>
</table>

Example Output

For the pure substance Fe (using the SSUB database), by entering a function as G+T*S-P*V, the following table is obtained by typing <Enter> in the prompt Output file /SCREEN/:, and the figure by typing 6 in the prompt Plot column /2/:

```
TAB: ENTER-FUNCTION
Name: InEnergy
Function: G+T*S-P*V;
TAB: TABULATE_SUBSTANCE
Substance (phase): Fe
Pressure /100000/: <Enter>
Low temperature limit /298.15/: <Enter>
High temperature limit /2000/: <Enter>
Step in temperature /100/: <Enter>
Output file /try1/: try2
Graphical output? /Y/: <Enter>
Plot column? /2/: 6
```
This gives the following output:

```
OUTPUT FROM THERMOCALC

Column 6: InEnergy G+T*S-P*V
Phase : FE_S              Pressure :   100000.00
Specie: FE

***********************************************************************************************

T   Cp   H      S      G  InEnergy
(K)  (Joule/K) (Joule) (Joule/K) (Joule)
***********************************************************************************************

298.15  2.48446E+01  2.17972E-06  2.72800E+01  -8.13353E+03  2.17972E-06
300.00  2.48905E+01  4.60049E+01  2.74338E+01  -8.18414E+03  4.60049E+01
400.00  2.71299E+01  2.64957E+03  4.11976E+01  -1.13138E+04  5.47211E+03
500.00  3.19293E+01  8.53245E+03  4.67701E+01  -1.95296E+04  8.53245E+03
600.00  3.50985E+01  1.18777E+04  5.19207E+01  -2.44667E+04  1.18777E+04
700.00  3.92042E+01  1.55830E+04  5.68623E+01  -2.99068E+04  1.55830E+04
800.00  4.49645E+01  1.97726E+04  6.17903E+01  -3.58387E+04  1.97726E+04
900.00  5.42147E+01  2.46891E+04  6.69619E+01  -4.22728E+04  2.46891E+04
1000.00 4.55851E+01  2.99025E+04  7.19412E+01  -4.92328E+04  2.99025E+04 $ unstable
Stable phase is FE_S2

1200.00 3.40840E+01  3.51037E+04  7.64466E+01  -5.66322E+04  3.51037E+04
1300.00 3.49398E+01  3.85549E+04  7.92086E+01  -6.44162E+04  3.85549E+04
1400.00 3.57994E+01  4.20918E+04  8.18293E+01  -7.24692E+04  4.20918E+04
1500.00 3.66636E+01  4.57149E+04  8.43287E+01  -8.07780E+04  4.57149E+04
1600.00 3.75330E+01  4.94247E+04  8.67226E+01  -8.93314E+04  4.94247E+04 $
Stable phase is FE_S3

1700.00 4.05217E+01  5.41173E+04  8.95609E+01  -9.81363E+04  5.41173E+04
1800.00 4.12595E+01  5.82055E+04  9.18975E+01  -1.07210E+05  5.82055E+04 $
Stable phase is FE_L

1900.00 4.60000E+01  7.74165E+04  1.02377E+02  -1.17099E+05  7.74165E+04
2000.00 4.60000E+01  8.20165E+04  1.04736E+02  -1.27456E+05  8.20165E+04
```

**ENTER_REACTION**

This is the same as "TABULATE_REACTION" on page 320 in that both the chemical reaction can be specified and the thermodynamic property changes for the reaction can be generated as a table, and plotted as a graph or saved as an experimental file (with an extension of .EXP). The thermodynamic data are automatically retrieved from the SSUB5 database (by default), or the current database set by "SWITCH_DATABASE" on page 22 (thus...
there is no need to use the DATA module before this command). You can select any other database by using the SWITCH_DATABASE command in the TAB module. The rules to specify a reaction are the same as in the command TABULATE_REACTION.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>ENTER_REACTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompts</td>
<td>Same reaction? /Y/: &lt;Y or N&gt;</td>
</tr>
<tr>
<td></td>
<td>This displays if there is at least one reaction already defined either by the command ENTER_REACTION or TABULATE_REACTION. For Y the next prompt for defining reaction is not asked.</td>
</tr>
<tr>
<td></td>
<td>Reaction: &lt;Chemical reaction equation&gt; &amp; &lt;RA+RB=PC+PD&gt;</td>
</tr>
<tr>
<td></td>
<td>A long reaction can be typed over several lines. A reaction should be terminated by a semicolon (;) or an empty line. A list showing the used database, defined elements, getting-data sequence, references, etc.:</td>
</tr>
<tr>
<td></td>
<td>Pressure /100000/: &lt;Pressure of interest, in pa&gt;</td>
</tr>
<tr>
<td></td>
<td>Low temperature limit /298.15/: &lt;T-low, in K&gt;</td>
</tr>
<tr>
<td></td>
<td>High temperature limit /2000/: &lt;T-high, in K&gt; Step in temperature /100/: &lt;T-step&gt;</td>
</tr>
<tr>
<td></td>
<td>Output file /SCREEN/: &lt;RETURN for SCREEN, or type a file name&gt;</td>
</tr>
<tr>
<td></td>
<td>If you type Return for screen a list of thermodynamic property changes for the defined/chosen reaction is shown up as a table (which is demonstrated in the example outputs given below), and the command is terminated.</td>
</tr>
<tr>
<td></td>
<td>If typing a file name, the table is displayed and saved as an *.EXP or an *.TAB file. Then prompts:</td>
</tr>
<tr>
<td></td>
<td>Graphical output /Y/: &lt;Y or N&gt;</td>
</tr>
<tr>
<td></td>
<td>For N a table is output to the screen and this table is saved as a basic text file with the default extension .TAB under the current working directory. In this case, the graph cannot be plotted.</td>
</tr>
<tr>
<td></td>
<td>For Y a table is created with all thermodynamic functions as normal (which is displayed on screen) and generates a graph with temperature on the X-axis and a chosen property on a certain column in the table on the Y-axis (which is plotted on screen and saved as an *.EXP file), and it further asks which column is to be plotted on the resulting graph:</td>
</tr>
<tr>
<td></td>
<td>Plot column? /2/: &lt;1 or 2 or 3 or 4 or 5 or 6&gt;</td>
</tr>
</tbody>
</table>
|          | Specify which property (as column number) to be plotted as the Y-axis (versus temperature as X-axis) as a graph on the screen. Simultaneously, all tabulated
**Syntax** | **ENTER_REACTION**  
--- | ---  
properties and the Y-axis setting (i.e. the plotted column) for the graph is written into an *.*EXP file using the DATAPLOT format. The default column 2 is heat capacity, 3 enthalpy, 4 entropy and 5 Gibbs energy, and the additional column 6 is a user-entered function. The table displays on the screen. The plot then displays on the screen, followed by a POST prompt. The POST module (postprocessor) automatically opens, and all types of the POST-module commands to refine the plotted diagram may be used. Possibilities include scaling the X/Y-axis, changing the X/Y-axis texts, etc. The command BACK or EXIT at the POST prompt always takes you back to the TAB module.

---

**LIST_SUBSTANCES**

This is a TAB module command.

List all species in the current database with a certain set of elements. This is useful to specify species as pure substances in the command "TABULATE_SUBSTANCE" on page 322.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>LIST_SUBSTANCES</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Prompts</strong></td>
<td>With elements /<em>/ &lt;</em> or a set of elements&gt;</td>
</tr>
<tr>
<td></td>
<td>The elements building up various species must be specified. The wildcard * means all elements in the current database.</td>
</tr>
<tr>
<td></td>
<td>If some elements are specified, it also prompts for how to list species with such elements.</td>
</tr>
<tr>
<td></td>
<td>Exclusively with those elements /Y/: &lt;Y or N&gt;</td>
</tr>
<tr>
<td></td>
<td>All species (not phases) in the current database are searched. If the answer is Y (the default), no other elements are allowed in searching, except for those specified. If N all species containing at least one of the specified elements are listed.</td>
</tr>
</tbody>
</table>

**Example Output**

For the SSOL5 database, there are different lists, as shown below:

```
TAB: l-sub
With elements */*: <Enter>
VA AG AL
```
| AM | AS | AU |
| B  | BA | BE BI BR C |
| CA | CD | CE |
| CL | CO | CR |
| CS | CU | DY |
| ER | EU | F |
| FE | GA | GD |
| GE | H  | HF |
| HG | HO | I |
| IN | IR | K |
| LA | LI | LU |
| MG | MN | MO |
| NA | NB | |
| ND | NI | NP |
| OS | P  | |
| PA | PB | PD |
| PR | PT | PU |
| RB | RE | RH |
| RU | S  | SB |
| SC | SE | SI |
| SM | SN | SR |
| TA | TB | TC |
| TE | TH | TI |
| TL | TM | U |
| V  | W  | Y |
| YB | ZN | ZR |
| C1 | C2 | C3 |
| C4 | C5 | C6 |
| C7 | N2 | O2 |
| P1 | P2 | P4 |
| NA/+1 | K/+1 | CL/-1 |
| H2O | H1/+ | LI1/+ |
| CS1/+ | RB1/+ | O1H1/- |
| F1/- | BR1/- | I1/- |
| H1/+1 | H1O1/-1 | SI1O2 CA1O1 TAB: |

TAB: l-sub
With elements */: fe cr ni c n o
Exclusively with those elements? /Y/: <Enter>
C CR FE
N NI 0
C C2 C3
C C5 C6
C N2 O2
TAB: 1-sub fe cr ni c n o
Exclusively with those elements? /Y/: n
C CR FE N NI O
C1 C2 C3
C4 C5 C6
C7 N2 O2
H2O O1H1/- H1O1/- SI1O2 CA1O1 TAB:

**SET_ENERGY_UNIT**

Set the energy unit as calories or Joule, in all the subsequent outputs (tables, graphs, and files) in the current calculation operation.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_ENERGY_UNIT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Energy unit (C=Cal, J=Joule) /J/: &lt;Unit&gt;</td>
</tr>
</tbody>
</table>

**SET_PLOT_FORMAT**

Set the plotting format while the result is plotted on screen or the file is saved as EXP file [using DATAPLOT graphical format] and TAB file (as a basic text file and as displayed on screen).

This command is different from "SET_PLOT_FORMAT" on page 264 in the POST module, but is identical to "SET_PLOT_ENVIRONMENT" on page 303 in the SYS (system utility) monitor.
### Syntax

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SET_PLOT_FORMAT</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Options</strong></td>
<td></td>
</tr>
<tr>
<td>The default set Unit is 1 (Windows) or 9 (Linux) for graphical presentation on screen, or all other units for outputs as *.EXP and *.TAB files. Also set the format of the graphical output to different graphical devices. The default unit 22 (1 for legacy Windows, and 9 for legacy Linux) may be altered with the SET_PLOT_ENVIRONMENT command in the SYS monitor or by the TC.INI file.</td>
<td></td>
</tr>
</tbody>
</table>

### SWITC_H_DATABASE

By default, the TAB module always automatically retrieves thermodynamic data for substances or reactant/product substances in a defined reaction, or for pure phases or ideal solution phases, from the SSUB Substances Database. However, you can select thermodynamic data for complex non-ideal solution phases from another database. This is possible with this command.

This command switches (or changes) from the current database to a new one, and reinitializes the entire TAB module for defining a substance or reaction and the GIBBS workspace for storing retrieved data. All the directly connected databases as predefined by the original database initiation file (TC_INITD.TDB file in the /DATA/ area for Windows environments, or the initd.tdb file in the \data\ area for Linux) are listed by pressing the <Enter> key without giving any argument. You can also supply your own database by giving the argument USER and then the database name and, if it is not located in the current working directory, its correct path.

This command (when required to use another database for subsequent tabulations) must be used before executing the TAB commands "TABULATE_SUBSTANCE" on page 322 for substances, and "ENTER_REACTION" on page 308 or "TABULATE_REACTION" on page 320 for reactions.

When a predefined database or an appropriate USER database is switched on, the DATA command "GET_DATA" on page 16 is automatically executed; therefore, the TAB module immediately displays a message

#### Example

Example of TAB module message with the PSUB database specified

```
TAB: SW PSUB
THERMODYNAMIC DATABASE Module running on PC/Windows NT
Current database: TC Public Substances Database
```
VA DEFINED
REINITIATING GES5
VA DEFINED
ELEMENTS
SPECIES
PHASES
PARAMETERS
FUNCTIONS
-OK- TAB:

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SWITCH_DATABASE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database /XYZ/: &lt;new database name&gt;</td>
<td></td>
</tr>
</tbody>
</table>

Specify a New database name. XYZ stands for the default SSUB database or the current database which is switched on. If an appropriate database name is not given and the USER option is not used, this list displays:

- Use one of these databases
  - PURE4 = SGTE Pure Elements Database v4
  - SSUB3 = SGTE Substances Database v3
  - USER = user defined database

| Prompt     | DATABASE NAME: The new database is specified by typing the abbreviation given in the front of one of the available predefined databases. For convenience when switching/appending databases or recently purchased databases from Thermo-Calc Software or its agents, you can add them to the predefined database list in the database initiation file TC_INITD.TDB or initd.tdb of your installed software. When this command is used in a MACRO (*.TCM) file, if the USER option is selected, the database setup file name (*.setup.TDB) containing the setup definitions of the USER database, and its correct path, must be provided. If a USER database name or its path is not given on the same line of the SWITCH_DATABASE command, or if it is incomplete or incorrect, an Open window displays to specify the filename of the database setup file name (*.setup.TDB) of the to-be-switched USER database. |
| Notes      | Unlike in the DATA module, if a USER database is used, the Gibbs energy system is also reinitialized and only data from the USER databases are retrieved for tabulations. |
**TABULATION**

Gives the values of an already-defined table (with various properties varied with the stepping axis variable) from equilibria calculated with a STEP command. You can tabulate a table even if the table is entered after the STEP calculation.

**Syntax**

<table>
<thead>
<tr>
<th>Prompt</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name:</td>
<td>&lt;Name of a defined table&gt;</td>
</tr>
<tr>
<td>Output to Screen or file /Screen/:</td>
<td>&lt;File name&gt;</td>
</tr>
</tbody>
</table>

**TABULATE_DERIVATIVES**

This command is mainly for system debugging purposes and for experienced users. It automatically calculates all partial derivatives for a pure phase or solution phase at a given composition.

This is not the same as the chemical potential.

Before using this command, the system must be defined and thermodynamic data retrieved from an appropriate solution database in the DATA module. The phase name can be given in either upper, lower or mixed cases, and can be abbreviated until it is unique, e.g. fcc, BCC, cem, Liq, etc. as the SSOL database is used for the tabulations, or GAS, FE-S, wustite, Fe2O3-hem, etc. as the SSUB database is used. The module then optionally goes through a specific sublattice or all the possible sublattices for the specified phase, as well as through the whole framework of a currently defined system (including all the defined elements/species, as well as the default defined vacancy and electron if necessary for the current database), when it prompts for inputs of site fractions for various species possibly occupying such sublattices. Therefore, thermodynamic properties can be tabulated for a pure phase, or for a solution phase as a pure end-member (with a composition definition for the corresponding non-interacting species on all necessary sublattices in the end-member), or for a solution phase as a real solution (with a composition definition for related interacting species on all necessary sublattices in the solution).
**Syntax**

<table>
<thead>
<tr>
<th>TABULATE_DERIVATIVES</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phase name /XXXX/: &lt;Name of the phase&gt;</td>
</tr>
</tbody>
</table>

Specify the phase name of a pure phase or a solution phase.

**Prompts**

*XXXX* is the last phase the TAB module accounted for. It automatically prompts for other options and necessary inputs for the definition of the composition of the specified phase.

For a pure phase (such as Fe-S, Wustite, and Fe2O3-Hematite), no further composition definition is needed. For a solution phase with one sublattice (such as AQUEOUS solution, GAS mixture and SLAG solution), it requests *n*-1 site-fraction inputs for the phase constituents (if there are *n* species in the defined phase within the whole framework of currently defined system, including all the defined elements/species, as well as the default defined vacancy and electron if necessary for the current database); the *n*th species is automatically assigned as the rest.

- The sum of input site fractions must not exceed unity.

**Example**

For example, these prompts and inputs can be seen for a LIQUID solution phase (from the SSOL database) within the Fe-Cr-Ni-C-N-O framework (Note that by default, the unprompted Ni species are assigned as the rest):

```
FRACTION OF CONSTITUENT (RETURN FOR PROMPT): <RETURN> C /1/: .05
CR /1/: .1
FE /1/: < RETURN>
SUM OF FRACTIONS EXCEED UNITY, PLEASE REENTER
FE /1/: .8
N /1/: .005
```

For a solution phase with two or more sublattices (such as FCC alloy solution, and ION_LIQ ionic liquid solution), it first asks for which sublattice the site-fractions of constituents shall be specified: the default value 0 for all possible sublattices, and a given positive number for a specific sublattice (of course, this number must be reasonable for the currently specified phase, i.e. it must be smaller than the total sublattice number of the phase). Then, for the given sublattice or for all sublattices, it prompts for all the necessary inputs of site-
Syntax | TABULATE_DERIVATIVES
--- | ---
   | fractions for the possible constituents on each sublattice n-1 times if there are n species on such a sublattice in the defined phase; the nth species on each of the sublattices is automatically assigned as the rest. For example, the following prompts and inputs can be seen for an FCC solution phase (from the SSOL5 database) within the Fe-Cr-Ni-C-N-O framework (Note that by default, the unprompted O species on its sublattice 1 and VA on its sublattice 2 are assigned as the rest):

```
SPECIFY SUBLATTICE (0 FOR ALL) /0/: <RETURN>
FRACTIONS IN SUBLATTICE 1
CR /1/: .1
FE /1/: .8
NI /1/: .0995
FRACTIONS IN SUBLATTICE 2
C /1/: .05
N /1/: .05
```

```
Temperature /2000/: <Temperature of interest, in K>
```

```
Specify the temperature of interest in K.
```

```
Pressure /100000/: <Pressure of interest, in pa>
```

```
Specify the pressure of interest in Pa.
```

### Example Output

For the FCC phase in the Fe-Cr-Ni-C-N-O system (using the SSOL database), the following table is obtained at a specified composition:

```
TAB: TAB_DER
Phase name /BCC/: FCC
SPECIFY SUBLATTICE (0 FOR ALL) /0/: <Enter>
FRACTIONS IN SUBLATTICE 1
CR /1/: .1
FE /1/: .8
NI /1/: .3
SUM OF FRACTIONS EXCEED UNITY, PLEASE REENTER
NI /0/: .0995
```
FRACTIONS IN SUBLATTICE 2
C /1/: .05
N /1/: .05
Temperature /1800/: <Enter>
Pressure /100000/: <Enter>
Gibbs energy: .................. -1.27432533E+05
Helmholz energy: .................. -1.27433205E+05
Enthalpy: .................. 5.95773994E+04
Internal energy: .................. 5.95767279E+04
Entropy: .................. 1.0389407E+02
Molar volume: .................. 6.71473258E-06
Thermal expansivity: .................. 7.6386416E-05
Isothermal compressibility: ........ 6.02925387E-12
Heat capacity at constant pressure: 4.33555074E+01
First partial derivative with respect to CR in sublattice 1 of Gibbs energy:
                      -1.26034739E+05 of enthalpy: .................. 4.63000206E+04
                      9.57415334E+01 of entropy: .................. 6.87203263E-06
Second partial derivative of Gibbs energy with respect to also
CR  in 1:  1.54392858E+05
   in 2: -3.73062665E+05
FE  in 1: -1.5353158E+04
   in 2: -9.36260878E+04
NI  in 1: -1.71750366E+04
   in 2:  0.00000000E+00
O   in 1:  0.00000000E+00
   in 2: -1.82016870E+05
C   in 1:  0.00000000E+00
   in 2: -1.82016870E+05
VA  in 2: -9.36260878E+04
First partial derivative with respect to FE in sublattice 1 of Gibbs energy:
                      -1.02869265E+05 of enthalpy:  6.11738912E+04
                      9.11350866E+01 of entropy:  7.53441165E-06
Second partial derivative of Gibbs energy with respect to also
FE  in 1:  1.82508696E+04
NI  in 1: -3.07043434E+03
   in 1:  0.00000000E+00
C   in 2: -1.36027071E+05
   in 2: -2.13007485E+05
VA  in 2: -1.11741180E+05
First partial derivative with respect to NI in sublattice 1 of Gibbs energy:

\[ -1.32427029 \times 10^5 \text{ of enthalpy: } \]
\[ 5.2156380 \times 10^4 \text{ of entropy: } \]
\[ 1.02546326 \times 10^2 \text{ of volume: } \]

Second partial derivative of Gibbs energy with respect to also

NI in 1: \[ 1.48390257 \times 10^5 \]
C in 2: \[ -7.70620431 \times 10^4 \]
VA in 2: \[ -1.12772206 \times 10^5 \]

First partial derivative with respect to O in sublattice 1 of Gibbs energy:

\[ -2.62929308 \times 10^5 \text{ of enthalpy: } \]
\[ 5.02555370 \times 10^4 \text{ of entropy: } \]
\[ 1.73991581 \times 10^2 \text{ of volume: } \]

Second partial derivative of Gibbs energy with respect to also

in 1: \[ 2.99322360 \times 10^7 \]
C in 2: \[ 0.00000000 \times 10^0 \]
N in 2: \[ 0.00000000 \times 10^0 \]
VA in 2: \[ -1.82377137 \times 10^5 \]

First partial derivative with respect to C in sublattice 2 of Gibbs energy:

\[ -1.59508417 \times 10^5 \text{ of enthalpy: } \]
\[ 1.21259096 \times 10^5 \text{ of entropy: } \]
\[ 1.55987507 \times 10^2 \text{ of volume: } \]

Second partial derivative of Gibbs energy with respect to also

C in 2: \[ 2.99322360 \times 10^5 \]
N in 2: \[ -1.90144000 \times 10^4 \]
VA in 2: \[ -2.78465070 \times 10^4 \]

First partial derivative with respect to N in sublattice 2 of Gibbs energy:

\[ -2.39671400 \times 10^5 \text{ of enthalpy: } \]
\[ 4.04456947 \times 10^4 \text{ of entropy: } \]
\[ 1.55620608 \times 10^2 \text{ of volume: } \]

Second partial derivative of Gibbs energy with respect to also

N in 2: \[ 2.99322360 \times 10^5 \]
VA in 2: \[ -3.30383665 \times 10^4 \]

First partial derivative with respect to VA in sublattice 2 of Gibbs energy:

\[ -9.52042686 \times 10^4 \text{ of enthalpy: } \]
\[ 5.37142294 \times 10^4 \text{ of entropy: } \]
\[ 8.27324989 \times 10^1 \text{ of volume: } \]

Second partial derivative of Gibbs energy with respect to also

VA in 2: \[ 1.66290200 \times 10^4 \]
**TABULATE_REACTION**

Tabulate thermodynamic property changes for a chemical reaction as a table, or variation of one chosen property can be plotted against temperature as a graph, or saved as an experimental file (with an extension of .EXP). The thermodynamic data are automatically retrieved from the SSUB5 database (by default), or the current database set by the SWITCH_DATABASE command (thus there is no need to use the DATA module before this command). You can select any other database by using "SWITCH_DATABASE" on page 313 in the TAB module.

It is important to remember the rules to specify a reaction:

- The reaction is specified, by giving the reactants and products, such as \( \text{Ga}+\text{S} = \text{GaS} \), \( 5\text{Al}+2\text{Fe} = \text{Al}_5\text{Fe}_2 \).
- Under Linux environments, the notation for a chemical formula treats upper and lower cases as the same (such as \( \text{ga}+\text{s} = \text{GaS} \), \( 5\text{Al}+2\text{Fe} = \text{al}_5\text{Fe}_2 \)); but under Windows, the TAB module only accepts upper cases, e.g. \( \text{Ga}+\text{S} = \text{GaS} \), \( 5\text{AL}+2\text{FE} = \text{AL}_5\text{FE}_2 \).
- Elements with a single letter symbol must be followed by a stoichiometry factor, even if it is 1; thus, the symbol \( \text{CO} \) is taken as cobalt, carbon monoxide must be given as \( \text{C}_1\text{O}_1 \) (or \( \text{C}_0\text{O}_1 \)).
- All the reactants and products must be defined as species-stoichiometries in the currently-used database; in other words, the reaction definition only accepts already-defined species-stoichiometries as reactants and products. For example, if a database does not have a species defined with a stoichiometry of \( \text{Al}_5\text{Fe}_2 \) (e.g. the Al and Fe (but not \( \text{Al}_5\text{Fe}_2 \)) may be defined as species, and the \( \text{Al}_5\text{Fe}_2 \) phase may be defined as a two-sublattice stoichiometric phase \( [\text{Al}]5[\text{Fe}]2 \), rather than a single sublattice stoichiometric phase \( [\text{Al}_5\text{Fe}_2] \)), then the reaction \( 5\text{Al}+2\text{Fe} = \text{Al}_5\text{Fe}_2 \) cannot be tabulated.
- Make sure that the Gibbs free energy expression for a stoichiometric phase is really corresponding to the species-stoichiometry. For example, if a database has a definition of Function \( \text{GAL5FE2} \) for \( 1/7 \) of the \( \text{AL5FE2} \) formula, then the relation \( G(\text{Al}_5\text{Fe}_2) = 7*\text{GAL5FE2} \) must be defined; otherwise, the tabulated thermodynamic properties for the reaction \( 5\text{Al}+2\text{Fe} = \text{Al}_5\text{Fe}_2 \) is wrong.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>TABULATE_REACTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompts</td>
<td>Same reaction? /Y/: &lt;Y or N&gt;</td>
</tr>
<tr>
<td></td>
<td>This prompt displays if there is at least one reaction already defined either with the commands &quot;ENTER_REACTION&quot; on page 308 or TABULATE_REACTION. If you answer Y, then the next prompt is not asked.</td>
</tr>
<tr>
<td></td>
<td>Reaction: &lt;Chemical reaction equation&gt; &amp; &lt;RA+RB=PC+PD&gt;</td>
</tr>
<tr>
<td>Syntax</td>
<td>TABULATE_REACTION</td>
</tr>
<tr>
<td>---------------</td>
<td>------------------</td>
</tr>
<tr>
<td></td>
<td>A long reaction can be typed over several lines. A reaction should be terminated by a semicolon (;) or an empty line. A list showing the used database, defined elements, getting-data sequence, references, etc.</td>
</tr>
<tr>
<td></td>
<td>Pressure /100000/: &lt;pressure of interest, in pa&gt;</td>
</tr>
<tr>
<td></td>
<td>Low temperature limit /298.15/: &lt;T-low, in K&gt; Specify the starting temperature K.</td>
</tr>
<tr>
<td></td>
<td>High temperature limit /298.15/: &lt;T-high, in K&gt; Specify the ending temperature K. Step in temperature /100/: &lt;T-step&gt; Specify the temperature step for the tabulation.</td>
</tr>
<tr>
<td></td>
<td>Output file /Screen/: &lt;Return for screen, or type a file name&gt;</td>
</tr>
<tr>
<td></td>
<td>If you type Return for screen, a list of thermodynamic property changes for the defined/chosen reaction is shown as a table (which is demonstrated in the example outputs given below), and the command is terminated.</td>
</tr>
<tr>
<td></td>
<td>If typing a file name, the table is both displayed on screen and saved as an *.EXP or a *.TAB file, and the program prompts:</td>
</tr>
<tr>
<td></td>
<td>Graphical output /Y/: &lt;Y or N&gt;</td>
</tr>
<tr>
<td></td>
<td>• For N a table is output to the screen, and the same table is saved as a basic text file with the default extension .TAB under the current working directory. In this case, the graph cannot be plotted.</td>
</tr>
<tr>
<td></td>
<td>• For Y a table is created with all thermodynamic functions as normal (which is displayed on screen) and generates a graph with temperature on the X-axis and a chosen property on a certain column in the table on the Y-axis (which is plotted on screen and saved as an *.EXP file), and it also asks which column is to be plotted on the resulting graph:</td>
</tr>
<tr>
<td></td>
<td>Plot column? /2/: &lt;1 or 2 or 3 or 4 or 5 or 6&gt;</td>
</tr>
<tr>
<td></td>
<td>Specify which property (as column number) to be plotted as the Y-axis (versus temperature as X-axis) as a graph on the screen. Simultaneously, all tabulated properties and the Y-axis setting (i.e. the plotted column) for the graph is written into an *.EXP file using the DATAPLOT format. The default column 2 is heat capacity, 3 enthalpy, 4 entropy and 5 Gibbs energy, and the additional column 6 is a user-entered function. The table displays on the screen. The plot then displays on the screen, followed by a POST: prompt. The POST module (postprocessor) automatically opens, and all types of the POST-module commands to refine the plotted diagram may be used. Possibilities include scaling the X/Y-axis, changing the X/Y-axis texts, etc. The command BACK or EXIT at the POST: prompt always takes you back to the TAB module.</td>
</tr>
</tbody>
</table>
Example Output

For the reaction Ga+S=GaS (using the SSUB5 database), the following table is obtained by typing <Enter> in the prompt Output file /SCREEN/, and the figure by typing 2 in the prompt Plot column /2/:

```
OUTPUT FROM THERMO-CALC
Reaction: S+Ga=GaS
stable as S_S
Ga stable as GA_S
Ga1S1 stable as GA1S1_S
Delta-Cp   Delta-H   Delta-S   Delta-G
(K)   (Joule/K)   (Joule)   (Joule)   (Joule)
==============================================================================
298.15   -2.79489E+00  -2.09200E+05  -1.50580E+01  -2.04710E+05
300.00   -2.87516E+00  -2.09205E+05  -1.50755E+01  -2.04683E+05
302.00   -2.18925E+00  -2.09219E+05  -1.50774E+01  -2.04792E+05
305.00   -2.59804E+00  -2.09231E+05  -1.50794E+01  -2.04900E+05
306.00   -2.74372E+00  -2.09241E+05  -1.50804E+01  -2.04906E+05
307.00   -2.78071E+00  -2.09249E+05  -1.50813E+01  -2.04911E+05
308.00   -2.79226E+00  -2.09252E+05  -1.50818E+01  -2.04914E+05
```

Ga becomes GA_L, delta-H = 5589.80
S becomes S_S2, delta-H = 401.00
S becomes S_L, delta-H = 1721.00

**TABULATE_SUBSTANCE**

Tabulate thermodynamic properties of a substance (with a given chemical formula but it is not certain in which phase/state it may form) or a pure stoichiometric phase (getting data from a specific substance database such as SSUB5, or from a specific solution database such as SSOL5 and TCFE8), or of a solution phase with a fixed composition (getting data from a
specific solution database such as SSOL5 and TCFE8), under a constant pressure and various temperatures.

In case of a pure stoichiometric phase or a solution phase with a fixed composition, you must already define the system and get thermodynamic data from an appropriate solution database in the DATA module before using this TAB command. The phase name can be given either upper or lower or mixed cases, and can be abbreviated until it is unique, e.g. fcc, BCC, Liq, cem, Al5Fe2, etc. as the SSOL database is used for the tabulations, or GAS, FE-S, wustite, Fe2O3-hem, etc. as the SSUB database is used. The module then optionally goes through a specific sublattice or all the possible sublattices for the specified phase, as well as through the whole framework of a currently defined system (including all the defined elements/species, as well as the default defined vacancy and electron if necessary for the current database), when it prompts for inputs of site fractions for various species possibly occupying such sublattices. Therefore, you can tabulate thermodynamic properties for a pure phase, or for a solution phase as a pure end-member (with a composition definition for the corresponding non-interacting species on all necessary sublattices in the end-member), or for a solution phase as a real solution (with a composition definition for related interacting species on all necessary sublattices in the solution).

Moreover, the variation for one of the tabulated properties for a substance, a pure stoichiometric phase, or a solution phase with a fixed composition can be plotted against temperature as a graph or saved as an experimental file (with an extension of .EXP).
**Syntax**

<table>
<thead>
<tr>
<th>TABULATE_SUBSTANCE</th>
</tr>
</thead>
</table>

Substance (phase): `<Name of the species or phase>`

In case of a substance, give its chemical formula, e.g. Fe, H2, C1H6, FeC1, CaC1O3, MgSiO3, etc. When the TABULATE_SUBSTANCE `<SUBSTANCE>` command sequence is used for the first time in the TAB module, it always uses the SSUB Substances Database as the default database. If the SSUB database is not available for the current Thermo-Calc installation and a specific database has not been switched on yet, it may prompt to specify an appropriate substance or solution database (e.g. typing **SSUB2, SSUB3, SSUB4, SSUB5; SSOL2, SSOL4, SSOL5; TCFE3, TCFE4, TCFE5, TCFE6, TCFE7, TCFE8** etc.). Prior to this command, you can also use the **"SWITCH_DATABASE" on page 313** command in the TAB module to set the current database. If a solution database is set as the current database, only the neutral species that are valid substance standing by themselves as phases can be tabulated.

Before other prompts, a list of the used database, defined elements, getting-data sequence, references, etc. is displayed on screen. From such information, you know what the TAB module is performing.

In case of a pure stoichiometric phase or a solution phase, give its phase name, e.g. FCC, CEMENTITE, LIQUID, SLG, AQUEOUS, GAS, Al5Fe2, Fe-S, Wustite, Fe2O3-Hematite, etc.

**REMEmber:** It is important that you have already defined the system and gotten thermodynamic data from an appropriate solution database in the DATA module before using this TAB_SUB command. It automatically prompts for other options and necessary inputs for the definition of the composition of the specified phase.

For a pure stoichiometric phase defined with one single sublattice (such as Fe-S, Wustite, and Fe2O3-Hematite), no further composition definition is needed.

For a solution phase defined with one sublattice (such as AQUEOUS solution, GAS mixture and SLG solution), it requests n-1 site-fraction inputs for the phase constituents (if there are n species in the defined phase within the whole framework of currently defined system, including all the defined elements/species, as well as the default defined vacancy and electron if necessary for the current database); the n-th species is automatically assigned
<table>
<thead>
<tr>
<th>Syntax</th>
<th>TABULATE_SUBSTANCE</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>as the rest.</td>
</tr>
</tbody>
</table>

The sum of input site fractions must not exceed unity. For example, the following prompts and inputs can be seen for a LIQUID solution phase (from the SSOL database) within the Fe-Cr-Ni-C-N-O framework (Note that by default, the unprompted Ni species is assigned as the rest):

<table>
<thead>
<tr>
<th>Fraction of constituent (return for prompt): &lt;Return&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>C /1/: 0.05</td>
</tr>
<tr>
<td>CR /1/: 0.1</td>
</tr>
<tr>
<td>FE /1/: &lt;RETURN&gt;</td>
</tr>
</tbody>
</table>

Sum of fractions exceed unity, please reenter

| FE /1/: 0.8                                         |
| N /1/: 0.005                                        |

For a pure stoichiometric phase defined with two or more sublattices (such as Al5Fe2 inter-metallic stoichiometric phase) and for a solution phase defined with two or more sublattices (such as FCC alloy solution, and ION_LIQ ionic liquid solution, Al5Fe4 inter-metallic solution phase), it first asks for which sublattice the site-fractions of constituents shall be specified: the default value 0 for all possible sublattices, and a given positive number for a specific sublattice (this number must be reasonable for the currently specified phase, i.e. it must be smaller than the total sublattice number of the phase). Then, for the given sublattice or for all sublattices, it prompts for all the necessary inputs of site-fractions for the possible constituents on each sublattice n-1 times if there are n species on such a sublattice in the defined phase; the nth species on each of the sublattices are automatically assigned as the rest. For example, these prompts and inputs can be seen for an FCC solution phase (from the SSOL database) within the Fe-Cr-Ni-C-N-O framework (Note that by default, the unprompted O species on its sublattice 1 and VA on its sublattice 2 is assigned as the rest):

<table>
<thead>
<tr>
<th>Specify sublattice (0 for all) /0/: &lt;Return&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>FRACTIONS IN SUBLATTICE 1</td>
</tr>
<tr>
<td>CR /1/: 0.1</td>
</tr>
<tr>
<td>FE /1/: 0.8</td>
</tr>
</tbody>
</table>
### TABULATE_SUBSTANCE

<table>
<thead>
<tr>
<th>Syntax</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>N I /1/: .0995</td>
<td>FRACTIONS IN SUBLATTICE 2</td>
</tr>
<tr>
<td>C /1/: .05</td>
<td>N /1/: .05</td>
</tr>
<tr>
<td>Pressure /100000/: &lt;Pressure of interest, in Pa&gt;</td>
<td>Specify the constant pressure condition in Pa.</td>
</tr>
<tr>
<td>Low temperature limit /298.15/: &lt;T-low, in K&gt;</td>
<td>Specify the starting temperature K.</td>
</tr>
<tr>
<td>High temperature limit /298.15/: &lt;T-high, in K&gt;</td>
<td>Specify the ending temperature K.</td>
</tr>
<tr>
<td>Step in temperature /100/: &lt;T-step&gt;</td>
<td>Specify the temperature step for the tabulation.</td>
</tr>
<tr>
<td>Output file /Screen/: &lt;Return for screen, or type a file name&gt;</td>
<td>If you type Return for screen a list of basic thermodynamic functions for the chosen substance or for the specified pure or solution phase with the fixed composition is shown up as a table (which is demonstrated in the example outputs given below), and the command is terminated. If typing a file name, the table is both displayed on screen and saved as an *.EXP or a *.TAB file, and the program further prompts:</td>
</tr>
<tr>
<td>Graphical output /Y/: &lt;Y or N&gt;</td>
<td>For N a table is output to the screen, and the same table is saved as a basic text file with the default extension .TAB under the current working directory. In this case, the graph cannot be plotted. For Y a table is created with all the thermodynamic functions as normal (which is displayed on screen) as well as generates a graph with temperature on the X-axis and a chosen property on a certain column in the table on the Y-axis (which is plotted on screen and saved as an *.EXP file), and it also ask which column is to be plotted on the resulting graph:</td>
</tr>
<tr>
<td>Plot column ? /2/: &lt;1 or 2 or 3 or 4 or 5 or 6&gt;</td>
<td>Specify which property (as column number) to be plotted as the Y-axis (versus...</td>
</tr>
</tbody>
</table>
**Syntax**  
<table>
<thead>
<tr>
<th>TABULATE_SUBSTANCE</th>
</tr>
</thead>
</table>

Temperature as X-axis) as a graph on the screen. Simultaneously, all tabulated properties and the Y-axis setting (i.e. the plotted column) for the graph is written into an *.EXP file using the DATAPLOT format. The default column 2 is heat capacity, 3 enthalpy, 4 entropy and 5 Gibbs energy, and the additional column 6 is a user-entered function. The table displays on the screen. The plot then displays on the screen, followed by a POST: prompt. The POST module (postprocessor) automatically opens, and all types of the POST-module commands to refine the plotted diagram may be used. Possibilities include scaling the X/Y-axis, changing the X/Y-axis texts, etc. The command BACK or EXIT at the POST: prompt always takes you back to the TAB module.

Also see the *DATPLOT User Guide* included with this documentation set.

**Example Output 1**

For the **FCC** alloy phase as a non-ideal solution with a fixed composition

\[ \text{[Fe0.80,Cr0.10,Ni0.0995,O0.005][C0.05,N0.05,VA0.90]} \]

The following table is obtained by typing Return for screen at the prompt Output file \(/\text{SCREEN}/: \)

<table>
<thead>
<tr>
<th>OUTPUT FROM THERMO CALC</th>
<th>Phase : FCC</th>
<th>Pressure : 100000.00</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specie: CR1/--2</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*******************************************************************************
<table>
<thead>
<tr>
<th>T</th>
<th>Cp</th>
<th>H</th>
<th>S</th>
<th>G</th>
</tr>
</thead>
<tbody>
<tr>
<td>(K)</td>
<td>(Joule/K)</td>
<td>(Joule)</td>
<td>(Joule/K)</td>
<td>(Joule)</td>
</tr>
</tbody>
</table>
***********************************************************************
| 298.15     | 2.70517E+01 | 6.23824E+03 | 4.40241E+01 | -6.88755E+03 |
| 300.00     | 2.70889E+01 | 6.28832E+03 | 4.41916E+01 | -6.96915E+03 |
| 400.00     | 2.87304E+01 | 9.08420E+03 | 5.22235E+01 | -1.18052E+04 |
| 500.00     | 2.99904E+01 | 1.20222E+04 | 5.87742E+01 | -1.73649E+04 |
| 600.00     | 3.10889E+01 | 1.50770E+04 | 6.43408E+01 | -2.35275E+04 |
| 700.00     | 3.21166E+01 | 1.82375E+04 | 6.92106E+01 | -3.02100E+04 |
| 800.00     | 3.30994E+01 | 2.14982E+04 | 7.35633E+01 | -3.73524E+04 |
| 900.00     | 3.40742E+01 | 2.48569E+04 | 7.75182E+01 | -4.49094E+04 |
Example Output 2

For a phase, as either an end-member or real solution, the listed species name is irrelevant.

For the H2 species as a pure substance (using the SSUB5 database), the following table is obtained by typing Return for screen at the prompt Output file /SCREEN/, whilst the figure is generated by typing 5 at the prompt Plot column /2/:

<table>
<thead>
<tr>
<th>Pressure</th>
<th>Species</th>
<th>Cp</th>
<th>H</th>
<th>S</th>
<th>G</th>
</tr>
</thead>
<tbody>
<tr>
<td>1000.00</td>
<td>H2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>298.15</td>
<td>2.88369E+01</td>
<td>3.17684E-06</td>
<td>1.30680E+02</td>
<td>-3.89622E+04</td>
<td>2.83130E+04</td>
</tr>
<tr>
<td>300.00</td>
<td>2.91591E+01</td>
<td>2.95686E+03</td>
<td>1.39209E+02</td>
<td>-5.27268E+04</td>
<td>2.83130E+04</td>
</tr>
<tr>
<td>400.00</td>
<td>2.92650E+01</td>
<td>5.87874E+03</td>
<td>1.45729E+02</td>
<td>-6.69566E+04</td>
<td>2.83130E+04</td>
</tr>
<tr>
<td>500.00</td>
<td>2.93441E+01</td>
<td>8.80908E+03</td>
<td>1.51071E+02</td>
<td>-8.18336E+04</td>
<td>2.83130E+04</td>
</tr>
<tr>
<td>600.00</td>
<td>2.94579E+01</td>
<td>1.17488E+04</td>
<td>1.55602E+02</td>
<td>-9.71300E+04</td>
<td>2.83130E+04</td>
</tr>
<tr>
<td>700.00</td>
<td>2.96320E+01</td>
<td>1.47027E+04</td>
<td>1.59547E+02</td>
<td>-1.12935E+05</td>
<td>2.83130E+04</td>
</tr>
<tr>
<td>800.00</td>
<td>2.98786E+01</td>
<td>1.76776E+04</td>
<td>1.63050E+02</td>
<td>-1.29068E+05</td>
<td>2.83130E+04</td>
</tr>
<tr>
<td>900.00</td>
<td>3.02043E+01</td>
<td>2.06810E+04</td>
<td>1.66214E+02</td>
<td>-1.45533E+05</td>
<td>2.83130E+04</td>
</tr>
<tr>
<td>1000.00</td>
<td>3.05319E+01</td>
<td>2.37171E+04</td>
<td>1.69108E+02</td>
<td>-1.62302E+05</td>
<td>2.83130E+04</td>
</tr>
<tr>
<td>Temperature</td>
<td>Density</td>
<td>Diffusion</td>
<td>Activation Energy</td>
<td>Reaction Rate</td>
<td></td>
</tr>
<tr>
<td>-------------</td>
<td>---------</td>
<td>-----------</td>
<td>-------------------</td>
<td>---------------</td>
<td></td>
</tr>
<tr>
<td>1200.00</td>
<td>3.09281E+01</td>
<td>2.67897E+04</td>
<td>1.71781E+02</td>
<td>-1.79348E+05</td>
<td></td>
</tr>
<tr>
<td>1300.00</td>
<td>3.13615E+01</td>
<td>2.99040E+04</td>
<td>1.74274E+02</td>
<td>-1.96652E+05</td>
<td></td>
</tr>
<tr>
<td>1400.00</td>
<td>3.18115E+01</td>
<td>3.30625E+04</td>
<td>1.76614E+02</td>
<td>-2.14197E+05</td>
<td></td>
</tr>
<tr>
<td>1500.00</td>
<td>3.22641E+01</td>
<td>3.62664E+04</td>
<td>1.78824E+02</td>
<td>-2.31700E+05</td>
<td></td>
</tr>
<tr>
<td>1600.00</td>
<td>3.27094E+01</td>
<td>3.95151E+04</td>
<td>1.80921E+02</td>
<td>-2.49958E+05</td>
<td></td>
</tr>
<tr>
<td>1700.00</td>
<td>3.31406E+01</td>
<td>4.28078E+04</td>
<td>1.82917E+02</td>
<td>-2.68151E+05</td>
<td></td>
</tr>
<tr>
<td>1800.00</td>
<td>3.35526E+01</td>
<td>4.61426E+04</td>
<td>1.84823E+02</td>
<td>-2.86539E+05</td>
<td></td>
</tr>
<tr>
<td>1900.00</td>
<td>3.39415E+01</td>
<td>4.95175E+04</td>
<td>1.86648E+02</td>
<td>-3.05113E+05</td>
<td></td>
</tr>
<tr>
<td>2000.00</td>
<td>3.43045E+01</td>
<td>5.29300E+04</td>
<td>1.88398E+02</td>
<td>-3.23866E+05</td>
<td></td>
</tr>
</tbody>
</table>
TERNARY_DIAGRAM Commands

In this section:

TERNARY_DIAGRAM Module ................................................................. 331
**TERNARY_DIAGRAM Module**

The TERNARY_DIAGRAM module (short name, the TERN module) enables you to quickly calculate a simple ternary phase diagram.

To enter the module, at the SYS prompt type GOTO_MODULE TERNARY. There are no other commands for this module. Follow the prompts to plot a diagram.

Also see the Graphical Mode equivalent to this command, "Ternary Calculator" on page 133 as described in the Thermo-Calc User Guide.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>TERNARY_DIAGRAM</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompts</td>
<td>Database: /FEDEMO/</td>
</tr>
<tr>
<td></td>
<td>First element:</td>
</tr>
<tr>
<td></td>
<td>Second element:</td>
</tr>
<tr>
<td></td>
<td>Third element:</td>
</tr>
<tr>
<td></td>
<td>Phase diagram, Monovariants, or Liquidus Surface: /Phase_Diagram/</td>
</tr>
<tr>
<td></td>
<td>Temperture (C) /1000/</td>
</tr>
<tr>
<td></td>
<td>Global minimization on: /Y/</td>
</tr>
</tbody>
</table>
Thermodynamic Variables and Units

The following topics are about the different thermodynamic variables recognised by Thermo-Calc. The topics have information about how to define new derived variables and functions and how to express thermodynamic variables in non-default units. The POLY module only recognises default units, which are the SI units.

See example 44 in the Thermo-Calc Console Mode Examples to learn about using variables and functions.

In this section:

- Thermodynamic Variables ................................................................. 333
- Common Thermodynamic Variables .................................................. 333
- Derived Variables and Partial Derivatives .......................................... 350
- Defining New Derived Variables and Functions .................................. 352
- Derived Variables for Aqueous Solutions .......................................... 352
- Defining New Derived Variables for Aqueous Solutions ....................... 356
- Thermodynamic Variables and Wildcard Characters .......................... 357
- Units of State Variables and Derived Variables ................................. 358
Thermodynamic Variables

There are different thermodynamic variables in Thermo-Calc. Some are state variables, for example temperature, pressure and mole fraction. These characterize the equilibrium state of a system. You set them when you define your system in the POLY module before performing a calculation. They are also used in other modules such as DATA, GIBBS and PARROT. State variables that involve components can be used for the defined components, but not for any species. (To define new components in a defined system, use "DEFINE COMPONENTS" on page 196).

Other useful thermodynamic variables are derived from state variables with a mathematical function. Some derived variables are pre-defined by Thermo-Calc, such as normalized energetic and compositional extensive state variables for example. You use these by appending various normalizing suffixes to abbreviations that are associated with the state variables.

Thermodynamic variables can also be divided into extensive variables and intensive variables. An extensive variable is a variable whose value depends on the size of the system, whereas an intensive variable is a variable whose value is independent of system size.

More information about thermodynamic variables is available in the online help in Thermo-Calc Console Mode. Use the command "INFORMATION" on page 5, with a subject keyword such as one of the following as argument: STATE VARIABLES, INTENSIVE VARIABLES, EXTENSIVE VARIABLES, DERIVED VARIABLES, CONDITIONS (for condition settings), AXIS-VARIABLES (for stepping/mapping variable settings).

Common Thermodynamic Variables

The tables below list common thermodynamic variables. Most of these can be used to define equilibrium conditions in the POLY module unless otherwise indicated.

The variables are divided into the following tables:

- Intensive variables
- Energy-related extensive variables for whole system or for a phase
- Compositional extensive variables (overall amount of components in the whole system, or amount of a component in system or in a phase)
- Constitutional composition-related extensive variables (amount of a constituent/species on a sublattice site in a phase)
- Special quantities
How to read the tables

- The **Abbrev.** column shows the abbreviation that you use in the POLY module for referring to the variable. If the variable must be given any arguments, then these are given in parenthesis directly after the abbreviation. For most variables, this is also the abbreviation that you use to refer to the variable in other modules. However, some variables are referred to with a different abbreviation in the POST module. If this is the case, then this is noted at the bottom of the table.

- Variables that are specific to a species, in which case the species is specified as an argument (sp in the table below). If there are two or more sublattices in a given phase, then this argument is given as constituent#sublattice. This indicates a constituent on a specific sublattice or site in the phase (referred to by the # sign and a digit). For example, \( y(BCC, C#2) \) stands for the site fraction of the C species on the second sublattice site of the BCC_A2 solution phase.

- The **Unit** column show which unit that you can use to express the variable in the POLY module. This unit is always the SI unit. In other modules, state variables may be expressed in other units.

- The **Suffix** column shows the suffixes you can append to the variables. The R-suffix can be used with all compositional extensive state variables, but the suffix does not always change the value of the variable. This is indicated by putting the R in parenthesis.

These types of variables are listed in the following topics:

- "Intensive Variables" below
- "Extensive Variables" on the next page
- "Special Quantities" on page 339
- "The u-Fraction Variable" on page 340
- "Suffixes" on page 341

### Intensive Variables

<table>
<thead>
<tr>
<th>V</th>
<th>Abbrev.</th>
<th>Unit</th>
<th>Descript.</th>
<th>Domain</th>
<th>Suffix</th>
</tr>
</thead>
<tbody>
<tr>
<td>T</td>
<td>( T^1 )</td>
<td>K</td>
<td>Temperature</td>
<td>System</td>
<td></td>
</tr>
<tr>
<td>P</td>
<td>P</td>
<td>Pa</td>
<td>Pressure</td>
<td>System</td>
<td></td>
</tr>
</tbody>
</table>
### Thermodynamic Variables and Units

<table>
<thead>
<tr>
<th>V</th>
<th>Abbrev.</th>
<th>Unit</th>
<th>Descript.</th>
<th>Domain</th>
<th>Suffix</th>
</tr>
</thead>
<tbody>
<tr>
<td>( \mu )</td>
<td>MU(comp)</td>
<td>J/mol</td>
<td>Chemical potential</td>
<td>Component</td>
<td>R</td>
</tr>
<tr>
<td></td>
<td>MU(sp,ph)(^2)</td>
<td></td>
<td></td>
<td>Species relative to a solution phase</td>
<td>R</td>
</tr>
<tr>
<td>a</td>
<td>AC(comp)</td>
<td></td>
<td>Activity</td>
<td>Component</td>
<td>R</td>
</tr>
<tr>
<td></td>
<td>AC(sp,ph)(^2)</td>
<td></td>
<td></td>
<td>Species relative to a solution phase</td>
<td>R</td>
</tr>
<tr>
<td></td>
<td>LNAC(comp)(^3)</td>
<td>N/A</td>
<td></td>
<td>Component</td>
<td>R</td>
</tr>
<tr>
<td></td>
<td>LNAC(sp,ph)(^2)</td>
<td></td>
<td>ln(Activity)</td>
<td>Species relative to a solution phase</td>
<td>R</td>
</tr>
</tbody>
</table>

1. When plotting in POST, besides \(T\) (Kelvin), you can also use \(T\_C\) or \(T\_F\) to plot temperature in °C or °F.

2. Only for single-substitutional-lattice solution phases such as AQUEOUS solution and GASeous mixture phases and for interacting species on the substitutional sublattice of two-sublattice solution phases (such as the phases BCC\_A2 and M6C phases).

3. In natural logarithm (\(\ln\)AC=\(\mu\)/\(RT\))

---

**Extensive Variables**

**Energy-Related Extensive Variables for Whole System or for a Phase**

See [example tce44](#) in the *Thermo-Calc Console Mode Examples Guide* for an example of using variables and functions.
<table>
<thead>
<tr>
<th>Abbrev.</th>
<th>Unit</th>
<th>Descript.</th>
<th>Domain</th>
<th>Suffix</th>
</tr>
</thead>
<tbody>
<tr>
<td>V</td>
<td>m³</td>
<td>Volume</td>
<td>System</td>
<td>M, W, V, R</td>
</tr>
<tr>
<td>V(ph)¹</td>
<td></td>
<td></td>
<td>Phase</td>
<td>M, W, F, R</td>
</tr>
<tr>
<td>VP(ph)²</td>
<td></td>
<td></td>
<td>Phase</td>
<td>M, W, V, R</td>
</tr>
<tr>
<td>G</td>
<td>J</td>
<td>Gibbs energy</td>
<td>System</td>
<td>M, W, V, R</td>
</tr>
<tr>
<td>G(ph)¹</td>
<td></td>
<td></td>
<td>Phase</td>
<td>M, W, V, F, R</td>
</tr>
<tr>
<td>A</td>
<td>J</td>
<td>Helmholtz energy</td>
<td>System</td>
<td>M, W, V, R</td>
</tr>
<tr>
<td>A(ph)¹</td>
<td></td>
<td></td>
<td>Phase</td>
<td>M, W, V, F, R</td>
</tr>
<tr>
<td>U</td>
<td>J</td>
<td>Internal energy</td>
<td>System</td>
<td>M, W, V, R</td>
</tr>
<tr>
<td>U(ph)¹</td>
<td></td>
<td></td>
<td>Phase</td>
<td>M, W, V, F, R</td>
</tr>
<tr>
<td>H</td>
<td>J</td>
<td>Enthalpy</td>
<td>System</td>
<td>M, W, V, R</td>
</tr>
<tr>
<td>H(ph)</td>
<td></td>
<td></td>
<td>Phase</td>
<td>M, W, V, F</td>
</tr>
<tr>
<td>S</td>
<td>J/K</td>
<td>Entropy</td>
<td>System</td>
<td>M, W, V, R</td>
</tr>
<tr>
<td>S(ph)¹</td>
<td></td>
<td></td>
<td>Phase</td>
<td>M, W, V, F, R</td>
</tr>
<tr>
<td>Cp</td>
<td>J/mol/K</td>
<td>Heat capacity at constant pressure</td>
<td>System</td>
<td>R</td>
</tr>
<tr>
<td>HM.T³</td>
<td></td>
<td></td>
<td>Phase</td>
<td>R</td>
</tr>
<tr>
<td>Cp</td>
<td>J/mol/K</td>
<td>Heat capacity at constant volume</td>
<td>System</td>
<td>R</td>
</tr>
<tr>
<td>Cv</td>
<td>J/mol/K</td>
<td></td>
<td>System</td>
<td>R</td>
</tr>
<tr>
<td>V</td>
<td>Abbrev.</td>
<td>Unit</td>
<td>Descript.</td>
<td>Domain</td>
</tr>
<tr>
<td>---</td>
<td>--------------</td>
<td>------</td>
<td>----------------------------------</td>
<td>--------</td>
</tr>
<tr>
<td></td>
<td>HM(ph).T^4</td>
<td></td>
<td></td>
<td>Phase</td>
</tr>
<tr>
<td>D</td>
<td>DG(ph)(^5)</td>
<td>N/A</td>
<td>Driving force (thermodynamic factor)</td>
<td>Phase</td>
</tr>
</tbody>
</table>

1 For this variable, if the phase is unstable, then the variable gets a value of zero.

2 Do not use VP(ph) as a condition in POLY. Instead, use CHANGE_STATUS PHASE <PHASE>=FIX <AMOUNT> where the fixed <AMOUNT> is roughly equal to VPF(ph), which cannot be directly evaluated or listed. If the phase is unstable, then VP(ph) and its normalized quantities get zero value.

3 Use only if pressure has been set as a condition.

4 Use only if volume has been set as a condition.

5 Already divided by RT.

**Compositional Extensive Variables**

These are for the overall amount of components in whole system, or amount of a component in system or in a phase.

Do not use NP(ph) or BP(ph) as conditions in the POLY module. Instead use CHANGE_STATUS PHASE <PHASE>=FIX <AMOUNT> where the fixed <AMOUNT> is roughly equal to NPF(ph) or BPF(ph), which cannot be directly evaluated or listed. If the phase is unstable, then NP(ph) or BP(ph) (and its normalized quantities) get zero value.

When plotting the following quantities in POST, refer to each as indicated:

- X(comp) -> Mole-Fraction <comp> (or M_F)
- W(comp) -> Weight-Fraction <comp> (or W_F)
- X%(comp) -> Mole-Percent <comp> (or M_P)
- W%(comp) -> Weight-Percent <comp> (or W_P).
- u-f(ph,comp) -> U-F
<table>
<thead>
<tr>
<th>V</th>
<th>Abbrev.</th>
<th>Unit</th>
<th>Descript.</th>
<th>Domain</th>
<th>Suffix</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>n</td>
<td>N</td>
<td>mole</td>
<td>Moles</td>
<td>All components</td>
<td>M, W, V, (R)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>N(comp)</td>
<td></td>
<td></td>
<td>Component</td>
<td>M, W, V, (R)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>N(ph,comp)</td>
<td></td>
<td></td>
<td>Component in a phase</td>
<td>M, W, V, (R)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>NP(ph) (^1)</td>
<td></td>
<td></td>
<td>Phase</td>
<td>M, W, V, (R)</td>
<td>See above</td>
</tr>
<tr>
<td>b</td>
<td>B</td>
<td>gram</td>
<td>Mass</td>
<td>All components</td>
<td>M, W, V, (R)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>B(comp)</td>
<td></td>
<td></td>
<td>Component</td>
<td>M, W, V, (R)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>B(ph,comp)</td>
<td></td>
<td></td>
<td>Component in a phase</td>
<td>M, W, V, (R)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>BP(ph) (^1)</td>
<td></td>
<td></td>
<td>Phase</td>
<td>M, W, V, (R)</td>
<td>See above</td>
</tr>
<tr>
<td>x</td>
<td>X(comp)</td>
<td>N/A</td>
<td>Mole fraction</td>
<td>Component</td>
<td>(R)</td>
<td>See above</td>
</tr>
<tr>
<td></td>
<td>X(ph,comp)</td>
<td></td>
<td></td>
<td>Component in a phase</td>
<td>(R)</td>
<td></td>
</tr>
<tr>
<td>w</td>
<td>W(comp)</td>
<td>N/A</td>
<td>Mass (weight) fraction</td>
<td>Component</td>
<td>(R)</td>
<td>See above</td>
</tr>
<tr>
<td></td>
<td>W(ph,comp)</td>
<td></td>
<td></td>
<td>Component in a phase</td>
<td>(R)</td>
<td></td>
</tr>
<tr>
<td>x%</td>
<td>X%(comp) (^2)</td>
<td>N/A</td>
<td>Mole percent</td>
<td>Component</td>
<td>(R)</td>
<td>See above</td>
</tr>
</tbody>
</table>
### Constitutional Composition-Related Extensive Variable

This is the amount of a constituent/species on a sublattice site in a phase.

<table>
<thead>
<tr>
<th>V</th>
<th>Abbrev.</th>
<th>Unit</th>
<th>Descript.</th>
<th>Domain</th>
<th>Suffix</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>y</td>
<td>Y (ph,cons#sub)</td>
<td>N/A</td>
<td>Site fraction</td>
<td>Constituent on a sublattice site (denoted by # and a digit) in a phase</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Special Quantities

<table>
<thead>
<tr>
<th>V</th>
<th>Abbrev.</th>
<th>Unit</th>
<th>Descript.</th>
<th>Domain</th>
<th>Suffix</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Q</td>
<td>QF(ph)¹</td>
<td>N/A</td>
<td>Phase stability function</td>
<td>Phase</td>
<td>R</td>
<td>Under a condition and system definition, QFR(ph) = QF(ph)</td>
</tr>
<tr>
<td>V</td>
<td>Abbrev.</td>
<td>Unit</td>
<td>Descript.</td>
<td>Domain</td>
<td>Suffix</td>
<td></td>
</tr>
<tr>
<td>----</td>
<td>---------------</td>
<td>------</td>
<td>-----------------</td>
<td>--------</td>
<td>--------</td>
<td>------------</td>
</tr>
<tr>
<td>Tc</td>
<td>TC((ph)) ^2</td>
<td>K</td>
<td>Curie temperature</td>
<td>Phase</td>
<td>R</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Under a condition and system definition, (TCR((ph)) = TC((ph)))</td>
</tr>
<tr>
<td>Mb</td>
<td>BMAG((ph))^3</td>
<td>N/A</td>
<td>Bohr magneton number</td>
<td>Phase</td>
<td>R</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Under a condition and system definition, (BMAGR((ph)) = BMAG((ph)))</td>
</tr>
</tbody>
</table>

1 Negative when phase composition is inside a spinodal, otherwise positive. Can be used to find out if an equilibrium is within the miscibility gap for a solution phase. Cannot be used as a condition.

2 Calculated for phases with magnetic contributions in an equilibrium state. Cannot be used as a condition, but can be plotted in POST or evaluated in POLY using SHOWVALUE.

3 Calculated for phases with magnetic contributions in an equilibrium state.

**The u-Fraction Variable**

The u-fraction is an important quantity in some single-point or stepping paraequilibrium calculations in the POLY module and in the DICTRA module. You can apply the variable in a paraequilibrium calculation to the substitutional matrix component, the substitutional alloying components or the interstitial component. The u-fraction is denoted as \(u_i\) for the \(i\)-th system component \(n\) of a whole system or of a specific phase in various equilibrium states (such as full-equilibria, partial-equilibria, para-equilibria, local-equilibria).

Generally, the u-fraction is defined as:

\[
\frac{x_i}{\sum_{j \in S} x_j}
\]

The sum of \(x_j\) in the denominator is calculated for all substitutional alloying elements in the whole system or in a specific phase. The variable \(x_j\) in the numerator stands for the mole-fraction of the \(i\)-th component in the whole system or in the specific phase.
Suffixes

Suffixes may be appended to all extensive variables and to some intensive variables. Some suffixes can be used to enter the value of variables in normalized form. These are referred to as normalizing suffixes. If the variable that you create with a normalizing suffix is based on a state variable that can be set as a condition in POLY, then the normalized variable can also be set as a condition in POLY.

The normalizing suffixes are M (per mole), W (per mass in gram), V (per volume in m³) and F (per mole formula unit). There is also a reference state suffix R, which you can use if you want the value of a thermodynamic variable to be calculated with respect to a reference state that have previously set.

Normalizing Suffixes

When variables that express system and phase quantities are normalized, the following general rules are used:

- System quantities are normalized by the total system size (in terms of N, B or V).
- Phase quantities are normalized by the phase amount [in terms of NP(ph), BP(ph) or VP(ph)].

The normalized quantities of G(ph), A(ph), U(ph), H(ph), S(ph) and V(ph) are calculated according to the thermodynamic model used for the phase (e.g. GM(ph), AM(ph), UM(ph), HM(ph), SM(ph) and VM(ph)). These quantities are calculated using the first derivatives of the Gibbs energy expressed for the phase with respect to the current composition of the system.

The tables describe the normalizing suffixes for the different state variables.

G, A, U, H, S and V of a Whole System

<table>
<thead>
<tr>
<th>Suffix</th>
<th>Description</th>
<th>Example(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>M (per mole)</td>
<td>First derivative of the variable with regard to the total system size in terms of N.</td>
<td>GM is the Gibbs energy per mole of the system (J/mol). GM = (\frac{\partial G}{\partial N})</td>
</tr>
<tr>
<td>W (per mass in gram)</td>
<td>First derivative of the variable with regard to the total system size in terms of B.</td>
<td>GW is the Gibbs energy per mass of the system (J/g). GW = (\frac{\partial G}{\partial B})</td>
</tr>
<tr>
<td>Suffix</td>
<td>Description</td>
<td>Example(s)</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>V (per volume in m³)</td>
<td>First derivative of the variable with regard to the total system size in terms of V. VV does not have to be evaluated.</td>
<td>GV is the Gibbs energy per volume of the system (J/m³). GV = ∂G/∂V</td>
</tr>
</tbody>
</table>
### $G(\text{ph}), A(\text{ph}), U(\text{ph}), H(\text{ph}), S(\text{ph})$ and $V(\text{ph})$ of a Phase

<table>
<thead>
<tr>
<th>Suffix</th>
<th>Description</th>
<th>Example(s)</th>
</tr>
</thead>
</table>
| $M$ (per mole)              | First derivative of the variable with regard to the phase amount in terms of $NP(\text{ph})$. | $GM(\text{ph})$ is Gibbs energy of the phase per mole of the phase $(\text{J/mol})$.  
$GM(\text{ph}) = \partial G(\text{ph})/\partial NP(\text{ph})$ |
| $W$ (per mass in gram)      | First derivative of the variable with regard to the phase amount in terms of $BP(\text{ph})$. | $GW(\text{ph})$ is Gibbs energy of the phase per mass of the phase $(\text{J/mol})$.  
$GW(\text{ph}) = \partial G(\text{ph})/\partial BP(\text{ph})$ |
| $V$ (per volume in $m^3$)   | First derivative of the variable with regard to the phase amount in terms of $VP(\text{ph})$. $VV(\text{ph})$ does not have to be evaluated. | $GV(\text{ph})$ is Gibbs energy of the phase per volume of the phase $(\text{J/mol})$.  
$GV(\text{ph}) = \partial G(\text{ph})/\partial VP(\text{ph})$ |
| $F$ (per mole formula unit) | First derivative of the variable with regard to the phase amount in terms of $NP(\text{ph})$ and $NA$ ($NA$ is the total atomic number in the phase formula) | $GF(\text{ph})$ is the Gibbs energy of the phase per formula unit of the phase $(\text{J/mol})$.  
$GF(\text{ph}) = \partial G(\text{ph})/\partial NP(\text{ph}) \times NA$ |
### DG(ph) of a Phase

<table>
<thead>
<tr>
<th>Suffix</th>
<th>Description</th>
<th>Example(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>M (per mole)</strong></td>
<td>Theoretically, the first derivative of the variable with regard to the phase amount in terms of NP (ph). Since DG(ph) is not directly calculated, the second derivative of the Gibbs energy expressed for the phase in question with respect to the current compositions in the equilibrium state of the system is calculated instead. DGM(ph) cannot not be set as a condition since it is only calculated under a certain type of equilibrium state.</td>
<td>DGM(ph) is driving force for precipitation of the phase per mole of components. DGM(ph) = ( \frac{\partial \text{DG}(\text{ph})}{\partial \text{NP} (\text{ph})} )</td>
</tr>
<tr>
<td><strong>W (per mass in gram)</strong></td>
<td>Theoretically, the first derivative of the variable with regard to the phase amount in terms of BP (ph). Since DG(ph) is not directly calculated, the second derivative of the Gibbs energy expressed for the phase in question with respect to the current compositions in the equilibrium state of the system is calculated instead. DGW(ph) cannot not be set as a condition since it is only calculated under a certain type of equilibrium state.</td>
<td>DGW(ph) is driving force for precipitation of the phase per mass of components. DGW(ph) = ( \frac{\partial \text{DG}(\text{ph})}{\partial \text{BP} (\text{ph})} )</td>
</tr>
<tr>
<td><strong>V (per volume in m³)</strong></td>
<td>Theoretically, the first derivative of the variable with regard to the phase amount in terms of VP (ph). Since DG(ph) is not directly calculated, the second derivative of the Gibbs energy expressed for the phase in question with respect to the current compositions in the equilibrium state of the system is calculated instead. DGV(ph) cannot not be set as a condition since it is only calculated under a certain type of equilibrium state.</td>
<td>DGV(ph) is driving force for precipitation of the phase per volume of components. DGV(ph) = ( \frac{\partial \text{DG}(\text{ph})}{\partial \text{VP} (\text{ph})} )</td>
</tr>
<tr>
<td>Suffix</td>
<td>Description</td>
<td>Example(s)</td>
</tr>
<tr>
<td>--------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>F (per mole formula unit)</td>
<td>Theoretically, the first derivative of the variable with regard to the phase amount in terms of NP (ph) and NA (NA is the total atomic number in the phase formula). Since DG(ph) is not directly calculated, the second derivative of the Gibbs energy expressed for the phase in question with respect to the current compositions in the equilibrium state of the system is calculated instead. DGF(ph) cannot not be set as a condition since it is only calculated under a certain type of equilibrium state.</td>
<td>DGF(ph) is driving force for precipitation of the phase per formula unit of components. DGF(ph) = ∂DG(ph)/∂NP(ph)*NA</td>
</tr>
</tbody>
</table>
### N and B of a System

<table>
<thead>
<tr>
<th>Suffix</th>
<th>Description</th>
<th>Example(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>M (per mole)</td>
<td>First derivative of the variable with regard to the total system size in terms of N. NM does not have to be evaluated. BM cannot be set as a condition.</td>
<td>BM is mass (gram) of components per mole of the system (g/mol). BM = ∂B/∂N</td>
</tr>
<tr>
<td>W (per mass in gram)</td>
<td>First derivative of the variable with regard to the total system size in terms of B. BW does not have to be evaluated. NW cannot be set as a condition.</td>
<td>NW is mole number of components per mass of the system (mol/g). NW = ∂N/∂B</td>
</tr>
<tr>
<td>V (per volume in m³)</td>
<td>First derivative of the variable with regard to the total system size in terms of V. BV is the density of the entire system.</td>
<td>NV is mole number of components per volume of the system (mol/m³). NV = ∂N/∂V BV is the density of the entire system (g/m³). BV = ∂B/∂V</td>
</tr>
</tbody>
</table>

### N (comp) and B(comp) of a Component in the System

<table>
<thead>
<tr>
<th>Suffix</th>
<th>Description</th>
<th>Example(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>M (per mole)</td>
<td>First derivative of the variable with regard to the total system size in terms of N. BM(comp) cannot be set as a condition.</td>
<td>NM(comp) is the mole of a component per mole of the system (i.e. mole fraction, which also is expressed as X(comp)). NM(comp) = ∂N(comp)/∂N</td>
</tr>
<tr>
<td>W (per mass in gram)</td>
<td>First derivative of the variable with regard to the total system size in terms of B. NW(comp) cannot be set as a condition.</td>
<td>BW(comp) is mass (gram) of a component per mass of the system (i.e. mass fraction, which also is expressed as W(comp)). BW(comp) = ∂B(comp)/∂B</td>
</tr>
<tr>
<td>Suffix</td>
<td>Description</td>
<td>Example(s)</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------------------------------------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>V (per volume in m³)</td>
<td>First derivative of the variable with regard to the total system size in terms of V.</td>
<td>NV(comp) is mole number of a component per volume of the system (mol/m³). NV(comp) = ∂N(comp)/∂V</td>
</tr>
</tbody>
</table>
## NP(ph), BP(ph) and VP(ph) of a Phase in the System

<table>
<thead>
<tr>
<th>Suffix</th>
<th>Description</th>
<th>Example(s)</th>
</tr>
</thead>
</table>
| M (per mole) | BPM(ph) and VPM(ph): First derivative of the variable with regard to the phase amount in terms of NP(ph).  
NPM(ph): First derivative of the variable with regard to the total system size in terms of N. | BPM(ph) is mass (gram) of a phase per moles of the system (g/mol).  
BPM(ph) = ∂BP(ph)/∂N  
NPM(ph) is number of moles of a phase per moles of the system (mole fraction).  
NPM(ph) = ∂NP(ph)/∂N |
| W (per mass in gram) | NPW(ph) and VPW(ph): First derivative of the variable with regard to the phase amount in terms of BP(ph).  
BPW(ph): First derivative of the variable with regard to the total system size in terms of B. | VPW(ph) is volume (m3) of a phase per mass of the system (m3/g)  
VPW(ph) = ∂VP(ph)/∂B  
BPW(ph) is mass (gram) of a phase per mass of the system (mass fraction)  
BPW(ph) = ∂BP(ph)/∂B |
| V (per volume in m³) | NPV(ph) and BPV(ph): First derivative of the variable with regard to the phase amount in terms of VP(ph).  
VPV(ph): First derivative of the variable with regard to the total system size in terms of V. | NPV(ph) is number of moles of a phase per volume of the system (mol/m³).  
NPV(ph) = ∂NP(ph)/∂V  
VPV(ph) is volume (m³) of a phase per volume of the system (volume fraction).  
VPV(ph) = ∂VP(ph)/∂V |
**N(ph,comp) and B(ph,comp) of a Component in a Phase**

<table>
<thead>
<tr>
<th>Suffix</th>
<th>Description</th>
<th>Example(s)</th>
</tr>
</thead>
</table>
| M (per mole)   | First derivative of the variable with regard to the phase amount in terms of NP (ph) of the phase. | NM(ph,comp) is number of moles of a component per mole of a phase (i.e. mole fraction of a component in a phase, which is equivalent to X(ph, comp)).  
NM(ph,comp) = ∂N(ph,comp)/∂NP(ph) |
| W (per mass in gram) | First derivative of the variable with regard to the phase amount in terms of BP (ph) of the phase. | BW(ph,comp) is mass (gram) of a component per mass of a phase (i.e. mass fraction of a component in a phase, which is equivalent to W(ph,comp)).  
BW(ph,comp) = ∂B(ph,comp)/∂BP(ph) |
| V (per volume in m³) | First derivative of variable with regard to the phase amount in terms of VP(ph) of the phase. | NV(ph,comp) is mole number of a component per volume of a phase (mol/m³).  
NV(ph,comp) = ∂N(ph,comp)/∂VP(ph) |

**The Reference State Suffix R**

You can use the reference state suffix R for some thermodynamic variables to calculate their value with respect to a reference state that you have previously set for a system component with the "SET_REFERENCE_STATE" on page 224 command in POLY (or in a response-driven modules such as the POURBAIX module). The value of energy-related variables that are used with the R suffix depends on the reference states of all the components in the defined system.

It is possible to use an R suffix on all compositional extensive state variables as well, but the value of the state variable is always the same, with or without the suffix.

If the reference state for a system component is the default reference state (the stable reference state (SER) which is defined in a Thermo-Calc database), then MUR(comp)= MU(comp), ACR(comp)= AC(comp) and LNACR(comp)= LNAC(comp).

In the case of some thermodynamic variables, you can also use the R suffix to express chemical potentials and activities of species relative to some single-substitutional-lattice solution phases (such as aqueous solution, gaseous mixture, metallic liquid solution, slag mixture or MO solid solution). These state variables are MU(sp,ph), MUR(sp,ph), AC(sp,ph),
ACR(sp,ph), LNAC(sp,ph) and LNACR(sp,ph).

The reference states and standard states of various solution species are pre-defined for some solution phases in some databases. For all solution species in any solution model in any database, it is always the case that MUR(sp,ph)= MU(sp,ph), ACR(sp,ph)= AC(sp,ph) and LNACR(sp,ph)= LNAC(sp,ph).

### Derived Variables and Partial Derivatives

Many derived variables can be obtained easily by using partial derivatives of state variables, such as heat capacity, thermal expansivity, isothermal compressibility, among others.

Derivatives of state variables can be defined or evaluated by putting a dot (.) between two state variables. The variable after the dot must be a condition that you have set when you defined your system. For example, the heat capacity (at constant pressure or volume) of a system is the partial derivative of the state variable enthalpy with respect to temperature. To evaluate this derivative, use the designation HM.T, where temperature is a state variable that you have set already.

Any partial derivative of a state variable with respect to another can be defined or evaluated as a derived variable by using the dot (.) notation.

### Derived Variables Dot Notation Examples

The following table shows some examples:

<table>
<thead>
<tr>
<th>Derived variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HM.T = (\partial\text{HM}/\partial T)</td>
<td>Heat capacity for the system at either constant P if pressure is a condition or constant V if volume is a condition.</td>
</tr>
<tr>
<td>HM(ph).T = (\partial\text{HM(ph)}/\partial T)</td>
<td>Heat capacity for a phase at either constant P if pressure is a condition or constant V if volume is a condition.</td>
</tr>
<tr>
<td>H.T = (\partial\text{H}/\partial T)</td>
<td>Heat capacity for the system multiplied by total mole number of components, i.e., (\partial\text{H}/\partial T = \text{Cp<em>N}) if pressure is a condition in a closed system or (\partial\text{H}/\partial T = \text{Cv</em>N}) if volume is a condition in a closed system.</td>
</tr>
<tr>
<td>Derived variable</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>( H(\text{ph}).T = \frac{\partial H(\text{ph})}{\partial T} )</td>
<td>Heat capacity for a phase multiplied by the sum of ( NP(\text{ph}) ) and ( HM(\text{ph}) )( \frac{\partial NP(\text{ph})}{\partial T} ), i.e., ( \text{Cp}(\text{ph}) \cdot NP(\text{ph}) + HM(\text{ph}) \cdot \frac{\partial NP(\text{ph})}{\partial T} ) if pressure is a condition or ( \text{Cv}(\text{ph}) \cdot NP(\text{ph}) + HM(\text{ph}) \cdot \frac{\partial NP(\text{ph})}{\partial T} ) if volume is a condition.</td>
</tr>
<tr>
<td>( VM.T = \frac{\partial VM}{\partial T} )</td>
<td>Thermal expansivity of the system (already multiplied by the total molar volume), i.e., ( \frac{\partial VM}{\partial T} = \alpha \cdot VM ).</td>
</tr>
<tr>
<td>( VM(\text{ph}).T = \frac{\partial VM(\text{ph})}{\partial T} )</td>
<td>Thermal expansivity of a phase (already multiplied by its molar volume), i.e., ( \frac{\partial VM(\text{ph})}{\partial T} = \alpha(\text{ph}) \cdot VM(\text{ph}) ).</td>
</tr>
<tr>
<td>( V.T = \frac{\partial V}{\partial T} )</td>
<td>Thermal expansivity of the system (already multiplied by the total volume), i.e., ( \frac{\partial V}{\partial T} = \alpha \cdot V ).</td>
</tr>
<tr>
<td>( V(\text{ph}).T = \frac{\partial V(\text{ph})}{\partial T} )</td>
<td>Thermal expansivity of a phase (already multiplied by the phase volume) plus the ( VM(\text{ph}) \cdot \frac{\partial NP(\text{ph})}{\partial T} ) term, i.e., ( \frac{\partial V(\text{ph})}{\partial T} = \alpha(\text{ph}) \cdot V(\text{ph}) = \alpha(\text{ph}) \cdot VM(\text{ph}) \cdot NP(\text{ph}) + VM(\text{ph}) \cdot \frac{\partial NP(\text{ph})}{\partial T} ).</td>
</tr>
<tr>
<td>( VM.P = -\frac{\partial VM}{\partial P} )</td>
<td>Isothermal compressibility of the system (already multiplied by the total molar volume), i.e., ( -\frac{\partial VM}{\partial P} = \kappa \cdot VM ).</td>
</tr>
<tr>
<td>( VM(\text{ph}).P = -\frac{\partial VM(\text{ph})}{\partial P} )</td>
<td>Isothermal compressibility of a phase (already multiplied by its molar volume), i.e., ( -\frac{\partial VM(\text{ph})}{\partial P} = \kappa(\text{ph}) \cdot VM(\text{ph}) ).</td>
</tr>
<tr>
<td>( V.P = -\frac{\partial V}{\partial P} )</td>
<td>Isothermal compressibility of the system (already multiplied by the total volume), i.e., ( -\frac{\partial V}{\partial P} = \kappa \cdot V ).</td>
</tr>
<tr>
<td>( V(\text{ph}).P = -\frac{\partial V(\text{ph})}{\partial P} )</td>
<td>Isothermal compressibility of a phase (already multiplied by the phase volume) plus the ( VM(\text{ph}) \cdot \frac{\partial NP(\text{ph})}{\partial P} ) term, i.e., ( -\frac{\partial V(\text{ph})}{\partial P} = \kappa(\text{ph}) \cdot V(\text{ph}) = \kappa(\text{ph}) \cdot VM(\text{ph}) \cdot NP(\text{ph}) + VM(\text{ph}) \cdot \frac{\partial NP(\text{ph})}{\partial P} ).</td>
</tr>
<tr>
<td>( T.X(\text{comp}) = \frac{\partial T}{\partial X(\text{comp})} )</td>
<td>Slope of a phase boundary on a T-X(\text{comp}) phase diagram with respect to mole fraction of the component in the system.</td>
</tr>
<tr>
<td>( T.W(\text{comp}) = \frac{\partial T}{\partial W(\text{comp})} )</td>
<td>Slope of a phase boundary on a T-W(\text{comp}) phase diagram with respect to mass of the component in the system.</td>
</tr>
</tbody>
</table>
Derived variable | Description
--- | ---
\(T.X(\text{ph,comp}) = \frac{\partial T}{\partial X(\text{ph,comp})}\) | Slope of a phase boundary on a T-X(\text{ph,comp}) phase diagram with respect to mole fraction of the component in the phase.
\(T.W(\text{ph,comp}) = \frac{\partial T}{\partial W(\text{ph,comp})}\) | Slope of a phase boundary on a T-W(\text{ph,comp}) phase diagram with respect to mole fraction of the component in the phase.
\(P.T = \frac{\partial P}{\partial T}\) | Slope of a phase boundary on a P-T phase diagram (Note that the equilibrium with phase assemblage must be calculated first).

**Defining New Derived Variables and Functions**

You can define additional derived variables or functions based on a state variable by using "ENTER_SYMBOL" on page 247. Any derived variable or function must have a unique name that starts with a letter and has a maximum number of eight characters. These characters can include both uppercase and lowercase letters, numerical digits and the underscore (_). No other characters are allowed.

The difference between new derived variables introduced with the ENTER_SYMBOL command and new functions introduced with the same command is as follows. Whenever Thermo-Calc calculates the value of a function (as part of an equilibrium calculation for example), all functions related to the defined system is evaluated. An entered derived variable, on the other hand, is only evaluated when it is defined and when it is re-evaluated with "EVALUATE_FUNCTIONS" on page 208.

**Derived Variables for Aqueous Solutions**

Standard state variables used for other phases can be directly applied to the aqueous solution phase. In addition, there are pre-defined derived variables for the aqueous solution phase in particular.

Examples of predefined derived variables for the aqueous solution phase are listed and briefly described in the following tables. Some derived variables for a gaseous mixture phase are also shown. This is because EOS (Equation of State) expressions, standard thermodynamic properties and transport properties of the pure solvent H2O are also expressions and properties of the pure gaseous species H2O.
For Aqueous Solution Phase

<table>
<thead>
<tr>
<th>Name</th>
<th>Abbrev.</th>
<th>Units</th>
<th>Description</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>pH</td>
<td>PH</td>
<td>N/A</td>
<td>Acidity</td>
<td>of the aqueous solution phase&lt;br&gt;[ \text{pH} = -\log_{10}(\text{AC}(\text{H}^+)) = -\log_{10}(\text{ACR}(\text{H}^+,\text{AQ})) ]</td>
</tr>
<tr>
<td>Eh</td>
<td>EH</td>
<td>V, mV</td>
<td>Hypothetical electric potential</td>
<td>of the aqueous solution phase&lt;br&gt;[ \text{Eh} = \frac{u(ZE)}{96485.309} ]</td>
</tr>
<tr>
<td>Pe</td>
<td>PE</td>
<td>N/A</td>
<td>Logarithm of the hypothetical electron activity</td>
<td>of the aqueous solution phase&lt;br&gt;[ \text{pe} = \frac{u(ZE)}{2.3025851*RT} ]</td>
</tr>
<tr>
<td>Ah</td>
<td>AH</td>
<td>kJ, kcal</td>
<td>Thermodynamic affinity per electron</td>
<td>of a redox couple wrt the standard hydrogen electrode in the aqueous solution phase&lt;br&gt;[ \text{Ah} = u(ZE) ]</td>
</tr>
<tr>
<td>yw</td>
<td>YH2O</td>
<td>N/A</td>
<td>Mole fraction</td>
<td>of the solvent H2O in the aqueous solution phase&lt;br&gt;[ \text{YH2O} = \text{Y}(	ext{AQ},\text{H2O}) ]</td>
</tr>
<tr>
<td>Nw</td>
<td>AH2O</td>
<td>mole</td>
<td>Mole number</td>
<td>of 1.0 kg of solvent H2O&lt;br&gt;[ \text{AH2O} = 55.508435 ]</td>
</tr>
<tr>
<td>Nsp</td>
<td>NSH2O</td>
<td>mole</td>
<td>Mole number, ( \text{NS}(	ext{AQ},\text{H2O}) )</td>
<td>of the solvent (H2O) in the aqueous solution phase&lt;br&gt;[ \text{NS}(	ext{AQ},\text{H2O}) = \text{YH2O} \times \text{NP}(	ext{AQ}) ]</td>
</tr>
<tr>
<td>Name</td>
<td>Abbrev.</td>
<td>Units</td>
<td>Description</td>
<td>Comments</td>
</tr>
<tr>
<td>------</td>
<td>---------</td>
<td>----------------</td>
<td>--------------------------------------</td>
<td>----------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>NS#</td>
<td>M</td>
<td>mol/kg_H2O</td>
<td>Mole number, NS(AQ,sp)</td>
<td>of a solute species in the aqueous solution phase NS(AQ,sp) = Y (AQ,sp)*NP(AQ)</td>
</tr>
<tr>
<td>ML#</td>
<td>m*</td>
<td>equivalent molality</td>
<td>Molality, ML(AQ,sp)</td>
<td>of a solute species in the aqueous phase ML(AQ,sp) = Y (AQ,sp)*AH2O/YH2O</td>
</tr>
<tr>
<td>TIM</td>
<td>m*</td>
<td>equivalent molality</td>
<td>Total molality</td>
<td>of all solute species in the aqueous solution phase TIM = sum[ML(AQ,sp)]ions + sum [ML(AQ,sp)]complexes</td>
</tr>
<tr>
<td>TIC#</td>
<td>mt</td>
<td>equivalent molality</td>
<td>Total ionic concentration, TIC(AQ,sp)</td>
<td>of a cation I in the aqueous phase TIC(AQ,sp) = sum[ML(AQ,sp)]*V(spl-in-spJ)]</td>
</tr>
<tr>
<td>ISTR</td>
<td>I</td>
<td>N/A</td>
<td>Ionic strength</td>
<td>of the aqueous solution phase ISTR=1/2*sum[ML(AQ,sp)*Z(AQ,sp)**2]</td>
</tr>
<tr>
<td>RCH2O</td>
<td>γ</td>
<td>N/A</td>
<td>Activity coefficient, RC(H2O,AQ)</td>
<td>of the solvent (H2O) RC(H2O,AQ) = ACR(H2O,AQ)/YH2O</td>
</tr>
<tr>
<td>RC#</td>
<td>αi</td>
<td>N/A</td>
<td>Activity coefficient, RC(sp,AQ)</td>
<td>of a solute species RC(sp,AQ) = ACR(sp,AQ)/YH2O</td>
</tr>
<tr>
<td>AIH2O</td>
<td>αi</td>
<td>N/A</td>
<td>Activity,</td>
<td>of the solvent (H2O), Adamson, 1973, 1974</td>
</tr>
<tr>
<td>Name</td>
<td>Abbrev.</td>
<td>Units</td>
<td>Description</td>
<td>Comments</td>
</tr>
<tr>
<td>------</td>
<td>---------</td>
<td>-------</td>
<td>-------------</td>
<td>----------</td>
</tr>
<tr>
<td>AI#</td>
<td>AI</td>
<td></td>
<td>Activity,</td>
<td>of a solute species related to the aqueous solution phase,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>AI(sp,AQ)</td>
<td>AI(sp,AQ) = ACR (sp,AQ)*AH2O</td>
</tr>
<tr>
<td>LogAI#</td>
<td></td>
<td></td>
<td>Log10 Activity, LogAI(H2O,AQ), LogAI(sp,AQ)</td>
<td>of the solvent or a solute species related to the aqueous solution phase in common logarithm,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>LogAI(H2O,AQ) = log10[AI(H2O,AQ)]</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>LogAI(sp,AQ) = log10[AI(sp,AQ)]</td>
</tr>
<tr>
<td>αw</td>
<td>AW</td>
<td>N/A</td>
<td>Activity</td>
<td>of H2O in the aqueous solution phase</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>AW = ACR(H2O,AQ)</td>
</tr>
<tr>
<td>φ</td>
<td>OS</td>
<td>N/A</td>
<td>Osmotic coefficient</td>
<td>of aqueous solution phase</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>OS = -55.508435*lnAW/TIM</td>
</tr>
<tr>
<td>At1</td>
<td>AT1</td>
<td>equil_mol/kg_H2O</td>
<td>Titration alkalinity (definition 1)</td>
<td>of the aqueous solution phase</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Generally defined as the equivalent molality of carbonate and bicarbonate at the methyl orange endpoint (pH=4.5).</td>
</tr>
</tbody>
</table>
### For Gaseous Mixture Phase

<table>
<thead>
<tr>
<th>Name</th>
<th>Abbrev.</th>
<th>Units</th>
<th>Description</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>γ</td>
<td>RA#</td>
<td>N/A</td>
<td>Activity coefficient, RA(sp,GAS)</td>
<td>of a gaseous species in the gaseous mixture ( \gamma_{RA}(sp,GAS) = \text{function}(Y,T,P) )</td>
</tr>
<tr>
<td>γ*</td>
<td>RF#</td>
<td>N/A</td>
<td>Fugacity coefficient, RF(sp,GAS)</td>
<td>of a pure gaseous species under TP ( \gamma_{RF}(sp,GAS) = \text{function}(T,P/V) )</td>
</tr>
<tr>
<td>F</td>
<td>FUG#</td>
<td>pa, bar, psi</td>
<td>Fugacity, FUG(sp,GAS)</td>
<td>of a gaseous species in the gaseous mixture ( FUG(sp,GAS) = \text{RA}(sp,GAS) \cdot \text{RF}(sp,GAS) \cdot Y_{(GAS,sp)} \cdot P )</td>
</tr>
<tr>
<td>ft</td>
<td>TFUG</td>
<td>pa, bar, psi</td>
<td>Total gas fugacity</td>
<td>of the gaseous mixture phase ( TFUG = \text{sum}[FUG(sp,GAS)] )</td>
</tr>
</tbody>
</table>

### Defining New Derived Variables for Aqueous Solutions

You can define many different additional derived variables and functions. For instance, the partition coefficient of a component between two phases is defined as follows:

\[
P_c\langle name \rangle = \frac{X(\text{phase1, component})}{X(\text{phase2, component})}
\]

Another example is the activity coefficient of a component in the system. It is defined as follows:

\[
R_c\langle name \rangle = \frac{\text{ACR}(\text{component})}{X(\text{component})}
\]
The activity coefficient of a species in a solution phase depends on which model definitions on the reference states that are used and it depends on the standard states for the species. If the standard state of a species is defined to be the same as the pure species in a substitutional phase, then the activity coefficient of the species can be calculated as:

\[ RC\text{<name>} = \frac{ACR(\text{species,phase})}{Y(\text{phase,species})} \]

In some cases, there are more than one sublattice in the phase and the reference states for the phase species cannot be presented by the pure species, as in the case of C in FCC \([(Fe)1(C,N,VA)1]\), where the model may end at fifty percent C and fifty percent Fe. In those cases, the chemical potential and activity of all phase constituents is not well defined and you cannot properly define the activity coefficients of the species in the phase.

For an aqueous solution phase, no matter what model is used, the reference state and standard state for both the solvent and solutes are defined in a special way in the Thermo-Calc software. The reference state for the solvent is set as pure water, the same as its standard state (according to Raoult's Law). The standard state for a solute species is set the hypothetical solute species, whilst its reference state is defined as the hypothetical state at unit molality (one mole dissolved into 1.0 kg of solvent) but in which the environment of each molecular is the same as at infinite dilution (according to Henry's Law). Under these definitions, the activity coefficients for solvent species can be calculated as follows:

\[ RC\text{<H2O>} = \frac{ACR(\text{H2O,aqueous})}{Y(\text{aqueous,H2O})} \]

The coefficients for the solute species can be calculated as follows:

\[ RC\text{<spec>} = \frac{AI(\text{species,aqueous})/ML(\text{aqueous,species})}{Y(\text{aqueous,species})Y(\text{aqueous,H2O})} \]

AI is here the activity of solute species calculated from the model, and ML is the molality of the species.

**Thermodynamic Variables and Wildcard Characters**

The ACR (species,phase) and the MUR (species,phase) quantities can only be appropriately and meaningfully applied to substitutional solution phases (such as GAS, AQUEOUS, LIQUID) and to solution phases without an interstitial sublattice set. This means that the wildcard characters * and $ normally don’t work properly for the activity and/or chemical potential properties.

For example, do not use ACR(*,*), or MUR(*,*) for all the species relative to all phases, nor ACR(*,phase) or MUR(*,phase) for all the species relative to a specific phase, nor ACR (species,*) or MUR(species,*) for a specific species relative to all phases.

Instead, use specific names for species and (applicable) phase, as in the following examples:

**SHOW_VALUE acr(fe+2,aqueous)Lists activity of the Fe+2 species in AQUEOUS solution phase**
SHOW_VALUE mur(c2,gas) Lists chemical potential of the C2 species in GAS mixture phase

SET_AXIS_VAR y ac(o2,gas) Sets activity of the O2 species in GAS mixture phase as Y-axis

**Units of State Variables and Derived Variables**

The units for the state variables in the Units column in the table in "User-Specified Units" below are the SI units that are used in the POLY module. However, in the POST module, you can both use pre-defined symbols and define your own symbols which are based on state variables and derived variables. By doing this, you can express the value of the thermodynamic variables in non-default units. The following topic briefly describes how you can create your own symbols and suggests expressions that you can use to convert default units into other standard units which are not default units in Thermo-Calc.

The topic "Examples of User-Defined Units" on the next page describes some variables of specific species in a phase and the units in which they are expressed. These variables are not used in POLY or POST, but in the GIBBS, DATA, PARROT and ED_EXP modules.

**User-Specified Units**

You do not always need to use the default units for variables. Using "ENTER_SYMBOL" on page 247, you can convert the value of variable from the default unit to your preferred unit. (Some response-driven modules also allow you to set conditions in non-default units.) User-defined symbols in the form of functions can be used for plotting in the POST module, but they cannot be used as conditions in POLY. User defined symbols in the form of variables can be used as conditions.

For example, if you want pressure to be plotted in bar rather than Pa, then you define the following function PB:

Enter_symbol function PB = P/1E5 ;

If you wanted heat capacity of a system to be shown as in terms of J/mol/K, then you can define the following function Cp:

Enter_symbol function Cp = Hm.T ;

If the variable you want to convert is a function of one or more derivatives, then you must enter the symbol as a variable rather as a function. For instance, a symbol expressing heat capacity of a system in a unit of cal/mol/K can be defined as the following variable Cp2:

Enter_symbol variable Cp2 = Hm.T/4.1858 ;

Also see "Examples of User-Defined Units" on the next page for information about entering conventional functions and the associated units.
Examples of User-Defined Units

The following tables give examples of expressions you can use to enter symbols. This enables you to show the values of thermodynamic variables in a variety of units.

"Units of State Variables and Derived Variables" on the previous page and "User-Specified Units" on the previous page

You can also use thermodynamic variables with normalizing suffixes in the expression when you enter a symbol. However, the tables do not have examples of these expressions.

In the expressions these are defined as follows:

- $i$ is for an auxiliary index or letter that corresponds to the component $c$
- $j$ is for an auxiliary index or letter that corresponds to the phase $ph$, and
- $ij$ stands for an auxiliary index or letter that corresponds to the component $c$ in the phase $ph$.

Intensive and Extensive Variables of a Defined System

<table>
<thead>
<tr>
<th>Quantity</th>
<th>Suggested name and expression</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temperature</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>$TempC = T-273.15$</td>
<td>Celsius (C)</td>
</tr>
<tr>
<td></td>
<td>$TempF = 1.8*T-459.67$</td>
<td>Fahrenheit (F)</td>
</tr>
<tr>
<td></td>
<td>$TempF = 1.8*TempC+32$</td>
<td></td>
</tr>
</tbody>
</table>
## Thermodynamic Variables and Units

<table>
<thead>
<tr>
<th>Quantity</th>
<th>Suggested name and expression</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Pressure</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PB = P/1E5</td>
<td>bars (bar)</td>
<td></td>
</tr>
<tr>
<td>PKb = P/1E8</td>
<td>kilobars (kbar)</td>
<td></td>
</tr>
<tr>
<td>PAtm = P/101325</td>
<td>atmosphere (atm)</td>
<td></td>
</tr>
<tr>
<td>PSI = P/6894.76</td>
<td>pounds/sq. inch (psi)</td>
<td></td>
</tr>
<tr>
<td>PIHg = P/3342.11</td>
<td>inches of Hg</td>
<td></td>
</tr>
<tr>
<td>PToR = P/133.322</td>
<td>Tors (millimeters of Hg)</td>
<td></td>
</tr>
</tbody>
</table>

For extensive variables of a defined system

<table>
<thead>
<tr>
<th>Amount</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>BKg = 1E-3*B</td>
<td>kilograms (kg)</td>
<td></td>
</tr>
<tr>
<td>BTon = 1E-6*B</td>
<td>tons</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Volume</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>VDM = 1E-3*V</td>
<td>cubic decimeters (dm³, l)</td>
<td></td>
</tr>
<tr>
<td>VCM = 1E-6*V</td>
<td>cubic centimeters (cm³)</td>
<td></td>
</tr>
<tr>
<td>VMM = 1E-9*V</td>
<td>cubic millimeters (mm³)</td>
<td></td>
</tr>
<tr>
<td>VCl = 1.6387064E-5*V</td>
<td>cubic inches (in³)</td>
<td></td>
</tr>
<tr>
<td>VLi = 1E-3*V</td>
<td>liters (l)</td>
<td></td>
</tr>
<tr>
<td>Quantity</td>
<td>Suggested name and expression</td>
<td>Unit</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>Energy</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>GCal = G/4.1858</td>
<td>cal</td>
</tr>
<tr>
<td></td>
<td>ACal = A/4.1858</td>
<td>cal</td>
</tr>
<tr>
<td></td>
<td>UCal = U/4.1858</td>
<td>cal</td>
</tr>
<tr>
<td></td>
<td>HCal = H/4.1858</td>
<td>cal</td>
</tr>
<tr>
<td></td>
<td>SCal = S/4.1858</td>
<td>Cal/K</td>
</tr>
<tr>
<td>Heat Capacity</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Cp2 = HM.T/4.1858</td>
<td>cal/mol/K</td>
</tr>
<tr>
<td></td>
<td>Cp3 = HW.T/4.1858</td>
<td>cal/g/K</td>
</tr>
<tr>
<td></td>
<td>Cp4 = HV.T/4.1858</td>
<td>cal/m³/K</td>
</tr>
<tr>
<td>Thermal Expansion</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>A2 = VM.T<em>1E-6</em>VM</td>
<td>cm³/mol/K</td>
</tr>
<tr>
<td></td>
<td>A3 = VW.T<em>1E-6</em>VM</td>
<td>cm³/g/K</td>
</tr>
<tr>
<td>Isothermal Compressibility</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>B2 = -VM.P<em>1E-9</em>VM</td>
<td>mm³/mol/Pa</td>
</tr>
<tr>
<td></td>
<td>B3 = -VW.P<em>1E-9</em>VM</td>
<td>mm³/g/Pa</td>
</tr>
</tbody>
</table>

**Intensive and Extensive Variables of a System Component**

<table>
<thead>
<tr>
<th>Quantity</th>
<th>Suggested name and expression</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>For intensive variables of a system component</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Chemical Potential</td>
<td>MU(_i) = MU(c)/4.1858</td>
<td>cal/mol</td>
</tr>
<tr>
<td></td>
<td>MUR(_i) = MUR(c)/4.1858</td>
<td>cal/mol</td>
</tr>
<tr>
<td>Quantity</td>
<td>Suggested name and expression</td>
<td>Unit</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------------------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Special quantity for aqueous solution</td>
<td>pH = -LOG10(ACR(H+1))</td>
<td>dimensionless</td>
</tr>
<tr>
<td></td>
<td>Eh = MUR(ZE)/RNF where RNF=96485.309</td>
<td>volts (V)</td>
</tr>
</tbody>
</table>

*For extensive variables of a system component*

<table>
<thead>
<tr>
<th>Quantity</th>
<th>Expression</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amount</td>
<td>MF = N(c)/N = X(c)</td>
<td>dimensionless</td>
</tr>
<tr>
<td></td>
<td>MP = N(c)/N*100</td>
<td>dimensionless</td>
</tr>
<tr>
<td></td>
<td>WF = B(c)/B = W(c)</td>
<td>dimensionless</td>
</tr>
<tr>
<td></td>
<td>WP = B(c)/B*100</td>
<td>dimensionless</td>
</tr>
<tr>
<td></td>
<td>BK = 1E-3*B(c)</td>
<td>kilograms (kg)</td>
</tr>
<tr>
<td></td>
<td>BT = 1E-6*B(c)</td>
<td>tons</td>
</tr>
</tbody>
</table>
# Extensive Variables of a Phase

<table>
<thead>
<tr>
<th>Quantity</th>
<th>Suggested name and expression</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Amount</strong></td>
<td>MFj = NP(ph)/N</td>
<td>dimensionless</td>
</tr>
<tr>
<td></td>
<td>MPj = NP(ph)/N*100</td>
<td>dimensionless</td>
</tr>
<tr>
<td></td>
<td>WFj = BP(ph)/B</td>
<td>dimensionless</td>
</tr>
<tr>
<td></td>
<td>WPj = BP(ph)/B*100</td>
<td>dimensionless</td>
</tr>
<tr>
<td></td>
<td>BKgj = 1E-3*BP(ph)</td>
<td>kilograms (kg)</td>
</tr>
<tr>
<td></td>
<td>BTonj = 1E-6*BP(ph)</td>
<td>tons</td>
</tr>
<tr>
<td><strong>Volume</strong></td>
<td>VCMj = 1E-3*V(ph)</td>
<td>cubic decimeters (dm³, l)</td>
</tr>
<tr>
<td></td>
<td>VCMj = 1E-6*V(ph)</td>
<td>cubic centimeters (cm³)</td>
</tr>
<tr>
<td></td>
<td>VMMj = 1E-9*V(ph)</td>
<td>cubic millimeters (mm³)</td>
</tr>
<tr>
<td><strong>Energy</strong></td>
<td>GCalj = G(ph)/4.1858</td>
<td>cal</td>
</tr>
<tr>
<td></td>
<td>ACalj = A(ph)/4.1858</td>
<td>cal</td>
</tr>
<tr>
<td></td>
<td>UCalj = U(ph)/4.1858</td>
<td>cal</td>
</tr>
<tr>
<td></td>
<td>HCalj = H(ph)/4.1858</td>
<td>cal</td>
</tr>
<tr>
<td></td>
<td>SCalj = S(ph)/4.1858</td>
<td>Cal/K</td>
</tr>
<tr>
<td>Quantity</td>
<td>Suggested name and expression</td>
<td>Unit</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-------------------------------</td>
<td>----------------------------</td>
</tr>
<tr>
<td><strong>Driving Force</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DG2j = DGM(ph)/4.1858</td>
<td>cal/mol</td>
<td></td>
</tr>
<tr>
<td>DG3j = DGW(ph)/4.1858</td>
<td>cal/g</td>
<td></td>
</tr>
<tr>
<td>DG4j = DGV(ph)/4.1858</td>
<td>Cal/m³</td>
<td></td>
</tr>
<tr>
<td>DG5j = DGF(ph)/4.1858</td>
<td>cal/mole_formula_unit</td>
<td></td>
</tr>
<tr>
<td><strong>Heat Capacity</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cp2j = HM(ph).T/4.1858</td>
<td>cal/mol/K</td>
<td></td>
</tr>
<tr>
<td>Cp3j = HW(ph).T/4.1858</td>
<td>cal/g/K</td>
<td></td>
</tr>
<tr>
<td>Cp4j = HV(ph).T/4.1858</td>
<td>cal/m³/K</td>
<td></td>
</tr>
<tr>
<td>Cp5j = HF(ph).T/4.1858</td>
<td>cal/mole_formula_unit/K</td>
<td></td>
</tr>
<tr>
<td><strong>Thermal Expansion</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A2j = VM(ph).T<em>1E-6</em>VM</td>
<td>cm³/mol/K</td>
<td></td>
</tr>
<tr>
<td>A3j = VW(ph).T<em>1E-6</em>VM</td>
<td>cm³/g/K</td>
<td></td>
</tr>
<tr>
<td>A4j = VF(ph).T<em>1E-6</em>VM</td>
<td>cm³/mole_formula_unit/K</td>
<td></td>
</tr>
<tr>
<td><strong>Isothermal Compressibility</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>B2j = -VM(ph).P<em>1E-9</em>VM</td>
<td>mm³/mol/Pa</td>
<td></td>
</tr>
<tr>
<td>B3j = -VW(ph).P<em>1E-9</em>VM</td>
<td>mm³/g/Pa</td>
<td></td>
</tr>
<tr>
<td>B4j = -VF(ph).P<em>1E-9</em>VM</td>
<td>mm³/mole_formula_unit/Pa</td>
<td></td>
</tr>
</tbody>
</table>
### Extensive Variables of a Component in a Phase

<table>
<thead>
<tr>
<th>Quantity</th>
<th>Suggested name and expression</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amount</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MFij</td>
<td>( N(\text{ph},c)/N(\text{ph}) = X(\text{ph},c) )</td>
<td>dimensionless</td>
</tr>
<tr>
<td>MPij</td>
<td>( N(\text{ph},c)/N(\text{ph})*100 )</td>
<td>dimensionless</td>
</tr>
<tr>
<td>WFij</td>
<td>( B(\text{ph},c)/B(\text{ph}) = W(\text{ph},c) )</td>
<td>dimensionless</td>
</tr>
<tr>
<td>WPij</td>
<td>( B(\text{ph},c)/B(\text{ph})*100 )</td>
<td>dimensionless</td>
</tr>
<tr>
<td>BKgij</td>
<td>( 1E-3*B(\text{ph},c) )</td>
<td>kilograms (kg)</td>
</tr>
<tr>
<td>BTonij</td>
<td>( 1E-6*B(\text{ph},c) )</td>
<td>tons</td>
</tr>
</tbody>
</table>

### Intensive and Extensive Variables of a Species in a Phase

<table>
<thead>
<tr>
<th>Quantity</th>
<th>Suggested name and expression</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>For intensive variables of a species in a phase</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Chemical Potential</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MUCalij</td>
<td>( \mu_{\text{cal}}(\text{sp,ph})/4.1858 )</td>
<td>cal/mol</td>
</tr>
<tr>
<td>MUErgij</td>
<td>( \mu_{\text{erg}}(\text{sp,ph})*1E7 )</td>
<td>cal/mol</td>
</tr>
<tr>
<td>Fugacity</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FAij</td>
<td>( a(\text{sp,ph})*\text{PATM} )</td>
<td>atmosphere (atm)</td>
</tr>
<tr>
<td>FBij</td>
<td>( a(\text{sp,ph})*\text{PB} )</td>
<td>bars (bar)</td>
</tr>
<tr>
<td>FCij</td>
<td>( a(\text{sp,ph})*\text{PKB} )</td>
<td>kilobars (kbar)</td>
</tr>
<tr>
<td>FTij</td>
<td>( a(\text{sp,ph})*\text{PTOR} )</td>
<td>Tors (millimeters of Hg)</td>
</tr>
<tr>
<td>Quantity</td>
<td>Suggested name and expression</td>
<td>Unit</td>
</tr>
<tr>
<td>----------</td>
<td>-----------------------------</td>
<td>------</td>
</tr>
<tr>
<td>ln(Fugacity)</td>
<td>LnFAij = LNAC(sp,ph)+LN(PATM)</td>
<td>atmosphere (atm)</td>
</tr>
<tr>
<td></td>
<td>LnFBij = LNAC(sp,ph)+LN(PB)</td>
<td>bars (bar)</td>
</tr>
<tr>
<td></td>
<td>LnFCij = LNAC(sp,ph)+LN(PKB)</td>
<td>kilobars (kbar)</td>
</tr>
<tr>
<td></td>
<td>LnFTij = LNAC(sp,ph)+LN(PTOR)</td>
<td>Tors (millimeters of Hg)</td>
</tr>
<tr>
<td>Special quantity for aqueous solution</td>
<td>Alij=ACR(FE+3,AQ)*AH2O</td>
<td>dimensionless</td>
</tr>
<tr>
<td></td>
<td>RCij=ACR(FE+3,AQ)*YH2O/Y(AQ,FE+3)</td>
<td>dimensionless</td>
</tr>
<tr>
<td></td>
<td>where AH2O=55.508435 and YH2O=Y(AQ,H2O)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>WRCalij = WR(AQ,sp)/4.1858</td>
<td>cal/mol</td>
</tr>
<tr>
<td></td>
<td>(WR(AQ,sp) is only valid for aqueous species in a system in which the AQUEOUS solution phase is considered)</td>
<td></td>
</tr>
<tr>
<td>For extensive variables of a species in a phase</td>
<td>MLij=Y(AQ,FE+3)*AH2O/YH2O</td>
<td>molality (m)</td>
</tr>
<tr>
<td></td>
<td>ISTR=1<em>IS1+1</em>IS2+1*IS3</td>
<td>molality (m)</td>
</tr>
<tr>
<td></td>
<td>where AH2O=55.508435, YH2O=Y(AQ,H2O) and ISn=.5<em>MLi</em>Zi<strong>2+.5<em>MLj</em>Zj</strong>2+.5<em>MLk</em>Zk**2</td>
<td></td>
</tr>
</tbody>
</table>

**Units for Variables of Specific Species in a Phase**

In the GIBBS, DATA, PARROT and ED_EXP modules, there are quantities that describe various thermodynamic, physical, chemical and transport properties for a compound phase, and for a certain species or a given species combination in a specific solution phase. The following
These variables cannot be directly used in the POLY or POST modules.

<table>
<thead>
<tr>
<th>Variables</th>
<th>Description and unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>( G(\text{ph}, \text{sp}) )</td>
<td>Gibbs energy (J/mol) of a pure substance or end-member.</td>
</tr>
<tr>
<td>( G(\text{ph}, \text{sp}; 0) )</td>
<td></td>
</tr>
<tr>
<td>( G(\text{ph}, \text{sp}; \text{sp}1; \text{sp}2; \ldots; 0) )</td>
<td>Zero-order interaction parameter (J/mol) of a specified binary, ternary or higher-order interactions on a certain sublattice site in a solution phase.</td>
</tr>
<tr>
<td>( G(\text{ph}, \text{sp}; \text{sp}1, \text{sp}2, \ldots) )</td>
<td></td>
</tr>
<tr>
<td>( L(\text{ph}, \text{sp}; \text{sp}1, \text{sp}2, \ldots) )</td>
<td></td>
</tr>
<tr>
<td>( G(\text{ph}, \text{sp}; \text{sp}1, \text{sp}2, \ldots; 0) )</td>
<td></td>
</tr>
<tr>
<td>( L(\text{ph}, \text{sp}; \text{sp}1, \text{sp}2, \ldots; 0) )</td>
<td></td>
</tr>
<tr>
<td>( G(\text{ph}, \text{sp}; \text{sp}1, \text{sp}2, \ldots; i) )</td>
<td>The ( i )-th order interaction parameter (J/mol) of a specified binary, ternary or higher-order interactions on a certain sublattice site in a solution phase.</td>
</tr>
<tr>
<td>( L(\text{ph}, \text{sp}; \text{sp}1, \text{sp}2, \ldots; i) )</td>
<td></td>
</tr>
<tr>
<td>( \text{TC}(\text{ph}, \text{sp}) )</td>
<td>Curie temperature (K) of a pure substance or end-member.</td>
</tr>
<tr>
<td>( \text{TC}(\text{ph}, \text{sp}; 0) )</td>
<td></td>
</tr>
<tr>
<td>( \text{TC}(\text{ph}, \text{sp}; \text{sp}1; \text{sp}2; \ldots; 0) )</td>
<td>Zero-order Curie-temperature contribution (K) to a specified binary, ternary or higher-order interactions on a certain sublattice site in a solution phase.</td>
</tr>
<tr>
<td>( \text{TC}(\text{ph}, \text{sp}; \text{sp}1, \text{sp}2, \ldots) )</td>
<td></td>
</tr>
<tr>
<td>( \text{TC}(\text{ph}, \text{sp}; \text{sp}1, \text{sp}2, \ldots; 0) )</td>
<td></td>
</tr>
<tr>
<td>( \text{TC}(\text{ph}, \text{sp}; \text{sp}1, \text{sp}2, \ldots; 0) )</td>
<td></td>
</tr>
<tr>
<td>Variables</td>
<td>Description and unit</td>
</tr>
<tr>
<td>-----------</td>
<td>----------------------</td>
</tr>
<tr>
<td>TC(ph,sp1,sp2,..;i) TC (ph,sp1,sp2,;.;;i)</td>
<td>The ith-order Curie-temperature contribution (K) to a specified binary, ternary or higher-order interactions on a certain sublattice site in a solution phase.</td>
</tr>
<tr>
<td>BMAGN(ph,sp) BMAGN(ph,sp;0) BMAGN (ph,sp1,sp2;..;0)</td>
<td>Bohr magneton number (dimensionless) of a pure substance or end-member.</td>
</tr>
<tr>
<td>BMAGN (ph,sp1,sp2,..) BMAGN (ph,sp1,sp2,..;0) BMAGN (ph,..;sp1,sp2,..;0)</td>
<td>Zero-order Bohr magneton number (dimensionless) to a specified binary, ternary or higher-order interactions on a certain sublattice site in a solution phase.</td>
</tr>
<tr>
<td>BMAGN (ph,sp1,sp2,..;i) BMAGN (ph,sp1,sp2,..;.;i)</td>
<td>The ith-order Bohr magneton number (dimensionless) to a specified binary, ternary or higher-order interactions on a certain sublattice site in a solution phase.</td>
</tr>
<tr>
<td>V0(ph,sp) V0(ph,sp;0) V0 (ph,sp1,sp2;..;0)</td>
<td>Molar volume (m^3) at 1 bar and reference T0 of a pure substance or end-member.</td>
</tr>
<tr>
<td>V0(ph,sp1,sp2,..) V0 (ph,sp1,sp2,..;0) V0 (ph,sp1,sp2,..;.;0)</td>
<td>Zero-order composition-dependent molar volume (m^3) of a specified binary, ternary or higher-order interactions on a certain sublattice site in a solution phase.</td>
</tr>
<tr>
<td>V0(ph,sp1,sp2,..;i) V0 (ph,sp1,sp2,..;.;i)</td>
<td>The ith-order composition-dependent molar volume (m^3) of a specified binary, ternary or higher-order interactions on a certain sublattice site in a solution phase.</td>
</tr>
<tr>
<td>Variables</td>
<td>Description and unit</td>
</tr>
<tr>
<td>---------------------------</td>
<td>--------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>VA(ph,sp)</td>
<td>Integrated thermal expansivity ($m^3/mol/K$) of a pure substance or end-member.</td>
</tr>
<tr>
<td>VA(ph,sp;0)</td>
<td></td>
</tr>
<tr>
<td>VA(ph,sp1;sp2;...;0)</td>
<td></td>
</tr>
<tr>
<td>VA(ph,sp1,sp2,...)</td>
<td>Zero-order composition-dependent thermal expansivity ($m^3/mol/K$) of a specified binary, ternary or higher-order interactions on a certain sublattice site in a solution phase.</td>
</tr>
<tr>
<td>VA(ph,sp1,sp2;...;0)</td>
<td></td>
</tr>
<tr>
<td>VA(ph,sp1,sp2;...;i)</td>
<td>The ith-order composition-dependent thermal expansivity ($m^3/mol/K$) of a specified binary, ternary or higher-order interactions on a certain sublattice site in a solution phase.</td>
</tr>
<tr>
<td>VA(ph,sp1,sp2;...;i)</td>
<td></td>
</tr>
<tr>
<td>VC(ph,sp)</td>
<td>Isothermal compressibility ($m^3/mol/Pa$) of a pure substance or end-member.</td>
</tr>
<tr>
<td>VB(ph,sp;0)</td>
<td></td>
</tr>
<tr>
<td>VB(ph,sp1;sp2;...;0)</td>
<td></td>
</tr>
<tr>
<td>VC(ph,sp1,sp2,...)</td>
<td>Zero-order composition-dependent isothermal compressibility ($m^3/mol/Pa$) of a specified binary, ternary or higher-order interactions on a certain sublattice site in a solution phase.</td>
</tr>
<tr>
<td>VB(ph,sp1,sp2;...;0)</td>
<td></td>
</tr>
<tr>
<td>VC(ph,sp1,sp2;...;i)</td>
<td>The ith-order composition-dependent isothermal compressibility ($m^3/mol/Pa$) of a specified binary, ternary or higher-order interactions on a certain sublattice site in a solution phase.</td>
</tr>
<tr>
<td>VB(ph,sp1,sp2;...;i)</td>
<td></td>
</tr>
<tr>
<td>VK(ph,sp)</td>
<td>High-pressure fitting parameter ($m^3/mol$) of a pure substance or end-member.</td>
</tr>
<tr>
<td>VB(ph,sp;0)</td>
<td></td>
</tr>
<tr>
<td>VB(ph,sp1;sp2;...;0)</td>
<td></td>
</tr>
<tr>
<td>Variables</td>
<td>Description and unit</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>$VK(ph,sp1,sp2,...)$</td>
<td>Zero-order composition-dependent high-pressure fitting parameter ($m^3/mol$) of a specified binary, ternary or higher-order interactions on a certain sublattice site in a solution phase.</td>
</tr>
<tr>
<td>$VB(ph,sp1,sp2,...;0)$</td>
<td></td>
</tr>
<tr>
<td>$VB(ph,sp1,sp2,...;...;0)$</td>
<td></td>
</tr>
<tr>
<td>$VK(ph,sp1,sp2,...;i)$</td>
<td>The $i$th-order composition-dependent high-pressure fitting parameter ($m^3/mol$) of a specified binary, ternary or higher-order interactions on a certain sublattice site in a solution phase.</td>
</tr>
<tr>
<td>$VB(ph,sp1,sp2,...;...;i)$</td>
<td></td>
</tr>
<tr>
<td>$WR(ph,sp)$</td>
<td>Standard Born function ($J/mol$) of a specific aqueous species in the AQUEOUS solution phase (always with a single sublattice) under the reference-state temperature and pressure.</td>
</tr>
<tr>
<td>$WR(ph,sp;0)$</td>
<td></td>
</tr>
</tbody>
</table>
Data Optimization User Guide
Thermo-Calc Version 2017a
Introduction

In this section:

Introduction to Data Optimization .......................................................... 3
Data Optimization .............................................................................. 3
The Least-Squares Method ................................................................. 4
The CALPHAD Approach ................................................................. 4
Introduction to Data Optimization

This user guide describes the basic idea behind data optimization, contains brief descriptions of the modules and file types that you work with while doing your optimization, as well as rough outline of overarching workflow that you typically follow when working with optimization.

This guide assumes that you are familiar with using the Thermo-Calc Console Mode. It also assumes that you understand the principles of thermodynamics and are familiar with the theoretical foundations of computational thermodynamics.

Also see the Thermo-Calc Console Mode Command Reference included with this documentation set, which has information about all the commands available in the Thermo-Calc Console Mode, including PARROT and ED_EXP. Note that the commands listed under PARROT and ED_EXP are only commands that are specific to PARROT and/or ED_EXP. These modules also contain some commands that are also available in POLY.

Thermo-Calc Console Mode example tctx36 in the Console Mode Examples Guide is a detailed example of assessment and optimization in Thermo-Calc.

Data Optimization

In a thermodynamic database, each phase in a system is characterised using a mathematical model of its Gibbs energy. The Gibbs energy of a phase depends on various state variables. It can be defined individually even in a heterogeneous system with many stable phases since the properties of one phase are completely independent of the properties of the other phases in the system. In most alloy systems, the thermodynamic properties of a phase can be modelled by expressing how the Gibbs energy depends on temperature and composition. State variables such as pressure, volume or entropy can also serve as parameters in the Gibbs energy expression. The Gibbs energy of the whole system is the sum of the products of the Gibbs energy of each phase multiplied by the amount of that phase.

How the Gibbs energy of the phase varies with various state variables is determined by a mathematical model and how various adjustable parameters of the model is set. By optimizing these parameters, you can calculate the thermodynamic properties of a system under various conditions (by calculating phase diagrams for example). The thermodynamic properties themselves are functions of temperature, pressure or composition. They include, among other properties, standard enthalpy of formation, entropy, heat capacity, molar volume, thermal expansivity, compressibility and Curie temperature for magnetic transformations.
Data optimization is about adjusting the model parameters so that calculated equilibria fit well with experimental data. An important part of a data optimization is therefore collecting and assessing available experimental and theoretical information about phase equilibria and thermochemical properties of a system.

When you optimize the parameters of the model of a phase, you put what is called optimizing variables into the Gibbs energy expressions of those parameters. During the optimization, the values of these variables are varied in order to find a fit between the calculated equilibria and the experimental data that you base the optimization on. Once you have settled on a Gibbs energy expression for a certain parameter of a phase of the element, then you must stick to this expression in all future optimizations involving the element. If you do not do this, then you must re-optimize all previous systems that involve this element when the expression is changed.

The Thermo-Calc software allows you to optimize parameters that characterize not only binary systems, but also ternary system and systems of even higher orders. You can even optimize parameters that characterise systems of different orders at the same time.

**The Least-Squares Method**

Data optimization in Thermo-Calc is based on the least-squares method for fitting values calculated on the basis of a model with observed quantities. The software is accordingly trying to find the optimizing variable values that lead the minimized sum of the squares of the differences between the calculated values and the observed quantities (that is, of the errors or residuals).

The least-squares method works best under the following conditions:

- The observed quantities have a Gaussian probability distribution.
- The observed quantities are only subject to random errors.
- The different observations (experiments) are uncorrelated.
- The standard deviation of each observation can be estimated.
- The number of observations is large.
- The models used give precise predictions.

Of course, these conditions are usually not all met in a normal thermodynamic assessment. But even in non-ideal conditions, there is no known method that works better than the least-squares method.

**The CALPHAD Approach**

The data optimization functionality in Thermo-Calc works according to the CALPHAD approach to computational thermodynamics. This approach builds on the development of
models that accurately represent thermodynamic properties for various phases. These models enable you to predict the thermodynamic properties of multicomponent systems-based data concerning binary and ternary subsystems. The predictions can take many factors into accounts, such as, for example, crystallography, type of bonding, order-disorder transitions and magnetic properties.

CALPHAD is originally an abbreviation of CALculation of PHAsse Diagrams, but as the approach has expanded in scope, it now stands for computer coupling of phase diagrams and thermochemistry.

References


Information about the concept of ‘lattice stability’ (which is important for the development of multicomponent thermodynamic databases) can also be found in the paper Hume-Rothery and Calphad Thermodynamics by Larry Kaufman, published in Calphad and Alloy Thermodynamics, edited by Patrice E.A. Turchi, Antonios Gonis, Robert Shull (The Minerals, Metals & Materials Society, 2002), pp. 3-19.
Working with Data Optimization in Thermo-Calc

In this section:

- Data Optimization in Thermo-Calc ................................................................. 7
- Data Optimization Workflow ........................................................................... 7
- The PARROT Module ........................................................................................ 8
- The EDIT_EXPERIMENTS Module .................................................................. 8
- Data Optimization in Other Modules ............................................................... 9
- Optimization File Types .................................................................................. 9
- Optimization Workspaces ................................................................................ 10
- Method for Optimization and Simulation ......................................................... 11
Data Optimization in Thermo-Calc

The actual performance of the optimization of a system is primarily done in the PARROT module, and in its sub-module ED_EXP. The POLY and POST modules are used to calculate and plot property or phase diagrams based on the optimized variables. This allows you to visually assess how good a fit you have achieved between your calculated results and your experimental data.

The end result of a successful optimization is typically an updated Thermo-Calc database file (with filename extension *.TDB) or a new database file.

Data Optimization Workflow

When you carry out an optimization using Thermo-Calc, you typically follow a workflow as outlined below.

1. Collect experimental data about your system from various sources such as journal articles and reports.
2. Create a POP-file in which you enter the experimental data you have collected.
3. Create a setup macro file in which you define your system and the variables you want to optimize. A useful general procedure is to first find a minimum set of variables that allows you to calculate most of the experiments.
4. Run the setup macro file.
5. Compile your POP-file. This file often contains errors, which need to be corrected, and the file recompiled several times before the compilation is completed without errors.
6. In the ED_EXP module, check that the experiments in your POP-file reach equilibrium with reasonable results. If any experiments do not reach equilibrium with reasonable results, then try changing the starting values on equilibrium conditions (such as composition) to see whether the equilibrium can be computed after all. If this does not work, then you can temporarily exclude the experiment from the optimization. At a later stage in the optimization, when the optimizing variables have different values, you can check whether the experiments can be computed with reasonable results.
7. Back in the PARROT module, run the first optimization cycle and evaluate the feedback in the console. You can also plot diagrams in the POLY module that allow you to visually inspect the fit between calculated optimization results and the experimental data. If you are not satisfied with the fit, then enter the ED_EXP module again and adjust the weights of the experiments in a way that is likely to improve the fit and run another optimization cycle. Reiterate until you are satisfied with the fit.
8. Once you get the optimization stable and smooth with the minimum set of variables chosen in step 3 above, try using different sets of variables to see whether improvements are possible.

9. When you are satisfied with the fit between calculated results and experimental data with your final set of optimizing variables, update your setup file and POP-file. In the setup file, enter the calculated optimizing variable values as the variables’ start values. In the POP-file, enter the final weights of the experiments. With these files updated, you can easily regenerate the parameter values of your optimized system. Having the files updated also makes it easier to optimize the system again in light of new data or new theoretical models.

10. Finally, update the database with your calculated results or create a new database with information about the system that you have optimized.

**The PARROT Module**

The PARROT module consists of a comprehensive subroutine package for data evaluation of thermodynamic model parameters from experimental data. The module has 99 variables that you can use for optimization and the module can handle a thousand experimental measurements in an optimization. However, there are limits on the simultaneous numbers of variables and experiments. These limits are listed at each optimization.

The PARROT module is part of the Thermo-Calc software. The module is not included in the software development kits TQ-Interface, TC-API or TC-Toolbox for MATLAB®.

The experimental data is entered and edited in a sub-module of PARROT: "The EDIT_EXPERIMENTS Module" below.

**The EDIT_EXPERIMENTS Module**

The EDIT_EXPERIMENTS module, or ED_EXP for short, is used for entering, evaluating and editing experimental data. To enter the module, go to "The PARROT Module" above and then issue the command "EDIT_EXPERIMENTS" on page 139.

Since ED_EXP uses the POLY module for doing equilibrium calculations of experimental data points, many POLY commands are also available in the ED_EXP module. However, the commands may work somewhat differently in the two modules. There are also unique ED_EXP commands which are not found in POLY.

When you execute ED_EXP commands, the PARROT workspace is modified. However, note that you must always first use "READ_WORKSPACES" on page 214 in ED_EXP before doing anything in the module. The command loads the experimental data that you are going to work with during the optimization. Furthermore, before leaving ED_EXP you must use "SAVE_WORKSPACES" on page 54 or the results of your work in the ED_EXP module is lost.
Data Optimization in Other Modules

All kinds of thermodynamic data, calculated equilibrium states or dynamic parameters are transferred back and forth between the PARROT and the GIBBS module as well between these and the POLY module. Whenever an optimization run is performed, PARROT calls the GIBBS module for stored system definition data and model parameters.

In Thermo-Calc, the GIBBS module (the Gibbs Energy System) handles the models of the various phases that can form in a multicomponent system. It stores thermodynamic data and performs various Gibbs energy equilibrium calculations. It contains subroutines to analytically calculate the first and second partial derivatives of integral Gibbs energy with respect to any set of variables. Many thermodynamic models for various types of substances are implemented in the module. Some commands that are available in the PARROT module are also available in the GIBBS module.

In the GIBBS module, parameters of the Gibbs energy models are referred to as TP-functions.

PARROT calls the POLY module for equilibrium calculations. The POLY module is used for calculating and storing complex heterogeneous equilibria.

Optimization File Types

These are the important files you work with when optimizing.

<table>
<thead>
<tr>
<th>File type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>POP-file</td>
<td>The POP-file (Parrot OPtimization file) is the file that contains all the experimental data that you use for optimizing Gibbs energy values for your system. The POP-file is a plain text file that contains ED_EXP commands. By default, the file has the filename extension *.POP in Thermo-Calc.</td>
</tr>
<tr>
<td>Setup file</td>
<td>The setup file is a Thermo-Calc macro file (*.TCM). This file typically contains commands that define your system, opens the PARROT workspace (and associated GIBBS and POLY workspaces) and sets optimizing variables.</td>
</tr>
<tr>
<td>Other macro files</td>
<td>It is often useful to have other macro files than the setup file at hand while you are doing your optimization. For example, it is convenient to have a macro file that automatically plots phase diagrams or other diagrams based on the latest values of your optimizing variables. An optimization process typically involves many optimization cycles, so this operation needs to be done many times during a typical optimization.</td>
</tr>
</tbody>
</table>
### File type

<table>
<thead>
<tr>
<th>Workspace files</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Workspace files</strong></td>
<td>The PARROT module has its own workspace with dynamic memories, similar to the workspaces of POLY and GIBBS. It is stored and updated in a PARROT workspace file with the filename extension *.PAR. The workspace file is a binary file whose format is hardware dependent. This means that the format is unique for each type of CPU. Hence, a workspace file saved on a computer with one type of CPU cannot be used on a computer with another type of CPU.</td>
</tr>
</tbody>
</table>

| EXP-file | The EXP-file is a plain text file with information in the form of DATAPLOT Graphical Language commands. These commands can specify some or all of the data points in your POP-file. This allows you to plot these data points on top of your plotted optimization results (with the POST commands "APPEND_EXPERIMENTAL_DATA" on page 245 or "QUICK_EXPERIMENTAL_PLOT" on page 254). You can then visually assess the fit between these results and the experimental data. The PARROT workspace is not influenced in any way by the creation or use of EXP-files. |

Also see the DATAPLOT User Guide included with this documentation set.

### Optimization Workspaces

When writing the setup file, you enter a "CREATE_NEW_STORE_FILE" on page 139 command which creates a PARROT workspace file. Alternatively, select an existing PARROT workspace file with "SET_STORE_FILE" on page 162. The workspace file is automatically updated and saved with the latest optimization results (after each use of the "OPTIMIZE_VARIABLES" on page 154 command). You can also explicitly instruct Thermo-Calc to save the workspace using "SAVE_PARROT_WORKSPACES" on page 156. If you want to get rid of your latest changes and return to the state of your workspace when it was last saved, use "READ_PARROT_WORKSPACES" on page 154.

When the PARROT workspace is saved, parts of the POLY and GIBBS workspaces are also saved to the PARROT workspace file, along with the PARROT workspace itself. Using the POLY command "SAVE_WORKSPACES" on page 215 creates a new POLY3 file, nothing is saved to the PARROT workspace file.

If you do any POLY calculations based on data in the current workspace file, then a *.POLY3 file is created, which contains a copy of the current set of parameters. If you continue on your optimization and read the old *.POLY3 file, then the new set of parameters is overwritten with the old set. It is therefore recommended that you never read a *.POLY3 or *.GESS file while you are doing an optimization.
Method for Optimization and Simulation

The PARROT module typically uses ordinary POLY minimization for equilibrium calculations. The global minimization technique that is used in POLY cannot be used because it automatically creates new composition sets which corrupt the PARROT workspace. Furthermore, the equilibrium definitions that you use as input for your optimization must each be attributed to a specific phase. Some of these definitions may specify some local or partial equilibrium state rather than a global minimum. However, it is possible to use the global minimization technique for some equilibrium calculations by using the ED_EXP command "ADVANCED_OPTIONS" on page 174 with the Toggle_Alternate option.

Optimization in PARROT is performed on the basis of a ‘maximum likelihood’ principle. According to this principle, the best fit between various calculated results and all the input of experimental data is found where the sum of the square of the weighted residuals is at its minimum.

Typically, the results of an optimization is considered to be better the fewer optimizing variables that are needed to get the same level of fit between computed results and experimental data. If you can get almost the same fit using eight instead of twelve parameters, then this should be considered to be a significant improvement. When more parameters are used, the values of the individual parameters tend to become unrealistic. This is particularly true when it comes to temperature-dependent parameters. However, relatively small differences in the number of parameters are often insignificant. For example, it does not typically matter whether you used 24 or 25 parameters to reach a certain degree of fit.

It is often difficult to compare the quality of different optimizations based on the number of optimizing variables that have been optimized. Since you may rely more or less heavily on different pieces of available experimental data (and do so with good reason), it is possible that two different users could end up with very different numbers of parameters for the same system. For example, suppose you optimize the Fe-Al system to incorporate it into an Al database, while someone else optimizes the same system to incorporate it into an Fe database. In this situation, the two of you would probably make different judgements about which experimental information your calculated results must have a good fit with.
Creating the POP-File

Before starting an optimization in Thermo-Calc, you must collect relevant experimental data about your system that is available in the research literature. This data is then entered in the POP-file. The experimental data points and measurements are entered in this plain text file in the form of ED_EXP commands.

The syntax of the POP-file is in principle independent of the models used for describing the phases in the system.

In this section:

Experimental Information ................................................................. 13
POP-File Syntax ............................................................................. 16
Entering Experimental Information ................................................. 17
Using Stability Conditions ............................................................... 24
Grouping Equilibria with Labels ...................................................... 24
Dividing the POP-File into Several Blocks ...................................... 25
Experimental Information

An optimization of thermodynamic model parameters should be based on a range of reliable experimental results that is as wide as possible, as well as on empirical or semi-empirical correlations and theoretical considerations. During an optimization in Thermo-Calc, many kinds of thermochemical and thermophysical data can be mixed and used together.

The information needed for an optimization represent measurements of thermodynamic parameters in the system at equilibrium. These can be measurements of any of the thermodynamic quantities that can be set as conditions in Thermo-Calc. The information may represent measurements of activities or enthalpies in single-phase regions for example, or solubilities or transformation temperatures in a multi-phase region.

For each equilibrium that is used in the optimization, at least one quantity must have been measured and you also need to know the conditions that must be set to compute the system’s equilibrium state. For example, consider a binary system in a single-phase region. Suppose that you have measured the temperature, pressure, composition and the chemical potential. Three of these quantities are necessary to specify the equilibrium state and the forth can be used as experimental information to model the phase.

If you have a two-phase region and know the temperature and pressure conditions, as well as which the stable phases are, then you could use the compositions of one or both phases as experimental data. The former information about the conditions is sufficient to determine the equilibrium. The experimental information can then be used to optimize the parameters that are used to characterise and model the system.

For examples how to enter various kinds of experimental data in the POP-file, see "Experiments and Experimental Data" on page 54.
Conflicting or Missing Information

You are likely to sometimes have inconsistent or conflicting experimental information. In principle, all available experimental data should still be entered into the POP-file, unless you have good reasons to exclude some information. For example, if you have reason to believe that the samples used in some experiments were not pure, then these experiments could be excluded from the POP-file.

For some systems, you have very little experimental data to go on. When this is the case, do not try to fit the available data uncritically with high accuracy without considering possible errors. You can look for data in systems with similar elements to get an idea about what the reasonable estimates of data that is lacking could be. Or you can use calculations from first principles or semi-empirical methods to get reasonable estimates that can be used as experimental data.
Invariant Equilibria Information

The most valuable experimental information for an optimization is information about stable invariant equilibria. An invariant equilibrium is such that neither pressure, temperature nor composition can be changed without there being a change in the set of phases present in the system. It is recommended that all information about invariant equilibria for a system is included in the POP-file. These equilibria need not all be based on explicit experimental measurements of thermodynamic properties.

Reasonable estimates from available experimental data are often useful to include in the POP-file. Such estimates, which should be based on the available experimental data, helps Thermo-Calc find a good set of start values on the optimization variables. However, at the end of the assessment, these estimated equilibria should be excluded and you should complete the optimization based only on the experimental information that is based on measurements.

With some experience from phase diagram evaluation, it is possible to make reasonable estimates of metastable invariant equilibria. Such estimates helps reduce the number of phases that are assessed simultaneously during the optimization. For example, you may assume that a certain intermediate phase does not form in a system. Then extrapolate the liquidus curves below the stable three-phase equilibria and finally, estimate temperatures and compositions of metastable three-phase equilibria between two other phases and the liquid.

Another useful technique is to extrapolate a liquidus line from a peritectic equilibrium to estimate the congruent melting temperature of a compound. This estimate may be more useful than the information about the peritectic equilibrium itself as the equilibrium involves only two phases.
Equilibria in Higher-Order Systems Information

When you optimize a binary system, the available experimental information can often be described equally well by very different sets of parameters. Information about ternary and higher order systems that include the components of the binary system are then often useful for optimizing the binary system (the same is true of information about quaternary system with respect to optimizing ternary systems). Often, it is only when you extrapolate the optimized parameters to a higher-order system that you can judge which of the sets of model parameters that is best. Sometimes information from several ternary systems is required to make a reliable judgement about which set of parameters best describes a particular binary system.

Heat Capacities Information

If you want to optimize your system based on data about heat capacities, then the corresponding parameters should first be optimized separately before you perform the general optimization of your system. The parameters should be kept fixed during the general optimization. This is because it is normally not possible to optimize heat capacity data together with other data in a meaningful way. If you do this, then it is very likely that the parameters related to the heat capacity are badly determined.

POP-File Syntax

It is recommended that you specify an experimental equilibrium as close as possible to actual experimental conditions. Ideally, there is information about the set of stable phases, temperature, pressure and some or all compositions for the equilibrium.

In addition, it is recommended that you keep the POP-file well-organised and extensively commented. This is especially important if someone else reassesses the system when new experimental information is available.

If you have too many equilibria defined in your file, or if you define equilibria with different sets of components in the same file, then you must divide the POP-file in blocks (using the "FLUSH_BUFFER" on page 77 command). You know whether you have defined too many equilibria for one block when you compile the file. A too large number of equilibria leads to an error message when the file is compiled.

If you use the "DEFINE_COMPONENTS" on page 196 command, then it must be the first command in the POP-file (or if you have several blocks, DEFINE_COMPONENTS can also be put as the first command after FLUSH_BUFFER). This is because the command automatically reinitializes the current workspace, so the effect of any commands placed before it are not saved.

The last command in the POP-file should always be "SAVE_WORKSPACES " on page 54.
Legal Commands in a POP-File

The following commands can be used in a POP-file.

Also see the *Thermo-Calc Console Mode Command Reference Guide* for information about all these commands.

- "ADVANCED_OPTIONS" on page 174
- "CHANGE_STATUS" on page 186
- "COMMENT" on page 77
- "CREATE_NEW_EQUILIBRIUM" on page 195
- "DEFINE_COMPONENTS" on page 196
- "ENTER_SYMBOL" on page 247
- "EVALUATE_FUNCTIONS" on page 208
- "EXPERIMENT" on page 44
- "EXPORT" on page 46
- "FLUSH_BUFFER" on page 77
- "IMPORT" on page 47
- "LABEL_DATA" on page 48
- "SAVE_WORKSPACE" on page 289
- "SET_ALL_START_VALUES" on page 217
- "SET_ALTERNATE_CONDITION" on page 57
- "SET_CONDITION" on page 220
- "SET_NUMERICAL_LIMITS" on page 296
- "SET_REFERENCE_STATE" on page 224
- "SET_START_VALUE" on page 226
- "SET_WEIGHT" on page 66
- "TABLE_HEAD, TABLE_VALUES and TABLE_END" on page 75

Entering Experimental Information

A POP-file in Thermo-Calc (*.POP) mainly consists of descriptions of equilibria, each equilibrium describing a data point that is based on an experiment from the existing literature on your system. An equilibrium is specified using ED_EXP commands.
The following is an example of a specification of an equilibrium with a single stable phase in the Au-Cu system. Equilibria with a single stable phase are often from experiments where enthalpies of mixing or chemical potentials have been measured.

```
CREATE_NEW_EQUILIBRIUM 1 1
CHANGE_STATUS PHASE LIQUID=FIX 1
SET_CONDITION T=1379 P=1E5 X(LIQUID,AU)=0.0563
SET_REFERENCE_STATE AU LIQ * 1E5
SET_REFERENCE_STATE CU LIQ * 1E5
EXPERIMENT HMR=-1520:200
COMMENT Measurement by Topor and Kleppa, Met trans 1984
```

**Creating a New Equilibrium**

The first command in an equilibrium specification is always "CREATE_NEW_EQUILIBRIUM" on page 195. This command takes two integers as arguments. The first integer should specify a unique identifier that can be used later to refer to the equilibrium in question. The second integer is an initialisation code 0, 1 or 2:

- **Code 1**: This means that all components are entered but all phases are suspended. This code is appropriate in most cases.
- **Code 0**: This means that all components and phases in the equilibrium are suspended initially. This code is needed if you are using experimental data about systems of different orders simultaneously, such as data about both binary and ternary systems for example.
- **Code 2**: This means that all components and phases are initially entered.

**Example**

For example, the first command in the example above creates an equilibrium data point with the unique identifier 1. All components of the system are entered but all phases are suspended:

```
CREATE_NEW_EQUILIBRIUM 1 1
```

**Setting Equilibrium Conditions and its Uncertainty**

All the equilibrium-related commands that are placed in between two "CREATE_NEW_EQUILIBRIUM" on page 195 commands are interpreted as specifying the conditions of the equilibrium created by the first command. The values of these conditions should be based on the conditions specified in the experiment that you base the equilibrium definition on.
Example

In the example, the "CHANGE_STATUS" on page 100 command specifies that the equilibrium is a single-phase equilibrium with the liquid phase.

    CHANGE_STATUS PHASE LIQUID=FIX 1

Furthermore, the temperature is 1379 K, the pressure is 1 bar (1E5 Pa) and the mole fraction of Au is 0.0563.

    SET_CONDITION T=1379 P=1E5 X(LIQUID,AU)=0.0563

Sometimes you have reason to think that some information about an equilibrium condition may not be accurate. If this is the case, then you specify the degree of uncertainty for a condition with a colon after the condition quantity, directly followed by either an absolute value or a percentage. For example, if you have reason to doubt the reliability of the Au mole fraction measurement, then you could write:

    SET_CONDITION T=1379 P=1E5 X(LIQUID,AU)=0.0563:10%

This indicates that you think the Au mole fraction is between 0.0507 and 0.0619. PARROT calculates the equilibrium twice, once for 0.0507 and once for 0.0619, and then computes the change of each experimental value between these two equilibria. This change is used to modify the uncertainty specified for the experimental value.

Also see "Entering the Experimental Value and its Uncertainty" on the next page.

The possibility of specifying uncertainties on conditions may be useful when you have experimental data about a ternary system. In a binary system, a tie-line is determined by the two phases, the temperature and the pressure. Measurements of the compositions of both phases can then be used as experimental data. To specify the tie-line in a ternary two-phase equilibrium one of the four compositions must also be set as a condition. If the measurement of this composition has the same uncertainty as the other compositions, then you can assign this same degree of uncertainty both to the composition selected as a condition and the compositions selected as experimental data. Alternatively, the sample (overall) composition could be used as a condition and all four phase compositions could be used as experiment values. These phases must have the status entered (not fixed) since the relative amount of each is unknown.

Setting Reference States

If you want to specify a non-default reference state for one or several of your system components, then you do this with the "SET_REFERENCE_STATE" on page 224 command. In the following example, the reference state for the liquid phase is set to current temperature (*) and a pressure of 1E5 Pa.
Example

```
SET_REFERENCE_STATE AU LIQ * 1E5
SET_REFERENCE_STATE CU LIQ * 1E5
```

Note that in order for these reference states to be taken into account when the measurement of the enthalpy per mole of the system is entered with experiment, the R-suffix must be used.

**Entering the Experimental Value and its Uncertainty**

The "EXPERIMENT" on page 44 command is used to specify the quantity that the calculated results should be fitted to. When specifying this quantity, you both specify the measured quantity itself and your estimation of the uncertainty of this value.

Example

In the example, the EXPERIMENT command specifies the enthalpy per mole of the system, where this value is specified with respect to non-default reference states that you have set in the equilibrium specification:

```
EXPERIMENT HMR=-1520:200
```

The value before the colon is the quantity of the variable. The value after the colon is an assessment of the uncertainty of this quantity. A higher value means a greater uncertainty. In the example, the uncertainty has been specified with an absolute value but it could also be specified in percent of the quantity:

```
EXPERIMENT HMR=-1520:13%
```

Several experiments can be specified after the experiment command. Besides assigning values to conditions, it is also possible to specify that a certain quantity is greater than or less than a certain value. For instance, the following command would specify that the activity of the C-component is less than 0.01 and the mass fraction of the BCC phase of Ag is greater than 0.05:

```
EXPERIMENT ACR(C)<0.01:0.001 W(BCC,AG)>0.05:10%
```

Note that an experimental quantity can typically also be treated as an equilibrium condition, and vice versa. Which measured quantities that you treat as conditions and which quantities you treat as experimental data should be based on the accuracy of the different measurements. In most cases, the quantity that is based on the experimental technique with the lowest accuracy should be used as the experimental value.

**Entering Many Equilibria as a Table**

When one thermodynamic variable (e.g. heat capacity) has been measured as a function of another (e.g. temperature), then experimental data is often presented as a table. By using
the TABLE_HEAD, TABLE_VALUES and TABLE_END commands, you can enter such experimental information into the POP-file in the form of a table. These three commands should always be used together and must be entered in the right order. See "TABLE_HEAD, TABLE_VALUES and TABLE_END" on page 75.

The TABLE_HEAD command is followed by a number. This number identifies the table as a whole, but also uniquely identifies the first equilibrium that is included in the table. This numeric identifier is incremented by one for each additional equilibrium in the table. Each row in the table represents one equilibrium. Thus, the equilibrium defined by the first row in the table above (on the line immediately below TABLE_VALUE) is uniquely identified with the number 1, the equilibrium defined by the second row by number 2, and so on until the last equilibrium on the sixth row, which is identified by the number 6.

Since the unique identifiers of the equilibria in the table are automatically generated from the unique numerical identifier that you give to the table, the unique numerical identifier that is normally given to the "CREATE_NEW_EQUILIBRIUM" on page 195 command is replaced by two at signs (@@).

At least one of the equilibria conditions specified with the "SET_CONDITION" on page 220 command must be a condition whose value is set by the numbers in one of the table columns. To assign the numbers in a column to a condition, use the syntax SET_CONDITION <condition>=@<column number>. For instance, in the example above, the mole fraction of X(ALO3/2) is for each equilibrium given by the number in the first column of the table.

At least one of the measured variables that are entered with the experiment command must be a variable whose value is set by the numbers in a table column. To assign the numbers in a column to a measured variable, use the syntax EXPERIMENT <variable>=@<column number>. In the example above, the measured temperature for each equilibrium is given by the number in the second table column.

The actual table should be entered between TABLE_VALUES and TABLE_END. Separate the columns with tabs or any number of spaces. The columns do not have to contain numbers, but can also contain other types of values, such as phase names for example. If a column contains text with spaces or special characters, then the text must be surrounded by double quotes ("ABC DEF&ghi", for example). The table may have columns that are not used, but each row must have exactly the same number of columns.

Example

The following block of commands exemplifies how a table can be entered into a POP-file:

TABLE_HEAD 1
CREATE_NEW_EQUILIBRIUM @@ 1
CHANGE_STATUS PHASE TETR=FIX 0
CHANGE_STATUS PHASE ION=ENT 1
SET_CONDITION P=101325 N=1 ACR(O2,GAS)=.21 X(ALO3/2)=@1
EXPERIMENT T=@2:5

TABLE_VALUE
0.46082476
0.57142380
0.66822276
0.7496 2176
0.50382426
0.63132249

TABLE_END

**Setting Site Fraction Start Values**

In some systems, you have to set non-default composition start values on some experiments in order to get them to converge properly during optimization. This may be important if your system has a miscibility gap for example, in which case several equilibria with different compositions exist at certain temperatures. In such cases, you have to make sure it is specified in the POP-file which side of the miscibility gap the equilibrium is on. The calculated equilibrium could otherwise end up on the wrong side, resulting in a large error.

In the POP-file, you can set the site fraction of a constituent on an equilibrium with "SET_START_VALUE" on page 226.
**Example**

For example, the following command sets the composition start value of VA constituent of the FCC_A1 phase to 0.99:

```
SET_START_VALUE Y(FCC_A1,VA#2)=0.99
```

Setting the mole fraction for a component in a phase is not as reliable as setting the site fraction.

Additional equilibria entered after the last SET_START_VALUE command are automatically given a similar start value if the following command appears previously in the POP-file:

```
SET_ALL_START_VALUES Y
```

If start values are not set automatically for phase constituents, then you may have to set the composition start value for each equilibrium (or table of equilibria) separately.

**Commenting About an Equilibrium**

The COMMENT command inserts a comment about the equilibrium that is saved to the PARROT workspace file when the POP-file is compiled. The comment must be entered on one line.

Comments can also be entered immediately after a dollar sign ($), but these are not saved to the PARROT workspace. Instead, these comments are ignored by Thermo-Calc when the POP-file is compiled.

**Simultaneous Use of Binary and Ternary Experiments**

You can use experimental information about binary and ternary systems (as well as systems of even higher order) in the same POP-file and optimization. To do this, you must inform the PARROT module that not all components of the ternary system (or system of even higher order) should be considered. This allows you, for example, to use experimental information about a binary equilibrium that exists within a ternary system.

Use "CHANGE_STATUS" on page 100 with the keyword component and which components that should be entered. You should also give the initialization code 0 (rather than 1) to the "CREATE_NEW_EQUILIBRIUM" on page 195 command. This code indicates that all components must be entered.

**Example**

For example, the following set of ED_EXP commands characterises a binary (A-B) three-phase equilibrium (FCC-BCC-LIQ) in a ternary system (A-B-C). It can be used in a POP-file
that otherwise only contain experimental information about the ternary system (A-B-C):

```plaintext
CREATE_NEW_EQUILIBRIUM 1 0
CHANGE_STATUS COMPONENT A B = ENTERED
CHANGE_STATUS PHASE FCC BCC LIQ=FIX 1
SET_CONDITION P=1E5
EXPERIMENT T=1177:10
COMMENT from A-B
```

**Using Stability Conditions**

Early in the optimization when parameter values are not so good it is often useful to set the driving force for precipitation of a phase (per mole of components) to make sure that it appears where it should. The DGM condition is very useful for making sure that phases appear where they should. It can be removed when the optimization becomes stable.

The DGM condition is also useful for suppressing phases that appear where they should not appear. Do this by setting the value and the uncertainty to something reasonable. For example, the driving force for precipitation of the BCC phase could be set as follows:

```
DGM(BCC)<-0.1:0.1
```

This produces an error even before BCC becomes stable and the weight of the experiment in question can be adjusted as needed. If you specify that the driving force for the BCC phase should be below 0 (DGM(BCC)<0:1E-4 for example), then the optimization converges extremely slowly (if at all). With such a sharp error condition, calculating the equilibrium is like finding the minimum point on a lawn that gently slopes towards a rock wall. The optimization keeps bouncing into the wall.

Another useful stability condition is the phase stability function, abbreviated QF. This can be used to specify that a phase is outside the miscibility gap for a solution phase. If QF(phase) is negative, then the phase is inside the miscibility gap; if QF(phase) is positive, then it is outside the miscibility gap.

**Grouping Equilibria with Labels**

If you have several equilibria describing experiments that you want to be able to treat collectively, you can give all of the equilibria one and the same label.

Use LABEL to give an equilibrium a label. The label must start with the letter A and can only be up to four characters long. For example, you can insert the following command in several equilibria specifications:

```
LABEL ALH
```
During the optimization, you could use this label to, for example, set all the equilibria that have it to the same weight in the ED_EXP module.

**Dividing the POP-File into Several Blocks**

For two different reasons, you may have to divide your POP-file into different blocks:

- PARROT uses a buffer for storing compiled experimental data. If there is not enough memory in this buffer for storing all the experiments from the POP-file, then the POP-file can be divided into several blocks. When PARROT encounters the end of a POP-file block, it saves the experimental data that has been compiled to PARROT workspace, clears out the memory buffer and then proceeds to read the next block in the POP-file. This goes on until the experimental data from all the blocks have been saved to the PARROT workspace.

- If you want to put equilibria with different sets of components in one and the same POP-file, then you must divide the file up into blocks. Each block should only contain equilibria that all have the same set of components.

To divide the equilibria in the POP-file into different blocks, enter the ["FLUSH_BUFFER" on page 77](#) command between two equilibria. This command marks the beginning of a new block. When the command is encountered during the compilation of the POP-file, the compilation of the current block is terminated, the equilibria saved to the PARROT workspace file and a new block is initiated. That the buffer is reinitialized means that all functions and constants that were entered in the previous block must be entered again in new block in order to be used.

When editing your experimental data in the ED_EXP module, you can select which block to load and edit using ["READ_WORKSPACES" on page 214](#) <block number>. The block before the first instance of FLUSH_BUFFER is block number 1, the block after the first instance and before the second instance is block number 2, and so on.
The Setup File

In this section:

- Creating the Setup File ................................................................. 27
- Defining the System ........................................................................ 27
- Creating Additional Composition Sets of a Phase ................................ 28
- Entering the Optimizing Variables ..................................................... 28
- Initializing Optimizing Variables in PARROT ................................... 30
- Creating the Workspace File ............................................................. 31
- Compiling the POP-file ..................................................................... 31
- Returning Control to the Console ...................................................... 32
Creating the Setup File

The second step is to create the setup file. This is an ordinary Thermo-Calc macro file (*.TCM). Typically, your setup file should contain the following:

- A system definition.
- A section where you enter model parameters and optimizing variables.
- A GO PARROT command.
- A section where initial values are assigned to the optimizing variables for the first optimization cycle.
- A "CREATE_NEW_STORE_FILE" on page 139 <filename.par> which creates the PARROT workspace file onto which the results of your optimization are continuously saved and updated. By default this workspace file has the same filename as the setup file, but with the *.PAR filename extension.
- A "COMPILE_EXPERIMENTS" on page 137 <filename.pop> command. Since you often encounter syntax errors when you first try to compile a POP-file, it may be useful to execute this command from the console rather than as part of the setup macro file.
- Normally, you also have a "SET_INTERACTIVE" on page 295 at the end of the setup file. This command returns control over Thermo-Calc to the console.

It is possible to interactively execute all these commands one at a time in the console. It may be instructive to enter the commands that would normally go into the setup file interactively while using the on-line help while you are learning to use the PARROT module.

Defining the System

If you have an existing database with information about your system, then you can write the system definition part of your setup file in two different ways.

- If you have an unencrypted user database, then you can define your system by entering DATA module commands directly in the setup file. Use the DATA commands that you normally use to define a system when doing equilibrium calculations in Thermo-Calc Console Mode.

- Define your system by entering DATA module commands directly in the console, then generate a macro file with the GIBBS command "LIST_DATA" on page 120 <name of setup file>.tcm p. This command saves all the data that has been loaded in the GIBBS workspace as a macro file. This file can then be modified as required into an optimization setup file.
Creating Additional Composition Sets of a Phase

If you need several composition sets of a phase, then these should be created with the GIBBS command "AMEND_PHASE_DESCRIPTION" on page 93 <phase name> composition_sets <composition set number> in the setup file.

If you add composition sets of a phase after the POP-file has been compiled, the data structure in the workspace is corrupted and you have to recompile the POP-file.

Entering the Optimizing Variables

When you have retrieved the data about your system for the setup file, you must manually enter the model parameters that you want to optimize. This is done using the GIBBS command "ENTER_PARAMETER" on page 143, but when you specify the Gibbs energy expression for the parameter, you enter variables that can be given various values into the expression. It is the values of these variables (and thus, the Gibbs energy of the parameter) that you are optimizing.

How you in detail specify the optimizing variables in your setup file depends on which phase you are trying to optimize and what thermodynamic model that is used in the optimization.

Also see "Thermodynamic Models" on page 64 for a range of examples.

Entering Optimizing Variables in Parameter Specifications

There are ninety-nine predefined variables in the PARROT module which you can use in your optimization. These variables are referred to as V1, V2, V3, ... V98 and V 99. When the GIBBS workspace is initialise, all optimizing variables are set to a fixed numerical value of zero. When you do an optimization, there is always some variable for which you want to evaluate the best value, but you can assign fixed values to optimizing variables too. It is often useful to enter all the variables that you can conceivably want to optimize, and then you can interactively select and change which variable to focus at various stages of the optimization.

The setup file excerpts that follow show how optimizing variables are entered. However, before the optimizing variables are introduced in this example, the following command enters an ionic liquid solution phase (a phase for which you have some experimental information):

```
ENTER_PHASE IONIC_LIQ Y,
AL+3,ZR+4 ; ALO2-1,0-2 ; N N
```

This "ENTER_PHASE" on page 110 command enters a phase called IONIC_LIQ into the GIBBS workspace. This phase is of the type ionic liquid solution, which is specified by type code Y. Such a phase is modelled by the *Ionic Two Sublattice Liquid Model*. The next two arguments specify the two sublattices, in this case the cations AL+3,ZR+4 and the anions ALO2-1,0-2.
Components that interact in a sublattice are separated by a comma. The first \( N \) at the end means that no additional constituents are added to the phase. The second \( N \) means that a list of possible parameters for the phase should not be shown in the console.

There are model parameters that describe the phase which you do not want to optimize, in which case the Gibbs energy expression of the parameter does not contain any optimizing variables.

**Example 1**

For example, the following parameters of the IONIC_LIQ phase do not contain any optimizing variables:

```plaintext
ENTER_PARAMETER G(IONIC_LIQ,AL+3:ALO2-1;0) 298.15 +2*GAL2O3_L; 6000 N
ENTER_PARAMETER G(IONIC_LIQ,AL+3:O-2;0) 298.15 +GAL2O3_L+40000; 6000 N
ENTER_PARAMETER G(IONIC_LIQ,ZR+4:O-2;0) 298.15 +2*GZRO2L; 6000 N
```

These parameters define the Gibbs energy expressions for three constituents in the constituent array, namely AL+3:ALO2-1, AL+3:O-2 and ZR+4:O-2. The names that occur in these expressions—that is, GAL2O3_L and GZRO2L—are the names of complex functions of temperature that are entered in the GIBBS workspace with the "ENTER_SYMBOL" on page 113 command.

The numbers that frame the Gibbs energy expressions specify the temperature range within which the expression should be applied. In the above, the expressions are applied in a temperature range from 298.15 K to 6000 K.

**Example 2**

In this example, suppose that you want to optimize the model parameter for the ZR+4:ALO2-1 combination, then you could enter the variables \( V1 \) and \( V2 \) in the Gibbs energy expression for that parameter in the following way:

```plaintext
ENTER_PARAMETER G(IONIC_LIQ,ZR+4:ALO2-1;0) 298.15 +GZRO2L +2*GAL2O3_L +V1+V2*T; 6000 N
```

You normally have different optimizing variables in different parameters, but in some cases you may want several parameters to vary together, in which case you can use the same variable in the Gibbs energy expressions of several parameters.

**Entering Interaction Parameters**

For some systems, you have to consider interaction parameters in order to take excess Gibbs energy into account and correctly model the phase. By default, the software uses a Redlich-
Kister expression for the excess Gibbs energy. The coefficient is entered after the constituent array when you use the "ENTER_PARAMETER" on page 143 command. In the last section, all the parameters were entered with a coefficient of zero (0).

Example

To take account of the excess Gibbs energy, you might enter the following:

```
ENTER_PARAMETER L(IONIC_LIQ,2R+4:ALO2-1,0-2;0) 298.15 +V11+V12*T;
   6000 N
ENTER_PARAMETER L(IONIC_LIQ,2R+4:ALO2-1,0-2;1) 298.15 +V13+V14*T;
   6000 N
ENTER_PARAMETER L(IONIC_LIQ,2R+4:ALO2-1,0-2;2) 298.15 +V15+V16*T;
   6000 N
```

Parameters with interaction coefficients are referred to as interaction parameters. The regular parameter has a coefficient of 0. The subregular parameter has a coefficient of 1. It is possible to interaction coefficients up to a value of 9, but you are advised not to use more than three coefficients (that is, with coefficient values of 0, 1 and 2).

Initializing Optimizing Variables in PARROT

Variables that have been entered into Gibbs energy expressions for model parameters in the setup file has to be initialized and given start values before they are optimized.

You have to estimate what start values to give to the optimizing variables based on your knowledge of the system or of relevantly similar systems. There are no general rules for what start values your optimizing variables should have. If you are not able to make any informed estimation about what start values to use, then you may not be able to find a good fit between your experimental data and your calculated results. In this case, it is often best to start the optimization in the so-called alternate mode. In alternate mode, the PARROT module helps you find some reasonable start values for your optimizing variables.

Also see "About Alternate Mode" on page 47.

Even if you are starting your optimization in alternate mode, you still have to initialize the optimizing variables though (you can all give them a start value of 0).

To initialize an optimizing variable and to give it a start value, use either "SET_OPTIMIZING_VARIABLE" on page 159 or "SET_SCALED_VARIABLE" on page 161. Using SET-OPTIMIZING_VARIABLE results in a scaling factor equal to the current value of the parameter unless the current value is zero, in which case the scaling factor is 1000. This is typically appropriate for enthalpic parameters, but not necessarily for other parameters. The scaling factor is the factor by which the optimizing variable value is varied during the optimization.
Example

For example, if you want to optimize the variables V1, V2, V11, V13 and V17, then you could enter the following in the setup file:

```
SET_OPTIMIZING_VARIABLE 1 +43000
SET_OPTIMIZING_VARIABLE 2 -35.2
SET_OPTIMIZING_VARIABLE 11 +72000
SET_OPTIMIZING_VARIABLE 13 +27000
SET_OPTIMIZING_VARIABLE 17 -100000
```

The value given to each optimizing variable (+43000 for variable V1 for example) is also that variable’s initial scaling factor. If you want to set the initial scaling factor of a variable to a value that is lower or higher than its start value, then use SET-SCALED_VARIABLE <start value><scaling factor><min value><max value>.

Creating the Workspace File

In the setup file, after the system definition and the entered optimizing variables, use the PARROT command "CREATE_NEW_STORE_FILE" on page 139 to create and save a PARROT workspace file for the system defined in the setup file. For example, the following command saves all current data on system definitions (elements, species, components, phases), symbol definitions (constants, variables, functions, tables) and parameters that are stored in the workspace used by GIBBS, POLY and PARROT into a file called AL2O3-ZRO2.PAR:

```
CREATE_NEW_STORE_FILE AL2O3-ZRO2
```

The experimental information in the POP-file is not saved to this PARROT workspace file.

Compiling the POP-file

At the end of the setup file, use the command "COMPILE_EXPERIMENTS" on page 137 followed by the name of your POP-file to compile the data in that file and save it to the current PARROT workspace file. Note that you must first have opened or created a new PARROT workspace file before you compile your POP-file. The other argument to the command can typically be given default values with comma signs (,):

```
COMPILE_EXPERIMENTS AL2O3-ZRO2.POP,,,,
console for editing the experimental data and another console for compiling and reading any further error messages.

**Returning Control to the Console**

Put the command "SET_INTERACTIVE" on page 295 at the end of the setup file if you want to return control to the console when the commands in the setup file have all been executed.
Optimizing in PARROT

In this section:

- Optimizing the System in PARROT ......................................................... 34
- Changes that Require POP-file Recompilation ........................................... 34
- Optimization Workflow ........................................................................... 34
- Ensuring Computation of all Equilibria ..................................................... 35
- Setting Weights ....................................................................................... 36
- Optimizing and Evaluating Results ......................................................... 37
- The Critical Set of Experiments ............................................................... 38
- Continuing the Optimization and Resetting Variables ............................. 38
- Updating the Set of Optimizing Variables ............................................... 40
- Reducing the Number of Optimizing Variables ........................................ 41
- Plotting Intermediate Results ................................................................. 41
Optimizing the System in PARROT

When you have created a POP-file, a setup macro file and (optionally) EXP-files, you should start doing optimization runs interactively in the console. This process can be divided into a number of steps (such as running optimization, evaluating optimization results, modifying weights and models and adding new information), but usually, you have to go through many optimization cycles before achieving a satisfactory fit between calculation results and experimental data.

Typically, it is not obvious when an optimization is finished. You must exercise your judgement about when the fit you have achieved is good enough.

It is possible to interactively change almost everything in the initial setup macro file and in the POP-file. For example, you can add more parameters to be optimized and modify or add more experimental information.

Changes that Require POP-file Recompilation

Some changes that you do interactively in the PARROT module or the ED_EXP sub-module destroys the data structure in the workspace. For example, if you add more composition sets to a phase, then the number of phases actually change and the links break between the experimental data and the thermodynamic models. Note that if the global minimization technique is used in POLY, then new composition sets that corrupts the PARROT workspace may be created automatically. If this happens, then you have to compile the POP-file again.

If you recompile the POP-file, then the experimental equilibria are calculated with the default start values.

Optimization Workflow

Normally, the workflow during an optimization is the following:

1. In the PARROT module, run the setup macro file using "$MACRO_FILE_OPEN" on page 5.
2. Go to ED_EXP with "$EDIT_EXPERIMENTS" on page 139, use "$READ_WORKSPACES" on page 214 to load your experimental data and then execute "$COMPUTE_ALL_EQULIBRIA" on page 37.
3. If an equilibrium cannot be computed, then this either means that the start values (site fractions, for example) were inappropriate or that the equilibrium cannot be calculated with the current set of parameters. If the latter, then the equilibrium may have to be excluded from the optimization. However, you should make an effort to exclude the possibility that the reason is just that you do not have the appropriate start values for the equilibrium.
4. When each equilibrium is either successfully computed or excluded from the calculation, go back to the PARROT module and run the "OPTIMIZE_VARIABLES" on page 154 command. Give the number of optimization iterations you want the Thermo-Calc program to carry out as an argument to the command. This number specifies how many different sets of values for the optimizing variables that PARROT tries to fit with the experimental data. It is recommended that you run 0 iterations first to see the discrepancy between the experimental data and the initial calculated results. The current workspace file is automatically updated with the last set of optimized variables and calculated results.

5. List and evaluate the result of the optimization using "LIST_RESULT" on page 149. Typically, what is of interest in the results are the relative standard deviation of the optimizing variables and the error values in the list of calculated experimental data results. If the relative standard deviation for an optimizing variable is very large, this means that the variable doesn’t have any effect on the computed results and that the variable should not be used (you can make PARROT ignore the variable by setting its value to 0 with "SET_FIX_VARIABLE" on page 158). If the relative standard deviation is close to zero for a variable, then this might indicate that you need to use more variables. When it comes to errors in the calculated equilibrium results, these can be decreased by lowering the weight that PARROT gives the experiment in the calculation (the more weight, the more the experiment affects the calculated results).

6. Use "OPTIMIZE_VARIABLES" on page 154 or "CONTINUE_OPTIMIZATION" on page 138 to carry out a new optimization cycle. Go back to step 5 above and continue to do optimization cycles until you judge that there is a good enough fit between your calculated results and your experimental data. It is recommended that you do not only rely on feedback from "LIST_RESULT" on page 149 but also frequently plot various diagrams and compare them visually to some of your experimental data.

**Ensuring Computation of all Equilibria**

When you have run the setup macro file, you should start by trying to compute all the equilibria that were created when your POP-file was compiled. To do this, you must first go to the ED_EXP submodule, and load the experimental data from the current PARROT workspace file with the "READ_WORKSPACES" on page 214 command (normally, the block number is 1).

When you have loaded all equilibria, you should try to compute them all using the ED_EXP command "COMPUTE_ALL_EQUILIBRIA" on page 37. A list of calculated equilibrium results are shown in the console, but the software is not able to reach an equilibrium for an experiment, then the program cancels the calculations and displays an error message.

The following list shows an example output where the first two experiments in the POP-file have been successfully computed, but an equilibrium is not reached for the third
experiment. No other equilibria are computed, since the calculations are aborted when the error occurs.

<table>
<thead>
<tr>
<th>Eq</th>
<th>Lab</th>
<th>Iter</th>
<th>Weight</th>
<th>Temp</th>
<th>Exp</th>
<th>Fix phases or comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>A1</td>
<td>22</td>
<td>1.</td>
<td>2575.3</td>
<td>IONIC_FLUORI</td>
<td>TETR</td>
</tr>
<tr>
<td>2</td>
<td>A1</td>
<td>18</td>
<td>1.</td>
<td>2156.9</td>
<td>IONIC_CORUND</td>
<td>TETR</td>
</tr>
</tbody>
</table>

*** ERROR 1614 IN QTHISS

*** CONDITIONS CAN NOT BE FULLFILLED

When this happens, try to find out why the equilibrium calculation fail. Are the condition start values that you have given the equilibrium inappropriate for example? If you have a similar equilibrium that has already been successfully computed, then you can select the equilibrium that does not work, use the ED_EXP command "SET_ALL_START_VALUES" on page 217 and accept all the suggestions for the site fractions. Alternatively, use "TRANSFER_START_VALUES" on page 70<equilibrium number> to make the currently selected equilibrium inherit the start values of the indicated equilibrium. Run "COMPUTE_EQUILIBRIUM" on page 190 again to see if the equilibrium can be computed with the inherited start value.

If you cannot find an explanation of why the equilibrium cannot be computed, then it may be that the experiment is faulty. If so, then this experiment should be excluded from the optimization by being given a weight of 0. You should then run COMPUTE_EQUILIBRIUM again to make sure that all equilibria can be computed. However, experiments that fail to reach equilibria could succeed in doing so if the optimizing variables have other values. It is therefore sometimes worth trying to include experiments later in the optimization process (when the optimizing variables are relatively close to their final values), even if they had to be excluded at its start. In some cases, it might also be appropriate to change the error tolerance for in an experiment (using the ED_EXP command "EXPERIMENT" on page 44).

⚠️ You must save the PARROT workspace with "SAVE_WORKSPACES " on page 54 before you exit the ED_EXP module.

**Setting Weights**

To change the weight of an experiment, first enter the ED_EXP module from PARROT using "EDIT_EXPERIMENTS" on page 139. Then use the "SET_WEIGHT" on page 66 command to set the weight for a specific equilibrium (equilibrium number 3 for example), for a range of equilibria (the equilibria 10-19) or all the equilibria that have a certain label (such as all the equilibria with the label A1). To save the new weight(s), use "SAVE_WORKSPACES " on page 54.
By default, all the experimental information in your POP-file is treated equally: each experiment has a weight of 1. However, experiments that you excluded because they did not reach equilibrium now have a weight of 0. The higher the weight of an experiment is, the more Thermo-Calc tries to ensure that the computed result fits the condition measured in that experiment.

The contribution of an experiment’s error to the sum of errors is multiplied by the square of the weight set for that experiment. In other words, if you want to cut the error of an experiment with weight 1.0 by half, then you should use a weight of 0.7. This makes the experiment’s error 0.49. Setting the weight to 1.4 instead makes the error twice as large (1.96).

Note that if you use "READ_WORKSPACES" on page 214 after you have changed weights on the experiments, your changes are lost unless you have saved those changes. In the ED_EXP module, you can get a list of all the experiments in the console if you first read the experimental data from the workspace file (with READ_WORKSPACES) and then use "LIST_ALL_EQUILIBRIA" on page 48.

Optimizing and Evaluating Results

When you have ensured that all the experimental data points can reach equilibrium, go back to the PARROT module and use "OPTIMIZE_VARIABLES" on page 154 <number of iterations> with 0 iterations. Present the result of this initial optimization by using "LIST_RESULT" on page 149.

When evaluating the optimization results, the most important information is found in the list of experiments at the end of the listed results. The rightmost column shows the difference between the value of the experimental data and the value computed by Thermo-Calc in the last optimization cycle.

The following shows part of list of experiments in the output of a LIST_RESULT command:

The experiments for which the optimization has not found a good fit are marked with an asterisk (*) or a hash sign (#) in the rightmost column. An asterisk in this column indicates that the experiment has an error that is larger than the error tolerance and a hash sign
indicates that the error is much larger. The error tolerance depends on the degree of accuracy set for that particular piece of experimental information. The error values are presented in the next to rightmost column.

Note that if you are optimizing in alternate mode, then you usually do not need to change the weights for the experiments. Instead, you can simply run OPTIMIZE_VARIABLES again, specifying, say, thirty iterations, evaluate the results again, and continue in that way until you are satisfied with the results.

Also see "About Alternate Mode" on page 47.

The Critical Set of Experiments

The set of weighted experiments that you end up with as a result of your optimization is referred to as the critical set of experiments. When you work to determine this set and the weights of the experiments, the following factors should be reflected in both the selection of experiments and the weights of those experiments:

- The reliability of the experimental technique.
- The extent of agreement/disagreement between independent measurements of the same quantity.
- The extent of agreement/disagreement between data obtained with different experimental methods.

Continuing the Optimization and Resetting Variables

To continue the optimization after you have used "OPTIMIZE_VARIABLES" on page 154, you can either use this command and enter <Number of iterations> again or "CONTINUE_OPTIMIZATION" on page 138 <Number of iterations>.

If you use "CONTINUE_OPTIMIZATION" on page 138, then PARROT continues the optimization using the same Hessian matrix. If the optimization is going well but you run out of iterations, then continuing with the same Hessian matrix may be useful.

As before, use "LIST_RESULT" on page 149 to inspect the fit between the calculated and the experimental values for your experiments. If necessary, adjust the weights of the experiments again in the ED_EXP module. You may even discover that you have to exclude additional experiments from the optimization.

Besides looking at the rightmost column in the list of experiments (that is produced when you use LIST_RESULT), it is also useful to look at the sum of squares of the errors of all the variables. This is shown in the output of OPTIMIZE_VARIABLES and CONTINUE_OPTIMIZATION. This sum should be as low as possible.
**Example Output**

The following shows part of the output that you get when using "LIST\_RESULT" on page 149:

```
= OPTIMIZING VARIABLES =

AVAILABLE VARIABLES ARE V1 TO V10

<table>
<thead>
<tr>
<th>VAR</th>
<th>VALUE</th>
<th>START VALUE</th>
<th>SCALING FACTOR</th>
<th>REL. STAND. DEV</th>
</tr>
</thead>
<tbody>
<tr>
<td>V1</td>
<td>-0.6452164E+05</td>
<td>4.00000000E+04</td>
<td>6.00000000E+04</td>
<td>4.00000000E+04</td>
</tr>
<tr>
<td>V2</td>
<td>-0.3210958E+02</td>
<td>-3.52000000E+01</td>
<td>3.52000000E+01</td>
<td>3.52000000E+01</td>
</tr>
<tr>
<td>V3</td>
<td>2.6525324E+01</td>
<td>2.70000000E+00</td>
<td>2.70000000E+00</td>
<td>2.70000000E+00</td>
</tr>
<tr>
<td>V4</td>
<td>-0.6697426E+05</td>
<td>-1.00000000E+05</td>
<td>-1.00000000E+05</td>
<td>-1.00000000E+05</td>
</tr>
</tbody>
</table>

NUMBER OF OPTIMIZING VARIABLES : 5
ALL OTHER VARIABLES ARE FIXED WITH THE VALUE ZERO

THE SUM OF SQUARES HAS CHANGED FROM 3.5019657E+05 TO 3.4009672E+05

DEGREES OF FREEDOM 14. REDUCED SUM OF SQUARES 2.49354800E+04
```

In the example you can see that the sum of squares have decreased slightly. (The final sum of squares that you get after an optimization run is also presented directly in the output from OPTIMIZE\_VARIABLES and CONTINUE\_OPTIMIZATION.) As long as the sum of squares figure is decreasing, the optimization is working as it should.

When your calculated results have been improving for a while, that is, when the sum of squares has been decreasing, and you are confident that you are making definitive progress, then you should use the PARROT command "RESCALE\_VARIABLES" on page 156 to reset the starting values of the optimizing variables to their current values. When you do this, the start values and scaling factors of the optimizing variables (shown in the table’s third column in the preceding screen shot), are all set to the current values (shown in the table’s second column).

If your optimization is not going well, then you may want to reset the values of your optimization variables to their current start values. To do this, use "RECOVER\_VARIABLES" on page 155.

After rescaling the variables, continue the optimization using OPTIMIZE\_VARIABLES again. Cycle through calls of the commands OPTIMIZE\_VARIABLES/CONTINUE\_OPTIMIZATION, CONTINUE\_OPTIMIZATION, RESCALE\_VARIABLES and OPTIMIZE\_VARIABLES again until your set of optimizing variables does not seem to improve anymore. Even when it seems to you that you have reached this point, it is recommended that you use OPTIMIZE\_VARIABLES/CONTINUE\_OPTIMIZATION a few extra times to make sure that the variable values cannot be further improved, that is, that the sum of squares of the errors of all the variables cannot be reduced further. If the final solution is repeatedly calculated after the same number of iterations and reaching the same result, then it is generally reasonable to accept the current variable values.
Updating the Set of Optimizing Variables

Besides evaluating the fit between the calculated results and the experimental data, you should also ensure that you have the right number of optimizing variables. If you have too many or too few optimizing variables, then you may not be able to use your model to accurately extrapolate thermodynamic properties in a wide range of temperature, pressure and composition conditions.

With more optimization parameters, the sum of errors usually decrease, but the parameters also tend to become less precisely determined. A measure of this precision is the Relative Standard Deviation (RSD) of each optimizing variable. However, the RSD is only significant if you have used "RESCALE_VARIABLES" on page 156 followed by an optimization which converges and the values of the variables do not change much. The RSD tells you how much the parameter can be changed in either a positive or in a negative direction without changing the reduced sum of errors with more than one unit.

Example

A large RSD value thus means that the parameter has not been determined well.

If such a significant RSD has a value larger than 1, then this typically means that you are using too many optimizing variables. However, the RSD values also depend on the weighting of the experiments, so it is sometimes possible to reduce the RSD by changing weights.

The RSD should not be too low either. If one or more of them is very close to 0, then this suggests that you are trying to optimize the system with too few optimizing variables. You can add optimizing variables interactively using "ENTER_PARAMETER" on page 143 in GIBBS. However, it is recommended that you add a sufficient number of variables in the setup file from the start so that do not need to do this. You can fix variables to a value of 0 until you discover that they are needed.
Besides the RSD, you should also keep an eye on the variable values themselves (shown in the VALUE column, next to the leftmost column in the table shown in the preceding screenshot). If the value of a variable is in the order of 1E5 or higher and this variable has been put in the temperature-independent part of an interaction parameter’s Gibbs energy expression, then you may not have the right weights on your experiments or you are using too many optimizing variables. This is also typically the case if a variable with a value in the order of 10 or more (per mole atoms) is in the temperature-dependent part of the Gibbs energy expression of an interaction parameter. Such a high parameter value may lead to inverted miscibility gaps or re-stabilisation of a phase at high temperature. It is important to keep an eye on this since the temperature-independent and the temperature-dependent interaction parameter often varies together. If the temperature-dependent interaction parameter cannot be reliably determined, you may have to fix its value.

Note that even if you have found a good enough fit between calculated and experimental values after an optimization run, a parameter value may suddenly start to change by several orders of magnitude when you use "OPTIMIZE_VARIABLES" on page 154 is used again. If this happens, then careful reconsideration of the weighting of the experiments of the set of optimizing variables is required. However, when the optimization has converged and the parameter values remain stable after repeated use of OPTIMIZE_VARIABLES, this should usually not happen.

**Reducing the Number of Optimizing Variables**

If you have one or more optimizing variables with RSD larger than 1, then you should remove one or more of the variables by setting them to a value of 0, or alternately, set them to a reliably estimated value (estimated based on, for example, semi-empirical methods).

To fix an optimizing variable to certain value, use the PARROT command "SET_FIX_VARIABLE" on page 158 <variable number> <value>.

**Plotting Intermediate Results**

It is typically not sufficient to look at the plain text output of "LIST_RESULT" on page 149 to reliably judge how the optimization is progressing. Plotting a phase or property diagram of the system you are optimizing using the POLY and POST modules is often very useful.

It is recommended that you create a macro file for plotting the diagram since you probably want to repeatedly plot the diagram as you progress with the optimization. This macro file can then be called directly from the PARROT module with the "MACRO_FILE_OPEN" on page 5 command.

**Superimposing Experimental Data from EXP-files**

If you create one or several EXP-files based on the experiments in your POP-file, you can visually compare the fit your plot and the experimental data you are optimizing the system
against. An EXP-file contains data points specified in the DATAPLOT format. You could make an EXP-file for each type of data that you are using in the optimization.

Use the POST command "APPEND_EXPERIMENTAL_DATA" on page 245 to superimpose the data points in an EXP-file on a phase or property diagram that you have plotted. For example, to put the experimental data points from a file entitled DP.EXP onto a plotted diagram, you could enter the following:

```
APPEND_EXPERIMENTAL_DATA Y DP.EXP 0 1
```

Such a command tells Thermo-Calc to superimpose the data points in dataset 1 of DP.EXP onto the plot in the Console Results window, but not to impose any information about axis scaling, labels and other information which is normally found in the prologue of the DP.EXP file.

The POST command "QUICK_EXPERIMENTAL_PLOT" on page 254 can also be used to superimpose data points on a plotted phase or property diagram.

Also see the DATPLOT User Guide included with this documentation set.
Finalizing the Optimization

In this section:

- Finishing the Optimization ................................................................. 44
- Rounding off Optimizing Variable Values ............................................. 44
- Updating the Database File .................................................................. 44
- Creating a Database File ...................................................................... 45
- Updating the Setup File and the POP-file ............................................. 45
**Finishing the Optimization**

When to stop optimizing is a matter of judgement. It is rarely the case that you finish optimizing a system with the feeling that it cannot be improved.

The final step is to update your files with the final results. Besides updating your database file (or alternatively, creating a new database file), it is advised that you also update your setup and POP-files with the final weights and optimizing variable values.

**Rounding off Optimizing Variable Values**

When you save the optimizing variable values, it is important that you round off the values correctly. When you have a metallic system, it is usually best to keep whatever number of decimal digits that you need to make less than one J/mol difference at 1000 K. When you have an aqueous system or a system that you are optimizing based on data from very different temperature ranges, then this is not always the only appropriate guideline. However, rounding off the values in such a way that it gives a difference that is larger than one J/mol may lead to differences in the phase diagram.

Another approach you can take when rounding off variable values is by progressively fixing the value of more and more of the variables. This allows you to round-off all but one of the variables values so that each only has a few significant digits. Variables whose values have been rounded off in this way are easier to handle compared with those that are rounded off so that they continue to have many significant (non-zero) digits.

To round off the variable values according to this second approach, first use "SET_FIX_VARIABLE" on page 158 to set the variable(s) with the highest RSD to a rounded off value (such as, say, 0.4). When you then re-optimize using "OPTIMIZE_VARIABLES" on page 154, the sum or errors changes. However, you should get almost exactly the same sum of errors as before after you rescale the variable values using "RESCALE_VARIABLES" on page 156. (If the sum of errors is different, then this means that the variable with the highest RSD was not rounded off in a good way.) If you successfully round off the first variable value, then continue to round of the optimizing variable which now has the highest RSD. Continue doing this until you have fixed all but one of the optimizing variables to their rounded-off values. The final sum of errors that you get after having fixed the variable values should not deviate significantly from the initial sum of errors you had before starting to round-off the variable values.

**Updating the Database File**

To update the database file (with filename extension TDB) open it in a text editor and enter or update each of the parameters that you have optimized.

For example, suppose you have the following command in your setup file:

```
ENTER_PARAMETER L(IONIC_LIQ,AL+3,ZR+4:0-2;0) 298.15 +V17; 6000 N
```
If you then end up with a value for optimizing variable V17 of -100000, then you should enter the following under the IONIC\_LIQ phase in the database file:

\[
\text{PARAM L(IONIC\_LIQ,AL+3,2R+4:O-2;0) 298.15 -100000; 6000 N REF !}
\]

If you often need to round-off the optimizing variable value in some way, see "Rounding off Optimizing Variable Values" on the previous page.

When you have updated or entered the parameters that you optimized, save the database file.

### Creating a Database File

In some circumstances you may want to save all the information about your system into a new database file. To do this, go to the GIBBS module and use LIST\_DATA <Filename> N. This creates a new user database file that contains all the information about the system that is in the workspace.

The N-argument tells the "LIST\_DATA" on page 120 command to save the output into database file rather than some other type of file, such as a macro file for example. Note that the output database file that you get from LIST\_DATA have to undergo some manual editing before it can be used as proper database file.

### Updating the Setup File and the POP-file

It may be useful for you to be able to recreate your optimization from scratch. It is therefore recommended that you do the following when you are done with the optimization:

- Update your POP-file so that it contains the weights of your critical set of experiments. Use "SET\_WEIGHT" on page 66 to set the weights directly in the POP-file. You may also have to use "SET\_START\_VALUE" on page 226 for some conditions in the POP-file. Otherwise, you may not be able to compute the equilibria with "COMPUTE\_ALL\_EQUILIBRIA" on page 37.

- Copy the final values of your optimizing variables and set them as start values of the variables in the setup macro file (with "SET\_FIX\_VARIABLE" on page 158).

It is important that you round off the values of the optimizing variables correctly. See "Rounding off Optimizing Variable Values" on the previous page. When you have done this, you can run the setup macro file to recreate the final result of the optimization.
Alternate Mode

In this section:

- About Alternate Mode ................................................................. 47
- Optimizing in Alternate Mode ......................................................... 48
- Preparing the POP-file for Alternate Mode ..................................... 48
- Examples of SET_ALTERNATE_CONDITION .................................. 48
- Entering Other Experiments in the POP with Alternate Mode .......... 49
**About Alternate Mode**

To turn Alternate Mode ON or OFF, use the PARROT command "SET_ALTERNATE_MODE" on page 156.

When you have one or more multi-phase equilibria (that is, with the fixed phase-status) in your POP-file and the optimizing values lack appropriate starting values (such as the default value of 0 for example), then Thermo-Calc may not be able to compute the equilibria for the experiments. In these cases, a common tangent cannot be found, that is, a state where the chemical potentials for all components are the same in all phases cannot be found. A common tangent may not exist or it be found at the wrong composition or temperature given the initial set of model parameters.

If you are not able to estimate reasonable starting values for the optimizing variables, then this problem can be overcome by initially running your optimization in alternate mode. The alternate mode in PARROT module should help you find reasonable starting values for the optimizing variables. Note that you are only supposed to use alternate mode in the beginning of the optimization. Once you have achieved a reasonable fit between calculated results and experimental data, turn off alternate mode and calculate all equilibria again in the normal mode.

In alternate mode, PARROT modifies multi-phase equilibria so that the chemical potentials for each stable phases is calculated separately. For example, consider the following experimental equilibrium:

```
CREATE_NEW_EQUILIBRIUM 1 1
CHANGE_STATUS PHASE LIQ FCC=FIX 1
SET_CONDITION T=1000 P=1E5
EXPERIMENT X(LIQ,B)=.2:.01 X(FCC,B)=.1
```

When PARROT optimizes in alternate mode, the computation of this equilibrium is done by way of the following two calculations:

```
CHANGE_STATUS PHASE LIQ=FIX 1
SET_CONDITION T=1000 P=1E5 X(LIQ,B)=.2
CHANGE_STATUS PHASE FCC=FIX 1
SET_CONDITION T=1000 P=1E5 X(FCC,B)=.1
```

The difference between the chemical potentials in every pair of phases is calculated and PARROT tries to adjust the parameters of the phases so that these differences are minimized. In other words, PARROT tries to make the chemical potentials equal in all phases. For PARROT to be able to do this, some additional information about the experimental multi-phase equilibria is required, at least for all invariant equilibria.
Optimizing in Alternate Mode

When you are optimizing in the alternate mode, you usually do not need to enter the ED_EXP module and manually change the weights of experiments that the computed results have not been fitted well with. Instead, after using "OPTIMIZE_VARIABLES" on page 154 initially with no iterations, and listing the result with "LIST_RESULT" on page 149, simply run OPTIMIZE_VARIABLES again specifying, say, thirty iterations. Continue to optimize until your optimization seems to be going in the right direction, then set the optimizing variables’ starting values to their current values use "RESCALE_VARIABLES" on page 156 before you turn alternate mode off by answering N at the "SET_ALTERNATE_MODE" on page 156 prompt.

Preparing the POP-file for Alternate Mode

Information in your POP-file that concerns equilibria with ENTERED or DORMANT phases is ignored when you optimize in alternate mode.

To use the alternate mode, ensure that there is enough information about each phase in a given equilibrium. In addition to the temperature and pressure of the system, you should specify the composition of all phases in a given equilibrium. This is done with, "SET_CONDITION" on page 220, "EXPERIMENT" on page 44 or "SET_ALTERNATE_CONDITION" on page 57.

If both compositions of a binary tie-line have been measured, then you could specify this in the POP-file in the following way:

```
CREATE_NEW_EQUILIBRIUM 1 1
CHANGE_STATUS PHASE FCC BCC=FIX 1
SET_CONDITION P=1E5 T=1000
EXPERIMENT X(BCC,B)=.2:.01 X(FCC,B)=.3:.01
```

This equilibrium could be calculated with alternate mode without any modification. The compositions specified with the experiment command is used as condition when the thermodynamic properties of each phase are calculated.

Examples of SET_ALTERNATE_CONDITION

The following topics demonstrate how "SET_ALTERNATE_CONDITION" on page 57 is used to prepare different kinds of equilibria for optimization in alternate mode.

Specifying the Composition of One Side of a Binary Tie-Line

If only one side of the tie-line has been measured, then you must provide an estimate of the
composition of the other phase. You can make such an estimate with SET_ALTERNATE_CONDITION. This command has no effect unless alternate mode is turned on. The equilibrium described could thus be specified in the following way:

```
CREATE_NEW_EQUILIBRIUM 1 1
CHANGE_STATUS PHASE FCC BCC=FIX 1
SET_CONDITION P=1E5 T=1000
EXPERIMENT X(BCC,B)=.2:.01
SET_ALTERNATE_CONDITION X(FCC,B)=.3
```

When the alternate mode is turned on, the composition given by the SET_ALTERNATE_CONDITION command is used for the FCC phase. The properties of the BCC phase is calculated using the composition specified by experiment as a condition.

**Specifying the Compositions of a Three-Phase Equilibrium**

If you have a three-phase equilibrium in your POP-file, then one of its compositions can be specified as experimentally determined, while two can be provided as alternate conditions:

```
CREATE_NEW_EQUILIBRIUM 1 1
CHANGE_STATUS PHASE FCC BCC LIQ=FIX 1
SET_CONDITION P=1E5
EXPERIMENT T=912:5 X(LIQ,B)=0.2:.02
SET_ALTERNATE_CONDITION X(FCC,B)=0.1 X(BCC,B)=.4
```

**Specifying the Composition of a Stoichiometric Phase**

When you specify the composition of stoichiometric phase with SET_ALTERNATE_CONDITION, the value must be given with at least seven decimal digits, as in the following example:

```
CREATE_NEW_EQUILIBRIUM 1 1
CHANGE_STATUS PHASE LIQ A2B=FIX 1
SET_CONDITION P=1E5 X(LIQ,B)=0.2
EXPERIMENT T=992:5
SET_ALTERNATE_CONDITION X(A2B,B)=.6666667
```

**Entering Other Experiments in the POP with Alternate Mode**

The following table shows some additional examples of how to enter different kinds of experiments in the POP-file when you are using the alternate mode.
<table>
<thead>
<tr>
<th>Example</th>
<th>ED_EXP commands</th>
</tr>
</thead>
<tbody>
<tr>
<td>Two-phase equilibrium: The melting temperature of an Au-Cu alloy</td>
<td>CHANGE_STATUS PHASE LIQUID FCC=FIX 1 SET_CONDITION X (FCC,CU)=0.14 P=1E5 EXPERIMENT T=970:2 SET_ALTERNATE_CONDITION X(LIQUID,CU)=0.16</td>
</tr>
<tr>
<td>Invariant equilibrium experiment: A three-phase equilibrium in a binary system</td>
<td>CREATE_NEW_EQUILIBRIUM 1 1 CHANGE_STATUS PHASE FCC BCC LIQUID=FIX 1 SET_CONDITION P=1E5 EXPERIMENT T=912:5 SET_ALTERNATE_CONDITION X(FCC,B)=0.1 SET_ALTERNATE_CONDITION X(BCC,B)=0.4 SET_ALTERNATE_CONDITION X(LIQ,B)=0.2</td>
</tr>
<tr>
<td>Ternary system, with two compositions measured (both with uncertainty 0.02)</td>
<td>CREATE_NEW_EQUILIBRIUM 1 1 CHANGE_STATUS PHASE FCC BCC=FIX 1 SET_CONDITION T=1273 P=1E5 SET_CONDITION X (FCC,B)=0.1:0.02 EXPERIMENT X(FCC,C)=0.12:.02 SET_ALTERNATE_CONDITION X(BCC,B)=0.17 SET_ALTERNATE_CONDITION X(BCC,C)=0.07</td>
</tr>
</tbody>
</table>
Troubleshooting

During an optimization, you are likely to run into many different problems and challenges. This topic gives some general guidelines that can help avoid common mistakes and problems.

In this section:

- Useful Guidelines ................................................................. 52
- Excluding and Including the Correct Equilibria .......................... 53
- Conflicting Data ........................................................................ 53
Useful Guidelines

The following rules of thumb are generally good to adhere to when you are planning and executing an optimization:

- Do not use data from thermochemical tables of unknown origin.
- Use experimentally determined properties; avoid converted quantities.
- Carefully estimate the accuracy of the experiments.
- Correct systematic errors (by adjusting a temperature scale for example).
- Use negative information such as, for example, the information that a phase should not be stable in a composition or temperature region.
- With a hundred activity measurements in a system but only ten composition points from the phase diagram, it is often appropriate to decrease the weights on the activity experiments.
- If you initially exclude any intermediate phases to only optimize the liquid and the terminal or end-member phases for the pure components, then it is often useful to compute a metastable phase diagram with just these phases. In the metastable phase diagram, the metastable solubility lines should not have any strange kinks or turns. Such a diagram is often also useful to compute at later stages in the optimization.
- When you have fitted the liquid phase and some solution phases reasonably well, then you can fix the optimizing variables that characterise these phases. You can then go on and optimize the variables for the intermediate phases.
- Phases with miscibility gaps are always difficult to optimize. Try to keep control of the miscibility gaps by using real or estimated experimental information. (Note that it is not possible to calculate the top of a miscibility gap as a single equilibrium.)
- Phases with order/disorder transformation are often difficult to optimize. It may be difficult to find the right start values on the optimizing variables. The TABULATION module (see "TABULATION_REACTION Commands" on page 306) can be useful sometimes. Properties for specified site fractions can be calculated in the TABULATION module. This is not possible in the POLY module since this module only calculates for equilibrium site fractions. The ordered state may also disappear during the optimization of these phases. If this happens, you may be able to add an experiment that controls the state of order.
- Only use the alternate mode to find an initial set of model parameters that can then be make it possible to calculate the experimental equilibria in the normal mode.
- When you have achieved a satisfactory fit between calculated results and experimental data with an appropriate number of optimization variables, perform a couple of final optimization runs to make sure that your results are stable.
- Make sure that the values of the optimizing variables keep within a reasonable range. If a variable starts to change several orders of magnitudes, then you must consider whether you have the right weights on the experiments and whether you are using too many optimizing variables.

**Excluding and Including the Correct Equilibria**

Use as few experiments as possible initially to get a reasonable overall fit. It is generally best to first focus on the invariant equilibria, as well as metastable states that can be estimated by excluding some phases. Crucially, any experiments for which the computed results are clearly faulty should be excluded from the final critical set, while all important invariant equilibria are calculated and included in this critical set.

If you cannot compute some invariant equilibria with intermediate phases, then it may be best to first exclude those phases from the optimization and only optimize the liquid and the most important solution phases. After you have obtained reasonable results for these phases, you can enter the intermediate phases back in again. With the variables for the optimized liquid and solid phases set fixed, you can finally optimize the intermediate phases.

**Conflicting Data**

It is important that you do not include conflicting sets of data at the same time during an optimization. After all, if they are genuinely conflicting, then at least one of the sets must be incorrect. If you have conflicting sets of data, then only use one of these sets at a time together with the rest of the data. Often, the optimization makes it clear which dataset coheres best with the other information that is available about the system.

Sometimes, conflicting data cannot be detected directly. For example, you may have activity data which is inconsistent with solubility data from the phase diagram. This would be indicated by large errors in the fit when both the activity data and the solubility data are included. To find these inconsistencies, let alone correct the errors, you may thus have to optimize with some datasets excluded.
Experiments and Experimental Data

These topics contain examples of different kinds of equilibria in different kinds of systems. They are intended to help you figure out how to use various kinds of experimental data when creating POP-files. The topics that follow contain examples how to enter various kinds of experimental data into a POP-file.

In this section:

- Phase Diagram Data ................................................................. 55
- Data for Individual Compounds .................................................. 56
- Single Phase Mixing Enthalpies or Partial Enthalpies ....................... 58
- Enthalpies of Formation and Enthalpies of Reactions ....................... 58
- Chemical Potentials via EMF Measurements ................................ 59
- Driving Force for Metastable Phases ......................................... 60
- Pressure-Temperature-Volume EOS Data .................................... 60
- Crystal Structure, Lattice Parameters and Site-Occupancy ............... 61
- Magnetism and Other Atomistic Properties .................................. 62
- Data About Systems of Different Orders ..................................... 62
Phase Diagram Data

P-T-X phase diagram data for binary and ternary systems, or systems of even higher order can be used in the POP-file. This includes data of the following types:

- Data about the temperature- and composition-dependence of various properties (obtained from differential thermal analysis (DTA) measurements for example), including enthalpy, lattice parameter, dilatometric length, electronic conductivity and magnetic susceptibility;
- Data about reaction types (invariant/monovariant) and phase relations obtained from qualitative or quantitative metallographic studies;
- Data about phase amounts or compositions obtained from microprobe measurements (using X-ray spectroscopy or transmission electron microscopy (TEM));
- Data about the positions or directions of two-phase tie-lines and three-phase equilibria for ternary systems.

Example

The following table shows a POP-file excerpt that demonstrates how some kinds of phase diagram data can be entered:

<table>
<thead>
<tr>
<th>Example</th>
<th>ED_EXP commands</th>
</tr>
</thead>
</table>
| Solidus (melting temperature) of an Au-Cu alloy | CREATE_NEW_EQUILIBRIUM 1 1  
CHANGE_STATUS PHASE LIQUID FCC=FIX 1  
SET_CONDITION X(FCC,CU)=0.14 P=1E5  
EXPERIMENT T=970:2 |
| Three-phase equilibrium in a binary A-B system | CREATE_NEW_EQUILIBRIUM 1 1  
CHANGE_STATUS PHASE FCC BCC LIQUID=FIX 1  
SET_CONDITION P=1E5  
EXPERIMENT T=912:5 |
| Congruent transformation in a binary A-B system | CREATE_NEW_EQUILIBRIUM 1 1  
CHANGE_STATUS PHASE BCC LIQUID=FIX 1  
SET_CONDITION P=1E5 X(BCC,B)-X(LIQ,B)=0  
EXPERIMENT T=1213:10 |
Example | ED_EXP commands
--- | ---
Tie-line in a ternary A-B-C system | An uncertainty factor is set not only for the experimental measurement, but also for the X(FCC,B) condition. The factor is 0.02.
CREATE_NEW_EQUILIBRIUM 1 1
CHANGE_STATUS PHASE FCC BCC=FIX 1
SET_CONDITION T=1273 P=1E5 X(FCC,B)=0.1:0.02
EXPERIMENT X(FCC,C)=0.12:0.02

Data for Individual Compounds

You can use data about individual components in the POP-file. Such data includes activity, heat capacity, heat content, entropy, Gibbs energy of phase transformations, heat of transition and heat of melting.

Examples

<table>
<thead>
<tr>
<th>Example</th>
<th>ED_EXP commands</th>
</tr>
</thead>
</table>
| Carbon activity data in the fcc phase | CREATE_NEW_EQUILIBRIUM 1 1
CHANGE_STATUS PHASE FCC_A1=FIX 1
CHANGE_STATUS PHASE GRAPHITE=D
SET_REFERENCE_STATE C GRAPHITE,,,,,
SET_CONDITION P=101325 T=1273 X(MN)=0.03
SET_CONDITION X(C)=0.03
EXPERIMENT ACR(C)=0.29:5% |
| Ln(activity coefficient for O) | CREATE_NEW_EQUILIBRIUM 1 1
CHANGE_STATUS PHASE IONIC_LIQ=FIX 1
CHANGE_STATUS PHASE GAS=D
SET_CONDITION X(O)=0.02 T=1523 P=101325
SET_REFERENCE_STATE O GAS,,,,,
ENTER_SYMBOL FUNCTION LNFO=LOG(ACR(O)/X(O));
EXPERIMENT LNFO=-1.5:0.01 |
<table>
<thead>
<tr>
<th>Example</th>
<th>ED_EXP commands</th>
</tr>
</thead>
<tbody>
<tr>
<td>Entropy at 298.15 K of Cu2O</td>
<td><code>CREATE_NEW_EQUILIBRIUM 1 1</code>&lt;br&gt;<code>CHANGE_STATUS PHASE CU2O=FIX 1</code>&lt;br&gt;<code>CHANGE_STATUS PHASE CUO=FIX 0</code>&lt;br&gt;<code>SET_CONDITION P=101325 T=298.15</code>&lt;br&gt;<code>EXPERIMENT S=92.36:1</code></td>
</tr>
<tr>
<td>Gibbs energy of formation of NiAl2O4</td>
<td><code>CREATE_NEW_EQUILIBRIUM 1 1</code>&lt;br&gt;<code>CHANGE_STATUS PHASE SPINEL=ENT 1</code>&lt;br&gt;<code>CHANGE_STATUS PHASE FCC O2GAS=DORM</code>&lt;br&gt;<code>SET_REFERENCE_STATE NI FCC,,,,</code>&lt;br&gt;<code>SET_REFERENCE_STATE AL FCC,,,,</code>&lt;br&gt;<code>SET_REFERENCE_STATE O O2GAS,,,,</code>&lt;br&gt;<code>SET_CONDITION P=101325 T=1000 N(NI)=1 N(AL)=2</code>&lt;br&gt;<code>SET_CONDITION N(O)=4</code>&lt;br&gt;<code>EXPERIMENT GM=−298911.5%</code></td>
</tr>
<tr>
<td>Heat capacity of MgFe2O4</td>
<td><code>CREATE_NEW_EQUILIBRIUM 1 1</code>&lt;br&gt;<code>CHANGE_STATUS PHASE SPINEL=ENT 1</code>&lt;br&gt;<code>SET_CONDITION P=101325 N(FE)=2 N(MG)=1 N(O)=4</code>&lt;br&gt;<code>SET_CONDITION T=800</code>&lt;br&gt;<code>ENTER_SYMBOL FUNCTION CP=H.T;</code>&lt;br&gt;<code>EXPERIMENT CP=207:5%</code></td>
</tr>
<tr>
<td>Heat content (H-H298) for MnFe2O4</td>
<td><code>CREATE_NEW_EQUILIBRIUM 1 1</code>&lt;br&gt;<code>CHANGE_STATUS PHASE SPINEL=ENT 1</code>&lt;br&gt;<code>SET_CONDITION P=101325 T=298.15 N(MN)=1 N(FE)=2</code>&lt;br&gt;<code>SET_CONDITION N(O)=4</code>&lt;br&gt;<code>ENTER_SYMBOL VAR H298=H;</code>&lt;br&gt;<code>ENTER_SYMBOL FUN HMNFE2O4=H−H298;</code>&lt;br&gt;<code>CREATE_NEW_EQUILIBRIUM 2 1</code>&lt;br&gt;<code>CHANGE_STATUS PHASE SPINEL=ENT 1</code>&lt;br&gt;<code>SET_CONDITION P=101325 N(MN)=1 N(FE)=2 N(O)=4</code></td>
</tr>
</tbody>
</table>
Single Phase Mixing Enthalpies or Partial Enthalpies

You can use calorimetric data for mixing in the POP-file. This data could be the result of, for example, drop calorimetry or scanning calorimetry. This includes data about, for example, enthalpy of mixing of liquids, series of mixing-enthalpy and about partial enthalpy. Information about enthalpies of mixing can also be derived from theoretical principles using special quasi-random structures (SQSs).

Example

<table>
<thead>
<tr>
<th>Example</th>
<th>ED_EXP commands</th>
</tr>
</thead>
</table>
| Enthalpy of mixing in the liquid state of an Au-Cu alloy | CREATE_NEW_EQUILIBRIUM 1 1  
CHANGE_STATUS PHASE LIQUID=FIX 1  
SET_CONDITION T=1379 P=1E5  
SET_CONDITION X(LIQUID,AU)=0.0563  
SET_REFERENCE_STATE AU LIQ * 1E5  
SET_REFERENCE_STATE CU LIQ * 1E5  
EXPERIMENT HMR=-1520:200 |

Enthalpies of Formation and Enthalpies of Reactions

You can use calorimetric data for phase transformations in the POP-file. This data could be the result of, for example, direct-reaction calorimetry, solution calorimetry or combustion calorimetry. Information about enthalpies of formation can also be derived from theoretical principles.
Examples

<table>
<thead>
<tr>
<th>Example</th>
<th>ED_EXP commands</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enthalpy of melting of the eutectic in the Al2O3-ZrO2 binary (J/g)</td>
<td>CREATE_NEW_EQUILIBRIUM 1 1</td>
</tr>
<tr>
<td></td>
<td>CHANGE_STATUS PHASE CORUNDUM ZRO2_TETR=FIX 0</td>
</tr>
<tr>
<td></td>
<td>CHANGE_STATUS PHASE IONIC_LIQ=ENT 1</td>
</tr>
<tr>
<td></td>
<td>SET_CONDITION P=101325 N=1 LNAC(O)=-80</td>
</tr>
<tr>
<td></td>
<td>SET_REFERENCE_STATE ZRO2 TETR,,,,,,,</td>
</tr>
<tr>
<td></td>
<td>SET_REFERENCE_STATE AL2O3 CORUND,,,,,,,</td>
</tr>
<tr>
<td></td>
<td>EXPERIMENT HWR=1080:90</td>
</tr>
<tr>
<td>Enthalpy of formation of o-CaZrO3 from the component oxides</td>
<td>CREATE_NEW_EQUILIBRIUM 1 1</td>
</tr>
<tr>
<td></td>
<td>CHANGE_STATUS PHASE ZRO2_MONO HALITE CA2RO3_0=ENT 1</td>
</tr>
<tr>
<td></td>
<td>SET_CONDITION T=298.15 P=101325 N(CAO)=.5</td>
</tr>
<tr>
<td></td>
<td>SET_CONDITION N(ZRO2)=.5 LNAC(O)=-20</td>
</tr>
<tr>
<td></td>
<td>SET_REFERENCE_STATE CAO_HALITE,,,,,</td>
</tr>
<tr>
<td></td>
<td>SET_REFERENCE_STATE ZRO2 ZRO2_MONO,,,,,</td>
</tr>
<tr>
<td></td>
<td>EXPERIMENT HMR(CA2RO3_0)=-15960:5%</td>
</tr>
</tbody>
</table>

Chemical Potentials via EMF Measurements

You can use chemical potentials and activities/activity coefficients from electromagnetic field (EMF) measurements in the POP-file.
Example

<table>
<thead>
<tr>
<th>Example</th>
<th>ED_EXP commands</th>
</tr>
</thead>
<tbody>
<tr>
<td>Emf data on Cu(s)/Cu2O(s)</td>
<td>CREATE_NEW_EQUILIBRIUM 1 1</td>
</tr>
<tr>
<td></td>
<td>CHANGE_STATUS PHASE FCC CU2O=FIX 1</td>
</tr>
<tr>
<td></td>
<td>CHANGE_STATUS PHASE O2GAS=DORM</td>
</tr>
<tr>
<td></td>
<td>SET_CONDITION P=101325 T=1000</td>
</tr>
<tr>
<td></td>
<td>SET_REFERENCE_STATE O O2GAS,, 100000</td>
</tr>
<tr>
<td></td>
<td>EXPERIMENT MUR(O)=-95387:1000</td>
</tr>
</tbody>
</table>

Driving Force for Metastable Phases

You can use chemical driving forces for metastable phases in the POP-file.

Examples

<table>
<thead>
<tr>
<th>Example</th>
<th>ED_EXP commands</th>
</tr>
</thead>
<tbody>
<tr>
<td>To prevent BCC_A2 to be stable</td>
<td>CREATE_NEW_EQUILIBRIUM 1 1</td>
</tr>
<tr>
<td></td>
<td>CHANGE_STATUS PHASE FCC_A1 M7C3 M23C6=FIX 1</td>
</tr>
<tr>
<td></td>
<td>CHANGE_STATUS PHASE BCC_A2=D</td>
</tr>
<tr>
<td></td>
<td>SET_CONDITION P=101325 T=1473</td>
</tr>
<tr>
<td></td>
<td>EXPERIMENT DGM(BCC)&lt;-0.1:0.1</td>
</tr>
<tr>
<td>To promote CEMENTITE to be</td>
<td>CHANGE_STATUS PHASE BCC M7C3 GRAPHITE=FIX 1</td>
</tr>
<tr>
<td>stable</td>
<td>CHANGE_STATUS PHASE CEMENTITE=DORMANT</td>
</tr>
<tr>
<td></td>
<td>SET_CONDITION P=P0 T=973</td>
</tr>
<tr>
<td></td>
<td>EXPERIMENT DGM(CEM)&gt;0.1:0.01</td>
</tr>
</tbody>
</table>

Pressure-Temperature-Volume EOS Data

You can use Pressure-Temperature-Volume Equation of State (EOS) data in the POP-file. Such data includes, for example, molar volume, density, thermal expansion and bulk-modulus/compressibility.
Examples

<table>
<thead>
<tr>
<th>Example</th>
<th>ED_EXP commands</th>
</tr>
</thead>
</table>
| Volume of liquid Pt | `CREATE_NEW_EQUILIBRIUM 1 1`  
CHANGE_STATUS PHASE LIQUID=ENT 1  
SET_CONDITION P=101325 N=1 T=1873  
EXPERIMENT VM=1.00758E-5:5% |
| Thermal expansion | `CREATE_NEW_EQUILIBRIUM 1 1`  
CHANGE_STATUS PHASE FCC_A1=ENT 1  
SET_CONDITION P=101325 N=1 T=400  
ENTER_SYMBOL FUNCTION ALPHA=VM.T/VM/3;  
EXPERIMENT ALPHA=2.35E-5:5% |

Crystal Structure, Lattice Parameters and Site-Occupancy

You use information about defects, ordering or site occupancy, as well as information about crystal structures in the form of lattice parameter values. This information may come from measurements made by X-ray, neutron diffraction, Mössbauer spectroscopy or perturbed angular-correlation.

Examples

<table>
<thead>
<tr>
<th>Example</th>
<th>ED_EXP commands</th>
</tr>
</thead>
</table>
| Lattice parameter for fcc | `CREATE_NEW_EQUILIBRIUM 1 1`  
CHANGE_STATUS PHASE FCC_A1=ENT 1  
SET_CONDITION P=101325 N=1 T=298.15  
SET_CONDITION X(CR)=0.05  
ENTER_SYMBOL FUNCTION LPFCC=((4*VM/6.02214179E23)**(1/3))*1E10;  
EXPERIMENT LPFCC=4.02:5% |
| Lattice parameter for bcc | `CREATE_NEW_EQUILIBRIUM 1 1`  
CHANGE_STATUS PHASE BCC_A2=ENT 1 |
**Example**  |  **ED_EXP commands**
---|---
| | SET_CONDITION P=101325 N=1 T=298.15  
| | SET_CONDITION X(AL)=0.08  
| | ENTER_SYMBOL FUNCTION LPBCC=((2*VM/6.02214179E23)**(1/3))*1E10;  
| | EXPERIMENT LPBCC=2.90:5%  
**Site-occupancy, degree of inversion for spinel** | | CREATE_NEW_EQUILIBRIUM 1 1  
| | CHANGE_STATUS PHASE SPINEL=ENT 1  
| | SET_CONDITION P=101325 N(MG)=1 N(AL)=2 N(O)=4  
| | SET_CONDITION T=1073  
| | EXPERIMENT Y(SPINEL, AL+3#1)=0.31:5%  

**Magnetism and Other Atomistic Properties**

You can use data about atomistic properties such as magnetism and Curie temperatures in the POP-file.

**Example**

| Example | **ED_EXP commands** |
---|---|
| Curie temperature of Mn_xFe_{3-x}O_4, x=1.26 | CREATE_NEW_EQUILIBRIUM 1 1  
| | CHANGE_STATUS PHASE SPINEL=ENT 1  
| | SET_CONDITION T=520 P=101325 N(O)=4  
| | SET_CONDITION N(FE)+N(MN)=3 N(MN)=1.26  
| | EXPERIMENT TC(SPINEL)=520:5  

**Data About Systems of Different Orders**

You might want to use data about systems of different orders in the same optimization, such as data about a binary equilibrium with components A and B in a ternary system with components A, B and C, together with data about equilibria in the binary system with components A and B. To do this, you must first suspend all components in the ternary system (A, B and C), and then set the two components you want binary information on (A and B) to status ENTERED.

Suspending all components is done by giving the initialization code 0 to the "CREATE_NEW_EQUILIBRIUM" on page 195 command. The components about which you want to use binary
information must then be entered again using the "CHANGE_STATUS" on page 100 command.

**Example**

<table>
<thead>
<tr>
<th>Example</th>
<th>ED_EXP commands</th>
</tr>
</thead>
</table>
| A binary (A-B) three-phase equilibrium (FCC-BCC-LIQ) in a ternary system (A-B-C) | CREATE_NEW_EQUILIBRIUM 1 0  
CHANGE_STATUS COMPONENT A B = ENTERED  
CHANGE_STATUS PHASE FCC BCC LIQ=FIX 1  
SET_CONDITION P=1E5  
EXPERIMENT T=1177:10 |
Thermodynamic Models

The most common models used in assessments are described briefly in these topics. Examples of how to write the phase definitions in the setup-file are also given for each of these models. In addition to the models described here, a large number of thermodynamic models for various phases in different states have been implemented.

In this section:

- Gas ................................................................. 65
- Compound Energy Formalism .................................. 65
- Substitutional Liquid .............................................. 66
- Ionic Two-Sublattice Liquid Model ............................. 66
- Models for Ordered Phases ...................................... 67
- 4SL Model for FCC, HCP and BCC ............................ 68
- 2SL Model for FCC, HCP and BCC ............................ 69
- Magnetic Ordering ................................................. 70
- Molar Volumes and High Pressure ............................ 70
- Excess Models ..................................................... 71
**Gas**

The gaseous mixture phase is usually treated as a substitutional phase without sublattice. In the gaseous mixture phase, there are usually molecules formed, and the number of constituents of the gas phase is often much larger than the number of elements. These complex constituents have to be defined as species. The ideal gas model may handle a gas phase under low pressures (and low temperatures). This implies that the P-V-T relations and thermodynamic properties of pure gaseous species are calculated as for ideal gas, and that there is interaction between gaseous species in the mixture. In a defined system, there may only exist one gaseous mixture phase. Type code G is used for the gas phase:

```
ENTER_PHASE GAS G, 1 H,H1O1,H1O2,H2,H2O1,H2O2,O,O2,O3; N N
```

**Compound Energy Formalism**

If the atoms are sufficiently different in size, electronegativity or charge, they may prefer different types of sites in the lattice of crystalline solids. In some cases, a solute atom may even occupy interstitial sites between the normal lattice sites. All such phenomena are treated in Thermo-Calc by the sublattice concept. The Compound Energy Formalism (CEF) has proved to be the most general formalism for many different types of solution phases. It is therefore by default applied to various solid solution phases in the Thermo-Calc software package. CEF can also take ionic constraints (charged cation/anion species) into account. For a comprehensive description on the CEF, please see Hillert (2001), Frisk and Selleby (2001), Sundman and Ågren (1981).

Since the CEF is used by default, no special notation is needed in the phase definition, except for ionic phases, where type code I is given.
Examples

Examples of phase definitions in a setup-file using the CEF:

```
ENTER_PHASE SPINEL I, 4 1 2 2 4
  FE+2, FE+3; FE+2, FE+3, VA; FE+2, VA; O-2; N N
ENTER_PHASE SIGMA, 3 10 4 16
  AL, CO, CR, FE, NB; AL, CO, CR, FE, NB; AL, CO, CR, FE, NB; N N
ENTER_PHASE FCC_A1, 2 1 1
  CR, FE, MN; C, N, VA; N N
ENTER_PHASE BCC_A2, 2 1 3
  CR, FE, MN, VA; C, N, VA; N N
```

Substitutional Liquid

The liquid phase is normally (but not always) modelled as a substitutional phase with no sublattice, which is occupied by two or more constituents. The constituents are normally the elements, but molecules or associates can also be used. Type code L is used for the liquid phase.

Example

```
ENTER_PHASE LIQUID L, 1
  AL, C, CR, FE, MO, NI, SI; N N
ENTER_PHASE LIQUID L, 1
  C, FE, FEO, FEO3/2, NI, NIO; N N
```

Ionic Two-Sublattice Liquid Model

Within the framework of the CEF, the ionic two-sublattice liquid (I2SL) model was developed to be used when there is a tendency for ionization in the liquid, which happens in liquid oxides and sulphides for example. The same model can be used both for metallic and oxide melts. At low levels of oxygen, the model becomes equivalent to a substitutional solution model between metallic atoms. Two sublattices are assumed, one containing charged cations and one containing charged anions, neutrals and vacancies. The complication for an ionic liquid is that the numbers of sites on the cation sublattice and anion sublattice vary with the composition to preserve electroneutrality. For a comprehensive description on the I2SL model, see Hillert et al. (1985), Sundman (1991). In these references, the possible excess parameters are also discussed. Type code Y is used for the I2SL model.
Example

Examples of phase definitions in a setup-file:

```
ENTER_PHASE LIQUID Y,
   AL+3,Cr+2,Fe+2,Ni+2; VA; N N
ENTER_PHASE IONIC_LIQ Y,
   Ca+2,Mg+2; O-2; N N
ENTER_PHASE IONIC_LIQ Y,
   Al+3,Ca+2,Fe+2,Mg+2, Si+4;
   AlO2-,O-2, SiO4-,VA, FeO3/2, SiO2; N N
```

Models for Ordered Phases

Some solution phases have chemical order-disorder transformations: for example, the disordered FCC_A1 phase can transform to the ordered L1_2 or L1_0 structure where the atoms of different kinds occupy different sublattices. In some cases, it may be advantageous and easy to describe such ordered structures as completely different phases; but in some other cases, like the B2-ordered BCC structure in Al-Fe, the disordered and ordered structures must be described as one single phase because the transformation is of second order along a line in temperature and composition.

The ordering can easily be described by the CEF. For instance, an ordered FCC phase with only L1_2 or L1_0 ordering can be efficiently handled by the so-called Two Substitutional-Sublattice Ordering Model (2SL model), while an ordered FCC with both L1_2 and L1_0 ordering must be described with four sublattices using the so-called Four Substitutional-Sublattice Ordering Model (4SL model). Please note that in both these models, all the substitutional constituents must enter into these sublattices. In addition, you may also have one sublattice for interstitials.

Thermo-Calc supports a feature of splitting the parameters of a chemically ordered phase onto two different phase descriptions. This is very convenient. In this way, you can have one phase for all parameters describing the disordered state (the configuration independent state) and in the other phase only those parameters needed to describe the remaining part (the configuration dependent part), that is, the Gibbs energy contribution due to the ordering transformation. This has been implemented in such a way that the contribution from the configuration dependent part is zero when the solution phase is disordered. The optimization of the disordered phase is independent of the order-disorder transformation; the ordering energy is an add-on to the disordered part. This is particularly useful in higher order systems, as an ordered phase can dissolve several elements that have no particular contribution to the actual ordering. The phases Gibbs energy add together by giving this
command in the setup-file: "AMEND_PHASE_DESCRIPTION" on page 93 <ordered phase> disordered_part <disordered phase>

Since PARROT does not automatically create new composition sets, it is necessary to create composition sets for both the ordered and disordered phases in the setup-file: Amend_phase_description <phase> composition_sets <new highest set number>,

Example

Example of phase definitions for the corresponding disordered and ordered parts in a setup-file:

    ENTER_PHASE FCC_A1, 2 1 1
       AL,CR,FE,NI; VA; N N
    ENTER_PHASE FCC_L12, 3 .75 .25 1
       AL,CR,FE,NI; AL,CR,FE,NI; VA; N N
    AMEND_PHASE_DESCRIPTION FCC_L12 DIS_PART FCC_A1

4SL Model for FCC, HCP and BCC

Ordered FCC, HCP and BCC solution phases handled by the 4SL model requires four sublattices for substitutional ordering and can additionally have an interstitial sublattice. A 4SL model is especially useful for modelling different kinds of ordered phases that are based on the same disordered phase, such as L10 and L12 based on FCC_A1, and B2, D03, L21 and B32 based on BCC_A2 etc.

For ordered FCC or HCP phases, these four substitutional sublattices represent four corners of the regular tetrahedron on these lattices, all of which are the nearest neighbours. These corners are equivalent lattice points, thus all G parameters for each end-member with the same elements, but distributed on different sites, must be identical. It should be emphasized that the end-member energy here represents the ordering energy rather than the formation energy of the compound.

The constraints on the parameters in the 4SL model can be derived based on the symmetry of the lattice:

\[ G_{A:B:B:B} = G_{B:A:B:B} = G_{B:B:A:B} = G_{B:B:B:A} \]
\[ G_{A:A:B:B} = G_{A:B:A:B} = G_{A:B:B:A} = G_{B:B:A:A} \]
\[ G_{B:A:A:A} = G_{A:B:A:A} = G_{A:A:B:A} = G_{A:A:A:B} \]
\[ L_{A,B:*:*:*} = L_{*:A,B:*:*} = L_{*:*:A,B:*} = L_{*:*:*:A,B} \]
The asterisk * means that the interaction parameter is independent of the occupation of that sublattice. For the disordered phase to be completely disordered, i.e. that all site fractions are equal on all four sublattices, all constraints must be correct.

For ordered BCC phases, the situation is a bit more complicated, as the four sublattice ordering phase represents an irregular tetrahedron with two pairs of sites that are next nearest neighbours. Thus, for an A-B binary solution phase, with A located on two sublattice sites and B on the other two, the end-member described by $G_{A:A:B:B}$ has four nearest neighbour bonds between A and B atoms, whereas the end-member described by $G_{A:B:A:B}$ has two nearest neighbour bonds between A and B atoms and two next nearest neighbour bonds. Many parameters thus have a relation:

$$G_{A:B:B:B} = G_{B:A:B:B} = G_{B:B:A:B} = G_{B:B:B:A}$$

Kusoffsky et al. (2001) have shown the influence of different parameters available in the 4SL model applied to fcc ordering. The possibility to use the 4SL model to BCC ordering has been studied by Sundman et al. (2009) in the Al-Fe system.

### 2SL Model for FCC, HCP and BCC

The reason for using a 2SL model instead of a 4SL model is that the calculations are faster, but on the other hand it can only model one kind of ordered phase(s). For instance, it is not possible to model FCC with both L10 and L21, or BCC with D03 and B2, etc.

In order to get the fully disordered phase to form, constraints are needed as for the 4SL model. For the symmetric phases, e.g. B2 and L10, the relation between parameters are:

$$G_{A:B} = G_{B:A}$$

$$L_{A,B:*:*:A,B} = L_{A,B:*:*:B,A}$$
For a 2SL asymmetric model including, but not limited to, L1₂, more constraints are needed. This model has many complicated relations between the parameters. The relation between the parameters for the 2SL L1₂ model can be derived from a 4SL model. The conversion from 4SL model parameters to 2SL parameters for L1₂ can be found in Dupin et al. (2001) and for L1₀ in Yuan et al. (2012). Higher-order systems with an L1₂ phase modelled with two sublattices require a lot of ternary and some quaternary interaction parameters in order to make the disordered state stable. These parameters have been derived by e.g. Dupin (1995), also found in Kusoffsky et al. (2001).

Many publications exist on how to model order/disorder transformations using a two-sublattice model, see e.g. Dupin, Ansara (1999), De Keyzer et al. (2009).

**Magnetic Ordering**

The magnetic contribution to the Gibbs energy is given by a model proposed by Inden (1975) and adapted by Hillert and Jarl (1978), and is described by:

\[ G = RT \ln(b+1)f(t) \]

where \( t = T/T_C \).

The values of the Curie temperature, \( T_C \), and Bohr magneton number, \( b \), at a certain composition are then used in an optimization procedure to calculate the contribution to Gibbs energy due to magnetic ordering. Curie temperature and Bohr magneton number are given in the command "ENTER_PARAMETER" on page 143 for phases that undergo a magnetic transition:

```
AMEND_PHASE_DESCRIPTION BCC_A2 MAGNETIC -1.0 0.4
ENTER_PARAMETER TC(BCC_A2,FE:VA;0) 298.15 +V1; 6000 N
ENTER_PARAMETER BMAGN(BCC_A2,FE:VA;0) 298.15 +V2; 6000 N
```

The arguments -1 and 0.4 specify the values of parameters in the magnetic model: -1 is the antiferromagnetic factor and 0.4 is the structure factor. Usually the antiferromagnetic factor =-1 for bcc and =-3 for fcc (and other non-bcc phases). The structure factor corresponds to the short range order fraction of the enthalpy. This factor is 0.4 for bcc and 0.28 for non-bcc phases.

**Molar Volumes and High Pressure**

Including volumes in a thermodynamic database enable calculations of volume changes, volume fraction, lattice mismatch in cubic structures and phase diagrams at increased pressure. Pressure independent volumes can be used up to about 1 GPa. At pressures above 1 GPa the pressure dependence of the volumes must be included by using a proper equation of state (EOS). An EOS has been developed by Lu et al. (2005), based on the EOS from Jacobs...
and Oonk (2000). Four parameters are used in the implementation of the model in Thermo-Calc:

- **$V_0$:** Volume at 1 bar and at reference temperature $T_0$
- **$V_A$:** Integrated thermal expansivity
- **$V_K$:** Isothermal compressibility at 1 bar
- **$V_C$:** Parameter to fit high pressure data

All parameters can be composition dependent in the same way as all other model parameters in Thermo-Calc. Experimental information about the temperature, pressure and composition dependence of the volume can be assessed using these model parameters. To evaluate $V_0$, $V_A$ and $V_K$ experimental data at 1 bar only are needed.

**Example**

Examples on modelling molar volume in a setup-file:

```plaintext
ENTER_PARAMETER $V_0$(BCC_A2,FE:VA;0) 298.15 +V1; 6000 N
ENTER_PARAMETER $V_A$(BCC_A2,FE:VA;0) 298.15 +V2*T+V3*T**2; 6000 N
ENTER_PARAMETER $V_K$(BCC_A2,FE:VA;0) 298.15 +V6+V7*T; 6000 N
ENTER_PARAMETER $V_0$(FCC_A1,CR,FE:VA;0) 298.15 +V8; 6000 N
ENTER_PARAMETER $V_A$(FCC_A1,CR,FE:VA;0) 298.15 +V9*(T-298.15); 6000 N
```

**Excess Models**

Unless specifically amended, the excess Gibbs energy terms are modelled by the Redlich-Kister-Muggianu Model. Other excess models for the Gibbs energy are also implemented in Thermo-Calc, such as e.g. Kohler and Toop-Kohler extrapolation models.

More information about different excess models can be found in the Thermo-Calc Console Mode example tcex51.

Thermo-Calc is not restricted to binary interaction parameters. Ternary, quaternary and higher-order interaction parameters can also be used if there is enough information to evaluate these from experimental data. The ternary interaction parameters are identified by the degrees of the so-called ternary $L$ parameter (i.e. 0, 1 and 2) in the command "ENTER_PARAMETER" on page 143. If the parameter is composition-independent, you only need a single interaction parameter with a degree of zero, i.e. only the $0L$ term. If there is a
ternary composition-dependent interaction parameter, you must enter all three parameters (0, 1 and 2). If such a ternary interaction parameter should be zero, then assign it a function which is zero. If the three interaction parameters have the same value, then that is identical to having a composition-independent ternary parameter.

**Example**

```
ENTER PARAMETER L( LIQUID, A, B, C; 0 ) 298.15 +1000; 6000 N
ENTER PARAMETER L( LIQUID, A, B, C; 1 ) 298.15 +1000; 6000 N
ENTER PARAMETER L( LIQUID, A, B, C; 2 ) 298.15 +1000; 6000 N
```

is identical to

```
ENTER PARAMETER L( LIQUID, A, B, C; 0 ) 298.15 +1000; 6000 N
```

This also means that

```
ENTER PARAMETER L( LIQUID, A, B, C; 0 ) 298.15 +1000; 6000 N
ENTER PARAMETER L( LIQUID, A, B, C; 1 ) 298.15 +ZERO#; 6000 N
ENTER PARAMETER L( LIQUID, A, B, C; 2 ) 298.15 +ZERO#; 6000 N
```

is NOT identical to

```
ENTER PARAMETER L( LIQUID, A, B, C; 0 ) 298.15 +1000; 6000 N
```
Introduction to the Database Manager Guide

In this section:

- Thermodynamic and Kinetic/Mobility Databases .................................................. 3
- Initialization of the DATA Module ........................................................................... 3
- Initiation Parameter Examples ............................................................................... 4
Thermodynamic and Kinetic/Mobility Databases

This guide describes how to define and construct a thermodynamic or kinetic database. It includes details about the data structures and formats of the Thermo-Calc databases as well as the Diffusion Module (DICTRA) database-extensions.

The Thermo-Calc databases are created and maintained in the Thermo-Calc Database Format (TDB) which is an international standard for the CALPHAD-type thermodynamic calculations and kinetic simulations. This document gives a full description of the TDB format (with the Diffusion Module (DICTRA) database extension) and is a comprehensive guide about how to create and manage a Thermo-Calc (and Diffusion Module (DICTRA)) database.

Usually, a Thermo-Calc or Diffusion Module (DICTRA) database is constructed as a single text file with an extension of TDB, for example, PAQS2setup.TDB. For some databases (especially large databases used with older versions of Thermo-Calc or Diffusion Module (DICTRA)) a database may consist of one primary-definition file (**setup.TDB) and several additional-definition TDB files (such as ***param.TDB, ***funct.TDB, ***refer.TDB, etc. These are built for a variety of defined parameters, functions, references and so forth, and are linked to the **setup.TDB file through the correct use of the "TYPE_DEFINITION " on page 21 and/or "FTP_FILE" on page 24 commands inside the **setup.TDB file.

With Thermo-Calc, Precipitation Module (TC-PRISMA) and Thermo-Calc Software Development Kits (SDKs), you can code everything into a single **setup.TDB file for a database at any scale.

Initialization of the DATA Module

The following explains how a database initiation file (or a database directory file) is constructed to work with the DATA module. When you start, DATA looks for this file that has information about the available predefined databases.

The database initiation file is called:

- ** Windows: TC_INITD.TDB (or TC_INITD)
- ** Linux/UNIX: initd.tdb

You can have your own file, but it is more efficient to define an environment variable with the default name as above, and then during installation, translate it to a common initiation file name. The common file is automatically copied by the Thermo-Calc installation script to the following directories:
- Windows: \DATA\ under the directory defined by the TCPATH parameter
- Linux/UNIX:/data/ under the directory defined by the TC_DATA parameter.

The database manager can find the file on a local computer (independent installations) or a connected server (server installations).

When editing or modifying the definitions of initiation parameters (including short-names, paths and subdirectories, database definition file names, and instructive database descriptions) for the available databases in the database initiation file a specific format is used with the fields:

- The first field gives the abbreviated name for the database (to a maximum of five characters)
- The second field specifies a path and filename (maximum 78 characters) containing the database path definition and the actual database definition (setup) file name, where the extension is either TDB (which stands for original textual TDB file) or TDC (which is encrypted from the original TDB file). There are differences between platforms with respect to entering parameters as listed in the table.
- The third field (maximum 60 characters) details an optional full name (and version/subversion numbers) for the brief database description.

## Initiation Parameter Examples

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Windows</th>
<th>Linux/Unix</th>
</tr>
</thead>
<tbody>
<tr>
<td>The setup file name must consist of a main part and an extension of a maximum of three characters:</td>
<td>For example, SSOL5SETUP.TDB</td>
<td>For example, ssol5setup.tdb</td>
</tr>
<tr>
<td>Database path definition</td>
<td>Use a back-slash \</td>
<td>Use a forward-slash /</td>
</tr>
<tr>
<td>All databases should be normally located in subdirectories that are under the directory defined by the:</td>
<td>TCPATH parameter or under its subdirectory \DATA\</td>
<td>TC_DATA parameter or under its subdirectory /data/</td>
</tr>
</tbody>
</table>
Each entry record (i.e. for a single database) must finish with an exclamation mark !. There should be no spaces or commas within the first and second fields since these characters are taken as field separators, while spaces or commas can be used in the third field.

You can write each database entry on one or two lines (up to the!), it is recommended that the third field is added as follows:

- Windows: on the same line as the first and second fields.
- Linux/UNIX: on the following line.

The following are examples of an initiation file defining two databases named SSOL6 and TCFE8.

**Windows**

<table>
<thead>
<tr>
<th>Database</th>
<th>Path</th>
<th>Description</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>SSOL6</td>
<td>TCPATH\DATA\SSOL6\SSOL6SETUP.TDC</td>
<td>SGTE Solutions Database</td>
<td>6.0</td>
</tr>
<tr>
<td>TCFE8</td>
<td>TCPATH\DATA\TCFE8\TCFE8SETUP.TDC</td>
<td>TCS Steels/Fe-Alloys Database</td>
<td>8.0</td>
</tr>
</tbody>
</table>

**Linux/UNIX**

<table>
<thead>
<tr>
<th>Database</th>
<th>Path</th>
<th>Description</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>SSOL5</td>
<td>TC_DATA/data/ssol5/ssol5setup.tdc</td>
<td>SGTE Solutions Database</td>
<td>5.1</td>
</tr>
<tr>
<td>TCFE8</td>
<td>TC_DATA/data/tcfe8/tcfe8setup.tdc</td>
<td>TCS Steels/Fe-Alloys Database</td>
<td>8.0</td>
</tr>
</tbody>
</table>
# The Database Definition File and Keywords

In this section:

- Database Definition File Syntax .................................................. 8
- ELEMENT .................................................................................. 9
- SPECIES .................................................................................. 10
- PHASE ....................................................................................... 11
- Examples of Recommended Suffixes ............................................ 11
- GIBBS Phase-type Codes ............................................................... 12
- CONSTITUENT ........................................................................... 16
- ADD_CONSTITUENT ................................................................... 17
- COMPOUND_PHASE ................................................................... 18
- ALLOTROPIC_PHASE ................................................................... 18
- TEMPERATURE_LIMITS ................................................................. 19
- DEFINE_SYSTEM_DEFAULT ............................................................. 19
- DEFAULT_COMMAND ................................................................... 20
- DATABASE_INFORMATION ............................................................... 20
- TYPE_DEFINITION ...................................................................... 21
- FTP_FILE ................................................................................... 24
- FUNCTION ................................................................................... 25
- PARAMETER ............................................................................... 28
- GIBBS Parameter Name ................................................................. 29
- OPTIONS ..................................................................................... 34
- TABLE ........................................................................................ 35
- ASSESSED_SYSTEMS .................................................................... 35
- REFERENCE_FILE ....................................................................... 38
- LIST_OF_REFERENCE ................................................................... 40
<table>
<thead>
<tr>
<th>Keyword</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADD_REFERENCE</td>
<td>40</td>
</tr>
<tr>
<td>CASE and ENDCASE</td>
<td>42</td>
</tr>
<tr>
<td>VERSION_DATA</td>
<td>42</td>
</tr>
</tbody>
</table>
Database Definition File Syntax

The database definition (*.TDB) file (normally named ***setup.TDB) consists of a set of keyword codes each followed by one or several parameters (arguments).

- A complete keyword entry must end with an exclamation mark (!).
- A single keyword entry can be up to 2000 characters long. However, the maximum length of a line in an *.TDB file is 78 characters—it may be necessary to continue the keyword parameter (arguments) on several lines. The ! must be at the end of the last line.
- It is recommended to always have at least one empty space at the beginning of each continuation line for the keyword parameters (arguments); otherwise, the DATA module can misunderstand the parameters (or arguments), or issue an error message.
- The keyword and its various parameters (arguments) are separated by a space or a comma.
- A dollar sign ($) in the first position of the line indicates that the line is a comment line, which is ignored by the DATA module.

When the database is selected the DATA module only reads the database definition file (***setup.TDB) once, from beginning to end. The DATA module checks continuously when reading the definition file. This implies that (nearly) everything must be declared or defined before it is used in any other way.

For example, if the GRAPHITE phase is to be included in the database definition, the element C (carbon) and the phase GRAPHITE must be defined before declaring that carbon dissolves in graphite. This definition order is necessary to build the internal data structure acceptable by the DATA module (during its consistency checking).

This topic gives a description of the available keywords and the appropriate arguments. A basic knowledge of the Gibbs Energy System (GIBBS) module is assumed.

This syntax is used:

```
KEYWORD [arg.1]*# [arg.2]*## {optional arg.3}!
```

The keywords are written in full length but can be abbreviated as long as the abbreviation is unique. A keyword may have syntax consisting of several arguments and optional arguments. The number, # or ##, in the notation, [...]# or [...]###, indicates an argument with a maximum length of # ASCII characters.
ELEMENT

ELEMENT [element name]*2 [ref. state]*24 [mass] [H298] [S298] !

The *element name* (maximum two characters) is the one found in the periodic chart but there are no naming restrictions. However, the GIBBS module only recognizes UPPERCASE element names (if the Upper Case Mode is selected by the GIBBS command "REINITIATE" on page 127), which means that lower-case (if defined in a database) is automatically converted to UPPERCASE by the DATA/GIBBS module.

The elements are automatically entered as species using the same names of the elements. If, for example, the species corresponding to FE needs to be named FE1, you can define the species as FE1, which results in an element named FE and a species named FE1. Vacancies (VA) and electrons (denoted either as /- in gaseous, liquid or solid phases, or ZE in an aqueous solution phase), need to be entered as special elements for correct handling by the DATA module.

The *reference (ref.) state* (maximum 24 characters) is the stable phase (at 298.15 K and 1 bar) that should contain this element and be used as the reference state for all element thermodynamic data. The *mass*, given in gram per mole, is used in various calculation programs and should always be given the correct value. *H298* and *S298* denote the enthalpy and entropy difference between 0 and 298.15 K for the element in SI units. If these are unknown, the values can be set to zero. All this information (reference state, H298 and S298) define the SER (Stable Element Reference state).

**Examples**

```
ELEMENT /- ELECTRON_GAS 0.0 0.0 0.0 !
ELEMENT VA VACUUM 0.0 0.0 0.0 !
ELEMENT ZE UNIT_CHARGE 0.0000000001 0.0 0.0 !
ELEMENT AL FCC_A1 26.98154 4577.296 28.3215 !
ELEMENT C GRAPHITE 12.011 1054.0 5.74 !
ELEMENT FE BCC_A2 55.847 4489 27.28 !
ELEMENT O 1/2_MOLE_O2(G) 15.9994 4341 102.5158 !
ELEMENT TI HCP_A3 47.88 4810 30.648 !
```
ELEMENT ZR HCP_A3 91.224 5566.27 39.181 !
ELEMENT ZY DUMMY 1 1 1 !

### SPECIES

**SPECIES [species name] *24 [stoichiometric formula] !**

This keyword defines species in the data structure. Every *species name* (maximum 24 characters) must be unique. The species are built from the predefined set of elements in the stoichiometric formula. If an undefined element is referenced, DATA displays an error message and the data structure is probably damaged.

The species names do not have to be the same as the stoichiometry formula, although in general this is recommended. The elements are automatically entered as species using the same names of the elements.

You can define a species name as a mixture of UPPER-case and lower-case letters in a database, but the DATA module automatically converts all lower-case to UPPER-case because the GIBBS module only recognizes UPPER-case species names.

When naming the species in a database, use special characters (such as +, -, _, / and .) in species names. Avoid using other special characters (such as ( and )).

The **stoichiometric formula** is written with a simplified chemical notation, in which the chemical elements should always be given in UPPER-case and in any preferred order, and the stoichiometric coefficients are written in either real numerical factors or integer digits.

It is important that the numerical factor of 1 is not left out. Subgroups are not allowed in a stoichiometry formula; however, while specifying the stoichiometry formula for a specific species in a database, you can specify it in a way that some elements (always together with the corresponding partial stoichiometric coefficients) are repeated (as in the examples below).

**Examples**

SPECIES AL2O3 AL2O3 !
SPECIES Silica SI1O2 !
SPECIES NaSb_6OH NA1SB1O6H6 !
SPECIES FE+2 FE/+2 !
Species SB-3 SB/-3!
Species AlCl2/3 Al.33333CL.666667!
Species AlCl1H2O2 Al1CL1H2O2!
Species AlC13_3H2O Al1CL3H6O3!
Species AlO2H2Cl.H6O3 Al1O2H2CL1H6O3!
Species AlCl2-OH.3H2O Al1CL2O1H1H6O3!
Species AlCl2OH.3Water Al1O1H1CL2H6O3!

**PHASE**

```
PHASE [phase name]*24 [data-type code]*8 [numb. subl.] [sites in subl. 1] [sites in subl. 2] etc... [auxiliary text string]!
```

This keyword defines a phase and its properties (except for what species are allowed to enter it and for its parameters).

The *phase name* (maximum 24 characters) must be unique; otherwise the DATA module sees it as an attempt to redefine a previously defined phase. This causes DATA to display an error message and ignore the rest of the line. A phase name can be suffixed by an underscore (_ and letters to identify the physical state(s) or structure type(s) of the phase.

**Examples of Recommended Suffixes**

<table>
<thead>
<tr>
<th>Suffix</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABC_S</td>
<td>The ABC phase in solid state.</td>
</tr>
<tr>
<td>ABC_S2</td>
<td>The ABC phase in solid state 2.</td>
</tr>
<tr>
<td>ABC_S3</td>
<td>The ABC phase in solid state 3.</td>
</tr>
<tr>
<td>ABC_LT</td>
<td>The ABC phase in solid state at low temperatures.</td>
</tr>
<tr>
<td>ABC_HT</td>
<td>The ABC phase in solid state at high temperatures.</td>
</tr>
<tr>
<td>ABC_L</td>
<td>The ABC phase in liquid state.</td>
</tr>
<tr>
<td>ABC_LIQ</td>
<td>The ABC phase in liquid state.</td>
</tr>
<tr>
<td>FCC_A1</td>
<td>The FCC phase in disordered structure type A1.</td>
</tr>
<tr>
<td>FCC_L12</td>
<td>The FCC phase in ordered structure type L12.</td>
</tr>
</tbody>
</table>

The *phase name* can also be attached with a colon sign (:) and a letter for a legal GIBBS phase-type code (e.g. IONIC_LIQ:Y and GAS:G).
## GIBBS Phase-type Codes

<table>
<thead>
<tr>
<th>Code</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>G</td>
<td>Bit set for a gaseous mixture phase.</td>
</tr>
<tr>
<td>A</td>
<td>Bit set for an aqueous solution phase.</td>
</tr>
<tr>
<td>Y</td>
<td>Bit set for an ionic liquid solution phase (specially treated by the Ionic Two-Sublattice Liquid Model).</td>
</tr>
<tr>
<td>L</td>
<td>Bit set for a liquid solution phase (but not A (aqueous) or Y (ionic liquid)).</td>
</tr>
<tr>
<td>I</td>
<td>Bit set for a phase with charged species (but not G (gaseous), A (aqueous) or Y (ionic liquid)).</td>
</tr>
<tr>
<td>F</td>
<td>Bit set for an ordered FCC or HCP solution phase using the <em>Four Substitutional-Sublattice Ordering Model</em> (additionally, such a phase can also have interstitial sublattices).</td>
</tr>
<tr>
<td>B</td>
<td>Bit set for an ordered BCC solution phase using the <em>Four Substitutional-Sublattice Ordering Model</em> (additionally, such a phase can also have interstitial sublattices).</td>
</tr>
</tbody>
</table>

Other invalid characters (e.g. M or P) are eventually treated, together with the colon (:) as a part of a phase name.

A G phase (gaseous mixture) or an A phase (aqueous solution) is usually treated as a substitutional phase without sublattice, and an L phase (ordinary liquid solution) is normally (but not always) modelled as a substitutional phase without sublattice, too.

For ordered FCC or HCP phases, these four substitutional sublattices represent four corners of the regular tetrahedron on these lattices, all of which are the nearest neighbours, as shown.

### FCC Unit Cell Example

An FCC unit cell with the lattice positions indicated that correspond to the G (FCC,A:B:C:D) end member. All lattice positions are equivalent for a four substitutional-sublattice ordering model.
A Normal 4-Sublattice Model requires that all the G parameters for each of the end-members with the same elements but distributed on different sites be given separately. However, as these corners are identical lattice points, the phase-type option F means that the G parameters need be given only once. The possible permutations are handled automatically.

Additional clarification

An A-B binary solution phase (with the element A located on one sublattice site and B on the other three sublattice sites) treated by the Normal 4-Sublattice Model has to have four G parameters for four end-members, i.e.

- G(phase,A:B:B:B)
- G(phase,B:A:B:B)
- G(phase,B:B:A:B, and
- G(phase,B:B:B:A)

This is because in the general case these G parameters can be different from each other. But for the FCC and HCP orderings, they are identical and thus all G parameters of such end-members need to be given only once, and the possible permutations are then automatically handled by the GIBBS module. Also, only one of the identical permutations is listed; in this example, G(phase,A:B:B:B) where it is alphabetically the first in the list of permutations. This significantly simplifies the usage of this model (Four Substitutional-Sublattice Ordering Model) in multicomponent alloys.
For ordered BCC phases, the phase-type option \( B \) means the same thing but it is more complicated since the 4-substitutional-sublattice ordering phase represents an irregular tetrahedron with two pairs of sites that are next nearest neighbours as shown:

**BCC Unit Cell Example**

Two BCC unit cells with the lattice positions indicated that correspond to the \( G(BCC,A:B:C:D,0) \) end member. Lattice positions \( (A) \) and \( (B) \) are equivalent, as are lattice positions \( (C) \) and \( (B) \) for a four substitutional-sublattice ordering model.

For an end member described by the parameter \( G(\text{phase},A:A:B:B) \) \( A \) and \( B \) are next nearest neighbours, as are \( C \) and \( D \). And the nearest neighbours of \( A \) (or \( B \)) are \( C \) and \( D \). Thus, for an \( A-B \) binary solution phase (with the element \( A \) located on two sublattice sites and \( B \) on two sublattice sites) treated by the Normal 4-Sublattice Model, the end-member described by the \( G(\text{phase},A:A:B:B) \) term has four nearest neighbour bonds between \( A \) and \( B \) atoms, whereas the end-member described by the \( G(\text{phase},A:B:A:B) \) term has two nearest neighbour bonds between \( A \) and \( B \) atoms and three next nearest neighbour bonds.

The first end-member (described by the \( G(\text{phase},A:A:B:B) \) term) represents \( B2 \)-ordering and the second (described by the \( G(\text{phase},A:B:A:B) \) term) stands for \( B32 \)-ordering. There are two permutations of the \( G(\text{phase},A:A:B:B) \) term and four permutations of the \( G(\text{phase},A:B:A:B) \) term, automatically conducted in the *Four Substitutional-Sublattice Ordering Model*. If you enter the unary, binary, ternary and quaternary parameters you are dealing with 1, 6, 21, 55 parameters for BCC:B, 1, 5, 15, 35 parameters for FCC:F and 1, 16, 81, 256 parameters for phases without F/B.

An additional feature with the phase-type options \( F \) and \( B \) is that a composition set that represents the solution phase has a suffix (indicating what ordering the phase has) that is automatically added to its phase name in some listings of equilibrium calculations (when
performing either single-point or stepping or mapping calculations, and when plotting the calculated property diagrams or phase diagrams).

Such suffix indications can be:

<table>
<thead>
<tr>
<th>Solution Phase</th>
<th>Suffix for Disordered Phase</th>
<th>Suffix for Ordered Phase</th>
</tr>
</thead>
<tbody>
<tr>
<td>FCC PHASE</td>
<td>FCC_A1</td>
<td>FCC_L12</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FCC_L10</td>
</tr>
<tr>
<td></td>
<td></td>
<td>BCC_B2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>BCC_B32</td>
</tr>
<tr>
<td></td>
<td></td>
<td>BCC_D03</td>
</tr>
<tr>
<td></td>
<td></td>
<td>BCC_L21</td>
</tr>
<tr>
<td>BCC PHASE</td>
<td>BCC_A2</td>
<td>HCP_D019</td>
</tr>
<tr>
<td>HCP PHASE</td>
<td>HCP_A3</td>
<td>HCP_B19</td>
</tr>
</tbody>
</table>

If you want to convert an existing database TDB-file to use the F/B feature, add the phase-type code to the corresponding phase name in the PHASE and CONSTITUENT commands in the TDB-file, then when running the LIST_DATA command in the GES module. The created database file is in this less verbose format.

The data-type code consists of 1 to 8 characters where each character must stand for an action, which is to be coupled to this phase. The keyword "TYPE_DEFINITION" on page 21, described below, must be used in the current database to specify what action should be taken by DATA for each character code.

The data entries [numb. subl.] [sites in subl. 1] [sites in subl. 2] etc., specify the total number of sublattices (always as an integer digit) and the sites (i.e. stoichiometric coefficients) of each of the sublattices (given in either integer digits or real numerical factors) for the phase.

Optionally, an auxiliary text string (maximum 78 characters) can be given after the last [sites in sublattice #] but before the exclamation mark !. This string displays in connection with the phase name in some listings within the DATA module.

**Examples**

```
PHASE GAS:G % 1 1.0 !
```
PHASE LIQUID:L %ZCDQ 2 1.0 1.0
> Metallic liquid solution, modelled by CEF Model.

PHASE IONIC-LIQ:Y %ZCDQ 2 1.0 1.0
> Ionic liquid solution, modelled by Ionic Two-Sublattice Model.

PHASE SPINEL:I %ZA 4 1 2 2 4
> Complex Spinel Solution, by CEF model with ionic constraints.

PHASE M23C6 % 3 20.0 3.0 6.0

PHASE FCC_A1 %&A 2 1 1
> Disordered FCC phase; also as MX carbides/nitrides.

PHASE FCC_L10 %&AX 3 0.75 0.25 1
> Ordered FCC phase, modelled by 2-Sublattice Model for Ordering.

PHASE FCC_L12:F %&AX 5 0.25 0.25 0.25 0.25 1.0
> Ordered FCC phase, modelled by 4-Sublattice Model for Ordering.

PHASE AQUEOUS:A %HIJMR 1 1.0
> Aqueous Solution: using the Complete Revised HKF Model.

**CONSTITUENT**

CONSTITUENT [phase name]*24 [constituent description]*2000

This keyword (and the "ADD_CONSTITUENT" on the next page keyword for large solution phase) defines the phase-constitution as a list of constituents (for a substitutional phase with no sublattice) or of constituent arrays (for a sublattice phase).

The *phase name* (maximum 24 characters) must be a predefined phase (i.e. already through the "PHASE" on page 11 keyword).

It is important that if a phase bears a legal phase-type (among G, A, Y, L, I, F and B) in its phase definition (already by the PHASE keyword; such as GAS:G, SLAG:L, LIQUID:L, IONIC_LIQ:Y, SPINEL:I, FCC_L12:F, HCP_D021:F, BCC_B2:B, AQUEOUS:A), such a valid phase-type code must also always be attached to the phase name in the CONSTITUENT keyword (and the ADD_CONSTITUENT keyword).
Specifying the phase name in UPPER-case is recommended. You can define a phase name as a mixture of UPPER-case and lower-case letters in a database, but the DATA module automatically converts all lower-case to UPPER-case because the GIBBS module only recognizes UPPER-case phase names.

The *constituent description* (maximum 2000 characters) is a list of the species that enter a phase. The list starts with a colon (:) indicating the start of the sub-list of species for the first sublattice, and different sublattices are separated by colons. The complete sequence ends with a final colon.

Optionally, each sublattice may specify which species are considered to be major constituents. This is done by adding a percent sign (%) directly to the species name. The start values on the site fractions of the major constituents should sum to 0.99 on a specific sublattice. Thus, the minor constituents (i.e. those without a %) add up to 0.01. A maximum of 2000 characters can be coded in the constituent description, continuing in sequent lines. If the phase has a constituent description longer than 2000 characters, the rest can be coded in one or several ADD_CONSTITUENT keywords.

**Examples**

```
CONSTITUENT BCC_A2 :FE
CONSTITUENT IONIC-LIQ:Y :FE+2 : SB-3: !
CONSTITUENT M23C6 :CR FE :FE CR W MO : C: !
CONSTITUENT AQUEOUS:A :H2O% AG+1 AGF AGCL AGCL2-1 AGI3-2 AGSO4-1
AGC2H4+1
    AGN2H6+1 AGC2N2-1 AGC2H4NO2 AL+3 ALF3 AL02-1, ... : !
CONSTITUENT SPINEL:I : AL+3% CR+3 FE+2% FE+3 MG+2% NI+2
    ; AL+3% CA+2 CR+3 FE+2 FE+3 MG+2% NI+2 VA
    : FE+2 MG+2 VA%
    : N-3 O-2% :!
```

**ADD_CONSTITUENT**

```
ADD_CONSTITUENT [phase name]*24 [constituent description]*2000 !
```

This keyword adds more constituents to a phase that already has some constituents. Its syntax is the same as for the "CONSTITUENT" on the previous page keyword. This keyword can be used several times, if the phase is very large, e.g. a gaseous mixture or a complex aqueous solution. This is useful when there are so many constituents in a phase that the 2000 characters available for the constituent description list is not enough.

Constituents are not necessary on all sublattices. In the second example below, no addition is made to the first sublattice.
Examples

ADD_CONSTITUENT GAS :S1 S2 S3 ... : !
ADD_CONSTITUENT IM-PHASE : :CR:W ... : !
ADD_CONSTITUENT AQUEOUS:A :CUCL+1 CUCL2 CUCL2-1 CUCL3-2 CUOH+1
CUO2H2 CUO3H3-1
CUO4H4-2 CU2OH+3 CU2O2H2+2 CU3O4H4+2 NI02H2 NI03H3-1 NI04H4-2
NI2OH+3
NI4O4H4+4 ZNOH+1 ZNO2H2 ZNO3H3-1 ZNO4H4-2 ... : !

COMPOND_PHASE

The keyword is a compact way to simultaneously define a species, a compound phase (maximum 24 characters) and its phase-constituent. It is useful for stoichiometric phases with constant compositions. The species name and stoichiometric formula must be identical, i.e. being the given constituent. The phase has this species as its only constituent. This keyword allows the database definition file for a large substance database to be more compact; it is a combination of the "SPECIES" on page 10, "PHASE" on page 11 and "CONSTITUENT" on page 16 keywords.

Examples

COMPOND_PHASE AL2O3 % AL2O3 !
COMPOND_PHASE MAGNETITE %MF FE3O4 !
COMPOND_PHASE QUARTZ % SIO2 !

ALLOTROPIC_PHASE

The keyword does the same as the "COMPOND_PHASE" above keyword for entering an allotropic phase (maximum 24 characters), but does not enter the constituent as a species to the data structure. Use this if the species is already defined.
Examples

ALLOTROPIC_PHASE BETHA-AL2O3 % AL2O3 !
ALLOTROPIC_PHASE CRISTOBALITE % SIO2 !
ALLOTROPIC_PHASE TRIDYMITE % SIO2 !

TEMPERATURE_LIMITS

TEMPERATURE_LIMITS [lower limit] [upper limit] !

This keyword sets the default upper and lower temperature limits used by the GIBBS module for Gibbs energy parameters and functions. It can be used only once in one database definition file and all its sequential files.

Example

TEMPERATURE_LIMITS 500.0 1800.0 !

DEFINE_SYSTEM_DEFAULT

DEFINE_SYSTEM_DEFAULT [keyword] {G-ref. type index} !

This keyword sets the default value to ELEMENT or SPECIES in the DATA command "DEFINE_SYSTEM" on page 15 in the Thermo-Calc Console Mode Command Reference.

For a substance database, it can be appropriate to have ELEMENT as a default value whereas a large solution database can benefit from having SPECIES as a default value. A proper default value is useful for beginners. An advanced user is more likely to use the DATA commands DEFINE_ELEMENT and DEFINE_SPECIES to override the default value.

{G-ref. type index} is an integer indicating the reference state type for an element when entering and listing data in the GIBBS module. The following lists legal numbers and the corresponding meaning (the reference state type for an element):

<table>
<thead>
<tr>
<th>Number</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>symbol: G</td>
</tr>
<tr>
<td>2</td>
<td>symbol: H298</td>
</tr>
<tr>
<td>3</td>
<td>symbol: H0</td>
</tr>
</tbody>
</table>
Example

DEFINE_SYSTEM_DEFAULT element 2 !

DEFAULT_COMMAND

DEFAULT_COMMAND [secondary keyword and parameters] !

This keyword specifies commands to be executed by the DATA module at database initialization. The syntax of the available command is currently not the same as the user available DATA commands but the actions are similar. The available secondary keyword and parameters in syntax are:

- DEFINE_SYSTEM_ELEMENT [element names]
- DEFINE_SYSTEM_SPECIES [species names]
- DEFINE_SYSTEM_CONSTITUENT [phase] [sublattice] [species]
- REJECT_SYSTEM_ELEMENT [element names]
- REJECT_SYSTEM_SPECIES [species names]
- REJECT_SYSTEM_CONSTITUENT [phase] [sublattice] [species]
- REJECT_PHASE [phase names]
- RESTORE_PHASE [phase names]

Examples

DEFAULT_COMMAND DEFINE_SYSTEM_ELEMENT FE VA !
DEFAULT_COMMAND REJECT_SYSTEM_CONSTITUENT LIQUID 2 C !
DEFAULT_COMMAND REJECT_PHASE LIQUID !
DEFAULT_COMMAND RESTOR_PHASE GAS !

DATABASE_INFORMATION

DATABASE_INFORMATION [text]*10000 !

This keyword defines a text for the detailed description of the current database. The text can be listed with the DATA command DATABASE_INFORMATION. An apostrophe (') can be used in the text to indicate a new line; and two apostrophes, ('' ) can be used in the text to indicate a new line plus an empty line.

⚠️ The continuous text length (each line with max 78 characters) is 10,000 characters.
Example

DATABASE_INFORMATION This is the XXX-Alloy Solution Database 'in the A-B-C-D-...... System. '
Developed by TCS, released in May 2001. ''
... more ... !

**TYPE_DEFINITION**

**TYPE_DEFINITION** [data-type code]*1 [secondary keyword with parameters] !

This keyword couples phases to an action performed by the DATA module when the DATA command "GET_DATA" on page 16 is executed.

**Secondary Keywords**

The secondary keywords and associated parameters in syntax are:

- SEQ [filename]
- RND# [filename]
- GES [valid GIBBS command with parameters]
- POLY3 [valid POLY command with parameters]
- TDB [valid DATA command with parameters]
- IF [conditional statement] THEN [keyword with parameters]
- AFTER [valid GIBBS command with parameters]

The secondary keyword **SEQ** specifies a sequential file that stores parameters belonging to the phases using the associated data type code (which is defined by this keyword). A special case where the filename is given as an asterisk (*) implies that the database definition file also acts as a sequential data storage file. This case makes it possible to have a single file for a small database, which is especially suited for personal databases.

The secondary keyword **RND** should be concatenated with a positive integer # to indicate the type of the random file. Currently, there are these types of random files:

- **RND0**, the default, is used for complete Gibbs energy expressions (G0 parameters), where the search field is the unabbreviated parameter name.

- **RND1** is designated for functions, where the function name is used as the search field.
- **RND2** is reserved for binary interaction parameters, where its search field is also the unabbreviated parameter name without any interaction order notation.

Ternary and higher order interaction parameters must be specified on a sequential file. Moreover, the internal structures of these random files are subject to changes with different versions of DATA, and with implementations of DATA on various computer systems. For more information, see the FORTRAN program TDBSORT, which is available from Thermo-Calc Software AB.

The secondary keywords **GES**, **POLY3**, or **TDB** specifies a modification of, or addition to, phases having the associated data type code, such as magnetic contribution, another excess model, or any other valid GIBBS/POLY/DATA command that applies to a certain phase. By implementing this as a call to the interactive GIBBS/POLY/DATA module, flexibility is achieved. If a new type of addition is implemented in a GIBBS/POLY/DATA module, it can be immediately used in the database definition file without reprogramming the DATA module.

In several examples below, the use of the at (@) sign indicates any phase to which the relevant type definition (e.g. A, B, 4, or E) applies.

The secondary keywords **IF** and **THEN** allow specification of a conditional statement structured with respect to the phase constitution that controls the execution of a following type-definition (keyword with parameters) string. See the last four examples.

The secondary keyword **AFTER** is similar to the **GES** keyword except the defined GIBBS command is executed after all parameters are entered. The reason for this is that the command has no effect unless there is a parameter. Following the **AFTER** keyword, a GIBBS command must be given and it is executed after entering the parameters of the phase.

The data-type code (always as one string) can be any normal or special character, e.g. 0, 5, A, F, M, %, &, and so forth, and is referred in the definition keywords "**PHASE** on page 11", "**COMPOUND_PHASE** on page 18" and "**ALLOTROPIC_PHASE** on page 18" for various phases.

A phase can have several ADDITIONAL parts of different types (that are enforced by certain TYPE_DEFINITIONS which call the GIBBS command AMEND_PHASE_DESCRIPTION for describing various contributions to Gibbs energy). However, the DATA/GIBBS module automatically deletes any early-defined ADDITIONAL part(s) of the same type.

The DATA module can selectively retrieve functions that are necessary for a defined system from a database that has functions stored in its setup file or SEQ sequential function file, while all other functions irrelevant for the defined system are ignored and are not saved in associated GIBBS and POLY workspaces.

**Examples**

```plaintext
TYPE_DEF % SEQ TCPATH\DATA\[DATABASE]\PARAMETERS.TDB !
```
```
TYPE_DEF I SEQ TCPATH\DATA\[DATABASE]\INTERACTION-PARAMS.TDB !
TYPE_DEF G RND0 TCPATH\DATA\[DATABASE]\GZERO-PARAMS.TDB !
TYPE_DEF F RND1 TCPATH\DATA\[DATABASE]\FUNCTIONS.TDB !
TYPE_DEF & RND2 TCPATH\DATA\[DATABASE]\BINARY-INTERACTIONS.TDB !
TYPE_DEF A GES AM_PH_DES @ MAGNETIC -1 0.40 !
TYPE_DEF B GES AM_PH_DES @ MAGNETIC -3 0.28 !
TYPE_DEF 4 GES AM_PH_DES @ EXCESS_MODEL REDLICH-KISTER_KOHLER !
TYPE_DEF 5 GES AM_PH_DES AQUEOUS EXCESS_MODEL HKF !
TYPE_DEF 6 GES AM_PH_DES AQUEOUS HKF_ELECTROSTATIC !
TYPE_DEF 7 GES AM_PH_DES AQUEOUS STATUS 02084000,,! !
TYPE_DEF 8 GES AM_PH_DES AQUEOUS MAJOR_CONST 1 H2O !
TYPE_DEF E AFTER AM_PH_DES LIQUID EXCESS MIXED-EXCESS
   A B LEGENDRE C A POLYNOM ,,!,
TYPE_DEF T AFTER AM_PH_DES LIQUID TERN-EXT TOOP-KOHLER B A C,,!,
TYPE_DEF Q AFTER AM_PH_DES LIQUID TERN-EXT KOHLER FE CR NI !
TYPE_DEF C IF (PD AND PT AND SN) THEN TDB RESTORE_PHASE BCT_A5 !
TYPE_DEF D IF (PD AND (PT OR SN)) THEN TDB REJECT_PHASE BCC_A2 !
TYPE_DEF E IF ((NB OR TI OR V) AND (C OR N)) THEN
   GES AM_PH_DES @ COMP_SET ,, CR NB TI V: C N: !
TYPE_DEF F IF (ALO3/2 OR CRO3/2 OR FEO OR MNO OR SIO2) THEN
   GES AM_PH_DES LIQUID COMP_SET ,, ALN%,ALO3/2%,CRO3/2%,
   FEO%,FEO3/2,MNO3/2%,MNS%,SIO2%,TIO2% : !
TYPE_DEF R GES AM_PH_DES FE LIQUID FRACTION_LIMITS Fe 0 0.6
   Ag 0 0.01 A1 0 0.05 Ca 0 0.05 Co 0 0.01 Cr 0 0.01
   Cu 0 0.02 Mg 0 0.05 Mn 0 0.05 Mo 0 0.05 Nb 0 0.05
   Ni 0 0.05 Pb 0 0.05 Si 0 0.10 Sn 0 0.02 Ti 0 0.05
   U 0 0.01 V 0 0.02 W 0 0.02 Zr 0 0.03
   B 0 0.01 C 0 0.01 H 0 0.01 N 0 0.01 O 0 0.01
   P 0 0.01 S 0 0.01 !
```
Ordered Phase Restores Disorder Contribution

When an ordered phase with disordered contribution is restored, the disordered contribution is automatically restored as well. You can also restore the disordered phase \textit{without} restoring the ordered phase.

However the DIS\_PART TYPE\_DEFINITION must always be set on the ordered phase. It is important that the disordered phase is declared \textit{before} the ordered phase. Otherwise it causes an error when DIS\_PART TYPE\_DEFINITION is executed and then either the ordered or disordered phase is rejected.

Example

\begin{verbatim}
TYPE\_DEFINITION & GES A\_P\_D FCC\_A1 MAGNETIC -3.0 2.80000E-01 !
PHASE FCC\_A1 %& 2 1 1 !
    CONSTITUENT FCC\_A1 :CR,NI% : C%,VA : !
$ THIS \ PHASE \ HAS \ A \ DISORDERED \ CONTRIBUTION \ FROM \ FCC\_A1
TYPE\_DEFINITION ' GES AMEND\_PHASE\_DESCRIPTION FCC\_L12 DIS\_PART
FCC\_A1,,,!
TYPE\_DEFINITION ( GES A\_P\_D FCC\_L12 MAGNETIC -3.0 2.80000E-01 !
PHASE FCC\_L12 %'( 3 .75 .25 1 !
    CONSTITUENT FCC\_L12 :CR,NI% : CR,NI% : C,VA% : !
\end{verbatim}

For example a GES command such as the following only affects phases defined above or at the phase with this TYPE\_DEFINITION in the TDB file:

\begin{verbatim}
TYPE\_DEFINITION ( GES A\_P\_D FCC\_L12 DIS\_PART FCC\_A1,,, !
\end{verbatim}

For example a TDB command such as the following only affects phases defined \textit{below} the phase with this TYPE\_DEFINITION in the TDB file:

\begin{verbatim}
TYPE\_DEFINITION ( TDB RESTORE\_PHASE FCC\_A1 !
\end{verbatim}

\textbf{FTP\_FILE}

\begin{verbatim}
FTP\_FILE [filename] !
\end{verbatim}

FTP\_FILE is a special function random file and the function names correspond to the record numbers where these record names and the functions are stored. The FTP\_FILE decreases search time for the associated database in the DATA module. The file is used for large
substance databases along with a SEQ sequential or RND0 random file for storage of G0 parameters referring the functions named FxxtT that are stored in the FTP file. The integer number xxxx is a search code used by DATA when such files are processed.

No modification of this file type is allowed.

Example

FTP_FILE TCPPATH\DATA\[DATABASE]\FTP-FILE.DATA !

FUNCTION

FUNCTION [function name]*8 [lowest temp. limit]
[expression 2]; [upper temp. limit 2] Y
[expression 1]; [upper temp. limit 1] Y
[expression 3]; [upper temp. limit 2] Y
........ ; ..... Y
[expression n-1]; [upper temp. limit n-1] Y
[expression n]; [upper temp. limit n] N {Ref. Index} !

GIBBS can use predefined functions in the expression (TP-Function) of a Gibbs energy parameter or in other functions. This is often used when several parameters (or functions) have a common sub-expression, such as for metastable modifications of elements. This keyword can appear in both files for database definition and sequential storage, but not in FTP files. A valid function name can have up to 8 characters.

A function always starts with a lowest temperature limit of its applicability, followed by one or more (up to 10) expressions (TP-Functions) that are coded as mathematical relations of constants, functions of stable variables (T and P) and other entered functions (normally with a # suffix, e.g. +3*GHSERAL#).

Also see the "ENTER_PARAMETER" on page 143 in the Thermo-Calc Console Mode Command Reference.

The expression is a FORTRAN-like expression and operators +, -, *, = and ** can be used (** only with integer powers). Unary-functions LN or LOG (both for natural logarithm) and EXP (for exponential) can also be used. Each expression (TP-Function) should end with a semicolon (;), and be followed by its upper applicable temperature limit and a continuation indicator (Y to continue with the next expression or N to end the function’s expression). If there is no continuation after a specific expression (TP-Function), the reference index can optionally be given after the N indicator.
A complete/valid function entry can be written in several continuation lines if the function’s expression (TP-Function) is too long or if there is more than one applicable expression (TP-Function), as the maximum length of each line is 78 characters.

It is recommended to always have at least one empty space at the beginning of each continuation line. Otherwise, the DATA module may misunderstand the expression or issue some error messages when reading the function entry. Avoid entering functions like the one below.

```
FUNCTION GHSERXY 298.15
-1000+1058*T-38.9*T*LOG(T)+GFUNXY#; 6000 N !
```

Such a function is read by the DATA module as

```
1000+1058*T-38.9*T*LOG(T)+GFUNXY#
```

rather than

```
-1000+1058*T-38.9*T*LOG(T)+GFUNXY#
```

This is because the DATA module concatenates all lines and removes extra spaces before trying to enter the function in the GIBBS workspace. Thus, the – sign is taken as a delimiter between 298.15 and 1000, and the function incorrectly becomes:

```
FUNCTION GHSERXY 298.15 1000+1058*T-38.9*T*LOG(T)+GFUNXY#; 6000 N !
```

Avoid this mistake by giving at least one empty space as the first character of a new line, such as

```
FUNCTION GHSERXY 298.15
-1000+1058*T-38.9*T*LOG(T)+GFUNXY#; 6000 N !
```

which is read correctly as

```
FUNCTION GHSERXY 298.15 -1000+1058*T-38.9*T*LOG(T)+GFUNXY#; 6000 N !
```

The lowest-temperature limit (in Kelvin) for the applicability of the (first) TP-Function in a function is normally set by default as 298.15 K, in most cases. However, you can set another limit when it is applicable (according to experimental data and assessments).

An upper-temperature limit (in Kelvin; followed by a Y or N sign) for the applicability of each TP-Function in a function must be given after the semicolon (;) immediately following the specific TP-Function. The highest-temperature limit (in Kelvin) for the applicability of the current function is always followed by the N sign. If a negative number is given as the lowest-
temperature limit, it assumes there are breakpoints in pressure for this function. In these cases, it is interpreted as the lowest-pressure limit (in Pascal), and the other limits in the current function is also taken as pressure limit values (in Pascal).

The temperature/pressure limits for the functions are checked during calculations. An indicator is set if the actual temperature/pressure condition is below the lowest temperature/pressure limit or above the highest temperature/pressure limit. In these cases, an extrapolation is done using the TP-Function valid in the nearest temperature/pressure range.

The optional reference index \{Ref. Index\} is an integer number indicating where to find the particular function in a special reference file. The references are listed when doing the GET_DATA command in the DATA module. They can also be listed in the GIBBS module with the command LIST_DATA with the option R.

\[ \text{For accounting for the reference indices, also see the keyword "REFERENCE_FILE" on page 38.} \]

The reference index field can also be an abbreviation (such as REF:250, REF_002, or REF-SGTE) which denotes the original reference. In this case, the reference cannot be obtained when issuing the DATA command GET_DATA or the GIBBS command LIST_DATA (with the option R).

However, the references directly coded in the database definition file (**setup.TDB)** starting with a letter can be shown when issuing the DATA command GET_DATA or the GIBBS command LIST_DATA (with the option N or R). Normally, such references must be located after the LIST_OF_REFERENCE keyword. It is recommended to use reference code names such as REF001, REF018, etc. The reference list, which is generated by the GIBBS command "LIST_DATA" on page 120 <file> with the N or R option, is also possible to be directly read by the DATA module.

The DATA module can selectively retrieve functions which are necessary for a defined system from a database that has functions stored in its setup file or SEQ sequential function file, while all other functions irrelevant for the defined system are ignored and are not saved in associated GIBBS and POLY workspaces. Previously, this can only be done for large databases that have functions stored in RND1 random or FTP function files.

**Examples**

\[
\begin{align*}
\text{FUNCTION GFREE } & 298.15 \ 1000+GFUNXY#; \ 6000 \ N \ ! \\
\text{FUNCTION GFUNXY } & 298.15 \ -1000+200*T+30*T*\log(T); \ 6000 \ N \ 505 \ ! \\
\text{FUNCTION G0_CAO } & 298.15 \ -663538.11+352.67749*T-57.7533*T*\ln(T) \\
& +5.3895E-03*T**2-8.879385E-07*T**3+575530*T**(-1); \\
\end{align*}
\]
PARAMETER


This keyword can appear in both files for database definition and sequential storage, but not in FTP files. After the keyword, a valid GIBBS parameter name should be given.

It is used to define standard Gibbs energies (i.e. the G parameters for Gibbs energy of formations) of all valid end-members of various stoichiometric and solution phases, and excess Gibbs energies (i.e. the L parameters for Gibbs energy of interactions) of all binary, ternary, quaternary or higher-order interactions in various solution phases; both standard Gibbs energies and excess energies can also have parameters for contributions from PT-depended volume variations (i.e. the V0, VA, VB, VC and VK parameters for molar volume, thermal expansivity, bulk modulus, isothermal compressibility and high-pressure fitting parameter), magnetic ordering (i.e. the TC and BM parameters for Curie temperature and Bohr magneton number) and hypothetical electrostatic interactions (i.e. BM parameter for Born functions ωPr,Tr of aqueous solute species).

The general form of a parameter is:

<identifier>{<phase>, <constituent array>; <digit>) <xxx> <expression> <yyy> <keyword Y or N> <zzz> !
General Form

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>identifier</td>
<td>The parameter type.</td>
</tr>
<tr>
<td>phase</td>
<td>The phase name (maximum 24 characters).</td>
</tr>
<tr>
<td>constituent</td>
<td>The specific constituent array in the phase.</td>
</tr>
<tr>
<td>array</td>
<td></td>
</tr>
<tr>
<td>digit</td>
<td>The degree of composition-dependent interaction contribution (an integer</td>
</tr>
<tr>
<td></td>
<td>number from 0 through 9), that is only for excess energy (L), Curie</td>
</tr>
<tr>
<td></td>
<td>temperature (TC) and Bohr magneton number (BMAGN), as well as for</td>
</tr>
<tr>
<td></td>
<td>volume-related parameters (V0 or VA or VB or VC or VK); if it is valued as</td>
</tr>
<tr>
<td></td>
<td>zero, or if it is for the standard Gibbs energy (G) for which the degree is</td>
</tr>
<tr>
<td></td>
<td>always zero, it can be omitted.</td>
</tr>
<tr>
<td>expression</td>
<td>The mathematical relation to describe the parameter.</td>
</tr>
<tr>
<td>xxx and yyyy</td>
<td>The low and high temperature limits respectively for the applicable</td>
</tr>
<tr>
<td></td>
<td>temperature range of the parameter expression</td>
</tr>
<tr>
<td>keyword Y or N</td>
<td>The indicator on if there is continuation for the parameter expression or</td>
</tr>
<tr>
<td></td>
<td>not</td>
</tr>
<tr>
<td>zzz</td>
<td>The reference index/number for the assessment of this parameter;</td>
</tr>
<tr>
<td>!</td>
<td>The exclamation mark is used to indicate that the current parameter</td>
</tr>
<tr>
<td></td>
<td>definition is ended</td>
</tr>
</tbody>
</table>

GIBBS Parameter Name

The GIBBS parameter name has a general form of:

\[
<\text{identifier}>(<\text{phase},<\text{constituent array}>;<\text{digit}>)
\]

Name Examples

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>G(GAS,C1O2)</td>
<td>The Gibbs energy of formation of a CO2 molecule in gas.</td>
</tr>
</tbody>
</table>
### Parameter Definition

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>L(LIQ,Fe,Cr;0)</td>
<td>The regular solution parameter for Fe and Cr in liquid.</td>
</tr>
<tr>
<td>L(LIQ,Fe,Cr;1)</td>
<td>The sub-regular solution parameter.</td>
</tr>
<tr>
<td>TC(BCC,Fe:Va)</td>
<td>The Curie temperature of bcc Fe.</td>
</tr>
<tr>
<td>BMAGN(BCC,Fe:Va)</td>
<td>The Bohr magneton number parameter of bcc Fe.</td>
</tr>
</tbody>
</table>

The GIBBS parameter name consists of several parts. The first is a *type-identifier*. The following type-identifiers are legal:

<table>
<thead>
<tr>
<th>Type-Identifier</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>G</td>
<td>Standard energy parameter (Gibbs energy of formation)</td>
</tr>
<tr>
<td>L</td>
<td>Excess energy parameter (Gibbs energy of interaction)</td>
</tr>
<tr>
<td>TC</td>
<td>Curie temperature for magnetic ordering</td>
</tr>
<tr>
<td>BMAGN or BM</td>
<td>Bohr magneton number for magnetic ordering (or Born function (\omega)Pr,Tr for aqueous solute species).</td>
</tr>
<tr>
<td>V0</td>
<td>Molar volume at 298.15 K and 1 bar (a numeric value only)</td>
</tr>
<tr>
<td>VA</td>
<td>Integrated thermal expansivity (\int_{298.15}^{T} \alpha(T)dT)</td>
</tr>
<tr>
<td>VB</td>
<td>Bulk modulus at 1 bar</td>
</tr>
<tr>
<td>VC</td>
<td>Isothermal compressibility</td>
</tr>
<tr>
<td>VK</td>
<td>High-pressure fitting parameter</td>
</tr>
</tbody>
</table>

You can also use \(\ell\) for interaction parameters; and on output list (performed by the GIBBS command LIST_PARAMETER or LIST_PHASE_DATA) the type-identifier \(L\) is always used for interaction parameters. Note that the type-identifier \(BM\) is also used for Born functions \(\omega\)Pr,Tr of aqueous solute species.

The identifier must be followed by an opening parenthesis, a phase name, a comma and a constituent array. Optionally, the constituent array can be followed by a semicolon and a digit. The parameter name is terminated by a closing parenthesis.
It is important that if a phase bears a legal phase-type (among G, A, Y, L, I, F and B) in its phase definition (already by the PHASE keyword; such as GAS:G, LIQUID:L, SLAG:L, IONIC_LIQ:Y, SPINEL:I, FCC_L12:F, HCP_D021:F, BCC_B2:B, AQUEOUS:A), such a valid phase-type code should not be attached to the phase name in the PARAMETER keyword.

Specifying the phase name in UPPER-case is recommended. You can define a phase name as a mixture of UPPER-case and lower-case letters in a database, but the DATA module automatically converts all lower-case to UPPER-case because the GIBBS module only recognizes UPPER-case phase names.

The constituent array consists of a list of constituent names. Interaction parameters have two or more constituents from the same sublattice separated by a comma. If the phase has sublattices, at least one constituent in each sublattice must be specified. The constituents in different sublattices must be given in sublattice order and are separated by a colon.

After the component array, a sub-index digit can be specified after a semicolon. This digit must be in the range 0 to 9. The interpretation of the sub-index depends on the excess energy model used for the phase. If no semicolon and digit are given, the sub-index value is assumed to be as zero.

The excess energy parameters, e.g. the regular/subregular (binary) parameter or ternary parameters, are multiplied with two or more fractions of the constituents from the same sublattice of the solution phase. These additional constituents must be given as interacting constituents.

Be careful about the sign of odd terms, for example, L(BCC, B, A:VA;1) is treated as L(BCC, A, B:VA;1), i.e. it is always put into alphabetical order.

Solution phases with sublattices may have interacting constituents in each sublattice.

You can use an asterisk (*) to denote that the excess interaction parameter is independent of the constituents of a specific sublattice. For example, L(FCC_L12, AL, NI:* ) means that the interaction parameter is for the binary interaction between constituents AL and NI on the first sublattice in the FCC_L12 solution phase, while it is independent of all constituents on the second sublattice. A interaction parameter in the list of constituents is always added to the Gibbs energy and the asterisk (*) is calculated with the term of \[ 1-\sum y(\text{specified constituents}) \], which implies that in an A-B binary system the following three L parameters are identical (but in higher-order systems, they are different):
\[ L(\text{phase}, A, B) \text{ is multiplied with } X(A) \times X(B) \]

\[ L(\text{phase}, A, *) \text{ is multiplied with } X(A) \times (1 - X(A)) \]

\[ L(\text{phase}, B, *) \text{ is multiplied with } X(B) \times (1 - X(B)) \]

A parameter always starts with a lowest temperature limit of its applicability, followed by one or more (up to 10) expressions (TP-Functions) coded as mathematical relations of constants, functions of stable variables (\(T\) and \(p\)) and entered functions (normally with a \# suffix, e.g. \(+3*\text{GSE}R\)).

The expression is a FORTRAN-like expression and operators \(+\), \(-\), \(*\), \(=\) and \(**\) can be used (** only with integer powers). Unary-functions \(\text{LN}\) or \(\text{LOG}\) (both for natural logarithm) and \(\text{EXP}\) (for exponential) can also be used. Each expression (TP-Function) should end with a semicolon (\(;\)) and be followed by its upper applicable temperature limit and a continuation indicator (\(Y\) to continue with the next expression, or \(N\) to end the parameter’s expression). If there is no continuation after a specific expression (TP-Function), the reference index can be optionally given after the \(N\) indicator.

A complete/valid parameter entry can be written in several continuation lines if the parameter’s expression (TP-Function) is too long or if there is more than one applicable expression (TP-Function), as the maximum length of each line is 78 characters.

It is recommended to always have at least one empty space at the beginning of each continuation line. Avoid entering parameters such as:

```
PARAMETR G(\text{LIQUID}, A, B) 298.15
-2000+4568*T+2*\text{GFUNAB}\#; 6000 N !
```

Such a parameter is read by the DATA module as \(2000+4568*T+2*\text{GFUNAB}\#,\) rather than as \(-2000 +4568*T+2*\text{GFUNAB}\#.\)

Avoid this mistake by giving at least one empty space as the first character of a new line, such as

```
PARAMETR G(\text{LIQUID}, A, B) 298.15
-2000+4568*T+2*\text{GFUNAB}\#; 6000 N !
```

The lowest-temperature limit (in Kelvin) for the applicability of the (first) TP-Function in a parameter is normally set by default as 298.15 K, in most cases; however, you can set another limit when it is applicable (according to experimental data and assessments). An upper-temperature limit (in Kelvin; followed by a \(Y\) or \(N\) sign) for the applicability of each TP-Function in a parameter must be given after the semicolon (\(;\)) immediately following the
specific TP-Function; and the highest-temperature limit (in Kelvin) for the applicability of the current parameter is always followed by the N sign. If a negative number is given as the lowest-temperature limit, it is assumed that there are breakpoints in pressure for this parameter. In such cases, it is interpreted as the lowest-pressure limit (in Pascal), and the other limits in the current parameter are also taken as pressure limit values (in Pascal).

The temperature/pressure limits for the parameters are checked during calculations. An indicator is set if the actual temperature/pressure condition is below the lowest temperature/pressure limit or above the highest temperature/pressure limit. In these cases, an extrapolation is done using the TP-Function valid in the nearest temperature/pressure range.

The optional reference index {Ref. Index} is an integer number indicating where to find the particular parameter in a special reference file. The references are listed when doing the GET_DATA command in the DATA module. These can also be listed in the GIBBS module with the command LIST_DATA and the option R or N.

For accounting the reference indices, also see the keyword "REFERENCE_FILE" on page 38.

The reference index field can also be an abbreviation (such as REF:250, REF_002, or REF-SGTE) denoting the original reference. In this case, the reference cannot be obtained when issuing the DATA command GET_DATA or the GIBBS command LIST_DATA (with the option R or N).

However, the references directly coded in the database definition file (**setup.TDB) that starts with a letter can be shown when issuing the DATA command GET_DATA or the GIBBS command LIST_DATA (with the option R or N). Normally, such references must be located after the LIST_OF_REFERENCE keyword. It is recommended to use reference code names such as REF001, REF018, etc. The reference list, which is generated by the GIBBS command LIST_DATA <file> with the N option, is thus also possible to be directly read by the DATA module.

Examples

```
PARAMETER G(BCC,FE:VA) 298.15 1000+200*T+...; 6000 N 91DIN !
PARAMETER TC(BCC,FE:VA) 298.15 +1043; 6000 N 91DIN !
PARAMETER BMAGN(BCC,FE:VA) 298.15 +2.22; 6000 N 91DIN !
PARAMETER G(SIGMA,FE:CR:CR;0) 298.15 1000+200*T+...; 6000 N 101 !
PARAMETER G(LIQUID,AL;0) 298.15 +11005.553-11.840873*T
+7.9401E-20*T**7+GHSERAL#
```
933.60 Y +10481.974-11.252014*T+1.234264E+28*T**(-9)+GHSERAL#;
   2900.00 N REF:283 !
PARAMETER G(BCC_A2,PC:CO) 298.15 UN_ASS#; 300 N REF:0 !
PARAMETER G(BCC_A2,NI:C:0) 298.15 +GHSERNI#+3*GHSERCC#
   +400000-100*T; 6000 N REF071 !
PARAMETER G(BCC_A2,MN:VA) 298.15 +GMNBCC#; 6000 N REF285 !
PARAMETER BM(AQUEOUS,OH:1) 298.15 +20002PW0#: 1600 N 155 !
PARAMETER L(BCC,FE,CO:VA;0) 298.15 1000+200*T...; 6000 N !
PARAMETER L(BCC,FE,CO:VA;1) 298.15 1000+200*T...; 6000 N !
PARAMETER L(BCC,FE,CO:VA;2) 298.15 1000+200*T...; 6000 N !
PARAM TC(BCC_A2,CO,MO:VA;0) 298.15 -3700; 6000 N R454 !
PARAM TC(BCC_A2,CO,MO:VA;1) 298.15 +2300; 6000 N R454 !
PARAM BMAGN(BCC_A2,CO,MO:VA;0) 298.15 -3.445; 6000 N R454 !
PARAM V0(BCC_A2,CR,FE:VA;0) 298.15 +ZERO#; 6000 N REF06V !
PARAM V0(BCC_A2,CR,FE:VA;1) 298.15 -1.10524097E-7; 6000 N REF06V !
PARAM V0(BCC_A2,CR,FE:VA;2) 298.15 +1.40024130E-7; 6000 N REF06V !
PARAM VA(BCC_A2,CR,FE:VA;0) 298.15 -6.49444634E-6*DELTAT#; 6000 N REF06V !
PARAM VA(BCC_A2,CR,FE:VA;1) 298.15 +2.91269321E-5*DELTAT#; 6000 N REF06V !

OPTIONS

OPTIONS /[alloy name]([composition limitations for all alloying elements]) !

This keyword defines an alloy in a database. An alloy has a name, a major component and a number of alloying elements. The purpose for defining an alloy is to be able to tell you about applicable composition limits of the current database in applications to that particular type of alloy. It is possible to have several alloys in the same database. The alloys are given after the keyword in the database.

The alloy name must be proceeded by a slash (/) and terminated by the opening parenthesis, with no spaces are allowed in between.

- The alloy name is maximum 8 characters.
- After the parenthesis, follows the major element and a parenthesis with its minimum mass and minimum mole percent given inside.
Then, the alloying element names, each with its maximum mass and mole percent are given within parenthesis.

There must be a space between definitions for each alloying element.

The alloy definition is terminated by a closing parenthesis, and the whole OPTIONS keyword by the exclamation mark (!).

Example

OPTIONS /SSteel(Fe(60,60) CR(30,30) NI(15,15) SI(1,1) N(.1,1))!

TABLE

It is recommended to always have at least one empty space at the beginning of each continuation line. Otherwise, the DATA module may issue some error messages when reading the table entry.

This keyword can appear in both files for database definition and sequential storage, but not in FTP files. It makes a table of Gibbs energy as a function of temperature where the values are given from the start temperature to the end temperature, at a step of the delta temperature.

Example

TABLE DEMTAB 1000.0 1500.0 100.0 -2912.9008 -2834.2416 -2755.5824
-2677.7600 -2600.7744 -2524.2072!

ASSESSED_SYSTEMS

ASSESSED_SYSTEM [descriptions on special treatments for specific assessed systems]*8000!

This keyword can be included in the database definition file (the ***setup.TDB file). A maximum of 8000 characters after the keyword (to describe some special options when the DATA, GIBBS and POLY models deal with the existing systems with assessed data) is allowed until the exclamation mark (!).

Several ASSESSED_SYSTEMS keywords can be used in the same TDB file in order to have more lists of assessed systems. There is no limit to the number of the entries in the same TDB file.
The assessed systems in the database, and the special treatment options, are typed after the keyword. The elements (always in UPPER CASE) in each assessed system must be in alphabetical order and be separated by a hyphen, such as C-FE for the Fe-C binary system, and C-CR-FE for the Fe-Cr-C ternary system. A space must be between each assessed system. Information on assessed binary, ternary or higher-order systems may also be given in this way.

A ternary system like C-CR-FE does not imply that the binary C-CR, C-FE and CR-FE are assessed. There is no way to indicate partially assessed systems.

- There is a field to give some descriptive information for a specific system, with various options about how to:
- Reject or restore phase(s) from the current database in the DATA module;
- Set major constituent(s) in the first composition set and to set a second composition set for a specific phase available in the current database in the GIBBS module; and
- Calculate this specific system in the POLY module.
- This is the facility used by the BIN (binary phase diagrams) and TERN (ternary phase diagrams) modules in the Thermo-Calc software/database package.

The descriptive information must immediately follow the specific system name, and must be enclosed within parenthesis ( and ), and the left parenthesis must follow directly after the system, such as:

```
AL-NI(TDB +L12 ;G5 C-S:L12/NI:AL:VA ;P3 STP:.8/1200/1 STP:.2/600/1)
```

The syntax TDB means that the commands to the DATA module proceed, and +L12 in the example means that the phase called L12 should be restored (it has been rejected by default).

The directive ;G5 means that the following are commands to the GIBBS module. C_S: means creating a second composition set, after the colon follows the phase name and after the slash the major constituents.

After the directive ;P3 follows commands to the POLY module. STP: means setting a start point with the value of the X-axis first (composition for the second element in a binary system), the slash separates the Y-axis value (temperature), and possibly one or more directions (−1, 1, −2 or 2).

A summary of the allowed syntax is:

TDB accepts
<ul>
  <li>+phase and -phase for restore/reject.</li>
  <li>;G5 accepts MAJ:phase/constituent-array for major constituents of the first composition set.</li>
  <li>C_S:phase/constituent-array for a second composition set.</li>
  <li>;P3 accepts TMM:lt/ht for the low-/high-temperature limits (lt and ht; for instance TMM:500/4000) suitable for calculating phase diagrams and property diagrams of a binary system.</li>
  <li>* for a default start point which is set as:
      - for a binary system: at the composition X(2<sup>nd</sup> element)=.1234, temperature T=1100 K and with the default directions; or
      - for a ternary system: at the compositions X(2<sup>nd</sup> element)=.1234 and X(3<sup>rd</sup> element)=.1234 and with the default directions.
  </li>
  <li>STP:x/t/d1/d2/d3 for a specific start point in a binary system which is set as at the composition X(2<sup>nd</sup> element)=x and temperature T=t (in K), and with the directions d1, d2 and/or d3.</li>
  <li>STP:x1/x2/d1/d2/d3 for a specific start point in a ternary system which is set as at the compositions X(2<sup>nd</sup> element)=x1 and X(3<sup>rd</sup> element)=x2 and with the directions d1, d2 and/or d3. The direction(s) can be defined as -1, 1, -2 or 2. If no direction is specified, all default directions are used (meaning no ADD command is enforced in the POLY module).
      - If only one start point is specified, the direction(s) may be omitted; if more than one start points are specified, at least one direction for each start point must be given for all start points.
  </li>
</ul>

Each entry for a specific binary or ternary sub-system can be written in one or several lines (each line with 78 characters).

**Other Examples**

```
ASSESSED_SYSTEMS
AL-NI(TDB +L12 +BCC_B2 ;G5 C_S:L12/NI:AL:VA
      ;P3 STP:.8/1000/1 STP:.45/700/1 STP:.7/700/1)
AL-PB(TDB -HCP -BCC
```
;G5 MAJ:LIQ/AL MAJ:FCC/AL:VA C-S:LIQ/PB C-S:FCC/PB:VA ;P3 *

CR-FE( ;G5 C-S:BCC/CR:VA ;P3 STP:.6/1200/1/-2/2)
AG-CU( ;G5 MAJ:FCC/AG:VA C_S:FCC/CU:VA ;P3 STP:.3/1000)
C-NB( ;P3 STP:.9/1100/1)
C-SI( ;P3 *)
CO-CR( ;G5 MAJ:FCC/CO:VA C_S:FCC/CR:VA ;P3 STP:.1/1100)
CR-FE(TDB -HCP ;G5 C_S:BCC/CR:VA ;P3 STP:.6/1200/1/-2/2)
CR-NI( ;P3 *)
CR-W( ;G5 MAJ:BCC/W:VA C_S:BCC/CR:VA
 ;P3 TMM:500/4000 STP:.3/700/1 STP:.3/1800/2 )
CU-FE(TDB -HCP ;G5 MAJ:LIQ/CU MAJ:FCC/FE:VA C_S:FCC/CU:VA
 ;P3 STP:.9/1400)
FE-N(TDB +FE4N ;P3 *)
FE-O(TDB -LIQUID +IONIC ;G5 C_S:ION_LIQ/FE+2:O-2 MAJ:ION_LIQ/FE+2:VA
 ;P3 STP:.2/2000/1 )
FE-S(TDB -LIQUID +IONIC ;G5 C_S:ION_LIQ/FE+2:S MAJ:ION_LIQ/FE+2:S-2 ;P3 *)
AL-MG-SI( ;P3 *)
C-CR-FE ;G5 MAJ:BCC/FE:VA C_S:BCC/CR:VA ;P3 *)

The semicolon (;) is a part of the ;G5 and ;P3 directives. A long descriptive information can be written in more than one line, such as for the AL-NI, AL-PB, CU-FE and FE-O systems shown above.

The directive ;P3 * is needed if the default start point should be used. If there is no P3 directive, the BIN or TERN module generates some 20 different start points in order to cover all possible compositions and temperatures (for a binary system) or all possible compositions (for a ternary system under any specific temperature).

REFERENCE_FILE

REFERENCE_FILE [file name] !

This keyword takes a reference file name as its argument. This reference file (that must be edited in a restrictive way and be saved as a blocked file with a fixed line-length for each line in the file, as described below) contains a complete list of the references for the various parameters (and sometimes functions) in the database. The file must have a fixed record
structure: each reference entry with one or several records, and each record with exactly 78 characters written in one single blocked line; and no empty space is allowed at the beginning of all lines in the file. If there are more than one record entered for a reference entry, all the continuation lines must start with an ampersand (&). The line number of the first record for a specific reference entry is then accounted as the unique integer for that specific reference, which is referred when a parameter or function calls this integer as the optional \{Ref. Index\}.

Also see keyword "PARAMETER" on page 28 or "FUNCTION" on page 25 about specifying a reference index.

Example

/-1<G> T.C.R.A.S. Class 1
AG1.64TE1 THERMODATA 01/93
&28/01/93
&SILVER 1.64-TELLURIDE. Solid Standard State.
AG1 HULTGREN SELECTED VAL. SGTE **
&AT.WEIGHT 107.870,STANDARD STATE:CODATA KEY VALUE.MPT=1234.93K.
&--U.D. 30/10/85.
AG1<G> T.C.R.A.S Class: 1
AG1/1<G> T.C.R.A.S Class: 1
AG1BR1 N.P.L. SGTE **
&Tfusion uncertain and heat vaporization estimated.
AG1BR1<G> THERMODATA 01/93
&28/01/93
&Gaseous Standard State.
AG1BR103 BARIN & KNACKE.SUPPL.REF:62,* SGTE **
&AGO3BR SILVER OXYTRIBROMIDE

In the example, the unique integers of related references (for assessed elements, species, phases, interactions, etc.) are:

1/-1<G>
2AG1.64TE1
5 AG1
8AG1<G>
LIST_OF_REFERENCE

This keyword starts a reference list that is directly coded in the database definition file (**setup.TDB). Its argument begins on the following line, and normally has an explanation line (NUMBER SOURCE) that is followed by various reference codes. Each reference code may occupy one or more lines (each line with maximum 78 characters), but must have a reference code name (that starts with a letter) and the detailed reference information (that is written within two single-quotiation marks, ' '). It is recommended to use reference code names such as REF001, REF018, etc. A maximum of 400,000 characters after the keyword is allowed until the exclamation mark (!).

Such a reference list can be shown when issuing the DATA command "GET_DATA" on page 16 or the GIBBS command "LIST_DATA" on page 120 (with the R option). The reference list, which is generated by the GIBBS command LIST_DATA <file> with the N option, has this structure, and is thus possible to be directly read by the DATA module.

Example

LIST_OF_REFERENCES
NUMBER SOURCE
REF283 'Alan Dinsdale, SGTE Data for Pure Elements,
   Calphad Vol 15(1991) p 317-425,
   also in NPL Report DMA(A)195 Rev. August 1990'

ADD_REFERENCE

ADD_REFERENCE
[REFxxx]  '[Detailed reference]'  

............

............ !

Use this keyword to have an unlimited number of references. The use of this is the same as that of "LIST_OFREFERENCE" on the previous page, and is used after it. Several ADD_REFERENCES sections can be used in a single database if there are too many references.

It is recommended to always start with a so-called empty reference (such as the DUMP0 reference in the following example) as the first entry in each of the ADD_REFERENCE sections to make sure that all references are listed appropriately as retrieving data by issuing the "GET_DATA" on page 16 command.

Example

ADD_REFERENCE

    DUMP0  'Empty reference 0'
            TRITA 0270 (1986); CR-FE'
            TRITA 0207 (1986); C-CR-FE'
    REFS  'Pingfang Shi (2006), TCS PTERN Public Ternary Alloys Database,
            v1.2; Modified L0(BCC,Fe,C) and L0(BCC,Cr,C) parameters
            at high temperatures.'

    ...

ADD_REFERENCE

    DUMP1  'Empty reference 1'
            p.524-536,
            TRITA-MAC 362 (1988); C-CO-NI AND C-CO-FE-NI'
            TRITA 0409 (1989); CR-FE-N'
TRITA-MAC 348, (1987); C-CR-FE-W'

... ...
!

**CASE and ENDCASE**

```
CASE [ELEMENT/SPECIE/PHASE] !
   IF (boolean algebra on element, species or phase names) THEN
      [GIBBS/POLY/DATA command] !
   ENDCASE !
```

This keyword takes as its argument, a definition on which type of the following Boolean algebra operates. A simple Boolean algebra using AND and OR with a maximum of four levels of parentheses works. The `CASE` construction must end with the `ENDCASE` keyword. This makes it possible to have additional GIBBS or POLY commands executed depending on the user selection of elements, species or phases. The DATA commands that can be given as secondary keyword to "DEFAULT_COMMAND " on page 20 can also be executed.

**Example 1**

```
CASE ELEMENT !
   IF ((CR OR TI OR V) AND N)
      THEN GES AM_PH_DES @ C_S ,, CR MO TI V:C N: !
ENDCASE !
```

**Example 2**

```
CASE ELEMENT !
   IF (0) THEN TDB DEFINE_SYSTEM_ELEMENT /- !
ENDCASE !
```

**Example 3**

```
CASE ELEMENT !
   IF (AL AND FE)
      THEN TDB DEF_SYS_ELEMENT VA !
ENDCASE !
```

**VERSION_DATA**

```
VERSION_DATE [string]*78 !
```
The string is denoted as the version/revision date and database manager of the database. Nowadays, this directive is used mainly for the purpose of keeping the development and revision history mostly updated.

Example

```
VERSION_DATE Last update and adjustment: Database Manager, 2015-09-25 |
```
Working with the Mobility Databases

In this section:

- About the Diffusion Module (DICTRA) and the Databases ............................................. 45
- Extensions to Database Definition File Syntax ................................................................. 46
- PARAMETER .......................................................................................................................... 46
- DIFFUSION ........................................................................................................................... 47
- ZERO_VOLUME_SPECIES ...................................................................................................... 48
About the Diffusion Module (DICTRA) and the Databases

A Diffusion Module (DICTRA) installation shares directories with Thermo-Calc, including the \DATA\ (or /data/) area and the database initiation file (TC_INITD.TDB or initd.tdb).

When you want to switch or add self-generated databases/data-sets or any new database, use the predefined database list in the database initiation file as part of the Thermo-Calc installation packages.

You can add comment lines in the database initiation file, which must start with a $ sign. These lines are ignored by the DATA module. This is also applicable if the database manager or user wants to temporarily disable a database in the predefined database list. If there are too many databases in the \DATA\ area that the DATA module cannot handle properly, the $ sign can be used to temporarily comment about the uncommon databases. However, this does not often happen.

If Thermo-Calc is used with a Windows platform, such additional database initiation files can be located at any directory of any driver, on either a local computer or connected server. The NEW_DICTORY_FILE command displays an Open window to access a database initiation file if the file name or its path is not given on the same line of the NEW_DICTORY_FILE command, or if it is incomplete or incorrect, so that the path (in the Look in box) and database initiation file name (in the File name box) can be appropriately selected. However, if Thermo-Calc is run on a Linux/UNIX platform, these files must be located in the current working directory (where Thermo-Calc is started).

In an additional database initiation file, the first database entry may need to have the same path definition structure as in the ordinary database initiation file. Copy the entry line(s) for common databases from the original file to a database initiation file. The entries of the additional databases follow. Similar to the standard databases predefined in the database initiation file, all databases should normally be located in subdirectories under the directory as defined by the TCPATH parameter (Windows) or the TC_DATA parameter (Linux/UNIX), or under its subdirectory \DATA\ or /data/.

Windows Database Initiation File Example

For a Windows platform, the following example is an additional database initiation file, called MYINITD1.TDB:

```

$  

$ DATABASES TCC (Additional TCC Databases)
```
PURE5 TCPATH\DATA\PURE5\PURE5SETU.TDB SGTE Pure Elements Database, version 5 !
AD1 TCPATH\DATA\ADD1\AD1SETUP.TDB TCS ADD1 Solution Database, version 1 !
AD2 TCPATH\ADDDATA\ADD2\AD2SETUP.TDB TCS ADD2 Solution Database !
$AD2o TCPATH\ADDDATA\ADD2old\AD2SETUP.TDB TCS ADD2 Database (old) !
AD3 TCPATH\DATA\NEWDATA\ADD3\AD3SETUP.TDB TCS ADD3 Solution Database !
AD4 TCPATH\DATA\NEWDATA\MYPROJ1\ADD4\AD4SETUP.TDB MYPROJECT1 ADD4 Solution Database !
$
$
DATABASES DIC (Additional DICTRA Databases)
DCAD1 TCPATH\DICDATA\DCADD1\DCAD1SET.TDB TCS DCADD1 Mobility Database !

**Extensions to Database Definition File Syntax**

Software packages for simulation of diffusional phase transformations, such as the Diffusion Module (DICTRA) and Precipitation Module (TC-PRISMA), need both thermodynamic data and kinetic data (i.e. diffusivities or mobilities). Naturally, the handling and storage of kinetic data also benefits from the use of some kind of database management. Thus, the TDB database definition file syntax has been extended to incorporate some new keywords needed for storing kinetic data - "PARAMETER" on page 28, "DIFFUSION" on the next page, and "ZERO_VOLUME_SPECIES " on page 48.

**PARAMETER**

PARAMETER [special GIBBS parameter name] [low temp. limit]
[expression 1]; [upper temp. limit 1] Y
[expression 2]; [upper temp. limit 2] Y
[expression 3]; [upper temp. limit 2] Y
........... ; ..... Y
[expression n-1]; [upper temp. limit n-1] Y
[expression n]; [upper temp. limit n] N {Ref. Index} !
This keyword allows you to enter all types of normal GIBBS parameters for thermodynamic data as well as five special extensions suitable for kinetic data used in the Diffusion Module (DICTRA).

Valid extensions to special GIBBS parameter names are:

- **MQ**: Activation enthalpy for mobility equation.
- **MF**: Pre-exponential factor for mobility equation.
- **DQ**: Activation enthalpy for diffusivity equation.
- **DF**: Pre-exponential factor for diffusivity equation.
- **VS**: Volume counted per mole of volume carrying species.

**Examples**

PARAMETER MQ(BCC,FE:VA) 298.15 1000+200*T+...; 6000 N !
PARAMETER MF(BCC,CO:VA) 298.15 1000+200*T+...; 6000 N !
PARAMETER DQ(FCC,FE:VA) 298.15 1043+...; 6000 N 10 !
PARAMETER DF(FCC,CR:C ) 298.15 1000+200*T+...; 6000 N 10 !
PARAMETER VS(FCC) 298.15 1000+200*T+...; 6000 N 11 !

**DIFFUSION**

DIFFUSION [model keyword] [phase name] [additional parameter(s)] !

This keyword specifies the type of diffusion model to use for a phase if the default model is not desired. The default model calculates the full diffusion matrix. A diffusivity is calculated from the different mobilities and the thermodynamic factors. The former ones are calculated as:

\[ M = \exp\left(\sum_{i} \frac{MF_i}{RT}\right) \exp\left(\sum_{i} \frac{MQ_i}{RT}\right) / RT \]

where \( \sum \) stands for a weighted summation of the different MF’s and MQ’s plus possibly a Redlich-Kister term.
Valid Model Keywords

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NONE</td>
<td>No diffusion in this phase</td>
</tr>
<tr>
<td>DILUTE</td>
<td>Constitution list of dependent species in each sublattice must be given as an additional parameter. Only the diagonal terms in the diffusion matrix are calculated. ( D = \exp (\sum DF/RT) \exp (\sum DQ/RT) ).</td>
</tr>
<tr>
<td>SIMPLE</td>
<td>Constitution list of dependent species in each sublattice must be given as an additional parameter. Only the diagonal terms in the diffusion matrix are calculated. ( D = \sum DF + \sum DQ ).</td>
</tr>
<tr>
<td>MAGNETIC</td>
<td>The so-called ALPHA and ALPHA2 parameters must be given as additional parameters. ALPHA is for the substitutional magnetic model and ALPHA2 for the interstitial one. By appending an &amp; sign and a species name after the alpha keyword one can supply individual values for the different species. The full diffusion matrix is calculated.</td>
</tr>
</tbody>
</table>

Examples

```
DIFFUSION NONE SIGMA !
DIFFUSION DILUTE CEMENTITE : FE : C : !
DIFFUSION MAGNETIC BCC_A2 ALPHA=0.3 ALPHA2&C=1.8 ALPHA2&N=0.6 !
```

**ZERO_VOLUME_SPECIES**

```
ZERO_VOLUME_SPECIES [list of species] !
```

In the Diffusion Module (DICTRA), the assumption that the volume is carried by the substitutional elements only is applied. The interstitial elements are assumed to have zero molar volumes. This keyword uses a list of which species are to be considered as zero volume ones for an argument.

Example

```
ZERO_VOLUME_SPECIES VA C N !
```
Database Definition File Examples

In this section:

Example 1: A Steel Database ................................................................. 50
Example 2: A Custom Database for the Sb-Sn Binary System ....................... 51
Example 3: A Public Database for the Fe-Cr-C Ternary System ....................... 54
Example 1: A Steel Database

TEMP-LIM 500.0 2000.0 !
$
$ELEMENT, NAME, REF.STATE, ATOMIC-MASS, H0, S0 !
ELEMENT VA VACUUM 0.0 0.0 0.0 !
ELEMENT C GRAPHITE 12.011 0.0 0.0 !
ELEMENT V BCC 50.9415 0.0 0.0 !
ELEMENT CR BCC-PARAMAGNETIC 51.996 0.0 0.0 !
ELEMENT FE FCC-PARAMAGNETIC 55.847 0.0 0.0 !
ELEMENT NI FCC-PARAMAGNETIC 58.69 0.0 0.0 !
ELEMENT MO BCC 95.94 0.0 0.0 !
ELEMENT W BCC 183.85 0.0 0.0 !
$
$PHASE, NAME, TYPE, NR-OF-SUBL, SITES-IN-EACH-SUBL. !
PHASE BCC B1M 2 1.0 3.0 !
PHASE FCC F2M 2 1.0 1.0 !
PHASE HCP 0 2 2.0 1.0 !
PHASE LIQUID 3 2 1.0 1.0 !
PHASE CEMENTITE 4 2 3.0 1.0 !
PHASE M23C6 4 2 23.0 6.0 !
PHASE M7C3 4 2 7.0 3.0 !
PHASE M6C 4 2 2.0 2.0 2.0 1.0 !
PHASE SIGMA 0 3 10.0 4.0 16.0 !
PHASE MU-PHASE 0 3 7.0 2.0 4.0 !
PHASE R-PHASE 0 3 27.0 14.0 12.0 !
PHASE GRAPHITE 4 1 1.0 !
$
$CONSTITUENT, PHASE-NAME : CONSTITUENTS !
CONSTITUENT BCC :V CR FE NI MO W:VA C: !
CONSTITUENT FCC :V CR FE NI MO W:VA C: !
CONSTITUENT HCP :CR FE NI:VA C N: !
CONSTITUENT LIQUID :C V CR FE NI MO W VA:VA C: !
CONSTITUENT CEMENTITE :CR FE:C: !
CONSTITUENT M23C6 :CR FE:C: !
CONSTITUENT M7C3 :CR FE:C: !
CONSTITUENT M6C :FE:W:FE W:C: !
CONSTITUENT SIGMA :FE:V CR MO:FE V CR MO: !
CONSTITUENT MU-PHASE :FE:MO W:FE MO W: !
CONSTITUENT R-PHASE :FE:MO :FE MO: !
CONSTITUENT GRAPHITE :C: !
$
$TYPE_DEFINITIONS:
TYPE-DEFINITION 0 SEQ TCPATH\DATA\METDATA\TC-THEREST.TDB !
TYPE-DEFINITION 1 SEQ TCPATH\DATA\METDATA\TC-BCC.TDB !
TYPE-DEFINITION 2 SEQ TCPATH\DATA\METDATA\TC-FCC.TDB !
TYPE-DEFINITION 3 SEQ TCPATH\DATA\METDATA\TC-LIQUID.TDB !
TYPE-DEFINITION 4 SEQ TCPATH\DATA\METDATA\TC-CARBIDES.TDB !
TYPE-DEFINITION M SEQ TCPATH\DATA\METDATA\TC-CURIE-BOHR.TDB !
TYPE-DEFINITION B GES AM-PH BCC MAGNETIC -1 .4 !
TYPE-DEFINITION F GES AM-PH FCC MAGNETIC -3 .28 !
$
$DEFAULT_COMMANDS:
DEFAULT-COMMAND DEF_ELEMENT VA !
DEFAULT-COMMAND REJ_SYS-CONST LIQUID 1 VA !
$DATABASE_INFORMATION:
DATABASE-INFO The following binary and ternary systems are available: ' 
   FE-CR-NI by Hertzman'
   FE-MO Fernandez'
   FE-CR-C Andersson'
   FE-W-C Gustafson'
   FE-W Andersson & Gustafson'

**Example 2: A Custom Database for the Sb-Sn Binary System**

$
$ELEMENT, NAME, REF.STATE, ATOMIC-MASS, HO, SO !
ELEM VA VACUUM 0.0 0.0 0.0 !
ELEM MG HCP(A3) 24.305 0.0 0.0 !
ELEM SB RHOMBOHEDRAL(A7) 121.75 0.0 0.0 !
ELEM SN BCT(A5) 118.69 0.0 0.0 !
ELEM /- ELECTRON-GAS 0 0 0 !
$
$SPECIES, NAME, STOICHIOMETRIC-FORMULA !
SPECIE MG1 MG1!
SPECIE MG2 MG2!
SPECIE MG2+ MG/+2!
SPECIE SB1 SB1!
SPECIE SB2 SB2!
SPECIE SB4 SB4!
SPECIE SB3- SB/-3!
SPECIE SB5- SB/-5!
SPECIE SN1 SN1!
SPECIE SN4- SN/-4!
$

$PHASE, NAME, TYPE, NR-OF-SUBL, SITES-IN-EACH-SUBL. !
PHASE BCT Z 1 1.0!
PHASE HCP Z 1 1.0!
PHASE RHOMBO Z 1 1.0!
PHASE GAS:G Z 1 1.0!
PHASE LIQUID:L Z 1 1.0!
PHASE IONICLIQ:Y Z 2 1 1!
PHASE SPLIQ:Y Z 2 1 1!
PHASE BMG3SB2:I Z 2 3 2!
PHASE AMG3SB2:I Z 2 3 2!
PHASE MG2SN:I Z 2 2 1!
PHASE SBSN Z 2 1 1!
PHASE SB2SN3 Z 2 2 3!
$

$CONSTITUENT, PHASE-NAME : CONSTITUENTS !
CONSTITUENT RHOMBO :SB SN:!
CONSTITUENT HCP :MG SN:!
CONSTITUENT BCT :SB SN:!
CONSTITUENT GAS:G :MG1 MG2 SB1 SB2 SB4 SN1:
    > Gas phase, using the Ideal EOS and Mixing Model. !
CONSTITUENT LIQUID:L :SB SN:!
CONSTITUENT IONICLIQ:Y :MG2+:SB SB3- SN SN4- VA:
    > This is the Ionic Liquid Solution Phase. !
CONSTITUENT SPLIQ:Y :MG2+:SB SB3- SN SN4- VA:!
CONSTITUENT BMG3SB2:I :MG2+:SB3- SB5- VA SN4-!: 
CONSTITUENT AMG3SB2: I :MG2+:SB3- VA SN4-:
CONSTITUENT MG2SN: I :MG2+ VA:SB3- SN4-:
CONSTITUENT SBSN :SB SN:SB SN:
CONSTITUENT SB2SN3 :SB:SN:

$DEFAULT_COMMANDS:
DEFAULT-COM DEF-ELEM VA /-
DEFAULT-COM REJ-PHASE LIQUID!
DEFAULT-COM REJ-PHASE SPLIQ!

$TYPE_DEFINITIONS:
TYPE-DEFINITION Z SEQ *!

$DATABASE_INFORMATION:
DATABASE_INFO The Sb-Sn system with isentropic temperatures!

$VERSION_DATE:
VERSION_DATE Last update 1986-05-18 11:39:49

$ HERE COMES THE THERMODYNAMIC DATA (expressed in functions & parameters):
FUNCTION MGLIQUID 298.15 -4630.90976+192.994374*T-34.0888057*T*LOG(T)
    -36544605.6*T**(2); 6000 N!

FUNCTION MGSOLID 298.15 -8367.34+143.677876*T-26.1849785*T*LOG(T)
    +4.858E-4*T**2-1.393669E-6*T**3+78950*T**(2);
    923.00 Y -13804.4772 +202.909445*T-34.0888057*T*LOG(T)
    -3.65446056E7*T**(2) +1.06753982E28*T**(2); 6000 N!

FUNCTION SBLIQUID 298.15 9071.98+146.800*T-31.38*T*LOG(T)
    -2.4416468E8*T**(2); 6000 N!

FUNCTION LFCT 298.15 -17325.6+5.03600*T; 6000 N!
FUNCTION GFCTSBSN 298.15 LFCT+SBSOLID+SNSOLID+2948.291+3721.286;  
    6000 N!

FUNCTION ISB 298.15 15000; 6000 N!

FUNCTION ISN 298.15 47199.9 -95.6270*T; 6000 N!

$ 
...... 
...... <more>

$ 

PARAMETER G(RHOMBO,SB;0) 298.15 SBSOLID; 6000 N!

PARAMETER G(RHOMBO,SN;0) 298.15 2035+SNSOLID; 6000 N!

$ 

PARAMETER G(HCP, MG;0) 298.15 MGSOLID; 6000 N!

PARAMETER G(HCP, SN;0) 298.15 32000+SNSOLID; 6000 N!

PARAMETER G(HCP, MG, SN;0) 298.15 -69566-9.23183*T; 6000 N!

$ 

PARAMETER G(BCT, SN;0) 298.15 SNSOLID; 6000 N!

PARAMETER G(BCT, SB;0) 298.15 1000+SBSOLID; 6000 N!

PARAMETER G(BCT, SB, SN;0) 298.15 0.5*ISB+0.5*SNSOLID; 6000 N!

PARAMETER G(BCT, SB, SN;1) 298.15 0.5*ISB-0.5*SNSOLID; 6000 N!

$ 

PARAMETER G(IONICLIQ, MG2+:SB3-;0) 298.15 -204389-4.98506*T  
    -2.75637E9*T**(-2)+3*MGLIQUID+2*SBLIQUID; 6000 N!

PARAMETER G(IONICLIQ, MG2+:SN4-;0) 298.15 -98639.5+881.073*T  
    -174.523*T*LOG(T)-1.79808E9*T**(-2); 6000 N!

PARAMETER G(IONICLIQ, MG2+:SB;0) 298.15 SBLIQUID; 6000 N!

$ 

...... 
...... <more>

$ 

Example 3: A Public Database for the Fe-Cr-C Ternary System

$ 

$ Revision history:

$ Created as PDEMO by Pingfang Shi on 2004-10-05

$ Renamed to DFeCrC by Pingfang Shi on 2006-10-25
FURTHER MODIFICATIONS:

$pfs: /20041005$ (PDEMO)

* Retrieved all definitions from PTERN for the Fe-Cr-C ternary!

$pfs: /20061025$ (DFeCrC)

* Ignore ELEMENT /- definition.
* Modify the $L(BCC_A2,FE:C,VA;0)$ [and $L(BCC_A2,CR:C,VA;0)$]
parameters, in order to avoid BCC-appearance (Fe-C)
at temperatures higher than 3900 K.

$L(BCC_A2,CR:C,VA;0)$ 298.15 -190*T; 6000 N REF1 !
$L(BCC_A2,CR:C,VA;0)$ 298.15 -190*T; 3000 Y 0; 6000 N REF1 !
$L(BCC_A2,FE:C,VA;0)$ 298.15 -190*T; 6000 N REF3 !
$L(BCC_A2,FE:C,VA;0)$ 298.15 -190*T; 3900 Y 0; 6000 N REF3 !
* Add Cr into HCP_A3 phase, and
add all necessary G0/L parameters (according to SSOL2/TCFE3):
$G(HCP_A3,CR:VA;0)$
$TC(HCP_A3,CR:VA;0)$
$BMAGN(HCP_A3,CR:VA;0)$
$G(HCP_A3,FE:C;0)$
$G(HCP_A3,CR:C;0)$
$L(HCP_A3,CR:C,VA;0)$
$L(HCP_A3,CR,FE:VA;0)$
* Add "TMM:300/3000" limits to all three binary joins in the
ASSESSED_SYSTEM section.
* Change the reference indices, e.g., 101 to REF1, in order to
always get the reference list correctly.
* Re-arrange database format slightly.
* Updated the DATABASE_INFO section.

DATABASE INFORMATION:

$DATABASE_INFO DFeCrC$
The DFeCrC database (previously called PDEMO) is the TCS Demo Fe-Cr-C 'Alloy Solutions Database, which is especially designed for primarily demonstrating the uses of:

* TCC-Demo software: BIN, TERN, SCHEIL and some other modules;
* TCW-Demo software:
  "Binary" module calculations of phase diagrams and property diagrams' in available binary systems;
  "Ternary" module calculations of phase diagrams (e.g., isothermal sections, monovariant lines involving liquid, liquidus' surface projections) and property diagrams in available' ternary systems;
  "Scheil" module simulations of alloy solidifications; and/or '
  "Equilibrium" calculation routines for phase diagrams and property' diagrams in available binary or ternary systems.

It can also be used for other types of calculations/simulations in both' TCC and TCW software, and in their application programming interfaces."

It includes critically-assessed data for all possible three binary joins' (i.e. Cr-C, Fe-Cr and Fe-Cr) and one complete ternary alloy solutions ' within the Fe-Cr-C system. However, due to the fact that experimental' data for the Fe-C and Cr-C binary joins and Fe-Cr-C ternary system at ' extremely-high temperatures are not sufficient, the available assessed' data can not be applied to temperature conditions higher than 4000 K.'"

Included thermodynamic data are available for various stoichiometric 'and solution phases, e.g. liquid mixture, various alloy solutions and ' intermetallic phases. But the gaseous mixture phase is excluded in this' DEMO version.'"

The DFeCrC database can be used not only in calculating various types ' of phase diagrams (binary phase diagrams, ternary isothermal sections,' ternary monovariant lines involving liquid, ternary liquidus surface ' projections, ternary isopleth sections, etc.) and property diagrams' (the easiest ways are through the BIN and TERN modules), but also in ' simulating alloy solidification processes (with the SCHEIL module) of'
Fe-based or Cr-based alloys (but limited within the Fe-Cr-C ternary system in this DEMO version). Many unique features of the TCC/TCW software can be demonstrated using this and other specially-designed DEMO databases.

However, this DFeCrC database (similar to other DEMO and/or PUBLIC TC databases) is provided within the TCC-Demo/TCW-Demo software only for the purposes of demonstration, testing and evaluation. For R&D projects and teaching activities, you are highly encouraged to only use the FULL versions of the TCC and/or TCW software together with some commercial databases that are appropriate for your specific applications. Please contact us for all kinds of details.

Release History:
Version 1.1 with minor improvements, Oct. 2004
Version 1.2 with minor modifications, Oct. 2006

Edited by: Dr. Pingfang Shi (Thermo-Calc Software, Oct. 2006).

$---------------------------------------------------------------------$
$VERSION_DATE Last update and adjustment: Pingfang Shi, 2004-10-05!
VERSION_DATE Last update and adjustment: Pingfang Shi, 2006-10-25!

$---------------------------------------------------------------------$
$ Definition of Elements in the Database System: $

$SELEM NAME STABLE_ELEMENT_REF ATOMIC MASS H298-H0 S298 !$

$ELEMENT /- ELECTRON_GAS 0.0000E+00 0.0000E+00 0.0000E+00!$
ELECTRON VA VACUUM 0.0000E+00 0.0000E+00 0.0000E+00!
ELECTRON C GRAPHITE 1.2011E+01 1.0540E+03 5.7400E+00!
ELECTRON CR BCC_A2 5.1996E+01 4.0500E+03 2.3560E+01!
ELECTRON FE BCC_A2 5.5847E+01 4.4890E+03 2.7280E+01!

$---------------------------------------------------------------------$
$ TYPE_DEFINITIONS for data inclusions: $

TYPE_DEFINITION % SEQ *!
$ TYPE_DEFINITIONS for phase descriptions:
$---------------------------------------------------------

$... For magnetic contributions:
TYPE_DEFINITION A GES AMEND_PHASE_DES @ MAGNETIC -1.0 4.00000E-01 !
TYPE_DEFINITION B GES AMEND_PHASE_DES @ MAGNETIC -3.0 2.80000E-01 !

$... For Cr/Fe-C in FCC phase and Cr/Fe-C in HCP phase:
TYPE_DEFINITION C IF(C) THEN GES AMEND_PHASE_DES @ C_S , , :C: !

$

$ Default Commands:
$---------------------------------------------------------

$DEFINE_SYSTEM_DEFAULT SPECIES 2 !
DEFINE_SYSTEM_DEFAULT ELEMENT 2 !

DEFAULT_COMMAND DEF_SYS_ELEMENT VA !

$

$ FUNCTIONS for various phases:
$---------------------------------------------------------

$ FUNCT GHSERCC 298.15 -17368.441+170.73*T-24.3*T*LN(T)
-4.723E-04*T**2+2562600*T**(1-2.643E+08*T**(2)
+1.2E+10*T**(2); 6000 N!
FUNCT GHSERCR 298.15 -8856.94+157.48*T-26.908*T*LN(T)
+.00189435*T**2-1.47721E-06*T**3+139250*T**(1-1); 2180 Y
-34869.344+344.18*T-50*T*LN(T)-2.88526E+32*T**(1-9); 6000 N!
FUNCT GHSERFE 298.15 +1225.7+124.134*T-23.5143*T*LN(T)
-.00439752*T**2-5.8927E-08*T**3+77359*T**(1-1); 1811.00 Y
-25383.581+299.3125*5*T-46*T*LN(T)+2.29603E+31*T**(9); 6000 N!

FUNCT GFELIQ 298.15 +GHSERFE#+12040.17-6.55843*T
\begin{verbatim}
-3.6751551E-21*T**7; 1811 Y
-10839.7+291.302*T-46*T*LN(T); 6000 N!
FUNCT GFEFCC 298.15 +GHSERFE#-1462.4+8.282*T
-1.15*T*LN(T)+6.4E-04*T**2; 1811 Y
-27098.26+300.25256*T-46*T*LN(T)+2.78854E+31*T**(-9); 6000 N!
FUNCT GFECEM 298.15 +GPCEM1#-10745+706.04*T
-120.6*T*LN(T); 6000 N!
FUNCT GFEM23C6 298.15 +7.666667*GFECEM#-1.666667*GHSERCC#
+66920-40*T; 6000 N!

FUNCT GCRFCC 298.15 +GHSERCR#+7284+.163*T; 6000 N!
FUNCT GCRM23C6 298.15 -521983+3622.24*T-620.965*T*LN(T)
-.126431*T**2; 6000 N!
FUNCT GCRM3C2 298.15 -100823.8+530.66989*T
-89.6694*T*LN(T)-.0301188*T**2; 6000 N!
FUNCT GCRM7C3 298.15 -201690+1103.128*T
-190.177*T*LN(T)-.0578207*T**2; 6000 N!

FUNCT GPCLIQ 298.15 +YCLIQ#*EXP(ZCLIQ#); 6000 N!
FUNCT ACLIQ 298.15 +2.32E-05*T+2.85E-09*T**2; 6000 N!
FUNCT BCLIQ 298.15 +1+3.2E-10*P; 6000 N!
FUNCT CCLIQ 298.15 1.6E-10; 6000 N!
FUNCT DCLIQ 298.15 +1*LN(BCLIQ#); 6000 N!
FUNCT ECLIQ 298.15 +1*LN(CCLIQ#); 6000 N!
FUNCT VCLIQ 298.15 +7.626E-06*EXP(ACLIQ#); 6000 N!
FUNCT XCLIQ 298.15 +1*EXP(.5*DCLIQ#)-1; 6000 N!
FUNCT YCLIQ 298.15 +VCLIQ#*EXP(-ECLIQ#); 6000 N!
FUNCT ZCLIQ 298.15 +1*LN(XCLIQ#); 6000 N!

FUNCTGPCGRA 298.15 +YCGRA#*EXP(ZCGRA#); 6000 N!
FUNCTACGRA 298.15 +2.32E-05*T+2.85E-09*T**2; 6000 N!
FUNCTBCGRA 298.15 +1+3.6E-10*P; 6000 N!
FUNTTCGRA 298.15 3.3E-10; 6000 N!
FUNCTDCGRA 298.15 +1*LN(BCGRA#); 6000 N!
FUNCTECGRA 298.15 +1*LN(CCGRA#); 6000 N!
FUNCTVCGRA 298.15 +5.259E-06*EXP(ACGRA#); 6000 N!
FUNCTXCGRA 298.15 +1*EXP(.9166667*DCGRA#)-1; 6000 N!
FUNCTYCGRA 298.15 +VCGRA#*EXP(-ECGRA#); 6000 N!
\end{verbatim}
FUNCTION ZCGRA  298.15 +1*LN(XCGRA#);  6000 N!
FUNCTION GPCFCC  298.15 +YCFCC#*EXP(ZFEFCC#);  6000 N!
FUNCTION ACFCC  298.15 +1.44E-04*T;  6000 N!
FUNCTION VCFCC  298.15 +1.031E-05*EXP(ACFCC#);  6000 N!
FUNCTION YCFCC  298.15 +VCFCC#*EXP(-EFEFCC#);  6000 N!
FUNCTION GPCRLIQ  298.15 +YCRLIQ#*EXP(ZCRLIQ#);  6000 N!
FUNCTION ACRLIQ  298.15 +1.7E-05*T+9.2E-09*T**2;  6000 N!
FUNCTION BCRLIQ  298.15 3.72E-11;  6000 N!
FUNCTION DCRLIQ  298.15 +1*LN(BCRLIQ#);  6000 N!
FUNCTION ECRLIQ  298.15 +1*LN(CCRLIQ#);  6000 N!
FUNCTION VCRRLIQ  298.15 +7.653E-06*EXP(ACRLIQ#);  6000 N!
FUNCTION XCRRLIQ  298.15 +1*EXP(.8*DCRLIQ#)-1;  6000 N!
FUNCTION YCRRLIQ  298.15 +VCRRLIQ#*EXP(-ECRLIQ#);  6000 N!
FUNCTION ZCRRLIQ  298.15 +1*LN(XCRRLIQ#);  6000 N!
FUNCTION GPFELIQ  298.15 +YFELIQ#*EXP(ZFELIQ#);  6000 N!
FUNCTION AFELIQ  298.15 +1.135E-04*T;  6000 N!
FUNCTION BFELIQ  298.15 +1+4.98009787E-12*P+3.20078924E-417*T*P;  6000 N!
FUNCTION CFELIQ  298.15 +4.22534787E-12+2.71569924E-14*T;  6000 N!
FUNCTION DFELIQ  298.15 +1*LN(BFELIQ#);  6000 N!
FUNCTION EFELIQ  298.15 +1*LN(CFELIQ#);  6000 N!
FUNCTION VFELIQ  298.15 +6.46677E-06*EXP(AFELIQ#);  6000 N!
FUNCTION XFELIQ  298.15 +1*EXP(.8484467*DFELIQ#)-1;  6000 N!
FUNCT YFELIQ  298.15 +VFELIQ#*EXP(-EFELIQ#); 6000 N!
FUNCT ZFELIQ  298.15 +1*LN(XFELIQ#); 6000 N!

FUNCT GPFEFCC  298.15 +YFELIQ#*EXP(ZFELIQ#); 6000 N!
FUNCT AFEFCC  298.15 +7.3097E-05*T; 6000 N!
FUNCT BFEFCC  298.15 +1+3.25236341E-11*1+3.36607808E-16*T*P; 6000 N!
FUNCT CFEFCC  298.15 +2.62285341E-11+2.71455808E-16*T; 6000 N!
FUNCT DFEFCC  298.15 +1*LN(BFEFCC#); 6000 N!
FUNCT EFEFCC  298.15 +1*LN(CFEFCC#); 6000 N!
FUNCT VFEFCC  298.15 +1*EXP(.8064454*DFEFCC#)-1; 6000 N!
FUNCT YFEFCC  298.15 +YFELIQ#*EXP(-EFELIQ#); 6000 N!
FUNCT ZFEFCC  298.15 +1*LN(XFEFCC#); 6000 N!

FUNCT GPFEFCC  298.15 +YFELIQ#*EXP(ZFELIQ#); 6000 N!
FUNCT AFEFCC  298.15 +2.3987E-05*T+1.2845E-08*T**2; 6000 N!
FUNCT BFEFCC  298.15 +1+2.80599565E-11*1+3.06481523E-16*T*P; 6000 N!
FUNCT CFEFCC  298.15 +2.20949565E-11+2.41329523E-16*T; 6000 N!
FUNCT DFEFCC  298.15 +1*LN(BFEFCC#); 6000 N!
FUNCT EFEFCC  298.15 +1*LN(CFEFCC#); 6000 N!
FUNCT VFEFCC  298.15 +7.042095E-06*EXP(AFEFCC#); 6000 N!
FUNCT XFEFCC  298.15 +1*EXP(.7874195*DFEFCC#)-1; 6000 N!
FUNCT YFEFCC  298.15 +YFELIQ#*EXP(-EFELIQ#); 6000 N!
FUNCT ZFEFCC  298.15 +1*LN(XFEFCC#); 6000 N!

FUNCT GPFEHCP  298.15 +YFELIQ#*EXP(ZFELIQ#); 6000 N!
FUNCT AFEHCP  298.15 +7.3646E-5*T; 6000 N!
FUNCT BFEHCP  298.15 +1+3.25236341E-12*1+3.36607808E-16*T*P; 6000 N!
FUNCT CFEHCP  298.15 +26.2285341E-12+2.71455808E-16*T; 6000 N!
FUNCT DFEHCP  298.15 +LOG(BFEHCP#); 6000 N!
FUNCT EFEHCP  298.15 +LOG(CFEHCP#); 6000 N!
FUNCT VFEHCP  298.15 +6.59121E-6*EXP(AFEHCP#); 6000 N!
FUNCT XFEHCP  298.15 +EXP(0.8064454*DFEHCP#)-1; 6000 N!
FUNCT YFEHCP  298.15 +YFELIQ#*EXP(-1*EFELIQ#); 6000 N!
FUNCT ZFEHCP  298.15 +LOG(XFEHCP#); 6000 N!

FUNCT GPCEM1  298.15 +VCEM1##P; 6000 N!
Define the various Phase and their Constituents, and Assign parameters to phases:

*** LIQUID (Solution) *******************************************
PHASE LIQUID:L 1 1.0
  > This is metallic liquid solution phase, with C species!
CONST LIQUID:L : C,CR,FE :

PARAM G(LIQUID,C;0) 298.15 +GHSERCC#+GPCLIQ#
  +117369-24.63*T; 6000 N REF0 !
PARAM G(LIQUID,CR;0) 298.15 +GHSERCR#+GPCRLIQ#
  +24339.955-11.420225*T+2.37615E-21*T**7; 2180 Y
  +GHSERCR#+GPCRLIQ#
  +18409.36-8.563683*T+2.88526E+32*T**(-9); 6000 N REF0 !
PARAM G(LIQUID,FE;0) 298.15 +GFELIQ#+GPFELIQ#; 6000 N REF0 !
$***** FCC_A1 (Solution) ......................................................................................
$PHASE FCC_A1 %BC 2 1 1!
$ Note the C TYPE_DEF for 2nd FCC composition-set (MC) is not necessary
$ for the (Fe,Cr)-C system.
PHASE FCC_A1 %B 2 1 1!
CONST FCC_A1 : CR,FE%
    : C,VA% : !

PARAM G(FCC_A1,CR:VA;0) 298.15 +GCRFCC#+GPCRBCC#; 6000 N REF0 !
PARAM TC(FCC_A1,CR:VA;0) 298.15 -1109; 6000 N REF0 !
PARAM BMAGN(FCC_A1,CR:VA;0) 298.15 -2.46; 6000 N REF0 !
PARAM G(FCC_A1,FE:VA;0) 298.15 +GFEFCC#+GPFEFCC#; 6000 N REF0 !
PARAM TC(FCC_A1,FE:VA;0) 298.15 -201; 6000 N REF0 !
PARAM BMAGN(FCC_A1,FE:VA;0) 298.15 -2.1; 6000 N REF0 !

PARAM G(FCC_A1,CR:C;0) 298.15 +GHSERCR#+GHSERCC#
    +1200-1.94*T; 6000 N REF2 !
PARAM G(FCC_A1,FE:C;0) 298.15 +GFEFCC#+GHSERCC#+GPCFCC#
    +77207-15.877*T; 6000 N REF3 !
PARAM TC(FCC_A1,FE:C;0) 298.15 -201; 6000 N REF3 !
PARAM BMAGN(FCC_A1,FE:C;0) 298.15 -2.1; 6000 N REF3 !

PARAM L(FCC_A1,CR:C,VA;0) 298.15 -11977+6.8194*T; 6000 N REF2 !
PARAM L(FCC_A1,FE:C,VA;0) 298.15 -34671; 6000 N REF3 !
PARAM L(FCC_A1,CR,FE:VA;0) 298.15 +10833-7.477*T; 6000 N REF4 !
PARAM L(FCC_A1,CR,FE:VA;1) 298.15 +1410; 6000 N REF4 !
PARAM L(FCC_A1,CR,FE:C;0) 298.15 -74319+3.2353*T; 6000 N REF2 !

$***** BCC_A2 (Solution) ......................................................................................
PHASE BCC_A2 %A 2 1 3!
CONST BCC_A2 : CR%,FE%
    : C,VA% : !

PARAM G(BCC_A2,CR:VA;0) 298.15 +GHSERCR#+GPCRBCC#; 6000 N REF0 !
PARAM TC(BCC_A2,CR:VA;0) 298.15 -311.5; 6000 N REF0 !
PARAM BMAGN(BCC_A2,CR:VA;0) 298.15  -.01; 6000 N REF0 !
PARAM G(BCC_A2,FE:VA;0) 298.15 +GHSERFE#+GPFEBCC#; 6000 N REF0 !
PARAM TC(BCC_A2,FE:VA;0) 298.15 1043; 6000 N REF0 !
PARAM BMAGN(BCC_A2,FE:VA;0) 298.15 2.22; 6000 N REF0 !

PARAM G(BCC_A2,CR:C;0) 298.15 +GHSERCR#+3*GHSERCC#+GPFEBCC#+3*GPCGRA#
                           +416000; 6000 N REF0 !
PARAM TC(BCC_A2,CR:C;0) 298.15  -311.5; 6000 N REF1 !
PARAM BMAGN(BCC_A2,CR:C;0) 298.15  -0.08; 6000 N REF1 !
PARAM G(BCC_A2,FE:C;0) 298.15 +GHSERFE#+3*GHSERCC#+GPFEBCC#+3*GPCGRA#
                           +322050+75.667*T; 6000 N REF3 !
PARAM TC(BCC_A2,FE:C;0) 298.15 1043; 6000 N REF3 !
PARAM BMAGN(BCC_A2,FE:C;0) 298.15 2.22; 6000 N REF3 !

$ PF-20061025: Modify the L(BCC_A2,FE:C;0) [and L(BCC_A2,CR:C,VA;0)] !
$ parametera, in order to avoid BCC-appearance (Fe-C) !
$ at temperatures higher than 3900 K. !
$PARAM L(BCC_A2,CR:C,VA;0) 298.15 -190*T; 6000 N REF1 !
PARAM L(BCC_A2,CR:C,VA;0) 298.15 -190*T; 3000 Y 0; 6000 N REFS !
$PARAM L(BCC_A2,FE:C,VA;0) 298.15 -190*T; 6000 N REF3 !
PARAM L(BCC_A2,FE:C,VA;0) 298.15 -190*T; 3900 Y 0; 6000 N REFS !
$
PARAM L(BCC_A2,CR,FE:VA;0) 298.15 +205000-9.68*T; 6000 N REF4 !
PARAM TC(BCC_A2,CR,FE:VA;0) 298.15 1650; 6000 N REF4 !
PARAM TC(BCC_A2,CR,FE:VA;1) 298.15  550; 6000 N REF4 !
PARAM BMAGN(BCC_A2,CR,FE:VA;0) 298.15  -.85; 6000 N REF4 !

PARAM L(BCC_A2,CR,FE:C;0) 298.15 -1250000+667.7*T; 6000 N REF2 !
PARAM TC(BCC_A2,CR,FE:C;0) 298.15 1650; 6000 N REF5 !
PARAM TC(BCC_A2,CR,FE:C;1) 298.15  550; 6000 N REF5 !
PARAM BMAGN(BCC_A2,CR,FE:C;0) 298.15  -.85; 6000 N REF5 !

$***** HCP_A3 (Solution) *************************************************
$PHASE HCP_A3  %BC  2 1 .5 !
$ Note the C TYPE_DEF for 2nd HCP composition-set (M2C) is not necessary !
$ for the (Fe,Cr)-C system.
PHASE HCP_A3  %B  2 1 .5 !
CONST HCP_A3 : CR,FE,
            : VA%,C :

PARAM G(HCP_A3,CR:VA;0) 298.15 +GHSERCR#+4438; 6000 N REF1 !
PARAM TC(HCP_A3,CR:VA;0) 298.15 -1109; 6000 N REF1 !
PARAM BMAGN(HCP_A3,CR:VA;0) 298.15 -2.46; 6000 N REF1 !
PARAM G(HCP_A3,FE:VA;0) 298.15 +GHSERFE#+GFEHCP#
         -3705.78+12.591*T-1.15*T*LN(T)+6.4E-04*T**2; 1811 Y
         +GHSERFE#+GFEHCP#
         -3957.199+5.24951*T+4.9251E+30*T**(-9); 6000 N REF0 !
PARAM G(HCP_A3,CR:C;0) 298.15 +GHSERCR#+.5*GHSERCC#
         -18504+9.4173*T-2.4997*T*LN(T)+.001386*T**2; 6000 N REF1 !
PARAM G(HCP_A3,FE:C;0) 298.15 +GFEFCC#+.5*GHSERCC#+GPCFCC#
                     +52905-11.9075*T; 6000 N REF3 !
PARAM L(HCP_A3,CR:C,VA;0) 298.15 +4165; 6000 N REF1 !
PARAM L(HCP_A3,FE:C,VA;0) 298.15 -22126; 6000 N REF3 !
$PARAM L(HCP_A3,FE:C,VA;0) 298.15 -17335; 6000 N TCFE3 !
PARAM L(HCP_A3,CR,FE:VA;0) 298.15 +10833-7.477*T; 6000 N REF4 !

$***** SIGMA (Solution) ****************************************
PHASE SIGMA  % 3 8 4 10 !
CONST SIGMA : FE
            : CR
            : CR,FE : !

PARAM G(SIGMA,FE:CR:CR;0) 298.15 +8*GFEFCC#+22*GHSERCR#
                   +92300-95.96*T+GPSIG1#; 6000 N REF4 !
PARAM G(SIGMA,FE:CR:FE;0) 298.15 +8*GFEFCC#+4*GHSERCR#+18*GHSERFE#
                   +117300-95.96*T+GPSIG2#; 6000 N REF4 !

$***** CEMENTITE (Solution) ****************************************
PHASE CEMENTITE % 2 3 1 !
CONST CEMENTITE : CR,FE%
            : C : !

PARAM G(CEMENTITE,CR:C;0) 298.15 +3*GHSERCR#+GHSERCC#
-48000-9.2888*T; 6000 N REF2 !
PARAM G(CEMENTITE,FE:C;0) 298.15 +GFECEM#; 6000 N REF3 !
PARAM L(CEMENTITE,CR,FE:C;0) 298.15 +25278-17.5*T; 6000 N REF2 !

$***** M3C2 (Compound) **********************************************
PHASE M3C2 % 2 3 2 !
CONST M3C2 : CR
: C : !
PARAM G(M3C2,CR:C;0) 298.15 +GCRM3C2#; 6000 N REF2 !

$***** M7C3 (Solution) **********************************************
PHASE M7C3 % 2 7 3 !
CONST M7C3 : CR%,FE
: C : !
PARAM G(M7C3,CR:C;0) 298.15 +GCRM7C3#; 6000 N REF2 !
PARAM G(M7C3,FE:C;0) 298.15 +7*GHSERFE#+3*GHSERCC#
 +75000-48.2168*T; 6000 N REF2 !
PARAM L(M7C3,CR,FE:CR:C;0) 298.15 -4520-10*T; 6000 N REF2 !

$***** M23C6 (Solution) **********************************************
PHASE M23C6 % 3 20 3 6 !
CONST M23C6 : CR%,FE%
: CR%,FE%
: C : !
PARAM G(M23C6,CR:CR:C;0) 298.15 +GCRM23C6#; 6000 N REF5 !
PARAM G(M23C6,FE:CR:C;0) 298.15 +.1304348*GCRM23C6#
 +.8695652*GFEM23C6#; 6000 N REF5 !
PARAM G(M23C6,CR:FE:C;0) 298.15 +.8695652*GCRM23C6#
 +.1304348*GFEM23C6#; 6000 N REF5 !
PARAM G(M23C6,FE:FE:C;0) 298.15 +GFEM23C6#; 6000 N REF5 !
PARAM L(M23C6,CR,FE:CR:C;0) 298.15 -205342+141.6667*T; 6000 N REF2 !
PARAM L(M23C6,CR,FE:FE:C;0) 298.15 -205342+141.6667*T; 6000 N REF2 !

$***** GRAPHITE (Compound) **********************************************
PHASE GRAPHITE % 1 1.0 !
CONST GRAPHITE : C : !

PARAM G(GRAPHITE,C;0) 298.15 +GHSERCC#+GPCGRA#; 6000 N REF0 !

$

$ ASSESSED_SYSTEMS information:
$ * necessary for the BIN and TERN modules in TCC
$ the Binary Phase Diagram module in TCW
$ and the Equilibrium calculation routine in TCW
$----------------------------------------------

ASSESSED_SYSTEM

$... Binary ...
C-FE(;P3 TMM:300/4000 *)
C-CR(;P3 TMM:300/4000 *)
CR-FE(;G5 MAJ:BCC/FE:VA C_S:BCC/CR:VA
 ;P3 TMM:300/3000 STP:.6/1200/1/-2/2)
$ CR-FE(TDB -HCP ;G5 MAJ:BCC/FE:VA C_S:BCC/CR:VA
$ ;P3 TMM:300/3000 STP:.6/1200/1/-2/2)
$

$... Ternary ...
C-CR-FE(;G5 MAJ:BCC/FE:VA C_S:BCC/CR:VA
 ;P3 STP:.4/.5/1 STP:0.1/0.5/1)
!

$

$ LIST OF REFERENCE:
$

$-----------------------------------------------
LIST_OF_REFERENCES
NUMBER SOURCE

REF1 'J-O Andersson, Calphad Vol 11 (1987) p 271-276, TRITA 0314; C-CR'

REF2 'Byeong-Joo Lee, unpublished revision (1991); C-Cr-Fe-Ni'

   TRITA 0237 (1984); C-FE'

   TRITA 0270 (1986); CR-FE'

   TRITA 0207 (1986); C-CR-FE'

REFS 'Pingfang Shi (2006), TCS PTERN Public Ternary Alloys Database, v1.2; Modified L0(BCC,Fe,C) and L0(BCC,Cr,C) parameters at high temperatures.'
The Database Checker

In this section:

About the Database Checker ................................................................. 70
Database Checker Revision History .................................................... 70
About the Database Checker

The Thermo-Calc software package includes a program to check that the syntax of unencrypted database files is correct. The program applies the syntax rules set out in the *Database Manager User Guide* and reports errors and issues warnings. This program is intended for advanced users who develop and manage databases.

Thermo-Calc accepts deviations from these syntax rules. This means that a database can work even if the Database Checker reports errors and warnings. For example, an error is reported if an abbreviated phase name is found, but phase name abbreviations are accepted by Thermo-Calc and its add-on modules.

The executable DatabaseChecker file is found in the Thermo-Calc home directory. The program can also be launched by selecting **Tools→Database Checker** from the main menu. "Database Checker Revision History" below for releases notes that may assist database developers.

Database Checker Revision History

The DatabaseChecker application is standalone and need not be installed separately, just download the containing zip file, open it and follow the instructions in the README.TXT file. The program requires that Java is installed on the target machine. Please note that large amounts of RAM may be required when checking large databases.
Release Notes Version 1.4

- The DatabaseChecker user interface has been modified to allow checking of several database files in one batch. Instead of selecting an individual database file, the user now selects a directory that contains databases. The application then shows a tree structure with all database files in the chosen directory and its subdirectories. The user may then select any number of these files for processing.

- A check of parameters whose interaction order is 3 has been introduced. For such parameters, there must either exist one parameter with the interaction degree 0 or three parameters with the interaction degrees 0, 1 and 2.

- To facilitate optimization of databases, the tool now generates information messages about functions and parameters that will always return 0.

Release Notes, Version 1.3.2

- The tool now detects conflicts between identical parameters even if one of them have been defined with the G prefix and the other with the L prefix.

Release Notes, Version 1.3

A bug prevented integers bigger than 32 bits from being parsed. This has been corrected.

The tool now checks that the species and number of sublattices used in parameter definitions match the phase definition and generates an error message for every mismatch. Ionic liquid parameters are currently exempted from this check as not to break the widespread use of defining only one constituent for ionic liquid parameters.

Type definitions and case statements are now parsed for errors. However, only a subset of all possible GES, POLY and TDB commands are accepted and all other commands will result in an error message. The accepted commands are:

- GES AMEND_PHASE_DESCRIPTION
- COMPOSITION_SETS
- MAJOR_CONSTITUENTS
- DISORDERED_PART
- MAGNETIC_ORDERING
- STATUS_BITS
- DEFAULT_STABLE
• FRACTION_LIMITS
• EXCESS_MODEL
• REDLICH-KISTER_MUGGIANU
• HKF
• HKF_ELECTROSTATIC
• DEBYE_HUCKEL
• GES_CHANGE_STATUS
• TDB_DEFINE_SYSTEM_ELEMENTS
• TDB_RESTORE_PHASES
• TDB_REJECT_PHASES

Some improvements to warning and error messages have been made to facilitate finding errors.

**Release Notes, Version 1.2**

• The tool now uses parallel processing of database files on multi-core systems. This significantly improves performance when large databases are checked.

• It is no longer required that inter-dependent database statements are defined in a specific order in the database file (e.g., species need not any longer be defined before the elements on which they depend). However, for the sake of readability, it is still advised that the database statements occur in a natural order in the file.

• Because of the parallel processing of database statements, multiple definition errors (cases where one name has been used to define more than one entity in the database e.g, two identically named species) may now be generated for any of the violating occurrences and not only for the last occurrence in the file.

**Release Notes, Version 1.1**

• Phase names were not properly recognized in parameter definitions if there was one or more whitespace characters between the opening parenthesis and the phase name. This has been corrected.

• The error message Could not parse parameter, <species name> has been given without a sublattice number but is defined in more than one sublattice is now displayed only for phases where the general diffusion model is used. Note: this implementation is temporary and may be subject to changes later.
• The meaning of the information message The phase <phase name> expects the following parameters: [<parameter names>] was unclear to users. It is now longer shown for the parameter names T and P. For all other names, the message is now displayed as an error message with the following text: The phase <phase name> contains references to the following undefined functions: [<function names>].

• The tool now looks for function names that are abbreviations of other function names and warns about this, since abbreviated names may cause problems during the execution of macro files that have been auto-generated from GES.

• The tools also warns for functions whose names are in the format V<integer>, since this may cause conflicts with names that are used by PARROT.

• Parameter names are now shown in a format that is less cryptic and more resembles the format used in the database. However, the format of diffusion parameters may still differ somewhat from what is used in the database.

Release Notes, Version 1.0

• The tool parses a TDB file and produces a log with error, warning and information messages about the state of the file

• The message log can be exported and saved as a separate file for later analysis

• The tool is based on the database command definitions given in TC_Database_ManagersGuide and DICTRA27_UsersGuide. All commands in these documents are supported. Some undocumented DIFFUSION commands are not supported.

• Databases that span several files are correctly handled, also blocked files

• The tool is in some aspects more strict than required by the guides (see Additional Information below)

• The tool performs the following checks:
  • Syntax control of database statements: ERROR
  • Line size: ERROR or WARNING depending on context
  • Multiply defined elements, species or phases: ERROR
  • Multiply defined functions and parameters: ERROR
  • Multiply defined assessed system: ERROR
  • Multiply defined references: ERROR
  • References entries that are never used: WARNING
  • References to non-existent type definitions: ERROR
  • Type definitions that are never used: WARNING
• Unused functions and parameters: WARNING
• Functions and parameters with undefined references: WARNING
• References to undefined elements, species or phases: ERROR
• Dependencies to external names from a phase: INFORMATION. (All parameters of a phase are evaluated with respect to their dependencies to other parameters and functions and all unresolved names are listed. Typically, this should only yield dependencies on T and possibly P)

**Additional Information**

In addition to the command definitions given in the user guides listed above, the following rules are also applied:

• Names are case-sensitive, meaning that e.g., the defined element MN cannot be referred to under the name Mn;
• Phase names cannot be abbreviated. When referred to in parameter descriptions their full names must be used.
DATAPLOT User Guide

Thermo-Calc Version 2017a
Introduction to the DATAPLOT User Guide

In this section:

Using this Guide ................................................................. 3
About the DATAPLOT Graphical Language .......................... 3
DATAPLOT Examples ............................................................. 3
Using this Guide

The DATAPLOT User Guide gives all the details on the graphical language DATAPLOT that a phase diagram or property diagram calculated by Thermo-Calc or a kinetic profile simulated by the Diffusion Module (DICTRA) can be defined.

This guide

- Discusses the important features of the DATAPLOT language.
- Describes the commands to define PROLOGUE and DATASET.
- Several examples and the standard codes for formatting are provided.

A topic introduce the method of formatting DIGLIB symbols in LaTeX documents, for the purpose of necessarily/appropriately referring to the corresponding LaTeX symbols (closest to those DIGLIB symbols which have been plotted on a diagram using the DATAPLOT Graphical Language) in the texts of LaTeX documents for publications/reports.

About the DATAPLOT Graphical Language

In order to obtain graphical output of any numerical data and informative strings, a graphical language called DATAPLOT was developed in connection with the graphical software DIGLIB. Using this graphical language, you can store information in a normal text file (*.EXP), which can be plotted as graphical symbols, lines, texts or Greek letters on any plot device support by DIGLIB.

You can generate and plot DATAPLOT (*.EXP) files together with various calculation and/or experimental results from, for example, phase and property diagrams calculated with the Thermo-Calc software composition profiles or other diagrams simulated by the Diffusion Module (DICTRA).

An EXP file automatically generated by the POST-processor (using the "MAKE_EXPERIMENTAL_DATAFILE" on page 252 command) in the Thermo-Calc software is a DATAPLOT (*.EXP) file and may contain all types of legal DATAPLOT commands and parameters. With a text editor, you can modify or add some DATAPLOT commands and related parameters in an existing EXP file. This is useful when appending experimental information to calculated/simulated plots, and when specifying user-defined texts, symbols, colors, fonts, filled patterns, diagram types, diagram sizes, symbol/character sizes, titles, special characters, etc.

DATAPLOT Examples

To help you prepare your EXP (experimental) files to use for your plotted diagrams generated by Thermo-Calc simulations, there are examples of EXP files using the DATAPLOT graphical language standard, which are normally independent of software versions.
Using DATAPLOT Graphical Language

In this section:

- DATAPLOT File Structure ................................................................. 5
- DATAPLOT Language Syntax ......................................................... 5
- Coordinate Systems ........................................................................ 5
- Graphical Operation Codes .............................................................. 6
- Tables or Blocks ................................................................................ 7
- Drawing a Polygon .......................................................................... 8
- Drawing an Analytical Function ...................................................... 8
- Painting of an Enclosed Area ........................................................... 8
- Writing a Text .................................................................................. 8
- Plotting a Symbol ........................................................................... 9
- Other Commands ............................................................................. 10
- Interactive Plotting .......................................................................... 11
- Formatting DIGLAB Symbols in LaTeX Documents ......................... 11
- LaTeX Formatting Codes ................................................................. 12
- LTEXT vs LaTeX Commands for Labels ............................................ 13
DATAPLOT File Structure

A DATAPLOT file is a normal text file with the extension EXP that can be created with a text editor or by a program. The file must contain one or more DATASETS and possibly also one or more PROLOGUES. Each PROLOGUE/DATASET is an entity that can be individually selected for plotting.

A PROLOGUE/DATASET is identified by a unique positive number in the file. A PROLOGUE normally contains various DATASET commands for defining information about axis scaling, axis text, axis length, title and so on. A PROLOGUE is terminated by another PROLOGUE or by the first DATASET. This means that all PROLOGUES must be placed at the beginning of the file, before the first DATASET.

A DATASET normally contains DATASET commands that are associated to separate data points, as well as with one or more BLOCKS of data (calculated or experimental). A DATASET is terminated by another DATASET command or the end of file.

DATAPLOT Language Syntax

The DATAPLOT language consists of commands with or without parameters:

    COMMAND {parameter(s)}

The basic graphical command consists of an X/Y coordinate pair and a Graphical Operation Code (GOC). With other commands, the interpretation of this basic command can be modified. There are separate commands to draw a polygon or a function and ways to get texts in different fonts.

To edit a DATAPLOT file, the graphical commands can be abbreviated.

A command (with parameters) must not exceed 80 characters. If it is too long (normally as writing necessary codes in a command’s parameters for a complex expression), two or more lines can be edited.

Coordinate Systems

The DATAPLOT language accepts coordinates in three different coordinate systems, which are called word, virtual and normalized.

- The word coordinates are selected to represent any kind of data and be of “any” magnitude.
- The virtual coordinate system uses centimeters as units. However, the actual size of one unit is dependent on the implementation of the device driver in DIGLIB. It is not recommended to use this coordinate system if different output devices are used for preliminary and final plots.
• The normalized coordinate system goes from zero to one. When plotting, you interactively scale each axis by selecting the minimum and maximum word coordinates on the axis. In the normalized coordinate system, the minimum axis value is represented by zero and the maximum by one. DIGLIB draws a square between the four points (of the X and Y axes) that are determined by the coordinates zero and one in the normalized coordinates.

It is also possible to draw triangular plots as described below. However, in most places, it only references square diagrams. All data points within the minimum and maximum word coordinates are plotted inside this square. DIGLIB also writes tic marks and corresponding word values at such tic marks.

It may be convenient to use normalized coordinates to draw boxes and texts. You can give normalized coordinates outside zero and one if you want to write texts outside the area enclosed by the square. To ensure proper operation outside the normalized box, the clipping must be turned off.

**Graphical Operation Codes**

The Graphical Operation Code (GOC) determines how the coordinates are interpreted and what is done at the point determined by the coordinates. For an individual data point, its GOC codes must be given. For each data "BLOCK" on page 19, you define a default GOC that is used for the whole BLOCK, unless a GOC is explicitly defined for a specific point.

• If $s$ is omitted, no symbol is plotted. A number selecting the symbol can optionally follow the character $s$. The DIGLIB software determines which symbol the number represents. See "Plotting a Symbol" on page 9.

• If any of the other characters are omitted, the default defined for the BLOCK is used. Absolute values imply the current coordinates; relative values mean that these are added to the current coordinates. The GOC must be written without any space between various characters, but the order for the characters is irrelevant.

• If no GOC is defined for a BLOCK, the system default is \texttt{MWA}, (Move Word Absolute), i.e., move to the given point that is interpreted as absolute word coordinates.

$\text{GOC=DNA}$ means draw a line from the current point to the new one interpreting the coordinates as normalized. After each draw or move operation, the so-called current point is the new point.

• The "\texttt{TEXT}" on page 28 following the \texttt{?} command is interpreted and expanded by the DIGLIB software, if it includes any ^ operator or "\texttt{STRING}" on page 26 names using the ^ descriptor. To get PostScript outputs, the TEXT must be edited by the LaTeX Text Formatting Program instead (see "LaTeX Formatting Codes" on page 12).
GOC Character Definitions

The GOC is a combination of the following characters:

<table>
<thead>
<tr>
<th>Character</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>W, V or N</td>
<td>To use word (W), virtual (V) or normalized (N) coordinates. W is the default.</td>
</tr>
<tr>
<td>A or R</td>
<td>XY are absolute (A) or relative (R) values. A is the default.</td>
</tr>
<tr>
<td>M or D</td>
<td>To perform a move (M) or draw (D) operation to XY. M is the default.</td>
</tr>
<tr>
<td>B</td>
<td>To apply “soft” splines on a line drawn between the coordinate pairs (used only on BLOCK data).</td>
</tr>
<tr>
<td>S</td>
<td>To plot default symbol at XY.</td>
</tr>
<tr>
<td>S#</td>
<td>To change default symbol to No # symbol and plot it at XY.</td>
</tr>
<tr>
<td>'TEXT</td>
<td>To plot TEXT at XY. It must be the last operation in a GOC code. The TEXT following the ' command is interpreted and expanded by the DIGLIB software, if it includes any ^ operator or STRING names using the ~ descriptor.</td>
</tr>
</tbody>
</table>

Tables or Blocks

In many cases, you have (calculated or experimental) data in the form of tables, and want to plot one or several columns as X-axis and one or more columns as Y-axis. A single table can contain many sets of data records of the same kind of information for a specific data "BLOCK" on page 19. There can be many data BLOCKS in a "DATASET" on page 19.

By enclosing these tables in a data BLOCK, you can select which column(s) is the X-axis and which is the Y-axis. For example,

```
BLOCK X=C1; Y1=C3; Y2=C2; GOC=C4,DAW
```

Where the X-axis values are in column 1, the Y-axis values are in columns 2 and 3, and any GOC codes are in column 4. The default GOC for this BLOCK is Draw Absolute Word. The GOC code inside the table is only necessary if the default GOC is not applicable.

A more elaborate use of the table is shown in this example:

```
BLOCK X=C3; Y=1E3/(C3+273); GOC=C8,MAWS1
```

Where the X-axis values are in column 3, the Y-axis values are in column 1 with some additional calculations applied. Any GOC is in column 8, and the default GOC is Move Absolute Word and plot the symbol no. 1.
Columns in a table must be separated by one or more space characters and do not have to be justified.

It is possible to have tables with mixed text and numbers, but each word followed by a space is counted as one column. The columns used for plotting also must be numerical. An example of a legal line in a table is

298.15 This_is_the_second_column 11.5 This_is_the_fourth_column

A line in the table must not exceed 80 characters. A BLOCK must be terminated by a line with the "BLOCKEND" on page 20 command.

**Drawing a Polygon**

Normally, each point is written on a separate line. But in order to draw a line in a more compact way, use the command "DRAWLINE" on page 21. DRAWLINE is followed by a couple of X/Y number pairs. The X/Y pairs must be separated by a space, and there must be a comma sign between the X and Y values. DRAWLINE makes a move operation to the first pair of X/Y coordinates, and then draws a line among all pairs up to the last one. All pairs must fit on one line of 80 characters, but there can be several consequent DRAWLINE commands.

**Drawing an Analytical Function**

Use a "BLOCK" on page 19 command to set an axis to a function. It is not necessary to use a value from any column in order to compute the function value to be plotted. Use the "FUNCTION" on page 28 command to plot a function with an even increment of the independent variable.

**Painting of an Enclosed Area**

Use the "PAINT" on page 29 command to paint or fill an area in a specified pattern in the plot. Available patterns are determined by the DIGLIB software. A related command to PAINT is "PCFUNCTION" on page 28.

**Writing a Text**

Use the "TEXT" on page 28 command to write a text at the current point. You can write a text at any X/Y pair by appending a single quote followed by the text on the same line. For example:

```
1.1 1.0 NAM'This is a text
```

writes This is a text at the normalized coordinates (1.1, 1.0).
Use the command "**FONT** on page 24" to select the font used for the text, and "**CHARSIZE** on page 22" to select the size of the characters. Set this size of the symbols with "**SYMBOLSIZE** on page 22".

If a text or a single character should be of a different font than all the other text, or to use subscripts or superscripts in a text, use the ^ operators or STRING command to create the text. The command "**STRING** on page 26" stores the text in a specified variable that includes all text-formatting information defined by the DIGLIB software. See "**Example 3 – Using Strings and Various Line Types** on page 33" and "**Example 5 – Use Included Files for Predefined Symbols**" on page 35.

However, if a graphical output is done on a PostScript device using the PostScript hardcopy fonts, special text formatting codes as "**LaTeX Formatting Codes** on page 12" should be used and the STRING formatting syntax is then not valid.

**Plotting a Symbol**

As described in "**Graphical Operation Codes** on page 6", a GOC code in a data BLOCK may contain an S option to plot a symbol for an X/Y pair or the same symbols for the data BLOCK. A number selecting the symbol can optionally follow the character S. You can plot a symbol at any current X/Y position by appending a quote specified by the symbol number in the GOC code (e.g., 1.1 1.0 MANS'This is a text).

You can also insert DIGLIB symbols into LaTeX-edited documents.

**DIGLIB symbols available in Thermo-Calc**

The image summarizes all the standard symbols available in the DIGLIB software. A default symbol is the current symbol in the run of the software (it is usually the No 1 symbol if the POST-processor is switched on for the first time). S (i.e., # is not specified) means that the current symbol is plotted. SO (i.e., #=0) means that no symbol is plotted.

All the DIGLIB symbols work properly and give good output results for the PostScript format.
Other Commands

Use the "LINETYPE" on page 21 command to define line types as solid, long dashed, short dashed or dotted. If you are using a color device, use the "COLOR" on page 22 command to change color of the lines. On some black and white devices, colors are simulated with different width and dashing of the lines.

- Use the "CLIP" on page 20 command to change the default where all data outside the normalized coordinates zero and one are not plotted.
- When plotting symbols representing various experimental data, it is important that the symbols are centered around the coordinate values.
- Use the "ATTRIBUTE" on page 21 command to change the coordinates where text is displayed. The default is the lower left corner of the first character in the text.
- Use the "INCLUDE" on page 29 command to create libraries with texts and include these in similar plots.
- The dollar sign $ as the first character of a line stands for a comment character, which means the whole line is ignored when plotting.
Interactive Plotting

The DATAPLOT file is read into the POST module in the workspace with "APPEND_EXPERIMENTAL_DATA" on page 245 or "QUICK_EXPERIMENTAL_PLOT" on page 254. These commands ask for the name of the DATAPLOT file and also which PROLOGUE(S) and DATASET(S) are to be plotted.

See the Thermo-Calc Command Mode Reference Guide for details about these commands.

By giving the PROLOGUE/DATASET number as -1, you get a list of the available PROLOGUES/DATASETS in the file. Note that if DATASET 0 is in a DATAPLOT file, its data is always used even if other DATASETS are chosen.

Formatting DIGLAB Symbols in LaTeX Documents

When using the LaTeX editor, you can use the DIGLIB symbols in texts and in figures. This then refers to the corresponding LaTeX symbols (closest to those DIGLIB symbols which are plotted on a plot using the DATAPLOT Graphical Language) in the texts of LaTeX documents for publications/reports.

This topic shows how to generate some DIGLIB symbols in texts, through the attached LaTeX source file and its converted jpg file.

**DIGLIB_Sym.tex**

\documentclass[dvips,12pt]{article}
\textheight 225mm
\oddsidemargin 1mm
\evensidemargin 1mm
\topmargin 1mm

%%%usepackage{amssymb}
%%% next replace amssymb and to get udtimes
\usepackage[utopia]{mathdesign}
\usepackage{rotating}
\usepackage{latin1}[inputenc]
\usepackage{graphics}
\usepackage[graphicx,subfigure]% with figures
%%%usepackage[draft]{graphicx}% without figures
\usepackage{subfigure}% with figures
The information below gives the closest corresponding LaTeX symbol. All symbols (except +) must be generated in math mode. Most of these require the package `amssymb`, i.e., you need a directive `usepackage{amssymb}` in the preamble. Two of the symbols require the more extensive `mathdesign` that can be included with `usepackage[utopia]{mathdesign}`.

\begin{tabular}{llll}
Diglib & Latex & Latex name & Note\\
1 & $\vartriangle$ & $\backslash$vartriangle & amssymb \ \\
2 & $\square$ & $\backslash$square & \\
3 & {\Huge $\diamond$} & $\backslash$diamond & size $\backslash$Large \ \\
4 & $\udtimes$ & $\backslash$udtimes & mathdesign \ \\
5 & $\triangledown$ & $\backslash$triangledown & amssymb \ & 6 & + & normal + \ \\
7 & $\ast$ & $\backslash$ast & amssymb \ \\
8 & $\times$ & $\backslash$times & \\
9 & {\Huge $\circ$} & $\backslash$circ & size $\backslash$Large \ \\
10 & {\Huge $\star$} & $\backslash$star & amssymb \ & 11 & - & nothing similar, overlapping $> <$ \ \\
12 & $\Join$ & $\backslash$Join & \\
13 & - & nothing similar, overlapping $< >$ \ \\
14 & - & nothing similar, 10-edged star \ \\
15 & $\maltese$ & $\backslash$maltese & mathdesign \ \\
16 & - & nothing similar, a pentagon \ \\
17 & $\curlywedge$ & $\backslash$curlywedge & amssymb \ \\
{\end{tabular}

\end{document}

LaTeX Formatting Codes

For a list of supported LaTeX commands, see:
http://www2.ph.ed.ac.uk/snuggletex/documentation/math-mode.html
By default when using the LaTeX command, you are in math mode and Thermo-Calc automatically interprets the entered text as math. The above link uses the dollar sign ($) in all the examples but this is NOT required. For example, if you enter \$E=mc^2\$ this is displayed including the $\$ instead of the equation.

As of Thermo-Calc 2015a the LTEXT text formatting is replaced by LaTeX. For existing users who may have plots and files that use the LTEXT format, and especially when using Console Mode, the following examples show the command changes from LTEXT and its LaTeX equivalent:

### LTEXT vs LaTeX Commands for Labels

<table>
<thead>
<tr>
<th>Symbol or text format</th>
<th>LTEXT</th>
<th>LaTeX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subscripts in an axis text</td>
<td>S-A-TEXT Y N Mole-fraction Al^DO2$O^DO3$</td>
<td>S-A-TEXT Y N \text{Mole-fraction} Al_{2O_3}</td>
</tr>
<tr>
<td>Label with subscript</td>
<td>add .13 .15 n c-ZrO^DO2$</td>
<td>add .13 .15 n \text{c-ZrO}_2</td>
</tr>
<tr>
<td>Greek symbol</td>
<td>ADD .05 .50 N ^GRd$</td>
<td>ADD .05 .50 N \text{\delta}</td>
</tr>
</tbody>
</table>
## PROLOGUE Commands

In this section:

<table>
<thead>
<tr>
<th>Command</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>PROLOGUE</td>
<td>15</td>
</tr>
<tr>
<td>XSCALE</td>
<td>15</td>
</tr>
<tr>
<td>YSCALE</td>
<td>15</td>
</tr>
<tr>
<td>XTEXT</td>
<td>15</td>
</tr>
<tr>
<td>YTEXT</td>
<td>15</td>
</tr>
<tr>
<td>XTYPE</td>
<td>16</td>
</tr>
<tr>
<td>YTYPE</td>
<td>16</td>
</tr>
<tr>
<td>XLENGTH</td>
<td>16</td>
</tr>
<tr>
<td>YLENGTH</td>
<td>16</td>
</tr>
<tr>
<td>TIC_TYPE</td>
<td>16</td>
</tr>
<tr>
<td>TITLE</td>
<td>17</td>
</tr>
<tr>
<td>DIAGRAM_TYPE</td>
<td>17</td>
</tr>
</tbody>
</table>
**PROLOGUE**

PROLOGUE is the beginning of a number of consequent lines of user-defined diagram layout commands. The lines are displayed with the optional text when using the -l option in the POST-processor as prompted for the PROLOGUE number with "APPEND_EXPERIMENTAL_DATA" on page 245 or "QUICK_EXPERIMENTAL_PLOT" on page 254.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>PROLOGUE # optional text</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td># is an unsigned integer identifying the PROLOGUE.</td>
</tr>
</tbody>
</table>

**XSCALE**

XSCALE sets the scaling in word coordinates of the X-axis.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>XSCALE min max</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>min and max are real numbers.</td>
</tr>
</tbody>
</table>

**YSCALE**

YSCALE sets the scaling in word coordinates of the Y-axis.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>YSCALE min max</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>min and max are real numbers.</td>
</tr>
</tbody>
</table>

**XTEXT**

XTEXT sets the X-axis text.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>XTEXT text</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>text is an arbitrary text string that may contain text-formatting codes.</td>
</tr>
</tbody>
</table>

**YTEXT**

YTEXT sets the Y-axis text.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>Y TEXT text</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>text is an arbitrary text string that may contain text-formatting codes.</td>
</tr>
</tbody>
</table>
**XTYPE**

XTYPE sets the X-axis type as linear (default), logarithmic or inverse.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>XTYPE type</th>
</tr>
</thead>
<tbody>
<tr>
<td>type is a character string reading LIN, LOG or INV.</td>
<td></td>
</tr>
</tbody>
</table>

**YTYPE**

YTYPE sets the Y-axis type as linear (default), logarithmic or inverse.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>Y TYPE type</th>
</tr>
</thead>
<tbody>
<tr>
<td>type is a character string reading LIN, LOG or INV.</td>
<td></td>
</tr>
</tbody>
</table>

**XLENGTH**

XLENGTH sets the X-axis length to approximately # centimeters.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>XLENGTH #</th>
</tr>
</thead>
<tbody>
<tr>
<td># is a positive real number (the approximate X-axis length in centimeters).</td>
<td></td>
</tr>
</tbody>
</table>

**YLENGTH**

YLENGTH sets the Y-axis length to approximately # centimeters.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>Y LENGTH #</th>
</tr>
</thead>
<tbody>
<tr>
<td># is a positive real number (the approximate Y-axis length in centimeters).</td>
<td></td>
</tr>
</tbody>
</table>

**TIC_TYPE**

TIC_TYPE sets the relative length of the tic marks.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>TIC_TYPE #</th>
</tr>
</thead>
<tbody>
<tr>
<td># is a real number. Default value is 1. Negative number gives tics on the inside of the diagram frame. 0 gives no tics.</td>
<td></td>
</tr>
</tbody>
</table>
**TITLE**

TITLE sets the title text string to be printed above the diagram.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>TITLE text</th>
</tr>
</thead>
<tbody>
<tr>
<td>text</td>
<td>is an arbitrary text string that may contain text-formatting codes</td>
</tr>
</tbody>
</table>

**DIAGRAM_TYPE**

DIAGRAM_TYPE sets the diagram type to square (the default) or triangular.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>DIAGRAM_TYPE type plot_3rd_axis clip_along_third-axis</th>
</tr>
</thead>
<tbody>
<tr>
<td>type</td>
<td>is a character string reading SQUARE (default) or TRIANGULAR. If type reads TRIANGULAR, then two additional parameters are given: plot_3rd_axis and clip_along_third-axis that are characters strings reading YES or NO.</td>
</tr>
</tbody>
</table>
DATASET Commands

In this section:

DATASET ................................................................. 19
BLOCK ................................................................. 19
BLOCKEND ............................................................. 20
DATAPoint .............................................................. 20
CLIP ..................................................................... 20
ATTRIBUTE ............................................................ 21
LINETYPE ............................................................... 21
DRAWLINE ............................................................ 21
CHARSIZE .............................................................. 22
SYMBOLSIZE ......................................................... 22
GLOBALSIZE .......................................................... 22
COLOR ................................................................. 22
FONT ................................................................. 24
STRING ................................................................. 26
TEXT ................................................................. 28
FUNCTION ............................................................. 28
PCFUNCTION .......................................................... 28
PAINT ................................................................. 29
INCLUDE ............................................................... 29
DATASET

DATASET indicates the beginning of a number of consequent lines comprising a set of user-defined data. The DATASET lines are displayed on the terminal along with the optional text when using the -1 option in the POST-processor as prompted for the DATASET number in the "APPEND_EXPERIMENTAL_DATA" on page 245 or "QUICK_EXPERIMENTAL_PLOT" on page 254 command.

Syntax

<table>
<thead>
<tr>
<th>Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>DATASET # optional text</td>
</tr>
<tr>
<td># is an unsigned integer identifying this set of data.</td>
</tr>
</tbody>
</table>

BLOCK

BLOCK defines how the following numeric data block shall be interpreted. The definitions of X and Y coordinates may also be expressed as a function of the column values, making it possible to perform transformations.

Syntax

<table>
<thead>
<tr>
<th>Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>BLOCK X&amp;=C#; ...; Y&amp;=C#; ...; GOC=C#,@@@...</td>
</tr>
<tr>
<td>&amp;’ are optional unsigned integers that make it possible to plot several (maximum 9) X- or Y- axis columns. #’ are unsigned integers identifying the column numbers. The column number # in “GOC=C#” is the location of any possible GOC codes in the current data BLOCK; @@ stands for the default Graphical Operation Code (GOC) for the current BLOCK. The GOC code inside the current table is only necessary if the current default GOC is not applicable.</td>
</tr>
</tbody>
</table>

GOC Characters

The GOC is a combination of the following characters:

<table>
<thead>
<tr>
<th>Character</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>W, V or N</td>
<td>To use word (W), virtual (V) or normalized (N) coordinates. W is the default.</td>
</tr>
<tr>
<td>A or R</td>
<td>XY are absolute (A) or relative (R) values. A is the default.</td>
</tr>
<tr>
<td>M or D</td>
<td>To perform a move (M) or draw (D) operation to XY. M is the default.</td>
</tr>
<tr>
<td>Character</td>
<td>Meaning</td>
</tr>
<tr>
<td>-----------</td>
<td>---------</td>
</tr>
<tr>
<td>B</td>
<td>To apply “soft” splines on a line drawn between the coordinate pairs (used only on BLOCK data).</td>
</tr>
<tr>
<td>S</td>
<td>To plot default symbol at XY.</td>
</tr>
<tr>
<td>S#</td>
<td>To change default symbol to No # symbol and plot it at XY.</td>
</tr>
<tr>
<td>'TEXT</td>
<td>To plot TEXT at XY. It must be the last operation in a GOC code. The TEXT following the ’ command is interpreted and expanded by the DIGLIB software, if it includes any ^ operator or STRING names using the ~ descriptor.</td>
</tr>
</tbody>
</table>

**BLOCKEND**

<table>
<thead>
<tr>
<th>Syntax</th>
<th>BLOCKEND</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>BLOCKEND terminates the local definition of the graphical operation code defined by the earlier BLOCK command.</td>
</tr>
</tbody>
</table>

**DATAPPOINT**

DATAPPOINT is not a DATASET command, but the basic DATAPLOT command (see synopsis below) performs an action at the current point determined by the specified X/Y-coordinates. A DATASET may contain various data points, in addition to one or more data "BLOCK" on the previous pages. Such data points are separated and independent on each other.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>X  Y  GOC</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>X and Y are unsigned real numbers identifying the X/Y-coordinates for the current data point. GOC stands for Graphical Operation Code (GOC) for the current point. Legal GOC characters.</td>
</tr>
</tbody>
</table>

**Example**

0.7 0.95 N'Example 6
0.5 0.08 MNA'E^FS18^SQ(^SK^FS10A+5#8*C#^FS10 -!a^FS18)^FS11+B^DIa#b#$

**CLIP**

CLIP turns clipping on or off. If it is OFF, it allows output outside the ordinary plot area defined by normalized coordinates zero and one.
### CLIP

**Syntax**

<table>
<thead>
<tr>
<th>Syntax</th>
<th>CLIP CLP</th>
</tr>
</thead>
</table>

*clp* is a character string reading ON or OFF.

### ATTRIBUTE

ATTRIBUTE specifies where the current XY position is in the character or symbol plotbox.

**Syntax**

| Syntax | ATTRIBUTE |

**Prompts**

| attribute |

attribute may be TOP, CENTER or BOTTOM. ATTRIBUTE CENTER is default for symbols; ATTRIBUTE BOTTOM is default for characters.

![Top, Center, Bottom](image)

### LINETYPE

LINETYPE redefines the current linetype in the plot.

**Syntax**

| Syntax | LINETYPE # |

# must be an unsigned integer. Legal linetypes are (for both normal graphical outputs and for PostScript formats):

- Solid (default)
- Long dashed
- Short dashed
- Dotted

### DRAWLINE

DRAWLINE draws a line starting at \((x_1, y_1)\) to \((x_n, y_n)\) through \((x_2, y_2)\) \(\rightarrow (x(n-1), y(n-1))\).
**Syntax**

DRAWLINE x1,y1 x2,y2 .... xn,yn

- *x* and *y* may be reals or integers of any value. This is the same as connecting all points in a table:

<table>
<thead>
<tr>
<th>X1</th>
<th>Y1</th>
<th>M</th>
</tr>
</thead>
<tbody>
<tr>
<td>X2</td>
<td>Y2</td>
<td>D</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td>D</td>
</tr>
<tr>
<td>Xn</td>
<td>Yn</td>
<td>D</td>
</tr>
</tbody>
</table>

---

**CHARSIZE**

CHARSIZE redefines the default size of the characters in the plot. The character size has an initial default value, which may vary with the current font setting and the output device (the plot format).

- **Syntax**

<table>
<thead>
<tr>
<th>Syntax</th>
<th>CHARSIZE $$</th>
</tr>
</thead>
<tbody>
<tr>
<td>$$</td>
<td>$$ must be an unsigned real.</td>
</tr>
</tbody>
</table>

---

**SYMBOLSIZE**

SYMBOLSIZE redefines the current symbol size setting. The symbol size has an initial default value.

- **Syntax**

<table>
<thead>
<tr>
<th>Syntax</th>
<th>SYMBOLSIZE $$</th>
</tr>
</thead>
<tbody>
<tr>
<td>$$</td>
<td>$$ must be an unsigned real.</td>
</tr>
</tbody>
</table>

---

**GLOBALSIZE**

GLOBALSIZE redefines the default global size of the plot. The global size has an initial default value.

- **Syntax**

<table>
<thead>
<tr>
<th>Syntax</th>
<th>GLOBALSIZE $$</th>
</tr>
</thead>
<tbody>
<tr>
<td>$$</td>
<td>$$ must be an unsigned real.</td>
</tr>
</tbody>
</table>

---

**COLOR**

COLOR redefines the current color setting. There are 22 legal color codes (from 0 to 21).
COLOR code is an unsigned integer number (from 0 to 21) identifying the color, or a character string specifying the color.

### DIGLIB Color Codes

<table>
<thead>
<tr>
<th>Code</th>
<th>Color</th>
<th>Equivalent Character</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Background</td>
<td>Invisible</td>
</tr>
<tr>
<td>1</td>
<td>Black</td>
<td>Normal</td>
</tr>
<tr>
<td>2</td>
<td>Red</td>
<td>Very_Thick</td>
</tr>
<tr>
<td>3</td>
<td>Green</td>
<td>Thin</td>
</tr>
<tr>
<td>4</td>
<td>Blue</td>
<td>Thick</td>
</tr>
<tr>
<td>5</td>
<td>Yellow</td>
<td>Very_Thin</td>
</tr>
<tr>
<td>6</td>
<td>Magenta</td>
<td>Dashed</td>
</tr>
<tr>
<td>7</td>
<td>Cyan</td>
<td>Dotted</td>
</tr>
<tr>
<td>8</td>
<td>Purple</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Gold</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Turquoise</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Pink</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Gray</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Orangered</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Maroon</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Plum</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>Seagreen</td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>Olivedrab</td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>Sienna</td>
<td></td>
</tr>
<tr>
<td>19</td>
<td>Orange</td>
<td></td>
</tr>
</tbody>
</table>
### Code Color Equivalent Character

<table>
<thead>
<tr>
<th>Code</th>
<th>Color</th>
<th>Equivalent Character</th>
</tr>
</thead>
<tbody>
<tr>
<td>20</td>
<td>Coral</td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>UserDef</td>
<td></td>
</tr>
<tr>
<td>22 and higher</td>
<td>Any digit larger than 21 has the color effect as 1 (black).</td>
<td></td>
</tr>
</tbody>
</table>

#### DIGLIB Color Effects

![Color Effects Diagram]

### FONT

FONT redefines the default font setting in the POST-processor.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FONT #</td>
<td># is an unsigned integer.</td>
</tr>
</tbody>
</table>
## Font Numbers

<table>
<thead>
<tr>
<th>Number</th>
<th>Font Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Cartographic Roman (the default)</td>
</tr>
<tr>
<td>2</td>
<td>Bold Roman script</td>
</tr>
<tr>
<td>3</td>
<td>Bold Roman</td>
</tr>
<tr>
<td>4</td>
<td>Bold italic</td>
</tr>
<tr>
<td>5</td>
<td>Script</td>
</tr>
<tr>
<td>6</td>
<td>Bold script</td>
</tr>
<tr>
<td>7</td>
<td>UNCIAL</td>
</tr>
<tr>
<td>8</td>
<td>Bold Greek</td>
</tr>
<tr>
<td>9</td>
<td>Gothic English</td>
</tr>
<tr>
<td>10</td>
<td>Gothic Greek</td>
</tr>
</tbody>
</table>
Examples of all the DIGLIB fonts and line types

```
THERMO-CALC (2001.08.21:10.53) : DIGLIB Fonts

1.0
0.9
0.8
0.7
0.6
0.5
0.4
0.3
0.2
0.1

0
0.2
0.4
0.6
0.8
1.0

<table>
<thead>
<tr>
<th>Font</th>
<th>Font</th>
<th>Font</th>
<th>Font</th>
<th>Font</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
</tr>
<tr>
<td>6</td>
<td>7</td>
<td>8</td>
<td>9</td>
<td>10</td>
</tr>
</tbody>
</table>

```

**STRING**

STRING defines a string containing a text and operation codes (e.g., to change the default font settings).
Syntax

<table>
<thead>
<tr>
<th>Operator</th>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>^S#</td>
<td>Set character size to size #</td>
</tr>
<tr>
<td>^G</td>
<td>Set font to Greek</td>
</tr>
<tr>
<td>^F#</td>
<td>Set font to font number #</td>
</tr>
<tr>
<td>^U#</td>
<td>Move up # units</td>
</tr>
<tr>
<td>^D#</td>
<td>Move down # units</td>
</tr>
<tr>
<td>^R#</td>
<td>Move right # units</td>
</tr>
<tr>
<td>^L#</td>
<td>Move left # units</td>
</tr>
<tr>
<td>^N</td>
<td>Do not move, remain at current</td>
</tr>
</tbody>
</table>

**String operation codes in the DIGLIB software**

For the PostScript hardcopy fonts, these operation codes are not valid; see "LaTeX Formatting Codes" on page 12:

**Examples**

```
STRING Alpha1 ^Ga^F0^D0^S8,1^S0^U0
```
is set to $\alpha_1$

```
STRING M23C6 M^D0^S8,23^S0^U0C^D0^S8,6^S0^U0
```

is set to $M_{23}C_6$

```
STRING ACA2CO3 ^Ga^F0^D0^S8Ca^D0^S4,2^S0^U0^S8CO^D0^S4,3^S0^U0
```

is set to $Ca_2CO_3$

**TEXT**

TEXT outputs, at the current position, the text following the keyword TEXT or the text in the string _string_name_ that is defined with "STRING" on page 26.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>TEXT text or ~string_name</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>It is possible to mix ^ operators and previously defined string names using the ~ operator.</td>
</tr>
</tbody>
</table>

**FUNCTION**

FUNCTION defines and plots a user-defined function.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>FUNCTION Y=f(X); start end number_of_XY_pairs; GOC;</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>FUNCTION X=f(Y); start end number_of_XY_pairs; GOC;</td>
</tr>
</tbody>
</table>

$f(X)$ or $f(Y)$ are legal mathematical functions of $X$ or $Y$, understandable by a FORTRAN program. start and end are unsigned real numbers, and number_of_XY_pairs an unsigned integer. GOC is a legal graphical operation code as defined with "BLOCK" on page 19.

**PCFUNCTION**

PCFUNCTION appends a user-defined function to the current path. It is used with "PAINT" on the next page.
**Syntax**

<table>
<thead>
<tr>
<th>PCFUNCTION Y=f(X); start end number_of_XY_pairs; GOC;</th>
</tr>
</thead>
<tbody>
<tr>
<td>PCFUNCTION X=f(Y); start end number_of_XY_pairs; GOC;</td>
</tr>
</tbody>
</table>

$f(X)$ or $f(Y)$ are legal mathematical functions of X or Y, understandable by a FORTRAN program. start and end are unsigned real numbers, and number_of_XY_pairs an unsigned integer. GOC is a legal graphical operation code as defined with "BLOCK" on page 19.

### PAINT

PAINT paints the area enclosed by the current path in the current pattern. The current path starts at the last MOVETO given and includes all subsequent DRAWs. This command only works for the PostScript format (as graphical files or on printed hardcopy).

Also see "PCFUNCTION" on the previous page.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>PAINT &lt;code&gt; &lt;video&gt; &lt;mode&gt;</th>
</tr>
</thead>
</table>

<> denotes optional parameters. To set a new current pattern, supply any or all of the optional parameters.

- <code> is a single letter 0-9, A-Z or a-t (if <code>=t, also supply a space and a number in the range 0.00-1.00). The default is 0.
- <video> is a string reading NORMAL (the default) or INVERSE.
- <mode> is a string reading TRANSPARENT (the default) or OPAQUE.

### INCLUDE

INCLUDE adds a file into the current input stream. See "Example 5 – Use Included Files for Predefined Symbols" on page 35.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>INCLUDE filename</th>
</tr>
</thead>
</table>

filename is a legal filename (with its correct path) for the operation system.
Examples of DATAPLOT Files and Outputs

In this section:

Example 1 – Draw Lines and Symbols ................................................................. 31
Example 2 – Draw Polygons and Symbols ............................................................ 32
Example 3 – Using Strings and Various Line Types .................................................. 33
Example 4 – Draw Curves Defined by Functions ....................................................... 34
Example 5 – Use Included Files for Predefined Symbols ............................................. 35
Example 6 – Plot Triangular Diagrams for Ternary Systems ........................................ 38
Example 7 – Color Codes and Effects ...................................................................... 42
Example 1 – Draw Lines and Symbols

$DATAPLOT Example 1
PROLOG 1 EXAMPLE 10<X<100, 0<Y<100
XSCALE 0.00000100
YScale 0.00000100
XTYPE LINEAR YTYPE LINEAR
XLENGTH 11.5000
YLENGTH 11.5000
TITLE EXAMPLE 1 XTEXT X
YTEXT Y

DATASET 1 Two lines started with two symbols
ATTRIBUTE CENTER
0.050.95 N'Example 1
0.70.95 NS'Line 1
0.70.90 NS2'Line 2 1010S1
2080D
8080S2
8010D
5060

THERMO-CALC (2001.08.16:11.26): EXAMPLE 15.1
Example 2 – Draw Polygons and Symbols

$DATAPLOT Example 2
PROLOG 2 EXAMPLE 20<X<100, 0<Y<100
XSCALE 0.00000100
YSCALE 0.00000100
XTYPE LINEAR YTYPE LINEAR
XLENGTH 11.5000
YLENGTH 11.5000
TITLE EXAMPLE 2 XTEXT X
YTEXTY

DATASET 2 Two polygons with three types of symbols ATTRIBUTE CENTER
CLIP OFF
0.050.95 N'Example 2
1.10.95 NS1'SYMBOL 1
1.10.90 NS2'SYMBOL 2
1.10.85 NS3'SYMBOL 3
BLOCK X=C1; Y=C2; GOCC=C3,DSWA
4040M
4060
6060S2'CHANGE OF SYMBOL
6040
4040S0
BLOCKEND
BLOCK X=C1*100; Y=C2*100; GOCC=C3,DSWA 0.20.2 MS1
0.20.8
0.80.8
0.80.2
0.20.2
BLOCKEND
Example 3 – Using Strings and Various Line Types

$DATAPLOT Example 3

PROLOG 3 EXAMPLE 3 0<X<10, 0<Y<100

XSCALE 0.0000010

YSCALE 0.00000100

XTYPE LINEAR

YTYPE LINEAR

XLENGTH 11.5000

YLENGTH 11.5000

TITLE EXAMPLE 3 XTEXT X

YTEXT Y

DATASET 3 Draw curves; plot formatted texts and symbols

$Define some strings: STRING BCC ^Ga^F0

STRING BCC1 ^Ga^F0^D0^S8,1^S0^U0

STRING M23C6 M^D0^S8,23^S0^U0C^D0^S8,6^S0^U0

STRING ACA2CO3 ^Ga^F0^D0^S8Ca^D0^S4,2^S0^U0^S8CO^D0^S4,3^S0^U0 STRING AMG2SO4 ^Ga^F0^D0^S8Mg^D0^S4,2^S0^U0^S8SO^D0^S4,4^S0^U0

$ Note: if as PostScript output:

$STRING BCC !a

$STRING BCC1 !a^do1$

$STRING M23C6 M^do23$C^do6$

$STRING ACA2CO3 !a^doCa^do2$^doCO^do3$
Example 4 – Draw Curves Defined by Functions

$DATAPLOT Example 4
Example 5 – Use Included Files for Predefined Symbols

$DATAPLOT Example 5
PROLOG 5 EXAMPLE 50<X<100, 0<Y<100
XSAMPLE 0.00000100
YSAMPLE 0.00000100
XTYPE LINEAR YTYPE LINEAR
XLENGTH 11.5000
YLENGTH 11.5000
TITLE EXAMPLE 5 XTEXT X
YTEXTY
DATASET 5 Write characters in various fonts, and defined symbols FONT 2
INCLUDE <DATAPLOT-EXAMPLE-PATH>INCLUDE.EXP ATTRIBUTE CENTER
0.050.95 N'Example 5 CLIP OFF
0.010.85 N'-TEST1A
0.010.75 N'-TEST1B
0.010.65 N'-TEST2A
0.010.55 N'-TEST2B
0.010.40 N'-BCC ~BCC1 -M23C6
0.010.30 N'-ACA2CO3 ~AM2SO4

The INCLUDE.EXP file has the following content:

STRING TEST 1A ^Ga b c d e f g h i j k^F0
STRING TEST 1B ^Gl m n o p q r s t u v w x y z^F0 STRING TEST2Aa b c d e f g h i j k
STRING TEST 2B1 m n o p q r s t u v w x y z STRING BCC ^Ga^F0
STRING BCC1 ^Ga^F0^D0^S8,1^S0^U0
STRING BCC2 ^Ga^F0^D0^S8,2^S0^U0 STRING FCC ^Gc^F0
STRING FCC1 ^Gc^F0^D0^S8,1^S0^U0 STRING FCC2 ^Gc^F0^D0^S8,2^S0^U0
STRING L Liquid STRING SIGMA ^Gs^F0 STRING MU ^Gm^F0 STRING LAVES ^G1^F0 STRING CHI ^Gx^F0 STRING KSI ^Gr^F0
STRING MCETA ^S12^Gh^F0^S0^U0 STRING M2CM^D0^S8,2^S0^U0C STRING M2CT M^D0^S10,2^S0^U0C
STRING M6CM^D0^S8,6^S0^U0C
STRING M23C6 M^D0^S8,23^S0^U0C^D0^S8,6^S0^U0 STRING M7C3
M^D0^S8,7^S0^U0C^D0^S8,3^S0^U0 STRING M3C2 M^D0^S8,3^S0^U0C^D0^S8,2^S0^U0 STRING MC1-X MC^D0^S8,1-x^S0^U0
STRING XC x^D0^S7,C^S0^U0 STRING XFE x^D0^S7,Fe^S0^U0 STRING XMO x^D0^S7,Mn^S0^U0
STRING XW x^D0^S7,W^S0^U0 STRING UW -XW/(-XMO+-XW)
STRING ac a^D0^S7,C^S0^U0 STRING ACC a^D0^S7,C^S0^U0
STRING ACA2CO3 ^Ga^F0^D0^S8Ca^D0^S4,2^S0^U0^CO^D0^S4,3^S0^U0 STRING AMG2SO4
^Ga^F0^D0^S8Mg^D0^S4,2^S0^U0^SO^D0^S4,4^S0^U0
$ Note: if as PostScript output:
$STRING TEST 1A !a !b !c !d !e !f !g !h !i !j !k^fo27
$STRING TEST 1B !l !m !n !o !p !q !r !s !t !u !v !w !x !y !z^fo27
$STRING TEST 2Aa b c d e f g h i j k
$STRING TEST 2B1 m n o p q r s t u v w x y z
$STRING BCC !a
$STRING BCC1 !a^do1$
$STRING BCC2 !a^do2$
$STRING FCC !c
$STRING FCC1 !c^do1$
$STRING FCC2 !c^do2$
$STRING L Liquid
$STRING SIGMA !s
$STRING MU !m
$STRING LAVES !l
$STRING CHI !x
$STRING KSI !r
$STRING MCETA !h
$STRING M2CM^do2$C
$STRING M2CT M^do2$C
$STRING M6CM^do6$C
$STRING M23C6 M^do23$C^do6$
$STRING M7C3 M^do7$C^do3$
$STRING M3C2 M^do3$C^do2$

Examples of DATAPLOT Files and Outputs | 37 of 45
Example 6 – Plot Triangular Diagrams for Ternary Systems

$DATAPLOT$ Example 6
PROLOG 6 EXAMPLE 6 0<X<0.969224, 0<Y<1.00000
XSCALE 0.000000.969224
YSCALE 0.307492E-011.00000
XTYPE LINEAR YTYPE LINEAR
XLENGTH 11.5000
YLENGTH 11.5000 TITLE A-B-C at T=1000 K XTEXT MOLE_FRACTION B YTEXT MOLE_FRACTION C
DIAGRAM_TYPE TRIANGULAR YES YES
DATASET 6 Plot a ternary phase diagram CLIP OFF
0.70 0.95 N'Example 6 0.85 0.30 N'B2C
0.54 0.87 N'Diamond CHARSIZE 0.25
1.4E+01 1.10E+01 MVA'1:*B2C Liquid
1.4E+01 1.05E+01 MVA'2:*Diamond Liquid
0.10 0.10 N'Liquid
0.48 0.45 N'Diamond+
0.48 0.40 N' B2C+Liquid 5.80E-01 5.40E-02 MWA' 1
1.90E-01 2.40E-01 MWA' 1
0.65E-01 2.50E-01 MWA' 2
CHARSIZE 0.45
-0.10 -0.05 N'A
1.06 -0.05 N'B
0.500.95 N'C
CHARSIZE 0.35
$\text{Calculated A-B-C Phase Equilibrium Data:}$

$\text{PHASE REGION FOR:}$

$F0 \text{ LIQUID}$

$E \text{ DIAMOND}_A4$

$F0 \text{ B2C}$

$\text{INVARIANT EQUILIBRIUM COLOR2}$

$\text{BLOCK X=C1; Y=C2; GOC=C3, WAD; 2.4555855989E-013.5568857193E-01M}$

0.0000000000E+009.9999523163E-01

2.4555855989E-013.5568857193E-01M

6.666666653E-013.3333334327E-01

0.0000000000E+009.9999523163E-01M

6.666666653E-013.3333334327E-01 COLOR1

$\text{BLOCKEND}$

$\text{PHASE REGION FOR:}$

$E \text{ LIQUID}$

$F0 \text{ B2C}$

$\text{BLOCK X=C1; Y=C2; GOC=C3, WAD; }$

$\text{PLOTTED COLUMNS ARE : X(LIQUID,B) and X(LIQUID,C)}$

2.203037155E-011.2340000272E-01M

2.2632879019E-011.1058768630E-01

2.337163387E-011.9345825613E-02

2.4253317714E-011.8345827699E-02

2.642946393E-011.2744041681E-02

2.842946486E-011.2814079225E-02

2.9617273808E-011.8319382370E-02

3.2811737061E-011.9470417202E-02

3.635862286E-011.3130427599E-02

3.989587511E-011.8979098201E-02

4.5209178329E-011.5266116261E-02

5.2293431759E-011.3152002841E-02

6.1148744822E-011.3077053726E-02

6.4690870047E-011.3490389585E-02

6.8232995272E-011.4017231315E-02

7.3546189070E-011.4814555198E-02

7.5317251682E-011.5033416003E-02

8.0630439520E-011.5373892635E-02

8.5943627357E-011.4983776510E-02
9.1256815195E-013.3575300127E-02
9.6747112274E-013.0857827514E-02
9.692245297E-013.0749246478E-02
2.203037155E-011.2340000272E-01M
2.129465337E-011.5308913589E-01
2.117152121E-011.8851040304E-01
2.1532440186E-012.393165529E-01
2.2180187702E-012.5932922244E-01
2.2992117703E-012.9477417469E-01
2.388295889E-013.019542694E-01
2.455585989E-013.5568857193E-01
$ PLOTTED COLUMNS ARE : X(B2C,B) and X(B2C,C) 6.6666668653E-013.333334327E-01M
6.666668653E-013.333334327E-01
$ TIELINES COLOR3
6.666668653E-013.333334327E-01M
8.7775242329E-013.4625384957E-02
6.666668653E-013.333334327E-01M
7.9250496626E-013.5342670977E-02
6.666668653E-013.333334327E-01M
2.4555824697E-013.5568737984E-01
6.666668653E-013.333334327E-01M
2.3944084346E-019.2542596161E-02
6.666668653E-013.333334327E-01M
2.3359020054E-013.954307318E-01
6.666668653E-013.333334327E-01M
2.2585247457E-012.7766343951E-01
6.666668653E-013.333334327E-01M
2.1618695557E-011.3621240854E-01
2.2632879019E-011.058768630E-01M
6.666668653E-013.333334327E-01 COLOR1
BLOCKEND
$ PHASE REGION FOR:
$F0 DIAMOND_A4
$E B2C
BLOCK X=C1; Y=C2; GOC=C3, WAD;
$ PLOTTED COLUMNS ARE : X(DIAMOND_A4,B) and X(DIAMOND_A4,C)
0.0000000000E+009.9999523163E-01M
0.0000000000E+009.9999976158E-01 BLOCKEND
$ PHASE REGION FOR:
$E LIQUID
$F0 DIAMOND_A4
BLOCK X=C1; Y=C2; GOC=C3, WAD;
$ PLOTTED COLUMNS ARE: X(LIQUID,B) and X(LIQUID,C)
2.45558E-01 3.55688E-01 M
2.02635E-01 3.34830E-01
1.62439E-01 3.13753E-01
1.22439E-01 2.91531E-01
8.24390E-02 2.68542E-01
4.24390E-02 2.45480E-01
2.43905E-03 2.23138E-01
2.49999E-07 2.21816E-01
$ TIELINES COLOR3
0.00000E+00 9.99995E-01 M
2.35291E-01 3.50859E-01
0.00000E+00 9.99994E-01 M
1.98265E-01 3.32609E-01
0.00000E+00 9.99994E-01 M
1.32400E-01 2.97160E-01
0.00000E+00 9.99993E-01 M
1.14399E-01 2.86953E-01 BLOCKEND
Example 7 – Color Codes and Effects

$DATAPLOT Color Codes & Color Effects

PROLOG 10 Color Codes 0<X<1.0, 0<Y<1.0
XSSCALE 0.01.0
YSSCALE 0.01.0
XTYPE LINEAR
YTYPE LINEAR
XLENGTH 11.5000
YLENGTH 11.5000
TITLE Color Outputs XTEXT Color Codes YTEXT Color Effects
DATASET 10 Various Color Codes for Color Outputs: CHARSIZE 0.3
LINETYPE 1
BLOCK X=C1; Y=C2;GOC=C3,WAD;
0.05 0.95 MNA’Color Code: Color Effect
0.55 0.95 MNA’Color Code: Color Effect CHARSIZE 0.25
COLOR 1
0.05 0.88 MNA’1: Black CLIP ON
0.22 0.88 M
0.45 0.88
CLIP OFF COLOR 2
0.05 0.82 MNA’2: Red CLIP ON
0.22  0.82 M
0.45  0.82
CLIP OFF COLOR 3
0.05  0.76 MNA'3: Green CLIP ON
0.22  0.76 M
0.45  0.76
CLIP OFF COLOR 4
0.05  0.70 MNA'4: Blue CLIP ON
0.22  0.70 M
0.45  0.70
CLIP OFF COLOR 5
0.05  0.64 MNA'5: Yellow CLIP ON
0.22  0.64 M
0.45  0.64
CLIP OFF COLOR 6
0.05  0.58 MNA'6: Magenta CLIP ON
0.22  0.58 M
0.45  0.58
CLIP OFF COLOR 7
0.05  0.52 MNA'7: Cyan CLIP ON
0.22  0.52 M
0.45  0.52
CLIP OFF COLOR 8
0.05  0.46 MNA'8: Purple CLIP ON
0.22  0.46 M
0.45  0.46
CLIP OFF COLOR 9
0.05  0.40 MNA'9: Gold CLIP ON
0.22  0.40 M
0.45  0.40
CLIP OFF COLOR 10
0.05  0.34 MNA'10: Turquoise CLIP ON
0.22  0.34 M
0.45  0.34
CLIP OFF COLOR 11
0.05  0.28 MNA'11: Pink CLIP ON
0.22  0.28 M
0.45 0.28
CLIP OFF COLOR 12
0.05 0.22 MNA'12: Gray CLIP ON
0.22 0.22 M
0.45 0.22
CLIP OFF COLOR 13
0.05 0.16 MNA'13: Orangered CLIP ON
0.22 0.16 M
0.45 0.16
CLIP OFF COLOR 14
0.05 0.10 MNA'14: Moroon CLIP ON
0.22 0.10 M
0.45 0.10
CLIP OFF COLOR 15
0.05 0.04 MNA'15: Plum CLIP ON
0.22 0.04 M
0.45 0.04
CLIP OFF COLOR 16
0.55 0.88 MNA'16: Seagreen CLIP ON
0.72 0.88 M
0.95 0.88
CLIP OFF COLOR 17
0.55 0.82 MNA'17: Olivedrab CLIP ON
0.72 0.82 M
0.95 0.82
CLIP OFF COLOR 18
0.55 0.76 MNA'18: Sienna CLIP ON
0.72 0.76 M
0.95 0.76
CLIP OFF COLOR 19
0.55 0.70 MNA'19: Orange CLIP ON
0.72 0.70 M
0.95 0.70
CLIP OFF COLOR 20
0.55 0.64 MNA'20: Coral CLIP ON
0.72 0.64 M
0.95 0.64
CLIP OFF COLOR 21
0.55 0.58 MNA'21: UserDef CLIP ON
0.72 0.58 M
0.95 0.58
CLIP OFF COLOR 22
0.55 0.52 MNA'22 = 1 CLIP ON
0.72 0.52 M
0.95 0.52
CLIP OFF COLOR 23
0.55 0.46 MNA'23 = 1 CLIP ON
0.72 0.46 M
0.95 0.46
CLIP OFF
BLOCKEND

THERMO-CALC (2012.06.18:14.01) : Color Outputs

![Color Chart Diagram](image-url)